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Chapter 1
About this Guide

About this Guide
This user guide describes the features supported by Aruba Central and provides detailed instructions to set
up and configure devices such as Instant APs, Aruba Switches, and Aruba SD-WAN Gateways.

Intended Audience
This guide is intended for system administrators who configure and monitor their networks using Aruba
Central.

Related Documents
In addition to this document, the Aruba Central product documentation includes the following documents:

n Aruba Central Help Center
n Aruba Central Getting Started Guide
n Aruba Central Managed Service Provider User Guide
n Aruba Central SD Branch Solution Guide

Conventions
The following conventions are used throughout this guide to emphasize important concepts:

Type Style Description

Italics This style is used to emphasize important terms and to mark the titles of
books.

System items This fixed-width font depicts the following:
n Sample screen output
n System prompts

Table 1: Typographical Conventions

The following informational icons are used throughout this guide:

nIndicates a risk of damage to your hardware or loss of data.

nIndicates helpful suggestions, pertinent information, and important things to remember.

nIndicates a risk of personal injury or death.

Terminology Change
As part of advancing HPE's commitment to racial justice, we are taking a much-needed step in overhauling
HPE engineering terminology to reflect our belief system of diversity and inclusion. Some legacy products
and publications may continue to include terminology that seemingly evokes bias against specific groups of
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people. Such content is not representative of our HPE culture and moving forward, Aruba will replace
racially insensitive terms and instead use the following new language:

Usage Old Language New Language

Campus Access
Points +
Controllers

Master-Slave Conductor-Member

Instant Access
Points

Master-Slave Conductor-Member

Switch Stack Master-Slave Conductor-Member

Wireless LAN
Controller

Mobility Master Mobility Conductor

Firewall
Configuration

Blacklist, Whitelist Denylist, Allowlist

Types of
Hackers

Black Hat, White Hat Unethical, Ethical

Contacting Support

Main Site arubanetworks.com

Support Site support.arubanetworks.com

Airheads Social Forums and Knowledge
Base

community.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)
1-408-754-1200

International Telephone arubanetworks.com/support-services/contact-support/

Software Licensing Site lms.arubanetworks.com

End-of-life Information arubanetworks.com/support-services/end-of-life/

Security Incident Response Team Site: arubanetworks.com/support-services/security-bulletins/
Email: aruba-sirt@hpe.com

Table 2: Contact Information

http://www.arubanetworks.com/
https://support.arubanetworks.com/
http://community.arubanetworks.com/
http://www.arubanetworks.com/support-services/contact-support/
https://lms.arubanetworks.com/
http://www.arubanetworks.com/support-services/end-of-life/
http://www.arubanetworks.com/support-services/security-bulletins/
mailto:aruba-sirt@hpe.com


Chapter 2
What is Aruba Central?

What is Aruba Central?
Aruba Central offers unified network management, AI-based analytics, and IoT device security for wired,
wireless, and SD-WAN networks. All of these capabilities are combined into one easy-to-use platform, which
includes the following apps:

n Network Operations—Provides unified network management by consolidating wired, wireless, and SD-
WAN deployment and management tasks, real-time diagnostics, and live monitoring, for simple and fast
problem resolution.

n ClearPass Device Insight—Provides a single pane of glass for device visibility employing automated
device discovery, machine learning (ML) based fingerprinting and identification. For more information,
see Aruba ClearPass Device Insight Information Center.

This section includes the following topics:

n Key Features
n What is Aruba Central?
n Supported Web Browsers
n Operational Modes and Interfaces

Key Features
Aruba Central offers the following key features and benefits:

n Streamlined configuration and deployment of devices—Leverages the ZTP capability of Aruba devices to
bring up your network in no time. Aruba Central supports group configuration of devices, which allows
you to provision and manage multiple devices with similar configuration requirements with less
administrative overhead.

n Integrated wired, WAN, and wireless Infrastructure management—Offers a centralized management
interface for managing wireless, WAN, and wired networks in distributed environments, and thus help
organizations save time and improve efficiency.

n Advanced analytics and assurance—With continuous monitoring, AI-based analytics provide real-time
visibility and insight into what’s happening in the Wi-Fi network. The insights utilize machine learning that
leverage a growing pool of network data and deep domain experience.

n Secure cloud-based platform—Offers a secure cloud platform with HTTPS connection and certificate
based authentication.

n Interface for Managed Service Providers—Offers an additional interface for MSPs to provision and
manage their respective tenant accounts. Using the MSP mode, service provider organizations can
administer network infrastructure for multiple organizations in a single interface.

n SD-Branch Management—Offers a simplified solution for managing and monitoring SD Branch devices
such as Branch Gateways, VPN Concentrators, Instant APs, and Aruba Switches. It also provides detailed
dashboards showing WAN health and pictorial depictions of the branch setup. The Aruba SD-Branch
solution extends the SD-WAN concepts to all elements in a branch setup to deliver a full-stack solution for
managing WLAN, LAN and WAN connections. The SD-Branch solution provides a common cloud-
management model that simplifies deployment, configuration, and management of all components of a
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branch setup. The solution leverages the ZTP and cloud management capabilities of Aruba devices to
integrate management and infrastructure for WAN, WLAN, and LAN and provide a holistic solution from
access network to edge with end-to-end security. It also addresses all communications in distributed
deployments, from micro branches to medium or large branches. For more information, see the Aruba
SD-Branch Solution.

n Health and usage monitoring—Provides a comprehensive view of your network, device status and
health, and application usage. You can monitor, identify, and address issues by using data-driven
dashboards, alerts, reports, and troubleshooting workflows. Aruba Central also utilizes the DPI feature of
the devices to monitor, analyze and block traffic based on application categories, application type, web
categories and website reputation. Using this data, you can prioritize business critical applications, limit
the use of inappropriate content, and enforce access policies on a per user, device or location basis.

n Guest Access—Allows you to manage access for your visitors with a secure guest Wi-Fi experience. You
can create guest sponsor roles and social logins for your guest networks. You can also design your guest
landing page with custom logos, color, and banner text.

n Presence Analytics—Offers a value added service for Instant AP based networks to get an insight into
user presence and loyalty. The Presence Analytics dashboard allows you to view the presence of users at
a specific site and the frequency of user visits at a given location or site. Using this data, you can make
business decisions to improve customer engagement.

Supported Web Browsers

To view the Aruba Central UI, ensure that JavaScript is enabled on the web browser.

Browser Versions Operating System

Google Chrome 39.0.2171.65 or later Windows and Mac OS

Mozilla Firefox 34.0.5 or later Windows and Mac OS

Safari 7 or later Mac OS

Table 3: Browser Compatibility Matrix

Operational Modes and Interfaces
Aruba offers the following variants of the Aruba Central web interface:

n Standard Enterprise Mode
n Managed Service Provider Mode

Standard Enterprise Mode
The Standard Enterprise interface is intended for users who manage their respective accounts end-to-end.
In the Standard Enterprise mode, the customers have complete access to their accounts. They can also
provision devices and subscriptions to manage their respective accounts.

The following figure illustrates a typical Standard Enterprise mode deployment.

https://help.central.arubanetworks.com/latest/documentation/online_help/content/gateways/overview/overview.htm
https://help.central.arubanetworks.com/latest/documentation/online_help/content/gateways/overview/overview.htm
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Figure 1 Standard Enterprise Mode

Managed Service Provider Mode
Aruba Central offers the MSP mode for managed service providers who need to manage multiple customer
networks. The MSP administrators can provision tenant accounts, allocate devices, assign licenses, and
monitor tenant accounts and their networks. The administrators can also drill down to a specific tenant
account and perform administration and configuration tasks. Tenants can access only their respective
accounts, and only those features and application services to which they have subscribed.

The following figure illustrates a typical MSP mode deployment.

Figure 2 Managed Service Provider Mode

Supported Devices
This section provides the following information:
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n Supported Instant APs
n Supported Aruba Switch Platforms
n Supported Aruba CX Platforms
n Supported SD-Branch Components

Supported Instant APs
The following section discusses the supported Instant APs:

Supported Indoor APs
Aruba Central supports the following indoor APs:

n AP-555
n AP-535
n AP-534
n AP-515
n AP-514
n AP-505H
n AP-505
n AP-504
n AP-345
n AP-344
n IAP-334/335
n IAP-324/325
n AP-318
n IAP-314/315
n IAP-304/305
n AP-303P
n AP-303H
n AP-303
n RAP-3WNP
n IAP-228
n IAP-224/225
n IAP-214/215
n IAP-207
n IAP-205H
n IAP-204/205
n AP-203R/AP-203RP
n AP-203H
n RAP-155/155P
n IAP-134/135
n IAP-114/115
n RAP-108/109
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n IAP-105
n IAP-104
n IAP-103

Supported Outdoor APs
Aruba Central supports the following outdoor APs:

n AP-577EX
n AP-577
n AP-575EX
n AP-575
n AP-574
n AP-518
n AP-387
n AP-377EX
n AP-377
n AP-375EX
n AP-375
n AP-374
n AP-367
n AP-365
n IAP-277
n IAP-274/275
n IAP-175

Supported Instant AP Firmware Versions
The current release of Aruba Central supports only the following Instant AP firmware versions:

n 8.7.0.0
n 8.6.0.4
n 8.6.0.3
n 8.6.0.2
n 8.5.0.9
n 8.5.0.8
n 8.5.0.7
n 8.5.0.6
n 8.5.0.5
n 8.4.0.6
n 8.3.0.12
n 8.3.0.11
n 6.5.4.17
n 6.5.4.16
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n 6.5.4.15
n 6.5.1.5-4.3.1.9
n 6.4.4.8-4.2.4.16

RAP-155, RAP-155P, IAP-214, IAP-215, IAP-224, IAP-225, IAP-228, IAP-274, IAP-275, IAP-277 Instant APs are no
longer supported from Aruba Instant 8.7.0.0 onwards.
IAP-103, RAP-108, RAP-109, IAP-114, IAP-115, IAP-204, IAP-205, and IAP-205H Instant APs are no longer
supported from Aruba Instant 8.3.0.0 onwards.
By default, AP-318, AP-374, AP-375, and AP-377 access points have Eth1 as the uplink port and Eth0 as the
downlink port. Aruba recommends that you not upgrade these access points to 8.5.0.0 or 8.5.0.1 firmware
versions as the upgrade process changes the uplink port from Eth1 to Eth0 port thereby making the devices
unreachable.

APs Supporting Power Draw
The following APs support Power Draw:

n AP-577EX
n AP-577
n AP-575EX
n AP-575
n AP-574
n AP-518
n AP-515
n AP-514
n AP-505H
n AP-505
n AP-504
n AP-387
n AP-377
n AP-375
n AP-374
n AP-345
n AP-344
n IAP-335
n IAP-334
n AP-318
n IAP-314
n IAP-305
n IAP-304
n AP-303H
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For more information about Aruba's End-of-life policy and the timelines for hardware and software products at
the end of their lives, see: https://www.arubanetworks.com/support-services/end-of-life/.
Data sheets and technical specifications for the supported AP platforms are available at:
https://www.arubanetworks.com/products/networking/access-points/.

Supported Aruba Switch Platforms

Aruba Central uses the SSL certificate by GeoTrust Certificate Authority for device termination and web
services. As the SSL certificate is about to expire, Aruba is replacing it with a new certificate from another
trusted Certificate Authority. During the certificate upgrade window, all devices managed by Aruba Central will
be disconnected. After the upgrade, the devices reconnect to Aruba Central and resume their services with
Aruba Central. However, for Aruba switches to reconnect to Aruba Central after the certificate upgrade, you
must ensure that the switches are upgraded to the recommended software version listed in Table 4.
Aruba Central does not support switch software versions below 16.08 release for firmware upgrade. In
addition, only the latest three switch software versions of all major release versions will be available for
firmware upgrade from Aruba Central. For example, if the latest switch software version released is 16.10.0009,
the following versions will be available for firmware upgrade: 16.10.0007, 16.10.0008 and 16.10.0009.

The following tables list the switch platforms, corresponding software versions supported in Aruba Central,
and switch stacking details.

Switch
Platform

Supported
Software
Versions

Recommended
Software
Versions

Switch Stack-
ing Support

Supported
Stack Type
(Frontplane
(VSF) /
Backplane
(BPS))

Supported
Configuration
Group Type for
Stacking (UI /
Template)

Aruba
2530
Switch
Series

YA/YB.16.05.0008
or later

YA/YB.16.10.0009 N/A N/A N/A

Aruba
2540
Switch
Series

YC.16.03.0004 or
later

YC.16.10.0009 N/A N/A N/A

Aruba
2920
Switch
Series

WB.16.03.0004 or
later

WB.16.10.0009 Yes
Switch
Software
Dependency:
WB.16.04.0008
or later

BPS UI and Template

Aruba
2930F
Switch
Series

WC.16.03.0004 or
later

WC.16.10.0009 Yes
Switch
Software
Dependency:
WC.16.07.0002
or later

VSF UI and Template

Table 4: Supported Aruba Switch Series, Software Versions, and Switch Stacking

https://www.arubanetworks.com/support-services/end-of-life/
https://www.arubanetworks.com/products/networking/access-points/
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Switch
Platform

Supported
Software
Versions

Recommended
Software
Versions

Switch Stack-
ing Support

Supported
Stack Type
(Frontplane
(VSF) /
Backplane
(BPS))

Supported
Configuration
Group Type for
Stacking (UI /
Template)

Aruba
2930M
Switch
Series

WC.16.04.0008 or
later

WC.16.10.0009 Yes
Switch
Software
Dependency:
WC.16.06.0006
or later

BPS UI and Template

Aruba
3810
Switch
Series

KB.16.03.0004 or
later

KB.16.10.0009 Yes
Switch
Software
Dependency:
KB.16.07.0002
or later

BPS UI and Template

Aruba
5400R
Switch
Series

KB.16.04.0008 or
later

KB.16.10.0009 Yes
Switch
Software
Dependency:
KB.16.06.0008
or later

VSF Template only

Provisioning and configuring of Aruba 5400R switch series and switch stacks is supported only through
configuration templates. Aruba Central does not support moving Aruba 5400R switches from the template
group to a UI group. If an Aruba 5400R switch is pre-assigned to a UI group, then the device is moved to an
unprovisioned group after it joins Aruba Central.

Mobility Access Switch Series Supported Software Versions

n S1500-12P
n S1500-24P
n S2500-24P
n S3500-24T

ArubaOS 7.3.2.6
ArubaOS 7.4.0.3
ArubaOS 7.4.0.4
ArubaOS 7.4.0.5
ArubaOS 7.4.0.6

Table 5: Supported Aruba Mobility Access Switch Series and Software
Versions

Data sheets and technical specifications for the supported switch platforms are available at:
https://www.arubanetworks.com/products/networking/switches/

Supported Aruba CX Platforms
To manage your Aruba CX switches using Aruba Central, ensure that the switch software is upgraded to
10.05.0001 or a later version. Aruba CX switches with version 10.04.2000 or earlier might not connect to Aruba
Central after ten days of operation. You must upgrade the Aruba CX switch to a recommended software version to
connect to Aruba Central.

https://www.arubanetworks.com/products/networking/switches/
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The following table lists the Aruba CX platforms, corresponding software versions supported in Aruba
Central, and switch stacking details.

Switch
Platform

Supported
Software
Versions

Recommended
Software
Versions

Switch
Stacking
Support

Supported
Stack
Type

Maximum
Number
of Stack
Members

Supported
Configuration
Group Type
(UI /
Template)

Aruba CX
6200
Switch
Series

10.04.1000 10.05.0010 Yes
Switch
Software
Dependency:
10.04.1000

VSF 8 Template only

Aruba CX
6300
Switch
Series

10.04.0020 10.05.0010 Yes
Switch
Software
Dependency:
10.04.0020

VSF 10 Template only

Aruba CX
6405
Switch
Series

10.04.1000 10.05.0010 -N/A- -N/A- -N/A- Template only

Aruba CX
6410
Switch
Series

10.05.0001 10.05.0010 -N/A- -N/A- -N/A- Template only

Aruba CX
8320
Switch
Series

10.05.0001 10.05.0010 -N/A- -N/A- -N/A- Template only

Aruba CX
8325
Switch
Series

10.05.0001 10.05.0010 -N/A- -N/A- -N/A- Template only

Table 6: Supported Aruba CX Switch Series, Software Versions, and Switch Stacking

Provisioning and configuring of Aruba CX switch series and switch stacks is supported only through configuration
templates.

Data sheets and technical specifications for the supported switch platforms are available at:
https://www.arubanetworks.com/products/networking/switches/.

Supported SD-Branch Components
The Aruba SD-WAN Gateway portfolio includes Aruba Gateways that function as Branch Gateways and
VPN Concentrators.

The following table lists the Aruba Gateway platforms and ArubaOS software versions that function as
Branch Gateways:

https://www.arubanetworks.com/products/networking/switches/
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Platform Minimum Supported
Software Version

Latest Software
Version

Recommended
Software Version

Aruba 9004-LTE ArubaOS 8.5.0.0-2.1.0.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.5.0.0-2.1.0.0

Aruba 9012 ArubaOS 8.5.0.0-2.0.0.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.5.0.0-2.0.0.4

Aruba 9004 ArubaOS 8.5.0.0-1.0.7.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.5.0.0-2.0.0.4

Aruba 7210, 7220,
and 7240XM

ArubaOS 8.5.0.0-2.0.0.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.5.0.0-2.0.0.4

Aruba 7030  ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7024  ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7010  ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7008  ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7005  ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0 ArubaOS 8.4.0.0-2.0.0.4

Table 7: Supported Aruba Gateways

The following table lists the Aruba Gateway platforms and ArubaOS software versions that function as VPN
Concentrators:

Platform Minimum Supported
Software Version

Latest Software
Version

Recommended Software
Version

Aruba 7280 ArubaOS 8.4.0.0-1.0.6.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7240XM  ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7220  ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7210 ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

vGW-4G ArubaOS 8.4.0.0-1.0.6.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

vGW-2G ArubaOS 8.4.0.0-1.0.6.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Table 8: Supported Aruba VPN Concentrators
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Platform Minimum Supported
Software Version

Latest Software
Version

Recommended Software
Version

vGW-500M ArubaOS 8.4.0.0-1.0.6.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7030 ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7024 ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Aruba 7010 ArubaOS 8.1.0.0-1.0.4.0 ArubaOS 8.6.0.4-
2.2.0.0

ArubaOS 8.4.0.0-2.0.0.4

Table 8: Supported Aruba VPN Concentrators

Aruba Virtual Gateways also function as VPN Concentrators. The minimum supported software version for
Virtual Gateways is ArubaOS 8.1.0.0-1.0.4.1.

Data sheets and technical specifications for the supported Gateways are available at:
https://www.arubanetworks.com/products/networking/gateways-and-controllers/

The following table lists the hardware platforms and ArubaOS software versions for Aruba Switches and
Instant APs that can be deployed in the branch:

SD Branch Component Hardware Platforms Minimum Software
Version

Aruba Switches Aruba 3810 Switch Series KB.16.05.0007 or later

Aruba 5400R Switch
Series

KB.16.05.0007 or later

Aruba 2920 Switch Series WB.16.05.0007 or later

Aruba 2930F Switch
Series

WC.16.05.0007 or later

Instant APs Aruba 310 Series and 300
Series Instant APs

Aruba Instant 6.5.3.x
Aruba Instant 8.3.0.0 or
later

Table 9: SD Branch Site Devices

https://www.arubanetworks.com/products/networking/gateways-and-controllers/


Chapter 3
Getting Started with Aruba Central

Getting Started with Aruba Central
Thank you for choosing Aruba Central as your network management solution!

Before you get started with Aruba Central, we recommend that you review the Key capabilities of Aruba
Central and the list of Aruba devices supported in Aruba Central.

Key Terms and Concepts
Take a few minutes to familiarize yourself with the key terms and concepts used in the help topics.

Cluster Zone Refers to an Aruba Central deployment area within a specific region. In other words, cluster
zones are regional grouping of one or more container instances on which Aruba Central is
deployed. Cluster zones allow your deployments to restrict customer data to a specific region
and plan time zone specific maintenance windows.
Each cluster zone has separate URLs for signing up for Aruba Central, accessing Aruba Central
portal, and for allowing devices to communicate with Aruba Central.
To view the zone in Aruba Central UI, click the User Settings menu at the bottom of the left
navigation pane.

Enterprise
Mode

Refers to the Aruba Central solution deployment mode in which the customers provision,
manage, and maintain their networks end-to-end for their respective organizations or
businesses.

Managed
Services
Mode

Refers to the Aruba Central deployment mode in which the service providers, resellers,
administrators, and retailers to centrally manage and monitor multiple tenant or end-customer
accounts from a single management interface.

Subscription Refers to the license granted to a customer for using a product or service.

Evaluation
Account

Refers to the Aruba Central account created for evaluating Aruba Central solution and its
services.

Paid
Subscriber

Refers to the customers who have purchased a subscription to obtain access to Aruba Central
and its services.

Subscription
Key

Refers to the license key. A subscription key is a 14-character alphanumeric string; for example,
PQREWD6ADWERAS.

Customer ID

Subscriber
ID

Refers to the identity number of your Aruba Central account. To view your subscriber ID, click the
User Settings menu at the bottom of the left navigation pane in the Aruba Central UI.

Zero Touch
Provisioning

Refers to one of the following:
n Zero Touch Provisioning of Aruba Central accounts— When you purchase a subscription
key and add this subscription key in Aruba Central, Aruba Central queries the Aruba Activate
database to retrieve the devices mapped to your purchase order and add these devices to
the inventory. This process is referred to as zero touch provisioning in Aruba Central.
n Zero Touch Provisioning of Devices—Most Aruba devices support self-provisioning; that is,
when you connect a device to a provisioning network, it can automatically download
provisioning parameters from the Activate server and connect to their management entity.
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Onboarding Refers to the process of importing devices to Aruba Central's device inventory, activating
subscriptions, and making devices available for management from Aruba Central.

Device Sync Refers to the process of synchronizing devices from the Activate database. The device sync
operation allows Aruba Central to retrieve devices from Activate and automatically add these
devices to the device inventory in Aruba Central.

Provisioning Refers to the process of setting up a device for deploying networks as per the configuration
requirements of your organization.

Group Refers to the device configuration container in Aruba Central. You can combine devices with
common configuration requirements into a single group and apply the same configuration to all
the devices in that group.

Site Refers to the physical locations where devices are installed. Organizing devices per sites allows
you to filter your dashboard view per site.

Label Refers to the tags used for logically grouping devices based on various parameters such as
ownership, specific areas within a site, departments, and so on.

Workflow Summary
The following illustration summarizes the steps required for getting started with Aruba Central:

Navigate through the following topics to know more about the onboarding and provisioning procedures:

n Creating an Aruba Central Account on page 38
n Accessing Aruba Central Portal on page 42
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n Starting Your Free Trial on page 63
n Setting up Your Aruba Central Instance on page 69

Creating an Aruba Central Account
To start using Aruba Central, you need to register and create an Aruba Central account. Both evaluating and
paid subscribers require an account to start using Aruba Central.

Zones and Sign Up URLs
Aruba Central instances are available on multiple regional clusters. These regional clusters are referred to as
zones. When you register for an Aruba Central account, Aruba creates an account for you in the zone that is
mapped to the country you selected during registration.

If you access the Sign Up URL from the www.arubanetworks.com website, you are automatically redirected
to the sign up URL. To create an Aruba Central account in the zone that is mapped to your country, use the
following zone-specific sign up URLs.

Regional
Cluster Sign Up URL Available Apps

US-1 https://portal.central.arubanetworks.com/signup Network Operations

US-2 https://portal-prod2.central.arubanetworks.com/signup
OR
https://signup.central.arubanetworks.com/

n Network Operations
n ClearPass Device
Insight

Canada-1 https://portal-ca.central.arubanetworks.com/signup Network Operations

China-1 https://portal.central.arubanetworks.com.cn/signup Network Operations

EU-1 https://portal-eu.central.arubanetworks.com/signup n Network Operations
n ClearPass Device
Insight

APAC-1 https://portal-apac.central.arubanetworks.com/signup Network Operations

APAC-EAST1 https://portal-apaceast.central.arubanetworks.com/signup Network Operations

APAC-SOUTH1 https://portal-
apacsouth.central.arubanetworks.com/signup

Network Operations

Table 10: Sign Up URLs & Apps

Signing up for an Aruba Central Account
You can choose one of the following ways to start your Aruba Central account trail:

1. Go to http://www.arubanetworks.com/products/sme/eval/.
n Click Start Demo and fill the form to start a product demo.
n Click Got an Aruba AP? Start your trial here. TheRegistration page opens.

2. Enter your email address. Based on the email address you entered, the Registration page guides you
to the subsequent steps:

https://portal.central.arubanetworks.com/signup
https://portal-prod2.central.arubanetworks.com/signup
https://signup.central.arubanetworks.com/
https://portal-ca.central.arubanetworks.com/signup
https://portal.central.arubanetworks.com.cn/signup
https://portal-eu.central.arubanetworks.com/signup
https://portal-apac.central.arubanetworks.com/signup
https://portal-apaceast.central.arubanetworks.com/signup
https://portal-apacsouth.central.arubanetworks.com/signup
https://portal-apacsouth.central.arubanetworks.com/signup
http://www.arubanetworks.com/products/sme/eval/
https://signup.central.arubanetworks.com/
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If... Then...

If you are a new
user:

The Registration page prompts you to create a password.
To continue with the registration, enter a password in the Password and Confirm
Password fields.

If you are an
existing Aruba
customer, but you
do not have an
Aruba Central
account:

The Registration page displays the following message:
Email already exists. Please enter the password below.
To continue with registration, validate your account:

1. Enter the password.
2. Click Validate Account.

NOTE: If you do not remember the password, click Forgot Password to reset the
password.

If your email
account is already
registered with
Aruba, but you do
not have an
Aruba Central
account:

If you are invited
to join as a user in
an existing Aruba
Central customer
account:

The Registration page displays the following message:
An invitation email has already been sent to your email ID. Resend.
To continue with the registration:

1. Go to your email box and check if you have received the email invitation.
2. If you have not received the email invitation, go to the Registration page and
click Resend. A registration invitation will be sent your account.
3. Click the registration link. The user account is validated.
4. Complete the registration on the Sign Up page to sign in to Aruba Central.

Table 11: Registration Workflow
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If... Then...

If you are a
registered user of
Aruba Central
and have not
verified your
email yet:

The Registration page displays the following message:
You are an existing Aruba Central user. Please verify your account. Resend
Verification email.
To continue:

1. Go to your email box and check if you have received the email invitation.
2. If you have not received the email invitation, go to the Registration page and
click Resend Verification email. A registration invitation will be sent your
account.
3. Click the account activation link.
4. After the email verification is completed successfully, click Log in to access
Aruba Central.

If you are already
a registered user
of Aruba Central
and have verified
your email:

The Registration page displays the following message:
User has been registered and verified. Sign in to Central.
Click Sign in to Central to skip the registration process and access the Aruba
Central portal.

If your email
address is in the
arubanetworks.c
om or hpe.com
domain:

The Single Sign-On option is enabled. You can use your respective Aruba or HP
Enterprise credentials to log in to your Aruba Central account after the registration.

Table 11: Registration Workflow
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If... Then...

Table 11: Registration Workflow

3. To continue with registration, enter your first name, last name, company name, address, country,
state, ZIP code, and phone details.

4. Specify if you are an Aruba partner.
5. Ensure that you select an appropriate zone. TheRegistration page displays a list of zones in which

the Aruba Central servers are available for account creation. Based on the country you select, the
Aruba Central server is automatically selected. If you want your account and Aruba Central data to
reside on a server from another zone, you can select an Aruba Central server from the list of available
servers.

6. From the Interested Apps section, select the app(s) that you want to pre-provision. You must select
at least one app to continue:
n Network Operations
n ClearPass Device Insight
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See Table 10 for the app(s) available in the zone in which you are signing up.

If you are interested in evaluating the Aruba Central MSP solution, select only the Network Operations
app.

7. Select the I agree to the Terms and Conditions check box.
8. Set a preferred mode of communication for receiving notifications about Aruba products and

services.
9. Optionally, to read about the the privacy statement, click theHPE Privacy Statement link. To opt

out of marketing communication, you can either click the unsubscribe link available at the bottom of
the email or click the link as shown in the following figure:

10. Click Sign Up. Your new account is created in the zone you selected and an email invitation is sent to
your email address for account activation.

11. Access your email account and click theActivate Your Account link. After you verify your email, you
can log in to Aruba Central.

Accessing Aruba Central Portal
After you create an Aruba Central account, the link to Aruba Central portal will be sent to your registered
email address. You can use this link to log in to Aruba Central.

If you are accessing the login URL from the www.arubanetworks.com website, ensure that you select the
zone in which your account was created.

Login URLs
When you try to access Aruba Central portal, you are redirected to the Aruba Central URL that is mapped to
your cluster zone.

Regional Cluster Sign Up URL

US-1 https://portal.central.arubanetworks.com/signup

Table 12: Cluster Zone— Portal URLs

https://portal.central.arubanetworks.com/signup
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Regional Cluster Sign Up URL

US-2 https://portal-prod2.central.arubanetworks.com/signup
OR
https://signup.central.arubanetworks.com/

Canada-1 https://portal-ca.central.arubanetworks.com/signup

China-1 https://portal.central.arubanetworks.com.cn/signup

EU-1 https://portal-eu.central.arubanetworks.com/signup

APAC-1 https://portal-apac.central.arubanetworks.com/signup

APAC-EAST1 https://portal-apaceast.central.arubanetworks.com/signup

APAC-SOUTH1 https://portal-apacsouth.central.arubanetworks.com/signup

Logging in to Aruba Central
To log in to Aruba Central:

1. Access the Aruba Central login URL for your zone.
2. Notice that the zone is automatically selected based on your geographical location.
3. Enter the email address and click Continue.
4. Log in using your credentials.

If your user credentials are stored in your organization's Identity Management server and SAML SSO
authentication is enabled for your IdP on Aruba Central, complete the SSO authentication workflow.

5. Enter the password.

If you have forgotten password, you can click the Forgot Password and reset your password. The
Forgot Password link resets only your Aruba Central account; hence, it is not available to SSO users.

6. Click Continue. The Initial Setupwizard opens.
n If you have a paid subscription, click Get Started and set up your account.
n If you are a trial user, click Evaluate Now and start your trial.

Changing Your Password
To change your Aruba Central account:

1. In the Aruba Central UI, click the user icon ( ) in the header pane.
2. Click Change Password.
3. Enter a new password.
4. Log in to Aruba Central using the new password.

https://portal-prod2.central.arubanetworks.com/signup
https://signup.central.arubanetworks.com/
https://portal-ca.central.arubanetworks.com/signup
https://portal.central.arubanetworks.com.cn/signup
https://portal-eu.central.arubanetworks.com/signup
https://portal-apac.central.arubanetworks.com/signup
https://portal-apaceast.central.arubanetworks.com/signup
https://portal-apacsouth.central.arubanetworks.com/signup
https://help.central.arubanetworks.com/latest/documentation/online_help/content/nms/get-started/start_trial.htm
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The Change Password menu option is not available for federated users who sign in to Aruba Central using
their SSO credentials.

Logging Out of Aruba Central
To log out of Aruba Central:

1. In the Aruba Central UI, click the user icon ( ) in the header pane.
2. Click Logout.

Accessing Aruba Central Mobile Application
Aruba Central mobile application lets you manage, monitor, and optimize your Central account. You can log
in to your Aruba Central account using your credentials from the mobile application. To download the Aruba
Central application, visit the App Store on iOS devices running iOS 9.0 or later and Google Play Store on
Android devices running android 5.0 Lollipop or later.

About the Network Operations App User Interface
TheNetwork Operations app is one of the apps in Aruba Central that helps to manage, monitor, and
analyze your network.

Aruba offers the following variants of theNetwork Operations app user interface:

n Standard Enterprise mode— This mode is intended for customers who manage their respective
accounts end-to- end. In the Standard Enterprise mode, the customers have complete access to their
accounts. They can also provision and manage their respective accounts.

n Managed Service Provider (MSP) mode— This mode is for managed service providers who need to
manage multiple customer networks. With MSP mode enabled, the MSP administrators can provision
customer accounts, allocate devices, assign licenses, and monitor customer accounts and their networks.
The administrators can also drill down to a specific tenant account and perform administration and
configuration tasks. The tenants can access only their respective accounts, and only those features and
application services to which they have subscribed.

The following image displays the navigational elements of theNetwork Operations app in the Standard
Enterprise mode. However, the navigational elements also apply to the MSP mode.

Figure 3 Navigation Elements of the Network Operations App
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Callout
Number Description

1 Filter to select an option under Groups, Labels, Sites. For all devices, select Global. A
corresponding dashboard is displayed.

2 Item under the left navigation contextual menu. The menu is dependent on the filter selection.

3 First-level tab on the dashboard.

4 Second-level tab on the dashboard.

5 Dashboard content for the selected view and filter. For example, the current dashboard in the
image displays the UCC tab under Manage > Applications in the List view for the Global
filter.

6 Time range filter. This is displayed for selected dashboards only.

7 List view to display tabular data for the selected filter. This is displayed for selected
dashboards only.

8 Summary view to display charts for the selected filter. This is displayed for selected
dashboards only.

9 Config view to enable configuration options for the selected filter. This is displayed for
selected dashboards only.

Types of Dashboards in the Network Operations App
TheNetwork Operations app uses a filter to set the dashboard context for the app. The menu for the left
navigation pane changes according to the selected filter value. Selecting any item on the left navigation
pane displays a corresponding dashboard. Accordingly, for different values of the filter, the content
displayed for the left navigation menu and the dashboard context differs.

The dashboard for any item on the left navigation menu can have a combination of the following views:

n Summary view— Click the Summary icon to display the summary dashboard. The summary
dashboard displays a number of charts. For example, for the global dashboard, underManage, the
Overview > Network Health tab in Summary view displays a map of the available sites and their
corresponding health. If available, use the time range filter to change the time-lines for the charts.

n List view— Click the List icon to display tabular data for a selected dashboard. For example, for the
global dashboard underManage, theOverview > Network Health tab in List view displays a list of
the available sites managed by Aruba Central. If available, use the time range filter to change the time-
lines for the tabular data.

n Config view— Click the Config icon to enable the configuration options for a specific dashboard.
For example, for the global dashboard underManage, theApplications > UCC tab in Config view
displays various configuration options for UCC.
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Navigating to the Switch, Access Point, or Gateway
Dashboard
In theNetwork Operations app, you can navigate to a device dashboard for a switch, access point, or
gateway. The device dashboard enables you to monitor, troubleshoot, or configure a single device. In order
to do this, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, select one of the following options:
n To view an access point dashboard, click theAccess Points tab.
n To view a switch dashboard, click the Switches tab.
n To view a gateway dashboard, click theGateways tab.

The list of devices is displayed in List view.

3. Click a device listed underDevice Name.

The dashboard context for the specific device is displayed.

To exit the device dashboard, click the back arrow on the filter.

Workflow to Configure, Monitor, or Troubleshoot in the
Network Operations App
The following image displays a flowchart to help you navigate theNetwork Operations app to complete
any task.
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Figure 4 Navigation Workflow for Network Operations App

The Standard Enterprise Mode
This section discusses the user interface for the Standard Enterprise mode for theNetwork Operations
app. This mode is intended for customers who manage their respective accounts end-to- end. In the
Standard Enterprise mode, the customers have complete access to their accounts. They can also provision
and manage their respective accounts.

The following topics are discussed in this section:

n Launching the Network Operations App
n Parts of the Network Operations App User Interface
n Search Bar
n Help Icon
n Account Home Icon
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n User Icon
n Filter
n Time Range Filter
n Left Navigation Pane

Launching the Network Operations App
If theNetwork Operations app is the only app provisioned, theNetwork Operations app is displayed at
each user login. If there are a number of apps provisioned such asNetwork Operations, ClearPass
Device Insight and so on, theAccount Home page is displayed at each user login. From theAccount
Home page, you can manage network inventory, subscriptions, and user access.

In the event of multiple apps provisioned, perform the following steps to launch theNetwork Operations
app:

1. Log in to theAccount Home page.

TheAccount Home page displays the apps and Global Settings
For more information, see Accessing Aruba Central Portal.

2. Click Launch on theNetwork Operations tile.

TheNetwork Operations app is launched.

Figure 5 Launching the Network Operations App

Parts of the Network Operations App User Interface
After you launch theNetwork Operations app, the Standard Enterprise view is displayed.
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Figure 6 Parts of the Network Operations App

Callout
Number Description

1 Filter to select an option under Groups, Labels, or Sites. For all devices, select Global.
To select a specific device, see Navigating to the Switch, Access Point, or Gateway Dashboard.
The example in the image shows the filter set to a group called "IAP_setup_GW".
For more information, see Filter.

2 Health Bar for the selected filter.
For more information, see The Health Bar.

3 First-level tab for the selected dashboard, corresponding to the selected item in the left navigation
pane.
The example in the image shows the first-level tab selection as Gateways under Manage > Devices
for the group dashboard.

4 Search bar.
For more information, see Search Bar.

5 Help icon.
For more information, see Help Icon.

6 Account Home icon
For more information, see Account Home Icon.

7 User settings icon.
For more information, see User Icon.

8 Menu item under left navigation contextual menu.
Menu is dependent on the filter selection.
For more information, see Types of Dashboards in the Network Operations App.

9 Second-level tab for the dashboard, corresponding to the selected first-level tab.
The example in the image shows the second-level tab selection as Gateways under Manage >
Devices > Gateways for the group dashboard.

10 Icon is for filtering the data of the selected column.

11 List icon.
Click the List icon to view a tabular representation of the data.
This icon is not available for all pages.
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Callout
Number Description

12 Summary icon.
Click the Summary icon to view a graphical representation of the data.
This icon is not available for all pages.

13 Config icon.
Click the Config icon to enable configuration mode.
This icon is not available for all pages.

14 Icon is for downloading the data of the selected page in CSV format.

15 Icon is for selecting or resetting the column headers for the selected page.

Search Bar

The search bar enables users to look for help information.

Help Icon

The help icon contains the following options:

n Tutorials—Displays the Aruba Central product learning center.
n Feedback—Allows you to provide feedback on the Aruba Central. You can choose the rating from the

range of 1 to 10, where 1 being extremely unlikely and 10 being extremely likely and type your comment
into the box and click Submit to submit the feedback.

n Documentation Center—Directs you to the online help documentation.
n Get help on this page—Selecting this option changes the appearance of some of the text on the UI to

green italics. On the UI, when you point to the text in green italics, a dialog box displays the help
information for that text. To disable this option, click Done.

n Airheads Community—Directs you to the Aruba support forum at
https://community.arubanetworks.com/t5/Cloud-Managed-Networks/bd-p/CloudManagedNetworks.

n View / Update Case—Enables you to view or edit an existing support ticket in the Aruba Support Portal
at https://asp.arubanetworks.com. You must log in to this portal.

n Open New Case—Enables you to create a new support ticket in the Aruba Support Portal at
https://asp.arubanetworks.com. You must log in to this portal.

Account Home Icon

The Account Home icon enables you to go to theAccount Home page and switch to another app if you
have one subscribed. Most of the apps require service subscriptions to be enabled on the devices. Contact
your administrator or the Aruba Central Support team to obtain access to an application service.

User Icon
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The user icon enables you to view user account details such as account name, domain, customer ID, and
zone details. It also includes the following options for managing your accounts:

n Switch Customer—Enables you to switch to another account. This is especially required during
troubleshooting scenarios.

n Change Password—Enables you to change the password of the account.
n User Settings

l Time Zone—Displays the zone, date, time, and time zone of the region.

l Language—Administrators can set a language preference. The Aruba Central web interface is available in
English, French, Spanish, German, Brazilian Portuguese, Chinese, and Japanese languages.

l Idle Timeout—Administrators can set a timeout value for inactive user sessions in the Idle Timeout field.
The value is in minutes.

l Get system maintenance notifications—Administrators can select the check box to receive system
maintenance notification on their registered email ID. Email notifications are sent before any scheduled
maintenance activity or unplanned outage.

l Get software update notifications—Administrators can select the check box to receive software update
notification on their registered email ID.
n Enable MSP—Enables MSP mode and switches the user interface to the MSP mode. This option changes

to Disable MSP when the MSP mode is enabled. You can select Disable MSP to switch to the Standard
Enterprise interface. The MSP mode can be disabled only if there is no tenant data. The option is grayed
out if there are any active tenant accounts.

n Terms of Service—Displays the terms and conditions for using Aruba Central services.
n Logout—Enables you to log out of from your account.

Filter
The filter enables you to set the dashboard context to a value under one of the following options:

n Groups—Sets the dashboard context to a group of devices.
n Site s—Sets the dashboard context to all a site.
n Labels—Sets the dashboard context to a label.

If no filter is applied, by default the filter is set to Global for all devices.

Use the search box in the filter to enter an available group, site, or label name and then select the option to
set the filter.

Hovering overGroups, Labels, or Sites displays the associated config icon. Clicking on the config icon
redirects you to Maintain > Organization in the global dashboard.

Time Range Filter
The time range filter enables you to set a time duration for showing monitoring and reports data. The
option is displayed for selected dashboards only. You can set the filter to any of the following time ranges:

n 3 hours
n 1 day
n 1 week
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n 1 month
n 3 months

Left Navigation Pane
The left navigation pane is a contextualmenu that displays a number of configuration, monitoring, and
troubleshooting options depending on filter value.

The Health Bar
The Health Bar provides a snapshot of the overall health of the devices configured as part of the specific
dashboard. The applicable dashboards include global, group, site, client, and device dashboards.

The topic discusses the following:

n Health Bar for the Global Dashboard
n Health Bar for the Group Dashboard
n Health Bar for the Site Dashboard
n Health Bar for the AP Dashboard
n Health Bar for the Switch Dashboard
n Health Bar Dashboard for the Gateway Dashboard
n Health Bar for the Wireless Client Dashboard
n Health Bar for the Wired Client Dashboard

Viewing the Health Bar Dashboard
To view the Health Bar, perform the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.

A list of devices is displayed in the List view.

c. Click a device listed underDevice Name.

The dashboard context for the device is displayed.

n To select a client:
a. Set the filter to Global.
b. UnderManage, click Clients.

A list of clients is displayed in the List view.

c. Click a client listed under Client Name.

The dashboard context for the client is displayed.

The Health Bar icon displays the overall health of the network of the selected filter as either online
or offline.
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2. In the selected filter, click the Health Bar icon to expand the Health Bar dashboard.

3. Use the pin icon to pin the Health Bar dashboard to theNetwork Operations app display.

Health Bar for the Global Dashboard
The following image shows the health bar for the global dashboard.

Figure 7 Expanded but Unpinned Health Bar in the Global Dashboard

The following table includes information on the various parameters of the Health Bar displayed for a global
dashboard. The health bar in a global dashboard is in the context of all devices.

Parameter Description

Access
Points

Displays the number of access points that are online and the number of access points that are
offline.
The number in green indicates the number of access points that are online.
Clicking the number in green redirects you to Manage > Devices > Access Points > Online in
List view.
The number in red indicates the number of access points that are offline.
Clicking the number in red redirects you to Manage > Devices > Access Points > Offline in
List view.

Switches Displays the number of switches that are online and the number of switches that are offline.
The number in green indicates the number of switches that are online.
Clicking the number in green redirects you to Manage > Devices > Switches > Online in List
view.
The number in red indicates the number of switches that are offline.
Clicking the number in red redirects you to Manage > Devices > Switches > Offline in List
view.

Gateways Displays the number of gateways that are online and the number of gateways that are offline.
The number in green indicates the number of gateways that are online.
Clicking the number in green redirects you to Manage > Devices > Gateways > Online in List
view.
The number in red indicates the number of gateways that are offline.
Clicking the number in red redirects you to Manage > Devices > Gateways > Offline in List
view.

Clients Displays the number of clients that are connected and the number of clients that are failed.
The number in green indicates the number of clients that are connected.
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Parameter Description

The number in red indicates the number of clients that are failed.
Clicking the numbers redirects you to Manage > Clients > Clients in List view.

Health Bar for the Group Dashboard
The following table includes information on the various parameters of the Health Bar displayed for a group
dashboard. The health bar in a group dashboard is in the context of all devices configured as part of that
group.

Parameter Description

Access
Points

Displays the number of access points that are online and the number of access points that are
offline.
The number in green indicates the number of access points that are online.
Clicking the number in green redirects you to Manage > Devices > Access Points > Online in
List view.
The number in red indicates the number of access points that are offline.
Clicking the number in red redirects you to Manage > Devices > Access Points > Offline in
List view.

Switches Displays the number of switches that are online and the number of switches that are offline.
The number in green indicates the number of switches that are online.
Clicking the number in green redirects you to Manage > Devices > Switches > Online in List
view.
The number in red indicates the number of switches that are offline.
Clicking the number in red redirects you to Manage > Devices > Switches > Offline in List
view.

Gateways Displays the number of gateways that are online and the number of gateways that are offline.
The number in green indicates the number of gateways that are online.
Clicking the number in green redirects you to Manage > Devices > Gateways > Online in List
view.
The number in red indicates the number of gateways that are offline.
Clicking the number in red redirects you to Manage > Devices > Gateways > Offline in List
view.

Clients Displays the number of clients that are connected and the number of clients that are failed.
The number in green indicates the number of clients that are connected.
The number in red indicates the number of clients that are failed.
Clicking the numbers redirects you to Manage > Clients > Clients in List view.

Health Bar for the Site Dashboard
The following table includes information on the various parameters of the Health Bar displayed for a site
dashboard. The health bar in a site dashboard is in the context of all devices configured as part of that site.

Parameter Description

Access
Points

Displays the number of access points that are online and the number of access points that are
offline.
The number in green indicates the number of access points that are online.
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Parameter Description

Clicking the number in green redirects you to Manage > Devices > Access Points > Online in
List view.
The number in red indicates the number of access points that are offline.
Clicking the number in red redirects you to Manage > Devices > Access Points > Offline in
List view.

Switches Displays the number of switches that are online and the number of switches that are offline.
The number in green indicates the number of switches that are online.
Clicking the number in green redirects you to Manage > Devices > Switches > Online in List
view.
The number in red indicates the number of switches that are offline.
Clicking the number in red redirects you to Manage > Devices > Switches > Offline in List
view.

Gateways Displays the number of gateways that are online and the number of gateways that are offline.
The number in green indicates the number of gateways that are online.
Clicking the number in green redirects you to Manage > Devices > Gateways > Online in List
view.
The number in red indicates the number of gateways that are offline.
Clicking the number in red redirects you to Manage > Devices > Gateways > Offline in List
view.

Clients Displays the number of clients that are connected and the number of clients that are failed.
The number in green indicates the number of clients that are connected.
The number in red indicates the number of clients that are failed.
Clicking the numbers redirects you to Manage > Clients > Clients in List view.

AI Insights Displays the number of insights categorized by status.
The number in green indicates the insights impact is less than or equal to 1%.
The number in yellow indicates the insights impact is more than 1% and less than or equal to
10%.
The number in red indicates the insights impact is more than 10%.
Clicking the numbers redirects you to Manage > Overview > AI Insights in List view.

Health Bar for the AP Dashboard
The following table includes information on the various parameters of the Health Bar displayed for an AP. If
the AP is not online and running, not all of the following data is available.

Parameter Description

AP Status Value can be Online Since, Offline, or Operating under Thermal Management.
If the value is Online Since, it also displays the time period, in the format of days-hours-minutes,
for which the AP has been online and running.
When an AP operates under thermal management, the device health is displayed as Poor and
the radios are in disabled mode. For more information, see Thermal Shutdown Support in Instant
AP.

Device
Health

Displays the performance of the AP in terms of the CPU and memory usage.
For example, the device health is Good when the CPU usage is less than or equal to 70% and the
memory usage is less than or equal to 90%. If the value of the CPU and/or memory usage falls
below the threshold, the device health is displayed as Poor. If the AP is down, the value is
Offline. If the scenario is not applicable, a “-” sign is displayed.
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Parameter Description

Hover over the Device Health status to get the exact percentage value of the memory and CPU
usage.

Radio 2.4
GHz

Displays the performance of the AP in terms of the channel utilization and noise floor in the 2.4
GHz channel.
For example, the device health is Good when the channel utilization is less than or equal to 70%
and the noise floor is less than or equal to -80 dBm. If the value of the channel utilization and
noise floor falls below the threshold, the device health is displayed as Poor. If the AP is online, but
the radio is down, the value displayed is Disabled. If the scenario is not applicable, a “-” sign is
displayed.
Hover over the Radio 2.4 GHz status to get the exact value of the channel utilization and noise
floor.

Radio 5
GHz

Displays the performance of the AP in terms of the channel utilization and noise floor in the 5
GHz channel.
For example, the device health is Good when the channel utilization is less than or equal to 70%
and the noise floor is less than or equal to -80 dBm. If the value of the channel utilization and
noise floor falls below the threshold, the device health is displayed as Poor If the AP is online, but
the radio is down, the value displayed is Disabled. If the scenario is not applicable, a “-” sign is
displayed.
Hover over the Radio 5 GHz status to get the exact value of the channel utilization and noise
floor.

Radio 5
GHz
(Secondary)

Displays the performance of the AP in terms of the channel utilization and noise floor in the 5
GHz (Secondary) channel.
For example, the device health is Good when the channel utilization is less than or equal to 70%
and the noise floor is less than or equal to -80 dBm. If the value of the channel utilization and
noise floor falls below the threshold, the device health is displayed as Poor. If the AP is online, but
the radio is down, the value displayed is Disabled. If the scenario is not applicable, a “-” sign is
displayed.
Hover over the Radio 5 GHz (Secondary) status to get the exact value of the channel utilization
and noise floor.

NOTE: In the Health Bar dashboard, the Radio 5 GHz (Secondary) data is available only for AP-
555 and only if the tri-radio mode is enabled. For more information, see About Tri-Radio Mode.

Virtual
Controller

Indicates if the AP is connected to a virtual controller. If the AP is connected, clicking on the
virtual controller name redirects you to the Manage > Overview > Summary page for the virtual
controller.

Health Bar for the Switch Dashboard
The following table includes information on the various parameters of the Health Bar displayed for a switch.
If the switch is not online and running, not all of the following data is available.

Parameter Description

Switch
Status

Displays the time period for which the switch has been online and running or its offline status.

Device
Health

Displays the performance of the switch in terms of the CPU and memory usage.
For example, the device health is Good when the CPU usage is less than or equal to 70% and the
memory usage is less than or equal to 70%. If the value of the CPU and/or memory usage falls
below the threshold, the device health is displayed as Poor.
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Parameter Description

Hover over the Device Health status to get the exact percentage value of the memory and CPU
usage.

Port -
Status

Displays the number of ports on the switch that are online and the number of ports that are
offline.
The number in green indicates the number of switch ports that are online.
The number in red indicates the number of switch ports that are offline.

Port -
Alerts

Displays the total number of open alerts.

Health Bar Dashboard for the Gateway Dashboard
The following table includes information on the various parameters of the Health Bar displayed for a
gateway. If the gateway is not online and running, not all of the following data is available.

Parameter Description

Gateway
Status

Displays the time period, in the format of days-hours-minutes, for which the gateway has been
running or its offline status.

WAN Displays the number of WAN ports as online or offline.
The number in green indicates the number of WAN ports that are online.
The number in red indicates the number of WAN ports that are offline.
Clicking the numbers redirects you to Manage > WAN > Summary.

LAN Displays the number of LAN ports as online or offline.
The number in green indicates the number of LAN ports that are online.
The number in red indicates the number of LAN ports that are offline.
Clicking the numbers redirects you to Manage > LAN > Summary.

Tunnels Displays the number of VPN tunnels as online or offline.
The number in green indicates the number of VPN tunnels that are online.
The number in red indicates the number of VPN tunnels that are offline.
Clicking the numbers redirects you to Manage > WAN > Tunnels.

Path
Steering

Displays the number of path steering policies that are compliant of the total number of policies.
Clicking the numbers redirects you to Manage > WAN > Path Steering.

Alerts Displays the total number of open alerts.
Clicking the number redirects you to Analyze > Alerts & Events in List view.

Health Bar for the Wireless Client Dashboard
The following table includes information on the various parameters of the Health Bar displayed for a
wireless client.

Parameter Description

Client Status Displays the connection status of the client.
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Parameter Description

Device
Health

Displays the device health of the client.

Signal
Quality

Displays the signal quality in dB.

Tx | Rx Rate Displays the transmit and receive rate in Mbps.

Connected To Displays the device to which the wired client is connected.
Clicking on the device redirects you to the Manage > Overview > Summary page for that
device.

Refresh icon Refreshes the data on the Health Bar for the client.

Health Bar for the Wired Client Dashboard
The following table includes information on the various parameters of the Health Bar displayed for a wired
client.

Parameter Description

Client Status Displays the connection status of the client.

Connected
Port

Displays the port to which the client is connected.

Connected To Displays the device to which the wired client is connected.
Clicking on the device redirects you to the Manage > Overview > Summary page for that
device.

Refresh icon Refreshes the data on the Health Bar for the client.

This topic discusses the Network Operations app in MSP mode. To know more about the Account Home page,
see the online Aruba Central documentation.

The MSP mode is intended for the managed service providers who manage multiple distinct tenant
accounts. The MSP mode allows MSP customers to provision and manage tenant accounts, assign devices to
tenant accounts, manage subscription keys and other functions such as configuring network profiles and
viewing alerts.

The following topics are discussed:

n Launching the Network Operations App for MSP
n Parts of the Network Operations App for MSP
n Help Icon
n Account Home Icon
n User Icon
n Filter
n Time Range Filter
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n The Global Dashboard in MSP Mode
n The Group Dashboard in MSP Mode

Launching the Network Operations App for MSP
Aruba Central in MSP mode consists of theNetwork Operations app and theAccount Home page.

After you create an Aruba Central account, the link to Aruba Central portal will be sent to your registered
email address. You can use this link to log in to Aruba Central. If you are accessing the login URL from the
www.arubanetworks.com website, ensure that you select the zone in which your account was created. The
Network Operations app is displayed at each user login to Aruba Central.

From theNetwork Operations app, you can navigate to theAccount Home page by clicking the

Account Home icon .
From theAccount Home page, you can navigate to theNetwork Operations app by clicking the Launch
button for theNetwork Operations tile.

Figure 8 Launching the Network Operations App for MSP from Account Home

Parts of the Network Operations App for MSP
After you launch theNetwork Operations app, the MSP view opens.
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Figure 9 Parts of the Aruba Central User Interface for MSP

Callout
Number Description

1 Filter to select a group or all groups.
For more information, see Filter.
Here, the global dashboard is displayed as the filter is set to All Groups.

2 Menu item under left navigation contextual menu. Menu is dependent on the filter selection.

3 First-level tab on dashboard. The dashboard may also have second and third-level tabs
dependent on the filter selection.

4 Help icon.
For more information, see Help Icon.

5 Account Home icon.

6 User Settings icon.
For more information, see User Icon.

7 List view.
Click the List icon to view a tabular representation of the data. Only applicable for the global
dashboard.

8 Summary view.
Click the Summary icon to view a graphical representation of the data. Only applicable for the
global dashboard.

9 Config view.
Click the Config icon to enable configuration mode.

Help Icon

The help icon contains the following options:

n Get help on this page— Selecting this option changes the appearance of some of the text on the UI to
green italics. On the UI, when you point to the text in green italics, a dialog box displays the help
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information for that text. To disable this option, click Done.
n Tutorials— Displays the Aruba Central product learning center.
n Feedback— Allows you to provide feedback on the Aruba Central. You can choose the rating from the

range of 1 to 10, where 1 being extremely unlikely and 10 being extremely likely and type your comment
into the box and click Submit to submit the feedback.

n Documentation Center— Directs you to the online help documentation.
n Airheads Community— Directs you to the Aruba support forum.
n View / Update Case— Enables you to view or edit an existing support ticket in the Aruba Support Portal

at https://asp.arubanetworks.com. You must log in to this portal.
n Open New Case— Enables you to create a new support ticket in the Aruba Support Portal at

https://asp.arubanetworks.com. You must log in to this portal.

Account Home Icon

The Account Home icon enables you to go to theAccount Home page.

User Icon
The user icon enables you to view user account details such as account name, domain, customer ID, and
zone details. It also includes the following options for managing your accounts:

n Switch Customer— Enables you to switch to another account. This is especially required during
troubleshooting scenarios.

n Change Password— Enables you to change the password of the account.
n User Settings

l Time Zone— Displays the zone, date, time, and time zone of the region.

l Language— Administrators can set a language preference. The Aruba Central web interface is available in
English, French, Spanish, German, Brazilian Portuguese, Chinese, and Japanese languages.

l Idle Timeout— Administrators can set a timeout value for inactive user sessions in the Idle Timeout field.
The value is in minutes.

l Get system maintenance notification— Administrators can select the check box to get system
maintenance notification.

l Get software update notifications— Administrators can select the check box to get software update
notification.
n Disable MSP— Disables MSP mode and switches the user interface to the standard enterprise mode.

This option changes to Enable MSP when the MSP mode is disabled. You can select Enable MSP to
switch to the MSP mode. The MSP mode can be disabled only if there is no tenant data. The option is
grayed out if there are any active tenant accounts.

n Terms of Service— Displays the terms and conditions for using Aruba Central services.
n Logout— Enables you to log out of from your account.

Filter
The filter enables you to select by a group orAll Groups for performing specific configuration and
monitoring tasks. If no filter is applied, by default the filter is set to All Groups. When you set the filter to
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All Groups, the Global dashboard is displayed and when you set the filter to a group, the group dashboard
is displayed.

Time Range Filter
The time range filter enables you to set a time duration for showing monitoring and reports data. This
time filter is not displayed when you view the configuration or device details. It is displayed only when you
view monitoring data. You can set the filter to any of the following time ranges:

n 3 hours
n 1 day
n 1 week
n 1 month
n 3 months

The Global Dashboard in MSP Mode
In theNetwork Operations app in MSP mode, use the filter to select All Groups. The global dashboard is
displayed.

In the global dashboard under the left navigation pane, you can see a number of menu items divided under
the following categories: Manage,Analyze, and Maintain.

Figure 10 Launching the Global Dashboard for MSP

Selecting each menu item in the left navigation pane displays a corresponding dashboard with tabs. Each
tab may support all or some of the following functions:

n Summary— Click the icon to view a graphical representation of the data. Only applicable for the global
dashboard.
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n List— Click the icon to view a tabular representation of the data. Only applicable for the global
dashboard.

n Config— Click the icon to enable configuration mode.

The Group Dashboard in MSP Mode
In theNetwork Operations app in MSP mode, use the filter to select a group. The group dashboard is
displayed.

Figure 11 Launching the Group Dashboard for MSP

Some tabs or options may not be seen in your dashboard view if you are not an administrator for the Aruba
Central account.

In the group dashboard under the left navigation pane, you can see theDevice and Guest options under
Manage.

Selecting an option in the left navigation pane displays a corresponding dashboard with tabs. Each tab
supports theConfig view that enables the configuration mode. The next sections discuss the left navigation
menu items in the group dashboard.

Starting Your Free Trial
Aruba Central offers a 90-day evaluation subscription for customers who want to try the solution for
managing their networks.

The evaluation subscription allows you to use the following functions:

Application Function

Network Operations n Device management
lManage up to 10 Instant APs and/or switches
lManage up to two SD-WAN Gateways

n Monitoring—Monitor your devices, network and client status
n Guest Access—Set up guest Wi-Fi on your custom portals

Table 13: Evaluation features
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Application Function

n Presence Analytics—Analyze consumer presence data for your stores
n Troubleshooting—Run diagnostic checks and troubleshoot device issues

ClearPass Device
Insight

Discover, monitor, and automatically classify new and existing devices that connect to
a network.

Figure 12 shows the steps required for getting started with your free trial.

Figure 12 Getting Started Workflow for Free Trial

Get Started with the Free Trial
Complete the following steps to evaluate Aruba Central:

n Step 1: Getting Started with the Initial Setup on page 64
n Step 2: Adding Devices on page 65
n Step 3: Organize Your Devices into Groups on page 65
n Step 4: Assigning Sites and Labels (Optional) on page 66
n Step 5: Configure Your Network on page 66
n Step 6: Monitor Your Network and Devices on page 67
n Step 7: Evaluate Value Added Services (Optional) on page 67
n Step 8: Cancel or Upgrade Your Subscription (Optional)

Step 1: Getting Started with the Initial Setup
To get started with the trial:

1. Register for evaluating Aruba Central.
2. Log in to Aruba Central.

n If you signed up to evaluate only theNetwork Operations app, theWelcome to Aruba
Central page is displayed.

l Click Evaluate Now. TheGet Started With Aruba Central page guides you through the
onboarding steps.

l Click through the steps to set up your account and start using Aruba Central. If you want to exit the
wizard and complete the onboarding steps on your own, click Exit Workflow.

The Initial Setup wizard is displayed only when you log in to Aruba Central for the first time. The
wizard is not available for Aruba Central users in the MSP mode.

n If you signed up to evaluate both Network Operations and ClearPass Device Insight, the
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Network Operations page is displayed.

For more information, see ClearPass Device Insight Information Center.

Step 2: Adding Devices
To manage devices from Aruba Central, trial users must manually add the devices to Aruba Central's device
inventory.

You can add up to 10 devices. The devices can be 10 Instant APs or 10 Switches, or a total of 10 Instant APs
and switches.

Use one of the following methods to add devices to Aruba Central:

Using the Initial Setup Wizard
1. In theAdd Devices tab of the Initial Setup wizard, click Add Device.
2. Enter the serial number of MAC address of your devices.

You can find the serial number and MAC address of Aruba devices on the front or back of the
hardware.

3. Click Done.
4. Review the devices in your inventory.

Using the Device Inventory Page
1. In theAccount Home page, underGlobal Settings, click Device Inventory.

TheDevice Inventory page is displayed.

2. Click Add Devices.

TheAdd Devices pop-up window is displayed.

3. Enter the serial number and the MAC address of each device.

You can find the serial number and MAC address of Aruba devices on the front or back of the
hardware.

4. Click Done.
5. Review the devices in your inventory.

Step 3: Organize Your Devices into Groups
A group in Aruba Central functions as a configuration container for devices added in Aruba Central.

Why Should You Use Groups?

Groups allow you to create a logical subset of devices and simplify the configuration and device
management tasks. Groups offer the following functions and benefits:

n Combining different types of devices under a group. For example, a group can have Instant APs and
Switches. Aruba Central allows you to manage configuration of these devices in separate containers
(wireless and wired management) within the same group. Any new device that is added to a group
inherits the current configuration of the group.

n Assigning multiple devices to a single group. For example, a group can consist of multiple Instant AP
Virtual Controllers (VCs). These VCs can share common configuration settings and push the configuration

https://www.arubanetworks.com/website/techdocs/ClearPassDeviceInsight/1.0.3/content/home.htm
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updates to slave Instant AP in their respective clusters. For example, you can apply a common security
policy for the devices deployed in a specific geographical location.

n Cloning an existing group allows you to create a base configuration for the devices and customize it as
per your network requirements.

You can also use groups for filtering your monitoring dashboard content, generating reports, and managing
software upgrades.

A device can be part of only one group at any given time.
Groups in Aruba Central are mutually exclusive (independent) and do not follow a hierarchical model.

For more information on groups and group configuration workflows, see Groups for Device Configuration
and Management on page 118.

Assigning Devices to Groups

After you successfully complete the onboarding workflow, the Initial Setupwizard prompts you to assign
your devices to a group. You can click Assign Group and assign your devices to a group. You can also use
one of the following methods to assign your devices to groups.

To assign a device to a group, in theAccount Home page, underGlobal Settings, click Device Inventory:

1. Select the device that you want to assign to a group.
2. Click Assign Group. TheAssign Group pop-up window opens.
3. Select the group to which you want to assign.
4. Click Assign Device(s).

To assign a device to a group from the Groups page:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. From the devices table on the right, select the device that you want to assign to a new group.
4. Drag and drop the device to the group to which you want to assign the device.

Step 4: Assigning Sites and Labels (Optional)
A site in Aruba Central refers to a physical location where a set of devices are installed; for example, campus,
branch, or venue. Aruba Central allows you to use sites as a primary navigation element. For example, if
your devices are deployed in a campus, you can create a site called CampusA. You can also tag the devices
within CampusA using labels. If your campus consists of multiple buildings, the devices deployed in the
campus can be labeled asBuilding1 or Lobby.

For more information on sites and labels and how to assign devices to sites and labels, see Managing Sites
on page 140 and Managing Labels on page 143.

Step 5: Configure Your Network
If you have added Instant APs as part of your evaluation, you can configure an employee and guest wireless
network. If you have Switches or SD-WAN Gateways, configure wired access network or SD-WAN
respectively.
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Step 6: Monitor Your Network and Devices
Use monitoring dashboards to view the health of the device and network.

You can also run reports, configure alerts, and view client details.

Step 7: Evaluate Value Added Services (Optional)
Enable Presence Analytics and Guest Access services on your Instant APs and review these services.

Step 8: Cancel or Upgrade Your Subscription (Optional)
During the trial period or after you complete your trial, if you want to continue using Aruba Central for
managing your devices, contact Aruba Customer Support to upgrade your subscription.

If you do not want to continue, contact Aruba support team to cancel your subscription or wait until the
trial expires. When the trial period expires, your devices can no longer be managed from Aruba Central.

Upgrading to a Paid Account
If you have purchased a subscription, upgrade your account by completing the following steps:

1. On the respective app, click the link that shows the number of days left for the evaluation to expire:

TheAdd a New Subscription pop-up window opens.

2. Enter the new subscription key that you purchased from Aruba.
3. Click Add Subscription.

After you upgrade your account, you can add more devices and enable services, and continue using Aruba
Central.

Configuring Email Notifications for Software
Upgrades
Aruba Central administrators would receive email notifications before software upgrades, scheduled
maintenance activity, or any unplanned outage. By default, email notifications are enabled. The banner is
updated in the Aruba Central UI seven days before the upgrade and an email notification is sent 72 hours
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before the upgrade. In case of an unplanned outage, an email notification is sent immediately and the
banner is also updated immediately in the Aruba Central UI. 

The email notification contains the following details:

n Start date and time.
n Estimated end date and time.
n Link to theWhat's New page where users can view the list of new features and enhancements included

in the release.
n Impact of the outage.

Users can no longer check the status of Aruba Central using the following URLs:

n US—http://status.central.arubanetworks.com
n Canada—http://ca-status.central.arubanetworks.com
n APAC—http://apac-status.central.arubanetworks.com
n APAC East—http://apaceast-status.central.arubanetworks.com
n Europe—http://eu-status.central.arubanetworks.com

Enabling Email Notifications
By default, email notifications are enabled. However, if email notifications are disabled and you wish to
enable system maintenance or software update email notifications, complete the following steps:

1. In the Aruba Central UI, click the user icon ( ) in the header pane.
2. Click User Settings.
3. In theUser Settings pop-up window, do the following:

a. Select theGet system maintenance notifications check box to receive system maintenance
notification on the registered email ID. Email notifications are sent before any scheduled
maintenance activity or unplanned outage.

b. Select theGet software update notifications check box to receive software update
notification on the registered email ID.

4. Click Save.

http://status.central.arubanetworks.com/
http://ca-status.central.arubanetworks.com/
http://apac-status.central.arubanetworks.com/
http://apaceast-status.central.arubanetworks.com/
http://eu-status.central.arubanetworks.com/
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Figure 13 Email Notifications

Configuring Idle Timeout
Aruba Central allows you to set a timeout value for inactive user sessions. The value is in minutes and is the
amount of time a user can be inactive before the user's session times out and closes.

To configure idle timeout, complete the following steps:

1. In the Aruba Central UI, click the user icon ( ) in the header pane.
2. Click User Settings.
3. In theUser Settings pop-up window, enter the timeout value in the Idle Timeout field. The value

must be within the range of 5 to 10080 minutes.
4. Click Save.

Setting up Your Aruba Central Instance
If you have purchased a subscription key to manage your devices and networks from Aruba Central, get
started with steps described in this topic.

Figure 14 illustrates the steps required for setting up your Aruba Central instance:

Figure 14 Getting Started Workflow

Getting Started with Aruba Central
Complete the following steps to start using Aruba Central for managing your devices and setting your
networks.
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n Step 1: Getting Started on page 70
n Step 2: Adding a Subscription Key on page 70
n Step 3: Adding Devices on page 70
n Step 4: Assigning Subscriptions on page 73
n Step 5: Organize Your Devices into Groups on page 74
n Step 6: Assigning Sites and Labels (Optional) on page 75
n Step 7: Configuring Users on page 75
n Step 8: Configuring and Managing Networks on page 75
n Step 9: Monitoring Your Network and Devices on page 75
n Step 10: Upgrading Software Images on Devices on page 75
n Step 11: Running Diagnostic Checks and Troubleshooting Issues on page 75

Step 1: Getting Started
To get started:

1. Sign up to create your Aruba Central account.
2. If you already have an Aruba Central account, log in to Aruba Central with your credentials. When you

log in for the first time, the Initial Setupwizard opens and guides you through the onboarding
workflow.

3. Click Get Started.
4. Click through the wizard to complete the onboarding workflow. If you want to exit the wizard and

complete the onboarding steps on your own, click Exit and go to Aruba Central.

The Initial Setup wizard is displayed only when you log in to Aruba Central for the first time. The wizard is not
available for Aruba Central users in the MSP mode.

Step 2: Adding a Subscription Key
At your first login, the Initial Setupwizard prompts you add your subscription key. To continue with the
onboarding workflow, add your subscription key in the Add Subscription Key tab.

If you are not using the wizard, complete the following steps to add your subscription key.

To add a subscription key:

1. In theAccount Home page, underGlobal Settings, click Key Management.
TheKey Management page is displayed.

2. Enter your subscription key.
3. Click Add Subscription. The subscription key is added to Aruba Central and the contents of the

subscription key are displayed in theManage Keys table.
4. Review the subscription details.

Step 3: Adding Devices
If you have a paid subscription, you can automatically import devices from the Activate database to the
Aruba Central device inventory.
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Setting up Device Sync for Automatic Device Addition
To set up device sync, use one of the following methods:

n In the Initial Setup Wizard
n From the Device Inventory Page

In the Initial Setup Wizard
1. Ensure that you have added a subscription key and click Next.
2. In theAdd Devices tab, enter the serial number and MAC address of one device from your purchase

order.

Most Aruba devices have the serial number and MAC address on the front or back of the hardware.

3. Click Add Device. Aruba Central imports all other devices mapped to your purchase order.
4. Review the devices in your inventory.
5. Perform the following options:

n Add Devices Manually—Manually add devices by entering the MAC address and serial number
of each device.

n Add Via Mobile App—Add devices from the Aruba Central mobile app. You can download the
Aruba Central app from Apple App Store on iOS devices and Google Play Store on Android devices.

n Contact support—Contact Aruba Technical Support.

From the Device Inventory Page
1. In theAccount Home page, underGlobal Settings, click Device Inventory.

TheDevice Inventory page is displayed.
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Aruba Central imports only devices associated with your Central account from Activate.

2. Do one of the following:
n Click Sync Devices. Enter the serial number and MAC address and click Add Device.
n Click Add Devices to manually add devices by entering the MAC address and serial number of

each device.
n If you are a paid subscriber, you can add devices using a CSV file. Click Import Via CSV and select

the CSV file. For a sample CSV file, click Download sample CSV file.

Manual addition of devices using a CSV file is restricted to 100 devices or to the number of available
device management tokens. An error message is displayed if more than 100 devices are imported
using the CSV file. You can view the status of the CSV upload in the Account Home > Audit Trail page.

3. Review the devices in your inventory.
4. Perform the following options:

n Add Devices Manually—Manually add devices by entering the MAC address and serial number
of each device.

n Add Via Mobile App—Add devices from the Aruba Central mobile app. You can download the
Aruba Central app from Apple App Store on iOS devices and Google Play Store on Android devices.

n Contact support—Contact Aruba Technical Support.

Manually Adding Devices
To add devices using MAC address and serial number, use one of the following methods:

n In the Initial Setup Wizard
n From the Device Inventory Page

In the Initial Setup Wizard
If you are using the Initial Setup wizard:

1. In theAdd Devices tab of the Initial Setup wizard.
2. Click Add Device.
3. Enter the serial number of MAC address of your device.
4. Click Done.
5. Review the list of devices.

From the Device Inventory Page
To add devices from theDevice Inventory page:

1. In theAccount Home page, underGlobal Settings, click Device Inventory.

TheDevice Inventory page is displayed.

2. Do one of the following:
n Click Add Devices to manually add devices by entering the MAC address and serial number of

each device.
n If you are a paid subscriber, you can add devices using a CSV file. Click Import Via CSV and select

the CSV file. For a sample CSV file, click Download sample CSV file.



Setting up Your Aruba Central Instance | 73

Manual addition of devices using a CSV file is restricted to 100 devices or to the number of available
device management tokens. An error message is displayed if more than 100 devices are imported
using the CSV file. You can view the status of the CSV upload in the Account Home > Audit Trail
page.

3. Click Done.
4. Review the devices added to the inventory.

When you add the serial number and MAC address of one AP from a cluster or a switch stack member,
Aruba Central imports all devices associated in the AP cluster and switch stack respectively.

For more information on adding devices, see Onboarding Devices on page 91.

Step 4: Assigning Subscriptions
Aruba Central supports the following types of subscriptions:

n Device Management subscriptions—Allows you to manage and monitor your Access Points and Switches
from Aruba Central. The device management subscriptions can be assigned only to the devices managed
by Aruba Central.

n Services Management subscriptions—Allows you to enable value-added services on the APs managed
from Aruba Central.

n Gateway subscriptions—Allows you to manage and monitor SD-WAN Gateways from Aruba Central.

You can either enable automatic assignment of subscription or manually assign subscriptions to your
devices. By default, the automatic subscription assignment is disabled.

Enabling Automatic Assignment of Subscriptions

Use one of the following options to enable automatic assignment of subscriptions:

In the Initial Setup Wizard

1. Verify that you have a valid subscription key.
2. Ensure that you have successfully added your devices to the device inventory.
3. In theAssign Subscription tab, turn on theAuto Subscribe toggle switch.

From the Subscription Assignment Page

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
2. UnderDevice Subscriptions, toggle theAuto Subscribe slider to ON. All the devices in your

inventory are selected for automatic assignment of subscriptions. You can edit the list by clearing the
existing selection and re-selecting devices.

Manually Assigning Subscriptions

In the Initial Setup Wizard

1. In theAssign Subscription tab, ensure that theAuto Subscribe toggle switch is turned off.
2. Select the devices in the list for which you want to manually assign subscriptions.
3. Click Update Subscription.
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From the Subscription Assignment Page

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
2. On the Subscription Assignment page, ensure that theAuto Subscribe toggle is turned off.
3. Select the devices to which you want to assign subscriptions.
4. Click Update Subscription.

For more information on subscriptions and how to assign network service and SD-WAN Gateway
subscriptions. see Managing Subscriptions on page 98.

Step 5: Organize Your Devices into Groups
A group in Aruba Central functions as a configuration container for devices added in Aruba Central.

Why Should You Use Groups?

Groups allow you to create a logical subset of devices and simplify the configuration and device
management tasks. Groups offer the following functions and benefits:

n Combining different types of devices under a group. For example, a group can have Instant APs and
Switches. Aruba Central allows you to manage configuration of these devices in separate containers
(wireless and wired management) within the same group. Any new device that is added to a group
inherits the current configuration of the group.

n Assigning multiple devices to a single group. For example, a group can consist of multiple Instant AP
Virtual Controllers (VCs). These VCs can share common configuration settings and push the configuration
updates to slave Instant AP in their respective clusters. For example, you can apply a common security
policy for the devices deployed in a specific geographical location.

n Cloning an existing group allows you to create a base configuration for the devices and customize it as
per your network requirements.

You can also use groups for filtering your monitoring dashboard content, generating reports, and managing
software upgrades.

A device can be part of only one group at any given time.
Groups in Aruba Central are mutually exclusive (independent) and do not follow a hierarchical model.

For more information on groups and group configuration workflows, see Groups for Device Configuration
and Management on page 118.

Assigning Devices to Groups

After you successfully complete the onboarding workflow, the Initial Setupwizard prompts you to assign
your devices to a group. You can click Assign Group and assign your devices to a group. You can also use
one of the following methods to assign your devices to groups.

To assign a device to a group, in theAccount Home page, underGlobal Settings, click Device Inventory:

1. Select the device that you want to assign to a group.
2. Click Assign Group. TheAssign Group pop-up window opens.
3. Select the group to which you want to assign.
4. Click Assign Device(s).
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To assign a device to a group from the Groups page:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. From the devices table on the right, select the device that you want to assign to a new group.
4. Drag and drop the device to the group to which you want to assign the device.

Step 6: Assigning Sites and Labels (Optional)
A site in Aruba Central refers to a physical location where a set of devices are installed; for example, campus,
branch, or venue. Aruba Central allows you to use sites as a primary navigation element. For example, if
your devices are deployed in a campus, you could create a site called CampusA. You can also tag the devices
within CampusA using labels. If your campus consists of multiple buildings, the devices deployed in the
campus can be labeled asBuilding1 or Lobby.

For more information on sites and labels and how to assign devices to sites and labels, see Managing Sites
on page 140 and Managing Labels on page 143.

Step 7: Configuring Users
Add system users, assign user roles, and configure role based access control.

For more information, see Configuring System Users on page 102.

Step 8: Configuring and Managing Networks
To start configuring your network setup:

1. Connect your devices to Aruba Central.
2. Provision Instant APs, Switches, or Gateways to set up your WLAN, wired access and SD-

WAN network.

Step 9: Monitoring Your Network and Devices
Use the monitoring dashboards to view the health of the device and network.

You can also run reports, configure alerts, and view client details.

Step 10: Upgrading Software Images on Devices
View software images available for the devices provisioned in your account, run a compliance check for the
recommended software version, and upgrade devices.

For more information and step-by-step instructions, see Managing Software Upgrades on page 160.

Step 11: Running Diagnostic Checks and Troubleshooting Issues
Run diagnostic checks and troubleshooting commands to analyze network connectivity and latency issues
and debug device issues if any. For more information and step-by-step instructions, see Using
Troubleshooting Tools.

Using the Search Bar
The search tool in theNetwork Operations app enables users to search for clients, devices, and
infrastructure connected to the network. The tool also retrieves relevant documentation to help users
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efficiently operate their networks. The search engine uses Natural Language Processing (NLP) to analyze
queries and return relevant search results. From the search results, users can navigate to:

n Various pages in theNetwork Operations app such as configuration pages, client or device monitoring
dashboards, or troubleshooting pages.

n Help page in the Aruba Central Help Center.

To activate the search bar in the Aruba Central UI, press / (forward slash) on your computer keyboard.

Figure 15 Search Bar

Client Search Terms
The following table provides a list of recommended client search terms with the corresponding search
results. Based on the displayed results, users can:

n Hover over a client to view more details.
n Click the client name to open theClient Details page.
n Click View to open the corresponding page in Aruba Central. For example, clicking theView button

corresponding to High DHCP Failures opens theAI Insights dashboard.

Typical
Queries Search Terms Result

View client(s)
facing issues in
the network

n client issues
n client anomalies
n problem clients

Returns client(s) that failed to connect and client(s)
experiencing issues such as high DHCP failures, authentication
failures, high roaming latency, and so on.

View failed client
(s)

n client failures
n failed clients

Returns client(s) that failed to connect to the network.

View client(s)
running Windows
operation system

list windows clients Returns a list of client(s) running Windows operation system.

View client(s)
running Android
operation system

list android clients Returns a list of client(s) running Android operation system.

View client(s) in a
site

Enter list clients in site
followed by the site
name.
Example—list clients in
site California

Returns a list of all client(s) in the site.

View offline client
(s) in a site

Enter show offline
clients in site followed
by the site name.

Returns a list of offline client(s) in the site.

Table 14: Client Search Terms
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Typical
Queries Search Terms Result

Example—show offline
clients in site California

View connected
client(s) in a
particular site

Enter show connected
clients in site followed
by the site name.
Example—show
connected clients in
site California

Returns a list of connected client(s) in the site.

Search by client
name

Enter the name of the
client.
Example—myipad

Returns the client whose name matches the search term.

Search by client
MAC address

Enter client followed by
the MAC address.
Example—client
00:01:00:10:9f:20

Returns the client whose MAC address matches the search
term.

Table 14: Client Search Terms

Device Search Terms
The following table provides a list of recommended search terms for all device types, with the corresponding
search results. Based on the displayed results, users can:

n Hover over a device to view more details.
n Click the device name to open the correspondingDevice Details page.
n Click View to open the corresponding page in Aruba Central. For example, clicking theView button

corresponding to Alerts & Events Overview opens theAlerts & Events page.

Typical Queries Search Terms Result

Access Point

View AP(s) facing issues in the
network

n AP issues
n AP anomalies
n problem APs

Returns a list of AP(s) that are offline, AP
radios changing channels more frequently, AP
(s) experiencing higher than normal channel
utilization, AP(s) experiencing frequent
transmit power changes, and AP(s) that
missed sending telemetry data, and so on.

View AP(s) in a site Enter list aps in site or
show aps in site
followed by the site
name.
Example—list aps in
site California

Returns a list of AP(s) in the site.

View a list of online AP(s) online aps Returns a list of AP(s) that are online.

Table 15: Device Search Terms
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Typical Queries Search Terms Result

View AP(s) belonging to a group Enter list aps in group
followed by group name.
Example—list aps in
group default

Returns a list of AP(s) that are belonging to the
group.

View AP(s) tagged with a
particular label

Enter list aps in label
followed by the label
name.
Example—list aps in
label lobby

Returns a list of AP(s) that are tagged with the
label.

View AP(s) by model number Enter show ap model
followed by the model
number.
Example—show ap
model ap-105

Returns a list of AP(s) whose model number
matches the search term.

Search by AP name Enter the name of the
AP.
Example—printer-room

Returns the AP whose name matches the
search term.

Search by AP MAC address Enter ap followed by the
MAC address.
Example—ap
94:b4:0f:d9:ba:cc

Returns the AP whose MAC address matches
the search term.

Search by AP serial number Enter ap serial followed
by the serial number.
Example—ap serial
CNJJKPN1G5

Returns the AP whose serial number matches
the search term.

Switch

View switch(es) facing issues in
the network

n switch issues
n switch anomalies
n problem
switches

Returns a list of switch(es) that are offline,
switch(es) experiencing high CPU and memory
utilization, switch(es) facing PoE issues, and so
on.

View switch(es) in a site Enter list switches in
site or show switches
in site followed by the
site name.
Example—list switches
in site California

Returns a list of switch(es) in the site.

View a list of online switch(es) online switches Returns a list of switch(es) that are online.

View switch(es) belonging to a
group

Enter list switches in
group followed by group
name.
Example—list switches
in group default

Returns a list of switch(es) belonging to the
group.

View switch(es) tagged with a
label

Enter list switches in
label followed by the
label name.

Returns a list of switch(es) that are tagged with
the label.

Table 15: Device Search Terms
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Typical Queries Search Terms Result

Example—list switches
in label store

Search by switch name Enter the name of the
switch.
Example—store-switch

Returns the switch whose name matches the
search term.

Search by switch MAC address Enter switches followed
by the MAC address.
Example—switch
f8:60:f0:b6:22:00

Returns the switch whose MAC address
matches the search term.

Search by switch serial number Enter switch serial
followed by the serial
number.
Example—switch serial
CN90HKX045

Returns the switch whose serial number
matches the search term.

Gateway

View gateway(s) facing issues in
the network

n gateway issues
n gateway
anomalies
n problem
gateways

Returns a list of gateway(s) that are down,
gateway(s) experiencing high CPU and
memory utilization, gateway tunnel(s) that are
down, and so on.

View gateway(s) in a site Enter list gateways in
site or show gateways
in site followed by the
site name.
Example—list gateways
in site California

Returns a list of gateway(s) in the site.

Configure gateway(s) in a
particular group

Enter configure
gateways in group
followed by the site
name.
Example—configure
gateways in group
default

Returns a link to the gateway configuration
page.

View a list of online gateway(s) online gateways Returns a list of gateway(s) that are online.

View gateway(s) belonging to a
group

Enter list gateways in
group followed by group
name.
Example—list gateways
in group default

Returns a list of gateway(s) belonging to the
group.

View gateway(s) tagged with a
label

Enter list gateways in
label followed by the
label name.
Example—list gateways
in label lobby

Returns a list of gateway(s) that are tagged
with the label.

Table 15: Device Search Terms
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Typical Queries Search Terms Result

Search by gateway name Enter the name of the
gateway.
Example—branch

Returns the gateway whose name matches the
search term.

Search by gateway MAC address Enter gateway followed
by the MAC address.
Example—gateway
00:0b:86:f9:0d:d2

Returns the gateway whose MAC address
matches the search term.

Search by gateway serial number Enter gateway serial
followed by the serial
number.
Example—gateway
serial CZ0003248

Returns the gateway whose serial number
matches the search term.

Table 15: Device Search Terms

User Experience Search Terms
The following table provides a list of recommended search terms with the corresponding search results for
gauging the network performance and identifying anomalies affecting user experience.

Search Terms Result

user experience
issues

Returns the following links:
n Client-related insights generated for the last three hours
n Network Health dashboard

Click View to open the corresponding page.

user experience
issues last month

Returns client-related insights generated for the last one month.

client issues last
week

Returns the following:
n Client(s) that failed to connect to the network in the last one week
n Client-related insights generated for the last one week

how is my
network today

Returns the following links:
n Wi-Fi Connectivity dashboard
n Network Health > List page

Click View to open the corresponding page.

is everything ok Returns a link to the AI Insights dashboard.
Click View to open the AI Insights dashboard and review the insights triggered.

roaming issues Returns links to the following insights:
n Clients roamed excessively
n Clients experienced high latency while roaming

Click View to open the corresponding insight and identify roaming anomalies.

authentication
Issues

Returns links to the following insights:
n Clients had excessive 802.1x authentication failures
n Clients had an unusual number of MAC authentication failures

Click View to open the corresponding insight and identify authentication anomalies.

Table 16: User Experience Search Terms
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Search Terms Result

problem clients Returns client(s) that failed to connect and client(s) experiencing issues such as high
DHCP failures, authentication failures, high roaming latency, and so on.

coverage issues Returns links to the following insights:
n Clients had a significant number of Low SNR uplink minutes
n Coverage Holes have been detected

Click View to open the corresponding insight and identify coverage anomalies.

Table 16: User Experience Search Terms

Site Search Terms
The following table provides a list of recommended search terms with the corresponding search results for
retrieving clients and devices or identifying issues at a site. Based on the displayed results, users can:

n Hover over the client or device to view more details.
n Click the client or device name to open theClient Details orDevice Details page.
n Click View to open the corresponding page in Aruba Central.

Typical
Queries Search Terms Result

View problems in
a site

Enter any problems in site followed by the
site name.
Example—any problems in site California

Returns the link to navigate to the
AI Insights dashboard for the site.

View client(s) in a
site

Enter list clients in site followed by the site
name.
Example—list clients in site California

Returns a list of all client(s) in the site.

View offline client
(s) in a site

Enter show offline clients in site followed by
the site name.
Example—show offline clients in site
California

Returns a list of offline client(s) in the
site.

View connected
client(s) in a site

Enter show connected clients in site followed
by the site name.
Example—show connected clients in site
California

Returns a list of connected client(s) in
the site.

View AP(s) in a
site

Enter list aps in site or show aps in site
followed by the site name.
Example—list aps in site California

Returns a list of AP(s) in the site.

View switch(es) in
a site

Enter list switches in site or show switches
in site followed by the site name.
Example—list switches in site California

Returns a list of switch(es) in the site.

View gateway(s)
in a site

Enter list gateways in site or show gateways
in site followed by the site name.
Example—list gateways in site California

Returns a list of gateway(s) in the site.

Table 17: Site Search Terms

Network & Services Search Terms
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The following table provides a list of recommended search terms with the corresponding search results for
network and services.

Search Terms Result

service issues Returns the following links:
n Wi-Fi Connectivity dashboard
n AI Insights dashboard

Click View to open the corresponding page.

dhcp issues Returns a link to the Clients had DHCP server connection problems insight.
Click View to open the insight and identify the DHCP failures impacting the network.

dns issues Returns links to the following insights:
n DNS queries failed to reach or return from the servers
n DNS request/responses were significantly delayed
n DNS server(s) rejected a high number of queries

Click View to open the corresponding insight and identify DNS anomalies.

authentication Issues Returns links to the following insights:
n Clients had excessive 802.1x authentication failures
n Clients had an unusual number of MAC authentication failures

Click View to open the corresponding insight and identify authentication anomalies.

Table 18: Network & Services Search Terms

Navigation Search Terms
The following table provides a list of recommended search terms with the corresponding search results for
that can help users navigate through Aruba Central. Based on the displayed results, click View to open the
corresponding page in Aruba Central.

Search Terms UI Page

network health Network Health > List

n access points usage statistics
n ap device summary

Devices > Access Points > Summary

list alerts Global > Alerts & Events > Summary

client overview Clients > Summary

bandwidth usage Global > Overview > Summary

configure ssid Group > Devices > Access Points > Config > WLANs > Wireless
SSIDs

configure vpn Group > Devices > Access Points > Config > VPN

n assign virtual controller
n config ap ports

Group > Devices > Access Points > Interfaces > Wired

Table 19: Navigation Search Terms
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Search Terms UI Page

radios profile Group > Devices > Access Points > Config > Radios

manage firmware for virtual
controller

Global > Firmware > Access Points

where can I configure switch Devices > Switches > Config

configure switch stacks Devices > Switches > Stacks > Config

enable cdp for switches Devices > Switches > System > CDP

configuration conflicts for switches Devices > Switches > Configuration Audit

switch dhcp pools Devices > Switches > IP Settings > DHCP Pools

switch security dhcp Devices > Switches > Security > DHCP Snooping

how to configure switch igmp Devices > Switches > IGMP

switch port priority Devices > Switches > Interface > PoE

manage switch ports Devices > Switches > Interface > Ports

configure VLANs Devices > Switches > Interface > VLANs

configure gateways Devices > Gateways > Config

config audit gateway Devices > Gateways > Config > Advanced Mode > Config Audit

wan transport health Devices > Gateways > Summary

wan performance Global > Overview > WAN Health > List

show branch uplinks utilization Global > Overview > WAN Health > Summary

virtual gateway settings Global > Network Services > Virtual Gateways

how to upgrade gateway Global > Firmware > Gateways

overlay route orchestrator topology Global > Network Services > SD-WAN Overlay > Route

topology Site > Overview > Topology

n list all saas apps
n saas express summary

Global > Applications > SaaS Express > Map

ssh threats Global > Security > Gateway IDS/IPS > Threats List

current threat map Global > Security > Gateway IDS/IPS > Summary

configure presence analytics Global > Guests > Presence Analytics > Config

view wifi connected devices Global > Guests > Presence Analytics > Summary

Table 19: Navigation Search Terms
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Search Terms UI Page

setup guest access Global > Guests > Guest Access

setup guest network Group > Guests > Config > Guest Networks

n ucc settings
n enable call prioritization for
ucc

Global > Applications > UCC > Config > Settings

list ucc call Global > Applications > UCC > List

tutorials WalkMe Menu for launching guided tutorials

Table 19: Navigation Search Terms

Managing Subscriptions
Aruba Central supports the following types of subscriptions:

n Device Management subscriptions—Allows you to manage and monitor your Access Points and Switches
from Aruba Central. The device management subscriptions can be assigned only to the devices managed
by Aruba Central.

n Services Management subscriptions—Allows you to enable value-added services on the APs managed
from Aruba Central.

n Gateway subscriptions—Allows you to manage and monitor SD-WAN Gateways from Aruba Central.

The following figure illustrates the supported subscription types and the assignment criteria:
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Assigning Device Management Subscriptions
You can either enable automatic assignment of subscriptions or manually assign subscriptions for Access
Points and Switches added in Aruba Central.

Automatically Assigning Device Management Subscriptions
To enable automatic assignment of subscriptions from the Initial Setup Wizard:

1. Verify that you have valid subscription key.
2. Ensure that you have successfully added your devices to the device inventory.
3. In the Assign Subscription tab, turn on theAuto Subscribe toggle switch.

To enable automatic assignment of subscriptions from the Subscription Assignment page:

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
The Subscription Management page is displayed.

2. UnderDevice Management Subscriptions, toggle theAuto Subscribe slider to ON. All the
devices in your inventory are selected for automatic assignment of subscriptions. You can edit the list
by clearing the existing selection and re-selecting devices.
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When a subscription assigned to a device expires or is canceled, Aruba Central checks for the available
subscription tokens in your account and assigns the longest available subscription token to the device. If
your account does not have an adequate number of subscriptions, you may have to manually assign
subscriptions to as many devices as possible. To view the subscription utilization details and the number
of subscriptions available in your account, go to the Account Home > Global Settings > Key
Management page.
To manually assign subscriptions, turn off the Auto Subscribe toggle.

Manually Assigning Device Management Subscriptions
To manually assign subscriptions to devices or override the current assignment:

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
The Subscription Management page is displayed.

2. Ensure that theAuto Subscribe toggle is turned off.
3. Select the devices to which you want to assign subscriptions.
4. Click Update Subscription.

Assigning Services Management Subscriptions
To assign a services management subscription, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
The Subscription Management page is displayed.

2. Select the service subscription that you want to enable on a device. The available services are:
n Cloud Guest
n UCC

3. Under Services Management Subscriptions, select the AP from the table on the right.
4. Drag and drop the device to the network service selected in the table on the left.

Important Points to Note

n Clarity service is deprecated. Wi-Fi Connectivity dashboard has replaced Clarity. Although you can assign
or unassign Clarity service subscription, Clarity does not monitor deployments or detect network
performance issues.

n Presence Analytics does not require a separate service subscription.
n If you had assigned a service subscription for Presence Analytics prior to Aruba Central 2.5.2 release,

you can remove the service subscription and use the same subscription for either Cloud Guest or UCC.

Assigning Gateway Subscriptions
For Aruba Gateways to start functioning, you must onboard them to the device inventory in Aruba Central
and ensure that a valid subscription is assigned to each Gateway. A valid subscription allows the Gateway to
be managed by Aruba Central.

For more information, see Aruba SD-WAN Solution User Guide.
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Removing Subscriptions from Devices
To remove the subscriptions from the devices, complete the following actions:

Removing a Device Subscription from a Device
1. In theAccount Home page, underGlobal Settings, click Subscription Assignment. Ensure that

theAuto Subscribe toggle is turned off. The devices that have the subscriptions assigned are
selected and highlighted in green.

2. Clear the Subscribed check box for the device from which you want to unassign the subscription and
click Update Subscription. TheConfirm Action pop-up window with theDo you want to modify
the subscription for selected devices message opens.

3. Click Yes to confirm. The subscription is unassigned and the Subscribed status for the device is
marked asNo in the devices table.

Removing a Services Management Subscription from a Device
To remove network service subscription from a device:

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
2. Under Services Management Subscriptions, select a subscription from the table on the left.
3. From the table on the right, select the devices from which you want to unassign the subscription.
4. Click Batch Remove Subscriptions. The subscription is unassigned from the selected devices.

Acknowledging Subscription Expiry Notifications
In theAccount Home page, underGlobal Settings, click Key Management. TheKey Management
page displays the expiration date for each subscription.

As the subscriptions expiration date approaches, users receive expiry notifications. The users with
evaluation subscription receive subscription expiry notifications on the 30th, 15th and 1 day before the
subscription expiry and on day 1 after the subscription expires.

The users with paid subscriptions receive subscription expiry notifications on the 90th, 60th, 30th, 15th,
and 1 day before expiry and two notifications per day on the day 1 and day 2 after the subscription expiry.

Acknowledging Notifications through Email
If the user has multiple subscriptions, a consolidated email with the expiry notifications for all subscriptions
is sent to the user. Users can acknowledge these notifications by clicking theAcknowledge All link in the
email notification.

Acknowledging Notifications in the UI
If a subscription has already expired or is about to expire within 24 hours, a subscription expiry notification
message is displayed in a pop-up window when the user logs in to Aruba Central.

To prevent Aruba Central from generating expiry notifications, click Acknowledge.



Aruba Central | User Guide 88

Renewing Subscriptions
To renew your subscription, contact your Aruba Central sales specialist.



Chapter 4
Administering Aruba Central

Administering Aruba Central
Aruba Central is a cloud-native network operations and assurance solution for wired, wireless, and SD-WAN
networks. Aruba Central unifies traditional management with AI-based network and user insights, and IoT
device profiling in a single interface for simplified and secure management and control.

Apps
From theAccount Home page, you can manage network inventory, subscriptions, and user access. You can
provision or launch the following apps:

n Network Operations
n ClearPass Device Insight
The application(s) displayed in theApps section of the page are dependent on the app(s) that you selected
while signing up for Aruba Central.

For more information, see Creating an Aruba Central Account on page 38.

To provision an app, click Get Started. After the app is provisioned, click Launch to navigate to the
corresponding application UI.

If the app provisioning fails, you can retry or contact Aruba Technical Support.

Figure 16 All Apps

Network Operations
Network Operations is a unified network operations, assurance and security platform that simplifies the
deployment, management, and service assurance of wireless, wired and SD-WAN environments. Network
Operations provides a cloud-based network management platform for managing your wireless, WAN, and
wired networks with Aruba APs, Gateways, and Switches. Along with device and network management
functions, the app also offers value-added services such as customized guest access, client presence, and
service assurance analytics.
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For more information, see Aruba Central Help Center.

ClearPass Device Insight
ClearPass Device Insight enables network and security administrators to discover, monitor, and
automatically classify new and existing devices that connect to a network. You can identify devices that
include loT devices, medical devices, printers, smart devices, laptops, VoIP phones, computers, gaming
consoles, routers, servers, and switches.

For more information, see Aruba ClearPass Device Insight Information Center.

Global Settings
In Aruba Central, most of the general administration tasks are grouped underGlobal Settings. The
following table lists all the options and relevant app(s) to which the option is applicable:

Option App(s)

User and Roles n Network Operations
n ClearPass Device Insight

Key Management n Network Operations
n ClearPass Device Insight

Device Inventory Network Operations

Subscription
Assignment

Network Operations

Data Collectors Data Collectors option appears only if the ClearPass Device Insight app is provisioned.

Audit Trail Network Operations

Single Sign On Network Operations

API Gateway API Gateway option appears only if the Network Operations app is provisioned and if
the API Gateway license is enabled.

Webhooks Network Operations

Table 20: Options & Apps

Managing Your Device Inventory
After you add paid subscription key(s) to your Aruba Central account, device(s) purchased by you are
automatically added to the device inventory in the respective Aruba Central account. For more information
subscription keys, see Managing Subscription Keys.

If the device you purchased does not show up in the inventory, you can manually add it. Aruba Central
allows you to add up to 32 devices manually by entering the valid MAC and serial number combination for
each device.

https://help.central.arubanetworks.com/latest/documentation/online_help/content/home.htm
https://www.arubanetworks.com/techdocs/ClearPassDeviceInsight/Content/home.htm
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Users having roles with Modify permission can add devices. Users having roles with View Only permission can
only view the Device Inventory module.

Viewing Devices
The devices provisioned in your account are listed in theAccount Home > Global Settings > Device
Inventory page.

The following table describes the contents of theDevice Inventory page.

Parameter Description

Serial
Number

Serial number of the device.

MAC
Address

MAC address of the device.

Type Type of the device, for example Instant AP, switch, or gateway.

IP Address IP address of the device.

Name Name of the device.

Model Hardware model of the device.

Part
Number

Part number of the device.

Group Name of the group to which the device is assigned. This column is displayed only for the Aruba
Central Standard Enterprise mode users.

Subscription Status of the subscription assignment

Table 21: Device Details

Adding Devices to Inventory
For information on adding devices, see Onboarding Devices.

Onboarding Devices
Aruba Central supports the following options for adding devices.

n If you are an evaluating user, you must manually add the serial number and MAC address of the devices
that you want to manage from Aruba Central.

This section includes the following topics:
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n Adding Devices (Evaluation Account)
n Adding Devices (Paid Subscription)
n Manually Adding Devices

Adding Devices (Evaluation Account)
Use one of the following methods to add devices to Aruba Central:

Using the Initial Setup Wizard
1. In theAdd Devices tab of the Initial Setup wizard, click Add Device.
2. Enter the serial number of MAC address of your devices.

You can find the serial number and MAC address of Aruba devices on the front or back of the
hardware.

3. Click Done.
4. Review the devices in your inventory.

Using the Device Inventory Page
1. In theAccount Home page, underGlobal Settings, click Device Inventory.

TheDevice Inventory page is displayed.

2. Click Add Devices.

TheAdd Devices pop-up window is displayed.

3. Enter the serial number and the MAC address of each device.

You can find the serial number and MAC address of Aruba devices on the front or back of the
hardware.

4. Click Done.
5. Review the devices in your inventory.

Adding Devices (Paid Subscription)
If your devices are not added to your inventory, set up a device sync by adding one device from your
purchase order.

To set up device sync, use one of the following methods:

n In the Initial Setup Wizard
n From the Device Inventory Page

In the Initial Setup Wizard
1. Ensure that you have added a subscription key and click Next.
2. In theAdd Devices tab, enter the serial number and MAC address of one device from your purchase

order.

Most Aruba devices have the serial number and MAC address on the front or back of the hardware.

3. Click Add Device. Aruba Central imports all other devices mapped to your purchase order.
4. Review the devices in your inventory.
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5. Perform the following options:
n Add Devices Manually—Manually add devices by entering the MAC address and serial number

of each device.
n Add Via Mobile App—Add devices from the Aruba Central mobile app. You can download the

Aruba Central app from Apple App Store on iOS devices and Google Play Store on Android devices.
n Contact support—Contact Aruba Technical Support.

From the Device Inventory Page
1. In theAccount Home page, underGlobal Settings, click Device Inventory.

TheDevice Inventory page is displayed.

Aruba Central imports only devices associated with your Central account from Activate.

2. Do one of the following:
n Click Sync Devices. Enter the serial number and MAC address and click Add Device.
n Click Add Devices to manually add devices by entering the MAC address and serial number of

each device.
n If you are a paid subscriber, you can add devices using a CSV file. Click Import Via CSV and select

the CSV file. For a sample CSV file, click Download sample CSV file.

Manual addition of devices using a CSV file is restricted to 100 devices or to the number of available
device management tokens. An error message is displayed if more than 100 devices are imported
using the CSV file. You can view the status of the CSV upload in the Account Home > Audit Trail page.

3. Review the devices in your inventory.
4. Perform the following options:

n Add Devices Manually—Manually add devices by entering the MAC address and serial number
of each device.

n Add Via Mobile App—Add devices from the Aruba Central mobile app. You can download the
Aruba Central app from Apple App Store on iOS devices and Google Play Store on Android devices.

n Contact support—Contact Aruba Technical Support.

Manually Adding Devices
Aruba Central allows you to set up only manual sync of devices from Activate database using one of the
following methods:

n Adding Devices Using MAC address and Serial Number on page 93
n Adding Devices Using Activate Account on page 94
n Adding Devices Using Cloud Activation Key on page 95

You can only set up only a manual sync for Aruba Central-managed folders such as the default, licensed, and
non-licensed folders.

Adding Devices Using MAC address and Serial Number
You can find the serial number and MAC address of Aruba devices on the front or back of the hardware.
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To add devices using MAC address and serial number, use one of the following methods:

n In the Initial Setup Wizard
n From the Device Inventory Page

In the Initial Setup Wizard
If you are using the Initial Setup wizard:

1. In theAdd Devices tab of the Initial Setup wizard.
2. Click Add Device.
3. Enter the serial number of MAC address of your device.
4. Click Done.
5. Review the list of devices.

From the Device Inventory Page
To add devices from theDevice Inventory page:

1. In theAccount Home page, underGlobal Settings, click Device Inventory.

TheDevice Inventory page is displayed.

2. Do one of the following:
n Click Add Devices to manually add devices by entering the MAC address and serial number of

each device.
n If you are a paid subscriber, you can add devices using a CSV file. Click Import Via CSV and select

the CSV file. For a sample CSV file, click Download sample CSV file.

Manual addition of devices using a CSV file is restricted to 100 devices or to the number of available
device management tokens. An error message is displayed if more than 100 devices are imported
using the CSV file. You can view the status of the CSV upload in the Account Home > Audit Trail
page.

3. Click Done.
4. Review the devices added to the inventory.

When you add the serial number and MAC address of one AP from a cluster or a switch stack member,
Aruba Central imports all devices associated in the AP cluster and switch stack respectively.

Adding Devices Using Activate Account

Use this device addition method only when you want to migrate your inventory from Aruba AirWave or a
standalone AP deployment to the Aruba Central management framework.
Use this option with caution as it imports all devices from your Activate account to the Aruba Central device
inventory.
You can use this option only once. After the devices are added, Aruba Central does not allow you to modify or
re-import the devices using your Aruba Activate credentials.

To add devices from your Activate account:
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1. In theAccount Home page, underGlobal Settings, click Device Inventory.

TheDevice Inventory page is displayed.

2. Click Advanced and select Using Activate.
3. Enter the username and password of your Activate account.
4. Click Add.
5. Review the devices added to the inventory.

Adding Devices Using Cloud Activation Key

When you import devices using the Cloud Activation Key, all your devices from the same purchase order are
added to your Aruba Central inventory.

Before adding devices using cloud activation key, ensure that you have noted the cloud activation key and
MAC address of the devices to add.

Locating Cloud Activation Key and MAC Address

To know the cloud activation key:

n For APs:

1. Log in to the WebUI or CLI.
n If using the WebUI, go to theMaintenance > About.
n If using the CLI, execute the show about command.

2. Note the cloud activation key and MAC address.

n For Aruba Switches:

1. Log in to the switch CLI.
2. Execute the show system | in Base and show system | in Serial commands.
3. Note the cloud activation key and MAC address in the command output.

n For Mobility Access Switches

1. Log in to the Mobility Access Switch UI or CLI.
n If using the UI, go to theMaintenance > About.
n If using the CLI, execute the show inventory | include HW and show version commands.

2. Note the cloud activation key and MAC address. The activation key is enabled only if the switch has
access to the Internet.

Adding Devices Using Cloud Activation Key

1. In theAccount Home page, underGlobal Settings, click Device Inventory.

TheDevice Inventory page is displayed.

2. Click Advanced and select With Cloud Activation Key. TheCloud Activation Key pop-up window
opens.

3. Enter the cloud activation key and MAC address of the device.
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4. Click Add.

If a device belongs to another customer account or is used by another service, Aruba Central displays it
as a blocked device. As Aruba Central does not support managing and monitoring blocked devices, you
may have to release the blocked devices before proceeding with the next steps.

Managing Subscription Keys
A subscription key is a 14-character alphanumeric string; for example, PQREWD6ADWERAS. Subscription
keys allow your devices to be managed by Aruba Central. To use Aruba Central for managing, profiling,
analyzing, and monitoring your devices, you must ensure that you have a valid subscription key. You must
either have an evaluation subscription key or a paid subscription key. The evaluation subscription key is
valid for 91 days.

Evaluation Subscription Key
The evaluation subscription key is enabled for trial users by default. It allows you to add up to a total of 10
devices. The evaluation subscription also allows you to enable services such as Presence Analytics and Guest
Access on your devices.

TheAccount Home > Global Settings > Key Management page displays the subscription expiration
date. You will receive subscription expiry notifications through email on the 30th, 15th and 1 day before the
subscription expiry and on day 1 after the subscription expires. The number of days left for subscription
expiry is also displayed in the respective app under theApps section of theAccount Home page.

Upgrading to a Paid Account
If you have purchased a subscription, upgrade your account by completing the following steps:

1. On the respective app, click the link that shows the number of days left for the evaluation to expire:

TheAdd a New Subscription pop-up window opens.

2. Enter the new subscription key that you purchased from Aruba.
3. Click Add Subscription.
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After you upgrade your account, you can add more devices and enable services, and continue using Aruba
Central.

Paid Subscription Key
If you have purchased a subscription key, you must ensure that your subscription key is added to Aruba
Central. If you are logging in for the first time, Aruba Central prompts you to add your subscription key to
activate your account. Ensure that you add the subscription key before onboarding devices to Aruba
Central.

TheAccount Home > Global Settings > Key Management page displays the subscription expiration
date. You will receive subscription expiry notifications through email on the 90th, 60th, 30th, 15th, and 1
day before expiry and two notifications per day on the day 1 and day 2 after the subscription expiry.

When you upgrade or renew your subscription, or purchase another subscription key, you must add the key
details in theAccount Home > Global Settings > Key Management page to avail the benefits of the new
subscription.

Adding a Subscription Key
To add a subscription key:

1. In theAccount Home page, underGlobal Settings, click Key Management.
TheKey Management page is displayed.

2. Enter your subscription key.
3. Click Add Subscription. The subscription key is added to Aruba Central and the contents of the

subscription key are displayed in theManage Keys table.
4. Review the subscription details.

Viewing Subscription Key Details
To view subscription key details, in theAccount Home page, underGlobal Settings, click Key
Management.
The following table describes the contents of theManage Keys table:

Data
Pane
Item

Description

Keys Subscription key number.

Type Type of the subscription. Aruba Central supports the following types of subscriptions:

n Device subscriptions—The device subscription allows you to avail services such as device
onboarding, configuration, management, monitoring, and reports. The device subscriptions
can be assigned only to the devices managed by Aruba Central.
n Service subscriptions—Aruba Central supports application services that you can run on
the devices provisioned in your setup. For example, if you have Instant APs with 6.4.4.4-
4.2.3.0 or later, you can assign a service subscription for Presence Analytics.
n Gateway Subscriptions—Aruba Central supports a separate set of subscriptions for
configuring and managing SD-WAN gateways. The Gateway subscriptions are marked as

Table 22: Subscription Key Details
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Data
Pane
Item

Description

Foundation-<device>; for example, Foundation-70XX.
n Virtual Gateways—Aruba Central supports a separate set of subscriptions for configuring
and managing Virtual Gateways. The Virtual Gateway subscriptions are prefixed with a
VGW-<bandwidth>; for example, VGW-500MB.

Expiration
Date

Expiration date for the subscription key.

Quantity Number of license tokens available for a subscription. Each Aruba Central subscription holds a
specific number of tokens. For example, when a subscription is assigned to a device, Aruba Central
binds the device with a token from the existing pool of subscriptions.

Status Status of the subscription key. For example, if you are a trial user, Aruba Central displays the
status of subscription key as Evaluation.

Apps Name of the application.

Managing Subscriptions
Aruba Central supports the following types of subscriptions:

n Device Management subscriptions—Allows you to manage and monitor your Access Points and Switches
from Aruba Central. The device management subscriptions can be assigned only to the devices managed
by Aruba Central.

n Services Management subscriptions—Allows you to enable value-added services on the APs managed
from Aruba Central.

n Gateway subscriptions—Allows you to manage and monitor SD-WAN Gateways from Aruba Central.

The following figure illustrates the supported subscription types and the assignment criteria:
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Assigning Device Management Subscriptions
You can either enable automatic assignment of subscriptions or manually assign subscriptions for Access
Points and Switches added in Aruba Central.

Automatically Assigning Device Management Subscriptions
To enable automatic assignment of subscriptions from the Initial Setup Wizard:

1. Verify that you have valid subscription key.
2. Ensure that you have successfully added your devices to the device inventory.
3. In the Assign Subscription tab, turn on theAuto Subscribe toggle switch.

To enable automatic assignment of subscriptions from the Subscription Assignment page:

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
The Subscription Management page is displayed.

2. UnderDevice Management Subscriptions, toggle theAuto Subscribe slider to ON. All the
devices in your inventory are selected for automatic assignment of subscriptions. You can edit the list
by clearing the existing selection and re-selecting devices.
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When a subscription assigned to a device expires or is canceled, Aruba Central checks for the available
subscription tokens in your account and assigns the longest available subscription token to the device. If
your account does not have an adequate number of subscriptions, you may have to manually assign
subscriptions to as many devices as possible. To view the subscription utilization details and the
number of subscriptions available in your account, go to the Account Home > Global Settings > Key
Management page.
To manually assign subscriptions, turn off the Auto Subscribe toggle.

Manually Assigning Device Management Subscriptions
To manually assign subscriptions to devices or override the current assignment:

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
The Subscription Management page is displayed.

2. Ensure that theAuto Subscribe toggle is turned off.
3. Select the devices to which you want to assign subscriptions.
4. Click Update Subscription.

Assigning Services Management Subscriptions
To assign a services management subscription, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
The Subscription Management page is displayed.

2. Select the service subscription that you want to enable on a device. The available services are:
n Cloud Guest
n UCC

3. Under Services Management Subscriptions, select the AP from the table on the right.
4. Drag and drop the device to the network service selected in the table on the left.

Important Points to Note

n Clarity service is deprecated. Wi-Fi Connectivity dashboard has replaced Clarity. Although you can assign
or unassign Clarity service subscription, Clarity does not monitor deployments or detect network
performance issues.

n Presence Analytics does not require a separate service subscription.
n If you had assigned a service subscription for Presence Analytics prior to Aruba Central 2.5.2 release,

you can remove the service subscription and use the same subscription for either Cloud Guest or UCC.

Assigning Gateway Subscriptions
For Aruba Gateways to start functioning, you must onboard them to the device inventory in Aruba Central
and ensure that a valid subscription is assigned to each Gateway. A valid subscription allows the Gateway to
be managed by Aruba Central.

For more information, see Aruba SD-WAN Solution User Guide.
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Removing Subscriptions from Devices
To remove the subscriptions from the devices, complete the following actions:

Removing a Device Subscription from a Device
1. In theAccount Home page, underGlobal Settings, click Subscription Assignment. Ensure that

theAuto Subscribe toggle is turned off. The devices that have the subscriptions assigned are
selected and highlighted in green.

2. Clear the Subscribed check box for the device from which you want to unassign the subscription and
click Update Subscription. TheConfirm Action pop-up window with theDo you want to modify
the subscription for selected devices message opens.

3. Click Yes to confirm. The subscription is unassigned and the Subscribed status for the device is
marked asNo in the devices table.

Removing a Services Management Subscription from a Device
To remove network service subscription from a device:

1. In theAccount Home page, underGlobal Settings, click Subscription Assignment.
2. Under Services Management Subscriptions, select a subscription from the table on the left.
3. From the table on the right, select the devices from which you want to unassign the subscription.
4. Click Batch Remove Subscriptions. The subscription is unassigned from the selected devices.

Acknowledging Subscription Expiry Notifications
In theAccount Home page, underGlobal Settings, click Key Management. TheKey Management
page displays the expiration date for each subscription.

As the subscriptions expiration date approaches, users receive expiry notifications. The users with
evaluation subscription receive subscription expiry notifications on the 30th, 15th and 1 day before the
subscription expiry and on day 1 after the subscription expires.

The users with paid subscriptions receive subscription expiry notifications on the 90th, 60th, 30th, 15th,
and 1 day before expiry and two notifications per day on the day 1 and day 2 after the subscription expiry.

Acknowledging Notifications through Email
If the user has multiple subscriptions, a consolidated email with the expiry notifications for all subscriptions
is sent to the user. Users can acknowledge these notifications by clicking theAcknowledge All link in the
email notification.

Acknowledging Notifications in the UI
If a subscription has already expired or is about to expire within 24 hours, a subscription expiry notification
message is displayed in a pop-up window when the user logs in to Aruba Central.

To prevent Aruba Central from generating expiry notifications, click Acknowledge.



Users and Roles | 102

Renewing Subscriptions
To renew your subscription, contact your Aruba Central sales specialist.

Users and Roles
Aruba Central users are broadly categorized as follows:

n Network Administrators—Network administrators manage, configure, and monitor devices in their
respective network or organization using the Aruba Central Standard Enterprise interface.

n Service Provider Administrators—Service Provider administrators are referred to as the MSP
administrators who create, manage, and monitor accounts for multiple organizations (tenants). For MSP
accounts, the Network Operations app provides a separate interface called the MSP View, using which
MSP administrators can provision and manage their respective tenant accounts. Tenant account users'
access is limited to their respective account or network setup. For more information on creating tenant
accounts, see the Aruba Central MSP User Guide.

Within each Aruba Central account, the admin users of the respective accounts can configure and manage
the following types of users:

n System users—Users who authenticate to the Aruba SSO server (public cloud deployments) or LocalDB
servers (private cloud deployments). System users can access both the UI and API interface with their
Aruba Central login credentials. Access for the system users is determined by the role to which they are
mapped. For more information on configuring system users, see Configuring System Users on page 102.

n External users—Users who log in to Aruba Central using an external authentication source. External user
accounts are maintained by IT administrators of the respective organizations. External users are also
referred to as federated users. To provide a secure and seamless sign-on experience for external users,
Aruba Central supports a federation configuration module based on the SAML SSO framework. For more
information on configuring the SAML SSO framework for federated users, see the Aruba Central SAML
SSO Solution Guide.

The following table lists the tasks that you can perform from theUsers and Roles page:

Task For more information...

Create, modify, or delete users Configuring System Users on page 102

Create, modify, or delete user roles Configuring User Roles on page 105

Resend email invitation to users Resend Email Invite on page 104

Enable Two-Factor Authentication (2FA) Two-Factor Authentication on page 110

Enable support access to debug issues Support Access on page 112

Table 23: Users and Roles—Tasks

Configuring System Users
In theAccount Home page, theUsers & Roles option underGlobal Settings allows you to create,
modify, and delete users.

This section describes the procedure for configuring users in an enterprise account. For information on how to
configure system users in the MSP mode, see the Aruba Central Managed Service Provider User Guide.

https://help.central.arubanetworks.com/latest/documentation/online_help/content/pdfs/aruba central saml sso solution guide.pdf
https://help.central.arubanetworks.com/latest/documentation/online_help/content/pdfs/aruba central saml sso solution guide.pdf
https://help.central.arubanetworks.com/latest/documentation/online_help/content/pdfs/aruba_central_msp_user_guide.pdf
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Adding a System User
To add a user, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.

TheUsers and Roles page is displayed.

2. Click Add User.
TheNew User window is displayed.

3. Configure the following parameters:
n Username—Email ID of the user. Enter a valid email address.
n Description—Description of the user role. You can enter up to a maximum of 32 characters

including alphabets, numbers, and special characters in the text field.
n Language—Select a language. The Aruba Central web interface is available in English, French,

Spanish, German, Brazilian Portuguese, Chinese, and Japanese languages.
n Account Home—Select a user role for theAccount Home page. If there are common modules

between Account Home and other app(s), theAccount Home user role has higher precedence.
For example, theDevices and Subscription module in theNetwork Operations app.

If an application is not provisioned, that application is not listed in the New User pop-up window.

n Network Operations—Select a user role for theNetwork Operations application.

l If you assign the user role guestoperator, readonly, or readwrite, from the Select Groups drop-
down list, select group(s). By default, the admin user role has access to all groups.
n ClearPass Device Insight—Select a user role for theClearPass Device Insight application.

For more information on user roles, see Configuring User Roles.

4. Click Save. An email invite is sent to the user with a registration link. Users can use this link to access
Aruba Central.

The registration link in the email invite is valid for 15 days. The link expiry date is also mentioned in the
registration email notification:
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Resend Email Invite
If any user has not received the email invite, complete the following steps to resend the invite:

1. Click Actions and slide theResend Invitation To Users toggle button to the right.
2. Enter the email ID and click Resend Invite.

Viewing User Details
In theAccount Home page, underGlobal Settings, click Users & Roles. TheUsers tab is displayed. The
List of Users table displays the following information:

n Email ID of the user.
n Type of user. The user can be system user or external user.
n Description of the user.
n Role assigned for theNetwork Operations app.
n Role assigned for theClearPass Device Insight app. This option is displayed only if theClearPass

Device Insight app is provisioned and if you have subscribed to the app.
n Role assigned for theAccount Home page.
n Allowed groups for the user.
n Last active time of the user. If the last active time cell is blank, the user has not logged in after the

product upgrade.
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Editing a User
To edit a user account, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.

TheUsers tab opens.

2. In the List of Users table, select the user and click the edit icon.
3. In the Edit User <"Username"> window, modify description, role, or allowed groups.
4. Click Save.

Deleting a User
To delete a user account:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.

TheUsers tab opens.

2. In the List of Users table, select the user and click the delete icon.
3. Confirm user deletion in theConfirm Action dialog box.

Viewing Audit Trail Logs for Users
Audit logs are generated when a new user is created and an existing user is modified or deleted from the
Aruba Central account. It also records the login and logout activities of users.

To view audit logs for Aruba Central users:

1. In theAccount Home page, underGlobal Settings, click Audit Trail.
TheAudit Trail page is displayed.

2. To view audit logs for user addition, modification, or deletion, click the filter in theClassification
column, and select User Management.

3. To filter audit logs about user activity, click the filter in theClassification column, and select User
Activity.

Configuring User Roles
A role refers to a logical entity used for determining user access to devices and application services in Aruba
Central. Users are always tagged to roles that govern the level of user access to the Aruba Central
applications and services.

Access control for federated users is determined by the attributes set in the IDP.

Aruba Central supports a set of predefined roles with different privileges and access permissions. You can
also configure custom roles.

Predefined User Roles
TheUsers & Roles page allows you to configure the following types of users with system-defined roles:
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Application User Role Privilege

Account
Home

admin Administrator for the Account Home page. If there are common modules
between Account Home and other app(s), the Account Home user role has
higher precedence and the user is granted permission if the operation is
initiated from the Account Home page.

readwrite Can view and modify settings in the Account Home page and all Global
Settings pages.

readonly Can view the Account Home page and all Global Settings pages.

Network
Operations

admin Administrator for the Network Operations application. Has access to
Account Home > Global Settings. This is applicable only if the Account
Home role is not set or is not conflicting.

deny-access Cannot view the Network Operations application.

guestoperator Has guest operator access for the Network Operations application. User does
not have access to Account Home > Global Settings.

readonly Has read-only access to Account Home > Global Settings and the Network
Operations application.

readwrite Has read-write access to Account Home > Global Settings and the Network
Operations application.
Has access to view and modify data using the Aruba Central UI or APIs.
However, the user cannot execute APIs to:

n Enable or disable MSP mode.
n Perform operations in the following pages:
lAccount Home > Users & Roles
lNetwork Operations application > Organization > Labels and Sites

ClearPass
Device
Insight

admin Administrator for the ClearPass Device Insight application.

deny-access Cannot view the ClearPass Device Insight application.

readonly Can launch and view all the pages in the ClearPass Device Insight
application.

Table 24: Predefined User Roles

Custom Roles
Along with the predefined user roles, Aruba Central also allows you to create custom roles with specific
security requirements and access control. However, only users with the administrator role and privileges can
create, modify, clone, or delete a custom role in Aruba Central.

With custom roles, you can configure access control at the application level and specify access rights to view
or modify specific application services or modules. For example, you can create a custom role that allows
access to a specific applications likeGuest Management orNetwork Management and assign it to a
user.

MSP tenant account users cannot add, edit, or delete roles.

Adding a Custom Role
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The following are the permissions that you can associate with a custom role:

n User roles with Modify permission can perform add, edit, or delete actions within the specific module.
n User roles with View Only permission can only view the specific module.
n User roles with Block permission cannot view that particular module.

To add a custom role, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.
2. Click theRoles tab.
3. Click Add Role. TheNew Role window is displayed.
4. Specify a name for the role.
5. From the drop-down list, select one of the following:

n Account Home—To manage access to devices and subscriptions in Aruba Central.
n Network Operations—To set permissions at the module level in theNetwork Operations

application.
n ClearPass Device Insight—To set permissions at the module level in theClearPass Device

Insight application. This option is displayed only if theClearPass Device Insight app is
provisioned and if you have subscribed to the app.

6. For Network Management and MSP modules, you can set access rights at the module level.

To set view or edit permissions or block the users from accessing a specific module, complete the
following steps:

a. Click Customize.

b. Select one of the following options for each module as required:
n View Only
n Modify
n Block

7. Click Save.
8. Assign the role to a user account as required.

Module Permissions
Aruba Central allows you to define user roles with view ormodify permissions. You can also block user
access to some modules. For example, if theGuest Management module is blocked for a specific user
role, the corresponding pages are not displayed in the UI.

Aruba Central supports setting permissions for the following modules:

Application Module Description

Account Home Devices and
Subscription

Aruba recommends users to add devices and assign keys
and subscriptions to devices in the Account Home page.

Table 25: Permissions
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Application Module Description

Network Operations MSP Allows users with administrator role and privileges to define
user access to MSP modules such as Customer Management
and Portal Customization. The MSP tenant account user does
not have access to the MSP application. Even if a tenant
account user is assigned a custom role having MSP
application privileges:

n Tenant account user does have access to the MSP
application.
n MSP will not appear in the Account Home > Global
Settings > Users & Roles > Roles > Allowed
Applications list.

Group
Management

Allows users to create, view, modify, and delete groups and
assign devices to groups.

Devices and
Subscription

Users cannot edit or set permissions for this module. Modify
and Block options are disabled. By default, the View Only
permission is set.

Network
Management

Allows users to configure, troubleshoot, and monitor Aruba
Central-managed networks.

Guest
Management

Allows users to configure cloud guest splash page profiles.

AirGroup Allows users to define or block user access to the AirGroup
pages.

Presence
Analytics

Allows users to access the Presence Analytics app and
analyze user presence data.

VisualRF Allows user to access VisualRF and RF heatmaps.

Unified
Communications

Allows users to access the Unified Communications pages.

Install Manager Allows users to manage installer profiles and site
installations.

Reports Allows users to view and create reports.

Other
Applications

Allows users to access other applications modules such as
notifications and Virtual Gateway deployment service.
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Application Module Description

ClearPass Device Insight

NOTE: This option is
displayed only if the
ClearPass Device Insight
app is provisioned and if
you have subscribed to the
app.

Classified
devices

Allows users to view or modify system and user-classified
devices.

Generic devices Allows users to view or modify devices which are not
classified by system or user.

User classified
devices

Allows users to view or modify user-classified devices.

Discovery
settings

Allows users to view, create, modify, or delete discovery
settings.

Application
settings

Allows users to view or modify application level user settings

Reports Allows users to view create and view reports

Other
Applications

Allows users to define or block access to other applications.

Viewing User Role Details
To view the details of a user role, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.
2. Click theRoles tab. TheRoles tab displays the following information:

n Role Name—Name of the user role.
n Allowed Applications—The application(s) to which the user account is subscribed to.
n Assigned Users—Number of users assigned to a role.

Editing a User Role
To edit a user role, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.
2. Click theRoles tab.
3. In the List of Roles table, select the role and click the edit icon.
4. In the Edit Role <"Rolename"> window, modify the permissions set for module(s).
5. Click Save.

Deleting a User Role
To delete a user role, ensure that the role is not associated to any user and complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.
2. Click theRoles tab.
3. In the List of Roles table, select the role and click the delete icon.
4. Confirm role deletion in theConfirm Action dialog box.
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Two-Factor Authentication
Aruba Central now supports two-factor authentication for both computers and mobile phones to offer a
second layer of security to your login, in addition to password. When two-factor authentication is enabled
on a user account, the users can sign in to their Aruba Central account either through the mobile app or the
web application, only after providing their password and the six-digit verification code displayed on their
trusted devices.

When two-factor authentication is enabled at the customer account level, all the users belonging to the
customer account are required to complete the authentication procedure when logging in to Aruba Central.
If a user account is associated with multiple customer accounts and if two-factor authentication is enabled
on one of these accounts, the user must complete the two-factor authentication during the login
procedure.

If two-factor authentication is enabled on your accounts, you must install the Google Authenticator app on
your devices such as mobile phones to access the Aruba Central application. When the users attempt to log
in to Aruba Central with their credentials, the Google Authenticator app provides a six-digit verification code
to complete the login procedure.

Installing the Google Authenticator App
For two-factor authentication, ensure that the Google Authenticator app is installed on your mobile device.

During the registration process, the Aruba Central application shares a secret key with the mobile device of
the user over a secure channel when the user logs in to Aruba Central. The key is stored in the Google
Authenticator app and used for future logins to the application. This prevents unauthorized access to a user
account as this authentication procedure involves two-levels for secure transaction.

When you register your mobile device successfully, the Google Authenticator app generates a six-digit token
for the second level authentication. The token is generated every thirty seconds.

Enabling Two-factor Authentication for User Accounts
To enable two-factor authentication, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.

TheUsers and Roles page is displayed.

2. From theActions menu, slide the Two-Factor Authentication (2FA) toggle button to the right.
The two-factor authentication is enabled for all the users associated with the account.

Two-factor Authentication for Aruba Central Web Application
When two-factor authentication is enabled for a customer account, the users associated with that customer
account are prompted for two-factor authentication when they log in to Aruba Central.

To complete two-factor authentication, perform the following actions:

1. Access the Aruba Central website.
2. Log in with your credentials. If two-factor authentication is enforced on your account, the two-factor

authentication page opens.
3. Install the Google Authenticator app on your mobile device if not already installed.
4. Click Next.
5. If this is your first login since two-factor authentication is enforced on your account, open Google

Authenticator on your mobile device.
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6. Scan the QR Code. If you are unable to scan the QR code, perform the following actions:

a. Click the Problem in Reading QR Code link. The secret key is displayed.

b. Enter this secret key in the Google Authenticator app.

c. Ensure that the Time-Based parameter is set. Aruba Central is added to the list of supported
clients and a six-digit token is generated.

7. Click Next.
8. Enter the six-digit token.
9. Select theRemember 2FA for 30 Days check box if you want the authentication to expire only

after 30 days.
10. Click Finish.

Two-factor Authentication for the Aruba Central Mobile App
Two-factor authentication must first be enabled for your account. If two-factor authentication is not
enabled, you log in to the application directly after a successful SSO authentication.

To log in to Aruba Central app on your mobile device, perform the following actions:

1. Open the Aruba Central app on your mobile device.
2. Enter your username and password and click Log in. If the registration process is pending, an error

message is displayed:

Please register for two-factor authentication in our web app to ensure secured authentication.

3. Enter the token. On successful authentication, the Aruba Central app opens.

Registering a New Mobile Device
If you have changed your mobile device, you need to install Google Authenticator app on your new device
and register again using a web browser on your Desktop for two-factor authentication.

To register your new mobile device, complete the following steps:

1. Log in to Aruba Central web application. The two-factor authentication page is displayed.
2. Click theChanged Your Mobile Device? link.
3. To register your new device and receive a reset email with instructions, click Send 2FA Reset Email.

A reset email with instructions will be sent to your registered email address:
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4. Follow the instructions in the email and complete the registration.

Support Access
Aruba technical support may ask you to enable Support Access to debug issues. After you enable Support
Access, the Aruba support team can access your Aruba Central account remotely. Only users with
administrator role can enable Support Access.

Enabling Support Access
To enable Support Access, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click Users & Roles.

TheUsers and Roles page is displayed.

2. From theActions menu, slide the Support Access toggle button to the right.
3. Set password expiry by selecting the number of days and click Get Password. A new password is

generated.
4. Copy the password and share it with the Aruba technical support representative.

Disabling Support Access
After the remote support session is complete, do the following to disable Support Access:
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1. In theAccount Home page, underGlobal Settings, click Users & Roles.

TheUsers and Roles page is displayed.

2. From theActions menu, slide the Support Access toggle button to the left.

Proximity Tracing
Aruba has introduced a new feature, proximity tracing, to perform queries for contact and location tracing.
Proximity tracing complements a host of other tools or techniques geared towards enabling customers to
understand their users' movements and interactions, specifically with a focus on combating the COVID-19
pandemic. To increase the scope and help as many people as possible, proximity tracing is offered to both
Aruba Central customers (Instant AP) and Airwave customers (Campus AP and Instant AP) including
NetInsight campus customers.

Proximity tracing tracks wireless client devices (stations) and associated stations they come into contact
with, either directly or through connections to neighboring access points, as well as location tracing.
Proximity tracing jobs from NetInsight process wireless client data connected to Instant AP through Aruba
Central and wireless client data connected to AP through Airwave connection (AW8).

Proximity tracing efforts work best when devices have a static MAC address and are required to have a unique
username. A random MAC address or a constantly changing username complicate the ability to locate an
individual user or device and the users they may have come into contact with and may lessen the impact of this
tool.

Proximity tracing can be done at global or customer (CID) level for duration of 14 days within the last 21
days. Customer can download the contact username list in a CSV file. The file downloaded shows additional
details with username, MAC address, AP, duration, site, and date. To trace contact clients and location, see
Contact and Location Tracing.

The Opt-Out feature allows to ignore specific users from being traced. To ignore a set of users, add their
MAC address in a TXT file and upload the file. User needs to specifically upload a latest list of MAC addresses
which should be ignored. The latest list of MAC addresses should include the complete new set of updated
entries including new entries, updated entries, or removed entries. When new file is uploaded, the opt-out
clients is updated to a new list. To opt-out clients, see Opt-Out Clients.

Pre-requisites
Proximity tracing has the following pre-requisites for data coming from Airwave Server:

n AirWave Server connection signup should happen through Aruba Central account by creating a new
customer account which does not have any Instant AP on-boarded. To signup AirWave Server connection
through Aruba Central by creating a new customer account, see AirWaveServer Connection Signup
Through Aruba Central.

n Devices (AP and wireless clients) should be present in customer network coming through Airwave.
n The following terms are derived for proximity tracing:
n If duplicate usernames exist, an imputed username is derived by taking the MAC address.
n If a username has more than 5 wireless clients connected during the same hour, an imputed username

derived by taking the MAC address is used instead.
n If the device generates random MAC address, it is mapped to the same username if it remains unique.
n If a user inputs both username and MAC address, the search results is based on the username.
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n If a username keeps changing in a network, the results are processed with the username that is used
most in the day.

Contact and Location Tracing
To trace contact clients and location:

1. In theNetwork Operations app, set the filter to Global.
2. UnderAnalyze, click Tools > Proximity Tracing.
3. Enter the values for the parameters listed in the following table.

Enter either the username or MAC address.

Mode Description

Username Client name.

MAC Address MAC address of the client.

Start Date Start date within the last 21 days.

End Date End date within the last 21 days. End date cannot be more than 14 days from start date.

Table 26: Contact Tracing

4. Click Trace Contacts/Locations.

The traced contacts are listed under Contact Usernames table and the location under Locations table.

If the username does not return any result, enter the MAC address. Contact and location tracing work best
when devices have a static MAC address and are required to have a unique username. A random MAC address
or a constantly changing username complicate the ability to locate an individual user or device and the users
they may have come into contact with and may lessen the impact of this tool.

Optionally, click Download to download the traced contacts or locations as a CSV file.

The CSV file contains additional information than what is displayed in the Contact Usernames table and
Locations table and can be used for advanced analysis.

Opt-Out Clients
To opt-out specific clients from being traced, save the MAC address of the clients as a TXT file and upload it
to Aruba Central.

The uploaded opt-out list will overwrite the previous list of opt-out entries. The latest list of MAC addresses
should include the complete new set of updated entries including new entries, updated entries, or removed
entries.

In the opt-out clients TXT file, enter each MAC address on a new line in the following format:

xx:xx:xx:xx:xx:xx or xx-xx-xx-xx-xx-xx or xxxxxxxxxxxx, where x is a case-insensitive hexadecimal number.
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For example:
00:1B:44:11:3A:B7

30-65-EC-6F-C4-58

f0c3717d06d1

To upload the opt-out clients file:

1. In theNetwork Operations app, set the filter to Global.
2. UnderAnalyze, click Tools > Proximity Tracing.

3. Click the configuration icon.
4. In theOpt-out Clients tab, click No file uploaded (text file only) and select the TXT file.
5. Click Upload.

To download the current opt-out list, click Download.

AirWaveServer Connection Signup Through Aruba Central
To signup AirWave Server connection through Aruba Central by creating a new customer account:

1. Navigate to Sign Up for Aruba Central site.
2. UnderAccount Details, enter an email address and password. Under Customer Details, enter the

requisite details. If you are already a Aruba Central user, it is recommended to use the same account.
If you are a Aruba Central user and an AirWave user for Data center, create a new account for AirWave
as both data sources are different.

3. Select an Aruba Central server based on your region.
4. Select Network Operations for Interested Apps.
5. Click I agree to the Terms and Conditions.
6. Click Sign Up.
7. An email is sent to the registered email address. In that email, click Activate your account here or

click the URL provided to activate the account.
8. After the account is verified, you will be redirected to theAruba Central Login site. Log in with the

registered credentials.
9. In theWelcome to Aruba Central page, select Evaluate Now.

10. Click Exit Workflow.
11. In the Exit Workflow pop-up, click Exit Now.
12. In theNetwork Operations app, set the filter to Global.
13. UnderAnalyze, click Tools > Proximity Tracing.
14. Click the configuration icon.
15. Click Airwave Connection tab. Under Status:

n Provision showsNot Provisioned
n Connection showsNot Connected
n Data Access shows Enabled

These parameters cannot be modified while provisioning.

If you signed-in using a TID loaded with Instant AP, the Airwave Connection tab is not available.
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16. Under Connection Settings, both Customer ID and Email Address are auto-filled and cannot be
edited. The values for both are obtained from the logged in user. For Secret, enter a value or click
Generate.

17. After a secret is entered or generated, click Copy to Clipboard. Paste and save the secret along with
customer ID and email address securely. These are required during AW8 configuration.

18. Click Save. The page automatically refreshes and under Status:
n Provision shows Provisioned
n Connection showsNot Connected
n Data Access shows Enabled

The Secret is hashed and cannot be viewed after it is saved.

19. After provisioning is completed, under Status:
n Provision shows Provisioned
n Connection shows Connected
n Data Access shows Enabled

AirWave Configuration
To configure AirWave to send information to Aruba Central:

1. Log in to AirWave.
2. Select 3.

AirWave Management Platform 8.2.11.1.20200628.0336 on localhost.localdomain

1 Files >

2 Backups >

3 Configuration >

4 System >

5 Users >

6 Support >

7 Security >

8 Advanced >

q >> Quit

Your choice:3

3. Select 6.

Configuration

1 Configure Network Settings

2 Set Hostname

3 Set Timezone

4 Certificates >

5 SSHD >

6 CLT >

b >> Back

Your choice:6
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4. Select 1.

CLT1 Configure CLT

2 Reconfigure CLT

3 Remove CLT

4 Test CLT GW connectivity

b >> Back

Your choice:1

Running Configure CLT

Before configuring AW8 for CLT, you are required to Sign Up on Central first.

You will require Customer ID, Email and Secret used on Central during SignUp.

You will also need to allow access from AW8 to

https://nookgw.netinsight.arubanetworks.com/ on tcp-port 443.

https://cltanalytics.s3-us-west-2.amazonaws.com on tcp-port 443

For more details, please refer to Installation Documents or contact your local

SE.

Would you like to continue? (y/N) : y
nter your Customer ID: <enter customer ID copied from Aruba Central>
Enter your CLT email ID: <enter email address copied from Aruba Central>
secret: <enter secret copied from Aruba Central>
CLT configured successfully.

Hit return to continue ...

Removing AirWave Connection
When you remove a AirWave connection, the original provisioning information will be available for a
maximum of 24 hours before it is removed. If the AirWave server was accidentally removed, it is
recommended to wait for at least 24 hours before provisioning the AirWave server again and completing
AirWave configuration.

To remove AirWave connection from Aruba Central:

1. In theNetwork Operations app, set the filter to Global.
2. UnderAnalyze, click Tools > Proximity Tracing.

3. Click the configuration icon.
4. Click Airwave Connection tab.
5. UnderRemove Airwave Connection, click Remove Airwave Connection.
6. In theRemove Airwave Connection pop-up, click Remove Airwave Connection.

Disabling Data Access
To disable access to proximity data:

1. In theNetwork Operations app, set the filter to Global.
2. UnderAnalyze, click Tools > Proximity Tracing.

3. Click the configuration icon.
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4. Click Airwave Connection tab.
5. Slide the Enable Data Access toggle to the left.

Groups for Device Configuration and Management
Aruba Central simplifies the configuration workflow for managed devices by allowing administrators to
combine a set of devices into groups. A group in Aruba Central is the primary configuration element that
functions as a container for device management, monitoring, and maintenance. Groups enable
administrators to manage devices efficiently by using either a UI-based configuration workflow or CLI-based
configuration template.

Groups provide the following functions and benefits:

n Ability to provision multiple devices in a single group. For example, a group can consist of multiple
Instant AP Virtual Controllers (VCs). These VCs can share common configuration settings and push the
configuration updates to slave Instant APs in their respective Instant AP clusters. For example, you can
apply a common security policy for the devices deployed in a specific geographical location.

n Ability to provision different types of devices in a group. For example, a group can consist of Instant APs,
Gateways, and Switches.

n Ability to create a configuration base and add devices as necessary. When you assign a new device to a
group, it inherits the configuration that is currently applied to the group.

n Ability to create a clone of an existing group. If you want to build a new group based on an existing
group, you can create a clone of the group and customize it as per your network requirements.

A device can be part of only one group at any given time.
Groups in Aruba Central are mutually exclusive (independent) and do not follow a hierarchical model.

The following figure illustrates a generic group deployment scenario in Aruba Central:

Figure 17 Group Deployment

Group Operations
The following list shows the most common tasks performed at a group level:
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n Configuration— Add, modify, or delete configuration parameters for devices in a group
n User Management—Control user access to device groups and group operations based the type of user

role
n Device Status and Health Monitoring—View device health and performance for devices in a specific

group.
n Report Generation—Run reports per group.
n Alerts and Notifications—View and configure notification settings per group.
n Firmware Upgrades—Enforce firmware compliance across all devices in a group.

Group Configuration Modes
Aruba Central allows network administrators to manage device configuration using either UI workflows or
configuration templates:

n UI-based configuration method—For device groups that use UI-based workflows, Aruba Central provides
a set of UI menu options. You can use these UI menu options to configure devices in a group. You can
also secure the UI-based device groups with a password and thus restrict user access.

n Template-based configuration method—For device groups that use a template-based workflow, Aruba
Central allows you to manage devices using configuration templates. A device configuration template
includes a set of CLI commands and variable definitions that can be applied to all other devices deployed
in a group.

If your site or store has different types of devices, such as the Instant APs, Switches, and Gateways, and you
want to manage these devices using different configuration methods, that is, either using the UI or
template-based workflows, you can create a single group and define a configuration method to use for each
type of device. This allows you to use a single group for both UI and template based configuration and
eliminates the need for creating separate groups for each configuration method.

For example, you can create a group with the nameGroup1 and within this group, you can enable template-
based configuration method for switches and UI-based configuration method for Instant APs and
Gateways. Aruba Central identifies both these groups under a single name ( Group1). If a device type in the
group is marked for template-based configuration method, the group name is prefixed with TG prefix is
added (TG Group1. You can useGroup1 as the group ID for workflows such as user management,
monitoring, reports, and audit trail.

When you add Instant APs, Gateways, and switches to a group, Aruba Central groups these devices based on
the configuration method you chose for the device type, and displays relevant workflows when you try to
access the respective configuration menu.

For information on how to create a group, see Managing Groups on page 120.

Default Groups and Unprovisioned Devices
Thedefault group is a system-defined group to which Aruba Central assigns all new devices with factory
default configuration. When a new device with factory default configuration connects to Aruba Central, it is
automatically added to thedefault group.

If a device has customized configuration and connects to Aruba Central, Aruba Central marks the device as
Unprovisioned. If you want to preserve the device configuration, you can create a new group and assign
this device to the newly created group. If you want to overwrite the configuration, you can move the
unprovisioned device to an existing group.
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The unprovisioned state does not apply to Aruba Switches as only the factory-default switches can join Aruba
Central. .

Best Practices and Recommendations
Use the following best practices and recommendations for deploying devices in groups:

n Determine the configuration method (UI or template-based) to use based on your deployment,
configuration, and device management requirements.

n If there are multiple sites with similar characteristics—for example, with the same device management
and configuration requirements—assign the devices deployed in these sites to a single group.

n Apply device-level or cluster-level configuration changes if necessary.
n Use groups cloning feature if you need to create a group with an existing group configuration settings.
n If the user access to a particular site must be restricted, create separate groups for each site.

Working with Groups
See the following topics for detailed information and step-by-step instructions on how to manage groups
and provision devices assigned to a group:

n Managing Groups
n Provisioning Devices Using UI-based Workflows
n Provisioning Devices Using Configuration Templates

Managing Groups
TheGroups page allows you to create, edit, or delete a group, view the list of groups provisioned in Aruba
Central, and assign devices to groups.

This section describes the following topics:

n Managing Groups on page 120
n Assigning Devices to Groups on page 121
n Creating a New Group by Importing Configuration from a Device on page 122
n Viewing Groups and Associated Devices on page 122
n Cloning a Group on page 123
n Moving Devices between Groups on page 123
n Configuring Device Groups on page 123
n Deleting a Group on page 124

Creating a Group
Aruba Central allows you to manage configuration for different types of devices, such as Aruba Instant APs,
Gateways, and switches in your inventory. These devices can be configured using either UI workflows or
configuration templates. You can define your preferred configuration method when creating a group.

Aruba Central allows you to create a single group with different configuration methods defined for each
device type. For example, you can create a group with the nameGroup1 and within this group, you can
enable template-based configuration method for switches and UI-based configuration method for Instant
APs and Gateways. Aruba Central identifies both these groups under a single name ( Group1). If a device
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type in the group is marked for template-based configuration method, the group name is prefixed with TG,
(TG Group1. You can useGroup1 as the group ID for workflows such as user management, monitoring,
reports, and audit trail.

After you assign devices to group and when you access configuration containers, Aruba Central
automatically displays relevant configuration options based on the configuration method you defined for
the device group.

To create a group:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. Click (+) New Group. TheCreate New Group pop-up window opens.
4. Enter a name for the group. The group name can be a maximum of 32 single byte ASCII characters if

you use the UI to create the names. However, if you are using an NB API, the character limit increases
to 128. A group name supports all special characters excluding the “>” character. System-defined
group names such as “default”, “unprovisioned”, and “global” are not allowed in group names.

By default, Aruba Central enables template-based configuration method for switches and UI-workflow-
based configuration method for Instant AP and Gateway.

5. To enable template-based configuration method for all device categories:
n For Instant APs or Gateways, select the IAP and Gateway check box.
n For Switches, ensure that Switch check box is selected. The Switch check box is enabled by

default.

6. To enable UI-based configuration method on all device categories:

a. For Instant APs and Gateways, ensure that the IAP and Gateway checkbox is cleared.

b. For switches, clear the Switch checkbox.

7. Assign a password. This password enables administrative access to the device interface.
8. Click Add Group.

You can also create a group that uses different provisioning methods for switch, and IAP and Gateway device
categories. For example, you can create a group with template-based provisioning method for switches and UI-
based provisioning method for Instant APs and Gateways.

Assigning Devices to Groups
To assign a device to a group, in theAccount Home page, underGlobal Settings, click Device Inventory:

1. Select the device that you want to assign to a group.
2. Click Assign Group. TheAssign Group pop-up window opens.
3. Select the group to which you want to assign.
4. Click Assign Device(s).
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To assign a device to a group from the Groups page:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. From the devices table on the right, select the device that you want to assign to a new group.
4. Drag and drop the device to the group to which you want to assign the device.

Viewing Groups and Associated Devices
To view the groups dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.

By default, theGroups page is displayed. The groups table on the left side of the page displays the
following information:
n Group Name—Name of the group.
n Devices—Number of devices assigned to a group.
n All Connected Devices—Total number of devices provisioned in Aruba Central. The devices

table on right side of the page shows all the devices provisioned in Aruba Central.
n Unassigned Devices—Total number of devices that are yet to be assigned. The devices table on

the right shows the devices are not assigned any group.

The devices table is not available for MSP users as the devices are primarily assigned to tenant
accounts. However, MSP administrators can drill down to a tenant account and view devices mapped to
a group.

3. To view the devices assigned to a group, select the group from the table on the left. The devices table
displays the following information:
n Name—Name of the device.
n Location—Physical location of the device.
n Type—Type of the device such as Instant AP or Switch.
n Serial—Serial number of the device.
n MAC Address—MAC address of the device.

Creating a New Group by Importing Configuration from a
Device
To import configuration from an existing device to a new group, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. Select the device from which you want to import the configuration.
4. Click Import Configuration to New Group. The Import Configuration pop-up window opens.
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5. Enter a name for the group.
6. Configure a password for the group.
7. Click Import Configuration.

Cloning a Group
To clone a group, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. To create a clone of an existing group, select the group from the groups table and click Clone
Selected Group.

4. Enter a name for the cloned group.
5. Click Add Group.

When you clone a group, Aruba Central also copies the configuration templates applied to the devices in the
group.

Moving Devices between Groups
To move a device from one group to another group:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. From the devices table on the right, select from the following device options that you want to move:
n Virtual Controller—Moving a Commander VC also moves the member IAP(s) to the new group.
n Switch stack—Moving a commander stack also moves the member switches to the new group.
n Standalone IAP—Moving a standalone IAP moves only that particular IAP to the new group.
n Standalone switch—Moving a standalone switch moves only that particular switch to the new

group.
n Gateways (MC)—Moving a standalone MC moves only that particular MC to the new group.

4. Drag and drop the device to group to which you want to assign the device.
5. Click Yes when the system prompts you to confirm device movement.

MSP mode does not support moving devices across different groups.

Configuring Device Groups
For information on provisioning devices in groups, see the following topics:

n Provisioning Devices Using UI-based Workflows on page 125
n Provisioning Devices Using Configuration Templates on page 129
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Configuring Groups in MSP Mode
For information on using groups in the MSP mode and instructions on how to assign devices to MSP
tenants, see the Aruba Central Managed Service Provider User Guide.

Deleting a Group

When you delete a group, Aruba Central removes all configuration, templates, and variable definitions
associated with the group. Before deleting a group, ensure that there are no devices attached to the group.

To delete a group:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. From the list of groups, select the group that you want to delete.
4. Click the delete icon.
5. Confirm deletion.

Assigning Devices to Groups
In Aruba Central, devices are assigned to groups for configuration, monitoring, and management purposes.
A group in Aruba Central is a primary configuration element that acts like a container. In other words,
groups are a subset of one or several devices that share common configuration settings. Aruba Central
supports assigning devices to groups for the ease of configuration and maintenance. For example, you can
create a common group for Branch Gateways or Instant APs that have similar configuration requirements.

Assigning Instant APs to Groups
The Instant AP groups may consist of the configuration elements:

n Instant AP Cluster—Consists of a master Instant AP and a set of slave Instant APs in the same VLAN.
n Virtual Controller—A virtual controller provides an interface for entire cluster. The slave Instant APs and

master Instant APs function together to provide a virtual interface.
n Master Instant AP and Slave Instant AP—In a typical Instant AP deployment scenario, the first Instant AP

that comes up is elected as the master Instant AP. All other Instant APs joining the cluster function as the
slave Instant APs. When a master Instant AP is elected, the slave Instant APs download the configuration
changes.

The following table describes the group assignment criteria for Instant APs:

APs with Default Configuration APs with Non-Default Configuration

If an Instant AP with factory default configuration joins Aruba
Central, it is automatically assigned to the default group or to
an existing group with similar configuration settings.
The administrators can perform any of the following actions:

If an Instant AP with non-default or custom
configuration joins Aruba Central, it is
automatically assigned to an unprovisioned
group.

Table 27: Instant AP Group Assignment

https://help.central.arubanetworks.com/latest/documentation/online_help/content/pdfs/aruba_central_msp_user_guide.pdf
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APs with Default Configuration APs with Non-Default Configuration

n Manually assign them to a pre-provisioned group.
n Create a new group. The administrators can perform any of the

following actions:
n Create a new group for the device and
preserve device configuration.
n Move the device to an existing group and
override the device configuration.

To manually assign Instant AP(s) to a group:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. To view a list of unassigned devices, click Unassigned Devices.

A list of unassigned devices is displayed in the devices table.

4. Select the group to which you want to assign the devices.
5. From the devices table on the right, select Instant AP(s) to assign.
6. Drag and drop the Instant APs to the group that you selected.

Assigning Switches to Groups
Aruba Central allows switches to join groups only if the switches are running factory default configuration.
Switches with factory default configuration are automatically assigned to thedefault group. Administrators
can either move the switch to an existing group or create a new group.

Provisioning and configuring of Aruba 5400R switch series and switch stacks is supported only through
configuration templates. Aruba Central does not support moving Aruba 5400R switches from the template
group to a UI group. If an Aruba 5400R switch is pre-assigned to a UI group, then the device is moved to an
unprovisioned group after it joins Aruba Central.

To manually assign switch(s) to a group:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. To view a list of unassigned devices, click Unassigned Devices. A list of unassigned devices is
displayed in the devices table.

4. Select the group to which you want to assign the devices.
5. From the devices table on the right, select the switch(s) to assign.
6. Drag and drop the switches to the group that you selected.

Provisioning Devices Using UI-based Workflows
This section describes the important points to consider when assigning devices to UI groups:
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n Provisioning Instant APs using UI-based Configuration Method on page 126
n Provisioning Switches Using UI-based Configuration Method on page 127
n Provisioning Aruba Gateways Using UI-based Configuration Method on page 128

Provisioning Instant APs using UI-based Configuration
Method
An Instant AP device group may consist of any of the following:

n Instant AP Cluster—Consists of a master Instant AP and slave Instant APs in the same VLAN.
n VC—A virtual controller. VC provides an interface for entire cluster. The slave Instant APs and master

Instant APs function together to provide a virtual interface.
n Master Instant AP and Slave Instant AP—In typical Instant AP deployment scenario, the first Instant AP

that comes up is elected as the master Instant AP. All other Instant APs joining the cluster function as the
slave Instant APs. When a master Instant AP is configured, the slave Instant APs download the
configuration changes. The master Instant AP may change as necessary from one device to another
without impacting network performance.

Aruba Central allows configuration operations at the following levels for a device group with Instant APs.

n Per group configuration—Aruba Central allows you to maintain unique configuration settings for each
group. However, these settings are applied to all devices within that group. For example, all VCs within a
group can have common SSID settings.

n Per VC Configuration—Any changes that need to applied at the Instant AP cluster level can be
configured on a VC within a group. For example, VCs within a group can have different VLAN
configuration for the SSIDs.

n Per Device Configuration—Although devices are assigned to a group, the users can maintain device -
specific configuration such as radio, power, or uplink settings for an individual AP within a group.

When the APs that are not pre-provisioned to any group join Aruba Central, they are assigned to groups
based on their current configuration.

APs with Default Configuration APs with Non-Default Configuration

If an Instant AP with factory default configuration joins Aruba
Central, it is automatically assigned to the default group or
an existing group with similar configuration settings.

The administrators can perform any of the following actions:
n Manually assign them to an existing group.
n Create a new group.

If an Instant AP with non-default or custom
configuration joins Aruba Central, it is
automatically assigned to an unprovisioned
group.

The administrators can perform any of the
following actions:

n Create a new group for the device and
preserve device configuration.
n Move the device to an existing group and
override the device configuration.

Table 28: Instant AP Provisioning

Ensure that the master Instant AP and slave Instant APs are assigned to the same group. You must convert the
slave Instant AP to a standalone AP in order to move the slave Instant AP to another group independently.
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In the following illustration, Instant APs from three different geographical locations are grouped under
California, Texas, and New York states. Each state has unique SSIDs and can support devices from multiple
locations in a state. As shown in Figure 18, the California group has devices from different locations and has
the same SSID, while devices in the other states/groups have different SSIDs.

When a device with the factory default configuration connects to Aruba Central, it is automatically assigned
to the default group. If the device has custom configuration, it is marked as unprovisioned. If you want to
preserve the custom configuration, create a new group for the device. If you want to overwrite the custom
configuration, you can assign the device to an existing group.

Figure 18 Instant AP provisioning

For more information on how to configure Instant APs using UI-based configuration workflows, see
Deploying a Wireless Network Using Instant APs on page 262.

To view local overrides and configuration errors, select a template group and navigate to Devices > Access
Points > Settings > Configuration Audit page.

Provisioning Switches Using UI-based Configuration
Method
Aruba Central allows switches to join UI groups only if the switches are running factory default
configuration. Aruba Central assigns switches with factory default configuration to thedefault group.

The administrators can either move the switch to an existing group or create a new group.

Provisioning and configuring of Aruba 5400R switch series and switch stacks is supported only through
configuration templates. Aruba Central does not support moving Aruba 5400R switches from the template group
to a UI group. If an Aruba 5400R switch is pre-assigned to a UI group, then the device is moved to an
unprovisioned group after it joins Aruba Central.

Aruba Central allows the following configuration operations at the following levels for switches in a
UI group: 

n Per group configuration— Aruba Central allows you to maintain unique configuration settings for each
group. However, these settings are applied to all devices within that group. For example, all switches
within a group can have common VLAN settings.

n Per Device Configuration—Although the Switches inherit group configuration, the users can maintain
device-specific configuration, for example, ports or DHCP pools.
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For more information on how to configure switches using UI-based configuration workflows, see
Configuring or Viewing Switch Properties in UI Groups on page 480.

To view local overrides and configuration errors, select a template group and navigate to Devices >
Switches > Settings > Configuration Audit page.

Provisioning Aruba Gateways Using UI-based Configuration
Method
For SD-Branch deployments with Aruba Gateways, the following recommendations apply:

n Combine Branch Gateways of identical characteristics and configuration requirements under a single
group.

n Create groups according to your branch requirements.

l You can create separate groups for the small, medium, and large sized branches.

l You can also create separate groups for the branch sites in different geographical locations; for example,
East Coast and West Coast branch sites. If these groups have similar characteristics with minor differences,
you can create the first group and then clone it.

l You can use either a single group for all their devices or deploy devices in multiple groups. For example, you
can deploy 7008 controllers and Aruba 2930F Switch Series with 24 ports in a single group for every branch.

l You can also deploy 7005 controller and Aruba 2930F Switch Series with 24 ports in one group and
provision 7008 controller with Aruba 2930F Switch Series with 48 ports in another group.

Important Points to Note

n The groups in Aruba Central are not device-specific, however, Aruba recommends that you use the
following guidelines for provisioning SD-WAN Gateways.

l Assign Branch Gateways and VPN Concentrators to separate groups. Because the configuration
requirements for Branch Gateways and VPN Concentrators are different, the Branch Gateways and
VPN Concentrators must be assigned to different groups.

l Ensure that the configuration group for SD-WAN Gateways consists of the same type of devices. For
example, Branch Gateways assigned to a group must have the same number of ports.
n Before assigning SD-WAN Gateways to groups, you must set the device persona or role as Branch

Gateway or VPN Concentrator.

Example
The following figures shows a few sample group deployment scenarios for Aruba Branch Gateways and
VPN Concentrators:
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Figure 19 Branch Gateway Groups

Figure 20 VPN Concentrator Groups

For more information on how to configure Aruba using UI-based configuration workflows, see the SD-
Branch Configuration section in Aruba Central Help Center.

To view local overrides and configuration errors, select a template group and navigate to Devices >
Gateways > Settings > Configuration Audit page.

Provisioning Devices Using Configuration Templates
Aruba Central allows you to provision devices using UI-based or template-based configuration method. If
you have groups with template-based configuration enabled, you can create a template with a common set
of CLI scripts, configuration commands, and variables. Using templates, you can apply CLI-based
configuration parameters to multiple devices in a group.

If the template-based configuration method is enabled for a group, the UI configuration wizards for the
devices in that group are disabled.
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Creating a Group with Template-Based Configuration
Method
To create a template group, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.

The dashboard context for selected filter is displayed.

2. UnderMaintain, click Organization.

By default, theGroups page is displayed.

3. Click (+) New Group.

TheCreate New Groupwindow is displayed.

4. Enter the name of the group.
5. Select one of the following device types for which you want to create a template group:

n IAP and Gateway
n Switch

6. Enter the password and confirm the password.
7. Click Save.

If the group is set as a template group, a configuration template is required for managing device configuration.

Provisioning Devices Using Configuration Templates and
Variable Definitions
For information on configuration template, see the following topics:

n Configuring APs Using Templates on page 427

n Using Configuration Templates for Aruba Switch Management on page 469

n Managing Variable Files on page 130

Managing Variable Files
Aruba Central allows you to configure multiple devices in bulk using templates. However, in some cases, the
configuration parameters may vary per device. To address this, Aruba Central identifies some customizable
CLI parameters as variables and allows you to modify the definitions for these variables as per your
requirements.

You can download a sample file with variables for a template group or for the devices deployed in a
template group, update the variable definitions, upload the file with the customized definitions, and apply
these configuration changes in bulk.

Important Points to Note

n Variables are associated to a device and not to a group. If you move a device between groups, variables
remain with the device.
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n Variables are displayed as part of the group to which the device belongs. After you upload the variables
for a device, the association would stay in the system even if the device is moved to a UI group or
template group.

n If the device is part of a UI group, variables are unused and not displayed in the UI. Aruba Central ignores
the variables.

n If the device is moved to a template group, variables are displayed in the UI and used for configuration
purposes.

Downloading a Sample Variables File
The sample variables file includes a set of sample variables that the users can customize. You can download
the sample variables file in the JSON or CSV format.

To download a sample variables file:

1. In theNetwork Operations app, set the filter to one of the template group underGroups.
2. UnderManage, click Devices > Switches.
3. Click theConfig icon.
4. Click Variables.
5. Select one of the following formats to download the sample variables file:

n JSON—shows the file in JSON format.
n CSV—Shows the variables in different columns.

6. Click Download Sample Variables File. The sample variables file is saved to your local directory.

Modifying a Variable File
The CSV file includes the following columns for which the variable definitions are mandatory:

n _sys_serial—Serial number of the device.
n _sys_lan_mac—MAC address of the device.
n modified—Indicates the modification status of the device. The value for this column is set to N in the

sample variables file. When you edit a variable definition, set themodified column to Y to allow Aruba
Central to parse the modified definition.

Predefined Variables for Aruba Switches
The system defined variables in the sample variables files are indicated with sys prefix.

Table 29 lists the predefined variables for switches.

Variable Name Description Variable Value

_sys_gateway Populates gateway IP
address.

 10.22.159.1

_sys_hostname Maintains unique host
name.

 HP-2920-48G-POEP

_sys_ip_address Indicates the IP address
of the device.

 10.22.159.201

Table 29: Predefined Variables Example
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Variable Name Description Variable Value

_sys_module_command Populates module lines.  module 1 type j9729a

_sys_netmask Netmask of the device.  255.255.255.0

_sys_oobm_command Represents Out of Band
Management (OOBM)
block.

oobm                          
ip address dhcp-bootp        
exit

_sys_snmpv3_engineid Populates engine ID.  00:00:00:0b:00:00:5c:b9:01:22:4c:00

_sys_stack_command Represents stack block. stacking
member 1 type "J9729A" mac-address 5cb901-
224c00
exit

_sys_template_header Represents the first two
lines of the configuration
file. Ensure that this
variable is the first line
in the template.

 ; J9729A Configuration Editor; Created on
release #WB.16.03.0003+
; Ver
#0f:3f.f3.b8.ee.34.79.3c.29.eb.9f.fc.f3.ff.37.ef:91

_sys_use_dhcp Indicates DHCP status
(true or false) of VLAN 1

 0

_sys_vlan_1_untag_command Indicates untagged ports
of VLAN 1

 1-28,A1-A2

_sys_vlan_1_tag_command Indicates tagged ports of
VLAN 1

 28-48

The _sys_template_header_ and _sys_snmpv3 engineid are mandatory variables that must have the values
populated, irrespective of their use in the template. If there is no value set for these variables, Aruba Central re-
imports the values for these mandatory variables when it processes the running configuration of the device.

Predefined Variables for APs
For APs, the sample variables file includes the _sys_allowed_ap variable for which you can specify a value to
allow new APs to join the Instant AP cluster.

Conditions
The following conditions apply to the variable files:

n The variable names must be on the left side of condition and its value must be defined on the right side.
For example, %if var=100% is supported and %if 100=var% is not supported.

n The < or <= or > or >= operators should have only numeric integer value on the right side. The variables
used in these 4 operations are compared as integer after flooring. For example, if any float value is set as
%if dpi_value > 2.8%, it is converted as %if dpi_value > 2 for comparison.

n The variable names should not include white space, and the& and % special characters. The variable
names must match regular expression [a-zA-Z0-9_]. If the variables values with % are defined, ensure
that the variable is surrounded by space. For example, wlan ssid-profile %ssid_name%.

n The first character of the variable name must be an alphabet. Numeric values are not accepted.
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n The values defined for the variable must not include spaces. If quotes are required, they must be
included as part of the variable value. For example, if the intended variable name iswlan ssid-profile "emp
ssid”, then the recommended format for the syntax is "wlan ssid-profile %ssid_name%” and variable as
“ssid_name”: "\"emp ssid\"".

n If the configuration text has the percentage sign % in it—for example, "url "/portal/scope.cust-
5001098/Splash%20Profile%201/capture"—Aruba Central treats it as a variable when you save the
template. To allow the use of percentage% as an escape character, use \" in the variable definition as
shown in the following example:

Template text

wlan external-captive-portal

"Splash Profile 1_#guest#_"server naw1.cloudguest.central.arubanetworks.comport

url %url%

Variable

"url": "\"/portal/scope.cust-5001098/Splash%20Profile%201/capture\""

n Aruba Central supports adding multiple lines of variables in Instant AP configuration templates. If you
want to add multiple lines of variables, you must add the HAS_MULTILINE_VARIABLE directive at the
beginning of the template.

Example

#define HAS_MULTILINE_VARIABLE 1

%if allowed_aps%

%allowed_aps%

%endif%

Variable

“allowed_aps”: “allowed-ap 24:de:c6:cb:76:4e\n allowed-ap ac:a3:1e:c5:db:d8\n

allowed-ap 84:d4:7e:c4:8f:2c"

For Instant APs, you can configure a variable file with a set of values defined for a master AP in the network.
When the variable file is uploaded, the configuration changes are applied to all Instant AP devices in the cluster.

Examples

The following example shows the contents of a variable file in the JSON format for Instant APs:

{ 

"CK0036968": {

"_sys_serial": "CK0036968",

"ssid": "s1",

"_sys_lan_mac": "ac:a3:1e:c5:db:7a",

"vc_name": "test_config_CK0036968",

"org": "Uber_org_test",

"vc_dns_ip":"22.22.22.22",
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"zonename": "Uber_1",

"uplinkvlan": "0",

"swarmmode": "cluster",

"md5_checksum": "ed8a67a3d1be58261640ca53f8fd3bb8",

"hostname": "Uber_1"

},

"CJ0219729": {

"_sys_serial": "CJ0219729",

"ssid": "s1",

"_sys_lan_mac": "ac:a3:1e:cb:04:92",

"vc_name": "test_config_CK0036968",

"org": "Uber_org_test",

"vc_dns_ip":"22.22.22.22",

"zonename": "Uber_1",

"uplinkvlan": "0",

"swarmmode": "cluster",

"md5_checksum": "ed8a67a3d1be58261640ca53f8fd3bb8",

"hostname": "Uber_2"

},

"CK0112486": {

"_sys_serial": "CK0112486",

"ssid": "s1",

"_sys_lan_mac": "ac:a3:1e:c8:29:76",

"vc_name": "test_config_CK0036968",

"org": "Uber_org_test",

"vc_dns_ip":"22.22.22.22",

"zonename": "Uber_1",

"uplinkvlan": "0",

"swarmmode": "cluster",

"md5_checksum": "ed8a67a3d1be58261640ca53f8fd3bb8",

"hostname": "Uber_3"

},

"CT0779001": {

"_sys_serial": "CT0779001",

"ssid": "s1",

"_sys_lan_mac": "84:d4:7e:c5:c6:b0",

"vc_name": "test_config_CK0036968",

"org": "Uber_org_test",

"vc_dns_ip":"22.22.22.22",

"zonename": "Uber_1",

"uplinkvlan": "0",

"swarmmode": "cluster",

"md5_checksum": "ed8a67a3d1be58261640ca53f8fd3bb8",

"hostname": "Uber_4"

},

"CM0640401": {

"_sys_serial": "CM0640401",

"ssid": "s1",

"_sys_lan_mac": "84:d4:7e:c4:8f:2c",

"vc_name": "test_config_CK0036968",

"org": "Uber_org_test",

"vc_dns_ip":"22.22.22.22",

"zonename": "Uber_1",

"uplinkvlan": "0",

"swarmmode": "cluster",

"md5_checksum": "ed8a67a3d1be58261640ca53f8fd3bb8",

"hostname": "Uber_6"

},

"CK0037015": {

"_sys_serial": "CK0037015",

"ssid": "s1",

"_sys_lan_mac": "ac:a3:1e:c5:db:d8",
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"vc_name": "test_config_CK0036968",

"org": "Uber_org_test",

"vc_dns_ip":"22.22.22.22",

"zonename": "Uber_1",

"uplinkvlan": "0",

"swarmmode": "cluster",

"md5_checksum": "ed8a67a3d1be58261640ca53f8fd3bb8",

"hostname": "Uber_7"

},

"CK0324517": {

"_sys_serial": "CK0324517",

"ssid": "s1",

"_sys_lan_mac": "f0:5c:19:c0:71:24",

"vc_name": "test_config_CK0036968",

"org": "Uber_org_test",

"vc_dns_ip":"22.22.22.22",

"zonename": "Uber_1",

"uplinkvlan": "0",

"swarmmode": "cluster",

"md5_checksum": "ed8a67a3d1be58261640ca53f8fd3bb8",

"hostname": "Uber_8"

}

}

Figure 21 shows a sample variables file in the CSV format:

Figure 21 Variables File in the CSV Format

Uploading a Variable File
To upload a variable file, complete the following steps:

While uploading the variables file to Aruba Central in the CSV format, make sure to choose the default language
in Microsoft Excel as English (United States).

1. Ensure that the _sys_serial and _sys_lan_mac variables are defined with the serial number and MAC
address of the devices, respectively.

2. In theNetwork Operations app, set the filter to one of the template groups underGroups.
3. UnderManage, click Devices > Switches.
4. Click theConfig icon.
5. Click Variables.
6. Click Upload Variables File and select the variable file to upload.
7. Click Open. The contents of the variable file is displayed in theVariables table.
8. To search for a variable, specify a search term and click Search icon.
9. To download variable file with device-specific definitions, click the download icon in theVariables

table.

Modifying Variables
To modify variables without downloading a variable file, modifying the variable file, and uploading the
customized variable file:
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1. In theNetwork Operations app, set the filter to one of the template groups underGroups.
2. UnderManage, click Devices > Switches.
3. Click theConfig icon.
4. Click Variables.
5. Select a device and variable.
6. Modify the value and click Add to Modifications.
7. Click Save.

Alternatively, to modify a single variable without downloading a variable file, modifying the variable file, and
uploading the customized variable file:

1. In theNetwork Operations app, set the filter to one of the template groups underGroups.
2. UnderManage, click Devices > Switches.
3. Click theConfig icon.
4. Hover over a desired variable and click Edit.
5. Modify the value and click Save.
6. Click Save.

Backing Up and Restoring Configuration Templates
Aruba Central allows you to create a backup of configuration templates and variables that you can restore in
the event of a failure or loss of data. TheConfiguration Backup and Restore feature is available in the
Configuration Audit page for devices deployed using the template-based configuration method.

TheConfiguration Backup and Restore feature enables administrators to perform the following
functions:

n Back up templates and variable files applied to the devices, managed using the template-based
configuration method.

n Restore an earlier known working combination of the configuration template and device variables in the
event of a failure.

Important Points to Note
n The backup and restoration options are available for devices deployed using the template-based

configuration method.
n When the backup or restore for a group is in progress, you cannot make configuration changes to that

group.
n The restore operation restores the variables only for the devices that are currently provisioned or pre-

provisioned to the group.
n The restore operation is terminated if the firmware version running on any one device in the group does

not match the firmware version in the backed up file that is being restored. For example, if the
configuration file was backed up when a switch was running 16.03.0003 and was later upgraded to
16.04.0003, the restore operation fails for the group.

n The restore operation deletes any templates applied to the group before the restore. It also deletes and
replaces device variables with the backed up version that is being restored.

n The details pertaining to the actions carried out during the backup and restore operations are logged in
theAudit Trail page.
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Creating a Configuration Backup
To back up configuration templates and variables applied to devices:

1. In theNetwork Operations app, set the filter to one of the template group underGroups.
2. Navigate to theConfiguration Audit page. See Viewing Configuration Status.
3. Under Configuration Backup and Restore, click New Configuration Backup. TheCreate New

Backupwindow is displayed.
4. Enter aBackup Name.
5. Select Do Not Delete if you do not want the backed up file to be deleted by a new backup after the

threshold of 20 backups is exceeded.

You can create and maintain up to 20 backed up configuration files. If the number of backup files exceed
20, the old backed up configuration files are overwritten. However, if the backed up files are marked as
Do not Delete, Aruba Central does not overwrite the backed up configuration files.

6. Click OK. TheConfirm Backupwindow is displayed.
7. Read through the information. Select the check box to confirm that configuration changes to the

group cannot be done when the backup is in progress.
8. Click Proceed. The backup for the group configuration is created.

Viewing Contents of a Backed Up Configuration
To view the contents of a backed up configuration:

1. Click theManage Backup option.
2. Download the backup and untar the downloaded file. The following example shows the tree

structure of a typical backup download.

<backup-name_timestamp>

├── templates

│ ├──<hppctemplate1.tmpl>

│ ├──<iaptemplate1.tmpl>

│ ├──template_meta.json

└── variables

├──HPPC_variables_1.json

├──IAP_variables_1.json

└──devices_meta.json

The variables are stored according the device type, such as, Instant APs and Aruba Switches. For example, for
all Instant APs, the variables are aggregated and stored together.
The aggregated file can include variables for up to 80 devices or up to 5 MB of variables data, based on
whichever condition is met first. When the number of variables or the data size exceeds this limit, new
aggregate files are created and added to the backup until all the variables in the selected group are backed up.
The variable data limit applies only to the aggregated files. Aruba Central does not impose any limit on the
number of devices or the device variables that can be backed up.

The following details are available for a backed up configuration snapshot:
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n Backups—provides details of the number of available and allowed backup and allows you to perform
the following actions:

l Manage group configuration backups

l Create new configuration backups

l Modify backup delete protection
n Last Backup—provides details of the status and the timestamp of the last backup.
n Last Restore—provides details of the status and the timestamp of the last restore.

Restoring a Backed Up Configuration
To restore a backed up configuration snapshot:

1. In theNetwork Operations app, use the filter to select a group that uses template-based
configuration method.

2. Navigate to theConfiguration Audit page. See Viewing Configuration Status.
3. Under Configuration Backup and Restore, click Restore Configuration Backup. TheRestore

from Backupwindow is displayed.
4. Select the backup name that you want to restore, from theBackup Name drop-down list.
5. Select the required device type from theDevice Type drop-down list.

Selecting a device type allows you to restore the backed up configuration by the specific device type, for
example, Instant APs, Aruba Switch. By default, All is selected. When the device type is set to All,
configuration restore does not follow any specific order.

6. Click OK. TheConfirm Configuration Restore window is displayed.
7. Read the instructions and select the check boxes to confirm your action for configuration restore.
8. Click Proceed. The selected backup configuration is restored.

Aruba recommends that the administrators take a backup of the current configuration of the group before the
restore operation.

Managing Backups
To manage the backed up configuration files:

1. In theNetwork Operations app, use the filter to select a group that uses template-based
configuration method.

2. Navigate to theConfiguration Audit page. See Viewing Configuration Status.
3. Under Configuration Backup and Restore, click Manage Backup. The Last <#> Backups

window is displayed.
4. View the backup details such as date and time of backup, backup name, username, and the delete

protection status for each configuration backup.
5. Click Close.
6. Click Last Backup Log to view the details of the latest backup. The Last Backup Log window

displays the following details:
n Group name
n Backup name
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n Username that initiated the configuration backup
n Details on whether templates and device variables are being saved, and completion of the

configuration backup process.

7. To get the status of the last restore, click Last Restore Log. To get the error log for a restore error
event, click Last Restore Error Log.

Backing Up and Restoring Templates and Variables Using APIs
Aruba Central supports the following NB APIs for the backup and restore feature:

n Create new configuration backup for group

[POST] /configuration/v1/groups/snapshot/{group}

n Create backups for multiple groups associated with a customer account

[POST]/configuration/v1/groups/snapshot/create_backups

Aruba Central creates a backup of configuration template and variables only for the groups included in the
API request payload. You can use the include or exclude parameters to create backups for specific list of
groups.

The following table describes the API response based on the inputs provided in the parameters:

include_groups exclude_groups API Functionality

No groups specified No groups specified Raises an exception to either include or exclude
groups.

group names group names Raises an exception to include or exclude groups.

[] No groups specified Raises an exception to provide valid values for the
include groups parameter.

group names No groups specified Includes selected groups for the backup operation.

No groups specified ALL_GROUPS Creates a backup for all groups.

No groups specified group names Does not create backup for the excluded groups.

Table 30: API Functionality for Backup Creation

n Restore a backed up version of the configuration template for all devices in a group:

[POST] /configuration/v1/groups/<group_name>/snapshots/<snapshot_name>/restore
The API restores a specific version of the backup snapshot for the group specified in the API request.

n Restore a backed up version of the configuration template by device type:

The [POST]/configuration/v1/groups/{group}/snapshots/{snapshot}/restore API provides you an
option to restore the configuration by device type. By selecting a specific device type, you can control the
order in which the configuration is restored by device type. This minimizes the impact of the
configuration restore activity on the network.
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If monitor mode is enabled at the device level, the selected device functions in the monitor mode. If the monitor
mode is enabled at the group level, all devices in the group inherit this setting.
If a device managed by Aruba Central displays a configuration sync issue and persistently fails to receive
configuration updates from Aruba Central, contact Aruba Central Technical Support.

Managing Sites
The Sites page allows you to create sites, view the list of sites configured in your setup, and assign devices
to sites. The Sites page includes the following functions:

Name Contents of the Table

Convert
Labels
to Sites

Allows you to convert existing labels to sites. To convert labels, download the CSV file with the list of
labels configured in your setup, add the site information, and upload the CSV file. For more
information, see Creating a Site on page 140.

Sites
table

Displays a list of sites configured. It provides the following information:
n Site Name—Name of the site.
n Address—Physical address of the site.
n Device Count—Number of devices assigned to a site.

The table also includes the following sorting options to reset the table view on the right:
n All Devices—Displays all the devices provisioned in Aruba Central.
n Unassigned—Displays the list of devices that are not assigned to any site.

You can also use the filter and sort icons on the Sites and Address columns to filter and sort sites
respectively.

New
Site

Allows you to create a new site.

Bulk
upload

Allows you to add sites in bulk from a CSV file.

Devices
table

Displays a list of devices provisioned. It provides the following information:
n Name—Name of the device
n Group—Group to which the device is assigned.
n Type—Type of the device.

Table 31: Sites Page

Creating a Site
To create a site, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Site(s).
5. To add a new site, click (+) New Site. TheCreate New Site pop-up window opens.
6. In theCreate New Site pop-up window, enter the following details:

a. Site Name—Name of the site. The site name can be a maximum of 255 single byte characters.
Special characters are allowed.

b. Street Address—Address of the site.
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c. City—City in which the site is located.

d. Country—Country in which the site is located.

e. State/Province—State or province in which the site is located.

f. ZIP/Postal Code—(Optional) ZIP or postal code of the site.

7. Click Add. The new site is added to the Sites table.

Adding Multiple Sites in Bulk
To import site information from a CSV file in bulk, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Site(s).
5. Click (+) Bulk upload. TheBulk Upload pop-up opens.
6. Download a sample file.
7. Fill the site information and save the CSV file in your local directory.

The CSV file for bulk upload of sites must include the mandatory information such as the name, address,
city, state, and country details.

8. In the Aruba Central UI, click Browse and add the file from your local directory.
9. Click Upload. The sites from the CSV file are added to the site table.

Assigning a Device to a Site
To assign devices to a site, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Site(s).
5. Select Unassigned. The list of devices that are not assigned to any site is displayed.
6. Select device(s) from the list of devices.
7. Drag and drop the devices to the site on the left. A pop-up window opens and prompts you to

confirm the site assignment.
8. Click Yes.

Converting Existing Labels to Sites
To convert existing labels to sites, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
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4. Set the toggle switch to Site(s).
5. Click Convert Labels to Sites. TheConfirm Conversion pop-up window opens.
6. To download a CSV file with the list of labels configured in your setup, click Download a File. A CSV

file with a list of all the labels in your setup is downloaded to your local directory.
7. Enter address, city, state, country, and ZIP code details for the labels that you want to convert to

sites.

In the CSV file, you must enter the following details: address, city, state, and country.

8. Save the CSV file.
9. On theConfirm Conversion pop-up window, click Browse and select the CSV file with the list of

labels to convert.
10. Click Upload.
11. Click Convert. The labels are converted to sites.

Points to Note

n If the conversion process fails for some labels, Aruba Central generates and opens an Excel file showing a
list of labels that could not be converted to sites. Verify the reason for the errors, update the CSV file, and
re-upload the file.

n Aruba Central does not allow conversion of sites to labels. If the existing labels are converted to sites, you
cannot revert these sites to labels.

n When the existing labels are converted to sites, Aruba Central retains only the historical data for these
labels. Aruba Central displays the historical data for these labels only in reports and on the monitoring
dashboard.

Editing a Site
To modify site details, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Site(s).
5. Select the site to edit and click the edit icon.
6. Modify the site information and click Update.

Deleting a Site
To delete a site, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Site(s).
5. Select the site to delete and click the delete icon.
6. Confirm deletion.
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Managing Labels
The Labels page allows you to create labels, view a list of labels, and assign devices to labels. The page
includes two tables. The table on the left lists the labels, whereas the table on the right lists the devices.
These tables provide the following information:

Name Contents of the Table

Labels Displays a list of labels configured. The table provides the following information:
n Name of the label
n Number of devices assigned to a label

The table also includes the following sorting options to reset the table view on the right:
n All Devices—Displays all the devices provisioned in Aruba Central.
n Unassigned—Displays the list of devices that are not assigned to any label.

Devices Displays a list of devices provisioned. The table provides the following information about the devices:
n Name—Name of the device
n Group—Group to which the device is assigned
n Type—Type of the device
n Labels—Number of labels assigned to a device

Table 32: Labels

Creating a Label
To create a label, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Labels.
5. To add a new label, click (+) Add Label. TheCreate New Label pop-up window opens.
6. Enter a name for the label. The label name can be a maximum of 255 single byte characters. Special

characters are allowed.
7. Click Add. The new label is added to theAll Labels table.

Assigning a Label to a Device
To assign a label to a device, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Labels.
5. Locate the label to which you want to assign a device.
6. In the table that lists the labels, you can perform one of the following actions:

n Click All Devices to view all devices.
n Click Unassigned to view all the devices that are not assigned to any labels.

7. Select Unassigned. The list of devices that are not assigned to any label is displayed.
8. Select device(s) from the list of devices.
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9. Drag and drop the selected device(s) to a specific label. A pop-up window asking you to confirm the
label assignment opens.

10. Click Yes.

Aruba Central allows you to assign up to five label tags per device.

Detaching a Device from a Label
To remove a label assigned to a device, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Labels.
5. Select the device from the table on the right.
6. Click the delete icon.
7. To detach labels from the multiple devices at once, select the devices, and click Batch Remove

Labels.
8. Confirm deletion.

Editing a Label
To edit a label, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Labels.
5. Select the label to edit.
6. Click the edit icon.
7. Edit the label and click Update.

Deleting a Label
To delete one or several labels, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Sites and Labels tab.
4. Set the toggle switch to Labels.
5. Select the label to delete.
6. Click the delete icon.
7. Confirm deletion.

Viewing Configuration Status
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Aruba Central provides an audit dashboard for reviewing configuration changes for the devices provisioned
in UI and template groups. TheConfiguration Audit page is available for Instant APs, switches, and
gateways.

Viewing the Configuration Audit Page
To view theConfiguration Audit page, complete the following steps:

n For Instant APs:
a. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the selected group is displayed.

b. UnderManage, click Devices > Access Points.
c. Click theConfig icon.

The tabs to configure access points are displayed.

d. Click Show Advanced, and click theConfiguration Audit tab.

The Configuration Audit details page is displayed.

Aruba Central now constantly displays the default tabs under the Show Advanced and Hide
Advanced option in the Devices > Access Points page. When you click the Show Advanced or
Hide Advanced option and navigate out of the page, the respective default tabs under Show
Advanced or Hide Advanced option are still displayed when you visit the page next time.

n For Aruba switches:
a. In theNetwork Operations app, set the filter to a group that contains at least one switch.

The dashboard context for the selected group is displayed.

b. Under Manage, click Devices > Switches.
c. Click theConfig icon.

The tabs to configure switches are displayed.

d. Click Configuration Audit.
The Configuration Audit details page is displayed.

n For Aruba gateways:
a. In theNetwork Operations app, set the filter to a group that contains at least one Branch

Gateway.

The dashboard context for the selected group is displayed.

b. Under Manage, click Devices > Gateways.
c. Click theConfig icon.

The tabs to configure gateways are displayed.

d. Click Show Advanced, and click theConfiguration Audit tab.

The Configuration Audit details page is displayed.

Applying Configuration Changes
Aruba Central supports a two-staged configuration commit workflow for Instant APs and switches. Aruba
Central now supports the auto commit feature at a group level. When auto commit state is enabled for a
group, the configuration changes are instantly applied to all devices where auto commit state is enabled.
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In theConfiguration Audit page of the group, theAuto Commit State section allows administrators to
switch their preference for committing configuration changes to the devices within the group.

n To enable auto commit, click Change to Auto commit state ON. When auto commit state is enabled
for a group, the configuration changes are instantly applied to all devices where auto commit state is
enabled.

n To disable auto commit, click Change to Auto commit state OFF. When auto commit state is disabled
for a group, an administrator can build a candidate configuration, save it on cloud, review it, and then
commit the configuration changes to all devices within the group.

Aruba Central resets the auto commit state, when a device moves to another group. The device inherits the
auto commit state of the group to which the device is moved.
When auto commit state is disabled for a group, Aruba Central restricts modification to the auto commit state
at a device level. When auto commit state is enabled for a group, Aruba Central allows modification to the auto
commit state at a device level.
The auto commit at a group level is not applicable for Aruba MAS switches and Aruba gateways in the
Configuration Audit page. Auto commit state is always enabled for Aruba MAS switches and Aruba gateways.

Viewing and Editing
To modify the auto commit state of devices within the group, when Auto Commit State for a group is
enabled, complete the following steps:

1. Click theView & Edit link underAuto Commit State: ON tile.
2. Select a device name, click Disable Auto Commit, and then click OK.
3. Click Yes in theConfirm Action dialog box.

To modify the auto commit state of devices within the group, when Auto Commit State for a group is
disabled, complete the following steps:

1. Click theView & Edit link underAuto Commit State: OFF tile.
2. Select a device name, click Enable Auto Commit, and then click OK.
3. Click Yes in theConfirm Action dialog box.

When auto commit state for a group is disabled, the View & Edit link is disabled to restrict modifications to the
auto commit state of the devices within the group. When auto commit state for a group is enabled, the View &
Edit link allows you to modify the auto commit state of the devices within the group.

Auto Commit Workflow
To enable Aruba Central to commit configuration changes instantly, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP and a switch.

The dashboard context for the selected group is displayed.
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2. UnderManage, click Devices > Access Points.

In Aruba Central, the auto commit workflow for a group can be implemented either from the switch
configuration audit page or Instant AP configuration audit page. Alternatively, you can navigate to
Devices > Switches.

3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click Show Advanced, and click theConfiguration Audit tab.

The Configuration Audit details page is displayed.

5. Ensure that theAuto Commit State for the group is set to ON.
6. Based on configuration mode set for the devices in the group, use either the UI workflows or a

configuration template to complete the configuration workflow and save the changes. Aruba Central
automatically commits the configuration changes to all devices where auto commit state is enabled.

7. View the Local Overrides and Configuration Sync Issues, if any.

Aruba Central does not support the two-staged configuration commit workflow for Aruba MAS switches and
Aruba gateways.
The tenant accounts in the MSP deployments do not inherit the Auto Commit State configured at the MSP
level. The tenant account users can enable or disable Auto Commit state for the devices in their respective
accounts.

Manual Commit Workflow
To build configuration and review it before committing the configuration changes, complete the following
steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP and a switch.

The dashboard context for the selected group is displayed.

2. UnderManage, click Devices > Access Points.

In Aruba Central, the manual commit workflow for a group can be implemented either from the switch
configuration audit page or Instant AP configuration audit page. Alternatively, you can navigate to
Devices > Switches.

3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click Show Advanced, and click theConfiguration Audit tab.

The Configuration Audit details page is displayed.

5. Ensure that theAuto Commit State for the group is set to OFF.
6. Based on configuration mode set for the device, use either the UI workflows or a configuration

template to complete the configuration workflow and save the changes. When you try to save the
save changes, Aruba Central displays the following warning message:
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7. When the auto commit state for a group is set to OFF, and changes are configured to the devices at a
group level, Aruba Central displays the following warning message when you try to save the changes:

8. View the Local Overrides and Configuration Sync Issues, if any.
9. Click Commit Now to commits the configuration changes to all devices within the group.

Viewing Configuration Overrides and Errors
TheConfiguration Audit page allows you to view the configuration push errors, template synchronization
errors, configuration sync, and device level configuration overrides. Some of notable status indicators
available on the page includes:

n Failed/Pending Changes—Provides details of the number of devices with configuration sync errors. To
view the devices with configuration sync errors, click the Failed/Pending config changes link. The
Config Difference pop-up window opens. You can view configuration differences for each device within
the group.

n Local Overrides—Provides details of the number of devices with local overrides. To view a complete list
of overrides, click theManage Local Overrides link. The Local Overrides pop-up window opens. You
can view configuration differences for each device within the group. To preserve the overrides, click
Close. To remove the overrides, select the group name with local override, click Remove and click OK.

n Configuration Conflicts—Provides details of the number of devices with configuration conflict errors.
To view a complete list of configuration conflicts, click theManage Configuration Conflicts link. The
Configuration Conflict pop-up window opens. To resolve the configuration conflicts, enable the
checkbox against each conflict, and then click Remove to remove the conflict.

n Template Errors—Provides the details of the number of devices with template errors. To view a
complete list of configuration template errors, click theView Template Errors link. The Template
Errors pop-up window opens. You can view a list of templates with errors.

n Move Failures—Aruba Central supports moving a device from one group to another. If the move
operation fails, Aruba Central logs such instances asMove Failures.

Viewing Configuration Status for Devices at the Group Level
(Template Configuration Mode)
When you select a template group from the filter, theConfiguration Audit page displays the following
information:

Data Pane Content Description

Template Errors Provides details of the number of devices with
template errors for the selected template group.

Table 33: Configuration Audit Status for a Template Group
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Data Pane Content Description

Devices deployed in the template group are
provisioned using configuration templates. If
there are errors in the templates or variable
definitions, the configuration push to the devices
fails. Aruba Central records such failed instances
as template errors and displays these errors on
the Configuration Audit page.
To view a complete list of errors, click View
Template Errors. The Template Errors pop-up
window allows you to view and resolve the
template errors issues if any.

Failed/Pending Changes Provides details of the number of devices with
configuration sync errors for the selected
template group. To view and resolve the
configuration sync errors, click the
Failed/Pending config changes link.

Configuration Backup &
Restore

Allows you to create a backup of templates and
variables applied to the devices in the template
group. For more information, see Backing Up and
Restoring Configuration Templates.

n New Configuration Backup—Allows you
to create a new backup of templates and
variables applied to the devices in the
template group.

All Devices The All Devices table provides the following
device information for the selected group:

n Name—The name of the device.
n Type—The type of the device.
n Auto Commit—The status of the auto
commit state for all the devices within the
group.
n Config Sync—Indicator showing
configuration sync errors.
n Template Errors—Indicator showing
configuration template errors for the devices
deployed in template groups.

Table 33: Configuration Audit Status for a Template Group

Viewing Configuration Status for a Device (Template Configuration
Mode)
When you select a device that is provisioned in a template group, theConfiguration Audit page displays
the following information:

Data Pane Content Description

Template Applied Displays the template that is currently applied on the
selected device.

Table 34: Configuration Audit Status for Devices in Template Groups
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Data Pane Content Description

Template Errors Displays the number of template errors for the
selected device. To view a complete list of errors, click
View Template Errors.

Failed/Pending Changes Displays the configuration sync errors for the
selected device. To view and resolve the configuration
sync errors, click the Failed/Pending config
changes link.

Config Comparison Tool Allows you to view the difference between the current
configuration and the configuration that is yet to be
pushed to the device (pending configuration).
To view the current and pending configuration
changes side by side, click View.

Table 34: Configuration Audit Status for Devices in Template Groups

Viewing Configuration Status for Devices at the Group Level (UI-
based Configuration Mode)
When you select an UI group, theConfiguration Audit page displays the following information:

Data Pane Content Description

Failed/Pending Changes Displays the number of devices with
configuration sync errors for the
selected UI group.
To view and resolve the configuration
sync errors, click the Failed/Pending
config changes link.

Local Overrides Displays the number of devices with
local overrides. To view a complete
list of overrides, click the Manage
Local Overrides link. The Local
Overrides pop-up window opens.

n To preserve the overrides, click
Close.
n To remove the overrides, select
the group name with local
override, click Remove and then
click OK.

All Devices The All Devices table provides the
following device information for the
selected group:

n MAC Address—MAC address
of the device.
n Name—The name of the
device.
n IP Address—IP address of the
device.
n Site—Name of the site to which
the device is assigned.
n Type—The type of the device.

Table 35: Configuration Audit Status for a UI Group
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Data Pane Content Description

n Auto Commit—The status of
the auto commit state for all the
devices within the group.
n Config Sync/Config Status—
Indicator showing configuration
sync errors.
n Local Overrides—Indicator
showing configuration overrides
for the devices deployed in the UI
groups.

NOTE: The MAC Address, IP
Address, Site, and Config Status
columns are available only for groups
in which Aruba gateways are
provisioned (Manage > Device >
Gateways, click the Config icon. The
gateway configuration page is
displayed. Navigate to Configuration
Audit).

Table 35: Configuration Audit Status for a UI Group

Viewing Configuration Status for a Device (UI-based Configuration
Mode)
When you select a device assigned to a UI group, theConfiguration Audit page displays the following
information:

Data Pane
Content

Description

Failed/Pending
Changes

Displays the number of devices with configuration sync errors for the selected device.
To view and resolve the configuration sync errors, click the Failed/Pending config
changes link.

Local Overrides Displays the number of local overrides. To view a complete list of overrides, click the
Manage Local Overrides link.
The Local Overrides pop-up window opens.

n To preserve the overrides, click Close.
n To remove the overrides, click Remove, and then click OK.

Table 36: Configuration Audit Status for a Device Assigned to a UI Group

Backing up and Restoring Configuration Templates
Aruba Central allows you to back up configuration templates assigned to the devices deployed in a template
group. TheConfiguration Audit pages for Instant AP, switch, and gateway configuration containers allow
you to create and manage backed up files and restore these files when required. For more information, see
Backing Up and Restoring Configuration Templates.
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If monitor mode is enabled at the device level, the selected device functions in the monitor mode. If the monitor
mode is enabled at the group level, all devices in the group inherit this setting.
If a device managed by Aruba Central displays a configuration sync issue and persistently fails to receive
configuration updates from Aruba Central, contact Aruba Central Technical Support.

Connecting Devices to Aruba Central
Aruba devices support automatic provisioning, also known as ZTP. In other words, Aruba devices can
download provisioning parameters from Aruba Activate and connect to their management entity once they
are powered on and connected to the network.

Although most of the communication between devices on the remote site and Aruba Central server in the
cloud is carried out through HTTPS (TCP 443), you may want to open the following ports for devices to
communicate over network firewall.

This section includes the following topics:

n Domain names for Aruba Central Portal Access on page 152
n Domain Names for Device Communication with Aruba Central on page 152
n Domain Names for Device Communication with Aruba Activate on page 153
n Cloud Guest Server Domains for Guest Access Service on page 153
n Domain Names for OpenFlow on page 154
n Other Domain Names on page 155

Domain names for Aruba Central Portal Access

Region Domain Name Protocol

US-1 portal.central.arubanetworks.com HTTPS
TCP port 443

US-2 portal-prod2.central.arubanetworks.com HTTPS
TCP port 443

EU-1 portal-eu.central.arubanetworks.com HTTPS
TCP port 443

Canada-1 portal-ca.central.arubanetworks.com HTTPS
TCP port 443

China-1 portal.central.arubanetworks.com.cn HTTPS
TCP port 443

APAC-1 portal-apac.central.arubanetworks.com HTTPS
TCP port 443

APAC-EAST1 portal-apaceast.central.arubanetworks.com HTTPS
TCP port 443

APAC-SOUTH1 portal-apacsouth.central.arubanetworks.com HTTPS
TCP port 443

Table 37: Domain Names and URLs for Aruba Central Portal Access

Domain Names for Device Communication with Aruba Central
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Regi
on Aruba Central URL URL for Device

Connectivity
Proto
col

FQDNs for SD-WAN
Orchestrator Service

US-1 app.central.arubanetworks.co
m

app1.central.arubanetworks.c
om

HTTPS
TCP
port
443

app1-
h2.central.arubanetworks.
com

US-2 app-
prod2.central.arubanetworks.
com

device-
prod2.central.arubanetworks.
com

HTTPS
TCP
port
443

device-prod2-
h2.central.arubanetworks.
com

EU-1 app2-
eu.central.arubanetworks.co
m

device-
eu.central.arubanetworks.co
m

HTTPS
TCP
port
443

device-eu-
h2.central.arubanetworks.
com

Cana
da-1

app-
ca.central.arubanetworks.co
m

device-
ca.central.arubanetworks.co
m

HTTPS
TCP
port
443

device-ca-
h2.central.arubanetworks.
com

Chin
a-1

app.central.arubanetworks.co
m.cn

device.central.arubanetworks.
com.cn

HTTPS
TCP
port
443

device-
h2.central.arubanetworks.
com.cn

APAC-
1

app2-
ap.central.arubanetworks.co
m

app1-
ap.central.arubanetworks.co
m

HTTPS
TCP
port
443

app1-ap-
h2.central.arubanetworks.
com

APAC-
EAST
1

app-
apaceast.central.arubanetwor
ks.com

device-
apaceast.central.arubanetwor
ks.com

HTTPS
TCP
port
443

device-apaceast-
h2.central.arubanetworks.
com

APAC-
SOUT
H1

app-
apacsouth.central.arubanetw
orks.com

device-
apacsouth.central.arubanetw
orks.com

HTTPS
TCP
port
443

device-apacsouth-
h2.central.arubanetworks.
com

Table 38: Domain Names for Device Communication with Aruba Central

Domain Names for Device Communication with Aruba Activate

Domain Name Protocol

device.arubanetworks.com HTTPS
TCP port 443

devices-v2.arubanetworks.com

Table 39: Domain Names for Device
Communication with Aruba Activate

Cloud Guest Server Domains for Guest Access Service
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Region Domain Name Protocol

US-1 nae1.cloudguest.central.arubanetworks.com TCP port 2083
TCP port 443

nae1-elb.cloudguest.central.arubanetworks.com TCP port 443

US-2 naw2.cloudguest.central.arubanetworks.com TCP port 2083
TCP port 443

naw2-elb.cloudguest.central.arubanetworks.com TCP port 443

EU-1 euw1.cloudguest.central.arubanetworks.com TCP port 2083
TCP port 443

euw1-elb.cloudguest.central.arubanetworks.com TCP port 443

Canada-1 ca.cloudguest.central.arubanetworks.com TCP port 2083
TCP port 443

ca-elb.cloudguest.central.arubanetworks.com TCP port 443

APAC-1 ap1.cloudguest.central.arubanetworks.com TCP port 2083
TCP port 443

ap1-elb.cloudguest.central.arubanetworks.com TCP port 443

APAC-EAST1 apaceast.cloudguest.central.arubanetworks.com TCP port 2083
TCP port 443

apaceast-elb.cloudguest.central.arubanetworks.com TCP port 443

APAC-SOUTH1 apacsouth.cloudguest.central.arubanetworks.com TCP port 2083
TCP port 443

apacsouth-elb.cloudguest.central.arubanetworks.com TCP port 443

Table 40: Domain Names for Cloud Guest Server Access

Domain Names for OpenFlow

Region Domain Name

US-1 https://app2-ofc.central.arubanetworks.com

US-2 https://ofc-prod2.central.arubanetworks.com

EU-1 https://app2-eu-ofc.central.arubanetworks.com

Canada-1 https://ofc-ca.central.arubanetworks.com

China-1 https://ofc.central.arubanetworks.com.cn

APAC-1 https://app2-ap-ofc.central.arubanetworks.com

Table 41: Domain Names for OpenFlow
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Region Domain Name

APAC-EAST1 https://ofc-apaceast.central.arubanetworks.com

APAC-SOUTH1 https://ofc-apacsouth.central.arubanetworks.com

Other Domain Names

Domain Name Protocol Description

sso.arubanetworks.com TCP port
443

Allows users to access their accounts on the internal
server.

internal.central.arubanetworks.com
internal2.central.arubanetworks.com

TCP port
443

Allows users to access the Aruba Central Internal portal.

pool.ntp.org UDP port
123

Allows users to update the internal clock and configure time
zone when a factory default device comes up.
By default, the Aruba devices contact pool.ntp.org and use
NTP to synchronize their system clocks.

activate.arubanetworks.com TCP port
443

Allows users to configure provisioning rules in Activate.

pqm.arubanetworks.com ICMP or
UDP port
4500

Allows users to check the health of WAN uplinks configured
on Branch Gateways.

images.arubanetworks.com TCP port
80

Allows users to access the server that hosts software
images available for upgrading devices.

http://h30326.www3.hpe.com TCP port
80

Allows users to access the Aruba switch software images.
To view the URL for software updates, use the show
activate software-update command.

d2vxf1j0rhr3p0.cloudfront.net TCP port
80

Allows users to access the CloudFront server for locating
Instant AP software images.

rcs-m.central.arubanetworks.com
(For all other regions)
central-eu-
rcs.central.arubanetworks.com (For
Europe region)

TCP port
443

Allows users to access a device console through SSH.

cloud.arubanetworks.com TCP port
80

Allows users to open the Aruba Central evaluation sign-up
page.

aruba.brightcloud.com TCP port
443

Enables devices to access the Webroot Brightcloud server
for application, application categories, and website content
classification.

bcap15-dualstack.brightcloud.com TCP port
443

Allows Aruba devices to look up the Webroot Brightcloud
server for Website categories.

Table 42: Other Domain Names
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Domain Name Protocol Description

api-dualstack.bcti.brightcloud.com TCP port
443

Allows Aruba devices to access the IP Reputation and IP
Geolocation service on the Webroot Brightcloud server.

database-dualstack.brightcloud.com TCP port
443

Allows Aruba devices to download the website classification
database from the Webroot Brightcloud server.

When configuring ACLs to allow traffic over a network firewall, use the domain names instead of the IP
addresses.
For Branch Gateways to set up IPsec tunnel with the VPN concentrators, the UDP 4500 port must be open.

Connecting Instant APs to Aruba Central
To bring up Instant APs in Aruba Central:

1. Connect the Instant AP to a provisioning network.

2. Ensure that Instant AP is operational and is connected to the Internet.

3. Ensure that the Instant AP has a valid DNS server address either through DHCP or static IP
configuration.

4. Ensure that NTP server is running and Instant AP system clock is configured.

Connecting Aruba Switches to Aruba Central
Note the following points about automatic provisioning of switches:

Pre-configured switches can now join Aruba Central. You can also import configuration from these switches to
generate a template. For more information, see Creating a Configuration Template.

If the switches ship with a version lower than the minimum supported firmware version, a factory reset may be
required, so that the switch can initiate a connection to Aruba Central. For information, on the minimum firmware
versions supported on the switches, see Supported Aruba Switch Platforms on page 434.

During Zero Touch Provisioning, the Aruba switches can join Aruba Central only if they are running the factory
default configuration, and have a valid IP address and DNS settings from a DHCP server.

The provisioning of the Aruba Mobility Access Switch fails when the provisioning process is interrupted during the
initial booting and if the switch has a static IP address with no DNS server configured.

Connecting SD-WAN Gateways to Aruba Central
The Aruba gateways have the ability to automatically provision themselves and connect to Aruba Central
once they are powered on. The gateways also support multiple active uplinks for ZTP (also referred to as
automatic provisioning). The supported ZTP ports for different hardware platforms are listed in the
following table. All these ZTP ports are assigned to VLAN 4094.
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ArubaOS Hardware Platform Supported ZTP Ports

Aruba 7005 Gateway ALL ports except 0/0/1

Aruba 7008 Gateway ALL ports except 0/0/1

Aruba 7010 Gateway ALL ports except 0/0/1

Aruba 7030 Gateway ALL ports except 0/0/1

Aruba 7024 Gateway ALL ports except 0/0/1

Aruba 7210 Gateway ALL ports except 0/0/1

Aruba 7220 Gateway ALL ports except 0/0/1

Aruba 7240 Gateway ALL ports except 0/0/1

Aruba 7280 Gateway ALL ports except 0/0/1

Aruba 9004 Gateway ALL ports except 0/0/1

Aruba 9004-LTE Gateway ALL ports except 0/0/1

Aruba 9012 Gateway ALL ports except 0/0/1

Table 43: ArubaOS Hardware Platforms and Supported ZTP
Ports

To know the minimum software version required for the gateways, see Supported SD-Branch Components.

To automatically provision the gateways:

1. Connect your gateway to the provisioning network.
2. Wait for the device to obtain an IP address through DHCP. Gateways support multiple uplink ports.

The first port to receive the DHCP IP connects to the Activate server and completes the provisioning
procedure:
n If the device has factory default configuration, it receives an IP address through DHCP, connects

to Aruba Activate, and downloads the provisioning parameters. When a device identifies Aruba
Central as its management entity, it automatically connects to Aruba Central.

n If the device is running a software version that does not have the SD-WAN image, the devices are
automatically upgraded to a supported SD-WAN software version.

3. Observe the LED indicators. Table 2 describes the LED behavior.

LED Indicator LCD Text Description

Solid Amber Getting
DHCP IP

Indicates that the uplink connection is UP, but DHCP IP is yet to be
retrieved.

Blinking Amber Activate
Wait

Indicates that the device was able to reach the DHCP server and the
connection to the Activate server is yet to be established.

Solid Green Activate
OK

Indicates that the device was able to retrieve provisioning parameters from
the Activate server.

Table 44: LED Indicators
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LED Indicator LCD Text Description

Alternating Solid
Green and Amber

Activate
Error

Indicates that the device was not able to retrieve provisioning parameters.

Table 44: LED Indicators

After successfully connecting to Aruba Central, the gateways download the configuration from Aruba
Central and reload.

The gateways also include service ports that the technicians can use for manually provisioning devices in the
event of ZTP failure. For more information on ports available for Aruba 7000 Series Mobility Controllers and
Aruba 7200 Series Mobility Controllers, see ArubaOS User Guide.

Certificates
By default, Aruba Central includes a self-signed certificate that is available on theCertificates page. The
default certificate is not signed by a root certificate authority (CA). For devices to validate and authorize
Aruba Central, administrators must upload a valid certificate signed by a root CA.

Aruba devices use digital certificates for authenticating a client's access to user-centric network services.
Most devices such as controllers and Instant APs include a server certificate by default for captive portal
server authentication. However, Aruba recommends that you replace the default certificate with a custom
certificate issued for your site or domain by a trusted CA. Certificates can be stored locally on the devices
and used for validating device or user identity during authentication.

Aruba Central-managed devices such as Instant AP and switches support the following root CA certificates:

Instant APs Switches

n AddTrust
n GeoTrust
n VeriSign
n Go Daddy

n Comodo
n GeoTrust

Uploading Certificates
To upload certificates, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Select theCertificates tab.

TheCertificates page opens.

4. Click the plus icon to add the certificate to the certificate store.
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5. In theAdd Certificate dialog box, do the following:

a. In theName text box, specify the certificate name.

b. Select the type of certificate. You can select any one of the following certificates:
n CA —Digital certificates issued by the CA.
n Server—Server certificates required for communication between devices and authentication

servers.
n CRL—Certificate Revocation List that contains the serial numbers of certificates that have

been revoked. This certificate is required for performing a certificate revocation check.
n OCSP Responder Cert—OCSP responder certificates.
n OCSP Signer Cert—OCSP Response Signing Certificate.

OCSP certificates are required for OCSP server authentication.

c. From the Format drop-down list, select a certificate format; for example, PEM, DER, and PKCS12.

d. In the Passphrase text box, enter a passphrase.

e. In theRetype Passphrase text box, retype the passphrase for confirmation.

The Passphrase and Retype Passphrase text boxes are displayed only when you select Server
Certificate from the Type drop-down list.

f. In theCertificate File field, click Browse and select the certificate files.

g. Click Add. The certificate is added to the Certificate Store.

Managing Certificates on Instant APs Configured Using
Templates
Aruba Central supports uploading multiple certificates to Instant APs configured using templates. You can
manage certificates either from the Aruba Central UI or through the API Gateway. For more information
about APIs, see API Documentation.

To push certificates to Instant APs configured using templates:

1. Upload certificate(s) through one of the following methods:
n UI—See Uploading Certificates on page 158.
n API—Use the [POST] /configuration/v1/certificates API.

2. Get the certificate name and MD5 checksum through one of the following methods:
n UI—In theNetwork Operations app, filterAll Devices. UnderMaintain, click Organization

and select theCertificates tab. TheCertificate Store table displays these details.
n API—Use the [GET] /configuration/v1/certificates API.

3. In the template, anywhere before theper-ap settings block, depending on your requirement, add
one or more of the following commands:

ca-cert-checksum <ca_cert_checksum/ca_cert_name>

cp-cert-checksum <captive_portal_cert_checksum/captive_portal_cert_name>

radsec-ca-checksum <radsed_ca_checksum/radsed_ca_name>

radsec-cert-checksum <radsed_cert_checksum/radsed_cert_name>

server-cert-checksum <server_cert_checksum/server_cert_name>
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You can either use the certificate name or the checksum value in the command. Or, you can set it as a
variable and enter the variable value for the Instant AP. Aruba recommends using the certificate name.

Example 1

ca-cert-checksum my_default_cert

Example 2

ca-cert-checksum %ca_cert_name%

variable:

{

"ca_cert_name": "my_default_cert"

}

Managing Software Upgrades
The Firmware page provides an overview of the latest firmware version supported on the device, details of
the device, and the option to upgrade the device.

This section includes the following topics:

n Viewing Firmware Details
n Upgrading a Device
n Setting Firmware Compliance For Access Points
n Setting Firmware Compliance For Switches
n Setting Firmware Compliance For Gateways in Standalone Mode

Viewing Firmware Details
To view the firmware details for devices provisioned in Aruba Central:

1. In theNetwork Operations app, select one of the following options:
n To select a group in the filter, set the filter to one of the options underGroup. For all devices, set

the filter to Global. The dashboard context for the selected filter is displayed.
n To select a device in the filter:

a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways. A

list of devices is displayed.
c. Click a device listed underDevice Name. The dashboard context for the device is

displayed.
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2. UnderMaintain, click Firmware. The Firmware dashboard displays the following information:
n The following image displays the Firmware dashboard at the global level:

Data Pane
Item Description

Set
Compliance

Allows you to set firmware compliance for devices within a group. Click Set Compliance to view
a list of supported firmware versions for each device in a group in the Manage Firmware
Compliance page.

Set Compliance for Access Points:
To ensure firmware version compliance, complete the following parameters in the Manage
Firmware Compliance page:

n Groups—Select the group for which the compliance must be set. Select the specific group
to set compliance at group level.
n Firmware Version—Select the firmware version number from the drop-down list to which
the compliance is required to be set. Select None to clear the compliance.
n Upgrade Type—Select any one of the following upgrade type:
lStandard—Recommended for operations during maintenance windows.
lLive—Recommended for operations during working hours.

n When —Select one of the following radio buttons to specify if the compliance must be
carried out immediately or at a later date and time.
lNow—To set the compliance to be carried out immediately.
lLater Date—To set at the later date and time.

Click Save and Upgrade button to save the firmware compliance with the above settings.

Set Compliance for Switches:
To ensure firmware version compliance, complete the following parameters in the Manage
Firmware Compliance page:

n Groups—Select the group for which the compliance must be set. Select the specific group
to set compliance at group level.
n AOS-S Firmware Version—Select the AOS-S firmware version number from the drop-
down list to which the compliance is required to be set.
n CX Firmware Version—Select the Aruba CX switch version number from the drop-down
list to which the compliance is required to be set.
n Auto Reboot—Select this check box to reboot Aruba Central automatically after the build
is downloaded on the device. On reboot, the new build is installed on the device.
n When —Select one of the following radio buttons to specify if the compliance must be
carried out immediately or at a later date and time.
lNow—To set the compliance to be carried out immediately.

Table 45: Firmware Maintenance
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Data Pane
Item Description

lLater Date—To set at the later date and time.

Click Save and Upgrade button to save the firmware compliance with the above settings.

NOTE: Aruba Central lists all available Aruba CX switches software versions. Select the software
version that is applicable to the Aruba CX switch to which compliance is required to be set. For
example, version 10.04.0020 is not applicable to Aruba CX 6200 and 6400 switch series.

Set Compliance for Gateways in Standalone Mode:
To ensure firmware version compliance, complete the following parameters in the Manage
Firmware Compliance page:

n Groups—Select the group for which the compliance must be set. Select the specific group
to set compliance at group level.
n Firmware Version—Select the firmware version number from the drop-down list to which
the compliance is required to be set. Select None to clear the compliance.
n Auto Reboot—Select this check box to reboot Aruba Central automatically after the build
is downloaded on the device. On reboot, the new build is installed on the device.
n When —Select one of the following radio buttons to specify if the compliance must be
carried out immediately or at a later date and time.
lNow—To set the compliance to be carried out immediately.
lLater Date—To set at the later date and time.

Click Save and Upgrade button to save the firmware compliance with the above settings.

Upgrade All Allows you to simultaneously upgrade firmware for all devices. Click Upgrade All to view a list of
supported firmware versions for each device.

To Upgrade all Access Points:
Click Upgrade All and complete the following parameters in the Upgrade Access Points
Firmware page:

n Firmware Version—Select the firmware version number from the drop-down list to which
the compliance is required to be set. Select None for none of the firmware versions.
n Upgrade Type—Select any one of the following upgrade type:
lStandard—Recommended for operations during maintenance windows.
lLive—Recommended for operations during working hours.

n When —Select one of the following radio buttons to specify if the compliance must be
carried out immediately or at a later date and time.
lNow—To set the compliance to be carried out immediately.
lLater Date—To set at the later date and time.

n Upgrade—Click this button to start the upgrade with the above settings.
n Cancel—Click this button to cancel the upgrade.

To Upgrade all Switches:
Click Upgrade All and complete the following parameters in the Upgrade Switch Firmware
page:

n AOS-S Firmware Version—Select the AOS-S firmware version number from the drop-
down list to which the compliance is required to be set.
n CX Firmware Version—Select the CX switch firmware version number from the drop-
down list to which the compliance is required to be set.
n Auto Reboot—Select this check box to reboot Aruba Central automatically after the build
is downloaded on the device. On reboot, the new build is installed on the device.
n When —Select one of the following radio buttons to specify if the compliance must be
carried out immediately or at a later date and time.
lNow—To set the compliance to be carried out immediately.
lLater Date—To set at the later date and time.

n Upgrade—Click this button to start the upgrade with the above settings.

Table 45: Firmware Maintenance
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Data Pane
Item Description

n Cancel—Click this button to cancel the upgrade.

To Upgrade all Gateways in Standalone Mode:
click Upgrade All and complete the following parameters in the Upgrade Gateway Firmware
page:

n Firmware Version—Select the firmware version number from the drop-down list to which
the compliance is required to be set.
n Auto Reboot—Select this check box to reboot Aruba Central automatically after the build
is downloaded on the device. On reboot, the new build is installed on the device.
n When—Select one of the following radio buttons to specify if the compliance must be
carried out immediately or at a later date and time.
lNow—To set the compliance to be carried out immediately.
lLater Date—To set at the later date and time.

n Upgrade—Click this button to start the upgrade with the above settings.
n Cancel—Click this button to cancel the upgrade.

Search
Filter

Allows you to define a filter criterion for searching devices based on the following properties:
n Common to all devices—Name, Firmware Version, Recommended Version and Upgrade
Status of the device.
n Specific to switches and gateways—MAC address and Model.

Column
Filter Clicking icon enables you to customize the table columns or set it to the default view.

Access
Points

Displays the following information:
n Name—Name of the AP. Clicking on the AP name opens a window with connected APs and
allows you to select and view the device Summary page. For more information, see Clients >
Wireless Client > Overview.
n APs—Number of APs associated to VC.
n Firmware Version—The current firmware version running on the AP.
n Recommended Version—The version to which the AP is recommended for upgrade.
n Upgrade Status—Filters the device list based on any of the following firmware upgrade
status:
lShow All
lNew firmware available
lScheduled
lIn progress
lFailed
lFirmware up to date

n Compliance Status—Status of the firmware compliance setting. The value displayed in
this column is either Set, Not Set, Set<date and time>, or Compliance scheduled on. The
Compliance scheduled on displays the date and time that is set in the Manage Firmware
Compliance Setting page.

NOTE: Clicking on the device name and APs from the Name and APs columns, opens a window
with connected APs and allows you to select and view the device Summary page. For more
information, see Clients > Wireless Client > Overview.

Table 45: Firmware Maintenance
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Data Pane
Item Description

Switch-MAS Displays the following details about Aruba switches managed through Aruba Central:
n Name—Host name of the switch.
n Family—Displays the following types of switches:
lAOS-S
lCX

This information is only available for Aruba switch and Aruba CX switches.
n MAC Address—MAC address of the switch.
n Model—Hardware model of the switch.
n Firmware Version—The current firmware version running on the switch.
n Recommended Version—The version to which the switch is recommended for upgrade.
n Upgrade Status—Filters the device list based on any of the following firmware upgrade
status:
lShow All
lNew firmware available
lScheduled
lIn progress
lFailed
lFirmware up to date

n Compliance Status—Status of the firmware compliance setting. The value displayed in
this column is either Set, Not Set, Set<date and time>, or Compliance scheduled on. The
Compliance scheduled on displays the date and time that is set in the Manage Firmware
Compliance Setting page.

NOTE: The Switch-MAS tab is only available for accounts with MAS switches.

NOTE: The Switches tab displays details of both Aruba switch and Aruba CX switches.

Switches

Continue Allows you to continue with firmware upgrade.

Cancel
Upgrade

Cancels a scheduled upgrade.

Cancel All Cancels a scheduled upgrade for all devices.

Table 45: Firmware Maintenance

Upgrading a Device
To check for a new version, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group in the filter, set the filter to one of the options underGroup. For all devices, set

the filter to Global. The dashboard context for the selected filter is displayed.
n To select a device in the filter:

a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways. A

list of devices is displayed.
c. Click a device listed underDevice Name. The dashboard context for the device is

displayed.

2. UnderMaintain, click Firmware.
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3. To upgrade firmware for devices in a specific group, select a group from the group selection filter.
4. Select one or several devices to upgrade.
5. Click Upgrade icon at the bottom of the page or hover over one of the selected device. To upgrade all

the devices, click Upgrade All option next to Set Compliance. TheUpgrade <Device> Firmware
pop-up window opens.

6. Select a firmware version. You can either select a recommended version or manually choose a specific
firmware version.

To obtain custom build details, contact Aruba Central Technical Support.

7. Select Auto Reboot if you want Aruba Central to automatically reboot after device upgrade.

The Auto Reboot option is available for Mobility Access Switches, Aruba Switch, Aruba CX switches, and
Branch Gateways.

8. Specify if the upgrade must be carried out immediately or at a later date and time.
9. Click Upgrade. The device downloads the image from the server, saves it to flash, and reboots.

Depending on the progress and success of the upgrade, one of the following messages is displayed:
n Upgrading—While image upgrade is in progress.
n Upgrade failed—When the upgrade fails.

10. If the upgrade fails, retry upgrading your device.

After upgrading a switch, click Reboot.

Setting Firmware Compliance For Access Points
Aruba Central allows you to run a firmware compliance check and force firmware upgrade for all APs in a
group. To force a specific firmware version for all APs in a group, complete the following steps:

1. In theGlobal dashboard, underMaintain, click Firmware.

TheAccess Points tab is selected by default.

2. Verify the firmware upgrade status for all APs.
3. Click Set Compliance at the top right. TheManage Firmware Compliance window opens.
4. In theGroups drop-down list, select a single group, multiple, or All Groups.
5. Select a firmware version from the Firmware Version drop-down list.
6. In theUpgrade Type, select one of the following options:

n Standard
n Live

7. Select Auto Reboot if you want Aruba Central to automatically reboot the device after a successful
device upgrade.

The Auto Reboot option is available for Mobility Access Switches, Aruba Switch, Aruba CX switches, and
Branch Gateways.
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8. Select one of the following as required:
n Select Now to set the compliance to be carried out immediately.
n Select Later Date to set the compliance at the later date and time.

9. Click Save and Upgrade. Aruba Central initiates a firmware upgrade operation only for the devices
that support the selected firmware version. If any of selected devices do not support the firmware
version selected for the upgrade, a list of unsupported devices is displayed.

The following image displays theManage Firmware Compliance window for Access Points:

Setting Firmware Compliance For Switches
To force a specific firmware version for all MAS switches in a group, complete the following steps:

1. In theGlobal dashboard, underMaintain, click Firmware > Switch-MAS tab.
2. Verify the firmware upgrade status for all MAS switches.
3. Click Set Compliance at the top right. TheManage Firmware Compliance window opens.
4. In theGroups drop-down list, select a single group, multiple, or All Groups.
5. Select a firmware version from the Firmware Version drop-down list.
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6. Select Auto Reboot if you want Aruba Central to automatically reboot the device after a successful
device upgrade.

7. Select one of the following as required:
n Select Now to set the compliance to be carried out immediately.
n Select Later Date to set the compliance at the later date and time.

8. Click Save and Upgrade. Aruba Central initiates a firmware upgrade operation only for the devices
that support the selected firmware version. If any of selected devices do not support the firmware
version selected for the upgrade, a list of unsupported devices is displayed.

The following image displays theManage Firmware Compliance window for MAS switches:

To force a specific firmware version for all Aruba switches in a group, complete the following steps:

1. In theGlobal dashboard, underMaintain, click Firmware > Switches tab.
2. Verify the firmware upgrade status for all switches.
3. Click Set Compliance at the top right. TheManage Firmware Compliance window opens.
4. In theGroups drop-down list, select a single group, multiple, or All Groups.
5. Select a AOS-S firmware version from theAOS-S Firmware Version drop-down list.
6. Select a CX firmware version from theCX Firmware Version drop-down list.
7. Select Auto Reboot if you want Aruba Central to automatically reboot the device after a successful

device upgrade.
8. Select one of the following as required:

n Select Now to set the compliance to be carried out immediately.
n Select Later Date to set the compliance at the later date and time.

9. Click Save and Upgrade. Aruba Central initiates a firmware upgrade operation only for the devices
that support the selected firmware version. If any of selected devices do not support the firmware
version selected for the upgrade, a list of unsupported devices is display



Managing Software Upgrades | 168

The following image displays theManage Firmware Compliance window for Aruba switches:

Setting Firmware Compliance For Gateways in Standalone
Mode
To force a specific firmware version for all gateways in standalone mode, complete the following steps:

1. In theGlobal dashboard, underMaintain, click Firmware > Gateways tab. All the gateways with
standalone mode is displayed.

2. Verify the firmware upgrade status for all gateways.
3. Click Set Compliance at the top right. TheManage Firmware Compliance window opens.
4. In theGroups drop-down list, select a single group, multiple, or All Groups.
5. Select a firmware version from the Firmware Version drop-down list.
6. Select Auto Reboot if you want Aruba Central to automatically reboot the device after a successful

device upgrade.
7. Select one of the following as required:

n Select Now to set the compliance to be carried out immediately.
n Select Later Date to set the compliance at the later date and time.

8. Click Save and Upgrade. Aruba Central initiates a firmware upgrade operation only for the devices
that support the selected firmware version. If any of selected devices do not support the firmware
version selected for the upgrade, a list of unsupported devices is displayed.

The following image displays theManage Firmware Compliance window for gateways:
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Using Troubleshooting Tools
In theNetwork Operations app, use the filter to select a group, label, site, or a device and then, select
Tools menu option underAnalyze. The Tools menu allows network administrators and users with
troubleshooting permission to perform troubleshooting or diagnostics tests on devices and networks
managed by Aruba Central. Users with admin role and custom roles that allow edit access to the
troubleshooting module can troubleshoot network and device issues. For more information on user roles,
see Configuring User Roles on page 105.

The Tools menu option is not visible to users who do not have troubleshooting permission.
Aruba Central does not support performing diagnostic checks on offline devices.

The Tools page is divided into the following tabs:

n Network Check—Allows you to run diagnostic checks on networks and troubleshoot client connectivity
issues. You must have admin privileges or read-write privileges to perform network checks.

n Device Check—Allows you to run diagnostic checks and troubleshoot switches. You must have admin
privileges or read-write privileges to perform device checks.

n Commands—Allows you to perform network health check on devices at an advanced level using
command categories. Read-only users can also perform advance checks.

This section includes the following topics:

n Troubleshooting Network Issues on page 170
n Enabling Gateway Logs
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n Troubleshooting Device Issues on page 178
n Advanced Device Troubleshooting on page 179

Troubleshooting Network Issues
Network check aims to identify, diagnose, and debug issues detected in an Aruba Central-managed network.
TheNetwork Check tab on the Tools page captures the troubleshooting utilities that are used to test a
network entity and collect results based on your selection.

To perform a diagnostic check on the Aruba Central-managed network, complete the following procedure:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.

A list of devices is displayed in the List view.

c. Click a device listed underDevice Name.

The dashboard context for the device is displayed.

2. UnderAnalyze > Tools, click theNetwork Check tab.

TheNetwork Check page is displayed.

3. Select a device. You can run diagnostic checks on the following types of devices managed by Aruba
Central:
n Access Points
n Switches
n Gateways

Table 46 lists the tests available for each device type:

Test Access Point Switch Gateway

Ping Test Available Available Available

Traceroute Available Available Available

HTTP Test Available NA NA

HTTPS Test Available NA NA

TCP Test Available NA NA

Speed Test Available NA NA

Table 46: Tests and Devices

Devices which are already running commands shall not execute newly added commands.
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Troubleshooting AP Connectivity Issues
The following tests are available to diagnose issues pertaining to WLAN network connections:

Ping Test
Sends ICMP echo packets to the hostname or IP addresses of the selected devices to check for latency
issues.

To perform a ping test on APs:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
n The dashboard context for the selected filter is displayed.
n To select a device in the filter:

a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name for which you want to perform diagnostic
test.

The dashboard context for the access point is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down list, select Access Point.
4. From the Test drop-down list, select Ping Test.
5. From the Sources drop-down list, select source(s). You can select multiple APs.
6. From theDestination Type drop-down list, select one of the following:

n Hostname/IP Address—Enter the hostname or IP address.
n Client—Select a client.

7. Enter the count in the range as mentioned in the field. The count should be a number between 1 to
300.

8. Click Run. The output is displayed in theDevice Output section.

Traceroute
Tracks the packets routed from a network host.

To perform a traceroute test on APs:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Group, Label, or Site. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.
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n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name for which you want to perform diagnostic
test.

The dashboard context for the access point is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down list, select Access Point.
4. From the Test drop-down list, select Traceroute.
5. From the Sources drop-down list, select source(s). You can select multiple APs.
6. Enter the hostname or IP address.
7. Click Run. The output is displayed in theDevice Output section.

HTTP Test
Sends packets to the HTTP URL and tries to establish a connection and exchange data. If the HTTP website
returns a response, the issue could be isolated to the client device.

To perform an HTTP test on APs:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Group, Label, or Site. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name for which you want to perform diagnostic
test.

The dashboard context for the access point is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down list, select Access Point.
4. From the Test drop-down list, select HTTP Test.
5. From the Sources drop-down list, select source(s). You can select multiple APs.
6. Enter the HTTP URL for which you want to perform the HTTP test, in theURL field, For example,

http://hostname or http://ipaddress.
7. Enter the timeout value in seconds. The value should be between 1 to 10 seconds. The default

timeout value is 1 second.
8. Click Run. The test output is displayed in theDevice Output section.

Important Points to Note

n HTTP test is supported only from version 8.3.0.0 or above.
n The test supports only IPv4 address or domain name in theURL field.
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HTTPS Test
Sends packets to the HTTPS URL and tries to establish a connection and exchange data. If the HTTPS
website returns a response, the issue could be isolated to the client device. HTTPS is a performance test to
identify the time taken to load a web page.

To perform an HTTPS URL test on APs:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Group, Label, or Site. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name for which you want to perform diagnostic
test.

The dashboard context for the access point is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down list, select Access Point.
4. From the Test drop-down list, select HTTPS Test.
5. From the Sources drop-down list, select source(s). You can select multiple APs.
6. Enter the HTTPS URL for which you want to perform the HTTPS test, in theURL field, For example,

https://URL or https://IPv4.
7. Enter the timeout value in seconds. The value should be between 1 to 10 seconds. The default

timeout value is 1 second.
8. Click Run. The test output is displayed in theDevice Output section.

Important Points to Note

n HTTPS test is supported only from version 8.4.0.0 or above.
n The test supports only IPv4 address or domain name in theURL field.

TCP Test
Sends packets to the host, for example, FTP server, and tries to establish a connection and exchange data. If
the FTP server returns a response, the issue could be isolated to the client device.

To perform a TCP test on APs:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Group, Label, or Site. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.
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c. Click an access point listed underDevice Name for which you want to perform diagnostic
test.

The dashboard context for the access point is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down list, select Access Point.
4. From the Test drop-down list, select TCP Test.
5. From the Sources drop-down list, select source(s). You can select multiple APs.
6. Enter a valid IPv4 address in theHost field. Hostname is not supported.
7. Enter the port number., in the Port field. The port number should be between 1 to 65535.
8. Enter the timeout value in seconds, in the Timeout field. The value should be between 1 to 10

seconds. The default timeout value is 5 seconds.
9. Click Run. The output is displayed in theDevice Output section.

Important Point to Note

n TCP test is supported only from version 8.3.0.0 or above.

Speed Test
Performs a speed test to measure network speed and bandwidth. The speed test diagnostic tool is available
only for Instant AP. To perform a speed test, you must provide the iPerf server address, protocol type, and
speed test options such as bandwidth.

To execute a speed test on APs:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Group, Label, or Site. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name for which you want to perform diagnostic
test.

The dashboard context for the access point is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down list, select Access Point.
4. From the Test drop-down list, select Speed Test.
5. From the Sources drop-down list, select source(s). You can select multiple APs.
6. In theHost field, enter a valid hostname.
7. From the Protocol drop-down list, select the protocol. The available options are TCP orUDP.
8. In theOptions field, enter the option. For example, bandwidth.
9. Click Run. The test output is displayed in theDevice Output section.
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While performing troubleshooting on APs, a maximum of 20 APs are listed in the drop-down list. If there are
more than 20 APs, use the Search option to search for an AP on which you would like to perform diagnostic
checks.
If you navigate from the device details page, the Tools page appears, where the device context is already set
and the Source field is automatically populated based on your selection.

Troubleshooting Switch Connectivity Issues
The following tests are available to diagnose issues related to wired network connections:

Ping Test
Sends ICMP echo packets to the IP address of the selected switch to check for latency issues.

To perform a ping test on switches, complete the following procedure:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a switch in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

c. Click a switch underDevice Name for which you want to perform diagnostic test.

The dashboard context for the switch is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down, select Switch.
4. From the Test drop-down, select Ping Test.
5. From the Sources drop-down, select source(s). You can select multiple switches.

You can select Aruba Switch or Mobility Access Switch from the Sources drop-down.

6. From theDestination Type drop-down, select one of the following:
n Hostname/IP Address—Enter the hostname or IP address in theHostname/IP Address field.
n Client—Select a client from theClient drop-down.

7. In theRepetitions field, enter the repetition value. The value should be between 1 to 10000.
8. In theData Size field, enter the data size. The value should be between 0 to 65471.

Mobility Access Switches do not support repetition and data size.

9. Select theUse Management Interface option if you want to use VRF Management interface. To
use VRF Default interface, clear this option, which is the default.

Use Management Interface option is available only for Aruba CX switches.

10. Click Run. The test output is displayed in theDevice Output section.
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Traceroute
Tracks the packets routed from a network host.

To perform a traceroute test on switches, complete the following procedure:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Group, Label, or Site. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a switch in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

c. Click a switch underDevice Name for which you want to perform diagnostic test.

The dashboard context for the switch is displayed.

2. UnderAnalyze > Tools,Network Check.
3. From theDevice Type drop-down, select Switch.
4. From the Test drop-down list, select Traceroute.
5. From the Sources drop-down, select source(s). You can select multiple switches.
6. Enter the hostname or IP address in theHostname/IP Address field.
7. Select theUse Management Interface option if you want to use VRF Management interface. To

use VRF Default interface, clear this option, which is the default.

Use Management Interface option is available only for Aruba CX switches.

8. Click Run. The output is displayed in theDevice Output section.

For information about viewing and downloading the output, see Viewing the Device Output.

If you navigate from the device details page, the Tools page appears, where the device context is already set
and the Source field is automatically populated based on your selection.

Troubleshooting Gateway Connectivity Issues
The following tests are available to diagnose issues pertaining to WAN or SD-WAN network connections:

Ping Test
Sends ICMP echo packets to the IP addresses of the selected devices to check for latency issues.

To perform a ping test on Gateways:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.
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n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Gateways.

A list of gateways is displayed in the List view.

c. Click a gateway listed underDevice Name for which you want to perform diagnostic test.

The dashboard context for the gateway is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down list, select Gateway.
4. From the Test drop-down list, select Ping Test.
5. From the Sources drop-down list, select source(s). You can select multiple Gateways.
6. From theDestination Type drop-down list, select one of the following:

n Hostname/IP Address—Enter the hostname or IP address.
n Client—Select a client.
n VPNC—Select the VPN Concentrator.

7. In the Packet Size field, enter the packet size to capture and store the data packet to analyze
network issues at a later stage. The range is from 10 to 2000 Bytes.

8. In theCount field, enter the count. The value should be between 1 to 100.
9. Click Run. The output is displayed in theDevice Output section.

Traceroute
Tracks the packets routed from a network host.

To perform a traceroute test on Gateways:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Group, Label, or Site. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Gateways.

A list of gateways is displayed in the List view.

c. Click a gateway listed underDevice Name for which you want to perform diagnostic test.

The dashboard context for the gateway is displayed.

2. UnderAnalyze > Tools, click Network Check.
3. From theDevice Type drop-down list, select Gateway.
4. From the Test drop-down list, select Traceroute.
5. From the Sources drop-down list, select source(s). You can select multiple Gateways.
6. Enter the hostname or IP address.
7. Click Run. The output is displayed in theDevice Output section.

If you navigate from the device details page, the Tools page appears, where the device context is already set
and the Source field is automatically populated based on your selection.
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Viewing the Device Output
After you execute troubleshooting commands on the devices, Aruba Central displays the output in the
Device Output section of the Tools page.

The output pane displays a list of devices on which the troubleshooting commands were executed, the test
type, initial timestamp, source, and target. It also shows the status of the tests as, in progress, complete, and
the buffer time. If there are multiple devices, select the device for which you want to view the output.

Output history of device with buffer space issues shall be automatically cleared.

You can perform the following tasks from theDevice Output section:

n Click Clear to clear the output. You can clear the output for a single device or for all devices. TheClear
option is disabled for read-only users.

n Click the Search icon to search for text in the output.
n Click the Email icon and click Send to send the output as an email. You can also add email recipients in

theCC field.
n Click theDownload icon to export the command output as a zip file.
n Click the maximize icon to maximize the device output pane.

For more information on the output displayed for the CLI commands, see the following documents:

n Aruba Instant CLI Reference Guide for Instant AP CLI command output
n HPE ArubaOS-Switch Management and Configuration Guide for Aruba Switch CLI command output
n ArubaOS 7.4.x CLI Reference Guide for Mobility Access Switches CLI command output
n ArubaOS CLI Reference Guide for SD-WAN Gateway CLI command output

Troubleshooting Device Issues
Device check aims to identify, diagnose, and debug issues on your device. TheDevice Check tab in the
Tools page can be used to perform troubleshooting check for Aruba Switches and Aruba CX switches only.
When a troubleshooting operation is initiated, Aruba Central establishes a session with the switch selected
for the troubleshooting operation and displays the output in theDevice Output section.

To perform a device check on a switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a switch in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

c. Click a switch underDevice Name for which you want to perform diagnostic test.

The dashboard context for the switch is displayed.

2. UnderAnalyze > Tools, click theDevice Check tab.

TheDevice Check page is displayed.
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By default, the Device Type is set to Switch if a switch is configured in the data path, else a warning is
displayed.
Multiple device selection is not allowed at this level.
Devices which are already running commands shall not execute newly added commands.

3. From the Sources drop-down, select a switch.
4. From the Test drop-down, select one of the following tests to perform diagnostic checks on the

selected switch:
n Cable Test—Enables testing of the electrical connections in the switch cable. It checks whether

the cabling is conformed to the cabling plans and is of expected quantity. It is useful for
production and maintenance.

Cable Test is supported in Aruba Switches only from version 16.05.000 or above.
Cable Test is not supported in Aruba CX switches.

n Interface Bounce—Restarts the port interface and forces a client to re-initiate a DHCP request.
This option is available only for Aruba Switches.

n PoE Bounce—Restarts the PoE port and the device that is either connected to the PoE port or
powered by it. This option is available only for Aruba Switches.

If you select Cable Test, PoE Bounce, or Interface Bounce, you must enter the port number or the
port number range as mentioned in the example text.
If you navigate to the Tools page from the Clients page, under Device Check the client context is
already set and the port number is auto filled based on the client selected.

n Chassis Locate—Activates the Switch locator LED. The locator LED indicates the physical location
where an Aruba Switch is currently installed.

Important Point to Note

Interface Bounce, PoE Bounce, and Chassis Locate tests are supported only from the following
versions in switches:

nAruba Switches: 16.04.0000 or above

nAruba CX: See Supported Aruba CX Platforms on page 436.

5. Click Run. The output is displayed in theDevice Output section.

For information about viewing and downloading the output, see Viewing the Device Output.

Unlike the other tests, for Cable Test, the output is displayed in a tabular format, and you cannot
download, email, or export the output.

Advanced Device Troubleshooting
Advanced device check aims to identify, diagnose, and debug issues on your device at an advanced level
using commands. TheCommands tab on the Tools page lists commands specific to a particular device to
test the device entity and collect results based on your selection. When a troubleshooting operation is
initiated, Aruba Central establishes a session with the devices selected for the troubleshooting operation
and displays the output in theDevice Output section.

To perform advanced troubleshooting on devices, complete the following steps:
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1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.

A list of devices is displayed in the List view.

c. Click a device listed underDevice Name.

The dashboard context for the device is displayed.

2. UnderAnalyze > Tools, click theCommands tab.

TheCommands page is displayed.

3. Select a device. Network administrators can perform advanced troubleshooting on the following
types of devices managed by Aruba Central:
n Access Points
n Switches
n Gateways

Devices which are already running shall not execute newly added commands.

To perform advanced troubleshooting on APs, the minimum software version required on Instant APs is 6.4.3.1-
4.2.0.3.
To perform advanced troubleshooting on Mobility Access Switches, the minimum version support is 7.4.0.6.

Troubleshooting Access Points
To troubleshoot APs at an advanced level:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name for which you want to perform diagnostic
test.

The dashboard context for the access point is displayed.

2. UnderAnalyze > Tools, click Commands.
3. In theCommands tab, select the device type asAccess Point.
4. From theAvailable Devices drop-down list, select the AP. You can select multiple APs.
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5. Select any command category and theCommands pane displays the associated commands.
6. Click Add> to add the selected commands to the Selected Commands pane.
7. If you have selected a command marked with either '*' or '+', enter the filtration parameters as

displayed in theAdditional Filters dialog box. For more information on filtering commands, see
Filtering Commands on page 183.

8. (Optional) Select command(s) and click <Remove to remove selected command(s) or click <Remove
All to clear the Selected Commands pane.

9. (Optional) To set a frequency for automatically executing the troubleshooting commands:

a. Click theRepeat check box.

b. Specify an interval for executing the troubleshooting commands. You can also specify how
frequently the commands must be executed during a given interval.

c. Click Reset to modify the values in all the fields, and Cancel All for canceling all the repeats. Click
the stop icon to stop a particular repeat.

10. Click Run. The output is displayed in theDevice Output section.

To perform advanced troubleshooting on APs, the minimum software version required on Instant APs is 6.4.3.1-
4.2.0.3.
To perform advanced troubleshooting on Mobility Access Switches, the minimum version support is 7.4.0.6.
If you navigate from the device details page, the Tools page appears, where the device context is already set
and the Source field is automatically populated based on your selection.

Troubleshooting Switches
To troubleshoot switches at an advanced level:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a switch in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

c. Click a switch underDevice Name for which you want to run a diagnostic test.

The dashboard context for the switch is displayed.

2. UnderAnalyze > Tools, click Commands.

TheCommands page is displayed.

3. From theDevice Type drop-down, select Switch.
4. From theAvailable Devices drop-down, select the switch. You can select multiple switches.
5. Select any command category in theCategories pane and theCommands pane displays the

associated commands.

Aruba CX switches support only the show tech and show running-config commands.
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6. Click Add > to add the selected commands to the Selected Commands pane.
7. If you have selected a command marked with either '*' or '+', enter the filtration parameters as

displayed in theAdditional Filters dialog box. For more information on filtering commands, see
Filtering Commands on page 183.

8. (Optional) Select command(s) and click < Remove to remove selected command(s) or click <
Remove All to clear the Selected Commands pane.

9. (Optional) To set a frequency for automatically executing the troubleshooting commands:

a. Click theRepeat check box.

b. Specify an interval for executing the troubleshooting commands. You can also specify how
frequently the commands must be executed during a given interval.

c. Click Reset to modify the values in all the fields, and Cancel All for canceling all the repeats.
Click the stop icon to stop a particular repeat.

10. Click Run. The output is displayed in theDevice Output section.

For information about viewing and downloading the output, see Viewing the Device Output.

Troubleshooting Gateways
To troubleshoot Gateways at an advanced level:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Gateways.

A list of gateways is displayed in the List view.

c. Click a gateway listed underDevice Name for which you want to perform diagnostic test.

The dashboard context for the gateway is displayed.

2. UnderAnalyze > Tools, click Commands.
3. In theCommands tab, select the device type asGateway.
4. From theAvailable Devices drop-down list, select the gateway. You can select multiple gateways.
5. Select any command category and theCommands pane displays the associated commands.
6. Click Add> to add the selected commands to the Selected Commands pane.
7. If you have selected a command marked with either '*' or '+', enter the filtration parameters as

displayed in theAdditional Filters dialog box. For more information on filtering commands, see
Filtering Commands on page 183.

8. (Optional) Select command(s) and click <Remove to remove selected command(s) or click <Remove
All to clear the Selected Commands pane.
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9. (Optional) To set a frequency for automatically executing the troubleshooting commands:

a. Click theRepeat check box.

b. Specify an interval for executing the troubleshooting commands. You can also specify how
frequently the commands must be executed during a given interval.

c. Click Reset to modify the values in all the fields, and Cancel All for canceling all the repeats. Click
the stop icon to stop a particular repeat.

10. Click Run. The output is displayed in theDevice Output section.

Filtering Commands
In order to streamline the debug process and avoid huge data generation while troubleshooting, few
commands enable Client MAC address, IP Address, and Port filtration.

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.

A list of devices is displayed in the List view.

c. Click a device listed underDevice Name.

The dashboard context for the device is displayed.

2. UnderAnalyze > Tools, click Commands.

TheCommands page is displayed.

3. Select the device type,Access Point, Switch, orGateway as required from the drop-down list.
4. Select any command category and theCommands pane displays the associated commands.

If you navigate from the device details page, the Tools page appears, where the device context is already set
and the Source field is automatically populated based on your selection.

Mandatory filters— Commands marked with '*'
1. Select a command marked with '*' and click Add.

TheAdditional Filters dialog box appears.

2. Enter the parameters such as, Client MAC address, IP address, port number, port list, or policy name
as required.

The parameters are generated based on the commands selected.
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3. Click Apply.

In case of mandatory filter commands, if you do no enter the filtering parameters in the additional
filters dialog box, the command does not get added to the selected command pane and you cannot
perform the troubleshooting.

4. (Optional) Click Edit All to reset the filtration parameters for all the commands added in the selected
command pane.

Optional filters— Commands marked with '+'
1. Select a command marked with '+' and click Add.

TheAdditional Filters dialog box appears.

2. (Optional) Enter the parameters such as, Client MAC address, IP address, port number, port list, or
policy name as required.

The parameters are generated based on the commands selected.

3. Click Apply.

In case of optional filter commands, if you do no enter the filtering parameters in the additional filters
dialog box, the command still gets added to the selected command pane and you can perform your
troubleshooting.

4. (Optional) Click Edit All to reset the filtration parameters for all the commands added in the selected
command pane.

Viewing the Device Output
After you execute troubleshooting commands on the devices, Aruba Central displays the output in the
Device Output section of the Tools page.

If there are multiple devices, select the device for which you want to view the output. It shows the status of
the tests as, in progress, complete, and the buffer time.

Output history of device with buffer space issues shall be automatically cleared.

You can perform the following tasks from theDevice Output section:

n Click Clear to clear the output. You can clear the output for a single device or for all devices. TheClear
option is disabled for read-only users.

n Click the Search icon to search for text in the output.
n Click the Email icon and click Send to send the output as an email. You can also add email recipients in

theCC field.
n Click theDownload icon to export the command output as a zip file.
n Click the maximize icon to maximize the device output pane.

For more information on the output displayed for the CLI commands, see the following documents:

n Aruba Instant CLI Reference Guide for Instant AP CLI command output
n HPE ArubaOS-Switch Management and Configuration Guide for Aruba Switch CLI command output
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n ArubaOS 7.4.x CLI Reference Guide for Mobility Access Switches CLI command output
n ArubaOS CLI Reference Guide for SD-WAN Gateway CLI command output

Viewing Audit Trails in the Account Home Page
TheAudit Trail page shows the logs for all the device management, configuration, and user management
events triggered in Aruba Central.

To view audit trail logs:

1. In theAccount Home page, underGlobal Settings, click Audit Trail.
TheAudit Trail page opens.

2. From the Select App drop-down list, select one of the following:

n All Apps—Displays audit trail logs for all apps.

n Network Operations—Displays audit trail logs for theNetwork Operations app.

n ClearPass Device Insight—Displays audit trail logs for theClearPass Device Insight app.

The following table describes the fields displayed in theAudit Trail table:

Parameter Description

Occurred
On

Time stamp of the events for which the audit trails are shown.

IP Address IP address of the client device.

Username Username of the admin user who applied the changes.

Target Group or device to which the changes were applied.

Source Tenant account in which the changes occurred.

NOTE: This column is applicable only in the MSP mode.

Category Type of modification and the affected device management category.

Description A short description of the changes such as subscription assignment, firmware upgrade, and

configuration updates. Click to view the complete details of the event. For example, if an event
was not successful, click the ellipsis to view the reason for the failure.

Table 47: Audit Trail Details

Viewing Audit Trail in the Standard Enterprise Mode
TheAudit Trail page in the Standard Enterprise Portal shows the total number logs generated for all the
device management, configuration, and user management events triggered in Aruba Central. You can search
or filter the audit trail records based on any of the following columns:

n Occurred on (Custom Range)
n Username
n IP Address
n Category
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n Description
n Target

To view the audit trail log details in Aruba Central:

1. In theNetwork Operations app, select one of the following options:
n To select a group or all devices in the filter, set the filter to Group. For all devices, set the filter to

Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.

A list of devices is displayed in the List view.

c. Click a device listed underDevice Name.

The dashboard context for the device is displayed.

2. UnderAnalyze, click Audit Trail.
The Audit Trail table is displayed with the following details:
n Occurred On— Timestamp of the audit log. Use the sort option to sort the audit logs by date

and time. Use the filter option to select a specific time range to display the audit logs.
n IP Address—IP address of the client device.
n Username—Username of the admin user who applied the changes.
n Target—The group or device to which the changes were applied.
n Category—Type of modification and the affected device management category.
n Description—A short description of the changes such as subscription assignment, firmware

upgrade, and configuration updates. Click to view the complete details of the event. For
example, if an event was not successful, clicking the ellipsis displays the reason for the failure.

To customize the Audit Trail table, click the eclipses icon to select the required columns, or click
Reset to default to set the table to the default columns.

Classification of Audit Trails
The audit trail is classified according to the type of modification and the affected device management
category. The category can be one of the following:

n Configuration
n Firmware Management
n Reboot
n Device Management
n Templates
n User Management
n Variables
n Label Management
n MSP
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n Guest
n Groups
n Subscription Management
n API Gateway
n RBAC
n Sites Management
n SAML Profile
n User Activity
n Federated User Activity
n Alert Configuration
n Install Manager
n Tools

Removing Devices
The device monitoring dashboards allow you to remove an offline device. However, you will not be able to
remove a device completely from Aruba Central database, because the device entry remains in theDevice
Inventory page. The devices appearing in theDevice Inventory page shows the hardware devices that
belong to your account or purchase order.

For information on removing an offline device, see the following topics:

n Deleting an Offline AP
n Deleting an Offline Switch
n Deleting a Gateway

Removing a Device from the Device Inventory Page
You cannot remove a device completely from Aruba Central, but you can unsubscribe the device. After you
unsubscribe, the device status changes to Unsubscribed in theDevice Inventory page. If you have more
than one Aruba Central account and if another Aruba Central user adds this unsubscribed device to another
Aruba Central account, the device entry is removed from theDevice Inventory page in your Aruba Central
account.



Chapter 5
The AI Insights Dashboard

The AI Insights Dashboard
In an environment of rapidly changing business and user expectations driven by an explosion of
connectivity requirements from the edge to the cloud, a new approach to network management is required.
Aruba AIOps (Artificial Intelligence for IT operations) is the next generation of AI-powered solutions that
integrates proven Artificial Intelligence solutions with recommended and automated action to provide both
fast response to identified problems, along with proactive prediction and prevention.

With data collected from over 750,000 access points, switches, and gateways, Aruba Central and built-in AI
Insights proactively identifies and solves issues, and provides pinpoint configuration recommendations. As
the data is stored in the cloud, it is easy to view the network performance across all locations from a single
pane of glass. Utilizing the cloud also provides the ability to anonymously compare a network with a peer
network or the baselines for a broader perspective and optimization. All of this comes from Aruba's
advantage in accessing an enormous volume and variety of data that is factored into insights. Aruba does
not collect or process personal data.

In this release the insights are classified under three categories:

n Connectivity—Issues related to the wireless connectivity in the network.
n Wireless Quality—Issues related to the RF Info or RF Health in the network.
n Availability—Issues related to the health of your network infrastructure and the devices in the network

such as, APs, switches, and gateways.

TheAI Insights dashboard displays a report of network events that could possibly affect the quality of the
overall network performance. These are anomalies observed at the access point, connectivity, and client
level for the selected time range. Each insight provides specific details on the occurrences of these events for
easy debugging.

To launch theAI Insights dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.The dashboard context for the selected
filter is displayed.

2. UnderManage, click Overview > AI Insights. The Insights table is displayed. AI Insights listed in
the dashboard are sorted from high priority to low priority.

3. Click the arrow against each insight to view the further details.
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Figure 22 Insight Details

Callout
Number Description

1 Click this arrow to expand any specific insight to view further details.

2 Displays the insight severity, using the following colors:
Red—High priority
Orange—Medium priority
Yellow—Low priority

NOTE: The following three configuration insights are marked in blue color ( ) in the severity
column:

lAccess Point transmit power can be optimized
lCoverage Holes have been detected
lOutdoor clients are impacting Wi-Fi performance

3 Short description of the insight.

4 Insight Summary displays the reason why the insight was generated along with recommendation. It
also shows the number and percentage of failures that occurred against each failure reason. The
reasons are classified into:

n Static—These reasons rely on Aruba's domain expertise.
n Dynamic—These reasons are generated based on error codes that is received from
infrastructure devices.

5 Time Series graph is a graphical representation of the failure percentage or failure events that
occurred for the selected time range.

6 Category of the insight.

7 Short description of the impact.

8 Cards display additional information specific to each insight. Cards might vary for each insight
based on the context the insight is accessed from.
For more information, see Cards.
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All AI Insights generated are listed in theGlobal > AI Insights dashboard. Alternatively, AI Insights for a
specific site, device, or client can be viewed by selecting the respective context. For more information on
available insights and the context, see Insights Context.

AI Insights are displayed for a selected time period based on the time selected in the Time Range Filter ( ).
You can select one of the following: 3 Hours, 1 Week, 1 Day, or 1 Month.

Figure 23 AI Insights Dashboard

Insights Context
Insights can be accessed from different contexts such asGlobal, Site, Clients, and Device. The following
table lists the different types of insights generated by Aruba Central and the path from where it can be
accessed.

In this release, all AI Insights are available irrespective of the user role or Aruba Central subscription. In the
upcoming Aruba Central release, AI Insights marked as Advanced in the user interface would require an
advanced subscription.

Insights Category Context Navigation

Access Points had unusually high
CPU utilization Availability

— Access
Point

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Table 48: Navigating Insights
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Insights Category Context Navigation

Access Points with unusually high
memory usage were found Availability

— Access
Point

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Information (telemetry) was not
received from APs/Radios

Availability
— Access
Point

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Access Points had a high number
of reboots

Availability
— Access
Point

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Switches had excessive port flaps Availability
— Switch

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Switches Network Operations > Global > Devices >
Switches > Device Name > AI Insights

Switches had an unusual number
of port error Availability

— Switch

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Switches Network Operations > Global > Devices >
Switches > Device Name > AI Insights

Switch ports had a high number
with Power-over-Ethernet
problems

Availability
— Switch

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Switches Network Operations > Global > Devices >
Switches > Device Name > AI Insights
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Insights Category Context Navigation

Switches had unusually high CPU
utilization Availability

— Switch

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Switches Network Operations > Global > Devices >
Switches > Device Name > AI Insights

Switches had unusually high
memory usage

Availability
— Switch

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Switches Network Operations > Global > Devices >
Switches > Device Name > AI Insights

Gateway tunnels failed to get
established Availability

— Gateway

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Gateways Network Operations > Global > Devices >
Gateways > Device Name > AI Insights

Gateways had unusually high CPU
utilization Availability

— Gateway

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Gateways Network Operations > Global > Devices >
Gateways > Device Name > AI Insights

Gateways had high Memory usage Availability
— Gateway

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Gateways Network Operations > Global > Devices >
Gateways > Device Name > AI Insights
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Insights Category Context Navigation

Clients roamed excessively

Connectivity
— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights

Clients experienced high latency
while roaming

Connectivity
— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights

DNS request/responses were
significantly delayed Connectivity

— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights
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Insights Category Context Navigation

DNS server(s) rejected a high
number of queries Connectivity

— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights

Clients had DHCP server
connection problems Connectivity

— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights

DNS queries failed to reach or
return from the servers Connectivity

— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients had an unusual number of
MAC authentication failures

Connectivity
— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights
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Insights Category Context Navigation

Clients had excessive Wi-Fi
security key-exchange failures

Connectivity
— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights

Clients had excessive 802.1x
authentication failures Connectivity

— Wi-Fi

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights

Access Point transmit power can
be optimized

Wireless
Quality

Global Network Operations > Global > Overview
> AI Insights

Access Points impacted by high 2.4
GHz usage Wireless

Quality

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Access Points were impacted by
high 5 GHz usage Wireless

Quality

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights



Aruba Central | User Guide 196

Insights Category Context Navigation

Dual-band (2.4/5 GHz) capable
clients primarily used 2.4 GHz Wireless

Quality

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights

Clients had a significant number of
Low SNR uplink minutes

Wireless
Quality

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Clients Network Operations > Global > Clients >
Client Name > AI Insights
Network Operations > Site > Clients >
Client Name > AI Insights

Coverage Holes have been
detected

Wireless
Quality

Global Network Operations > Global > Overview
> AI Insights

Access Points had an excessive
number of channel changes

Wireless
Quality

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Access Point radios changed their
transmit power frequently

Wireless
Quality

Global Network Operations > Global > Overview
> AI Insights

Site Network Operations > Sites > Overview >
AI Insights

Access
Points

Network Operations > Global > Devices >
Access Points > Device Name > AI
Insights

Outdoor clients are impacting Wi-Fi
performance

Wireless
Quality

Global Network Operations > Global > Overview
> AI Insights
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Cards
All the insights in Aruba Central display certain cards with additional information specific to that insight. The
top view of each card usually shows the top 5 data in a pie chart or a bar graph view. For few cards there is
further drill down available in form of a drop-down list. The cards might vary for each insight based on the
context the insight is accessed from.

The following table displays the cards available in different insights:

Card Card Details Description

The Site card displays the number of
sites impacted by an insight. Click the

arrow to expand the card and view
the top 5 sites where the issue occurred.

The Access Point card displays the
number of APs impacted by an insight.

Click the arrow to expand the card
and view the top 5 APs where the issue
occurred. You can also click the drop-
down list to view further details about
the impacted access points.

The Client card displays the number of
clients impacted by an insight. Click the

arrow to expand the card and view
the top 5 clients where the issue
occurred.

Table 49: Cards
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Card Card Details Description

The Server card displays the number of
servers impacted by an insight. Click the

arrow to expand the card and view
the top 5 servers where the issue
occurred.

The RF Info card displays the number of
channels impacted by an insight. Click

the arrow to expand the card and
view the top 5 bands where the issue
occurred. You can also click the drop-
down list to view further details about
the impacted RF bands.

The Switch card displays the number of
switches impacted by an insight. Click

the arrow to expand the card and
view the top 5 switches where the issue
occurred. You can also click the drop-
down list to view further details about
the impacted switches.
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Card Card Details Description

The Wired Client card displays the
number of wired clients impacted by an

insight. Click the arrow to expand
the card and click the drop-down list to
view further details about the impacted
wired clients.

The Roam card displays the percentage
of client latency roams. Click the arrow

to expand the card and click the
drop-down list to view further details
about the roaming latency and band.

The Tunnel card displays the number of
gateway tunnels down. Click the arrow

to expand the card and view the
reasons for the cause of tunnel down.
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Card Card Details Description

The Gateway card displays the number
of gateways impacted by an insight.

Click the arrow to expand the card
and view the top 5 gateways where the
issue occurred. You can also click the
drop-down list to view further details
about the impacted gateways.

The VPNC card displays the number of
VPNC gateways on which the tunnels

are down. Click the arrow to expand
the card and view the reasons for the
cause of VPNC tunnel down.

The Client Minutes card is available
only for Outdoor Clients Impacting
Wi-Fi Performance insight and it
displays the percentage of avoided
outdoor clients minutes and the effected
indoor client minutes in a network. Click

the arrow to expand the card and
view graphical representation of the
data.

The Port card is available for the switch
port health insights and it displays the
number of ports experiencing excessive

flaps or errors. Click the arrow to
expand the card and view the top 5
ports where the issue occurred.
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Card Card Details Description

The CPU card is available at the device
(Gateways and Switches) context and
displays the number of gateways and
switches impacted by high CPU
utilization in the network. Click the arrow

to expand the card and view
graphical representation of the data.

The Memory card is available at the
device (Gateways and Switches) context
and displays the number of gateways
and switches impacted by high memory
utilization in the network. Click the arrow

to expand the card and view
graphical representation of the data.

The Power card displays the number of
power changes in access points in the

network. Click the arrow to expand
the card and click the drop-down list to
view further details about the impacted
access points.

The Channel card displays the number
of channels changes per channel for a
specific access point in the network.

Click the arrow to expand the card
and click the drop-down list to view
further details about the impacted
channels.
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Card Card Details Description

If you click on the number displayed on each card, further details specific to that card is displayed in a
tabular format. Few columns are displayed by default whereas, there are few columns which does not
appear in the table by default.

To customize a table, click the ellipses icon to select the required columns, or click Reset to default to
set the table to the default columns.

Baselines
Baseline enables you to compare your network performance with similar peer groups. Baseline is calculated
on a weekly basis and is available in the trend chart for insights in the Site context only. Baseline is displayed
as a blue line in the trend chart. The following two baselines are available in Aruba Central:

n Class baseline—Provides a comparison with similar peer groups in the networks. Peer group
classification is done based on various parameters such as number of access points, neighboring devices
information, and so on.

n Company baseline—Provides a comparison of the network within the entire customer ID (CID).

Baseline is supported for the following insights:

n Clients had an unusual number of MAC authentication failures
n Clients had excessive Wi-Fi security key-exchange failures
n Clients had excessive 802.1x authentication failures
n Clients had DHCP server connection problems
n DNS queries failed to reach or return from the servers
n DNS server(s) rejected a high number of queries
n DNS request/responses were significantly delayed
n Access Points had unusually high CPU utilization
n Access Points with unusually high memory usage were found
n Access Points had a high number of reboots
n Information (telemetry) was not received from APs/Radios
n Access Points had an excessive number of channel changes
n Access Points impacted by high 2.4 GHz usage
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n Access Points were impacted by high 5 GHz usage
n Access Point transmit power can be optimized
n Dual-band (2.4/5 GHz) capable clients primarily used 2.4 GHz
n Clients had a significant number of Low SNR uplink minutes

Access Points had a high number of reboots
TheAccess Points had a high number of reboots insight can be accessed from theGlobal, Site, and
Access Points context. This insight provides information about APs that have been rebooted the
maximum times and is categorized under availability as the clients connected to these APs experience
connectivity drops. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the number of AP reboots that occurred during the selected time period. Hover your
mouse over each bar graph to see the exact number of reboots. The following graph shows data trend for
the last 30 days (1 Month).

Figure 24 Excessive AP Reboots Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site

Table 50: Cards Context

Site

Lists the number of sites where the APs experience excessive reboots. Click the arrow to view the
pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a detailed
description of the impacted sites:

n Site—Name of the site impacted by the insight.
n APs with Excessive Reboots—Number of APs that experience expressive reboots in each site.
n Reboot Count—Number reboots that occurred in each AP in a specific site.
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Access Point

Lists the number and details of reboots observed in an AP. Click the arrow to view the pictorial graph of
the Top 5 impacted access points. Click theAccess Point drop-down list, to view the following:

n Time Series—Pictorial graph of the AP reboots that occurred on different dates but similar timestamp.
n FW Version—Pictorial graph of AP reboots classified by AP firmware versions.
n AP Model—Pictorial graph of AP reboots classified by AP models.

Click the number displayed on theAccess Point card, to view a detailed description of the impacted access
points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP.
n AP Serial—Serial number of the AP.
n Firmware—Version of the firmware running on each AP.
n AP Model—Model number of each AP.
n Site—Name of the site where the AP resides.
n Reboot Count—Number of reboots over time.

Access Points had an excessive number of channel
changes
TheAccess Points had an excessive number of channel changes insight can be accessed from the
Global, Site, and Access Points context. This insight provides information about AP radios on the network
that changed channels excessively in the network. It is categorized under wireless quality as the connected
clients might have to reconnect after an AP changes channel for a better network performance. This insight
displays the following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the APs changed channels on the network.
n Recommendation—Displays the recommendation against each failure to resolve the same.
n Channel Changes—Displays the exact number and percentage of failures that occurred against each

failure reason.

Time Series Graph
This bar graph displays the number of channel changes per channel for a specific AP during the selected time
period. Hover your mouse on each bar graph to see the exact number of channel changes. The following
graph shows data trend for seven days (1 Week).
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Figure 25 Excessive AP Radio Channel Changes Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site

Client Global, Site, Device

Channel Global, Site, Device

Table 51: Cards Context

Site
Lists the number of sites that experience excessive AP radio channel changes in the network. Click the arrow

to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to
view a detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Impacted Session Count—Number of times the insight is triggered on each site.
n Total Session Count—Total number of session count in each site.
n Total Channel Changes—Total number of channel changes in each site.
n Impacted Radio Count—Number of radios with high airtime.
n Total Radios—Total number of radios in each site.

Access Point
Lists the number and details of APs that experience excessive AP radio channel changes in the network. Click

the arrow to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-
down list, to view the following:

n Model—Pictorial graph of the channel changes classified by AP models.
n FW Version—Pictorial graph of channel changes classified by AP firmware versions.

Click the number displayed on theAccess Point card to view a detailed description of the impacted access
points:

n Name—Name of the access points and link to theAccess Point Details page.
n Model—Model number of each AP.
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n Band—Bandwidth where each AP dwells.
n Channel Change Count—Number of channel changes on each AP.
n Impacted Session Count—Number of times the insight is triggered on each AP.
n Total Session Count—Total number of session count in each AP.

Client
Lists the MAC Address, name, host name, auth ID, and the corresponding number of channel changes for

each client. Click the arrow to view the pictorial graph of the Top 5 impacted clients. Click the number
displayed on theClients card, to view a detailed description of the impacted clients:

n Name—Name of the impacted client.

n Impacted Count—Number of channels changed on each client.

Channel
Number of channel changes per channel for a specific AP during the selected time period. Click the arrow

to expand the card and view the pictorial graph of the channel changes. Click theChannel drop-down
list to view the following:

n Band— Pictorial graph of the channel changes based on both 2.4 GHz and 5 GHz.
n Channel—Pictorial graph of the number of channel changes per channel for a specific AP during the

selected time period. It shows a comparison of the channel change between the peer network and AP.

Click the number displayed on theChannel card to view a detailed description of the impacted channels:

n Channel—Total number of channels.
n Number of Channel Changes—Number of channels that experienced excessive changes.

Access Points had unusually high CPU utilization
TheAccess Points had unusually high CPU utilization insight can be accessed from theGlobal, Site,
and Access Points context. This insight provides information about APs that have higher than normal CPU
utilization and is categorized under availability as the clients connected to these APs experience intermittent
connectivity drops. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the number of APs that experience high CPU utilization in the network during the
selected time period. Hover your mouse on each bar graph to see the exact number of APs. The following
graph shows data trend for 3 hours in a day.

Figure 26 APs with High CPU Utilization Data
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Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site

Table 52: Cards Context

Site

Lists the number of sites where the APs experience high CPU utilization. Click the arrow to view the
pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a detailed
description of the impacted sites:

n Site—Name of the site impacted by the insight.
n APs with High CPU—Number of APs that experience high CPU utilization in each site.
n Minutes with High CPU—Time range of high CPU utilization in each site.

Access Point

Lists the number and details of APs that experience high CPU utilization in the network. Click the arrow
to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down list, to
view the following:

n AP Model—Pictorial graph of CPU utilization classified by AP models.
n FW Version—Pictorial graph of CPU utilization classified by AP firmware versions.

Click the number displayed on theAccess Point card to view a detailed description of the impacted access
points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP.
n AP Serial—Serial number of the AP.
n Firmware—Version of the firmware running on each AP.
n AP Model—Model number of each AP.
n Site—Name of the site where the AP resides.
n Minutes with High CPU—Time range of high CPU utilization on each AP.
n Minutes with High CPU (%)—Percentage of high CPU utilization on each AP.

Access Points impacted by high 2.4 GHz usage
TheAccess Points impacted by high 2.4 GHz usage insight can be accessed from theGlobal, Site, and
Access Points context. This insight provides information about AP radios whose Wi-Fi channel utilization
deviated from the normal utilization range, as compared to other APs broadcasting in the same location, RF
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band, and time of day. It is categorized under wireless quality as the connected clients experience poor Wi-Fi
performance. This insight displays the following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the APs experience higher airtime utilization in the
network.

n Recommendation—Displays the possible recommendation against each failure to resolve the same.

Time Series Graph
This bar graph displays the number of APs that experience high 2.4 GHz airtime utilization in the network
during the selected time period. Hover your mouse on each bar graph to see the exact number of APs. The
following graph shows data trend for 3 hours in a day.

Figure 27 APs with High 2.4 GHz Utilization Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site

Client Global, Site, Device

RF Info Global, Site, Device

Table 53: Cards Context

Site

Lists the number of sites that experience high 2.4 GHz airtime utilization in the network. Click the arrow
to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view
a detailed description of the impacted sites:
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n Site—Name of the site impacted by the insight.
n Duration (mins)—Time range that an AP in each site experienced high airtime utilization.
n Clients Impacted—Number of clients impacted by the insight.
n APs Impacted—Number of APs impacted by the insight in each site.
n Reasons—Cause of the high 2.4 GHz airtime utilization in each site.

Access Point
Lists the number and details of APs that experience high 2.4 GHz airtime utilization in the network. Click the

arrow to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-
down list, to view the following:

n Model—Pictorial graph of the high 2.4 GHz airtime utilization percentage classified by AP models.
n Click the number displayed on theAccess Point card to view a detailed description of the impacted

access points:
n AP Name—Name of the access points and link to theAccess Point Details page.
n MAC—MAC address of the AP.
n Serial—Serial number of the AP.
n Consumed Airtime (mins)—Time range of the consumed airtime in each AP.
n Duration (mins)—Time range that the AP experienced high airtime utilization.
n Reasons—Cause of the high 2.4 GHz airtime utilization in each AP.
n Clients Impacted—Number of clients impacted by the insight connected to each AP.
n Avg Channel Utilization (%)—Average percentage of the airtime utilization in each AP.
n AP Model—Model number of each AP.
n FW Version—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

Client
Lists the MAC Address, name, host name, auth ID, and the corresponding percentage of high 2.4 GHz

airtime utilization of each client. Click the arrow to view the pictorial graph of the Top 5 impacted
clients. Click the number displayed on theClient card, to view a detailed description of the impacted clients:

n Client Name—Name of the client impacted by the insight.
n MAC—MAC address of the client.
n Duration (mins)—Time range that the client experienced high airtime utilization.
n Reason—Cause of the high 2.4 GHz airtime utilization for each client.
n Site—Name of the site where the client exists.

RF Info

Number of channels impacted by high 2.4 GHz airtime utilization. Click the arrow to view the pictorial
graph of the impacted band. Click theRF Info drop-down list to view the following:

n Channel—Chart of AP radio channels that experienced excessive AP airtime utilization. It displays the
channels impacted by this issue over the selected time period, sorted by airtime utilization score, which is
calculated from the severity of the utilization level and the duration of time that the channel was over
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utilized.
n Reason—Pictorial graph of the percentage of causes for high 2.4 GHz airtime utilization in a channel.
n Utilization—Pictorial graph of the airtime utilization in each AP on a specific date and time.
n Power Distribution—Pictorial graph of Tx Power distribution (dBm) for both the 2.4 GHz and 5 GHz

band during the time it is transmitting signal to the client.
n Hour of Day—Pictorial graph of which hours of the day the network was most impacted by excessive AP

airtime utilization.
n SNR Percentile—Pictorial graph of the average Signal-to-Noise Ratio of the AP in different percentiles

(25th, 50th, 75th, 90th, 99th) in 2.4 GHz band and 5 GHz band.
n Click the number displayed on theRF Info card to view a detailed description of the impacted channels:
n Channel—Number of channels that experienced excessive AP airtime utilization.
n Airtime (mins)—Time range of the consumed airtime in each client.

Access Point radios changed their transmit power
frequently
TheAccess Point radios changed their transmit power frequently insight can be accessed from the
Global, Site, and Access Points context. This insight provides information on AP radios that frequently
changed transmission power levels in the network. It is categorized under wireless quality since the
connected clients experience frequent throughput fluctuations. This insight displays the following
information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the APs experience frequent transmit power changes in
the network.

n Recommendation—Displays the recommendation against each failure to resolve the same.

Time Series Graph
This bar graph displays the number of AP power changes in the network during the selected time period.
Hover your mouse on each bar graph to see the exact number of power changes. The following graph
shows data trend for 3 hours in a day.

Figure 28 Frequent AP Transmit Power Changes Data

Cards
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The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site

Power Global, Site, Device

Table 54: Cards Context

Site

Lists the number of sites that experience power transmit changes in the network. Click the arrow to
view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a
detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Power Changes—Number of power changes occurred in each site.
n Radio—Number of AP radios in each site that changed transmission power level.

Access Point
Lists the number and details of APs that experience power transmit changes in the network. Click the arrow

to view the pictorial graph of the Top 5 impacted access points. Click the number displayed on the
Access Point card to view a detailed description of the impacted access points:

n Name—Name of the access points and link to theAccess Point Details page.
n MAC—MAC address of the AP.
n Serial—Serial number of the AP.
n Power Changes—Number of power changes occurred in each AP.
n Model—Model number of each AP.
n Firmware—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

Power

Displays the number of power changes that occurred in APs in the network. Click the arrow to view the
pictorial graph of the impacted band. Click the Power drop-down list to view the following:

n Power Changes over Time—Pictorial graphs of power transmit changes observed across time for 2.4
GHz and 5 GHz radio.

n Power Distribution—Pictorial graph of the percentage of time spent across power levels for the time
period in the 2.4 GHz and 5 GHz band.

n Band—Pictorial graph of the percent of number of changes observed in the 2.4 GHz and 5 GHz bands.
n Variance—Pictorial graph of the percentage of variance in transmission power across number of APs in

that power variance for the 2.4 GHz and 5 GHz band.

Click the number displayed on the Power card to view a detailed description of the impacted channels:
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n Band—Number of power changes observed in the 2.4 GHz and 5 GHz bands.
n Changes—Number of power changes that occurred in each band.

Access Point transmit power can be optimized
TheAccess Point transmit power can be optimized insight can be accessed only at theGlobalcontext.
This insight generates when the transmit power is not set optimally on the radios of access points existing in
the network. This insight detects that wireless clients are experiencing a poor Wi-Fi connectivity due to the
transmit power settings of the access points. It is categorized under wireless quality as the clients connected
to these APs can communicate with the APs well but, the APs have difficulty to communicate with the clients
in return. This insight displays the following information:

n Insight Summary
n Card

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the transmit power of APs are not set optimally.
n Recommendation—Displays the possible recommendation against each failure to resolve the same.

Card
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

RF Info Global

Power Global

Table 55: Cards
Context

RF Info

Number of channels in the APs impacted by transmit power setting in the network. Click the arrow to
view the pictorial graph of the impacted band. Click theRF Info drop-down list to view the following:

n Band—Pictorial graph of power changes in both the frequency bands by the AP (2.4 GHz or 5 GHz).
n SSID—Pictorial graph of the percent of AP dwell bands (2.4 GHz or 5 GHz) sorted by SSIDs.

Power

Displays the number of power changes that occurred in a specific access point. Click the arrow to
expand the card to view the pictorial graph of the band and power distribution in the network. Click the
Power drop-down list, to view the following:
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n Power Distribution—Pictorial graph of the percentage of time spent across power levels for the time
period in the 2.4 GHz and 5 GHz band.

n Band—Graph of the percent of number of changes observed in the 2.4 GHz and 5 GHz bands.

Click the number displayed on the Power card, to view a detailed description of the impacted clients:

n Band—Band where the maximum power changes occurred.
n Changes—Number of power changes that occurred in each band.

Access Points were impacted by high 5 GHz usage
TheAccess Points were impacted by high 5 GHz usage insight can be accessed from theGlobal, Site,
and Access Points context. This insight provides information about AP radios whose Wi-Fi channel
utilization deviated from the normal utilization range, as compared to other APs broadcasting in the same
location, RF band, and time of day. Access Points were impacted by high 5 GHz usage is categorized
under wireless quality as the connected clients experience poor Wi-Fi performance. This insight displays the
following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the APs experience higher airtime utilization in the
network.

n Recommendation—Displays the possible recommendation against each failure to resolve the same.

Time Series Graph
This bar graph displays the number of APs that experience high 5 GHz airtime utilization in the network
during the selected time period. Hover your mouse on each bar graph to see the exact number of APs. The
following graph shows data trend for 3 hours in a day.

Figure 29 APs with High 5 GHz Utilization Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:
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Cards Context

Site Global

Access Point Global, Site

Client Global, Site, Device

RF Info Global, Site, Device

Table 56: Cards Context

Site

Lists the number of sites that experience high 5 GHz airtime utilization in the network. Click the arrow
to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view
a detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Duration (mins)—Time range that an AP in each site experienced high airtime utilization.
n APs—Number of APs impacted by the insight in each site.
n Clients—Number of clients impacted by the insight.
n Reason—Cause of the high 5 GHz airtime utilization in each site.

Access Point
Lists the number and details of APs that experience high 5 GHz airtime utilization in the network. Click the

arrow to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-
down list, to view the following:

n Model—Pictorial graph of the high 5 GHz airtime utilization percentage classified by AP models. Click the
number displayed on theAccess Point card to view a detailed description of the impacted access points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n MAC—MAC address of the AP.
n Serial—Serial number of the AP.
n Consumed Airtime (mins)—Time range of the consumed airtime in each AP.
n Duration (mins)—Time range that the AP experienced high airtime utilization.
n Reason—Cause of the high 5 GHz airtime utilization in each AP.
n Clients Impacted—Number of clients impacted by the insight connected to each AP.
n Avg Channel Utilization (%)—Average percentage of the airtime utilization in each AP.
n AP Model—Model number of each AP.
n FW Version—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

Client
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Lists the MAC Address, name, host name, auth ID, and the corresponding percentage of high 5 GHz airtime

utilization for each client. Click the arrow to view the pictorial graph of the Top 5 impacted clients. Click
the number displayed on theClient card, to view a detailed description of the impacted clients:

n Client Name—Name of the client impacted by the insight.
n MAC—MAC address of the client.
n Duration (mins)—Time range that the client experienced high airtime utilization.
n Reason—Cause of the high 5 GHz airtime utilization for each client.
n Site—Name of the site where the client exists.

RF Info

Number of channels impacted by high 5 GHz airtime utilization. Click the arrow to view the pictorial
graph of the impacted band. Click theRF Info drop-down list to view the following:

n Channel—Chart of AP radio channels that experienced excessive AP airtime utilization. It displays the
channels impacted by this issue over the selected time period, sorted by airtime utilization score, which is
calculated from the severity of the utilization level and the duration of time that the channel was over
utilized.

n Reason—Pictorial graph of the percentage of causes for high 5 GHz airtime utilization in a channel.
n Utilization—Pictorial graph of the airtime utilization in each AP on a specific date and time.
n Power Distribution—Pictorial graph of Tx Power distribution (dBm) for both the 2.4 GHz and 5 GHz

band during the time it is transmitting signal to the client.
n Hour of Day—Pictorial graph of which hours of the day the network was most impacted by excessive AP

airtime utilization.
n SNR Percentile—Pictorial graph of the average Signal-to-Noise Ratio of the AP in different percentiles

(25th, 50th, 75th, 90th, 99th) in 5 GHz band.
n Click the number displayed on theRF Info card to view a detailed description of the impacted channels:
n Channel—Number of channels that experienced excessive AP airtime utilization.
n Airtime (mins)—Time range of the consumed airtime in each client.

Access Points with unusually high memory usage
were found
TheAccess Points with unusually high memory usage were found insight can be accessed from the
Global, Site, and Access Pointscontext. This insight provides information about APs that have higher than
normal memory utilization and is categorized under availability as the clients connected to these APs
experience intermittent connectivity drops. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the number of APs that experience high memory utilization in the network during
the selected time period. Hover your mouse on each bar graph to see the exact number of APs. The
following graph shows data trend for 3 hours in a day.
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Figure 30 APs with High Memory Utilization Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site

Table 57: Cards Context

Site

Lists the number of sites where the APs experience high memory utilization. Click the arrow to view the
pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a detailed
description of the impacted sites:

n Site—Name of the site impacted by the insight.
n APs with High Memory—Number of APs that experience high memory utilization in each site.
n Minutes with High Memory—Time range of high memory utilization in each site.

Access Point
Lists the number and details of APs that experience high memory utilization in the network. Click the arrow

to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down list,
to view the following:

n AP Model—Pictorial graph of memory utilization classified by AP models.
n FW Version—Pictorial graph of memory utilization classified by AP firmware versions.

Click the number displayed on theAccess Point card to view a detailed description of the impacted access
points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP.
n AP Serial—Serial number of the AP.
n Firmware—Version of the firmware running on each AP.
n AP Model—Model number of each AP.
n Site—Name of the site where the AP resides.
n Minutes with High Memory—Time range of high memory utilization on each AP.
n Minutes with High Memory (%)—Percentage of high memory utilization on each AP.
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Clients experienced high latency while roaming
TheClients experienced high latency while roaming insight can be accessed from theGlobal, Site,
Access Points, and Clients context. This insight provides reports on wireless clients that have experienced
long roam times to the target AP. The threshold to detect a delayed and long client roaming is set to 50 ms
and all the data and analysis pattern is perceived from the target AP issues if you access this insight from the
global, site, or client context. When you access this insight from device context, data is received from the
home AP issues. Clients experienced high latency while roaming is categorized under connectivity
since it helps the network administrators to take necessary actions if there are any clients experiencing long
delays to roam between APs. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the total number of roams and the percentage of high latency roams that occurred
in the network during the selected time period. Hover your mouse on each bar graph to see the exact
number and percentage of roams. The following graph shows data trend for 3 hours in a day.

Figure 31 Clients with High Roaming Latency

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site, Client

Client Global, Site, Device

Roam Global, Site, Device, Client

Table 58: Cards Context

Site
Lists the number of sites where the clients have experience high roaming latency in the network. Click the

arrow to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site
card, to view a detailed description of the impacted sites:
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n Site—Name of the site impacted by the insight.
n High Latency Roams (%)—Number and percentage of high latency roams in each site.
n Impacted Clients Count—Number of clients impacted with high roaming latency in each site.

Access Point
Lists the number and details of APs where the clients have experience high roaming latency. Click the arrow

to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down list,
to view the following:

n Model—Pictorial graph of high roaming latency classified by AP models.
n FW Version—Pictorial graph of high roaming latency classified by AP firmware versions.

Click the number displayed on theAccess Point card to view a detailed description of the impacted access
points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n Serial—Serial number of the AP.
n High Latency Roams (%)—Number and percentage of high latency roams in each AP.
n Clients From—Number of clients that roamed in each AP.
n Latency (min/avg/max) msec—The minimum, average, and maximum latency that occurred in each

AP.
n AP MAC—MAC address of the impacted AP and link to theAccess Point Details page.
n IP—IP address of the impacted AP.
n Model— Model number of each AP.
n FW Version—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

Client
Lists the MAC Address, name, host name, auth ID, and the number of clients that have experience high
roaming latency. Click the number displayed on theClient card, to view a detailed description of the
impacted clients:

n Client Name—Name of the impacted clients and link to theClient Details page.
n Client MAC—MAC address of the impacted client and link to theClient Details page.
n High Latency Roams (%)—Number and percentage of high latency roams in each client.
n Top AP— AP where the client roamed maximum as compared to other APs in the network.

Roam
Displays the percentage of client latency roams in the network. This card includes the raw telemetry feed
sorted based on latency at each context.

Click the arrow to expand theRoam card and click the drop-down list, to view the following:

n Latency—Pictorial graph of latency versus concurrences.
n Band—Pictorial graph of clients roaming trends between 2.4 GHz and 5 GHz.

Click the number displayed on theRoam card, to view a detailed description of the impacted clients:
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n Timestamp—Timestamp of the event received.
n Latency (msec)—Latency value in microsecond per client.
n From AP—Name of the home AP from the where the client roamed to the target AP.
n To AP—Name of the target AP to where the client roamed from the home AP.
n From Channel—Number of channel the client roamed from.
n Roaming Type—Type of the roam that occurred in each client.
n From AP MAC—MAC address of the home AP from the where the client roamed to the target AP.
n From AP Serial—Serial number of the home AP from the where the client roamed to the target AP.
n To AP MAC—MAC address of the target AP to where the client roamed from the home AP.
n To AP Serial—Serial number of the target AP to where the client roamed from the home AP.
n RSSI (dBm)—Received Signal Strength Indicator (RSSI) value of the client.
n To Channel—Number of channels the client roamed to.

Clients had a significant number of Low SNR uplink
minutes
TheClients had a significant number of Low SNR uplink minutes insight can be accessed from the
Global, Site,Access Points, and Clients context. This insight provides information about access points
that have a low-quality signal-strength connection and is categorized under wireless quality as the clients
connecting at a Low SNR have low throughput and high retransmissions. This insight displays the following
information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the APs experience low-quality SNR connection in the
network.

n Recommendation—Displays the possible recommendation against each failure to resolve the same.

Time Series Graph
This bar graph displays the number of clients with low SNR uplinks AP during the selected time period.
Hover your mouse on each bar graph to see the number of SNR links. The following graph shows data trend
for 3 hours in a day.

Figure 32 Clients with Low SNR Uplink Connections

Cards
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The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site, Client

Client Global, Site, Device

RF Info Global, Site, Device

Table 59: Cards Context

Site

Lists the number of sites where the APs and clients experience low signal connection. Click the arrow to
view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a
detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n APs with Low SNR—Number of APs with low signal connection.
n Clients with Low SNR—Number of clients with low signal connection.
n Uplink Minutes of Low SNR—Duration of uplink with low signal connection in each site.
n Downlink Minutes of Low SNR—Duration of downlink with low signal connection in each site.

Access Point
Lists the number and details of APs that experience low signal connection in the network. Click the arrow

to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down list,
to view the following:

n TX Power—Pictorial graph of the percentage of Tx Power distribution (dBm) in both the 2.4 GHz and 5
GHz band during the time it is transmitting signal to the client.

Click the number displayed on theAccess Point card to view a detailed description of the impacted access
points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP and link to theAccess Point Details page.
n AP Serial—Serial number of the AP
n AP Model—Model number of each AP.
n Clients with Low SNR—Number of clients that experience low signal connection in each AP.
n Uplink Minutes of Low SNR—Duration of uplink with low signal connection in each AP.
n Uplink Low SNR Minutes in 2.4 GHz—Duration of uplink with low signal connection in 2.4 GHz band

during the time it is transmitting signal to the AP.
n Uplink Low SNR Minutes in 5 GHz—Duration of uplink with low signal minutes in 5 GHz band during

the time it is transmitting signal to the AP.
n Downlink Minutes of Low SNR—Duration of downlink with low signal connection in each AP.
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n Downlink 2.4 GHz Dwell Minutes—Duration of downlink with low signal connection in 2.4 GHz band
during the time it is transmitting signal to the AP.

n Downlink 5 GHz Dwell Minutes—Duration of downlink with low signal connection in 5 GHz band
during the time it is transmitting signal to the AP.

Client
Lists the MAC Address, name, host name, auth ID, and the number of clients experiencing low signal quality.

Click the arrow to view the pictorial graph of the Top 5 impacted clients. Click theClient drop-down list,
to view the following:

n Client Type—Pictorial graph of the number and percentage of low SNR clients classified by vendors.

Click the number displayed on theClient card, to view a detailed description of the impacted clients:

n Client Name—Number of the impacted client and link to theClient Details page.
n Client MAC—MAC address of the client and link to theClient Details page.
n Device Type—Device type of the client.
n Uplink Minutes of Low SNR—Duration of uplink with low signal connection in each client.
n Uplink 2.4 GHz Dwell Minutes—Duration of uplink with low signal connection in 2.4 GHz band during

the time it is transmitting signal to the client.
n Uplink 5 GHz Dwell Minutes—Duration of uplink with low signal connection in 5 GHz band during the

time it is transmitting signal to the client.
n Downlink Minutes of Low SNR—Duration of downlink with low signal connection in each client.
n Downlink 2.4 GHz Dwell Minutes—Duration of downlink with low signal connection in 2.4 GHz band

during the time it is transmitting signal to the client.
n Downlink 2.4 GHz Dwell Minutes—Duration of downlink with low signal connection in 5 GHz band

during the time it is transmitting signal to the client.

RF Info

Number of channels impacted by low-quality signal-strength connection in the network. Click the arrow
to view the pictorial graph of the impacted band. Click theRF Info drop-down list to view the following:

n Band— Pictorial graph of devices experiencing a low signal-quality link using 2.4 GHz or 5 GHz radio
bands.

n Good vs Bad—Pictorial graph of the amount of time (minutes) with Low SNR (Bad) and High SNR
(Good) for all the clients.

Click the number displayed on theRF Info card to view a detailed description of the impacted channels:

n Band—Number of channel changes between 2.4 GHz and 5 GHz.
n Number of Power Changes—Number of power changes.

Clients had an unusual number of MAC
authentication failures
TheClients had an unusual number of MAC authentication failures insight can be accessed from
theGlobal, Site,Access Points, and Clients context. This insight provides information on excessive MAC
authentication failures observed in the network and is categorized under connectivity as the users are
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unable to connect to the Wi-Fi network. It also helps in order to identify the rogue users in a network. This
insight displays the following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the failure occurred.
n Recommendation—Displays the recommendation against each failure to resolve the same.
n Failures—Displays the exact number and percentage of failures that occurred against each failure

reason.

Time Series Graph
This bar graph displays the number of MAC authentication failures that occurred during the selected time
period. Hover your mouse over each bar graph to see the exact number of failures. The following graph
shows data trend for the last 24 hours (1 Day).

Figure 33 MAC Authentication Failure Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site, Client

Client Global, Site, Device

Table 60: Cards Context

Site

Lists the number of sites that experienced MAC authentication failures in the network. Click the arrow
to view a pictorial graph with the Top 5 impacted sites. Click the number displayed on the Site card, to view
a detailed description of the impacted sites:
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n Site—Name of the site impacted by the insight.
n Failures—Number of failures occurred in each site.
n Total—Total number of MAC authentication in each site.

Access Point
Lists the number and the details of APs that faced the MAC authentication failures in the network. Click the

arrow to view a pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down
list to view the following:

n SSID—Pictorial graph of the percentage of MAC authentication failures sorted by SSIDs.
n Model—Pictorial graph of the percentage of MAC authentication failures sorted by AP models.
n FW Version—Pictorial graph of the percentage of MAC authentication failures sorted by AP firmware

version.

Click the number displayed on theAccess Point card, to view the detailed description of the impacted
access points:

n Name—Name of the access points and link to theAccess Point Details page.
n MAC—MAC address of the AP and link to theAccess Point Details page.
n Failures—Number of failures occurred in each AP.
n Total—Total number of MAC authentication in each AP.
n Serial—Serial number of the AP
n IP—IP address of each AP.
n Model—Model number of each AP.
n FW Version—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

Client
Lists the MAC address, name, host name, and auth ID of clients that failed MAC authentication. Click the

arrow to view the pictorial graph of the Top 5 impacted clients. Click the number displayed on the
Client card, to view a detailed description of the impacted clients:

n Name—Name of the impacted client.
n MAC—MAC address of the client and link to theClient Details page.
n Failures—Number of failures occurred in each client.
n IP—IP address of each client.
n OS—OS type of the device.

Clients had DHCP server connection problems
TheClients had DHCP server connection problems insight can be accessed from theGlobal, Site,
Access Points, and Clients context. This insight provides information on excessive client to AP DHCP
failures observed in the network. This insight occurs when Wi-Fi clients attempt to acquire a DHCP IP
address multiple times but fails to do so. It is insight is categorized under connectivity since the users fail to
get an IP address and are unable to connect to the Wi-Fi network. It displays the following information:
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n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the failure occurred.
n Recommendation—Displays the possible recommendation against each failure to resolve the same.
n Failures—Displays the exact number and percentage of failures that occurred against each failure

reason.

Time Series Graph
This bar graph displays the number of DHCP failures that occurred during the selected time period. Hover
your mouse over each bar graph to see the exact number of failures. The following graph shows data trend
for the 3 hours in a day.

Figure 34 High DHCP Failures Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Server Global, Site, Device, Client

Access Point Global, Site, Client

Client Global, Site, Device

Table 61: Cards Context

Site
Lists the number of sites that experience DHCP server connection problems in the network. Click the arrow

to view a pictorial graph with the Top 5 impacted sites. Click the number displayed on the Site card, to
view a detailed description of the impacted sites:
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n Site—Name of the site impacted by the insight.
n Failures—Number and percentage of failures occurred in each site.
n Total—Total number of DHCP requests.

Server

Lists the number of DHCP servers involved in this insight. Click the arrow to view the pictorial graph of
the Top 5 impacted sites. Click the number displayed on the Server card, to view a detailed description of
the impacted servers:

n Name—Name of server impacted by this insight.
n Failures—Number of failures occurred in each server.
n Total—Total number of DHCP requests.

Access Point
Lists the number and the details of the DHCP server connection problems observed in an AP. Click the

arrow to view a pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down
list to view the following:

n SSID—Pictorial graph of the percentage of DHCP failures sorted by SSIDs.
n Model—Pictorial graph of the percentage of DHCP failures sorted by AP models.
n FW Version—Pictorial graph of the percentage of DHCP failures sorted by AP firmware version.

Click the number displayed on theAccess Point card, to view the detailed description of the impacted
access points:

n Name—Name of the access points and link to theAccess Point Details page.
n MAC—MAC address of the AP and link to theAccess Point Details page.
n Failures—Number of failures occurred in each AP.
n Serial—Serial number of the AP
n IP—IP address of each AP.
n Model—Model number of each AP.
n FW Version—Version of the firmware running on each AP.
n Site—Site name of the AP where the failure occurred.

Client

Lists the MAC address, host name, and auth ID of clients that failed DHCP handshake. Click the arrow
to view the pictorial graph of the Top 5 impacted clients. Click the number displayed on theClient card, to
view a detailed description of the impacted clients:

n Name—Name of the impacted client.
n MAC—MAC address of the client and link to theClient Details page.
n Failures—Number of failures occurred in each client.
n Total—Total number of DHCP requests.
n IP—IP address of each client.
n OS—OS type of the device.
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Clients had excessive 802.1x authentication failures
TheClients had excessive 802.1x authentication failures insight can be accessed from theGlobal,
Site,Access Points, and Clients context. This insight provides information on excessive 802.1X
authentication failures observed in the network. It is categorized under connectivity since the users are
unable to connect to the WiFi network. This insight displays the following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the failure occurred.
n Recommendation—Displays the possible recommendation against each failure to resolve the same.
n Failures—Displays the exact number and percentage of failures that occurred against each failure

reason.

Time Series Graph
This bar graph displays the number of 802.1X authentication failures observed in the network during the
selected time period. Hover your mouse over each bar graph to see the exact number of failures. The
following graph shows data trend for 3 hours in a day.

Figure 35 802.1x Authentication Failure Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Server Global, Site, Device, Client

Access Point Global, Site, Client

Client Global, Site, Device

Table 62: Cards Context

Site
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Lists the number of sites that experienced 802.1X authentication failures in the network. Click the arrow

to view a pictorial graph with the Top 5 impacted sites. Click the number displayed on the Site card, to
view a detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Failures—Number and percentage of failures occurred in each site.
n Total—Total number of 802.1X authentication in each site.

Server

Lists the number of servers that failed 802.1X authentication in the network. Click the arrow to view
the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Server card, to view a
detailed description of the impacted servers:

n Name—IP address of each server.
n Failures—Number of 802.1X authentication failures in each server.
n Total—Total number of 802.1X authentication.

Access Point
Lists the number and the details of APs that failed 802.1X authentication in the network. Click the arrow

to view a pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down list to
view the following:

n SSID—Pictorial graph of the percentage of 802.1X authentication failures sorted by SSIDs.
n Model—Pictorial graph of the percentage of 802.1X authentication failures sorted by AP models.
n FW Version—Pictorial graph of the percentage of 802.1X authentication failures sorted by AP firmware

version.

Click the number displayed on theAccess Point card, to view the detailed description of the impacted
access points:

n Name—Name of the access points and link to theAccess Point Details page.
n MAC—MAC address of the AP.
n Failures—Number and percentage of failures occurred in each AP.
n Total—Total number of failures in each AP.
n Serial—Serial number of the AP.
n IP—IP address of the AP.
n Model—Model number of each AP.
n FW Version—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

Client
Lists the MAC address, name, host name, and auth ID of clients that failed 802.1X authentication. Click the

arrow to view the pictorial graph of the Top 5 impacted clients. Click the number displayed on the
Client card, to view a detailed description of the impacted clients:
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n Name—Name of the impacted client.
n MAC—MAC address of the client.
n Failures—Number and percentage of failures occurred in each client.
n Total—Total number of failures in each client.
n IP—IP address of the client.
n OS—OS type of the device.

Clients had excessive Wi-Fi security key-exchange
failures
TheClients had excessive Wi-Fi security key-exchange failures insight can be accessed from the
Global, Site,Access Points, and Clients context. This insight provides information on excessive Wi-Fi
security key-exchange failures observed in the network. When this failure occurs, users connecting to Wi-Fi
using PSK or 802.1x authentication, experience higher EAPOL Key exchange failures. This insight is
categorized under connectivity since the users are unable to connect to the WiFi network. This insight
displays the following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes of Wi-Fi security key-exchange failure in the network.
n Recommendation—Displays the possible recommendation against each failure to resolve the same.
n Failures—Displays the exact number and percentage of failures that occurred against each failure

reason.

Time Series Graph
This bar graph displays the number of Wi-Fi security key-exchange failures that occurred in the network
during the selected time period. Hover your mouse on each bar graph to see the exact number of failures.
The following graph shows data trend for 3 hours in a day.

Figure 36 4-Way Handshake (EAPOL Key) Failures Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:
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Cards Context

Site Global

Access Point Global, Site, Client

Client Global, Site, Device

Table 63: Cards Context

Site
Lists the number of sites that experienced excessive Wi-Fi security key-exchange failures in the network.

Click the arrow to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on
the Site card, to view a detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Failures—Number and percentage of failures occurred in each site.
n Total—Total number of failures in each site.

Access Point
Lists the number APs that experienced Wi-Fi security key-exchange failures in the network. Click the arrow

to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down list,
to view the following:

n SSID: Pictorial graph of 4-way handshake authentication failures sorted by SSIDs.
n Model: Pictorial graph of 4-way handshake failures classified by AP models.
n FW Version: Pictorial graph of 4-way handshake failures classified by AP firmware versions.

Click the number displayed on theAccess Point card to view a detailed description of the impacted access
points:

n Name—Name of the access points and link to theAccess Point Details page.
n MAC—MAC address of the AP.
n Failures—Number and percentage of failures occurred in each AP.
n Total—Total number of failures in each AP.
n Serial—Serial number of the AP.
n IP—IP address of the AP.
n Model—Model number of each AP.
n FW Version—Version of the firmware running on each AP.
n Site Name—Name of the site where the AP resides.

Client
Lists the MAC Address, name, host name, and auth ID of clients that failed Wi-Fi security key-exchange

authentication. Click the arrow to view the pictorial graph of the Top 5 impacted clients. Click the
number displayed on theClient card, to view a detailed description of the impacted clients:
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n Name—Name of the impacted client.
n MAC—MAC address of the client.
n Failures—Number and percentage of failures occurred in each client.
n Total—Total number of failures in each client.
n IP—IP address of the client.
n OS—OS type of the device.

Clients roamed excessively
TheClients roamed excessively insight can be accessed from theGlobal, Site,Access Points, and
Clients context. This insight provides reports on wireless clients that roam to the target APs more than
normal from the home AP. This insight is categorized under connectivity since this helps to reduce the
frequency of roaming clients in the customer network. It also helps network administrators to eliminate
anonymous users and deploy additional access points in case the users get effected due to poor network
performance. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the total number of roams and the percentage of excessive roams that occurred in
the network during the selected time period. Hover your mouse on each bar graph to see the exact number
and percentage of roams. The following graph shows data trend for 3 hours in a day.

Figure 37 Clients that Roam Excessively

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site, Client

Client Global, Site, Device

Table 64: Cards Context

Site
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Lists the number of sites where the clients have experience excessive roams in the network. Click the arrow

to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to
view a detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Impacted Clients—Number and percentage of clients impacted with excessive roaming in each site.

Access Point

Lists the number and details of APs where the clients have experience excessive roams. Click the arrow
to view the pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down list, to
view the following:

n Model—Pictorial graph of excessive roams classified by AP models.
n FW Version—Pictorial graph of excessive roams classified by AP firmware versions.

Click the number displayed on theAccess Point card to view a detailed description of the impacted access
points:

n From AP—The AP name from where the client roamed excessively.
n Impacted Clients (%)—Clients impacted by excessive roams in each AP.
n AP MAC—MAC address of the APs and link to theAccess Point Details page.
n Serial—Serial number of the AP.
n IP—IP Address of each AP.
n Model— Model number of each AP.
n FW Version—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

Client
Lists the MAC Address, name, host name, auth ID, and the number of clients that have experience high

roaming latency. Click the arrow to view the pictorial graph of the Top 5 impacted clients. Click the
number displayed on theClient card, to view a detailed description of the impacted clients:

n Client Name—Name of the clients impacted by the insight and link to theClient Details page.
n MAC—MAC address of the client impacted by the insight and link to theClient Details page.
n Excessive Roams—Number of excessive roams for each client.
n Delayed Roams—Number of delayed roams by the client.
n Top AP—AP where the client roamed maximum as compared to other APs in the network.

Coverage Holes have been detected
TheCoverage Holes have been detected insight can be accessed only at theGlobal context. This insight
determines the connection status of Wi-Fi clients with the APs due to poor Wi-Fi coverage. Machine learning
determines when a relatively large proportion of the client minutes that consistently have low SNR links. The
exact location of the coverage hole can be identified from the location of the clients listed with poor
coverage and implies that there is a need to deploy one more AP which will avoid the low SNR clients in the
network. Coverage Holes have been detected is categorized under wireless quality since the clients in
coverage holes have poor or intermittent Wi-Fi connectivity causing loss of productivity. This insight displays
the following information:
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n Insight Summary
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the clients experience poor Wi-Fi coverage in the
network.

n Recommendation—Displays the recommendation against each failure to resolve the same.

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global

Client Global

Table 65: Cards Context

Site

Lists the sites where the clients experience poor Wi-Fi coverage in the network. Click the arrow to view
the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a
detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Number of APs—Number of APs that experience coverage hole in each site.
n Coverage Holes—Total number APs that needs to be deployed in the network due to coverage holes.

Access Point
Lists the number and details of APs which has clients with poor connections due to a coverage hole in the
network. This is measured by the amount of time the client experiences poor vs good connectivity. Click the

arrow to view the pictorial graph of the Top 5 impacted access points. Click the number displayed on
theAccess Point card, to view a detailed description of the impacted access points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of each AP and link to theAccess Point Details page.
n AP Serial—Serial number of each AP.
n Firmware—Version of the firmware running on each AP.
n Model—Model number of each AP.
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n Number of Clients—Number of clients with poor Wi-Fi coverage in each AP.
n Poor Coverage (mins, %)—Time range of the coverage hole detected in each AP.

Client
Lists the MAC Address, name, host name, auth ID, and the number of connected clients affected by poor

connections determined by the total number of minutes spend in the coverage hole. Click the arrow to
view the pictorial graph of the Top 5 impacted clients. Click the number displayed on theClient card, to
view a detailed description of the impacted clients:

n Client Name—Name of the client and link to Client Details page.
n Client MAC—MAC address of the client and link to theClient Details page.
n OS—Operating system of the client.
n Average SNR (dB)—Average SNR of the client on the AP.
n Poor Coverage (mins, %)—Time range of the coverage hole detected in each client.

Dual-band (2.4/5 GHz) capable clients primarily used
2.4 GHz
TheDual-band (2.4/5 GHz) capable clients primarily used 2.4 GHz insight can be accessed from the
Global, Site,Access Points, and Clients context. This insight provide reports on Dual band capable clients
that spent more airtime on 2.4 GHz band instead of 5 GHz band. Dual-band (2.4/5 GHz) capable clients
primarily used 2.4 GHz is categorized under wireless quality since the 2.4 GHz band has more
interference, more clients, and less bandwidth capabilities than the 5 GHz band. Dual-band clients have a
better user experience when they are on the 5 GHz band. This insight displays the following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the client is excessively dwelling in the 2.4 GHz band in
the network.

n Recommendation—Displays the recommendation against each cause to resolve the same.

Time Series Graph
This bar graph displays the percentage of clients over dwelling in the 2.4 GHz band in the network during
the selected time period. Hover your mouse on each bar graph to see the exact percentage of the dwelling
time. The following graph shows data trend for 3 hours in a day.

Figure 38 Clients with Excessive 2.4 GHz Dwell Time Data
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Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site

Client Global, Site, Device

Table 66: Cards Context

Site

Lists the number of sites where the clients are dwelling excessively in the 2.4 GHz band. Click the arrow
to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view
a detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Clients Impacted—Number of clients in each site that is excessively dwelling in the 2.4 GHz band.
n APs Impacted—Number of APs impacted by the insight in each site.

Access Point
Lists the number and details of APs where the clients are dwelling excessively in the 2.4 GHz band. Click the

arrow to view the pictorial graph of the Top 5 impacted access points. Click the number displayed on
theAccess Point card to view a detailed description of the impacted access points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP.
n AP Serial—Serial number of the AP.
n AP Model—Model number of each AP.
n Site—Name of the site where the AP resides.
n Total Clients—Total number of clients connected to each AP.
n Clients with Excess 2.4 GHz Dwell—Number of clients that is dwelling excessively on 2.4 GHz band.

Client
Lists the MAC Address, name, host name, auth ID, and the corresponding percentage of time spent for each

client in the radio bands. Click the arrow to view the pictorial graph of the Top 5 impacted clients. Click
theClient drop-down list, to view the following:

n Client Type—Pictorial graph of the percent of clients dwelling in the 2.4 GHz band sorted by client
device type.

Click the number displayed on theClient card, to view a detailed description of the impacted clients:
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n Client Name—Name of the client impacted by the insight.
n Client MAC—MAC address of the client impacted by the insight and link to theClient Details page.
n Device Type—Clients dwelling in the 2.4 GHz band sorted by client device type.
n Site—Name of the site where the client resides.
n 2.4 GHz Dwell Minutes—Duration of each client dwelling in the 2.4 GHz band.
n 5 GHz Dwell Minutes—Duration of each client dwelling in the 5 GHz band.
n Total Dwell Minutes—Total duration of each client dwelling on both the bands.
n Dwell Time in 2.4 GHz (%)—Percentage of the time of each client dwelling on 2.4 GHz band.

DNS request/responses were significantly delayed
TheDNS request/responses were significantly delayed insight can be accessed from theGlobal, Site,
Access Points, and Clients context. This insight provides information on significant delays in response
from the DNS servers. It is categorized under connectivity since there is a high delay in response from the
DNS server. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the number of delays from the DNS server that occurred during the selected time.
Hover your mouse on each bar graph to see the exact number of delays. The following graph shows data
trend for seven days (1 Week).

Figure 39 Excessive DNS Delays Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Server Global, Site, Device

Access Point Global, Site

Table 67: Cards Context

Site
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Lists the number sites that experience delays from the DNS server in the network. Click the arrow to
view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a
detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Min (ms)—Packet latency (delay) is measured. The lowest value of delay in the measurement interval is

the minimum response delay.
n Avg (ms)—Packet latency (delay) is measured. The average value of delay in the measurement interval is

the minimum response delay.
n Max (ms)—Packet latency (delay) is measured. The maximum value of delay in the measurement

interval is the maximum response delay.

Server

Lists the number of DNS servers that is impacted by this insight. Click the arrow to view the pictorial
graph of the Top 5 impacted servers. Click the number displayed on the Server card, to view a detailed
description of the impacted servers:

n Server IP—IP address of each server.
n Avg (ms)—Packet latency (delay) is measured. The average value of delay in the measurement interval is

the minimum response delay.
n Min (ms)—Packet latency (delay) is measured. The lowest value of delay in the measurement interval is

the minimum response delay.
n Max (ms)—Packet latency (delay) is measured. The maximum value of delay in the measurement

interval is the maximum response delay.

Access Point

Lists the number and details of APs that has the most DNS response delays. Click the arrow to view the
pictorial graph of the Top 5 impacted access points. Click the number displayed on theAccess Point card,
to view a detailed description of the impacted access points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP and link to theAccess Point Details page.
n AP Serial—Serial number of the AP.
n Avg (ms)—Packet latency (delay) is measured. The average value of delay in the measurement interval is

the minimum response delay.
n Min (ms)—Packet latency (delay) is measured. The lowest value of delay in the measurement interval is

the minimum response delay.
n Max (ms)—Packet latency (delay) is measured. The maximum value of delay in the measurement

interval is the maximum response delay.
n Servers—Server ID where the AP resides.
n Model—Model number of each AP.
n Firmware—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

DNS server(s) rejected a high number of queries
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TheDNS server(s) rejected a high number of queries insight can be accessed from theGlobal, Site,
Access Points, and Clients context. This insight provides information on excessive request failures from
the DNS servers. It is categorized under connectivity since there is a high number of request failures. This
insight displays the following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the failure occurred.
n Recommendation—Displays the possible recommendation against each failure to resolve the same.
n Failures—Displays the exact number and percentage of failures that occurred against each failure

reason.

Time Series Graph
This bar graph displays the number of request failures from the DNS server that occurred during the
selected time. Hover your mouse on each bar graph to see the exact number of failures. The following
graph shows data trend for 3 hours in a day.

Figure 40 Excessive DNS Request Failures Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Server Global, Site, Device

Access Point Global, Site

Table 68: Cards Context

Site
Lists the number sites that experience request failures from the DNS server in the network. Click the arrow

to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to
view a detailed description of the impacted sites:



Aruba Central | User Guide 238

n Site—Name of the site impacted by the insight.
n Total Failures(%)—Total number of failure packets at the site multiplied by 100.
n Query Attempts—Number of query attempts sent to the DNS server in a site.
n Query Success(%)—Percentage of successful DNS queries in a site.
n Query Format Error—Error in the DNS query format sent to the DNS server in a site.
n Request Failed to Complete—DNS request failed to complete, and the server responds with an error

code.
n Domain Name Does Not Exist—Domain name sent to the DNS server does not exist and the server

responds with an error code
n Function Not Implemented—Function is not implemented on the DNS server and the server responds

with an error code.
n Server Refused to Answer Query—Server refused to answer the query and responds with an error

code.

Server

Lists the number of servers that has the most number of DNS request rejections. Click the arrow to
view the pictorial graph of the Top 5 impacted servers. Click the number displayed on the Server card, to
view a detailed description of the impacted servers:

n Server IP—IP address of each server.
n Total Failures(%)—Total number of failure packets at the site multiplied by 100.
n Query Attempts—Number of query attempts sent to the DNS server.
n Query Success(%)—Percentage of successful DNS queries.
n Query Format Error—Error in the DNS query format sent to the DNS server in a site.
n Request Failed to Complete—DNS request failed to complete, and the server responds with an error

code.
n Domain Name Does Not Exist—Domain name sent to the DNS server does not exist and the server

responds with an error code
n Function Not Implemented—Function is not implemented on the DNS server and the server responds

with an error code.
n Server Refused to Answer Query—Server refused to answer the query and responds with an error

code.

Access Point
Lists the number and details of access points that has the most number of DNS request rejections. Click the

arrow to view a pictorial graph of the Top 5 impacted access points. Click theAccess Point drop-down
list to view the following:

n Success Rate—Graphical representation of the total failures and total successful requests that occurred
at the server.

Click the number displayed on theAccess Point card, to view a detailed description of the impacted access
points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP and link to theAccess Point Details page.
n AP Serial—Serial number of the AP.
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n Total Failures(%)—Total number of failure packets at the site multiplied by 100.
n Query Attempts—Number of query attempts sent to the DNS server in each AP.
n Query Success(%)—Percentage of successful DNS queries in each AP.
n Query Format Error—Error in the DNS query format sent to the DNS server in each AP.
n Request Failed to Complete—DNS request failed to complete, and the server responds with an error

code.
n Domain Name Does Not Exist—Domain name sent to the DNS server does not exist and the server

responds with an error code
n Function Not Implemented—Function is not implemented on the DNS server and the server responds

with an error code.
n Server Refused to Answer Query—Server refused to answer the query and responds with an error

code.
n Site—Name of the site where the AP resides.

Gateways had high Memory usage
TheGateways had high Memory usage insight can be accessed from theGlobal, Site, and Gateways
context. This insight provides information about gateways that have higher than normal memory
utilization. It is categorized under availability since the clients connected to these gateways experience
intermittent connectivity drops. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the percentage of impacted in the network during the selected time period. Hover
your mouse on each bar graph to see the percentage of impacted gateways. The following graph shows
data trend for 3 hours in a day.

Figure 41 Gateways with High Memory Utilization Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Gateway Global, Site

Table 69: Cards Context
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Cards Context

Memory Device

Site

Lists the number of sites where the gateways experience high memory utilization. Click the arrow to
view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a
detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Number of Gateways—Number of gateways that experience high memory utilization in each site.
n Duration (mins)—Amount of time (minutes) high memory utilization observed in each site.

Gateway
Lists the number and details of gateways that experience high memory utilization in the network. Click the

arrow to view the pictorial graph of the Top 5 impacted access points. Click theGateway drop-down
list, to view the following:

n Gateway Model—Pictorial graph of memory utilization classified by gateway models.
n FW Version—Pictorial graph of memory utilization classified by gateway firmware versions.
n Mode—Operational mode of the gateway.

Click the number displayed on theGateway card to view a detailed description of the impacted gateways:

n Serial—Serial number of each gateway and link to theGateway Details page.
n Gateway Name—Name of the gateway that experience high memory utilization.
n Mode—Operational mode of the mode.
n Max Memory—Maximum memory consumed by the gateway.
n Minutes with High Memory—Amount of time (minutes) high memory utilization observed in each

gateway.
n Model—Model number of each gateway.
n Firmware—Version of the firmware running on each gateway.
n Site—Name of the site where the gateway resides.

Memory

Memory card is displayed only when this insight is accessed from the device context. Click the arrow to
expand the card and view the graphical representation of the time series of memory utilization percentage
in the selected gateway.

Gateways had unusually high CPU utilization
TheGateways had unusually high CPU utilization insight can be accessed from theGlobal, Site, and
Gateways context. This insight provides information about gateways that have higher than normal CPU
utilization. It is categorized under availability since the clients connected to these gateways experience
intermittent connectivity drops. This insight displays the following information:



Gateways had unusually high CPU utilization | 241

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the percentage of impacted gateways in the network during the selected time
period. Hover your mouse on each bar graph to see the percentage of impacted gateways. The following
graph shows data trend for 3 hours in a day.

Figure 42 Gateways with High CPU Utilization Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Gateway Global, Site

CPU Device

Table 70: Cards Context

Site

Lists the number of sites where the gateways experience high CPU utilization. Click the arrow to view
the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a
detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Number of Gateways—Number of gateways that experience high CPU utilization in each site.
n Duration (mins)—Amount of time (minutes) high CPU utilization observed in each site.

Gateway
Lists the number and details of gateways that experience high CPU utilization in the network. Click the

arrow to view the pictorial graph of the Top 5 impacted access points. Click theGateway drop-down
list, to view the following:

n Gateway Model—Pictorial graph of CPU utilization classified by gateway models.
n FW Version—Pictorial graph of CPU utilization classified by gateway firmware versions.
n Mode—Operational mode of the gateway.
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Click the number displayed on theGateway card to view a detailed description of the impacted gateways:

n Serial—Serial number of each gateway and link to theGateway Details page.
n Gateway Name—Name of the gateway that experience high CPU utilization.
n Mode—Operational mode of the gateway.
n Max CPU—Rate of maximum CPU utilization observed in each gateway.
n Minutes with High CPU—Amount of time (minutes) high CPU utilization observed in each gateway.
n Model—The hardware model of each gateway.
n Firmware—Version of the firmware running on each gateway.
n Site—Name of the site where the gateway resides.

CPU

CPU card is displayed only when this insight is accessed from the device context. Click the arrow to
expand the card and view the graphical representation of the time series of CPU utilization percentage in the
selected gateway.

Gateway tunnels failed to get established
TheGateway tunnels failed to get established insight can be accessed from theGlobal, Site, and
Gateways context. This insight provides information about gateway tunnels that are marked down in the
network. It is categorized under availability since the clients connected to these gateways experience
connectivity drops.

Gateway Tunnels Down insight is available for branch and VPNC gateways in the network.

Tunnels are marked down in the network based on the following scenarios:

n If Aruba Central receives telemetry from branch gateway that a specific tunnel is down
n If Aruba Central receives telemetry from the VPNC that a specific tunnel is down
n Lack of telemetry from both branch and VPNC gateway

This insight displays the following information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for tunnel down in the network.
n Minutes Down—Displays the exact number and percentage of tunnel down that occurred against each

failure reason.

Time Series Graph
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This bar graph displays the percentage and number of tunnels down in the network during the selected time
period. Hover your mouse on each bar graph to see the exact percentage of tunnels down. The following
graph shows data trend for 3 hours in a day.

Figure 43 Gateway Tunnels Down Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Gateway Global, Site

VPNC Global, Site, Device

Tunnel Global, Site, Device

Table 71: Cards Context

Site

Lists the number of sites where the gateways experience tunnel down. Click the arrow to expand the
card and click the number displayed on the Site card, to view a detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Number of Down Tunnels—Number of tunnels down in each site that experience high memory

utilization in each site.
n Total Tunnels—Total number of gateway tunnels in each site.
n Number of Impacted Gateways—Number of gateways impacted by tunnel down in each site.
n Number of Impacted VPNC—Number of VPNC gateways that experience tunnel down in each site.

Gateway

Lists the number and the reason for the cause of tunnel down in gateways. Click the arrow to expand
the card and click the number displayed on theGateway card to view a detailed description of the
impacted gateways:

n Serial—Serial number of each gateway and link to theGateway Details page.
n Gateway Name—Name of the gateway that experience tunnel down.
n Mode—Operational mode of the gateway.
n Number of Tunnels—Number of tunnels down in each gateway.
n Total Tunnels—Total number tunnels in each gateway.
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n Duration (mins)—Time range of tunnel down in each gateway.
n Model—The hardware model number of the gateway.
n Firmware—Version of the firmware running on each gateway.
n Site—Name of the site where the gateway resides.

VPNC

Displays the total number of VPNC gateways experiencing tunnel down. Click the arrow to expand the
card and view the amount of time (minutes) and the reasons for the cause of down tunnels on the VPNC
gateways.

Click the number displayed on theVPNC card to view a detailed description of the impacted VPNC
gateways:

n Serial—Serial number of each gateway and link to theGateway Details page.
n Gateway Name—Name of the gateway that experience tunnel down.
n Mode—Operation mode of the VPNC.
n Total Number of Tunnels Down—Number of tunnels down in each gateway.
n Total Number of Tunnels—Number of tunnels down in each gateway.
n Number of Gateways—Number of gateways impacted by tunnel down.
n Number of Sites—Number of site impacted by tunnel down.
n Duration (mins)—Time range of tunnel down in each gateway.
n Model—The hardware model number of the gateway.
n Firmware—Version of the firmware running on each gateway.
n Site—Name of the site where the gateway resides.

Tunnel

Displays the total number of gateways experiencing tunnel down. Click the arrow to expand the card to
view the amount of time (minutes) and the reasons for the cause of tunnel down in the network.

Click the number displayed on the Tunnel card to view a detailed description of the impacted tunnels:

n Site Name—Name of the site where the tunnel resides.
n Gateway IP—IP address of the impacted gateway.
n VPNC IP—IP address of the impacted VPNC gateway.
n Duration (mins)—Time range of tunnel down.
n Gateway VLAN—VLAN ID of the gateway.
n VPNC VLAN—VLAN ID of the VPNC.
n Gateway Name—Name of the gateway where the tunnel is down.
n Gateway MAC—MAC address of the impacted gateway.
n VPNC Name—Name of the VPNC gateway where the tunnel is down.
n VPNC MAC—MAC address of the impacted VPNC gateway.
n Gateway Serial—Serial number of the gateway and link to theGateway Details page.
n VPNC Serial—Serial number of VPNC gateway.



DNS queries failed to reach or return from the servers | 245

DNS queries failed to reach or return from the
servers
TheDNS queries failed to reach or return from the serverinsight can be accessed from theGlobal,
Site, and Access Points context. This insight provides information about wireless APs that experience a
higher than normal number of connection failures with the DNS server. It is categorized under connectivity
since the wireless clients are unable to reach the destination URL. This insight displays the following
information:

n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the failure occurred.
n Recommendation—Displays the possible recommendation against each failure to resolve the same.

Time Series Graph
This bar graph displays the number of connection loss with the DNS server that occurred during the
selected time. Hover your mouse on each bar graph to see the exact number of loss. The following graph
shows data trend for 3 hours in a day.

Figure 44 High Number DNS Loss Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Server Global, Site, Device

Access Point Global, Site

Table 72: Cards Context

Site
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Lists the number sites that experience connection loss with the DNS server in the network. Click the arrow

to view the pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to
view a detailed description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Lost DNS Queries (%)—Total count of the DNS packets that get lost in the network. DNS server does

not receive these packets.
n Total Queries—Total number of successful DNS queries, denied DNS queries, and lost queries in the

DNS server.

Server
Lists the number of servers that have higher number of DNS connection failures in the network. Click the

arrow to view the pictorial graph of the Top 5 impacted servers. Click the number displayed on the
Server card, to view a detailed description of the impacted servers:

n Server IP—IP address of each server.
n Lost DNS Queries (%)—Total count of the DNS packets that get lost in the network. DNS server does

not receive these packets.
n Total Queries—Total number successful DNS queries, denied DNS queries, and lost queries in the DNS

server.

Access Point
Lists the number and details of APs that have higher number of DNS connection failures in the network.

Click the arrow to view a pictorial graph of the Top 5 impacted access points. Click theAccess Point
drop-down list to view the following:

n Success RateGraphical representation of the total failures and total successful requests that occurred
at the AP.

Click the number displayed on theAccess Point card, to view a detailed description of the impacted access
points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP and link to theAccess Point Details page.
n AP Serial—Serial number of the AP.
n Lost DNS Queries (%)—Total count of the DNS packets that get lost in the network. DNS server does

not receive these packets.
n Total Queries—Total number successful DNS queries, denied DNS queries, and lost queries in the DNS

server.
n Model—Model number of each AP.
n Firmware—Version of the firmware running on each AP.
n Site—Name of the site where the AP resides.

Information (telemetry) was not received from
APs/Radios
The Information (telemetry) was not received from APs/Radios insight can be accessed from the
Global and Site, and Access Points context. This insight provides information about AP radios that missed
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sending telemetry data to Aruba Central, and is categorized under availability since AI insights loses visibility
of the APs. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
This bar graph displays the number of 2.4 GHz and 5 GHz radios that failed to send telemetry data during
the selected time period. Hover your mouse over each bar graph to see the exact number of missing radios.
The following graph shows data trend for 3 hours in a day.

Figure 45 APs with Missing Telemetry Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Access Point Global, Site

Table 73: Cards Context

Site

Lists the number of sites where the APs experience missing telemetry. Click the arrow to view the
pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a detailed
description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Radios Impacted—Number radio channels that missed telemetry data.
n Minutes Missing—Time range of missing telemetry in each site.
n Hours Missing—Hourly data of the missing telemetry in each site.

Access Point

Lists the number and details of APs that experience missing telemetry. Click the arrow to view the
pictorial graph of the Top 5 impacted access points. Click the number displayed on theAccess Point card,
to view a detailed description of the impacted access points:

n AP Name—Name of the access points and link to theAccess Point Details page.
n AP MAC—MAC address of the AP and link to theAccess Point Details page.
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n AP Serial—Serial number of the AP.
n Firmware—Version of the firmware running on each AP.
n AP Model—Model number of each AP.
n Site Name—Name of the site where the AP resides.
n Minutes Missing in 2.4 GHz—Time range (minutes) of missing telemetry in 2.4 GHz band.
n Hours missing in 2.4 GHz—Time range (hours) of missing telemetry in 2.4 GHz band.
n Minutes missing in 5 GHz—Time range (minutes) of missing telemetry in 5 GHz band.
n Hours missing in 5 GHz—Time range (hours) of missing telemetry in 5 GHz band.

Outdoor clients are impacting Wi-Fi performance
TheOutdoor clients are impacting Wi-Fi performance insight can be accessed only at theGlobal
context. The intention of this insight is to understand which outdoor clients are affecting the performance
of the indoor AP. Outdoor clients are impacting Wi-Fi performance insight provides information about
the optimum Probe/Auth SNR Threshold value and recommended config value for Probe/Auth SNR
Threshold below which APs ignore Probe Requests and Authentication Requests from far away clients. It is
triggered when the Probe SNR threshold is not set optimally. Following are the recommendation scenarios:

n If the SNR Threshold value is below 8dBm, it is set back to 8dBm
n If the SNR Threshold value is anything higher than 16dBm, it is set back to 16dBm
n If the SNR Threshold is between 8dBm and 16dBm, no recommendation is provided
n If the recommended threshold value is in the range of +3 or -3, no recommendation will be provided

since there might be very few clients in the network or there might be some genuine users in that range

This insight is categorized under wireless quality as low SNR clients (outdoor) experience poor Wi-Fi
connectivity and this in return affects other clients on the AP, which have good SNR connections. This
insight displays the following information:

n Insight Summary
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Clients connected to the wireless network at low SNR.
n Recommendation—Change the Probe RSSI threshold and the Auth RSSI threshold to the

recommended value to improve the indoor Wi-Fi client experience.

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:



Switches had an unusual number of port error | 249

Cards Context

Client Global

Client Minute Global

Table 74: Cards Context

Client
Lists the MAC Address, name, host name, auth ID, and the total number of clients below the proposed SNR

threshold. Click the arrow to view the pictorial graph of the Top 5 impacted clients. Click the number
displayed on theClient card, to view a detailed description of the impacted clients:

n Client Name—Number of the impacted client and link to theClient Details page.
n Client MAC—MAC address of the impacted client.
n OS—OS type of the device.
n Site—Name of the site where the client resides.
n Duration (mins)—Number of minutes client was outside below the recommended Probe SNR/ Auth

threshold.

Client Minute
Displays the percentage of avoided outdoor clients minutes and effected indoor client minutes in a chart.
The graph also shows current and the recommended threshold (dBm) for each client type in the network. In
order to rectify the issue, the Probe SNR threshold must be set to the recommended value. This frees up
airtime and AP resources for indoor users.

Figure 46 Probe SNR Threshold Graph

Switches had an unusual number of port error
The Switches had an unusual number of port errors insight can be accessed from theGlobal, Site,
and Switches context. This insight provides information on the switches that experience excessive port
errors confined to the Layer1 and Layer2 in the network. This insight is categorized under availability since
the wired devices connected to the affected ports experience connectivity issues. This insight displays the
following information:
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n Insight Summary
n Time Series Graph
n Cards

Insight Summary
The insight summary provides the following details:

n Reason—Displays the possible causes for which the failure occurred.
n Recommendation—Displays the recommendation against each failure to resolve the same.
n Errors—Displays the exact number and percentage of failures that occurred against each failure reason.

Time Series Graph
In Global and Site context this bar graph displays the count of switches experiencing port errors in the
network during the selected time period. Hover your mouse on each bar graph to see the number of
impacted switches during the selected time under each severity. In theDevice context this bar graph
displays the severity level of the selected switch experiencing port errors during the selected time period.
The following graph shows data trend for 3 hours in a day at theGlobal level:

Figure 47 Switch Excessive Port Errors

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Switch Global, Site

Port Global, Site, Device

Table 75: Cards Context

Site

Lists the number of sites where switches have port errors. Click the arrow to view the pictorial graph of
the Top 5 impacted sites. Click the number displayed on the Site card, to view a detailed description of the
impacted sites:

n Site—Name of the site where the impacted switch resides and link to the Site page.
n Switches with Port Errors—Number of the switches experiencing port errors.
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n Number of Errors—Number of errors in each site.
n Number of Ports—Number of ports experiencing errors in each site.

Switch

Lists the number of switches that experience excessive port errors in the network. Click the arrow to
view the pictorial graph of the Top 5 impacted switches. Click the Switch drop-down list to view the
following:

n Switch Model—Pictorial graph of port errors classified by switch models.
n FW Version—Pictorial graph of port errors classified by switch firmware versions.

Click the number displayed on the Switch card to view a detailed description of the impacted switches:

n Switch Name—Name of the switch experiencing port errors and link to the Switch Details page.
n Serial—Serial number of the impacted switch and link to the Switch Details page.
n Stack ID—Stack ID of the impacted switch.
n Number of Errors—Number of port errors in each switch.
n Number of Ports—Number of ports experiential excessive errors.
n Model—Model number of the impacted switch.
n Firmware—Version of the firmware running on each switch.
n Site—Name of the site where the switch exists.

Port

Number of ports experiencing excessive errors. Click the arrow to view the pictorial graph of the Top 5
impacted ports. Click the number displayed on the Port card, to view a detailed description of the impacted
ports:

n Switch Name—Name of the switch experiencing power issues and link to the Switch Details page.
n Serial—Serial number of the impacted switch and link to the Switch Details page.
n Stack ID—Stack ID of the impacted switch.
n Port Number—Port number of the switch.
n Number of Errors—Number of port errors in each port.
n Status—Status of the impacted switch.
n Connected Device—MAC address of the connected device.
n Connected Device MAC—MAC address of the client device.
n Connected Device Description—An overview of the connected devices, including the OS type, model

,and version.

Switches had excessive port flaps
The Switches had excessive port flaps insight can be accessed from theGlobal, Site, and Switches
context. This insight provides information on the switches that experience port flaps in the network. It is
categorized under availability since this causes connectivity drops and also triggers the reboot of PoE
devices. This insight displays the following information:
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n Time Series Graph
n Cards

Time Series Graph
In Global and Site context this bar graph displays the count of switches experiencing port flaps in the
network during the selected time period. Hover your mouse on each bar graph to see the number of
impacted switches during the selected time under each severity. In theDevice context this bar graph
displays the severity level of the selected switch experiencing port flaps during the selected time period. The
following graph shows data trend for 3 hours in a day at theGlobal level:

Figure 48 Switch Excessive Port Flaps Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Switch Global, Site

Port Global, Site, Device

Table 76: Cards Context

Site
Site card is accessible only when this insight is accessed from the global context. It lists the number of sites

where switches have port flaps. Click the arrow to view the pictorial graph of the Top 5 impacted sites.
Click the number displayed on the Site card, to view a detailed description of the impacted sites:

n Site—Name of the site where the impacted switch resides and link to the Site page.
n Switches with Excessive Flaps—Number of the switches experiencing port flaps.
n Number of Flaps—Number of errors in each site.
n Number of Ports—Number of ports experiencing flaps in each site.

Switch

Lists the number of switches that experience excessive port flaps in the network. Click the arrow to
view the pictorial graph of the Top 5 impacted switches. Click the Switch drop-down list to view the
following:
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n Switch Model—Pictorial graph of port flaps classified by switch models.
n FW Version—Pictorial graph of port flaps classified by switch firmware versions.

Click the number displayed on the Switch card to view a detailed description of the impacted switches:

n Switch Name—Name of the switch experiencing port flaps and link to the Switch Details page.
n Serial—Serial number of the impacted switch and link to the Switch Details page.
n Stack ID—Stack ID of the impacted switch.
n Number of Flaps—Number of port flaps in each switch.
n Number of Ports—Number of ports effected by excessive flaps.
n Model—Model number of the impacted switch.
n Firmware—Version of the firmware running on each switch.
n Site Name—Name of the site where the switch exists.

Port

Number of ports experiencing excessive flaps. Click the arrow to view the pictorial graph of the Top 5
impacted ports. Click the number displayed on the Port card, to view a detailed description of the impacted
ports:

n Switch Name—Name of the switch experiencing power issues and link to the Switch Details page.
n Serial—Serial number of the impacted switch and link to the Switch Details page.
n Stack ID—Stack ID of the impacted switch.
n Port Number—Port number of the switch.
n Number of Flaps—Number of port flaps in each port.
n Status—Status of the impacted switch.
n Connected Device—MAC address of the connected device.
n Connected Device MAC—MAC address of the client device.
n Connected Device Description—An overview of the connected devices, including the OS type, Model ,

and Version.

Switches had unusually high CPU utilization
The Switches had unusually high CPU utilization insight can be accessed from theGlobal, Site, and
Switches context. This insight provides information on the switches experiencing higher than normal CPU
utilization. It is categorized under availability since the impacted switches and the associated devices
experience connectivity issues. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
In Global and Site context this bar graph displays the count of switches experiencing high CPU utilization in
the network during the selected time period. Hover your mouse on each bar graph to see the number of
impacted switches during the selected time under each severity. In theDevice context this bar graph
displays the severity level of the selected switch experiencing high CPU utilization during the selected time
period. The following graph shows data trend for 3 hours in a day at theGlobal level:
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Figure 49 Switch with High CPU Utilization Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Switch Global, Site

CPU Device

Table 77: Cards
Context

Site

Lists the number of sites where the switches experience high CPU utilization. Click the arrow to view the
pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a detailed
description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Switches with High CPU—Number of switches experiencing high CPU utilization in each site.
n Minutes with High CPU—Amount of time (minutes) high CPU utilization observed in each site.

Switch

Lists the number of switches that experience high CPU utilization. Click the arrow to view the pictorial
graph of the Top 5 impacted switches. Click the Switch drop-down list to view the following:

n Switch Model—Pictorial graph of the high CPU utilization sorted by switch models.
n FW Version—Pictorial graph of high CPU utilization sorted by switch firmware versions.

Click the number displayed on the Switch card to view a detailed description of the impacted switches:

n Switch Name—Name of the switch experiencing high CPU utilization and link to the Switch Details
page.

n Serial—Serial number the switch and link to the Switch Details page.
n Stack ID—Stack ID of the impacted switch.
n Max CPU—Maximum utilization of the CPU in each switch.
n Minutes with High CPU—Time range of high CPU utilization on each switch.
n Model—Model number of each switch.
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n Firmware—Version of the firmware running on each switch.
n Site—Name of the site where the switch exists.

CPU

Lists the time series of CPU utilization percentage for a switch. Click the arrow to expand the card and
view the graphical representation of the data in the selected switch. Click the number displayed on theCPU
card to view a detailed description of the impacted switch:

n Switch Name—Name of the switch experiencing high memory utilization.
n Max CPU—Maximum utilization of the CPU in a specific switch.
n Total Metrics—Total metrics of the utilization.
n Percentage Metrics—Percentage metrics of the utilization.
n Model—Model number of each switch.
n Firmware—Version of the firmware running on each switch.
n Site—Name of the site where the switch exists.

Switches had unusually high memory usage
The Switches had unusually high memory usage insight can be accessed from theGlobal, Site, and
Switches context. This insight provides information on the switches experiencing higher than normal
memory utilization, and is categorized under availability since the impacted switches and the associated
devices experience connectivity issues. This insight displays the following information:

n Time Series Graph
n Cards

Time Series Graph
In Global and Site context this bar graph displays the count of switches experiencing high memory
utilization in the network during the selected time period. Hover your mouse on each bar graph to see the
number of impacted switches during the selected time under each severity. In theDevice context this bar
graph displays the severity level of the selected switch experiencing high memory utilization during the
selected time period. The following graph shows data trend for 3 hours in a day at theGlobal level:

Figure 50 Switch with High Memory Utilization Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:
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Cards Context

Site Global

Switch Global, Site

Memory Device

Table 78: Cards Context

Site

Lists the number of sites where the switches experience memory utilization. Click the arrow to view the
pictorial graph of the Top 5 impacted sites. Click the number displayed on the Site card, to view a detailed
description of the impacted sites:

n Site—Name of the site impacted by the insight.
n Switches with High Memory—Number of switches experiencing high memory utilization in each site.
n Minutes with High Memory—Amount of time (minutes) high memory utilization observed in each

site.

Switch

Lists the number of switches that experience high memory utilization. Click the arrow to view the
pictorial graph of the Top 5 impacted switches. Click the Switch drop-down list to view the following:

n Switch Model—Pictorial graph of the high memory utilization sorted by switch models.
n FW Version—Pictorial graph of high memory utilization sorted by switch firmware versions.

Click the number displayed on the Switch card to view a detailed description of the impacted switches:

n Switch Name—Name of the switch experiencing high memory utilization and link to the Switch
Details page.

n Serial—Serial number the switch and link to the Switch Details page.
n Stack ID—Stack ID of the impacted switch.
n Max Memory—Maximum utilization of memory in each switch.
n Minutes with High Memory—Time range of high memory utilization on each switch.
n Model—Model number of each switch.
n Firmware—Version of the firmware running on each switch.
n Site—Name of the site where the switch exists.

Memory

Lists the time series of memory utilization percentage for a switch. Click the arrow to expand the card
and view the graphical representation of the data in the selected switch. Click the number displayed on the
Memory card to view a detailed description of the impacted switch:

n Switch Name—Name of the switch experiencing high memory utilization.
n Max Memory—Maximum utilization of memory in a specific switch.
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n Avg Memory—Average utilization of memory in a specific switch.
n Total Metrics—Total metrics of the utilization.
n Percentage Metrics—Percentage metrics of the utilization.
n Model—Model number of each switch.
n Firmware—Version of the firmware running on each switch.
n Site Name—Name of the site where the switch exists.

Switch ports had a high number with Power-over-
Ethernet problems
The Switch ports had a high number with Power-over-Ethernet problems insight can be accessed
from theGlobal, Site, and Switches context. This insight provides information on the switches that have
not received required power from PoE devices connected to them. PoE issues occur in switches when power
is denied, or power is demoted from the device connected to them. It is categorized under availability since
the impacted switches are unable to receive sufficient power. This insight displays the following
information:

n Time Series Graph
n Cards

Time Series Graph
In Global and Site context this bar graph displays the count of switches experiencing power issues in the
network during the selected time period. Hover your mouse on each bar graph to see the number of
impacted switches during the selected time under each severity. In theDevice context this bar graph
displays the severity level of the selected switch experiencing power issues during the selected time period.
The following graph shows data trend for 3 hours in a day at theGlobal level:

Figure 51 Switch PoE Issues Data

Cards
The cards vary based on the context that you access the insight from. Click one of the cards to view further
details:

Cards Context

Site Global

Switch Global, Site

Wired Clients Global, Site

Table 79: Cards Context

Site
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Lists the number of sites where switches have PoE issue. Click the arrow to view the pictorial graph of
the Top 5 impacted sites. Click the number displayed on the Site card, to view a detailed description of the
impacted sites:

n Site—Name of the site where the impacted switch resides.
n Switches with Port Issues—Number of the switches experiencing port issues.
n Events—Number of events generated pertaining to PoE failures in each site.
n Ports—Number of ports for which power is denied.
n Switches—Number of switches for which power is denied.
n Impact—Number of POE failures in each site.

Switch

Lists the number of switches that experience PoE issues in the network. Click the arrow to view the
pictorial graph of the Top 5 impacted switches. Click the Switch drop-down list to view the following:

n Switch Model—Pictorial graph of PoE issues classified by switch models.
n FW Version—Pictorial graph of PoE issues classified by switch firmware versions.

Click the number displayed on the Switch card to view a detailed description of the impacted switches:

n Switch Name—Name of the switch experiencing power issues and link to the Switch Details page.
n Serial—Serial number of the impacted switch and link to the Switch Details page.
n Events—Number of events generated pertaining to PoE failures in each switch.
n Wired Clients—Number of clients impacted by the PoE failures.
n Duration (mins)—Amount of time (minutes) for which power is denied in each switch.
n Stack ID—Stack ID of the impacted switch.
n Number of Events—Number of events generated pertaining to PoE failures in each switch.
n Model—Model number of the impacted switch.
n Firmware—Version of the firmware running on each switch.
n Site—Name of the site where the switch exists.

Wired Clients
Lists the MAC Address, name, host name, and auth ID of the clients connected to a switch that experience

PoE issues. Click the arrow to view the pictorial graph of the Top 5 impacted clients. Click theWired
Clients drop-down list to view the following:

n Model—Pictorial graph of all the device types models connected to the impacted switch.
n Vendor—Pictorial graph of the device type vendors connected to the impacted switch.

Click the number displayed on theWired Clients card to view a detailed description of the impacted
switches:

n Switch Name—Name of the impacted switch where the client resides and link to the Switch Details
page.

n Serial—Serial number of the impacted switch and link to the Switch Details page.
n Stack ID—Stack ID of the impacted switch where the client resides.
n Port Number—Port number of the switch the client device is connected to.
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n Power Requested/Offered—PoE consumption for each client.
n Reason—Cause of the denied PoE power in each client.
n Status—Status of client.
n Model—Hardware model of the impacted switch where the client resides.
n Vendor—Vendor of the wired client.
n Connected Device—MAC address of the connected device.
n Connected Device MAC—MAC address of the client device.
n Connected Device Description—An overview of the connected devices, including the OS type, model,

and version.
n Site—Name of the site where the client resides.



Chapter 6
Instant APs

Instant APs
Instant APs offer an enterprise-grade networking solution with a simple setup. The WLAN solution with
Instant APs supports simplified deployment, configuration, and management of Wi-Fi networks.

Instant APs run the Aruba Instant software that virtualizes Aruba Mobility Controller capabilities on 802.11
APs and offers a feature-rich enterprise-grade Wi-Fi solution. Instant APs are often deployed as a cluster. An
Instant AP cluster includes a master AP and set of other APs that act as slave APs.

In an Instant deployment scenario, only the first AP or the master AP that is connected to a provisioning
network is configured. All other Instant APs in the same VLAN join the master AP inherit the configuration
changes. The Instant AP clusters are configured through a common interface called Virtual Controller. A
Virtual Controller represents the combined intelligence of the Instant APs in a cluster.

Supported Deployment Modes
Aruba Instant APs can be deployed in the following modes in Aruba Central:

n Cluster mode—In this mode, several Instant APs form a cluster when connected to a provisioning
network and an master Instant AP is elected. In the cluster mode, new Instant AP onboarded to Aruba
Central can join an existing Instant AP cluster.

n Standalone mode—In this mode, individual Instant APs are provisioned in groups and managed from
Aruba Central.

Configuration and Management
Network administrators can manage Instant APs through the Aruba Instant UI, Aruba Central, or AirWave
management system.

For information on how to configure Instant APs using the Aruba Instant UI, see the Aruba Instant User
Guide.

For more information on how to deploy, provision, manage, and monitor Instant APs from Aruba Central,
see the following topics:

n Supported Instant APs on page 28
n Provisioning Instant APs on page 261
n Configuring Device Parameters on page 266
n Configuring Network Profiles on Instant APs on page 286
n Configuring Time-Based Services for Wireless Network Profiles on page 330
n Configuring ARM and RF Parameters on Instant APs on page 333
n Configuring IDS Parameters on APs on page 340
n Configuring Authentication and Security Profiles on Instant APs on page 345
n Configuring Instant APs for VPN Services on page 386
n Configuring DHCP Pools and Client IP Assignment Modes on Instant APs on page 393
n Configuring Services on page 401
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n Configuring Uplink Interfaces on Instant APs on page 412
n Configuring Enterprise Domains on page 419
n Configuring Syslog and TFTP Servers for Logging Events on page 422
n Opening a Remote Console on page 558
n Mapping Instant AP Certificates on page 426
n Configuring APs Using Templates on page 427
n Managing Variable Files on page 130
n Viewing APs Configuration Tabs on page 261

Provisioning Instant APs
The following figure illustrates the procedure for bringing up Instant APs and configuring a basic WLAN
setup. To view a detailed description of the tasks, click the task link in the flowchart.

When you click a task in the flowchart, the linked topic opens in a pop-up window. After you browse through the
topic, click outside the pop-up window to return to this page.

Figure 52 Getting Started—Instant APs

Viewing APs Configuration Tabs



Aruba Central | User Guide 262

Aruba Central now constantly displays the default tabs under the Show Advanced and Hide Advanced
options in theDevices > Access Points page. When you click the Show Advanced orHide Advanced
option, a set of default configuration tabs are displayed. The respective default tabs under these two
options are still displayed when you navigate out of the page, and visit the same page next time.

Following are the default tabs displayed when you navigate to Devices > Access Points page and click the
Config icon:

n WLANs
n Access Points
n Radios

When you click the Show Advanced option, the following tabs are displayed:

n WLANs
n Access Points
n Radios
n Interfaces
n Security
n VPN
n Services
n System
n Configuration Audit

Navigating to Virtual Controller Configuration
Dashboard
To navigate to the virtual controller configuration dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. In theVirtual Controller column, click on the virtual controller to navigate to theAccess Points >
List view of the virtual controller.

4. Click theConfig icon.

The default tabs to configure the virtual controller are displayed.

5. Click Show Advanced to view advanced configuration options.

For more information about the various configuration options, see Deploying a Wireless Network
Using Instant APs.

Deploying a Wireless Network Using Instant APs
This section describes how to configure WLAN SSIDs, radio profiles, DHCP profiles, VPN routes, security and
firewall settings, uplink interfaces, logging servers on Instant APs.

For more information on Instant AP configuration, see the following topics:
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n Configuring Device Parameters
n Configuring Network Profiles on Instant APs
n Configuring Time-Based Services for Wireless Network Profiles
n Configuring ARM and RF Parameters on Instant APs
n Configuring IDS Parameters on APs
n Configuring Authentication and Security Profiles on Instant APs
n Configuring Instant APs for VPN Services
n Configuring DHCP Pools and Client IP Assignment Modes on Instant APs
n Configuring Services
n Configuring Systems
n Configuring Uplink Interfaces on Instant APs
n Configuring Enterprise Domains
n Configuring Syslog and TFTP Servers for Logging Events
n Viewing APs Configuration Tabs
n Opening a Remote Console
n Mapping Instant AP Certificates

Setting Country Code
The initial Wi-Fi setup of an Instant AP requires you to specify the country code for the country in which the
Instant AP operates. This configuration sets the regulatory domain for the radio frequencies that the
Instant AP uses. The available 20 MHz, 40 MHz, or 80 MHz channels are dependent on the specified country
code.

Country Code Configuration in Aruba Central from UI
If you provision a new Instant AP without the country code, Aruba Central exhibits the following behavior:

Country
Code
Configured
at Instant AP

Country
Code
Configured
in Group

Behavior

No Yes The country code of the group is pushed to the newly added Instant AP.

No No Aruba Central displays the Country Code not set. Config not updated
message in Audit Trail. A notification is also displayed at the bottom of the
main window to set the country code of the new Instant AP.
To set the country code, perform the following actions:

1. Click Set Country Code now link on the notifications pane. The Set
Country Code pop up is displayed.
2. In the Device(s) without country code table, click the edit icon.
3. Specify a country code from the Country Code drop-down list.
4. Click Save.

Table 80: Instant AP Provisioned To Aruba Central

Setting Cory Code At Group Level
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If an Instant AP has a country code and joins Aruba Central using ZTP configuration, then the country code of the
Instant AP is retained. In this case,
Aruba Central will not push the group country code.

Setting Country Code at Group Level
To set the country code of the Instant AP at the group level, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click General.
6. In the Set Country code for group drop-down list, select the country code for Instant AP.
7. Click Save Settings.
8. Reboot Instant AP for changes to take effect.

By default, the value corresponding to the Set Country code for group field is empty. This indicates that any
Instant AP with different country codes can be a part of the group.
When the Set Country code for group field is set, the field cannot revert to the default value. When the country
code of the group is changed, the country code of the already connected Instant AP also will be updated.

Setting Country Code at Device Level
To set the country code of the Instant AP at the device level, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click General.
6. In theVirtual Controller pane, select an Instant AP, and then click the edit icon.
7. Select the new country code from theCountry Code drop-down list.
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8. Click OK.
9. Reboot Instant AP for changes to take effect.

Aruba Central now constantly displays the default tabs under the Show Advanced and Hide Advanced option
in the Devices > Access Points page, When you click the Show Advanced or Hide Advanced option and
navigate out of the page, the respective default tabs under Show Advanced or Hide Advanced option are still
displayed when you visit the page next time.
By default, the value corresponding to the Country code is the country code set at the group level which can be
then modified at the device level from the drop-down list. The country code of the Instant AP will always be the
most recently set country code at the group level or device level.
The auto If there is a discrepancy in country code configuration, Aruba Central displays it as an override in the
Configuration Audit page. .

Country Code Configuration at Group Level from API
Aruba Central provides an option to set and get the country code at group level through the APIs in API
Gateway.

To set or get the country code at group level through API, complete the following steps:

1. In theAccount Home page, click API Gateway.

TheAPI Gateway page is displayed.

2. Click theAuthorized Apps & Tokens tab and generate a token key.

The token key is valid only for 2 hours from the time it was generated.

3. Download and copy the generated token.
4. In theAll Published APIs window, click the url link listed under theDocumentation column.

TheCentral Network Management APIs page is displayed.

5. On the left navigation pane, select Configuration from theURL drop-down list.
6. Paste the token key in the Token field and press enter.
7. Click NB UI Group Configuration.

 The following options are displayed:
n Set country code at group level ([PUT]/configuration/v1/country)—This API allows to set

country code for multiple groups at once. Aruba Central currently allows country codes of up to
50 Instant AP device groups to be configured simultaneously. To set the country codes of multiple
groups, enter the group names and country code as inputs corresponding to the groups and
country labels respectively in the script { "groups": [ "string" ], "country": "string" } within the set_
group_config_ country_ code text box.

n Get country code set for group ([GET]/configuration/v1/{group}/country)—This API allows
to retrieve the country code set for a specific Instant AP group. To get the country code
information of the Instant AP group, enter the name of the group for which the country code is
being queried corresponding to the country label in the script { "country": "string"} within the
group text box.
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The APIs for setting and retrieving country code information are not available for the Instant AP devices
deployed in template groups.

The following are the response messages displayed in the Set country code at group level and Get
country code set for group sections:

Set country code at group level Get country code set for group

n 201 - Successful operation
n 400 - Bad Request
n 401 - Unauthorized access, authentication
required
n 403 - Forbidden, do not have write access for
group
n 413 - Request-size limit exceeded
n 417 - Request-size limit exceeded
n 429 - API Rate limit exceeded
n 500 - Internal Server Error
n 503 - Service unavailable, configuration update
in progress

n 400 - Bad Request
n 401 - Unauthorized access authentication
required
n 403 - Forbidden, do not have read access for
group
n 413 - Request-size limit exceeded
n 417 - Request-size limit exceeded
n 429 - API Rate limit exceeded
n 500 - Internal Server Error
n 503 - Service unavailable, configuration update
in progress

Table 81: Response Messages

For further details on APIs, see https://app1-apigw.central.arubanetworks.com/swagger/central.

Configuring Device Parameters
To configure device parameters on an Instant AP, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group in the filter:

a. Set the filter to one of the options underGroups. Ensure that the filter selected contains at
least one active access point.

The dashboard context for the group is displayed.

b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

n To select an access point in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

d. UnderManage, click Devices > Access Point.

2. Click theConfig icon.

The tabs to configure access points are displayed.

3. Click theAccess Points tab.

TheAccess Points table is displayed.

https://app1-apigw.central.arubanetworks.com/swagger/central


Configuring Device Parameters | 267

4. To edit an AP, select an AP in theAccess Points table, and then click the edit icon.
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5. Configure the parameters described below:
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UI Parameters Description

Basic Info Name Configures a name for the Instant AP. For Instant APs
running 8.7.0.0 or later versions, you can enter up to 128
ASCII or non-ASCII characters. For Instant APs running
8.6.0.0 or earlier versions, you can enter up to 32 ASCII or
non-ASCII characters.

Table 82: Access Points Configuration Parameters
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UI Parameters Description

AP Zone Configures the Instant AP zone. For Instant APs running
firmware versions 6.5.4.7 or later, and 8.3.0.0 or later,
you can configure multiple AP zones by adding zone
names as comma separated values.
Aruba recommends that you do not configure zones in
both SSID and in the Per AP settings of an Instant AP. If
the same zones are configured in SSID and Per AP
settings, APs may broadcast the SSIDs, but if the SSIDs
and Per AP settings have different zones configured, it
may lead to a configuration error. For more information
on AP zones, see Aruba Instant User Guide.

RF Zone Allows you to create an RF zone for the AP. With RF zone,
you can configure different power transmission settings
for APs in different zones or sections of a deployment
site. For example, you can configure power transmission
settings to make Wi-Fi available only for the devices in
specific areas of a store.
You can also configure separate RF zones for the 2.4 GHz
and 5 GHz radio bands for the Instant APs in a cluster. For
more information, see Configuring Radio Parameters on
page 338.
Aruba recommends that you configure RF zone for either
individual AP or for the cluster. Any discrepancy in the RF
zone names may lead to configuration errors.

Swarm Mode Allows to set one of the following operation modes:
Cluster—Allows Instant AP join an Instant AP cluster.
Standalone—Allows Instant AP to function in the
standalone mode.
After changing the AP operation mode, ensure that you
reboot the AP.

Preferred
Master

Turn on the toggle switch to provision the Instant AP as a
master Instant AP.

IP Address
for Access
Point

Select one of the following options:
n Get IP Address from DHCP server—Allows IP to
get an IP address from the DHCP server. By default,
the Instant APs obtain IP address from a DHCP server.
n Static—You can also assign a static IP address to
the Instant AP. To specify a static IP address for the
Instant AP, complete the following steps:
Enter the new IP address for the Instant AP in the IP
Address text-box.
Enter the subnet mask of the network in the Netmask
text-box.
Enter the IP address of the default gateway in the
Default Gateway text-box.
Enter the IP address of the DNS server in the DNS
Server text-box.

NOTE: You can configure up to two DNS servers
separated by a comma. If the first DNS server goes down,
the second DNS server takes control of resolving the
domain name.

Enter the domain name in the Domain Name text-
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UI Parameters Description

box.

Radio Enable Radio Select the Enable Radio check-box under 2.4GHz Band
and 5 GHz Band to enable and disable the radio.

Mode Select any of the following options:
n Access—In the Access mode, the Instant AP serves
clients, while also monitoring for rogue Instant APs in
the background.
n Monitor—In the Monitor mode, the Instant AP acts
as a dedicated monitor, scanning all channels for
rogue Instant APs and clients.
n Spectrum—In the Spectrum mode, the Instant AP
functions as a dedicated full-spectrum RF monitor,
scanning all channels to detect interference, whether
from the neighboring Instant APs or from non-Wi-Fi
devices such as microwaves and cordless phones. For
more information, see Spectrum Scan Overview.

NOTE: In the Monitor and Spectrum modes, the Instant
APs do not provide access services to clients.

NOTE: In the dual 5 GHz band, the Mode remains as
Access and is non-editable. This dual 5 GHz band is only
supported on AP-344 and AP-345 that runs on Instant AP
8.3.0.0. For more information, see the Configuring Dual 5
GHz Radio Bands on an Instant AP.

NOTE: To get accurate monitoring details and statistics, it
is highly recommended to reboot the Instant APs once the
Instant APs are toggled from the 2.4/5 GHz mode to dual
5 GHz radio mode or vice-versa.

Adaptive
radio
management
assigned

You can configure a radio profile on an Instant AP either
manually or by configuring the Adaptive radio
management assigned option.

NOTE: Adaptive Radio Management (ARM) feature is
enabled on Aruba Central by default. It automatically
assigns appropriate channel and power settings for the
Instant APs.

Administrator
assigned

You can also assign an administrator by using the
Administrator assigned option and selecting the
number of channels in the Channel drop-down list. In the
Transmit Power field, enter the signal strength
measured in dBm.
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UI Parameters Description

External
Antenna

Antenna Gain If the Instant AP has external antenna connectors, you
need to configure the transmit power of the system. You
can also measure or calculate additional attenuation
between the device and the antenna before configuring
the antenna gain. For more information, see Configuring
External Antenna

Antenna
Polarization
Type

The wireless bridge’s integrated antenna sends a radio
signal that is polarized in a particular direction. The
antenna’s receive sensitivity is also higher for radio
signals that have the same polarization. To maximize the
performance of the wireless link, both antennas must be
set to the same polarization direction. To maximize the
performance of the wireless link, both antennas must be
set to the same polarization direction.

Installation
Type

Installation
Type

Configure the Installation Type of the Instant AP you
have selected. The Installation Type drop-down consists
of the following options:

n Indoor
n Outdoor

You can either select the Indoor option to change the
installation to Indoor mode or select the Outdoor option
to change the installation to the Outdoor mode.
The options in the Installation Type drop-down are
listed based on the Instant AP model.

Uplink Uplink
Management
VLAN

The uplink traffic on Instant AP is carried out through a
management VLAN. However, you can configure a non-
native VLAN as an uplink management VLAN. After an
Instant AP is provisioned with the uplink management
VLAN, all management traffic sent from the Instant AP is
tagged to the management VLAN.
To configure a non-native uplink VLAN, click Uplink and
specify the VLAN in Uplink Management VLAN.

Eth0 Bridging If you want to convert the Eth0 uplink port to a downlink
port, enable Eth0 Bridging. Enable this option to support
wired bridging on the Ethernet 0 port of an Instant AP.

USB Port Enable the USB port if you do not want to use the cellular
uplink or 3G/4G modem in your current network setup.

PEAP User Create the PEAP user credentials for certificate based
authentication. Enter the user name, password, and
retype password in the Username, Password, and
Retype Password field for creating the PEAP user.
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UI Parameters Description

Mesh Mesh enable Enable this option to allow mesh access points to form
mesh network. The mesh feature ensures reliability and
redundancy by allowing the network to continue
operating even when an Instant AP is non-functional or if
the device fails to connect to the network. For more
information, see Configuring Mesh Instant AP

Clusterless
mesh name

Enter the name of mesh access points that do not belong
to any cluster. The Clusterless mesh name field is
disabled when the Mesh enable option is enabled.

Clusterless
mesh key

Enter the key of the mesh access points that do not
belong to any cluster. The Clusterless mesh key field is
disabled when the Mesh enable option is enabled.

Retype Re-enter the clusterless mesh key. The Retype is
disabled when the Mesh enable option is enabled.

6. Click Save Settings and reboot the Instant AP.

Configuring Systems
This section describes how to configure the General, Administrator, Time-Based Services, DHCP, Layer-3
Mobility, Enterprise Domains, Logging, SNMP, WISPr, Proxy, and Named VLAN Mapping parameters on an
Instant AP.

n Configuring System Parameters for an AP
n Configuring Users Accounts for the Instant AP Management Interface
n Configuring Time-Based Services for Wireless Network Profiles
n Configuring DHCP Pools and Client IP Assignment Modes on Instant APs
n Configuring Mobility for Clients
n Configuring Enterprise Domains
n Configuring Syslog and TFTP Servers for Logging Events
n Configuring SNMP Parameters
n Supported Authentication Methods
n Configuring HTTP Proxy on an Instant AP
n Configuring VLAN Name and VLAN ID

Configuring External Antenna
If the Instant AP has external antenna connectors, you need to configure the transmit power of the system.
The configuration must ensure that the system’s EIRP is in compliance with the limit specified by the
regulatory authority of the country in which the Instant AP is deployed. You can also measure or calculate
additional attenuation between the device and antenna before configuring the antenna gain. To know, if
the Instant AP device supports external antenna connectors, see the Installation Guide that is shipped along
with the Instant AP device.

EIRP and Antenna Gain
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The following formula can be used to calculate the EIRP limit related RF power based on selected antennas
(Antenna Gain) and feeder (Coaxial Cable Loss):

EIRP = Tx RF Power (dBm)+GA (dB) - FL (dB)

The following table describes this formula:

Formula
Element Description

EIRP Limit specific for each country of deployment.

Tx RF
Power

RF power measured at RF connector of the unit.

GA Antenna gain

FL Feeder loss

Table 83: Formula Variable Definitions

Configuring Antenna Gain
To configure antenna gain for Instant APs with external connectors, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group in the filter:

a. Set the filter to one of the options underGroups. Ensure that the filter selected contains at
least one active access point.

The dashboard context for the group is displayed.

b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

n To select an access point in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

d. UnderManage, click Device > Access Point.

2. Click theConfig icon.

The tabs to configure access points are displayed.

3. Click theAccess Points tab.

TheAccess Points table is displayed.

4. To edit an AP, select an AP in theAccess Points table, and then click the edit icon.
5. Click theRadio tab and select External Antenna to configure the antenna gain value. This option is

available only if the selected AP supports external antennas.
6. Enter theAntenna Gain values in dBm for the 2.4GHz Band and 5GHz Band.
7. Click Save Settings.
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Adding an Instant AP
To add an Instant AP to Aruba Central, assign an IP address and a subscription.

After an Instant AP is connected to the network and if theAuto Join Mode feature is enabled, the Instant
AP inherits the configuration from the virtual controller and is listed in theAccess Points tab.

Deleting an Instant AP from the Network
To delete an Instant AP, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. In theAccess Points table, hover over the offline AP that you want to delete.

4. Click the delete icon.

Renaming an AP
You can change the name of an AP provisioned in Aruba Central. The AP can be online or offline. When you
rename an AP or a VC, the AP or VC does not reboot, and the client traffic is not affected. The new name
must be a character string of upto 32 ASCII or non-ASCII characters, including spaces.

To rename an AP, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group in the filter:

a. Set the filter to one of the options underGroups. Ensure that the filter selected contains at
least one active access point.

The dashboard context for the group is displayed.

b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

n To select an access point in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

d. UnderManage, click Device > Access Point.

2. Click theConfig icon.

The tabs to configure access points are displayed.

3. Click theAccess Points tab.

TheAccess Points table is displayed.



Aruba Central | User Guide 276

4. To edit an AP, select an AP in theAccess Points table, and then click the edit icon.
5. UnderBasic Info, modify the AP or VC name in theName field.
6. Click Save Settings.

The AP name is updated on the AP immediately. It may take up to 1 minute for the new AP name to get reflected
in Aruba Central.Renaming an AP depends on various privileges and access permissions that are assigned to
each user to make configuration changes. For more information, see Users and Roles.

Configuring Intelligent Power Monitoring
The Intelligent Power Monitoring (IPM) feature actively measures the power utilization of an AP and
dynamically adapts to the power resources. IPM allows you to define the features that must be disabled to
save power, allowing the APs to operate at a lower power consumption without hampering the performance
of the related features. This feature constantly monitors the AP power consumption and adjusts the power
saving IPM features within the power budget.

IPM dynamically limits the power requirement of an AP as per the available power resources. IPM applies a
sequence of power reduction steps as defined by the priority definition until the AP functions within the
power budget. This happens dynamically as IPM constantly monitors the AP power consumption and
applies the next power reduction step in the priority list if the AP exceeds the power threshold. To manage
this prioritization, you can create IPM policies to define a set of power reduction steps and associate them
with a priority. The IPM policies, when applied to the AP, are based on IPM priorities, where the IPM policy
can be configured to disable or reduce certain features in a specific sequence to reduce the AP power
consumption below the power budget. IPM priority settings are defined by integer values, where the lower
values have the highest priority and are implemented first.

The Intelligent Power Monitoring feature is available only on AP devices running Aruba Instant 8.6.0.3.

To configure Intelligent Power Monitoring, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the IPM accordion.
6. Select the IPM Activation check box to enable IPM.
7. Click the + icon in the IPM Power Reduction Steps With Priorities pane.

The IPM Power Reduction Steps With Priorities window is displayed.

8. In the IPM Step Priority field, enter a value from 1 to 16 to define IPM priority.
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9. From the IPM Step drop-down list, select a setting as described in the following table:

Parameters Description

cpu_throttle_25 Reduces CPU frequency to 25% of
normal.

cpu_throttle_50 Reduces CPU frequency to 50% of
normal.

cpu_throttle_75 Reduces CPU frequency to 75% of
normal.

disable_alt_eth Disables the second Ethernet port.

disable_pse Disables Power Sourcing Equipment
(PSE).

disable_usb Disables USB.

radio_2ghz_chain_1 Reduces 2 GHz chains to 1x1.

radio_2ghz_chain_2 Reduces 2 GHz chains to 2x2.

radio_2ghz_chain_3 Reduces 2 GHz chains to 3x3.

radio_2ghz_power_3dB Reduces 2 GHz radio power by 3 dB
from the maximum value.

radio_2ghz_power_6dB Reduces 2 GHz radio power by 6 dB
from the maximum value.

radio_5ghz_chain_1 Reduces 5 GHz chains to 1x1.

radio_5ghz_chain_2 Reduces 5 GHz chains to 2x2.

radio_5ghz_chain_3 Reduces 5 GHz chains to 3x3.

radio_5ghz_power_3dB Reduces 5 GHz radio power by 3 dB
from the maximum value.

radio_5ghz_power_6dB Reduces 5 GHz radio power by 6 dB
from the maximum value.

Table 84: Intelligent Power Monitoring Step Parameters

10. Click OK.

The IPM Power Reduction Steps With Priorities table in the IPM section lists all the IPM settings.

11. Click Save Settings.
12. Reboot Instant AP for changes to take effect.

The following figure shows the IPM steps and priorities listed in the IPM Power Reduction Steps With
Priorities table:
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Figure 53 IPM Steps and Priorities

Setting a low-priority value for a power reduction step reduces the power level sooner than setting a high-
priority value for a power reduction step. However, if the power reduction step is of the same type but different
level, the smallest reduction should be allocated the lowest priority value so that the power reduction step takes
place earlier. For example, the cpu_throttle_25 or radio_2ghz_power_3dB parameter should have a lower
priority level than the cpu_throttle_50 or radio_2ghz_power_6dB, respectively, so that Intelligent Power
Monitoring reduces the CPU throttle or power usage based on the priority list.

Points to Remember
n By default, Intelligent Power Monitoring is disabled.
n When enabled, IPM enables all Instant AP functionality initially. IPM then proceeds to shut down or

restrict functionality if the power usage of the AP goes beyond the power budget of the Instant AP.

Spectrum Scan Overview
Wireless networks operate in environments with electrical and RF devices that can interfere with network
communications. Microwave ovens, cordless phones, and even adjacent Wi-Fi networks are all potential
sources of continuous or intermittent interference.

The spectrum monitor (SM) software modules on Instant APs can examine the RF environment in which the
Wi-Fi network is operating, identify interference, and classify its sources. An analysis of the results can then
be used to quickly isolate issues associated with packet transmission, channel quality, and traffic congestion
caused by contention with other devices operating in the same band or channel. SMs are Instant AP radios
that gather spectrum data but do not service clients. Each SM scans and analyzes the spectrum band used
by the SMs radio (2.4 GHz or 5 GHz).

The recorded spectrum is not reported to the virtual controller. A spectrum alert is sent to the virtual
controller when a non-Wi-Fi interference device is detected.

For more information on the Spectrum tab, see Access Point > Overview > Spectrum.

In Aruba Central, the Spectrum Scan feature is available only on Instant AP devices running Aruba Instant
firmware version 8.5.0.1 and later.

Configuring System Parameters for an AP
To configure system parameters for an AP, complete the following steps:
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1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

Aruba Central now constantly displays the default tabs under the Show Advanced and Hide Advanced
option in the Devices > Access Points page. When you click the Show Advanced or Hide Advanced
option and navigate out of the page, the respective default tabs under Show Advanced or Hide
Advanced option are still displayed when you visit the page next time.

5. Click theGeneral accordion and configure the following parameters:

Data Pane Item Description

Virtual Controller This parameter configuration is only applicable for APs that operate in a cluster
deployment environment.
To configure the virtual controller name and IP address, click edit icon and update
the name and IP address. The IP address serves as a static IP address for the multi-
AP network. When configured, this IP address is automatically provisioned on a
shadow interface on the AP that takes the role of a virtual controller. The AP sends
three ARP messages with the static IP address and its MAC address to update the
network ARP cache.
Name—Name of the virtual controller.
IP address—IPv4 address configured for the virtual controller. The IPv4 address
uses the 0.0.0.0 notation.
IPv6 address—IPv6 address configured for the virtual controller. You can configure
IPv6 address for the virtual controller only if the Allow IPv6 Management feature is
enabled.
IPv6 is the latest version of IP that is suitable for large-scale IP networks. IPv6
supports a 128-bit address to allow 2128, or approximately 3.4×1038 addresses
while IPv4 supports only 232 addresses.
The IP address of the IPv6 host is always represented as eight groups of four
hexadecimal digits separated by colons. For example
2001:0db8:0a0b:12f0:0000:0000:0000:0001. However, the IPv6 notation can be
abbreviated to compress one or more groups of zeroes or to compress leading or
trailing zeroes; for example 2001:db8:a0b:12f0::0:0:1.

Set Country code
for group

To configure a country code for the AP at the group level, select the country code
from the Set Country code for group drop-down list. By default, no country code
is configured for the AP device groups.
When a country code is configured for the group, it takes precedence over the
country code setting configured t the device level.

Timezone To configure a time zone, select a time zone from the Timezone drop-down list.
If the selected time zone supports DST, the UI displays the "The selected country
observes Daylight Savings Time" message.

Table 85: System Parameters
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Data Pane Item Description

Preferred Band Assign a preferred band by selecting an appropriate option from the Preferred
Band drop-down list.
Reboot the AP after modifying the radio profile for changes to take effect.

NTP Server This parameter allows you to configure NTP servers for the Instant AP. Up to four
NTP servers can be configured for the AP, each one separated by a comma.
To facilitate communication between various elements in a network, time
synchronization between the elements and across the network is critical. Time
synchronization allows you to:

lTrace and track security gaps, network usage, and troubleshoot network
issues.
lValidate certificates.
lMap an event on one network element to a corresponding event on another.
lMaintain accurate time for billing services and similar.

NTP helps obtain the precise time from a server and regulate the local time in each
network element. Connectivity to a valid NTP server is required to synchronize the
AP clock to set the correct time. If NTP server is not configured in the AP network,
an AP reboot may lead to variation in time data.
By default, the AP tries to connect to pool.ntp.org to synchronize time. The NTP
server can also be provisioned through the DHCP option 42. If the NTP server is
configured, it takes precedence over the DHCP option 42 provisioned value. The
NTP server provisioned through the DHCP option 42 is used if no server is
configured. The default server pool.ntp.org is used if no NTP server is configured
or provisioned through DHCP option 42.
To configure an NTP server, enter the IP address or the URL of the NTP server and
reboot the AP to apply the configuration changes.

Virtual Controller
Netmask
Virtual Controller
Gateway
Virtual Controller
DNS
Virtual Controller
VLAN

This parameter configuration is only applicable for APs that operate in a cluster
deployment environment.
The IP configured for the virtual controller can be in the same subnet as AP or can
be in a different subnet. Ensure that you configure the virtual controller VLAN,
gateway, and subnet mask details only if the virtual controller IP is in a different
subnet.
Ensure that virtual controller VLAN is not the same as native VLAN of the AP.

DHCP Option 82
XML

The DHCP Option 82 XML is not applicable for cloud APs.

DHCP Option 82 XML can be customized to cater to the requirements of any ISP
using the master AP. To facilitate customization using a XML definition, multiple
parameters for Circuit ID and Remote ID options of DHCP Option 82 XML are
introduced.
The XML file is used as the input and is validated against an XSD file in the master
AP. The format in the XML file is parsed and stored in the DHCP relay which is used
to insert Option 82 related values in the DHCP request packets sent from the client
to the server.
From the drop-down list, select one of the following XML files:

n default_dhcpopt82_1.xml
n default_dhcpopt82_2.xml

For more information, see Configuring DHCP Scopes on Instant APs.

Table 85: System Parameters
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Data Pane Item Description

Dynamic CPU
Utilization

APs perform various functions such as wired and wireless client connectivity and
traffic flows, wireless security, network management, and location tracking. If an AP
is overloaded, prioritize the platform resources across different functions. Typically,
the APs manage resources automatically in real time. However, under special
circumstances, if dynamic resource management needs to be enforced or disabled
altogether, the dynamic CPU management feature settings can be modified.
To configure dynamic CPU management, select any of the following options from
Dynamic CPU Utilization.
Automatic—When selected, the CPU management is enabled or disabled
automatically during run-time. This decision is based on real time load calculations
taking into account all different functions that the CPU needs to perform. This is the
default and recommended option.
Always Disabled in all APs—When selected, this setting disables CPU
management on all APs, typically for small networks. This setting protects user
experience.
Always Enabled in all APs—When selected, the client and network management
functions are protected. This setting helps in large networks with high client density.

Auto-Join Mode When enabled, APs can automatically discover the virtual controller and join the
network. The Auto-Join Mode feature is enabled by default.

APs allowed for
Auto-Join Mode

Displays the number of APs allowed for Auto-Join Mode.
n Click View Allowed APs to view the details of AP allowed for Auto-Join mode.
n Click Hide Allowed APs to hide the details of AP allowed for Auto-Join mode.

When Auto-Join Mode is enabled, the APs are automatically discovered and are
allowed to join the cluster. When the Auto-Join Mode is disabled on the AP, the list
of allowed APs on Aruba Central may not be synchronized or up-to-date. In such
cases, you can manually add a list of APs that can join the AP cluster in the Aruba
Central UI.
To manually add the list of allowed AP devices, complete the following steps:

Under View Allowed APs, click + in the Allowed APs pane.
In the Add Allowed AP window, enter the MAC address of the AP in the MAC
Address field.
Click Save.

Allow IPv6
Management

Enables IPv6 address configuration for the virtual controller.
You can configure an IPv6 address for a virtual controller IP only when Allow IPv6
Management feature is enabled.

Uplink switch
native VLAN

Allows you to specify a VLAN ID, to prevent the AP from sending tagged frames for
clients connected on the SSID that uses the same VLAN as the native VLAN of the
switch.
By default, the AP considers the native VLAN of the upstream switch, to which it is
connected, as the VLAN ID 1.

Terminal Access When enabled, the users can access the AP CLI through SSH.

Login Session
Timeout

Allows you to set a timeout for login session.

Console Access When enabled, the users can access AP through the console port.

WebUI Access
If an AP is connected to Aruba Central, you can use this option to disable AP Web UI
access and any communication via HTTPS or SSH. If you enable this feature, you
can manage the AP only from Aruba Central.

Table 85: System Parameters
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Data Pane Item Description

Telnet Server When enabled, the users can start a Telnet session with the AP CLI.

LED Display Enables or disables the LED display for all APs in a cluster.
The LED display is always enabled during the AP reboot.

Extended SSID Extended SSID is enabled by default in the factory default settings of APs. This
disables mesh in the factory default settings.
For AP devices that support Aruba Instant 8.4.0.0 firmware versions and above, you
can configure up to 14 SSIDs. By enabling Extended SSID, you can create up to 16
networks.

Advanced Zone Turn on the Advanced Zone toggle switch to broadcast the same ESSIDs on APs
that are part of the same AP zone in a cluster.

NOTE: When the advanced-zone feature is enabled and a zone is already
configured with 16 SSIDs, ensure to remove the zone from two WLAN SSID profiles
if you want to disable extended SSID.

Deny Inter User
Bridging

If you have security and traffic management policies defined in upstream devices,
you can disable bridging traffic between two clients connected to the same AP on
the same VLAN. When inter-user bridging is denied, the clients can connect to the
Internet but cannot communicate with each other, and the bridging traffic between
the clients is sent to the upstream device to make the forwarding decision.
To disable inter-user bridging, turn off the Deny Inter User Bridging toggle switch.

Deny Local
Routing

If you have security and traffic management policies defined in upstream devices,
you can disable routing traffic between two clients connected to the same AP on
different VLANs. When local routing is disabled, the clients can connect to the
Internet but cannot communicate with each other, and the routing traffic between
the clients is sent to the upstream device to make the forwarding decision.
To disable local routing, move the slider to the right.

Dynamic
RADIUS Proxy

If your network has separate RADIUS authentication servers (local and centralized
servers) for user authentication, you may want to enable Dynamic RADIUS proxy
to route traffic to a specific RADIUS server. When Dynamic RADIUS proxy is
enabled, the IP address of the virtual controller is used for communication with
external RADIUS servers.
To enable Dynamic RADIUS Proxy, you must configure an IP address for the
Virtual Controller and set it as a NAS client in the RADIUS server profile.

Dynamic TACACS
Proxy

If you want to route traffic to different TACACS servers, enable Dynamic
TACACS Proxy. When enabled, the AP cluster uses the IP address of the Virtual
Controller for communication with external TACACS servers.
If an IP address is not configured for the Virtual Controller, the IP address of the
bridge interface is used for communication between the AP and TACACS servers.
However, if a VPN tunnel exists between the Instant AP and TACACS server, the IP
address of the tunnel interface is used.

Cluster Security This parameter is required to be set only for APs that operate in a cluster
deployment environment.
Enables or disables the cluster security feature. When enabled, the control plane
communication between the AP cluster nodes is secured. The Disallow Non-DTLS
Slaves toggle switch appears. Turn on the toggle switch to allow slave APs to join a
DTLS enabled cluster.

Table 85: System Parameters
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Data Pane Item Description

For secure communication between the cluster nodes, the Internet connection must
be available, or at least a local NTP server must be configured.
After enabling or disabling cluster security, ensure that the configuration is
synchronized across all devices in the cluster, and then reboot the cluster.
The Disallow Non-DTLS Slaves feature is only supported in AP devices supporting
Aruba Instant 8.4.0.0 firmware versions and above.

Low Assurance
PKI

Turn on the toggle switch to allow low assurance devices that use non-TPM chip, in
the network.
To enable the cluster security feature, turn on the Low Assurance PKI toggle
switch. For more information on Low Assurance PKI, refer to Cluster Security section
in Aruba Instant User Guide.
The Low Assurance PKI toggle switch is supported in AP devices running Aruba
Instant 6.5.3.0 firmware versions and later.

Mobility Access
Switch
Integration

Turn on the toggle switch to enable LLDP protocol for Mobility Access Switch
integration. With this protocol, APs can instruct the switch to turn off ports where
rogue access points are connected, as well as take actions such as increasing PoE
priority and automatically configuring VLANs on ports where APs are connected.

URL Visibility Turn on the toggle switch to enable URL data logging for client HTTP and
HTTPS sessions and allows APs to extract URL information and periodically log
them on ALE for DPI and application analytics.

Table 85: System Parameters

6. Click Save Settings.

Configuring VLAN Name and VLAN ID
Aruba Central allows you to map VLAN name to a VLAN ID for the ease of identifying the existing VLANs.

To map a VLAN name to a VLAN ID, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click theNamed VLAN Mapping accordion.
6. Click the + icon in theVLAN Name to VLAN ID Mapping pane.

TheVLAN Name to VLAN ID Mapping window is displayed.

7. In theVLAN Name to VLAN ID Mapping window, enter theVLAN Name and VLAN ID.
8. Click OK.

TheVLAN Name to VLAN ID Mapping table in theNamed VLAN Mapping section lists all the
mapped VLAN.
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You can find theNamed VLAN Mapping feature applied in the following fields of corresponding UI pages
of Aruba Central:

n TheVLAN ID field in theVLANs tab, when for when Custom for Instant AP Assigned and Static for
External DHCP server assigned is selected during WLAN SSID creation. For more information, see
Creating a Wireless Network Profile.

n TheVLAN ID field in theVLANs tab, when Custom for Instant AP Assigned and Static for External
DHCP server assigned is selected during wired port profile creation. For more information, see
Configuring Wired Port Profiles on Instant APs.

n TheAccess rules page in the Interfaces > Access tab and theWLANs > Access tab, when you add
rules for selected roles. Select VLAN Assignment as the rule type in theAccess rules page to find the
mapped VLAN name in theVLAN ID field.

You can also map VLAN ID to a VLAN name when you customize the Client VLAN Assignment configuration in
VLANs tab during network profile creation. For more information, see VLANs Parameters.

Points to Remember
n The maximum number of Named VLAN ID Mapping allowed in Aruba Central is 32.
n VLAN mapping cannot be performed if the VLAN name does not exist.
n The VLAN mapping record is deleted from theVLAN Name to VLAN ID Mapping table when the VLAN

name is deleted.
n You can only map a single VLAN id to a VLAN name.
n The VLAN name field is not case-sensitive.

Configuring Dual 5 GHz Radio Bands on an Instant AP
Aruba Central provides an option to retrieve the radio numbers of Instant AP through the APIs. It also
provides an option to filter AP details using radio numbers in the AP monitoring dashboard.

For regular Instant APs with non-dual band, Central automatically assigns Radio 1 to 2.4 GHz band and Radio 0
to 5 GHz band respectively.

To retrieve the radio numbers through API, complete the following steps:

1. In theAccount Home page, click API Gateway.

TheAPI Gateway page is displayed.

2. Click theAPIs tab.

The token key is valid only for 2 hours from the time it was generated.

3. In theAll Published APIs window, click the url link listed under theDocumentation column.

TheCentral Network Management APIs page is displayed.

4. On the left navigation pane, select Monitoring from theURL drop-down list.
5. Click API Reference > AP.

The following APIs allow you to retrieve the radio number for the total number of clients connected:
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API Description

[GET]/monitoring/v1/aps/
{serial}/neighbouring_clients

Allows you to filter data of neighbouring clients for a specific
radio number in a given time period.
When there is no radio number entered in the radio_number
field, the API filters the data of neighbouring clients for both
radio 0 and radio 1. It is mandatory to provide the serial
number of the AP to get the data of neighboring clients for a
specific radio number.

[GET]/monitoring/v1/aps/rf_
summary

Retrieves information on RF summary such as channel
utilization and noise floor in positive, errors, drops for a given
time period.
This API can also be used to filter RF health statistics for a
specific radio number in a given time period.
When there is no radio number entered in the radio_number
field, the API filters the RF health statistics for both radio 0 and
radio 1. It is mandatory to provide the serial number of the AP
to get the RF health statistics for a specific radio number.

[GET]/monitoring/v1/aps/bandwith_
usage

This API can also be used to filter out bandwidth usage data for
a specific radio number in a given time period.
When there is no radio number entered in the radio_number
field, the API filters the bandwidth usage for both radio 0 and
radio 1. It is mandatory to provide the serial number of the AP
to get the bandwidth usage for a specific radio number.

Table 86: APIs to Get Radio Number in APs

6. On the left navigation pane, click API Reference > Client.
The following APIs allow you to retrieve the radio number for the total number of clients connected:

API Description

[GET]/monitoring/v1/clients/count This API is used to filter out the data for connected clients for a
specific radio number of AP in a given time period.
When there is no radio number entered in the radio_number
field, the API filters the clients count for both radio 0 and radio 1.
It is mandatory to provide the serial number of the AP to get the
total count of clients for a specific radio number.

Table 87: APIs to Get Radio Number in Connected Clients

For further details on APIs, see https://app1-apigw.central.arubanetworks.com/swagger/central.

Support for Dual 5 GHz AP
Aruba Central supports automatic opmode selection for dual 5 GHz AP. When the opmode is set to
automatic, AirMatch determines whether to convert a radio in an AP to 5 GHz operation instead of the 2.4
GHz and 5 GHz dual band operation. Automatic is the default dual 5G mode where Airmatch detects what is
an optimal mode for the radios – dual band or dual 5G and updates the running opmode without requiring
an AP reboot between the mode changes.

Manual setting of dual band and dual 5G is possible and the manual setting overrides the automatic mode
and explicitly enables or disables the dual 5G mode. In this scenario, the AP immediately switches to the
specified mode without a reboot and AirMatch maintains the specified channel and power assignments in
the specified mode.

https://app1-apigw.central.arubanetworks.com/swagger/central
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Automatic mode is not supported on AP-344. By default, AP-344 assumes the automatic mode to be the same
as dual 5G disabled and operates in the dual band mode. To switch AP-344 to dual 5G mode, explicitly enable
the dual 5G mode.

The following procedure describes how to configure automatic opmode selection for dual 5 GHz AP:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP. The
dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure APs are displayed.
4. Click theAccess Points tab. TheAccess Points table is displayed.
5. To edit an AP, click the edit icon for that AP. The edit pane for modifying the Instant AP parameters is

displayed.
6. Click Radio. TheRadio page is displayed.
7. Set Dual 5G Mode to Automatic.
8. Optionally, specify the manual channel by setting Channel Assignment to Manual.
9. Optionally, specify the transmit power by setting Transmit Power Assignment to Manual.

Configuring Network Profiles on Instant APs
This section describes the following procedures:

n Configuring Wireless Network Profiles on Instant APs
n Configuring Wireless Networks for Guest Users on Instant APs
n Configuring Wired Port Profiles on Instant APs
n Editing a WLAN Profile
n Deleting a Network Profile

Configuring Wireless Network Profiles on Instant APs
You can configure up to 14 SSIDs. By enabling Extended SSID in the System > General accordion, you can
create up to 16 networks.

If more than 16 SSIDs are assigned to a zone and the extended zone option is disabled, an error message is
displayed.

This section describes the following topics:

n Creating a Wireless Network Profile
n Configuring VLAN Settings for Wireless Network
n Configuring Security Settings for Wireless Network
n Configuring ACLs for User Access to a Wireless Network
n Viewing Wireless SSID Summary

Creating a Wireless Network Profile
To configure WLAN settings, complete the following steps:
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1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWLANs tab, click + Add SSID.

TheCreate a New Network pane is displayed.

6. In General tab, enter a name that is used to identify the network in theName (SSID) text-box.
7. UnderAdvanced Settings, configure the following parameters:

Parameter Description

Broadcast/Multicast

Broadcast
filtering

Select any of the following values:
n All—The Instant AP drops all broadcast and multicast frames except DHCP and ARP,
IGMP group queries, and IPv6 neighbor discovery protocols.
n ARP—The Instant AP drops broadcast and multicast frames except DHCP and ARP,
IGMP group queries, and IPv6 neighbor discovery protocols. Additionally, it converts
ARP requests to unicast and sends frames directly to the associated clients. By default,
the Instant AP is configured to ARP mode.
n Unicast ARP Only—This option enables Instant AP to convert ARP requests to
unicast frames thereby sending them to the associated clients.
n Disabled—The Instant AP forwards all the broadcast and multicast traffic is
forwarded to the wireless interfaces.

DTIM Interval The DTIM Interval indicates the DTIM period in beacons, which can be configured for
every WLAN SSID profile. The DTIM interval determines how often the Instant AP delivers
the buffered broadcast and multicast frames to the associated clients in the power save
mode. Range is 1 to 10 beacons.
The default value is 1, which means the client checks for buffered data on the Instant AP at
every beacon. You can also configure a higher DTIM value for power saving.

Multicast
Transmission
Optimization

Select the check-box if you want the Instant AP to select the optimal rate for sending
broadcast and multicast frames based on the lowest of unicast rates across all associated
clients. When this option is enabled, multicast traffic can be sent up to a rate of 24 Mbps.
The default rate for sending frames for 2.4 GHz is 1 Mbps and that for 5 GHz is 6 Mbps.
This option is disabled by default.

Dynamic
Multicast
Optimization
(DMO)

Select the check-box to allow Instant AP to convert multicast streams into unicast streams
over the wireless link. Enabling DMO enhances the quality and reliability of streaming
video, while preserving the bandwidth available to the non-video clients.

NOTE: When you enable DMO on multicast SSID profiles, ensure that the DMO feature is
enabled on all SSIDs configured in the same VLAN.

Table 88: Advanced Settings Parameters
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Parameter Description

DMO channel
utilization
threshold

Specify a value to set a threshold for DMO channel utilization. With DMO, the Instant AP
converts multicast streams into unicast streams as long as the channel utilization does not
exceed this threshold. The default value is 90% and the maximum threshold value is 100%.
When the threshold is reached or exceeds the maximum value, the Instant AP sends
multicast traffic over the wireless link.

NOTE: This option will be enabled only when Dynamic Multicast Optimization is
enabled.

Transmit Rates (Legacy Only)

2.4 GHz If the 2.4 GHz band is configured on the Instant AP, specify the minimum and maximum
transmission rates. The default value for minimum transmission rate is 1 Mbps and
maximum transmission rate is 54 Mbps.

5 GHz If the 5 GHz band is configured on the Instant AP, specify the minimum and maximum
transmission rates. The default value for minimum transmission rate is 6 Mbps and
maximum transmission rate is 54 Mbps.

Zone

Zone Specify the zone for the SSID. If a zone is configured in the SSID, only the Instant AP in that
zone broadcasts this SSID. If there are no Instant APs in the zone, SSID is broadcast.
If the Instant AP cluster has devices running Aruba Instant firmware versions 6.5.4.7 or
later, and 8.3.0.0 or later, you can configure multiple AP zones by adding zone names as
comma separated values.

NOTE: Aruba recommends that you do not configure zones in both SSID and in the device
specific settings of an Instant AP. If the same zones are configured in SSID and Per AP
settings, APs may broadcast the SSIDs, but if the SSIDs and Per AP settings have different
zones configured, it may lead to a configuration error. For more information on AP zones,
see Aruba Instant User Guide.

Bandwidth Control

Airtime Select this to specify an aggregate amount of airtime that all clients in this network can use
for sending and receiving data. Specify the airtime percentage.

Downstream Enter the downstream rates within a range of 1 to 65,535 Kbps for the SSID users. If the
assignment is specific for each user, select the Per User check-box.

NOTE: The bandwidth limit set in this method is implemented at the device level and not
cluster level.

Upstream Enter the upstream rates within a range of 1 to 65,535 Kbps for the SSID users. If the
assignment is specific for each user, select the Per user check-box.

NOTE: The bandwidth limit set in this method is implemented at the device level and not
cluster level.

Each Radio Select this to specify an aggregate amount of throughput that each radio is allowed to
provide for the connected clients. The value ranges from 1 through 65535.
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Parameter Description

Enable 11n When this option is selected, there is no disabling of High-Throughput (HT) on 802.11n
devices for the 5 GHz radio band. If HT is enabled for the 5 GHz radio profile on an Instant
AP, it is automatically enabled for all SSIDs configured on an Instant AP. By default, HT is
enabled on all SSIDs.

NOTE: If you want the 802.11ac Instant APs to function as 802.11n Instant APs, clear this
check-box to disable VHT on these devices.

Enable 11ac When this option is selected, VHT is enabled on the 802.11ac devices for the 5 GHz radio
band. If VHT is enabled for the 5 GHz radio profile on an Instant AP, it is automatically
enabled for all SSIDs configured on an Instant AP. By default, VHT is enabled on all SSIDs.

NOTE: If you want the 802.11ac Instant APs to function as 802.11n Instant APs, clear this
check-box to disable VHT on these devices.

Enable 11ax When this option is selected, VHT is enabled on the 802.11ax devices. If VHT is enabled for
a radio profile on an Instant AP, it is automatically enabled for all SSIDs configured on an
Instant AP. By default, VHT is enabled on all SSIDs.

WiFi Multimedia

Background Wifi
Multimedia
Share

Allocates bandwidth for background traffic such as file downloads or print jobs. Specify the
appropriate DSCP mapping values within a range of 0–63 for the background traffic in the
corresponding DSCP mapping text-box. Enter up to 8 values with no white space and no
duplicate single DHCP mapping value.

Best Effort Wifi
Multimedia
Share

Allocates bandwidth or best effort traffic such as traffic from legacy devices or traffic from
applications or devices that do not support QoS. Specify the appropriate DSCP mapping
values within a range of 0–63 for the best effort traffic in the corresponding DSCP mapping
text-box.

Video Wifi
Multimedia
Share

Allocates bandwidth for video traffic generated from video streaming. Specify the
appropriate DSCP mapping values within a range of 0–63 for the video traffic in the
corresponding DSCP mapping text-box.

Voice Wifi
Multimedia
Share

Allocates bandwidth for voice traffic generated from the incoming and outgoing voice
communication. Specify the appropriate DSCP mapping values within a range of 0–63 for
the voice traffic in the corresponding DSCP mapping text-box.

NOTE: In a non-WMM or hybrid environment, where some clients are not WMM-capable,
you can allocate higher values for Best Effort Wifi Multimedia share and Voice Wifi
Multimedia Share to allocate a higher bandwidth to clients transmitting best effort and
voice traffic.

Traffic
Specification
(TSPEC)

Select this check-box to set if you want the TSPEC for the wireless network. The term TSPEC
is used in wireless networks supporting the IEEE 802.11e Quality of Service standard. It
defines a series of parameters, characteristics and Quality of Service expectations of a
traffic flow.

TSPEC
Bandwidth

Enter the bandwidth for the TSPEC.

Spectralink
Voice Protocol
(SVP)

Select this check-box to opt for SVP protocol.
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Parameter Description

WiFi Multimedia
Power Save (U-
APSD)

Select this check-box to enable WiFi Multimedia Power Save (U-APSD). The U-APSD is a
power saving mechanism that is an optional part of the IEEE amendment 802.11e, QoS.

Miscellaneous

Band Select a value to specify the band at which the network transmits radio signals in the Band
drop-down list. You can set the band to 2.4 GHz, 5 GHz, or All. The All option is selected by
default.

Content Filtering Select this check-box to route all DNS requests for the non-corporate domains to OpenDNS
on this network.

Primary Usage Based on the type of network profile, select one of the following options:
n Mixed Traffic—Select this option to create an employee or guest network profile.
The employee network is used by the employees in an organization and it supports
passphrase-based or 802.1X-based authentication methods. Employees can access the
protected data of an enterprise through the employee network after successful
authentication. The guest network is created for guests, visitors, contractors, and any
non-employee users who use the enterprise Wi-Fi network. The VC assigns the IP
address for the guest clients. Captive portal or passphrase-based authentication
methods can be set for this wireless network. Typically, a guest network is an
unencrypted network. However, you can specify the encryption settings when
configuring a guest network.
n Voice Only—Select this option to configure a network profile for devices that provide
only voice services such as handsets or applications that require voice traffic
prioritization.

NOTE: When a client is associated with the voice network, all data traffic is marked and
placed into the high priority queue in QoS.

Inactivity
timeout

Specify an interval for session timeout. If a client session is inactive for the specified
duration, the session expires and the users are required to log in again. You can specify a
value within the range of 60–3600 seconds. The default value is 1000 seconds.

Hide SSID Select this check-box if you do not want the SSID to be visible to users.

Disable Network Select this check-box if you want to disable the SSID. When selected, the SSID is disabled,
but is not removed from the network. By default, all SSIDs are enabled.

Max clients
threshold

Specify the maximum number of clients that can be configured for each BSSID on a WLAN.
You can specify a value within the range of 0–255. The default value is 64.

Local Probe
Request
Threshold

Specify a threshold value to limit the number of incoming probe requests. When a client
sends a broadcast probe request frame to search for all available SSIDs, this option
controls system response for this network profile and ignores probe requests if required.
You can specify a RSSI value within range of 0–100 dB.

Min RSSI for
auth request

Enter the minimum RSSI threshold for authentication requests.

Deauth inactive
clients

Select this option to allow the Instant AP to send a de-authentication frame to the inactive
client and the clear client entry.

Can be used
without uplink

Select this check-box if you do not want the SSID profile to use the uplink.
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Parameter Description

Deny inter user
bridging

Disables bridging traffic between two clients connected to the same SSID on the same
VLAN. When this option is enabled, the clients can connect to the Internet, but cannot
communicate with each other, and the bridging traffic between the clients is sent to the
upstream device to make the forwarding decision.

Enable SSID
when

Select an option from the drop-down list and specify the time period.

Disable SSID
when

Select an option from the drop-down list and specify the time period.

Deny Intra VLAN
Traffic

Disables intra VLAN traffic to enable the client isolation and disable all peer-to-peer
communication. Client isolation disables inter-client communication by allowing only client
to gateway traffic from clients to flow in the network. All other traffic from the client that is
not destined to the gateway or configured servers will not be forwarded by the Instant AP.
This feature enhances the security of the network and protects it from vulnerabilities. For
more information, see Configuring Client Isolation.

Management
Frame
Protection

Turn on the Management Frames Protection toggle switch to provide high network
security by maintaining data confidentiality of management frames. The Management
Frame Protection (MFP) establishes encryption keys between the client and Instant AP
using 802.11i framework. For more information, see Configuring Management Frames
Protection.

Fine Timing
Measurement
(802.11mc)
Responder Mode

Turn on the toggle switch to enable the fine timing measurement (802.11mc) responder
mode.

Time Range Profiles

Time Range
Profiles

Ensure that the NTP server connection is active.
Select a time range profile from the Time Range Profiles list and apply a status form the
drop-down list.
Click + New Time Range Profile to create a new time range profile. For more information,
see Configuring Time-Based Services for Wireless Network Profiles.

Configuring VLAN Settings for Wireless Network
To configure VLANs settings for an SSID, complete the following steps:

1. In theVLANs tab, select any of the following options for Client IP Assignment:
n Instant AP assigned—When selected, the client obtains the IP address from the VC.
n External DHCP server assigned—When selected, the client obtains the IP address from the

network.
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2. Based on the type of client IP assignment mode selected, configure the following parameters:

Parameter Description

Instant AP
assigned

When this option is selected, the client obtains the IP address from the virtual controller.
The virtual controller creates a private subnet and VLAN on the Instant AP for the wireless
clients. The network address translation for all client traffic that goes out of this interface
is carried out at the source. This setup eliminates the need for complex VLAN and IP
address management for a multi-site wireless network. For more information on DHCP
scopes and server configuration, see Configuring DHCP Pools and Client IP Assignment
Modes on Instant APs.
If this option is selected, specify any of the following options in Client VLAN Assignment:

n Internal VLAN—Assigns IP address to the client in the same subnet as the Instant
APs. By default, the client VLAN is assigned to the native VLAN on the wired network.
n Custom—Allows you to customize the client VLAN assignment to a specific VLAN, or
a range of VLANs. When this option is selected, select the scope from the VLAN ID
drop-down list.

External
DHCP
server
assigned

When this option is selected, specify any of the following options in Client VLAN
Assignment:

n Static—In VLAN ID, specify a VLAN ID for a single VLAN(s). If a large number of
clients need to be in the same subnet, you can select this option to configure VLAN
pooling. VLAN pooling allows random assignment of VLANs from a pool of VLANs to
each client connecting to the SSID.
To show or hide the Named VLANs, click Show Named VLANs.Click the Show
Named VLANs, to view the Named VLAN table. To add a new Named VLAN, complete
the following steps:
lClick +Add Named VLAN. The Add Named VLAN window is displayed.
lEnter the VLAN Name and VLAN details, and then click OK.

n Dynamic—Assigns the VLANs dynamically from a DHCP server. To add a new VLAN
assignment rule, complete the following steps:
lClick + Add Rule in the VLAN Assignment Rules window. The New VLAN
Assignment Rule page is displayed.
lEnter the Attribute,Operator, String, and VLAN details, and then click OK.

To delete a VLAN assignment rule, select a rule in the VLAN Assignment Rules
window, and then click the delete icon.
To show or hide the Named VLANs, click Show Named VLANs.Click the Show
Named VLANs, to view the Named VLAN table. To add a new Named VLAN, complete
the following steps:
lClick + Add Named VLAN. The Add Named VLAN window is displayed.
lEnter the VLAN Name and VLAN details, and then click OK.

To delete, select a Named VLAN in the Named VLAN table, and then click the delete icon.
n Native VLAN—Assigns the client VLAN is assigned to the native VLAN.

Table 89: VLANs Parameters

3. Click Next.

Configuring Security Settings for Wireless Network
To configure security settings for mixed traffic or voice network, complete the following steps:

1. In the Security tab, specify any one of the following options in the Security Level:
n Enterprise—On selecting Enterprise security level, the authentication options applicable to the

network are displayed.
n Personal—On selecting Personal security level, the authentication options applicable to the

personalized network are displayed.
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n Captive Portal—On selecting Captive Portal security level, the authentication options applicable
to the captive portal is displayed. For more information on captive portal, see Configuring Wireless
Networks for Guest Users on Instant APs.

n Open—On selectingOpen security level, the authentication options applicable to an open
network are displayed.

The default security setting for a network profile is Personal.

2. Based on the security level specified, configure the following basic parameters:

Data Pane
Item Description

Key
Management

For Enterprise security level, select an encryption key from Key Management drop-
down list:

n WPA-2 Enterprise—Select this option to use WPA-2 security. The WPA-2
Enterprise requires user authentication and requires the use of a RADIUS server
for authentication.
n WPA Enterprise—Select this option to use both WPA Enterprise.
n Both (WPA-2 & WPA)—Select this option to use both WPA-2 and WPA security.
n Dynamic- WEP with 802.1X—If you do not want to use a session key from the
RADIUS Server to derive pairwise unicast keys, turn on the Use Session Key for
LEAP toggle switch. This is required for old printers that use dynamic WEP through
LEAP authentication. The Use Session Key for LEAP feature is Disabled by
default.
n WPA-3 Enterprise(CNSA)—Select this option to use WPA-3 security employing
CNSA encryption.
n WPA-3 Enterprise(CCM 128)—Select this option to use WPA-3 security
employing CCM encryption operation mode limited to encrypting 128 bits of plain
text.
n WPA-3 Enterprise(GCM 256)—Select this option to use WPA-3 security
employing GCM encryption operation mode limited to encrypting 256 bits of plain
text.

When WPA-2 Enterprise and Both (WPA2-WPA) encryption types are selected and if
802.1x authentication method is configured, OKC is enabled by default. If OKC is
enabled, a cached PMK is used when the client roams to a new AP. This allows faster
roaming of clients without the need for a complete 802.1x authentication. OKC
roaming can be configured only for the Enterprise security level.

For Personal security level, select an encryption key from Key Management drop-
down list.
For WPA-2 Personal, WPA Personal, Both (WPA-2&WPA), and WPA-3 Personal
keys, specify the following parameters:

n Passphrase Format—Select a passphrase format. The options available are 8-
63 alphanumeric characters and 64 hexadecimal characters.
n Passphrase—Enter a passphrase in
n Retype—Retype the passphrase to confirm.

For Static WEP, specify the following parameters:
n WEP Key Size—Select an appropriate value for WEP key size from the drop-
down list. Select an appropriate value from the Tx Key drop-down list.
n WEP Key—Enter an appropriate WEP key.
n Retype WEP Key—Retype the WEP key to confirm.

For MPSK-AES, select a primary server from the drop-down list.
For MPSK-LOCAL, select a Mpsk Local server from the drop-down list.

Table 90: Basic WLAN Security Parameters



Aruba Central | User Guide 294

Data Pane
Item Description

For Captive Portal security level, select an encryption key from Key Management.
For WPA-2 Personal, WPA Personal, Both (WPA-2&WPA), and WPA-3 Personal
keys, specify the following parameters:
Passphrase Format—Select a passphrase format. The options available are 8-63
alphanumeric characters and 64 hexadecimal characters.

n Passphrase—Enter a passphrase in
n Retype—Retype the passphrase to confirm.

For Static WEP, specify the following parameters:
n WEP Key Size—Select an appropriate value for WEP key size from the drop-
down list. Select an appropriate value from the Tx Key drop-down list.
n WEP Key—Enter an appropriate WEP key.
n Retype WEP Key—Retype the WEP key to confirm.

For information on configuring captive portal, see Configuring Wireless Networks for
Guest Users on Instant APs on page 299.

For Open security level, the Key Management includes Open and Enhanced Open
options.

EAP offload This option is applicable to Enterprise security levels only. To terminate the EAP
portion of 802.1X authentication on the Instant AP instead of the RADIUS server, turn
on the EAP offload toggle switch. Enabling EAP offload can reduce network traffic to
the external RADIUS server by terminating the authorization protocol on the Instant
AP. By default, for 802.1X authorization, the client conducts an EAP exchange with the
RADIUS server, and the Instant AP acts as a relay for this exchange. When EAP Offload
is enabled, the Instant AP by itself acts as an authentication server and terminates the
outer layers of the EAP protocol, only relaying the innermost layer to the external
RADIUS server. It can also reduce the number of exchange packets between the
Instant AP and the authentication server.
Instant supports the configuration of primary and backup authentication servers in an
EAP termination-enabled SSID.
If you are using LDAP for authentication, ensure that Instant AP termination is
configured to support EAP.

Authentication
Server

Configure the following parameters:
MAC Authentication—Turn on the MAC Authentication toggle switch to allow MAC
address based authentication for Personal, Captive Portal, and Open security levels.
Primary Server—Set a primary authentication server. The Primary Server option
appears only for Enterprise security level, internal and external captive portal types.
Select one of the following options from the drop-down list:
Internal Server—To use an internal server, select Internal Server and add the
clients that are required to authenticate with the internal RADIUS Server. Click Users
to add the users.
To add a new server, click +. For information on configuring external servers, see
Configuring External Authentication Servers for APs.
Aruba Central allows you to configure an external RADIUS server, TACACS or LDAP
server, and External Captive Portal for user authentication.
Secondary Server—To add another server for authentication, configure another
authentication server.
Authentication Survivability—If an external server is configured for authentication,
you can enable authentication survivability. Specify a value in hours for Cache
Timeout to set the duration after which the authenticated credentials in the cache
expires. When the cache expires, the clients are required to authenticate again. You
can specify a value within range of 1 to 99 hours. By default, authentication
survivability is disabled.
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Data Pane
Item Description

Load Balancing—Turn on the toggle switch to enable, if you are using two RADIUS
authentication servers, to balance the load across these servers. For more
information on the dynamic load balancing mechanism, see Configuring External
Authentication Servers for APs.

Users Click Users to add the users. The registered users of Employee type will be able to
access the users of Enterprise network. To add a new user, click + Add User and
enter the new user in the Add Userpane. The Primary Server option appears only for
Enterprise security level, Internal Captive Portal, and External Captive Portal.

3. Based on the security level specified, specify the following parameters in theAdvanced Settings
section:

Data pane
item Description

Use Session
Key for LEAP

Turn on the toggle switch to use the session key for Lightweight Extensible
Authentication Protocol. This option is available only for Enterprise level.

Opportunistic
Key Caching
(OKC)

Turn on the Opportunistic key caching (OKC) toggle switch to reduce the time
needed for authentication. When OKC is used, multiple APs can share Pairwise Master
Keys (PMKs) among themselves, and the station can roam to a new access points that
has not visited before and reuse a PMK that was established with the current AP. OKC
allows the station to roam quickly to an access point it has never authenticated to,
without having to perform pre-authentication. OKC is available specifically on WPA2
SSIDs only.

MAC
Authentication
for Enterprise
Networks

To enable MAC address based authentication for Personal and Open security levels,
turn on the toggle switch to enable MAC Authentication. For Enterprise security
level, the following options are available:

n Perform MAC authentication before 802.1X—Select this to use 802.1X
authentication only when the MAC authentication is successful.
n MAC Authentication Fail-Through—On selecting this, the 802.1X
authentication is attempted when the MAC authentication fails.

If MAC Authentication is enabled, configure the following parameters:
n Delimiter Character—Specify a character (for example, colon or dash) as a
delimiter for the MAC address string. When configured, the Instant AP uses the
delimiter in the MAC authentication request. For example, if you specify the colon
as a delimiter, MAC addresses in the xx:xx:xx:xx:xx:xx format are used. If the
delimiter is not specified, the MAC address in the xxxxxxxxxxxx format is used. This
option is available only when MAC authentication is enabled.
n Uppercase Support—Turn on the toggle switch to allow the Instant AP to use
uppercase letters in MAC address string for MAC authentication. This option is
available only if MAC authentication is enabled.

Reauth
Interval

Specify a value for Reauth Interval. When set to a value greater than zero, APs
periodically re-authenticate all associated and authenticated clients.
If the re-authentication interval is configured:

n On an SSID performing L2 authentication (MAC or 802.1X authentication): When
re-authentication fails, the clients are disconnected. If the SSID is performing only
MAC authentication and has a pre-authentication role assigned to the client, the
client will get a post-authentication role only after a successful re-authentication. If

Table 91: Advanced WLAN Security Parameters
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Data pane
item Description

re-authentication fails, the client retains the pre-authentication role.
n On an SSID performing both L2 and L3 authentication (MAC with captive portal
authentication): When re-authentication succeeds, the client retains the role that is
already assigned. If re-authentication fails, a pre-authentication role is assigned to
the client.
n On an SSID performing only L3 authentication (captive portal authentication):
When re-authentication succeeds, a pre-authentication role is assigned to the
client that is in a post-authentication role. Due to this, the clients are required to go
through captive portal to regain access.

Blacklisting By default, this option is disabled. To enable blacklisting of the clients with a specific
number of authentication failures, select Blacklisting and specify a value for Max
Authentication Failures. The users who fail to authenticate the number of times
specified in Max Authentication Failures field are dynamically blacklisted. By
default, the Blacklisting option is disabled.

Enforce DHCP Enforces WLAN SSID on Instant AP clients. When DHCP is enforced:
n A layer-2 user entry is created when a client associates with an Instant AP.
n The client DHCP state and IP address are tracked.
n When the client obtains an IP address from DHCP, the DHCP state changes to
complete.
n If the DHCP state is complete, a layer-3 user entry is created.
n When a client roams between the Instant APs, the DHCP state and the client IP
address is synchronized with the new Instant AP.

WPA3
Transition

Enable this option to allow transition from WPA3 to WPA2 and vice versa. The WPA3
Transition appears only when WPA3 is selected in the Key Management for
Personal, Captive Portal, and Open level.

Legacy
Support

Enable this option to allow backward compatibility of encryption modes in networks.
The Legacy Support appears only when WPA3 is selected in the Key Management
for Personal, Captive Portal, and Open level.

Use IP for
Calling Station
ID

Enable this option to configure client IP address as calling station ID. When this option
is enabled, the following options are displayed:

n Called Station ID Type—Select any of the following options for configuring
called station ID:
lAccess Point Group—Uses the VC ID as the called station ID.
lAccess Point Name—Uses the host name of the Instant AP as the called station
ID.
lVLAN ID—Uses the VLAN ID of as the called station ID.
lIP Address—Uses the IP address of the Instant AP as the called station ID.
lMAC address—Uses the MAC address of the Instant AP as the called station ID.

n Called Station ID Include SSID—Appends the SSID name to the called station
ID.

NOTE: The Called Station ID Type detail can be configured even if the Use IP for
Calling Station ID is set to disabled.

n Called Station ID Delimiter—Sets delimiter at the end of the called station ID.
n Max Authentication Failures—Sets a value for the maximum allowed
authentication failures.
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Data pane
item Description

Delimiter
Character

Specify a character (for example, colon or dash) as a delimiter for the MAC address
string. When configured, the Instant AP uses the delimiter in the MAC authentication
request. For example, if you specify the colon as a delimiter, MAC addresses in the
xx:xx:xx:xx:xx:xx format are used. If the delimiter is not specified, the MAC address in
the xxxxxxxxxxxx format is used. This option is available only when MAC
authentication is enabled.

Uppercase
Support

Select this option to allow the Instant AP to use uppercase letters in MAC address
string for MAC authentication. This option is available only if MAC authentication is
enabled.

Fast Roaming Enable the following fast roaming features as per your requirement:
n 802.11k—Turn on the 802.11k toggle switch to enable 802.11k roaming. The
802.11k protocol enables Instant APs and clients to dynamically measure the
available radio resources. When 802.11k is enabled, Instant APs and clients send
neighbor reports, beacon reports, and link measurement reports to each other.
n 802.11v—Turn on the 802.11v toggle switch to enable 802.11v based BSS
transition. The 802.11v standard defines mechanisms for wireless network
management enhancements and BSS transition management. It allows the client
devices to exchange information about the network topology and RF environment.
The BSS transition management mechanism enables an AP to request a voice
client to transition to a specific AP, or suggest a set of preferred APs to a voice
client, due to network load balancing or BSS termination. It also helps the voice
client identify the best AP to transition to as they roam.

4. Click Next.

Configuring ACLs for User Access to a Wireless Network
You can configure up to 64 access rules for a wireless network profile. To configure access rules for a
network, complete the following steps:

1. In theAccess tab, turn on theDownloadable Role toggle switch to allow downloading of pre-
existing user roles. For more information, see Configuring Downloadable Roles.

The Downloadable Role feature is optional.
The Downloadable Role feature is available only for networks that include APs that run a minimum of
Aruba Instant 8.4.0.0 firmware version with a minimum of ClearPass server version 6.7.8.
At least one radius server must be configured to apply the Downloadable Role feature. For more
information on configuring radius server, see Authentication Servers for Instant APs

2. Click the action corresponding to the server. The Edit Server page is displayed.

Viewing Wireless SSID Summary
In the Summary tab, theNetwork Summary page displays all the settings configured in theGeneral,
VLANs, Security, and Access tabs.

Click Save Settings to complete the network profile creation and save the settings.

Configuring Management Frames Protection
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Aruba Central supports the Management Frame Protection (MFP) feature in networks that include Aruba
Instant 8.5.0.0 firmware version and later. This feature protects networks against forged management
frames spoofed from other devices that might otherwise disrupt a valid user session.

The MFP increases the security by providing data confidentiality of management frames. MFP uses 802.11i
framework that establishes encryption keys between the client and Instant AP.

Enabling Management Frames Protection for Wireless Networks in
Aruba Central
To enable the MFP feature, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWLANspage, click + Add SSID. To modify an existing SSID, select a wireless SSID from the
Wireless SSIDs table and then click the edit icon.

6. In theGeneral tab, click Advanced Settings.
7. Expand Miscellaneous.
8. Turn on theManagement Frames Protection toggle switch to enable the MFP feature.
9. Click Next.

10. Click Save Settings.

The MFP configuration is a per-SSID configuration. The MFP feature can be enabled only on WPA2-PSK and
WPA2-Enterprise SSIDs. The 802.11r fast roaming option will not take effect when the MFP is enabled.

Configuring Client Isolation
Aruba Central supports theClient Isolation feature isolates clients from one another and disables all peer-
to-peer communication within the network. Client isolation disables inter-client communication by allowing
only client to gateway traffic from clients to flow in the network. All other traffic from the client that is not
destined to the gateway or configured servers will not be forwarded by the Instant AP.

This feature enhances the security of the network and protects it from vulnerabilities. Client Isolation can
only be configured through the CLI. When Client Isolation is configured, the Instant AP learns the IP,
subnet mask, MAC, and other essential information of the gateway and the DNS server. A subnet table of
trusted destinations is then populated with this information. Wired servers used in the network should be
manually configured into this subnet table to serve clients. The destination MAC of data packets sent by the
client is validated against this subnet table and only the data packets destined to the trusted addresses in
the subnet table are forwarded by the Instant AP. All other data packets are dropped.

Client Isolation feature is supported only in IPv4 networks. This feature does not support AirGroup and affects
Chromecast and Airplay services.
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Enabling Client Isolation for Wireless Networks in Aruba Central
To enable the Client Isolation feature, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWLANs page, click + Add SSID.

TheCreate a New Network page is displayed.

6. Click Advanced Settings and expand Miscellaneous.
7. Turn on theDeny Intra VLAN Traffic toggle switch.
8. Click Next.

Configuring Wireless Networks for Guest Users on Instant
APs
Instant APs support the captive portal authentication method in which a webpage is presented to the guest
users, when they try to access the Internet in hotels, conference centers, or Wi-Fi hotspots. The webpage
also prompts the guest users to authenticate or accept the usage policy and terms. Captive portals are used
at Wi-Fi hotspots and can be used to control wired access as well.

The captive portal solution for an Instant AP cluster consists of the following:

n The captive portal web login page hosted by an internal or external server.
n The RADIUS authentication or user authentication against internal database of the AP.
n The SSID broadcast by the Instant AP.

The Instant AP administrators can create a wired or WLAN guest network based on captive portal
authentication for guests, visitors, contractors, and any non-employee users who can use the enterprise Wi-
Fi network. Administrators can also create guest accounts and customize the captive portal page with
organization-specific logo, terms, and usage policy. With captive portal authentication and guest profiles,
the devices associating with the guest SSID are assigned an initial role and are assigned IP addresses. When a
guest user tries to access a URL through HTTP or HTTPS, the captive portal webpage prompts the user to
authenticate with a user name and password.

Splash Page Profiles
Instant APs support the following types of splash page profiles:

n Internal Captive portal—Select this splash page to use an internal server for hosting the captive portal
service. Internal captive portal supports the following types of authentication:

l Internal Authenticated—When Internal Authenticated is enabled, a guest user who is pre-provisioned
in the user database has to provide the authentication details.
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l Internal Acknowledged—When Internal Acknowledged is enabled, a guest user has to accept the terms
and conditions to access the Internet.
n External Captive portal—Select this splash page to use an external portal on the cloud or on a server

outside the enterprise network for authentication.
n Cloud Guest—Select this splash page to use the cloud guest profile configured through theGuest

Management tab.
n None—Select to disable the captive portal authentication.

To create splash page profiles, see the following sections:

n Creating a Wireless Network Profile for Guest Users
n Configuring an Internal Captive Portal Splash Page Profile
n Configuring an External Captive Portal Splash Page Profile
n Configuring a Cloud Guest Splash Page Profile
n Configuring a Cloud Guest Splash Page Profile
n Configuring ACLs for Guest User Access
n Configuring Captive Portal Roles for an SSID
n Disabling Captive Portal Authentication

Creating a Wireless Network Profile for Guest Users
To create an SSID for guest users, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWLANs page, click + Add SSID.

TheCreate a New Network pane is displayed.

6. UnderGeneral, enter a network name in theName (SSID) text-box.
7. If configuring a wireless guest profile, set the required WLAN configuration parameters described in

Table 1.
8. Click Next.

The VLANs details are displayed.

9. UnderVLANs, select any of the following options for Client IP Assignment:
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Parameter Description

Instant AP assigned When this option is selected, the client obtains the IP address from the
virtual controller. The virtual controller creates a private subnet and VLAN
on the Instant AP for the wireless clients. The network address translation
for all client traffic that goes out of this interface is carried out at the
source. This setup eliminates the need for complex VLAN and IP address
management for a multi-site wireless network. For more information on
DHCP scopes and server configuration, see Configuring DHCP Pools and
Client IP Assignment Modes on Instant APs.
If this option is selected, specify any of the following options in Client
VLAN Assignment:

n Internal VLAN—Assigns IP address to the client in the same subnet
as the Instant APs. By default, the client VLAN is assigned to the native
VLAN on the wired network.
n Custom—Allows you to customize the client VLAN assignment to a
specific VLAN, or a range of VLANs. When this option is selected, select
the scope from the VLAN ID drop-down list.

External DHCP server assigned When this option is selected, specify any of the following options in Client
VLAN Assignment:

n Static—In VLAN ID, specify a VLAN ID for a single VLAN(s). If a
large number of clients need to be in the same subnet, you can select
this option to configure VLAN pooling. VLAN pooling allows random
assignment of VLANs from a pool of VLANs to each client connecting
to the SSID.
To show or hide the Named VLANs, click Show Named VLANs.Click
the Show Named VLANs, to view the Named VLAN table. To add a
new Named VLAN, complete the following steps:
lClick +Add Named VLAN. The Add Named VLAN window is
displayed.
lEnter the VLAN Name and VLAN details, and then click OK.

n Dynamic—Assigns the VLANs dynamically from a DHCP server. To
add a new VLAN assignment rule, complete the following steps:
lClick + Add Rule in the VLAN Assignment Rules window. The
New VLAN Assignment Rule page is displayed.
lEnter the Attribute,Operator, String, and VLAN details, and then
click OK.

To delete a VLAN assignment rule, select a rule in the VLAN
Assignment Rules window, and then click the delete icon.
To show or hide the Named VLANs, click Show Named VLANs.Click
the Show Named VLANs, to view the Named VLAN table. To add a
new Named VLAN, complete the following steps:
lClick +Add Named VLAN. The Add Named VLAN window is
displayed.
lEnter the VLAN Name and VLAN details, and then click OK.

To delete, select a Named VLAN in the Named VLAN table, and then click
the delete icon.

n Native VLAN—Assigns the client VLAN is assigned to the native
VLAN.

For more information, see Configuring VLAN Assignment Rule.

Table 92: VLANs Assignment

Configuring an Internal Captive Portal Splash Page Profile
To configure an internal captive portal profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.
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2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select a guest SSID, and then click the edit icon.
6. Under Security tab, in the Security Level, select Captive Portal and configure the following

parameters:

Parameter Description

Captive Portal Type Select Internal from the drop-down list.

Captive Portal Location Select Acknowledged or Authenticated from the drop-down list.

Customize Captive Portal Under Splash Page, when Customize Captive Portal is clicked, use the
editor to specify text and colors for the initial page that is displayed to the
users connecting to the network. The initial page asks for user credentials
or email, depending on the splash page type (Authenticated or
Acknowledged) for which you are customizing the splash page design.
Complete the following steps to customize the splash page design.

n Top banner title—Enter a title for the banner.
n Header fill color—Specify a background color for the header.
n Welcome text—To change the welcome text, click the first square
box in the splash page, enter the required text in the Welcome text
box, and click OK. Ensure that the welcome text does not exceed 127
characters.
n Policy text—To change the policy text, click the second square in
the splash page, enter the required text in the Policy text box, and
click OK. Ensure that the policy text does not exceed 255 characters.
n Page fill color—To change the color of the splash page, click the
Splash page rectangle and select the required color from the color
palette.
n Redirect URL—To redirect users to another URL, specify a URL in
Redirect URL.
n Logo image—To upload a custom logo, click Choose Fileto upload.
Ensure that the image file size does not exceed 16 KB. To delete an
image, click Delete Logo.

To preview the captive portal page, click preview_splash_page.
To configure a captive portal proxy server or global proxy server to match
your browser configuration, enter the IP address and port number in the
Captive-portal proxy server IP and Captive Portal Proxy Server Port
fields.

Encryption By default, this field is disabled. Turn on the toggle switch to enable and
configure the following encryption parameters:

n Key Management—Specify an encryption and authentication key.
n Passphrase format—Specify a passphrase format.
n Passphrase—Enter a passphrase.
n Retype—Retype the passphrase to confirm.

Key Management Select Open or Enhanced Open from the drop-down list.

Table 93: Internal Captive Portal Configuration Parameters
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Parameter Description

Advanced Settings

Captive Portal Proxy
Server IP

Specify the IP address of the Captive Portal proxy server.

Captive Portal Proxy
Server Port

Specify the port number of the Captive Portal proxy server.

MAC Authentication Configure the following parameters:
n MAC Authentication—To enable MAC address based
authentication for Personal and Open security levels, turn on the MAC
Authentication toggle switch.
lTo use an internal server, select Internal Server and add the
clients that are required to authenticate with the internal RADIUS
Server. Click Users to add the users.
lTo add a new server, click +. For information on configuring external
servers, see Configuring External Authentication Servers for APs on
page 356.

n Secondary Server—To add another server for authentication,
configure another authentication server.
n Load Balancing—Turn on the toggle switch to enable, if you are
using two RADIUS authentication servers, to balance the load across
these servers. For more information on the dynamic load balancing
mechanism, see Configuring DHCP Server for Assigning IP Addresses
to Instant AP Clients.

Reauth Interval Specify a value for Reauth Interval. When set to a value greater than
zero, APs periodically re-authenticate all associated and authenticated
clients.

Accounting Select an accounting mode for posting accounting information at the
specified Accounting interval. When the accounting mode is set to
Authentication, the accounting starts only after client authentication is
successful and stops when the client logs out of the network. If the
accounting mode is set to Association, the accounting starts when the
client associates to the network successfully and stops when the client
disconnects. This is applicable for WLAN SSIDs only.

Blacklisting If you are configuring a wireless network profile, turn on the Blacklisting
toggle switch to blacklist clients with a specific number of authentication
failures. This is applicable for WLAN SSIDs only.

Max Authentication
Failures

If you are configuring a wireless network profile, turn on the Blacklisting
toggle switch to blacklist clients with a specific number of authentication
failures. This is applicable for WLAN SSIDs only.

Enforce DHCP If you are configuring a wireless network profile, turn on the Blacklisting
toggle switch to blacklist clients with a specific number of authentication
failures. This is applicable for WLAN SSIDs only.

WPA3 Transition If you are configuring a wireless network profile, turn on the Blacklisting
toggle switch to blacklist clients with a specific number of authentication
failures. This is applicable for WLAN SSIDs only.

Table 93: Internal Captive Portal Configuration Parameters
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Parameter Description

Called Station ID Include
SSID

If you are configuring a wireless network profile, turn on the Blacklisting
toggle switch to blacklist clients with a specific number of authentication
failures. This is applicable for WLAN SSIDs only.

Uppercase Support If you are configuring a wireless network profile, turn on the Blacklisting
toggle switch to blacklist clients with a specific number of authentication
failures. This is applicable for WLAN SSIDs only.

Disable if uplink type is To exclude uplink(s), expand Disable if uplink type is, and turn on the
toggle switch for the uplink type(s). For example, Ethernet, Wi-Fi, and
3G/4G.

Table 93: Internal Captive Portal Configuration Parameters

7. Click Save Settings.

Configuring an External Captive Portal Splash Page Profile
You can configure external captive portal profiles and associate these profiles to a user role or SSID. You can
create a set of captive portal profiles and associate these profiles with an SSID or a wired profile. You can
configure up to eight external captive portal profiles.

When the captive portal profile is associated to an SSID, it is used before user authentication. If the profile is
associated to a role, it is used only after the user authentication. When a captive portal profile is applied to
an SSID or wired profile, the users connecting to the SSID or wired network are assigned a role with the
captive portal rule. The guest user role allows only DNS and DHCP traffic between the client and network,
and directs all HTTP or HTTPS requests to the captive portal unless explicitly permitted.

To configure an external captive portal profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select a guest SSID, and then click the edit icon.
6. Under Security tab, in the Security Level, select Captive Portal.
7. Select the Splash Page type as External.
8. If required, configure a captive portal proxy server or a global proxy server to match your browser

configuration by specifying the IP address and port number in theCaptive Portal Proxy Server IP
and Captive Portal Proxy Server Port fields.
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9. Select a captive portal profile. To add a new profile, click + and configure the following parameters:

Data Pane Item Description

Name Enter a name for the profile.

Type Select any one of the following types of authentication:
n Radius Authentication—Select this option to enable user authentication
against a RADIUS server.
n Authentication Text—Select this option to specify an authentication text.
The specified text will be returned by the external server after a successful
user authentication.

IP or Hostname Enter the IP address or the host name of the external splash page server.

URL Enter the URL of the external captive portal server.

Port Enter the port number that is used for communicating with the external captive
portal server.

Use HTTPS Select this to enforce clients to use HTTPS to communicate with the captive portal
server. This option is available only if RADIUS Authentication is selected.

Captive Portal
Failure

This field allows you to configure Internet access for the guest users when the
external captive portal server is not available. Select Deny Internet to prevent
guest users from using the network, or Allow Internet to access the network.

Server Offload Select the check box to enable the server offload feature. The server offload
feature ensures that the non-browser client applications are not unnecessarily
redirected to the external captive portal server, thereby reducing the load on the
external captive portal server.

Prevent Frame
Overlay

Select this check box to prevent the overlay of frames. When enabled, the frames
display only those pages that are in the same domain as the main page.

Automatic URL
Whitelisting

On enabling this for the external captive portal authentication, the URLs that are
allowed for the unauthenticated users to access are automatically whitelisted.

Auth Text If the External Authentication splash page is selected, specify the
authentication text that is returned by the external server after successful
authentication. This option is available only if Authentication Text is selected.

Redirect URL Specify a redirect URL if you want to redirect the users to another URL.

Table 94: External Captive Portal Profile Configuration Parameters

10. Click Save.
11. On the external captive portal splash page configuration page, specify encryption settings if required.
12. Specify the following authentication parameters underAdvanced Settings:

n MAC Authentication—To enable MAC address based authentication for Personal and Open
security levels, turn on theMAC Authentication toggle switch.

n Primary Server—Sets a primary authentication server.

l To use an internal server, select Internal server and add the clients that are required to authenticate
with the internal RADIUS Server. Click Users to add the users.

l To add a new server, click +. For information on configuring external servers, see Configuring External
Authentication Servers for APs.
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n Secondary Server—To add another server for authentication, configure another authentication
server.

n Load Balancing—Turn on the toggle switch to enable, if you are using two RADIUS
authentication servers, to balance the load across these servers.

13. If required, underWalled Garden, create a list of domains that are blacklisted and also a white list of
websites that the users connected to this splash page profile can access.

14. To exclude uplink, select an uplink type.
15. If MAC authentication is enabled, you can configure the following parameters:

n Delimiter Character—Specify a character (for example, colon or dash) as a delimiter for the MAC
address string. When configured, the Instant AP uses the delimiter in the MAC authentication
request. For example, if you specify the colon as a delimiter, MAC addresses in the
xx:xx:xx:xx:xx:xx format are used. If the delimiter is not specified, the MAC address in the
xxxxxxxxxxxx format is used. This option is available only when MAC authentication is enabled.

n Uppercase Support—Turn on the toggle switch to enable to allow the Instant AP to use
uppercase letters in MAC address string for MAC authentication. This option is available only if
MAC authentication is enabled.

16. Configure theReauth Interval. Specify a value forReauth Interval. When set to a value greater
than zero, Instant APs periodically re-authenticate all associated and authenticated clients.

17. If required, enable blacklisting. Set a threshold for blacklisting clients based on the number of failed
authentication attempts.

18. Click Save Settings.

Configuring a Cloud Guest Splash Page Profile
To create a cloud guest network profile, see Configuring a Cloud Guest Splash Page Profile

Associating a Cloud Guest Splash Page Profile to a Guest SSID
To use the Cloud Guest splash page profile for the guest SSID, ensure that the Cloud Guest splash Page
profile is configured through theGuest Access app.

To associate a Cloud Guest splash page profile to a guest SSID, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. UnderWLANs tab, in theWireless SSIDs table, select a guest SSID and click the edit icon.
6. Click the Security tab.

a. Under Splash Page, select Cloud Guest from theCaptive Portal Type drop-down list.

b. Select the splash page profile name from theGuest Captive Portal Profile list, and then click
Next.
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c. To enable encryption, turn on the Encryption toggle switch and configure the following
encryption parameters:

d. Key Management—Specify an encryption and authentication key.

e. Passphrase format—Specify a passphrase format.

f. Passphrase—Enter a passphrase.

g. Retype—Retype the passphrase to confirm.

h. To exclude uplink, expand Disable if uplink type is and select an uplink type. For example,
Ethernet,Wi-Fi, and 3G/4G.

i. Click Next.

7. Click Save Settings.

Configuring ACLs for Guest User Access
To configure access rules for a guest network, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. UnderWLANs tab, in theWireless SSIDs table, select a guest SSID and click the edit icon.
6. Click theAccess tab.
7. UnderAccess rules, select any of the following types of access control:

n Unrestricted—Select this to set unrestricted access to the network.
n Network Based—Select Network Based to set common rules for all users in a network. By

default,Allow any to all destinations access rule is enabled. This rule allows traffic to all
destinations. To define an access rule, complete the following steps:

n Click + and select appropriate options forRule Type, Service,Action,Destination, and
Options fields.

n Click Save.
n Role Based—Select Role Based to enable access based on user roles.

For role-based access control, complete the following steps:

1. To create a user role:

a. Click + Add Role in Role pane.

b. Enter a name for the new role and click OK.
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2. To create access rules for a specific user role:

a. Click + Add Rule in Access Rules for Selected Roles, and select appropriate options forRule
Type, Service,Action,Destination, and Options fields.

b. Click Save.

3. To create a role assignment rule:

a. UnderRole Assignment Rules, click + Add Role Assignment. TheNew Role Assignment
Rule pane is displayed.

b. Select appropriate options in Attribute,Operator, String, and Role fields.

c. Click Save.

4. To assign pre-authentication role, select theAssign Pre-Authentication Role check-box and select
a pre-authentication role from the drop-down list.

5. Click Save Settings.

Configuring Captive Portal Roles for an SSID
You can configure an access rule to enforce captive portal authentication for SSIDs with 802.1X
authentication enabled. You can configure rules to provide access to an external captive portal, internal
captive portal, so that some of the clients using this SSID can derive the captive portal role.

The following conditions apply to the 802.1X and captive portal authentication configuration:

n If captive portal settings are not configured for a user role, the captive portal settings configured for an
SSID are applied to the client's profile.

n If captive portal settings are not configured for a SSID, the captive portal settings configured for a user
role are applied to the client's profile.

n If captive portal settings are configured for both SSID and user role, the captive portal settings
configured for a user role are applied to the profile of the client.

To create a captive portal role for the Internal and External splash page types:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. UnderWLANs tab, in theWireless SSIDs table, select a guest SSID and click the edit icon.
6. Click theAccess tab.
7. UnderAccess rules, select Role Based.
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8. Click + Add Rule in Access Rules for Selected Roles.
9. In theAdd Rules window, specify the following parameters.

Data
Pane
Item

Description

Rule
Type

Select Captive Portal from the drop-down list.

Splash
Page
Type

Select a splash page type from the drop-down list.

Internal If Internal is selected as Splash Page Type drop-down list, complete the following steps:
n Top banner title—Enter a title for the banner. To preview the page with the new
banner title, click Preview splash page.
n Header fill color—Specify a background color for the header.
n Welcome text—To change the welcome text, click the first square box in the splash
page, enter the required text in the Welcome text box, and click OK. Ensure that the
welcome text does not exceed 127 characters.
n Policy text—To change the policy text, click the second square in the splash page,
enter the required text in the Policy text box, and click OK. Ensure that the policy text
does not exceed 255 characters.
n Page fill color—To change the color of the splash page, click the Splash page
rectangle and select the required color from the color palette.
n Redirect URL—To redirect users to another URL, specify a URL in Redirect URL.
n Logo image—To upload a custom logo, click Choose Fileto upload. Ensure that the
image file size does not exceed 16 KB. To delete an image, click Delete Logo.

To preview the captive portal page, click preview_splash_page.

External If External is selected as Splash Page Type drop-down list, complete the following steps:
n Captive Portal Profile—Select a profile from the drop-down list.

To create a profile, click the + icon and enter the following information in the External
Captive Portal window.

n Name
n Authentication Type—From the drop-down list, select either RADIUS Authentication
(to enable user authentication against a RADIUS server) or Authentication Text (to
specify the authentication text to returned by the external server after a successful user
authentication).
n IP OR Hostname—Enter the IP address or the hostname of the external splash page
server.
n URL—Enter the URL for the external splash page server.
n Port—Enter the port number for communicating with the external splash page server.
n Captive Portal Failure—This field allows you to configure Internet access for the
guest clients when the external captive portal server is not available. From the drop-down
list, select Deny Internet to prevent clients from using the network, or Allow Internet to
allow the guest clients to access Internet when the external captive portal server is not
available.
n Automatic URL Whitelisting—Turn on the toggle switch to enable or disable
automatic whitelisting of URLs. On selecting this for the external captive portal
authentication, the URLs allowed for the unauthenticated users to access are
automatically whitelisted. The automatic URL whitelisting is disabled by default.
n Server offload—Turn on the toggle switch to offload the server.
n Prevent Frame Overlay—Turn on the toggle switch to prevent frame overlay.
n Use VC IP in Redirect URL—Turn on the toggle switch to use the virtual controller IP

Table 95: Access Rule Configuration Parameters
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Data
Pane
Item

Description

address as a redirect URL.
n Auth TEXT—Indicates the authentication text returned by the external server after a
successful user authentication.
n Redirect URL—Specify a redirect URL to redirect the users to another URL.

To edit a profile, click the edit icon and modify the parameters in the External Captive
Portal window.

Table 95: Access Rule Configuration Parameters

10. Click Save. The enforce captive portal rule is created and listed as an access rule.
11. Click Save Settings.

The client can connect to this SSID after authenticating with user name and password. After the user logs in
successfully, the captive portal role is assigned to the client.

Disabling Captive Portal Authentication
To disable captive portal authentication, perform the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select a guest SSID, and then click the edit icon.
6. Under Security tab, in the Security Level, select Captive Portal.
7. Under Splash Page, select None from theCaptive Portal Type drop-down list.
8. Click Save Settings.

Configuring Wired Networks for Guest Users on Instant
APs
Instant APs support the captive portal authentication method in which a webpage is presented to the guest
users, when they try to access the Internet in hotels, conference centres, or Wi-Fi hotspots. The webpage
also prompts the guest users to authenticate or accept the usage policy and terms. Captive portals are used
at Wi-Fi hotspots and can be used to control wired access as well.

The captive portal solution for an Instant AP cluster consists of the following:

n The captive portal web login page hosted by an internal or external server.
n The RADIUS authentication or user authentication against internal database of the AP.
n The SSID broadcast by the Instant AP.
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The Instant AP administrators can create a wired or WLAN guest network based on captive portal
authentication for guests, visitors, contractors, and any non-employee users who can use the enterprise Wi-
Fi network. Administrators can also create guest accounts and customize the captive portal page with
organization-specific logo, terms, and usage policy. With captive portal authentication and guest profiles,
the devices associating with the guest SSID are assigned an initial role and are assigned IP addresses. When a
guest user tries to access a URL through HTTP or HTTPS, the captive portal webpage prompts the user to
authenticate with a user name and password.

Splash Page Profiles
Instant APs support the following types of splash page profiles:

n Internal Captive portal—Select this splash page to use an internal server for hosting the captive portal
service. Internal captive portal supports the following types of authentication:

l Internal Authenticated—When Internal Authenticated is enabled, a guest user who is pre-provisioned
in the user database has to provide the authentication details.

l Internal Acknowledged—When Internal Acknowledged is enabled, a guest user has to accept the terms
and conditions to access the Internet.
n External Captive portal—Select this splash page to use an external portal on the cloud or on a server

outside the enterprise network for authentication.
n Cloud Guest—Select this splash page to use the cloud guest profile configured through theGuest

Management tab.
n None—Select to disable the captive portal authentication.

For information on how to create splash page profiles, see the following sections:

n Creating a Wired Network Profile for Guest Users
n Configuring an Internal Captive Portal Splash Page Profile
n Configuring an External Captive Portal Splash Page Profile
n Configuring a Cloud Guest Splash Page Profile
n Disabling Captive Portal Authentication

Creating a Wired Network Profile for Guest Users
To create a wired SSID for guest access, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theWired accordion.
6. To create a new wired SSID profile, click + Add Port Profile.

TheCreate a New Network pane is displayed.
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7. UnderGeneral, enter the following information:

a. Name—Enter a name.

b. ports—Select port(s) form the drop-down list.

8. Click Next to configure theVLANs settings.

The VLANs details are displayed.

9. In theVLANs tab, select a type of mode from theMode drop-down list.
10. Select any of the following options for Client IP Assignment:

Parameter Description

Instant AP assigned Select this option to allow the Virtual Controller to assign IP addresses to
the wired clients. When the Virtual Controller assignment is used, the
source IP address is translated for all client traffic that goes through this
interface. The Virtual Controller can also assign a guest VLAN to a wired
client.
If this option is selected, specify any of the following options in Client
VLAN Assignment:

n Default—When the client VLAN must be assigned to the native
VLAN on the network.
n Custom—To customize the client VLAN assignment to a specific
VLAN, or a range of VLANs.

External DHCP server assigned Select this option to allow the clients to receive an IP address from the
network to which the Virtual Controller is connected. On selecting this
option, the New button to create a VLAN is displayed. Create a new VLAN
if required.

Table 96: VLANs Parameters

Configuring an Internal Captive Portal Splash Page Profile
To configure internal captive portal profile, complete the following steps:
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1. Open the guest SSID to edit and configure the following parameters in the Ports > Security page.

Parameter Description

Captive Portal Type Select any of the following from the drop-down list:
n Internal - Authenticated—When Internal Authenticated is
selected, the guest users are required to authenticate in the captive
portal page to access the Internet. The guest users who are required to
authenticate must already be added to the user database.
n Internal - Acknowledged—When Internal Acknowledged is
selected, the guest users are required to accept the terms and
conditions to access the Internet.
n External—When External is selected, the guest users are required
to enter the proxy server details such as IP address and captive portal
proxy server port details. Also enter the details in Walled Garden, and
Advanced section.
n Cloud Guest—When Cloud Guest is selected, the guest users are
required to select the Guest Captive Portal Profile.
n None—Select this option if you do not want to set any splash page.

Captive Portal Location Select Acknowledged or Authenticated from the drop-down list.

Splash Page Properties ) for which you are customizing the splash page design.
Perform the following steps to customize the splash page design.

n Top Banner Title—Enter a title for the banner. To preview the page
with the new banner title, click Preview Splash Page.
n Header fill color—Specify a background color for the header.
n Welcome Text—To change the welcome text, click the first square
box in the splash page, enter the required text in the Welcome Text
box, and click OK. Ensure that the welcome text does not exceed 127
characters.
n Policy Text—To change the policy text, click the second square in
the splash page, enter the required text in the Policy Text box, and
click OK. Ensure that the policy text does not exceed 255 characters.
n Page Fill Color—To change the color of the splash page, click the
Splash page rectangle and select the required color from the color
palette.
n Redirect URL—To redirect users to another URL, specify a URL in
Redirect URL.
n Logo Image—To upload a custom logo, click Upload, browse the
image file, and click upload image. Ensure that the image file size
does not exceed 16 KB. To delete an image, click Delete.

To preview the captive portal page, click Preview splash page.
To configure a captive portal proxy server or global proxy server to match
your browser configuration, enter the IP address and port number in the
Captive-portal proxy server IP and Captive Portal Proxy Server Port
fields.

Encryption By default, this field is disabled. Turn on the toggle switch to enable and
configure the following encryption parameters:

n Key Management—Specify an encryption and authentication key.
n Passphrase format—Specify a passphrase format.
n Passphrase—Enter a passphrase and retype to confirm.

Authentication Configure the following parameters:Configure the following parameters:
n MAC Authentication—To enable MAC address based
authentication for Personal and Open security levels, turn on the MAC
Authentication toggle switch.

Table 97: Internal Captive Portal Configuration Parameters



Aruba Central | User Guide 314

Parameter Description

lTo use an internal server, select Internal Server and add the
clients that are required to authenticate with the internal RADIUS
Server. Click Users to add the users.
lTo add a new server, click +. For information on configuring external
servers, see Configuring External Authentication Servers for APs on
page 356.

n Secondary Server—To add another server for authentication,
configure another authentication server.
n Load Balancing—Turn on the toggle switch to enable, if you are
using two RADIUS authentication servers, to balance the load across
these servers. For more information on the dynamic load balancing
mechanism, see Configuring DHCP Server for Assigning IP Addresses
to Instant AP Clients.

Users Create and manage users in the captive portal network. Only registered
users of type Guest Employee will be able to access this network.

Advanced Settings > MAC
Authentication

To enable MAC address based authentication for Personal and Open
security levels, turn on the MAC Authentication toggle switch.

Advanced Settings >
Reauth Interval

Specify a value for Reauth Interval. When set to a value greater than
zero, APs periodically re-authenticate all associated and authenticated
clients.

Advanced Settings >
Blacklisting

If you are configuring a wireless network profile, turn on the Blacklisting
toggle switch to blacklist clients with a specific number of authentication
failures. This is applicable for WLAN SSIDs only.

Advanced Settings >
Disable If Uplink Type Is

To exclude uplink, select an uplink type.

Table 97: Internal Captive Portal Configuration Parameters

2. Click Save Settings.

Configuring an External Captive Portal Splash Page Profile
You can configure external captive portal profiles and associate these profiles to a user role or SSID. You can
create a set of captive portal profiles in the Security > External Captive Portal data pane and associate
these profiles with an SSID or a wired profile. You can also create a new captive portal profile under the
Security tab of the WLAN wizard or a Wired Network pane. You can configure up to eight external captive
portal profiles.

When the captive portal profile is associated to an SSID, it is used before user authentication. If the profile is
associated to a role, it is used only after the user authentication. When a captive portal profile is applied to
an SSID or wired profile, the users connecting to the SSID or wired network are assigned a role with the
captive portal rule. The guest user role allows only DNS and DHCP traffic between the client and network,
and directs all HTTP or HTTPS requests to the captive portal unless explicitly permitted.

To configure an external captive portal profile, complete the following steps:

1. UnderWLANs tab, in theWireless SSIDs table, select a guest SSID and click the edit icon.

TheCreate a New Network pane is displayed.

2. Under Security tab, in the Security Level, select Captive Portal and configure the following
parameters under Splash Page:
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3. Select the Splash Page type as External.
4. If required, configure a captive portal proxy server or a global proxy server to match your browser

configuration by specifying the IP address and port number in theCaptive Portal Proxy Server IP
and Captive Portal Proxy Server Port fields.

5. Select a captive portal profile. To add a new profile, click + and configure the following parameters:

Data Pane Item Description

Name Enter a name for the profile.

Type Select any one of the following types of authentication:
n Radius Authentication—Select this option to enable user authentication
against a RADIUS server.
n Authentication Text—Select this option to specify an authentication text.
The specified text will be returned by the external server after a successful
user authentication.

IP or Hostname Enter the IP address or the host name of the external splash page server.

URL Enter the URL of the external captive portal server.

Port Enter the port number that is used for communicating with the external captive
portal server.

Use HTTPS Select this to enforce clients to use HTTPS to communicate with the captive portal
server. This option is available only if RADIUS Authentication is selected.

Captive Portal
Failure

This field allows you to configure Internet access for the guest users when the
external captive portal server is not available. Select Deny Internet to prevent
guest users from using the network, or Allow Internet to access the network.

Server Offload Select the check box to enable the server offload feature. The server offload
feature ensures that the non-browser client applications are not unnecessarily
redirected to the external captive portal server, thereby reducing the load on the
external captive portal server.

Prevent Frame
Overlay

Select this check box to prevent the overlay of frames. When enabled, the frames
display only those pages that are in the same domain as the main page.

Automatic URL
Whitelisting

On enabling this for the external captive portal authentication, the URLs that are
allowed for the unauthenticated users to access are automatically whitelisted.

Auth Text If the External Authentication Splash page is selected, specify the
authentication text that is returned by the external server after successful
authentication. This option is available only if Authentication Text is selected.

Redirect URL Specify a redirect URL if you want to redirect the users to another URL.

Table 98: External Captive Portal Profile Configuration Parameters

6. Click Save.
7. On the external captive portal splash page configuration page, specify encryption settings if required.
8. Specify the following authentication parameters in Advanced Settings:

n MAC Authentication—To enable MAC address based authentication for Personal and Open
security levels, turn on theMAC Authentication toggle switch.
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n Primary Server—Sets a primary authentication server.

l To use an internal server, select Internal server and add the clients that are required to authenticate
with the internal RADIUS Server. Click Users to add the users.

l To add a new server, click +. For information on configuring external servers, see Configuring External
Authentication Servers for APs.
n Secondary Server—To add another server for authentication, configure another authentication

server.
n Load Balancing—Turn on the toggle switch to enable, if you are using two RADIUS

authentication servers, to balance the load across these servers.

9. If required, underWalled Garden, create a list of domains that are blacklisted and also a white list of
websites that the users connected to this splash page profile can access.

10. To exclude uplink, select an uplink type.
11. If MAC authentication is enabled, you can configure the following parameters:

n Delimiter Character—Specify a character (for example, colon or dash) as a delimiter for the MAC
address string. When configured, the Instant AP uses the delimiter in the MAC authentication
request. For example, if you specify the colon as a delimiter, MAC addresses in the
xx:xx:xx:xx:xx:xx format are used. If the delimiter is not specified, the MAC address in the
xxxxxxxxxxxx format is used. This option is available only when MAC authentication is enabled.

n Uppercase Support—Turn on the toggle switch to enable, to allow the Instant AP to use
uppercase letters in MAC address string for MAC authentication. This option is available only if
MAC authentication is enabled.

12. Configure theReauth Interval. Specify a value forReauth Interval. When set to a value greater
than zero, Instant APs periodically re-authenticate all associated and authenticated clients.

13. If required, enable blacklisting. Set a threshold for blacklisting clients based on the number of failed
authentication attempts.

14. Click Save Settings.

Configuring a Cloud Guest Splash Page Profile
For information on how to create a cloud guest network profile, see Configuring a Cloud Guest Splash Page
Profile

Associating a Cloud Guest Splash Page Profile to a Guest SSID
To use the Cloud Guest Splash page profile for the guest SSID, ensure that the Cloud Guest Splash Page
profile is configured through theGuest Access app.

To associate a Cloud Guest splash page profile to a guest SSID, complete the following steps:

1. UnderWLANs tab, in theWireless SSIDs table, select a guest SSID and click the edit icon.

TheCreate a New Network pane is displayed.

2. Click the Security tab.

a. Select Cloud Guest from the Splash Page Type list.

b. Select the splash page profile name from theGuest Captive Portal Profile list, and then click
Next.

c. To enable encryption, turn on the Encryption toggle switch and configure the encryption
parameters.
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d. To exclude uplink, select 3G/4G,Wi-Fi, or Ethernet option fromDisable If Uplink Type Is
accordion.

e. Click Next.

3. Click Save Settings.

Configuring ACLs for Guest User Access
To configure access rules for a guest network, complete the following steps:

1. UnderWLANs tab, in theWireless SSIDs table, select a guest SSID and click the edit icon.

TheCreate a New Network pane is displayed.

2. Click theAccess tab.
3. UnderAccess, select any of the following types of access control:

n Unrestricted—Select this to set unrestricted access to the network.
n Network Based—Select Network Based to set common rules for all users in a network. By

default,Allow any to all destinations access rule is enabled. This rule allows traffic to all
destinations. To define an access rule, complete the following steps:

a. Click + and select appropriate options forRule Type, Service,Action,
Destination, and Options fields.

b. Click Save.

n Role Based—Select Role Based to enable access based on user roles.

For role-based access control:

1. Create a user role:

a. Click New in Role pane.
b. Enter a name for the new role and click OK.

2. Create access rules for a specific user role:

a. Click + and select appropriate options forRule Type, Service,Action,
Destination, and Options fields.

b. Click Save.

3. Create a role assignment rule.

a. UnderRole Assignment Rule, click New. TheNew Role Assignment Rule pane is
displayed.

b. Select appropriate options in Attribute,Operator, String, and Role fields.

c. Click Save.

1. Click Save Settings.

Disabling Captive Portal Authentication
To disable captive portal authentication, complete the following steps:
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1. UnderWLANs tab, in theWireless SSIDs table, select a guest SSID and click the edit icon.

TheCreate a New Network pane is displayed.

2. Click the Security tab.
3. Under Security, select None for Splash Page Type.
4. Click Save Settings.

Configuring Downloadable Roles
Aruba Central allows you to download pre-existing user roles when you create network profiles.

The Downloadable Role feature is available only for networks that include APs that run a minimum of Aruba
Instant 8.4.0.0 firmware version with a minimum of ClearPass server version 6.7.8.

Aruba Instant and ClearPass Policy Manager include support for centralized policy definition and
distribution.

When ClearPass Policy Manager successfully authenticates a user, the user is assigned a role by ClearPass
Policy Manager. If the role is not defined on the Instant AP, the role attributes can also be downloaded
automatically. In order to provide highly granular per-user level access, user roles can be created when a
user has been successfully authenticated. During the configuration of a policy enforcement profile in
ClearPass Policy Manager, the administrator can define a role that should be assigned to the user after
successful authentication. In RADIUS authentication, when ClearPass Policy Manager successfully
authenticates a user, the user is assigned a role by ClearPass Policy Manager.

If the role is not defined on the Instant AP, the role attributes can also be downloaded automatically. This
feature supports roles obtained by the following authentication methods:

n 802.1X (WLAN and wired users)
n MAC authentication
n Captive Portal

This section describes the following topics:

n ClearPass Policy Manager Certificate Validation for Downloadable Role
n Enabling Downloadable Role Feature for Wireless Networks in Aruba Central
n Enabling Downloadable Role Feature for Wired Networks in Aruba Central

ClearPass Policy Manager Certificate Validation for Downloadable
Role
When a ClearPass Policy Manager server is configured as the domain for RADIUS authentication for
downloading user roles, in order to validate the ClearPass Policy Manager customized CA, Instant APs are
required to publish the root CA for the HTTPS server to the well-known URL (http://<clearpass-
fqdn>/.wellknown/ aruba/clearpass/https-root.pem). The Instant AP must ensure that an FQDN is
defined in the above URL for the RADIUS server and then attempt to fetch the trust anchor by using the
RADIUS FQDN. Upon configuring the domain of the ClearPass Policy Manager server for RADIUS
authentication along with a username and password, the Instant AP tries to retrieve the CA from the above
well-known URL and store it in flash memory. However, if there is more than one ClearPass Policy Manager
server configured for authentication, the CA must be uploaded manually.
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Enabling Downloadable Role Feature for Wireless Networks in
Aruba Central
To enable theDownloadable Role feature, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWLANs tab, click + Add SSID. To modify an existing SSID, select a wireless SSID from the
Wireless SSIDs table and then click the edit icon.

6. In the Security tab, select theRADIUS server in Primary Server field.

At least one radius server must be configured to apply the Downloadable User Roles feature. For more
information on configuring radius server, see Authentication Servers for Instant APs

7. Click Next.
8. TheAccess tab is displayed.
9. Turn on theDownloadable Role toggle switch to allow downloading of pre-existing user roles. The

CPPM Settings table with Name, CPPM Username, and Actions columns related to the radius
servers are displayed.

The Downloadable Role feature is available only for networks that include APs that run a minimum of
Aruba Instant 8.4.0.0 firmware version with a minimum of ClearPass server version 6.7.8.
At least one radius server must be configured to apply the Downloadable Role feature. For more
information on configuring radius server, see Authentication Servers for Instant APs

10. Click the action corresponding to the radius server listed in theCPPM Settings table. The Edit
Server page is displayed.

The Edit Server page displays the name of the radius server name. The Name field is non-editable.

11. Enter the following details:
n CPPM Username—Enter the ClearPass Policy Manager admin username.
n Password—Enter the password.
n Retype—Retype the password.

12. Click OK.

Enabling Downloadable Role Feature for Wired Networks in Aruba
Central
To enable theDownloadable Role feature, perform the following steps:
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1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theWired accordion.
6. UnderWired, click + Add Port Profile. To modify an existing profile, select the network that you

want to edit in theWired Port Profiles pane, and then click the edit icon.
7. In the Security tab, select theRADIUS server in Primary Server field.

At least one radius server must be configured to apply the Downloadable Role feature. For more
information on configuring radius server, see Authentication Servers for Instant APs

8. Click Next.
9. TheAccess tab is displayed.

10. Enable theDownloadable Role option to allow downloading of pre-existing user roles. TheCPPM
Settings table with Name, CPPM Username, and Actions columns related to the radius servers are
displayed.

The Downloadable Role feature is available only for networks that include APs that run a minimum of
Aruba Instant 8.4.0.0 firmware version with a minimum of ClearPass server version 6.7.8.
At least one radius server must be configured to apply the Downloadable Role feature. For more
information on configuring radius server, see Authentication Servers for Instant APs

11. Click the action corresponding to the radius server listed in theCPPM Settings table. The Edit
Server page with the radius server name is displayed.

The Edit Server page displays the radius server name. The Name field is non-editable.

12. Enter the following details:
n CPPM Username—Enter the ClearPass Policy Manager admin username.
n Password—Enter the password.
n Retype—Retype the password.

13. Click OK.

Configuring Wired Port Profiles on Instant APs
If the wired clients must be supported on the Instant APs, configure wired port profiles and assign these
profiles to the ports of an Instant AP.

The wired ports of an Instant AP allow third-party devices such as VoIP phones or printers (which support
only wired port connections) to connect to the wireless network. You can also configure an ACL for
additional security on the Ethernet downlink.

To configure wired port profiles on Instant AP, complete the following steps:
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1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theWired accordion.
6. To create a new wired port profile, click + Add Port Profile.

TheCreate a New Network pane is displayed.

Complete the configuration for each of the tabs in theCreate a New Network page as described in the
below sections:

Configuring General Network Profile Settings
To configure general network profile settings, complete the following steps in theGeneral tab:

1. UnderGeneral, enter the following information:

a. Name—Enter a name.

b. ports—Select port(s) form the drop-down list.

2. UnderAdvanced Settings section, configure the following parameters:

a. Speed/Duplex—Select the appropriate value from the Speed and Duplex drop-down list.
Contact your network administrator if you need to assign speed and duplex parameters.

b. Port Bonding—Turn on the Port Bonding toggle switch to enable port bonding.

c. Power over Ethernet—Turn on the Power over Ethernet toggle switch to enable PoE.

d. Admin Status—TheAdmin Status indicates if the port is up or down.

e. Content Filtering—Turn on theContent Filtering toggle switch to ensure that all DNS
requests to non-corporate domains on this wired port network are sent to OpenDNS.

f. Uplink—Turn on the toggle switch to configure uplink on this wired port profile. If theUplink
toggle switch is turned on and this network profile is assigned to a specific port, the port is
enabled as an uplink port.

g. Spanning Tree—Turn on the toggle switch to enable STP on the wired port profile. STP ensures
that there are no loops in any bridged Ethernet network and operates on all downlink ports,
regardless of forwarding mode. STP does not operate on uplink ports and is supported only on
Instant APs with three or more ports. By default, STP is disabled on wired port profiles.

h. Inactivity Timeout—Enter the time duration after which an inactive user needs to be disabled
from the network. The user must undergo the authentication process to re-join the network.

i. 802.3az—Turn on the toggle switch to enable, to support 802.3az Energy Efficient Ethernet
(EEE) standard on the device. This option allows the device to consume less power during periods
of low data activity. This setting can be enabled for provisioned APs or AP groups through the
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wired port network. If this feature is enabled for an AP group, APs in the group that do not
support 802.3.az ignore this setting. This option is available for Instant APs that support a
minimum of Aruba Instant 8.4.0.0 firmware version.

j. Deny Intra VLAN Traffic—Turn on the toggle switch to disable intra VLAN traffic. It enables the
client isolation and disable all peer-to-peer communication. Client isolation disables inter-client
communication by allowing only client to gateway traffic from clients to flow in the network. All
other traffic from the client that is not destined to the gateway or configured servers will not be
forwarded by the Instant AP. This feature enhances the security of the network and protects it
from vulnerabilities.

3. Click Next.
TheVLANs details page is displayed.

Configuring VLAN Network Profile Settings
To configure VLAN settings, complete the following steps in theVLANs tab:

1. Mode—Specify any of the following modes:
n Access—Select this mode to allow the port to carry a single VLAN specified as the native VLAN. If

theAccess mode is selected, perform one of the following options:

l If theClient IP Assignment is set to Virtual Controller Assigned, proceed to step 6.

l If theClient IP Assignment is set to Network Assigned, specify a value forAccess VLAN to
indicate the VLAN carried by the port in theAccess mode.
n Trunk—Select this mode to allow the port to carry packets for multiple VLANs specified as allowed

VLANs. If the Trunkmode is selected:
n Specify theAllowed VLAN, enter a list of comma separated digits or ranges, for example 1, 2, 5, or

1-4, or all. The Allowed VLAN refers to the VLANs carried by the port in Access mode.
n If theClient IP Assignment is set to Network Assigned, specify a value forNative VLAN. A

VLAN that does not have a VLAN ID tag in the frames is referred to as Native VLAN. You can
specify a value within the range of 1-4093.

2. Client IP Assignment—specify any of the following values:
n Instant AP Assigned—Select this option to allow the virtual controller to assign IP addresses to

the wired clients. When the virtual controller assignment is used, the source IP address is
translated for all client traffic that goes through this interface. The virtual controller can also assign
a guest VLAN to a wired client. In theClient VLAN Assignment section, select Default when the
client VLAN must be assigned to the native VLAN on the network. Select Custom to customize the
client VLAN assignment to a specific VLAN, or a range of VLANs. Click the Show Named VLANs
section to view all the named VLANs mapped to VLAN ID. Click + Add Named VLAN and enter the
VLAN Name and VLAN ID that is required to be mapped. ClickingOK populates the named VLAN
in the VLAN Name to VLAN ID Mapping table.

n External DHCP server Assigned—Select this option to allow the clients to receive an IP address
from the network to which the Virtual Controller is connected. On selecting this option, theNew
button to create a VLAN is displayed. Create a new VLAN if required.

3. Click Next.
The Security details page is displayed.

Configuring Security Settings
To configure security-specific settings, complete the following steps in the Security tab:
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1. On the Security pane, select the following security options as per your requirement:
n 802.1X Authentication—Set the toggle button to enable 802.1X Authentication. Configure

the basic parameters such as the authentication server, and MAC Authentication Fail-Through.
Select any of the following options for authentication server:

l New—On selecting this option, an external RADIUS server must be configured to authenticate the
users. For information on configuring an external server, see Configuring External Authentication
Servers for APs on page 356.

l Internal Server—If an internal server is selected, add the clients that are required to authenticate
with the internal RADIUS server. Click theUsers link to add the users.

l Load Balancing—Set the toggle button to enable, if you are using two RADIUS authentication
servers, so that the load across the two RADIUS servers is balanced. For more information on the
dynamic load balancing mechanism, see Dynamic Load Balancing between Authentication Servers on
page 356.
n MAC Authentication—To enable MAC authentication, enable the toggle button. The

MAC authentication is disabled by default.
n Captive Portal—Set the toggle button to enable captive portal authentication. For more

information on configuring security on captive portal, see Configuring Wired Networks for Guest
Users on Instant APs.

n Open—Set the toggle button to enable, to set security for open network.

2. Enable the Port Type Trusted option to connect uplink and downlink to a trusted port only.
3. In the Primary Server field, perform one of the following steps:

n Internal Server—To use an internal server, select Internal Server and add the clients that are
required to authenticate with the internal RADIUS Server. Click Users to add the users. To add a
new server, click +. For information on configuring external servers, see Configuring External
Authentication Servers for APs on page 356.

n Secondary Server—To add another server for authentication, configure another authentication
server.

l Load Balancing—Set the toggle button to enable, if you are using two RADIUS authentication
servers, to balance the load across these servers. For more information on the dynamic load
balancing mechanism, see Dynamic Load Balancing between Authentication Servers on page 356.

4. MAC Authentication Fail-Thru—Set the toggle button to enable, to attempt 802.1X
authentication is attempted when the MAC authentication fails.

5. Under theAdvance Settings section, configure the following options:
n Use IP for Calling Station ID—Set the toggle button to enable, to configure client IP address as

calling station ID.
n Called Station ID Type—Select one of the following options:

l Access Point Group—Uses the VC ID as the called station ID.

l Access Point Name—Uses the host name of the Instant AP as the called station ID.

l VLAN ID—Uses the VLAN ID of as the called station ID.

l IP Address—Uses the IP address of the Instant AP as the called station ID.

l MAC address—Uses the MAC address of the Instant AP as the called station ID.

The Called Station ID Type detail can be configured even if the Use IP for Calling Station ID is set to
disabled.
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n Reauth Interval—Specify the interval at which all associated and authenticated clients must be
re-authenticated.

6. Click Next.
TheAccess pane is displayed.

Configuring Access Settings
To configure access-specific settings, complete the following steps:

1. In theAccess tab, turn on theDownloadable Role toggle switch to allow downloading of pre-
existing user roles. or more information, see Configuring Downloadable Roles.

The Downloadable Role feature is optional.
The Downloadable Role feature is available only for networks that include APs that run a minimum of
Aruba Instant 8.4.0.0 firmware version with a minimum of ClearPass server version 6.7.8.
At least one radius server must be configured to apply the Downloadable Role feature. For more
information on configuring radius server, see Authentication Servers for Instant APs

2. Click the action corresponding to the server.

The Edit Server page is displayed.

The Edit Server page displays the radius server name. The Name field is non-editable.

3. Enter the CPPM username along with the CPPM authentication credentials for the radius server.
4. Click Ok.
5. Under Access Rules, configure the following access rule parameters:

a. Select any of the following types of access control:
n Role-based—Allows the users to obtain access based on the roles assigned to them.
n Unrestricted—Allows the users to obtain unrestricted access on the port.
n Network-based—Allows the users to be authenticated based on access rules specified for a

network.

b. If the Role-based access control is selected:
n UnderRole, select an existing role for which you want to apply the access rules, or click New

and add the required role. To add a new access rule, click Add Rule underAccess Rules For
Selected Roles.

The default role with the same name as the network is automatically defined for each network.
The default roles cannot be modified or deleted.

n Configure role assignment rules. To add a new role assignment rule, click New underRole
Assignment Rules. UnderNew Role Assignment Rule:

c. Select an attribute.

d. Specify an operator condition.

e. Select a role.

f. Click Save.
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6. Click Finish to create the wired port profile successfully.

Configuring Network Port Profile Assignment
To map the wired port profile to ethernet ports, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theWired accordion.

TheWired Port Profiles page is displayed.

6. In the Port Profiles Assignments section, assign wired port profiles to Ethernet ports:

a. Select a profile from the Ethernet 0/0drop down list.

b. Select the profile from the Ethernet 0/1 drop down list.

c. If the Instant AP supports Ethernet 2, Ethernet 3 and Ethernet 4 ports, assign profiles to these
ports by selecting a profile from the Ethernet 0/2, Ethernet 0/3, and Ethernet 0/4 drop-
down list respectively.

7. Click Save Settings.

Viewing Wired Port Profile Summary
In the Summary tab, theNetwork Summary page displays all the settings configured in theGeneral,
VLANs, Security, and Access tabs.

Click Save Settings to complete the network profile creation and save the settings.

Editing a WLAN Profile
To edit a network profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select the network that you want to edit, and then click the edit icon
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under theActions column.
6. Modify the profile and click Save Settings.

You can directly edit the SSID name under the Display Name column of the Wireless SSIDs table. Double-click
the relevant SSID that you want to rename, and type the new name. Press Enter to complete the process.

Editing an Access Point Port Profile
To edit a network profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.
2. Under Manage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

When you click the Show Advanced option, the Devices > Access Points page displays the WLANs,
Access Points, Radios, Interfaces, Security, VPN, Services, System, and Configuration Audit tabs
as the default configuration tabs.

5. Click theWired accordion.
6. In theWired Port Profiles pane, select the network that you want to edit, and then click the edit

icon under theActions column.
7. Modify the profile and click Save Settings.

When you click the Hide Advanced option, the Devices > Access Points tab displays only the WLANs, Access
Points, and Radio tabs as the default configuration tabs.
Aruba Central now constantly displays the default tabs under the Show Advanced and Hide Advanced option
in the Devices > Access Points page. When you click the Show Advanced or Hide Advanced option and
navigate out of the page, the respective default tabs under Show Advanced or Hide Advanced option are still
displayed when you visit the page next time.

Deleting a Network Profile
To delete a network profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.
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4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select the network that you want to delete, and then click the delete
icon under theActions column.

6. Click Yes in the confirmation dialog box.

Configuring Mesh Instant AP

Mesh Network Overview
The mesh solution effectively expands and configures network coverage for outdoor and indoor enterprises
in a wireless environment. The mesh network automatically reconfigures broken or blocked paths when
traffic traverses across mesh Instant AP. This feature provides increased reliability by allowing the network
to continue operating even when an Instant AP is non-functional or if the device fails to connect to the
network.

A mesh network requires at least one valid wired or 3G uplink connection.
The mesh network must be provisioned by plugging into the wired network for the first time.

Mesh Instant APs
The Instant APs that are configured for mesh can either operate as mesh portals or as mesh points based on
the uplink type.

Instant AP as Mesh Portal
Any provisioned Instant AP that has a valid wired or 3G uplink connection functions as a mesh portal. A
mesh portal acts as a gateway between the wireless mesh network and the enterprise wired LAN. The mesh
roles are automatically assigned based on the Instant AP configuration. The mesh portal can also act as a
virtual controller.

The mesh portal reboots after 5 minutes, when it loses its uplink connectivity to a wired network.

Instant AP as Mesh Point
The Instant AP without an ethernet link functions as a mesh point. The mesh point establishes an all-
wireless path to the mesh portal and provides traditional WLAN services such as client connectivity, IDS
capabilities, user role association, and QoS for LAN-to-mesh communication to the clients, and performs
mesh backhaul or network connectivity. The mesh points authenticate to the mesh portal and establish a
secured link using AES encryption.

A mesh point also supports LAN bridging by connecting any wired device to the downlink port of the mesh point.
In the case of single ethernet port platforms such as Instant AP-105, you can convert the Eth0 uplink port to a
downlink port by enabling Eth0 Bridging.
Redundancy is observed in a mesh network when two Instant APs have valid uplink connections, and most
mesh points try to mesh directly with one of the two portals.
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There can be a maximum of eight mesh points per mesh portal in a mesh network. When mesh Instant APs
boot up, they detect the environment to locate and associate with their nearest neighbor. The mesh Instant
APs determine the best path to the mesh portal ensuring a reliable network connectivity.

In a dual-radio Instant AP, the 2.4 GHz radio is always used for client traffic, and the 5 GHz radio is always used
for both mesh-backhaul and client traffic.

Automatic Mesh Role Assignment
Aruba Central supports enhanced role detection during Instant AP boot-up and Instant AP running time.
When a mesh point discovers that the Ethernet 0 port link is up, it sends loop detection packets to check the
availability of Ethernet 0 link. If the Ethernet 0 link is available, the mesh point reboots as a mesh portal.
Else, the mesh point does not reboot.

Mesh Role Detection during System Boot-Up
If the ethernet link is down during Instant AP boot-up, the Instant AP acts as a mesh point. If the ethernet
link is up, the Instant AP continues to detect if the network is reachable in the following scenarios:

n In a static IP address scenario, the Instant AP acts as a mesh portal if it successfully pings the gateway.
Otherwise, it acts as a mesh point.

n In case of DHCP, the Instant AP acts as a mesh portal when it obtains the IP address successfully.
Otherwise, it acts as a mesh point.

n In case of IPv6, Instant APs do not support the static IP address but only support DHCP for detection of
network reachability.

If the Instant AP has a 3G or 4G USB modem plugged, it always acts as a mesh portal. If the Instant AP is set to
Ethernet 0 bridging, it always acts as a mesh point.

Mesh Role Detection during System Running Time
The mesh point uses the Loop Protection for Secure Jack Port feature to detect the loop when the ethernet
is up. If the loop is detected, the Instant AP reboots. Otherwise, the Instant AP does not reboot and the
mesh role continues to act as a mesh point.

Setting up Instant Mesh Network
To provision Instant APs as mesh Instant APs, complete the following steps:

n Connect the Instant APs to a wired switch.
n Ensure that the virtual controller key is synchronized and the country code is configured.
n Ensure that a valid SSID is configured on the Instant AP.
n If the Instant AP has a factory default SSID (Instant SSID), delete the SSID.
n If an ESSID is enabled on the virtual controller, disable it and reboot the Instant AP cluster.
n Disconnect the Instant APs that you want to deploy as mesh points from the switch, and place the

Instant APs at a remote location. The Instant APs come up without any wired uplink connection and
function as mesh points. The Instant APs with valid uplink connections function as mesh portals.
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Configuring Wired Bridging on Eth0 for Mesh Point
Aruba Central supports wired bridging on the Eth0 port of an Instant AP. You can configure wired bridging, if
the Instant AP is configured to function as a mesh point.

To configure support for wired bridging on the Eth0 port of an Instant AP from Aruba Central UI, complete
the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group in the filter:

a. Set the filter to one of the options underGroups. Ensure that the filter selected contains at
least one active access point.

The dashboard context for the group is displayed.

b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

n To select an access point in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

d. UnderManage, click Device > Access Point.

2. Click theConfig icon.

The tabs to configure access points are displayed.

3. Click theAccess Points tab.

TheAccess Points table is displayed.

4. To edit an AP, select an AP in theAccess Points table, and then click the edit icon.
5. Click theUplink tab.
6. To configure a non-native uplink VLAN, specify the number of VLANs in theUplink Management

VLAN text-box.
7. Turn on the Eth0 Bridging toggle switch.
8. Click OK and reboot the Instant AP.

Mesh Cluster Function
Aruba Central introduces the mesh cluster function for easy deployments of Instant APs. You can configure
the ID, password, and also provision Instant APs to a specific mesh cluster.

In a cluster-based scenario, you can configure unlimited mesh profiles in a network. When an Instant AP
boots up, it attempts to find a mesh cluster configuration. The Instant AP fetches a pre-existing mesh
cluster configuration, if any. Otherwise, it uses the default mesh configuration in which the SSID, password,
and cluster name are generated by the virtual controller key.
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Instant APs that belong to the same mesh network can establish mesh links with each other. The Instant APs can
establish a mesh link in a standalone scenario also. However, the network role election does not take place in a
standalone environment. Users can set the same mesh cluster configuration to establish mesh links with other
networks. For more information on mesh cluster configuration, refer to the Mesh Instant AP Configuration
chapter of Aruba Instant User Guide.

Configuring Time-Based Services for Wireless
Network Profiles
Aruba Central allows you to configure the availability of a WLAN SSID at a particular time of the day. You can
now create a time range profile and assign it to a WLAN SSID, so that you can enable or disable access to the
SSID and thus control user access to the network during a specific time period.

Instant APs support the configuration of both absolute and periodic time range profiles. You can configure
an absolute time range profile to execute during a specific time frame, or create a periodic profile to execute
at regular intervals based on the periodicity specified in the configuration.

This section describes the following topics:

n Creating a Time Range Profile
n Associating a Time Range Profile to an SSID
n Associating a Time Range Profile to ACL

Before You Begin
Before you configure time-based services, ensure that the NTP server connection is active.

Creating a Time Range Profile
To create a time range profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the Time-Based Services accordion.
6. Click + in the Time Based Profiles table.

TheNew Profile window for creating a time range profile is displayed.

7. Configure the parameters that are listed in the following table:
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Parameter Description

Name Specify a name for the time range profile.

Type Select the type of time range profile:
n Periodic—Allows you configure a specific periodicity and recurrence pattern
for a time range profile.
n Absolute—Allows you to configure an absolute day and time range.

Repeat Specify the frequency for the periodic time range profile:
n Daily—Enables daily recurrence.
n Weekly—Allows you define a specific time range with specific start and end
days in a week.

Day Range Absolute
For an absolute time range profile, this field allows you to specify the start day and
end day, both in mm/dd/yyyy format. You can also use the calendar to specify the
start and end days.

Periodic
For a periodic time range profile, the following Day Range options are available:

n For daily recurrence—If the Repeat option is set to Daily, this field allows you to
select the following time ranges:
lMonday—Sunday (All Days)
lMonday—Friday (Weekdays)
lSaturday—Sunday (Weekend)

For example, if you set the Repeat option to Daily and then select
Monday—Friday (Weekday) for Day Range, and Start Time as 1 and
End time as 2, the applied time range will be Monday to Friday from 1
am to 2 am; that is, on Monday at 3 am, the profile will not be applied or
disabled.

n For weekly occurrence—If the Repeat option is set to Weekly, this field allows
you to select the start and end days of a week and time range.

For example, if you set Start Day as Monday and End Day as Friday,
and Start Time as 1 and End Time as 2, the applied time range profile
is Monday 1 am to Friday 2 am every week; that is, on Monday at 3 am,
the profile will be applied or enabled.

Start Time Select the start time for the time range profile from the Hours and Minutes drop-
down lists, respectively.

End Time Select the end time for the time range profile from the Hours and Minutes drop-
down lists, respectively.

Visualization Graph for
Time

The Visualization graph (approximated to the hour) provides a visual display of the
selected time range (Day Range, Start Time, and End Time) for periodic profiles.

Table 99: Time Range Profile Configuration Parameters

Associating a Time Range Profile to an SSID
To apply a time range profile to an SSID, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.
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3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select a network profile for which you want to apply the time range
profile, and then click the edit icon. You can also add a time range profile when configuring an SSID.

6. In General, click Time Range Profiles underAdvanced Settings.
7. In the Time Range Profiles section, enter the following information:

n Select a time range profile from the Time Range Profile list.
n Select a value from the Status drop-down list.
n When a time range profile is enabled on SSID, the SSID is made available to the users for the

configured time range. For example, if the specified time range is 12:00 to 13:00, the SSID
becomes available only between 12 PM to 1 PM on a given day.

n If a time range is disabled, the SSID becomes unavailable for the configured time range. For
example, if configured time-range is 14:00 to 17:00, the SSID is made unavailable from 2 PM to 5
PM on a given day.

8. Click Save.

To create a time range profile, click + New Time Range Profile. TheNew Profile window for creating a
time range profile is displayed.

Associating a Time Range Profile to ACL
Aruba Central allows you to configure time-based services for specific ACL. To apply a time range profile to
an access rule, complete the following procedure:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. In theRoles accordion, click the edit icon listed for access rules underAccess Rules For Selected
Roles to which you want to apply the time range profile.

6. TheAccess Rule page is displayed.

7. In theOptions section, select the Time Range check-box and select the time range profile from the
drop-down list.

n When a time range profile is associated with an ACL, the configured time range is applied on all the
WLAN SSID with the specific ACL.

n If a time range is disabled or if the time range profile is deleted for an ACL, all WLAN SSID with the
specific ACL will be able to access the network without any time constraint.

8. Click Save.

For more information on time range configuration, see the Aruba Instant User Guide.
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Configuring ARM and RF Parameters on Instant APs
This section provides the following information:

n ARM Overview
n Configuring ARM Features
n Configuring Radio Parameters

ARM Overview
ARM is a radio frequency management technology that optimizes WLAN performance even in the networks
with highest traffic by dynamically and intelligently choosing the best 802.11 channel and transmitting
power for each Instant AP in its current RF environment. ARM works with all standard clients, across all
operating systems, while remaining in compliance with the IEEE 802.11 standards. It does not require any
proprietary client software to achieve its performance goals. ARM ensures low-latency roaming, consistently
high performance, and maximum client compatibility in a multi-channel environment. By ensuring the fair
distribution of available Wi-Fi bandwidth to mobile devices, ARM ensures that data, voice, and video
applications have sufficient network resources at all times. ARM allows mixed 802.11a, b, g, n, and ac client
types to inter operate at the highest performance levels.

When ARM is enabled, an Instant AP dynamically scans all 802.11 channels within its 802.11 regulatory
domain at regular intervals and sends reports on WLAN coverage, interference, and intrusion detection to
the virtual controller. ARM computes coverage and interference metrics for each valid channel, chooses the
best performing channel, and transmit power settings for each Instant AP RF environment. Each Instant AP
gathers other metrics on its ARM-assigned channel to provide a snapshot of the current RF health state.

Instant APs support the following ARM features:

n Channel or Power Assignment—Assigns channel and power settings for all the Instant APs in the network
according to changes in the RF environment.

n Voice Aware Scanning—Improves voice quality by preventing an Instant AP from scanning for other
channels in the RF spectrum during a voice call and by allowing an Instant AP to resume scanning when
there are no active voice calls.

n Load Aware Scanning—Dynamically adjusts the scanning behavior to maintain uninterrupted data
transfer on resource intensive systems when the network traffic exceeds a predefined threshold.

n Band Steering—Assigns the dual-band capable clients to the 5 GHz band on dual-band Instant APs
thereby reducing co-channel interference and increasing the available bandwidth for dual-band clients.

n Client Match—Continually monitors the RF neighborhood of the client to support the ongoing band
steering and load balancing of channels, and enhanced Instant AP reassignment for roaming mobile
clients.

When Client Match is enabled on 802.11n capable Instant APs, the Client Match feature overrides any
settings configured for the legacy band steering, station hand-off assist or load balancing features. The
802.11ac capable Instant APs do not support the legacy band steering, station hand off or load balancing
settings, so these Instant APs must be managed using Client Match.

n Airtime Fairness—Provides equal access to all clients on the wireless medium, regardless of client type,
capability, or operating system to deliver uniform performance to all clients.

n For more information on ARM features supported by the APs, see the Aruba Instant User Guide.
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Configuring ARM Features
To configure the ARM features, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theRadios tab.

The Radios details page is displayed.

5. UnderRF > Adaptive Radio Management (ARM), theClient Control section displays the
following components:
n Band Steering Mode
n Airtime Fairness Mode
n ClientMatch
n ClientMatch Calculating Interval
n ClientMatch Neighbor Matching
n ClientMatch Threshold
n ClientMatch Key
n Spectrum Load Balancing Mode

6. ForBand Steering Mode, configure the following parameters:

Data
pane
item

Description

Prefer
5 GHz

Enables band steering in the 5 GHz mode. On selecting this, the Instant AP steers the client to
the 5 GHz band (if the client is 5 GHz capable), but allows the client connection on the 2.4 GHz
band if the client persistently attempts for 2.4 GHz association.

Force 5
GHz

Enforces 5 GHz band steering mode on the Instant APs.

Balance
Bands

Allows the Instant AP to balance the clients across the two radios to best utilize the available
2.4 GHz bandwidth. This feature takes into account the fact that the 5 GHz band has more
channels than the 2.4 GHz band, and that the 5 GHz channels operate in 40 MHz, while the 2.5
GHz band operates in 20 MHz.

Disable Allows the clients to select the band to use.

Table 100: Band Steering Mode Configuration Parameters
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7. ForAirtime Fairness Mode, specify any of the following values:

Data Pane
Item Description

Default Access Allows access based on client requests. When Airtime Fairness Mode is set to
Default Access option, per user and per SSID bandwidth limits are not enforced.

Fair Access Allocates air time evenly across all the clients.

Preferred Access Sets a preference where 802.11n clients are assigned more air time than
802.11a/11g. The 802.11a/11g clients get more airtime than 802.11b. The ratio is
16:4:1.

Table 101: Airtime Fairness Mode Configuration Parameters

8. For ClientMatch, configure the following parameters:

Data Pane Item Description

Client Match Turn on the toggle switch to enable the Client Match
feature on APs. When enabled, client count is balanced
among all the channels in the same band. When Client
Match is enabled, ensure that the Scanning option is
enabled. For more information, see AP Control
Configuration Parameters.

NOTE: When Client Match is disabled, channels can be
changed even when the clients are active on a BSSID. The
Client Match option is disabled by default.

ClientMatch
Calculating
Interval

Configures a value for the calculating interval of Client
Match. The interval is specified in seconds and the default
value is 3 seconds. You can specify a value within the range
of 10-600.

ClientMatch
Neighbor
Matching

Configures the calculating interval of Client Match. This
number takes into account the least similarity percentage
to be considered as in the same virtual RF neighborhood of
Client Match. You can specify a percentage value within
the range of 20-100. The default value is 60%.

ClientMatch
Threshold

Configures a Client Match threshold value. This number
takes acceptance client count difference among all the
channels of Client Match. When the client load on an AP
reaches or exceeds the threshold in comparison, Client
Match is enabled on that AP. You can specify a value within
range of 1-20. The default value is 5.

ClientMatch Key Enables the Client Match feature to work across different
standalone Instant APs in the same management VLAN. All
such standalone Instant APs must be set with the same
Client Match key.

Table 102: Additional ARM Configuration Parameters
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Data Pane Item Description

Client Match uses the wired layer 2 protocol to
synchronize information exchanged between Instant APs.
Users have an option to configure the Client Match keys.
Instant APs verify if the frames that they broadcast contain
a common Client Match key. Instant APs that receive these
frames verify if the sender belongs to the same network or
if the sender and receiver both have the same Client
Match key. You can specify a value within the range of 1–
2147483646.

Spectrum Load
Balancing Mode

Enables the Spectrum Load Balancing mode to determine
the balancing strategy for Client Match. The following
options are available:

n Channel
n Radio
n Channel + Radio

9. Click Access Point Control, and configure the following parameters:

Data
pane item

Description

Customize
Valid
Channels

Allows you to select a custom list of valid 20 MHz and 40 MHz channels for 2.4 GHz and 5
GHz bands. By default, the AP uses valid channels as defined by the Country Code
(regulatory domain). On selecting Customize Valid Channels, a list of valid channels for
both 2.4 GHz and 5 GHz are displayed. The valid channel customization feature is disabled
by default.
The valid channels automatically show in the Static Channel Assignment pane

Min
Transmit
Power

Allows you to configure a minimum transmission power within a range of 3 to 33 dBm in 3
dBm increments. If the minimum transmission EIRP setting configured on an AP is not
supported by the AP model, this value is reduced to the highest supported power setting.
The default value for minimum transmit power is 18 dBm.

Max
Transmit
Power

Allows you to configure the maximum transmission power within a range of 3 to 33 dBm in
3 dBm increments. If the maximum transmission EIRP configured on an AP is not supported
by the local regulatory requirements or AP model, the value is reduced to the highest
supported power settings.

Client
Aware

Allows ARM to control channel assignments for the Instant APs with active clients. When the
Client Match mode is disabled, an Instant AP may change to a more optimal channel,
which disrupts current client traffic. The Client Aware option is enabled by default.

Scanning Allows the Instant AP to dynamically scan all 802.11 channels within its 802.11 regulatory
domain at regular intervals. This scanning report includes WLAN coverage, interference,
and intrusion detection data.

NOTE: For Client Match configuration, ensure that Scanning is enabled.

Table 103: AP Control Configuration Parameters
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Data
pane item

Description

Wide
Channel
Bands

Allows the administrators to configure 40 MHz channels in the 2.4 GHz and 5.0 GHz bands.
40 MHz channels are two 20 MHz adjacent channels that are bonded together. The 40 MHz
channel effectively doubles the frequency bandwidth available for data transmission. For
high performance, you can select 5 GHz. If the AP density is low, enable in the 2.4 GHz
band.

80 MHz
Support

Enables or disables the use of 80 MHz channels on APs. This feature allows ARM to assign
80 MHz channels on APs with 5 GHz radios, which support a very high throughput. This
setting is enabled by default.

NOTE: Only the APs that support 802.11ac can be configured with 80 MHz channels.

10. Click Channel Control, and configure the following parameters:

Data
pane
item

Description

Backoff
Time

Allows you to configure the time within a range of 10 to 3600 seconds, when an Instant AP
backs off after requesting a new channel or power. It can increase the time window of
channel interference check, and the time window of power check. The default value for
minimum back off time is 240 seconds.

Free
Channel
Index

Allows you to check the difference in threshold in the channel interference index between
the new channel and the existing channel. An Instant AP only moves to a new channel if the
new channel has a lower interference index value than the current channel. This parameter
specifies the required difference between the two interference index values before the
Instant AP moves to the new channel. The lower this value, the more likely the Instant AP
moves to the new channel. It has a default value of 25.

Ideal
Coverage
Index

Allows you to specify the ideal coverage index in the range of 2 to 20, which an Instant AP
tries to achieve on its channel. The denser the Instant AP deployment, the lower this value
should be. It has a default value of 10.

Channel
Quality
Aware
Arm
Disable

Allows ARM to ignore the internally calculated channel quality metric and initiates channel
changes based on thresholds defined in the profile. ARM chooses the channel based on the
calculated interference index value. The option Channel Quality Aware Arm Disable is
disabled by default.

Channel
Quality
Threshold

Allows you to specify the channel quality percentage within a range of 0 to 100, below which
ARM initiates a channel change. It has a default value of 70%.

Channel
Quality
Wait
Time

Specifies the time that the channel quality is below the channel quality threshold value to
initiate a channel change. It has a range of 1 to 3600 seconds, with a default value of 120
seconds.

NOTE: If current channel quality is below the specified channel quality threshold for this
wait time period, ARM initiates a channel change.

Table 104: Channel Control Configuration Parameters
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11. Click Error Rate, and configure the following parameters:

Data
Pane
Item

Description

Error Rate
Threshold

Configures the minimum percentage of errors in the channel that triggers a channel
change. It has a range of 0 to 100 % with a default value of 70%.

Error Rate
Wait
Time

Configures the time that the error rate has to be at least equal to the error rate threshold to
trigger a channel change. The error rate must be equal to or more than the error rate
threshold to trigger a channel change. It has a range of 1 to 3600 seconds, with a default
value of 90 seconds.

Table 105: Error Rate Configuration Parameters

12. Click Save Settings.

Configuring Radio Parameters
To configure RF parameters for the 2.4 GHz and 5 GHz radio bands on an Instant AP, complete the
following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theRadios tab.

The Radios details page is displayed.

5. Expand theRadio accordion in theRF dashboard.
6. Under 2.4 GHz band, 5 GHz band, or both, configure the following parameters by clicking the +

sign.

Data Pane
Item Description

Zone Allows you to configure a zone per radio band for Instant APs in a cluster. You can also
configure an RF zone per Instant AP.

NOTE: Aruba recommends that you configure RF zone for either individual AP or for
the cluster. Any discrepancy in the RF zone names may lead to configuration errors.

Legacy Only Turn on the Legacy Only toggle switch. When enabled, the Instant AP runs the radio
in the non-802.11n mode. This option is disabled by default.

Table 106: Radio Configuration Parameters
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Data Pane
Item Description

802.11d /
802.11h

Turn on the 802.11d / 802.11h toggle switch. When enabled, the radios advertise
their 802.11d (Country Information) and 802.11h (Transmit Power Control)
capabilities. This option is disabled by default.

Beacon
Interval

Configures the beacon period for the Instant AP in milliseconds. This indicates how
often the 802.11 beacon management frames are transmitted by the AP. You can
specify a value within the range of 60–500. The default value is 100 milliseconds.

Interference
Immunity
Level

Configures the immunity level to improve performance in high-interference
environments. The default immunity level is 2.

n Level 0—No ANI adaptation.
n Level 1—Noise immunity only. This level enables power-based packet detection
by controlling the amount of power increase that makes a radio aware that it has
received a packet.
n Level 2—Noise and spur immunity. This level also controls the detection of
OFDM packets, and is the default setting for the Noise Immunity feature.
n Level 3—Level 2 settings and weak OFDM immunity. This level minimizes false
detects on the radio due to interference, but may also reduce radio sensitivity. This
level is recommended for environments with a high-level of interference related to
2.4 GHz appliances such as cordless phones.
n Level 4—Level 3 settings, and FIR immunity. At this level, the AP adjusts its
sensitivity to in-band power, which can improve performance in environments with
high and constant levels of noise interference.
n Level 5—The AP completely disables PHY error reporting, improving
performance by eliminating the time the Instant AP spends on PHY processing.

NOTE: Increasing the immunity level makes the AP lose a small amount of range.

Channel
Switch
Announcement
Count

Configures the number of channel switching announcements to be sent before
switching to a new channel. This allows the associated clients to recover gracefully
from a channel change.

Background
Spectrum
Monitoring

Turn on the Background Spectrum Monitoring toggle switch. When enabled, the
APs in the access mode continue with their normal access service to clients, while
performing additional function of monitoring RF interference (from both neighboring
APs and non Wi-Fi sources such as, microwaves and cordless phones) on the channel
they are currently serving the clients.

Customize
ARM Power
Range

Configures a minimum (Min Power) and maximum (Max Power) power range value
for the 2.4 GHz and 5 GHz band frequencies. The default value is 3 dBm. Unlike the
configuration in the ARM profile, the transmit power of all radios in the Radio profile
do not share the same configuration.

Enable 11ac Turn on the Enable 11ac toggle switch. When enabled, VHT is enabled on the
802.11ac devices for the 5 GHz radio band. If VHT is enabled for the 5 GHz radio
profile on an Instant AP, it is automatically enabled for all SSIDs configured on an
Instant AP. By default, VHT is enabled on all SSIDs.

NOTE: If you want the 802.11ac Instant APs to function as 802.11n Instant APs, clear
this check box to disable VHT on these devices.

Table 106: Radio Configuration Parameters
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Data Pane
Item Description

Smart antenna Turn on the Smart antenna toggle switch to combine an antenna array with a digital
signal-processing capability to transmit and receive in an adaptive, spatially sensitive
manner.

ARM/WIDS
Override

When ARM/WIDS Override is disabled, the Instant AP will always process frames for
WIDS. WIDS is an application that detects the attacks on a wireless network or
wireless system. purposes even when it is heavily loaded with client traffic. When
ARM/WIDS Override is enabled, the Instant AP will stop processing frames for WIDS.

Table 106: Radio Configuration Parameters

7. Click Save Settings.

Configuring IDS Parameters on APs
Aruba Central supports the IDS feature that monitors the network for the presence of unauthorized APs
and clients. It also logs information about the unauthorized APs and clients, and generates reports based on
the logged information.

Rogue APs
The IDS feature in the Aruba Central network enables you to detect rogue APs, interfering APs, and other
devices that can potentially disrupt network operations. A rogue AP is an unauthorized AP plugged into the
wired side of the network. An interfering AP is an AP seen in the RF environment, but it is not connected to
the wired network. While the interfering AP can potentially cause RF interference, it is not considered a direct
security threat, because it is not connected to the wired network. However, an interfering AP may be
reclassified as a rogue AP.

The built-in IDS scans for APs that are not controlled by the VC. These are listed and classified as either
Interfering or Rogue, depending on whether they are on a foreign network or your network.

Configuring Wireless Intrusion Detection and Protection
Policies
To configure a Wireless Intrusion Detection and Protection policy:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed.
4. Click Show Advanced.
5. Click Security. The Security details page is displayed.
6. Click theWireless IDS/IPS accordion.

The following three sections are displayed:
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n Detection
n Protection
n Firewall Settings

You can configure the following options in the above mentioned sections:

n Infrastructure Detection Policies—Specifies the policy for detecting wireless attacks on APs.
n Client Detection Policies—Specifies the policy for detecting wireless attacks on clients.
n Infrastructure Protection Policies—Specifies the policy for protecting APs from wireless

attacks.
n Client Protection Policies—Specifies the policy for protecting clients from wireless attacks.
n Firewall Policies—Specifies the policies to set a firewall for a secured network access.
n Containment Methods—Prevents unauthorized stations from connecting to your Aruba Central

network.

Each of these options contains several default levels that enable different sets of policies. An
administrator can customize enable or disable these options accordingly.

Detection
The detection levels can be configured using theDetection section. The following levels of detection can be
configured in the WIP Detection page:

n High
n Medium
n Low
n Off
n Custom

The following table describes the detection policies enabled in the Infrastructure Detection field.

Detection
level Detection policy

Off All detection policies are disabled.

Low n Detect Windows Bridge
n Signature Deassociation Broadcast
n Signature Deauthentication Broadcast
n Detect AP Spoofing

Medium n Detect Windows Bridge
n Signature Deassociation Broadcast
n Signature Deauthentication Broadcast
n Detect AP Spoofing
n Detect adhoc using VALID SSID
n Detect malformed large duration

High n Detect Windows Bridge
n Signature Deassociation Broadcast
n Signature Deauthentication Broadcast
n Detect AP Spoofing

Table 107: Infrastructure Detection Policies
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Detection
level Detection policy

n Detect adhoc using VALID SSID
n Detect malformed large duration
n Detect Overflow EAPOL key
n Detect Invalid Address Combination
n Detect AP Impersonation
n Detect AP Flood
n Detect Beacon Wrong Channel
n Detect ht Greenfield
n Detect Overflow IE
n Detect RTS Rate Anomaly
n Detect Malformed HT IE
n Detect CTS Rate Anomaly
n Detect Malformed Frame Auth.
n Detect devices with invalid MAC OUI
n Detect Malformed Association Request
n Detect Bad WEP
n Detect Wireless Bridge
n Detect HT 40 MHz intolerance
n Detect Valid SSID Misuse
n Detect Adhoc Network
n Detect Client Flood

Custom Allows you to select custom detection policies. To select, click the check box of respective
detection policy.

Table 107: Infrastructure Detection Policies

The following table describes the detection policies enabled in the Client Detection field.

Detection
level Detection policy

Off All detection policies are disabled.

Low Detect Valid Station Misassociation

Medium n Detect Valid Station Misassociation
n Detect Hotspotter Attack
n Detect Power Save DOS Attack
n Detect Omerta Attack
n Detect Disconnect Station
n Detect unencrypted Valid
n Detect Block ACK Attack
n Detect FATA-Jack

High n Detect Valid Station Mis-association
n Detect Hotspotter Attack
n Detect Power Save DOS Attack
n Detect Omerta Attack
n Detect Disconnect Station
n Detect unencrypted Valid
n Detect Block ACK Attack

Table 108: Client Detection Policies



Configuring IDS Parameters on APs | 343

Detection
level Detection policy

n Detect FATA-Jack
n Detect Rate Anomaly
n Detect Chop Chop Attack
n Detect EAP Rate Anomaly
n Detect TKIP Replay Attack
n Signature — Air Jack
n Signature — ASLEAP

Custom Allows you to select custom detection policies. To select, click the check box of respective
detection policy.

Protection
The following levels of detection can be configured in the WIP Protection page:

n Off
n Low
n High
n Custom

The following table describes the protection policies that are enabled in the Infrastructure Protection field.

Protection
level Protection policy

Off All protection policies are disabled

Low n Protect SSID
n Rogue Containment

High n Protect SSID
n Rogue Containment
n Protect AP Impersonation
n Protect from Adhoc Networks

Custom Allows you to select custom detection policies. To select, click the check box of respective
protection policy.

Table 109: Infrastructure Protection Policies

The following table describes the detection policies that are enabled in the Client Protection field.

Protection
level Protection policy

Off All protection policies are disabled

Low Protect Valid Station

Table 110: Client Protection Policies
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Protection
level Protection policy

High n Protect Valid Station
n Protect Windows Bridge

Custom Allows you to select custom detection policies. To select, click the check box of respective
protection policy.

Containment Methods
You can enable wired and wireless containment measures to prevent unauthorized stations from
connecting to your Aruba Central network.

Aruba Central supports the following types of containment mechanisms:

n Wired containment — When enabled, APs generate ARP packets on the wired network to contain
wireless attacks.

n Wireless containment — When enabled, the system attempts to disconnect all clients that are
connected or attempting to connect to the identified AP.

l None — Disables all the containment mechanisms.

l Deauthenticate only — With deauthentication containment, the AP or client is contained by disrupting the
client association on the wireless interface.

l Tarpit containment — With tarpit containment, the AP is contained by luring clients that are attempting to
associate with it to a tarpit. The tarpit can be on the same channel or a different channel as the AP being
contained.

l Tarpit all stations

The FCC and some third parties have alleged that under certain circumstances, the use of containment
functionality violates 47 U.S.C. §333. Before using any containment functionality, ensure that your intended use
is allowed under the applicable rules, regulations, and policies. Aruba is not liable for any claims, sanctions, or
other direct, indirect, special, consequential or incidental damages related to your use of containment
functionality.

Protection Against Wired Attacks
In the Protection Against Wired Attacks section, enable the following options:

n Drop Bad ARP—Drops the fake ARP packets.
n Fix Malformed DHCP—Fixes the malformed DHCP packets.
n ARP Poison Check—Triggers an alert on ARP poisoning caused by the rogue APs.

Firewall Settings
To configure firewall settings by specifying the policies for a secured network access, see Configuring Firewall
Parameters for Wireless Network Protection.

For all subnets, a deny rule is created by default as the last rule. If at least one rule is configured, the deny all
rule is applied to the upstream traffic by default.
Management access to the Instant AP is allowed irrespective of the inbound firewall rule.
The inbound firewall is not applied to traffic coming through the GRE tunnel.CustomHigh
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Configuring Authentication and Security Profiles on
Instant APs
This section describes the authentication and security parameters to configure on an Instant AP:

n Supported Authentication Methods
n Authentication Servers for Instant APs
n Configuring External Authentication Servers for APs
n Configuring Users Accounts for the Instant AP Management Interface
n Configuring Guest and Employee User Profiles on Instant APs
n Configuring Roles and Policies on Instant APs for User Access Control
n Enabling ALG Protocols on Instant APs
n Blacklisting Instant AP Clients
n Configuring an MPSK Local Profile
n Configuring Intra VLAN Traffic Whitelist

Supported Authentication Methods
Authentication is a process of identifying a user through a valid username and password. Clients can also be
authenticated based on their MAC addresses.

The authentication methods supported by the Instant APs managed through Aruba Central are described in
the following sections.

802.1X Authentication
802.1X is a method for authenticating the identity of a user before providing network access to the user.
The Aruba Central network supports internal RADIUS server and external RADIUS server for 802.1X
authentication. For authentication purpose, the wireless client can associate to a NAS or RADIUS client such
as a wireless Instant AP. The wireless client can pass data traffic only after successful 802.1X authentication.

The NAS acts as a gateway to guard access to a protected resource. A client connecting to the wireless network
first connects to the NAS.

Configuring 802.1X Authentication for a Network Profile
To configure 802.1X authentication for a wireless network profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select a network profile for which you want to enable 802.1X
authentication, and then click the edit icon.
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You can directly edit the SSID name under the Display Name column in the Wireless SSIDs table.
Double-click the relevant SSID that you want to rename, and type the new name. Press Enter to
complete the process.

6. Under Security, for the Enterprise security level, select the preferred option fromKey
Management.

7. To terminate the EAP portion of 802.1X authentication on the Instant AP instead of the RADIUS
server, set Termination to Enabled.

For 802.1X authorization, by default, the client conducts an EAP exchange with the RADIUS server,
and the AP acts as a relay for this exchange. When Termination is enabled, the Instant AP itself acts
as an authentication server, terminates the outer layers of the EAP protocol, and only relays the
innermost layer to the external RADIUS server.

8. Specify the type of authentication server to use.
9. Click Save Settings.

MAC Authentication
MAC authentication is used for authenticating devices based on their physical MAC addresses. MAC
authentication requires that the MAC address of a machine matches a manually defined list of addresses.
This authentication method is not recommended for scalable networks and the networks that require
stringent security settings.

MAC authentication can be used alone or it can be combined with other forms of authentication such as
WEP authentication.

Configuring MAC Authentication for a Network Profile
To configure MAC authentication for a wireless profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWLANs tab, select a network profile for which you want to enable MAC authentication and
click the edit icon.

6. In Security, turn on theMAC Authentication toggle switch to enable Personal orOpen security
level.

7. Specify the type of authentication server to use.
8. Click Save Settings.

MAC Authentication with 802.1X Authentication
The administrators can enable MAC authentication for 802.1X authentication. MAC authentication shares all
the authentication server configurations with 802.1X authentication. If a wireless or wired client connects to
the network, MAC authentication is performed first. If MAC authentication fails, 802.1X authentication does
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not trigger. If MAC authentication is successful, 802.1X authentication is attempted. If 802.1X
authentication is successful, the client is assigned an 802.1X authentication role. If 802.1X authentication
fails, the client is assigned a deny-all role ormac-auth-only role.

You can also configure the following authentication parameters for MAC+802.1X authentication:

n MAC authentication only—Allows you to create amac-auth-only role to allow role-based access rules
when MAC authentication is enabled for 802.1X authentication. Themac-auth-only role is assigned to a
client when the MAC authentication is successful and 802.1X authentication fails. If 802.1X
authentication is successful, themac-auth-only role is overwritten by the final role. Themac-auth-only
role is primarily used for wired clients.

n L2 authentication fall-through—Allows you to enable the l2-authentication-fallthrough mode. When
this option is enabled, the 802.1X authentication is allowed even if the MAC authentication fails. If this
option is disabled, 802.1X authentication is not allowed. The l2-authentication-fallthrough mode is
disabled by default.

Configuring MAC Authentication with 802.1X Authentication
To configure MAC authentication with 802.1X authentication for wireless network profile, configure the
following parameters:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWLANs tab, select a network profile for which you want to enable MAC and 802.1X
authentication and click the edit icon.

6. Turn on the Perform MAC Authentication Before 802.1X toggle switch to use 802.1X
authentication only when the MAC authentication is successful.

7. Turn on theMAC Authentication Fail Through toggle switch to use 802.1X authentication even
when the MAC authentication fails.

8. Click Save Settings.

Captive Portal Authentication
Captive portal authentication is used for authenticating guest users. For more information, see Configuring
Wireless Networks for Guest Users on Instant APs.

MAC Authentication with Captive Portal Authentication
The following conditions apply to a network profile with MAC authentication and Captive Portal
authentication enabled:

n If the captive portal splash page type is Internal-Authenticated or External-RADIUS Server, MAC
authentication reuses the server configurations.

n If the captive portal splash page type is Internal-Acknowledged or External-Authentication Text
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and MAC authentication is enabled, a server configuration page is displayed.
n If the captive portal splash page type isNone, MAC authentication is disabled.

The MAC authentication with captive portal authentication supports themac-auth-only role.

Configuring MAC Authentication with Captive Portal Authentication
To configure the MAC authentication with captive portal authentication for a network profile, complete the
following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWLANs tab, select an existing wireless profile for which you want to enable MAC
authentication with captive portal authentication, and then click the edit icon.

6. UnderAccess, specify the following parameters for a network with Role Based rules:

a. Turn on the Enforce Machine Authentication toggle switch, when MAC authentication is
enabled for captive portal. If the MAC authentication fails, the captive portal authentication role
is assigned to the client.

b. For wireless network profile, turn on the Enforce MAC Auth Only Role toggle switch, when
MAC authentication is enabled for captive portal. After successful MAC authentication, theMAC
Auth Only role is assigned to the client.

7. Click Next.

802.1X Authentication with Captive Portal Authentication
This authentication method allows you to configure different captive portal settings for clients on the same
SSID. For example, you can configure an 802.1X SSID and create a role for captive portal access, so that
some of the clients using the SSID derive the captive portal role. You can configure rules to indicate access to
external or internal Captive portal, or none.

For more information on configuring captive portal roles for an SSID with 802.1X authentication, see
Configuring Wireless Networks for Guest Users on Instant APs.

WISPr Authentication
WISPr authentication allows a smart client to authenticate on the network when they roam between
wireless Internet service providers, even if the wireless hotspot uses an ISP with whom the client may not
have an account.

If a hotspot is configured to use WISPr authentication in a specific ISP and a client attempts to access the
Internet at that hotspot, the WISPr AAA server configured for the ISP authenticates the client directly and
allows the client to access the network. If the client only has an account with a partner ISP, the WISPr AAA
server forwards the client’s credentials to the partner ISPs WISPr AAA server for authentication. When the
client is authenticated on the partner ISP, it is also authenticated on your hotspot own ISP as per their
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service agreements. The Instant AP assigns the default WISPr user role to the client when your ISP sends an
authentication message to the Instant AP.

Instant APs support the following smart clients:

n iPass
n Boingo

These smart clients enable client authentication and roaming between hotspots by embedding iPass
Generic Interface Specification (GIS) redirect, authentication, and logoff messages within HTML messages
that are sent to the Instant AP.

Configuring WISPr Authentication
To configure WISPr authentication, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click theWISPr accordion.
6. UnderWISPr, configure the following parameters:

n ISO Country Code—The ISO Country Code for the WISPr Location ID.
n E.164 Area Code—The E.164 Area Code for the WISPr Location ID.
n Operator Name—The operator name of the hotspot.
n E.164 Country Code—The E.164 Country Code for the WISPr Location ID.
n SSID/Zone—The SSID/Zone for the WISPr Location ID.
n Location Name—Name of the hotspot location. If no name is defined, the name of the Instant

AP, to which the user is associated, is used.

7. Click Save Settings.

The WISPr RADIUS attributes and configuration parameters are specific to the RADIUS server used by your
ISP for the WISPr authentication. Contact your ISP to determine these values. You can find a list of ISO and
ITU country and area codes at the ISO and ITU websites (www.iso.org and http://www.itu.int).

A Boingo smart client uses a NAS identifier in the format <CarrierID>_<VenueID> for location
identification. To support Boingo clients, ensure that you configure the NAS identifier parameter in the
RADIUS server profile for the WISPr server.

Walled Garden
On the Internet, a walled garden typically controls access to web content and services. The Walled garden
access is required when an external captive portal is used. For example, a hotel environment where the
unauthenticated users are allowed to navigate to a designated login page (for example, a hotel website) and
all its contents.

The users who do not sign up for the Internet service can view the allowed websites (typically hotel property
websites). The website names must be DNS-based and support the option to define wildcards. When a user

http://www.iso.org/
http://www.itu.int/
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attempts to navigate to other websites that are not in the whitelist of the walled garden profile, the user is
redirected to the login page. Instant AP supports Walled Garden only for the HTTP requests. For example, if
you add yahoo.com in Walled Garden whitelist and the client sends an HTTPS request (https://yahoo.com),
the requested page is not displayed and the users are redirected to the captive portal login page.

In addition, a blacklisted walled garden profile can also be configured to explicitly block the unauthenticated
users from accessing some websites.

Configuring Walled Garden Access
To configure walled garden access, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theWalled Garden accordion.
6. To allow access to a specific set of websites, click + underWhitelist, enter the domain name in the

window. This allows access to a domain while the user remains unauthenticated. Specify a POSIX
regular expression (regex(7)). For example:
n yahoo.com matches various domains such as news.yahoo.com, travel.yahoo.com and

finance.yahoo.com
n www.apple.com/library/test is a subset of www.apple.com site corresponding to path

/library/test/*
n favicon.ico allows access to /favicon.ico from all domains.

7. To deny users access to a domain, click + underBlacklist, and enter the domain name in the window.
This prevents the unauthenticated users from viewing specific websites. When a URL specified in the
blacklist is accessed by an unauthenticated user, Instant AP sends an HTTP 403 response to the client
with an error message.

8. Click Save Settings.

Support for Multiple PSK in WLAN SSID
Aruba Central allows you to configure multiple PSK (MPSK) in WLAN network profiles that include APs
running a minimum of Aruba Instant 8.4.0.0 firmware version and later. MPSK enhances the WPA2 PSK
mode by allowing device-specific or group-specific passphrases, which are generated by ClearPass Policy
Manager and sent to the Instant AP.

WPA2 PSK-based deployments generally consist of a single passphrase configured as part of the WLAN SSID
profile. This single passphrase is applicable for all clients that associate with the SSID. Starting from Aruba
Instant 8.4.0.0, multiple PSKs in conjunction with ClearPass Policy Manager are supported for WPA and
WPA2 PSK-based deployments. Every client connected to the WLAN SSID can have its own unique PSK.

A MPSK passphrase requires MAC authentication against a ClearPass Policy Manager server. The MPSK
passphrase works only with wpa2-psk-aes encryption and not with any other PSK-based encryption. The
Aruba-MPSK-Passphrase radius VSA is added and the ClearPass Policy Manager server populates this VSA
with the encrypted passphrase for the device.
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The workflow is as follows:

1. A user registers the device on a ClearPass Policy Manager guest-registration or device-registration
webpage and receives a device-specific or group-specific passphrase.

2. The device associates with the SSID using wpa2-psk-aes encryption and uses MPSK passphrase.
3. The Instant AP performs MAC authentication of the client against the ClearPass Policy Manager

server. On successful MAC authentication, the ClearPass Policy Manager returns Access-Accept with
the VSA containing the encrypted passphrase.

4. The Instant AP generates a PSK from the passphrase and performs 4-way key exchange.
5. If the device uses the correct per-device or per-group passphrase, authentication succeeds. If the

ClearPass Policy Manager server returns Access-Reject or the client uses incorrect passphrase,
authentication fails.

6. The Instant AP stores the MPSK passphrase in its local cache for client roaming. The cache is shared
between all the Instant APs within a single cluster. The cache can also be shared with standalone
Instant APs in a different cluster provided the APs belong to the same multicast VLAN. Each Instant
AP first searches the local cache for the MPSK information. If the local cache has the corresponding
MPSK passphrase, the Instant AP skips the MAC authentication procedure, and provides access to the
client.

When multiple PSK is enabled on the wireless SSID profile, make sure that MAC authentication is not configured
for RADIUS authentication. Multiple PSK and MAC authentication are mutually exclusive and follows a special
procedure which does not require enabling MAC authentication in the WLAN SSID manually. Also, ensure that
the RADIUS server configured for the wireless SSID profile is not an internal server.

Points to Remember
The following configurations are mutually exclusive with MPSK for the WLAN SSID profile and does not
require to be configured manually:

n MPSK and MAC authentication
n MPSK and Blacklisting
n MPSK and internal RADIUS server

Configuring Multiple PSK for Wireless Networks
To configure multiple PSK for wireless networks, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click WLANs tab.

The WLANs detail page is displayed.

5. Click + Add SSID to create a new SSID. To modify an existing SSID, select a wireless SSID from the
Wireless SSIDs table and then click the edit icon.

6. Click the Security tab.
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7. Select Personal from the Security Level. The authentication options applicable to the Enterprise
network are displayed.

8. From theKey Management drop-down list, select theMPSK-AES option.
9. From the Primary Server drop-down list, select a server. The radius server selected from the list is

the CPPM server.
10. Click Save Settings.

Enabling MPSK Local for Wireless Networks
To configure MPSK Local for wireless networks, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click WLANs tab.

The WLANs detail page is displayed.

5. Click + Add SSID to create a new SSID. To modify an existing SSID, select a wireless SSID from the
Wireless SSIDs table and then click the edit icon.

6. Click the Security tab.
7. Select Personal from the Security Level.

The authentication options applicable to the personal network are displayed.

8. From theKey Management drop-down list, select theMpsk Local option.
9. From theMpsk Local drop-down list, select an MPSK Local profile.

MPSK Local feature is supported for 8.7.0.0 or later versions. You cannot select an MPSK Local profile
from the Mpsk Local drop-down list if the AP version is less than 8.7.0.0.

10. Click Save Settings.

Configuring WPA3 Encryption
Aruba Central supports WPA3 encryption for security profiles in SSID creation for networks that include APs
running Aruba Instant 8.4.0.0 firmware version and above. The WPA3 security provides robust protection
with unique encryption per user session thereby ensuring a highly secured connection even on a public Wi-Fi
hotspot.

The following are the WPA3 encryptions based on the Enterprise, Personal, orOpen network types:

n WPA-3 Personal when the security level is Personal.
n Enhanced Open when the security level isOpen.

WPA3 Enterprise
WPA3-Enterprise enforces top secret security standards for an enterprise Wi-Fi in comparison to secret
security standards. Top secret security standards includes:
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n Deriving at least 384-bit PMK/MSK using Suite B compatible EAP-TLS.
n Securing pairwise data between STA and authenticator using AES-GCM-256.
n Securing group addressed data between STA and authenticator using AES-GCM-256.
n Securing group addressed management frames using BIP-GMAC-256.

Aruba Instant supports WPA3-Enterprise only in non-termination 802.1X and tunnel-forward modes. WPA3-
Enterprise compatible 802.1x authentication occurs between STA and CPPM.

WPA3-Enterprise advertises or negotiates the following capabilities in beacons, probes response, or 802.11
association:

n AKM Suite Selector as 00-0F-AC:12
n Pairwise Cipher Suite Selector as 00-0F-AC:9
n Group data cipher suite selector as 00-0F-AC:9
n Group management cipher suite (MFP) selector as 00-0F-AC:12

If WPA3-Enterprise is enabled, STA is successfully associated only if it uses one of the four suite selectors for
AKM selection, pairwise data protection, group data protection, and group management protection. If a STA
mismatches any one of the four suite selectors, the STA association fails.

Configuring WPA3 for Wireless Network
To configure WPA3 for enterprise security, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click WLANs tab.

The WLANs detail page is displayed.

5. Click + Add SSID to create a new SSID. To modify an existing SSID, select a wireless SSID from the
Wireless SSIDs table, and then click the edit icon.

6. Click the Security tab.
7. Select Enterprise from the Security Level.

The authentication options applicable to the Enterprise network are displayed.

8. Select one of the following from theKey Management drop-down list:
n WPA-3 Enterprise(GCM 256)—Select this option to use WPA-3 security employing GCM

encryption operation mode limited to encrypting 256 bits of plain text.
n WPA-3 Enterprise(CCM 128)—Select this option to use WPA-3 security employing CCM

encryption operation mode limited to encrypting 128 bits of plain text.

9. Click Save Settings.

Configuring WPA3 for Personal Security
To configure WPA3 for personal security, complete the following steps:
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1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click WLANs tab.

The WLANs detail page is displayed.

5. Click + Add SSID to create a new SSID. To modify an existing SSID, select a wireless SSID from the
Wireless SSIDs table and then click the edit icon.

6. Click the Security tab.
7. Select Personal from the Security Level.

The authentication options applicable to the Personal network are displayed.

8. Select WPA-3 Personal from theKey Management drop-down list.
9. Click Save Settings.

Authentication Servers for Instant APs
Based on the security requirements, you can configure internal or external RADIUS servers. This section
describes the types of authentication servers and authentication termination, that can be configured for a
network profile.

External RADIUS Server
In the external RADIUS server, the IP address of the VC is configured as the NAS IP address. Aruba Central
RADIUS is implemented on the VC, and this eliminates the need to configure multiple NAS clients for every
Instant AP on the RADIUS server for client authentication. Aruba Central RADIUS dynamically forwards all
the authentication requests from a NAS to a remote RADIUS server. The RADIUS server responds to the
authentication request with an Access-Accept orAccess-Reject message, and users are allowed or denied
access to the network depending on the response from the RADIUS server.

When you enable an external RADIUS server for the network, the client on the Instant AP sends a RADIUS
packet to the local IP address. The external RADIUS server then responds to the RADIUS packet.

Aruba Central supports the following external authentication servers:

n RADIUS
n LDAP

To use an LDAP server for user authentication, configure the LDAP server on the VC, and configure user IDs
and passwords.

To use a RADIUS server for user authentication, configure the RADIUS server on the VC.

RADIUS Server Authentication with VSA
An external RADIUS server authenticates network users and returns to the Instant AP the VSA that contains
the name of the network role for the user. The authenticated user is placed into the management role
specified by the VSA.

Internal RADIUS Server
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Each Instant AP has an instance of free RADIUS server operating locally. When you enable the internal
RADIUS server option for the network, the client on the Instant AP sends a RADIUS packet to the local IP
address. The internal RADIUS server listens and replies to the RADIUS packet.

The following authentication methods are supported in the Aruba Central network:

n EAP-TLS—The EAP-TLS method supports the termination of EAP-TLS security using the internal RADIUS
server. The EAP-TLS requires both server and CA certificates installed on the Instant AP. The client
certificate is verified on the virtual controller (the client certificate must be signed by a known CA), before
the username is verified on the authentication server.

n EAP-TTLS (MSCHAPv2)—The EAP-TTLS method uses server-side certificates to set up authentication
between clients and servers. However, the actual authentication is performed using passwords.

n EAP-PEAP (MSCHAPv2)—EAP-PEAP is an 802.1X authentication method that uses server-side public key
certificates to authenticate clients with server. The PEAP authentication creates an encrypted SSL / TLS
tunnel between the client and the authentication server. Exchange of information is encrypted and
stored in the tunnel ensuring the user credentials are kept secure.

n LEAP—LEAP uses dynamic WEP keys for authentication between the client and authentication server.

To use the internal database of an AP for user authentication, add the names and passwords of the users to
be authenticated.

Aruba does not recommend the use of LEAP authentication because it does not provide any resistance to
network attacks.

RADIUS Communication over TLS (RadSec)
RADIUS over TLS, also known as RadSec, is a RADIUS protocol that uses TLS protocol for end-to-end secure
communication between the RADIUS server and Instant AP. RadSec wraps the entire RADIUS packet
payload into a TLS stream. Enabling RadSec increases the level of security for authentication that is carried
out across the cloud network. When configured, this feature ensures that the RadSec protocol is used for
safely transmitting the authentication and accounting data between the Instant AP and the RadSec server.

The following conditions applies to RadSec configuration:

n The RADIUS packets go through the tunnel when TLS tunnel is established.
n By default, the TCP port 2083 is assigned for RadSec. Separate ports are not used for authentication,

accounting, and dynamic authorization changes.
n Aruba Central supports dynamic CoA (RFC 3576) over RadSec and the RADIUS server uses an existing TLS

connection opened by the Instant AP to send the request.
n By default, the Instant AP uses its device certificate to establish a TLS connection with RadSec server. You

can also upload your custom certificates on to Instant AP. For more information on uploading
certificates, see Certificates.

Authentication Termination on Instant AP
Aruba Central allows EAP termination for PEAP-Generic Token Card (PEAP-GTC) and Protected Extensible
Authentication Protocol-Microsoft Challenge Authentication Protocol version 2 (PEAP-MSCHAPv2). PEAP-
GTC termination allows authorization against an LDAP server and external RADIUS server while PEAP-
MSCHAPv2 allows authorization against an external RADIUS server.

This allows the users to run PEAP-GTC termination with their username and password to a local Microsoft
Active Directory server with LDAP authentication.
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n EAP-GTC—This EAP method permits the transfer of unencrypted usernames and passwords from client
to server. The EAP-GTC is mainly used for one-time token cards such as SecureID and the use of LDAP or
RADIUS as the user authentication server. You can also enable caching of user credentials on the Instant
AP to an external authentication server for user data backup.

n EAP-MSCHAPv2—This EAP method is widely supported by Microsoft clients. A RADIUS server must be
used as the back-end authentication server.

Dynamic Load Balancing between Authentication Servers
You can configure two authentication servers to serve as a primary and backup RADIUS server and enable
load balancing between these servers. Load balancing of authentication servers ensures that the
authentication load is split across multiple authentication servers and enables the Instant APs to perform
load balancing of authentication requests destined to authentication servers such as RADIUS or LDAP.

The load balancing in Instant AP is performed based on the outstanding authentication sessions. If there are
no outstanding sessions and if the rate of authentication is low, only primary server will be used. The
secondary is used only if there are outstanding authentication sessions on the primary server. With this, the
load balance can be performed across asymmetric capacity RADIUS servers without the need to obtain
inputs about the server capabilities from the administrators.

Configuring External Authentication Servers for APs
You can configure an external RADIUS server, TACACS, and LDAP server for user authentication. You can
configure guest network using External Captive Portal profile for external authentication.

To configure a server, complete the following procedure:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure APs are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details for the selected group or the device are displayed.

5. In theAuthentication Server panel, click + to create a new server.
6. Select any of the following server types and configure the parameters for your deployment scenario.

Type of Server Parameters

RADIUS

Name Name of the external RADIUS server.

IP Address IP address or the FQDN of the external RADIUS server.

Radsec Set Radsec to Enabled to enable secure communication
between the RADIUS server and Instant AP by creating a TLS
tunnel between the Instant AP and the server.

If Radsec is enabled, the following configuration options are

Table 111: Authentication Server Configuration
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Type of Server Parameters

displayed:
lRadsec Port—Communication port number for RadSec
TLS connection. By default, the port number is set to 2083.
lNAS Identifier
lNAS IP Address
lService Type Framed User
lQuery Status of RADIUS Servers (RFC 5997)
lDynamic Authorization

Auth Port Authorization port number of the external RADIUS server. The
default port number is 1812.

Accounting Port The accounting port number used for sending accounting
records to the RADIUS server. The default port number is 1813.

Shared Key and
Retype Shared
Key

Shared key for communicating with the external RADIUS server.

Timeout The timeout duration for one RADIUS request. The Instant AP
retries sending the request several times (as configured in the
Retry count) before the user is disconnected. For example, if
the Timeout is 5 seconds, Retry counter is 3, user is
disconnected after 20 seconds. The default value is 5 seconds.

Retry Count The maximum number of authentication requests that can be
sent to the server group by the Instant AP. You can specify a
value within the range of 1–5. The default value is 3 requests.

Dynamic
Authorization

To allow the APs to process RFC 3576-compliant CoA and
disconnect messages from the RADIUS server, select this check
box. Disconnect messages terminate the user session
immediately, whereas the CoA messages modify session
authorization attributes such as data filters. When you enable
the Dynamic Authorization option, the AirGroup CoA Port
field is displayed with the port number for sending Bonjour
support CoA on a different port than on the standard CoA port.
The default value is 5999.

NAS IP Address Enter the IP address.
lFor Instant AP-based cluster deployments, ensure that
you enter the VC IP address as the NAS IP address.

NAS Identifier Use this to configure strings for RADIUS attribute 32, NAS
Identifier, to be sent with RADIUS requests to the RADIUS
server.

Dead Time Specify a dead time for authentication server in minutes. When
two or more authentication servers are configured on the
Instant AP and a server is unavailable, the dead time
configuration determines the duration for which the
authentication server is available if the server is marked as
unavailable.

n If Dynamic RADIUS Proxy (DRP) is enabled on the APs,
configure the following parameters:
lDRP IP—IP address to be used as source IP for RADIUS
packets.
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Type of Server Parameters

lDRP MASK—Subnet mask of the DRP IP address.
lDRP VLAN—VLAN in which the RADIUS packets are
sent.
lDRP GATEWAY—Gateway IP address of the DRP VLAN.

Service Type
Framed User

Select any of the following check boxes to send the service type
as Framed User in the access requests to the RADIUS server:

l802.1X—Changes the service type to frame for 802.1X
authentication.
lMAC—Changes the service type to frame for MAC
authentication.
lCaptive Portal—Changes the service type to frame for
Captive Portal authentication.

Query Status of
RADIUS Servers
(RFC 5997)

Select any of the following check boxes to detect the server
status of the RADIUS server:

lAuthentication—Select this check-box to ensure the
Instant AP sends a status-server request to determine the
actual state of the authentication server before marking the
server as unavailable.
lAccounting—Select this check-box to ensure the Instant
AP sends a status-server request to determine the actual
state of the accounting server before marking the server as
unavailable.

LDAP

Name Name of the LDAP server.

IP Address IP address of the LDAP server.

Auth Port Authorization port number of the LDAP server. The default port
number is 389.

Admin-DN A distinguished name for the admin user with read and search
privileges across all the entries in the LDAP database (the
admin user need not have write privileges, but the admin user
must be able to search the database, and read attributes of
other users in the database).

Admin Password
and Retype
Admin Password

Password for the admin user.

Base-DN Distinguished name for the node that contains the entire user
database.

Filter The filter to apply when searching for a user in the LDAP
database. The default filter string is (objectclass=*).

Key Attribute The attribute to use as a key while searching for the LDAP
server. For Active Directory, the value is sAMAccountName.

Timeout Timeout interval within a range of 1–30 seconds for one
RADIUS request. The default value is 5.
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Type of Server Parameters

Retry Count The maximum number of authentication requests that can be
sent to the server group. You can specify a value within the
range of 1–5. The default value is 3.

TACACS

Name Name of the server.

Shared Key and
Retype Key

The secret key to authenticate communication between the
TACACS client and server.

Auth Port The TCP IP port used by the server. The default port number is
49.

Timeout A number between 1 and 30 seconds to indicate the timeout
period for TACACS+ requests. The default value is 20 seconds.

IP Address IP address of the server.

Retry Count The maximum number of authentication attempts to be
allowed. The default value is 3.

Dead Time (in
mins)

Specify a dead time for authentication server in minutes. When
two or more authentication servers are configured on the AP
and a server is unavailable, the dead time configuration
determines the duration for which the authentication server is
available if the server is marked as unavailable.

Session
Authorization

Enable this option to allow the authorization of sessions.

External Captive Portal—The external captive portal servers are used for
authenticating guest users in a WLAN.

Name Enter a name for the profile.

Type n Select any one of the following types of authentication:
lRadius Authentication—Select this option to enable
user authentication against a RADIUS server.
lAuthentication Text—Select this option to specify an
authentication text. The specified text will be returned by
the external server after a successful user authentication.

IP or Hostname Enter the IP address or the host name of the external splash
page server.

URL Enter the URL of the external captive portal server.

Port Enter the port number that is used for communicating with the
external captive portal server.

Use HTTPS Select this to enforce clients to use HTTPS to communicate with
the captive portal server. This option is available only if RADIUS
Authentication is selected.
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Type of Server Parameters

Captive Portal
Failure

This field allows you to configure Internet access for the guest
users when the external captive portal server is not available.
Select Deny Internet to prevent guest users from using the
network, or Allow Internet to access the network.

Server Offload Select the check box to enable the server offload feature. The
server offload feature ensures that the non-browser client
applications are not unnecessarily redirected to the external
captive portal server, thereby reducing the load on the external
captive portal server.

Prevent Frame
Overlay

Select this check box to prevent the overlay of frames. When
enabled, the frames display only those pages that are in the
same domain as the main page.

Automatic URL
Whitelisting

On enabling this for the external captive portal authentication,
the URLs that are allowed for the unauthenticated users to
access are automatically whitelisted.

Auth Text If the External Authentication splash page is selected, specify
the authentication text that is returned by the external server
after successful authentication. This option is available only if
Authentication Text is selected.

Redirect URL Specify a redirect URL if you want to redirect the users to
another URL.

Dynamic Authorization Only

Name Name of the server.

IP Address IP address of the server.

AirGroup CoA
Port

A port number for sending Bonjour support CoA on a different
port than on the standard CoA port. The default value is 5999.

Shared Key and
Retype Key

A shared key for communicating with the external RADIUS
server.
Change of Authorization(CoA) is a subset of Dynamic
Authorization include disconnecting messages.

7. Click Save.

To assign the authentication server to a network profile, select the newly added server when configuring
security settings for a wireless or wired network profile.

You can also add an external RADIUS server when configuring a WLAN SSID profile.

Configuring Users Accounts for the Instant AP
Management Interface
You can configure RADIUS or TACACS authentication servers to authenticate and authorize the
management users of an Instant AP. The authentication servers determine if the user has access to
administrative interface. The privilege level for different types of management users is defined on the
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RADIUS or TACACS server. The Instant APs map the management users to the corresponding privilege level
and provide access to the users based on the attributes returned by the RADIUS or TACACS server.

In Aruba Central, the Instant AP management user passwords are stored and displayed as hash instead of plain
text. The hash-mgmt-user command is enabled by default on the Instant APs provisioned in the template and
UI groups. If a pre-configured Instant AP joins Aruba Central and is moved to a new group, Aruba Central uses
the hash-mgmt-user configuration settings and discards mgmt-user configuration settings, if any, on the
Instant AP. In other words, Aruba Central hashes management user passwords irrespective of the management
user configuration settings running on an Instant AP.

To configure authentication parameters for local admin, read-only, and guest management administrator
account settings, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.
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5. Click theAdministrator accordion and configure the following parameters:

Type of
the User

Authentication
Options Steps to Follow

Client
Control

Internal In the Authentication drop-down list, select Internal if you want to
specify a single set of user credentials. If using an internal
authentication server:

1. In Username and Password, enter a username and
password.
2. In Retype Password, retype the password to confirm.

Authentication
Server

In the Authentication drop-down list, select the RADIUS or
TACACS authentication servers. You can also create a new server
by selecting New from the Authentication server drop-down list.

Authentication
Server with
fallback to
Internal

In the Authentication drop-down list, select Authentication
server w/ fallback to internal option if you want to use both
internal and external servers. When enabled, the authentication
switches to Internal if there is no response from the RADIUS server
(RADIUS server timeout).
To use this option, select the authentication servers and configure
the user credentials for internal server based authentication.

1. In Username and Password, enter a username and
password.
2. In Retype Password, retype the password to confirm.

Load Balancing If two servers are configured, the users can use them in the primary
or backup mode, or load balancing mode. To enable load balancing,
select Enabled from the Load balancing drop-down list. For more
information on load balancing, see Authentication Servers for
Instant APs.

TACACS
Accounting

If a TACACS server is selected, enable TACACS accounting to report
management commands, if required.

View Only To configure a user account with the read-only privileges:
1. In Username and Password, enter a username and
password.
2. In Retype Password, retype the password to confirm.

Guest
Registration
Only

To configure a guest user account with the read-only privileges:
1. In Username and Password, enter a username and
password.
2. In Retype Password, retype the password to confirm.

Table 112: Configuration Parameters for the Instant AP Users

6. Click Save Settings.

Configuring Guest and Employee User Profiles on Instant
APs
The local database of an Instant AP consists of a list of guest and employee users. The addition of a user
involves specifying a login credentials for a user. The login credentials for these users are provided outside
the Aruba Central system.

A guest user can be a visitor who is temporarily using the enterprise network to access the Internet.
However, if you do not want to allow access to the internal network and the Intranet, you can segregate the
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guest traffic from the enterprise traffic by creating a guest WLAN and specifying the required
authentication, encryption, and access rules.

An employee user is the employee who is using the enterprise network for official tasks. You can create
employee WLANs, specify the required authentication, encryption and access rules and allow the employees
to use the enterprise network.

The user database is also used when an Instant AP is configured as an internal RADIUS server.
The local user database of APs can support up to 512 user entries except IAP-92/93. IAP-92/93 supports only
256 user entries. If there are already 512 users, IAP-92/93 will not be able to join the cluster.

To configure users, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click User For Internal Server.
6. In theUsers pane, click the + icon.
7. In theAdd User window, enter the following information:

n In theUsername text-box, enter a username.
n In the Password text-box, enter the password.
n In theRetype text-box, retype the password to confirm.
n In the Type drop-down list, select a type of user from the drop-down list.
n Click OK.

8. To edit a user settings:

a. In theUsers pane, select the username to edit.

b. Click the edit icon to modify the user settings.

c. Click OK.

9. To delete a user:

a. In theUsers pane, select the username to delete.

b. Click the delete icon.

c. Click OK.

10. To delete all users, select Delete All in theUsers pane, and then click Yes.

Deleting a user only removes the user record from the user database, and will not disconnect the online user
associated with the username.

Configuring Intra VLAN Traffic Whitelist
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The Intra VLAN Traffic Whitelist is a global whitelist for all WLAN SSIDs and wired networks configured with
the feature. For servers to serve the network, you must add them to the Intra VLAN Traffic Whitelist using
their IP or MAC address. When you configure wired servers with their IP address or MAC address, the Instant
Access Point allows client traffic to the destination MAC addresses.

Configuring a Wired Server with the IP Address
To configure a wired server with the IP address, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click the Intra VLAN Traffic Whitelist accordion.
6. In theWired Server IPwindow, click + and enter the IP address of the server.
7. Click OK.
8. Click Save Settings.

To edit a wired server, select the IP address of the wired server in theWired Server IPwindow, and then
click the edit icon.

To delete a wired server, select the IP address of the wired server in theWired Server IPwindow, and then
click the delete icon.

Configuring a Wired Server with the MAC Address
To configure a wired server with the MAC address, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click the Intra VLAN Traffic Whitelist accordion.
6. In theWired Server MACwindow, click + and enter the MAC address of the server.
7. Click OK.
8. Click Save Settings.

To edit a wired server, select the IP address of the wired server in theWired Server MACwindow, and then
click the edit icon.

To delete a wired server, select the IP address of the wired server in theWired Server MACwindow, and
then click the delete icon.

The following figure shows the configuration options of a wired server with the IP address or MAC address:
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Figure 54 Intra VLAN Traffic Whitelist Configuration

Configuring an MPSK Local Profile
MPSK Local allows the user to configure 24 PSKs per SSID locally on the device. These local PSKs would serve
as an extension of the base MPSK functionality.

To configure an MPSK Local profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theMpsk Local accordion.
6. In theMPSK Local window, click + and enter a name for the MPSK Local profile.
7. To create an MPSK Local passphrase, enter the following information in theMpsk Local

Passphrase window:

a. Name—Enter a name.

b. Passphrase—Enter a passphrase.

c. Retype Passphrase—Retype the passphrase to confirm.

8. Click OK.
9. In theMpsk Local Passphrase window, select the MPSK Local passphrase name created in the

previous step, and then click OK.
10. Click Save Settings.

The following animation shows how to configure an MPSK Local profile:
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Configuring Roles and Policies on Instant APs for User
Access Control
Instant APs support identity-based access control to enforce application-layer security, prioritization, traffic
forwarding, and network performance policies for wired and wireless networks. Using the Instant AP firewall
policies, you can enforce network access policies to define access to the network, areas of the network that
the user may access, and the performance thresholds of various applications.

Instant APs supports a role-based stateful firewall. In other words, Instant firewall can recognize flows in a
network and keep track of the state of sessions. The firewall logs on the Instant APs are generated as syslog
messages. The firewall feature also supports ALG functions such as SIP, Vocera, Alcatel NOE, and Cisco
Skinny protocols.

ACL Rules
You can use ACL rules to either permit or deny data packets passing through the Instant AP. You can also
limit packets or bandwidth available to a set of user roles by defining access rules. By adding custom rules,
you can block or allow access based on the service or application, source or destination IP addresses.

You can create access rules to allow or block data packets that match the criteria defined in an access rule.
You can create rules for either inbound traffic or outbound traffic. Inbound rules explicitly allow or block the
inbound network traffic that matches the criteria in the rule. Outbound rules explicitly allow or block the
network traffic that matches the criteria in the rule. For example, you can configure a rule to explicitly block
outbound traffic to an IP address through the firewall.

The Instant AP clients are associated with user roles, which determine the client’s network privileges and the
frequency at which clients re-authenticate. Instant AP supports the following types of ACLs:

n ACLs that permit or deny traffic based on the source IP address of the packet.
n ACLs that permit or deny traffic based on source or destination IP address, or source or destination port

number.

You can configure up to 64 access control rules for a firewall policy.

Configuring Network Address Translation Rules
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NAT is the process of modifying network address information when packets pass through a routing device.
The routing device acts as an agent between the public (the Internet) and private (local network), which
allows translation of private network IP addresses to a public address space.

Instant AP supports the NAT mechanism to allow a routing device to use the translation tables to map the
private addresses into a single IP address and packets are sent from this address, so that they appear to
originate from the routing device. Similarly, if the packets are sent to the private IP address, the destination
address is translated as per the information stored in the translation tables of the routing device.

For more information, see:

n Configuring Network Service ACLs on page 367
n Configuring ACLs for Deep Packet Inspection
n Configuring User Roles for AP Clients
n Configuring Role Derivation Rules for AP Clients
n Configuring Firewall Parameters for Inbound Traffic

Configuring Network Service ACLs
To configure access rules for network services, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theRoles accordion.
6. UnderAccess Rules For Selected Roles, click + to add a new rule.

TheAccess Rule window is displayed.

7. UnderRule Type, select Access Control.
8. To configure access to applications or application categories, select a service category from the

following list:
n Network
n App Category
n Application
n Web Category
n Web Reputation
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9. Based on the selected service category, configure the following parameters:

Data Pane
Item Description

Rule Type Select a rule type from the list, for example Access Control.

Service Select a service from the list of available services. You can allow or deny access to any or
all of the following services based on your requirement:

n Any—Access is allowed or denied to all services.
n CUSTOM—Available options are TCP, UDP, and Other. If you select the TCP or UDP
options, enter appropriate port numbers. If you select the Other option, enter the
appropriate ID.

NOTE: If TCP and UDP uses the same port, ensure that you configure separate access
rules to permit or deny access.

Action Select any of following attributes:
n Select Allow to allow access users based on the access rule.
n Select Deny to deny access to users based on the access rule.
n Select Destination-NAT to allow the changes to destination IP address.
n Select Source-NAT to allow changes to the source IP address.

Destination Select a destination option. You can allow or deny access to any the following destinations
based on your requirements.

n To all destinations—Access is allowed or denied to all destinations.
n To a particular server—Access is allowed or denied to a particular server. After
selecting this option, specify the IP address of the destination server.
n Except to a particular server—Access is allowed or denied to servers other than
the specified server. After selecting this option, specify the IP address of the
destination server.
n To a network—Access is allowed or denied to a network. After selecting this option,
specify the IP address and netmask for the destination network.
n Except to a network—Access is allowed or denied to networks other than the
specified network. After selecting this option, specify the IP address and netmask of
the destination network.
n To a Domain Name—Access is allowed or denied to the specified domains. After
selecting this option, specify the domain name in the Domain Name text box.
n To AP IP—Traffic to the specified Instant AP is allowed. After selecting this option,
specify the domain name in the IP text box.
n To AP Network—Traffic to the specified Instant AP network is allowed. After
selecting this option, specify the domain name in the IP text box.
n To master IP—Traffic to the specified master Instant AP or virtual controller is
allowed. After selecting this option, specify the domain name in the IP text box.

Log Select Log to create a log entry when this rule is triggered. The Aruba Central firewall
supports firewall based logging. Firewall logs on the Instant APs are generated as security
logs.

Blacklist Select Blacklist to blacklist the client when this rule is triggered. The blacklisting lasts for
the duration specified as Auth failure blacklist time on the Blacklisting tab of the
Security window.

Classify
Media

Select Classify Media to prioritize video and voice traffic. When enabled, a packet
inspection is performed on all non-NAT traffic and the traffic is marked as follows:

n Video: Priority 5 (Critical)

Table 113: Access Rule Configuration Parameters
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Data Pane
Item Description

n Voice: Priority 6 (Internetwork Control)

Disable
Scanning

Select Disable Scanning to disable ARM scanning when this rule is triggered.
The selection of the Disable Scanning applies only if ARM scanning is enabled.

DSCP TAG Select DSCP TAGto specify a DSCP value to prioritize traffic when this rule is triggered.
Specify a value within the range of 0 to 63.

802.1p
priority

Select 802.1p priority to specify an 802.1 priority. Specify a value between 0 and 7.

Time
Range

Select this check box to allow a specific user to access the network for a specific time
range. You can select the time range profile from the drop-down list that appears when
the Time Range check box is selected.

Table 113: Access Rule Configuration Parameters

10. Click Save Settings.

Configuring User Roles for AP Clients
Every client in the Aruba Central network is associated with a user role, which determines the client’s
network privileges, the frequency of re-authentication, and the applicable bandwidth contracts. The user
role configuration on an Instant AP involves the following procedures:

n Creating a User Role
n Configuring User Roles for AP Clients

Creating a User Role
To create a user role, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theRoles accordion.
6. In theRoles pane, click +.
7. In theAdd Role window, enter a name for the new role in Roles, and then click OK.

You can also create a user role when configuring wireless profile. For more information, see Configuring
Wireless Network Profiles on Instant APs.

Assigning Bandwidth Contracts to User Roles
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The administrators can manage bandwidth utilization by assigning maximum bandwidth rates, or
bandwidth contracts to user roles. The administrator can assign a bandwidth contract configured in Kbps to
upstream (client to the Instant AP) or downstream (Instant AP to clients) traffic for a user role. The
bandwidth contract will not be applicable to the user traffic on the bridged out (same subnet) destinations.
For example, if clients are connected to an SSID, you can restrict the upstream bandwidth rate allowed for
each user to 512 Kbps.

By default, all users that belong to the same role share a configured bandwidth rate for upstream or
downstream traffic. The assigned bandwidth will be served and shared among all the users. You can also
assign bandwidth per user to provide every user a specific bandwidth within a range of 1 to 65535 Kbps. If
there is no bandwidth contract specified for a traffic direction, unlimited bandwidth is allowed.

To assign bandwidth contracts to a user role, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon.

The tabs to configure access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theRoles accordion.
6. Create a user role or select an existing role.
7. In theAccess Rues For Selected Roles pane, click +.
8. In theAccess Rule window, select Bandwidth Contract underRule Type.
9. Specify the downstream and upstream rates in Kbps. If the assignment is specific for each user, select

Per User.
10. Click Save. Associate the user role to a WLAN SSID or wired profile.

You can also create a user role and assign bandwidth contracts while configuring an SSID.

Configuring Role Derivation Rules for AP Clients
Aruba Central allows you to configure role and VLAN derivation-rules. You can configure these rules to
assign a user role or VLAN to the clients connecting to an SSID or a wired profile.

Creating a Role Derivation Rule
You can configure rules for determining the role that is assigned for each authenticated client.

When creating more than one role assignment rule, the first matching rule in the rule list is applied.

To create a role assignment rule, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.
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3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select a network profile and then click the edit icon.
6. Click theAccess tab.
7. UnderAccess rules, select Role Based to enable access based on user roles.
8. UnderRole Assignment Rules, click + Add Role Assignment. In New Role Assignment Rule,

define a match method by which the string in Operand is matched with the attribute value returned
by the authentication server.

9. Select the attribute from theAttribute list that the rule it matches against. The list of supported
attributes includes RADIUS attributes, dhcp-option, dot1x-authentication-type, mac-address, and
mac-address-and-dhcp-options.

10. Select the operator from theOperator list. The following types of operators are supported:
n contains—The rule is applied only if the attribute value contains the string specified in Operand.
n Is the role—The rule is applied if the attribute value is the role.
n equals—The rule is applied only if the attribute value is equal to the string specified in Operand.
n not-equals—The rule is applied only if the attribute value is not equal to the string specified in

Operand.
n starts-with—The rule is applied only if the attribute value starts with the string specified in

Operand.
n ends-with—The rule is applied only if the attribute value ends with string specified in Operand.
n matches-regular-expression—The rule is applied only if the attribute value matches the regular

expression pattern specified in Operand. This operator is available only if themac-address-and-
dhcp-options attribute is selected in theAttribute list. Themac-address-and-dhcp-options
attribute and matches-regular-expression are applicable only for WLAN clients.

11. Enter the string to match in the String box.
12. Select the appropriate role from theRole list.
13. Click Save.

Configuring VLAN Assignment Rule
To configure VLAN assignment rules for an SSID profile:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select a network profile and then click the edit icon.
6. Click theAccess tab.
7. Select the access rule fromAccess rules.
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8. In theAccess Rules For Selected Roles, click + Add Rule to add a new rule. TheAccess Rule page
is displayed.

The VLAN Assignment option is also listed in the Access Rule page when you create or edit a rule for
wired port profiles in the Ports > Create a New Network > Access tab.

9. From theRule Type drop-down list, select VLAN Assignment option.
10. Enter the VLAN ID in theVLAN ID field under Service section. Alternatively, you can select the VLAN

ID or the VLAN name from the drop-down list provided next to the VLAN ID field.

The VLAN name for a specific VLAN is available only after mapping the VLAN ID with the VLAN name in
the Systems > Named VLAN Mapping section. .

11. Click Save.

Configuring VLAN Derivation Rules
The users are assigned to a VLAN based on the attributes returned by the RADIUS server after users
authenticate.

To configure VLAN derivation rules for an SSID profile:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click theWLANs tab.

The WLANs details page is displayed.

5. In theWireless SSIDs table, select a network profile and then click the edit icon.
6. UnderVLANs, select Dynamic under Client VLAN Assignment.
7. Click + Add Rule to create a VLAN assignment rule. TheNew VLAN Assignment Rule window is

displayed. In this window, you can define a match method by which the string in Operand is matched
with the attribute values returned by the authentication server.

8. Select an attribute from theAttribute list.
9. Select an operator from theOperator list. The following types of operators are supported:

n contains—The rule is applied only if the attribute value contains the string specified in Operand.
n equals—The rule is applied only if the attribute value is equal to the string specified in Operand.
n not-equals—The rule is applied only if the attribute value is not equal to the string specified in

Operand.
n starts-with—The rule is applied only if the attribute value starts with the string specified in

Operand.
n ends-with—The rule is applied only if the attribute value ends with string specified in Operand.
n matches-regular-expression—The rule is applied only if the attribute value matches the regular

expression pattern specified in Operand. This operator is available only if themac-address-and-
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dhcp-options attribute is selected in theAttribute list. Themac-address-and-dhcp-options
attribute and matches-regular-expression are applicable only for the WLAN clients.

10. Enter the string to match in the String field.
11. Select the appropriate VLAN ID from VLAN. Ensure that all other required parameters are

configured.
12. Click OK.

Configuring Firewall Parameters for Wireless Network
Protection
To configure firewall settings, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theWireless IDS/IPS accordion.
6. Under Firewall Settings, turn on the toggle switch to enable SIP, VOCERA,ALCATEL NOE,Auto

Topology Rules, Restrict Corporate Access, and CISCO Skinny protocols.
7. Under Protection, in the Protection Against Wired Attacks section, enable the following options:

n Drop Bad ARP—Drops the fake ARP packets.
n Fix Malformed DHCP—Fixes the malformed DHCP packets.
n ARP Poison Check—Triggers an alert on ARP poisoning caused by the rogue APs.

Configuring Firewall Parameters for Inbound Traffic
Instant APs support an enhanced inbound firewall for the traffic that flows into the network through the
uplink ports of an Instant AP. You can configure firewall rules for the inbound traffic in the Security >
Inbound Firewall section.

To configure the firewall rules, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theWireless IDS/IPS accordion.
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6. Click Firewall Settings.
7. In theAccess Rule section, click the + icon.

The Inbound Firewall page is displayed.

8. In the Inbound Firewall page, enter the following information:

Parameter Description

Service Select a service from the list of available services. You can allow or deny
access to any or all of the services based on your requirement:

n Any—Access is allowed or denied to all services.
n Custom—Customize the access based on available options such as TCP,
UDP, and other options. If you select the TCP or UDP options, enter
appropriate port numbers. If the Other option is selected, ensure that an
appropriate ID is entered.

Action Select any of following actions:
n Select Allow to allow user access based on the access rule.
n Select Deny to deny user access based on the access rule.
n Select Destination-NAT to allow making changes to the destination IP
address and the port.
n Select Source-NAT to allow making changes to the source IP address.
The destination NAT and source NAT actions apply only to the network
services rules.

Source Select any of the following options:
n From all sources—Traffic from all sources is either allowed, denied, or
the IP address is translated at the source or the destination as defined in
the rule.
n From a particular host—Traffic from a particular host is either allowed,
denied, or the IP address is translated at the source or the destination as
defined in the rule. After selecting this option, specify the IP address of the
host.
n From a network—Traffic from a particular network is either allowed,
denied, or the IP address is translated at the source or the destination as
defined in the rule. After selecting this option, specify the IP address and
netmask of the source network.

Destination Select a destination option for the access rules for network services,
applications, and application categories. You can allow or deny access to any
the following destinations based on your requirements.

n To all destinations—Traffic for all destinations is allowed, denied, or
the IP address is translated at the source or the destination as defined in
the rule.
n To a particular server—Traffic to a specific server is allowed, denied, or
the IP address is translated at the source or the destination as defined in
the rule. After selecting this option, specify the IP address of the destination
server.
n Except to a particular server—Access is allowed or denied to servers
other than the specified server. After selecting this option, specify the IP
address of the destination server.
n To a network—Traffic to the specified network is allowed, denied, or the
IP address is translated at the source or the destination as defined in the
rule. After selecting this option, specify the IP address and netmask for the
destination network.
n Except to a network—Access is allowed or denied to networks other
than the specified network. After selecting this option, specify the IP
address and netmask of the destination network.

Table 114: Inbound Firewall Rule Configuration Parameters
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Parameter Description

n To a Domain name—Traffic to the specified domain is allowed, denied,
or the IP address is translated at the source or the destination as defined in
the rule. After selecting this option, specify the domain name in the
Domain Name text box.
n To AP IP—Traffic to the specified Instant AP is allowed. After selecting
this option, specify the domain name in the IP text box.
n To AP Network—Traffic to the specified Instant AP network is allowed.
After selecting this option, specify the domain name in the IP text box.
n To master IP—Traffic to the specified master Instant AP or virtual
controller is allowed. After selecting this option, specify the domain name in
the IP text box.

Log Select the Log check box if you want a log entry to be created when this rule is
triggered. Instant supports firewall-based logging function. Firewall logs on the
Instant APs are generated as security logs.

Blacklist Select the Blacklist check box to blacklist the client when this rule is triggered.
The blacklisting lasts for the duration specified in the Auth failure blacklist
time on the Blacklisting tab of the Security window.

Classify
Media

Select the Classify Media check box to classify and tag media on HTTPS traffic
as voice and video packets.

Disable
scanning

Select Disable scanning check box to disable ARM scanning when this rule is
triggered. The selection of Disable scanning applies only if ARM scanning is
enabled.

DSCP TAG Select the DSCP TAG check box to specify a DSCP value to prioritize traffic
when this rule is triggered. Specify a value within the range of 0–63. To assign
a higher priority, specify a higher value.

802.1p
priority

Select the 802.1p priority check box to specify an 802.1p priority. Specify a
value between 0 and 7. To assign a higher priority, specify a higher value.

Configuring Management Subnets
You can configure subnets to ensure that the Instant AP management is carried out only from these
subnets. When the management subnets are configured, Telnet, SSH, and UI access is restricted to these
subnets only.

To configure management subnets, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theWireless IDS/IPS accordion.
6. Click Firewall Settings.
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7. UnderManagement Subnets pane, to add a new management subnet, complete the following
steps:
n Enter the subnet address in Subnet.
n Enter the subnet mask in Mask.
n Click Add.

8. Click Save Settings.

Configuring Restricted Access to Corporate Network
You can configure restricted corporate access to block unauthorized users from accessing the corporate
network. When restricted corporate access is enabled, corporate access is blocked from the uplink port of
master Instant AP, including clients connected to a slave Instant AP.

To configure restricted corporate access, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theWireless IDS/IPS accordion.
6. Click Firewall Settings.
7. To restrict corporate access, turn on theRestrict Corporate Access toggle switch.
8. Click Save Settings.

Configuring ACLs for Deep Packet Inspection
To configure ACL rules for a user role for Deep Packet Inspection (DPI), complete the following procedure:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. Under Manage, click Devices > Access Points.
3. Click theConfig icon to display the AP configuration dashboard.
4. Click Show Advanced.
5. Click the Security tab.
6. UnderRoles, select the role for which you want to configure access rules.
7. UnderAccess Rules For Selected Roles, click + to add a new rule.
8. TheAccess Rule window is displayed.
9. UnderRule Type, select Access Control.

10. To configure access to applications or application categories, select a service category from the
following list:
n Network
n App Category
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n Application
n Web Category
n Web Reputation

11. Based on the selected service category, configure the following parameters:

Service
category Description

App
Category

Select the application categories to which you want to allow or deny access.

Application Select the applications to which you want to allow or deny access.

Application
Throttling

Application throttling allows you to set a bandwidth limit for an application and application
categories. For example, you can limit the bandwidth rate for video streaming
applications such as YouTube or Netflix, or assign a low bandwidth to high risk sites.
To specify a bandwidth limit:

1. Select the Application Throttling check box.
2. Specify the Downstream and Upstream rates in Kbps per user.

Action Select one of the following actions:
n Destination-NAT—Translation of the destination IP address of a packet entering
the network.
n Source-NAT—Used by internal users to access the internet.
n Allow—Select Allow to allow access users based on the access rule.
n Deny—Select Deny to deny access to users based on the access rule.

Destination Select a destination option for the access rules for network services, applications, and
application categories. You can allow or deny access to any the following destinations
based on your requirements.

n To all destinations— Access is allowed or denied to all destinations.
n To a particular server—Access is allowed or denied to a particular server. After
selecting this option, specify the IP address of the destination server.
n Except to a particular server—Access is allowed or denied to servers other than
the specified server. After selecting this option, specify the IP address of the
destination server.
n To a network—Access is allowed or denied to a network. After selecting this option,
specify the IP address and netmask for the destination network.
n Except to a network—Access is allowed or denied to networks other than the
specified network. After selecting this option, specify the IP address and netmask of
the destination network.
n To a Domain Name—Access is allowed or denied to the specified domains. After
selecting this option, specify the domain name in the Domain Name text box.
n To AP IP—Traffic to the specified Instant AP is allowed. After selecting this option,
specify the domain name in the IP text box.
n To AP Network—Traffic to the specified Instant AP network is allowed. After
selecting this option, specify the domain name in the IP text box.
n To master IP—Traffic to the specified master Instant AP or virtual controller is
allowed. After selecting this option, specify the domain name in the IP text box.

Log Select this check box if you want a log entry to be created when this rule is triggered.
Aruba Central supports firewall based logging. Firewall logs on the Instant APs are
generated as security logs.

Table 115: Access Rule Configuration Parameters
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Service
category Description

Blacklist Select the Blacklist check box to blacklist the client when this rule is triggered. The
blacklisting lasts for the duration specified as Auth failure blacklist time on the
Blacklisting tab of the Security window. .

Classify
Media

Select the Classify Media check box to classify and tag media on https traffic as voice
and video packets.

Disable
Scanning

Select Disable Scanning check box to disable ARM scanning when this rule is triggered.
The selection of the Disable Scanning applies only if ARM scanning is enabled.

DSCP Tag Select this check box to add a DSCP tag to the rule. DSCP is an L3 mechanism for
classifying and managing network traffic and providing QoS on the network. To assign a
higher priority, specify a higher value.

802.1p
priority

Select this check box to enable 802.1p priority. 802.1p priority is an L2 protocol for traffic
prioritization to manage QoS on the network. There are eight levels of priority, 0-7. To
assign a higher priority, specify a higher value.

Time
Range

Select this check box to enable user to access network for a specific time period. You can
select the time range profile from the drop-down list that appears when the Time Range
check box is selected..

Table 115: Access Rule Configuration Parameters

12. Click Save.

Configuring ACLs on APs for Website Content
Classification
You can configure web policy enforcement on an AP to block certain categories of websites based on your
organization specifications by defining ACL rules.

To configure ACLs for website content classification, follow the below procedure:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. Under Manage, click Devices > Access Points.
3. Click theConfig icon to display the AP configuration dashboard.
4. Click Show Advanced.
5. Click the Security tab.
6. UnderRoles, select the role to modify.
7. UnderAccess Rules For Selected Roles, click + to add a new rule.

TheAccess Rule window is displayed.

8. UnderRule Type, select Access Control.
9. To set an access policy based on web categories:

a. Under Service, select Web Category.

b. Select the categories to which you want to deny or allow access. You can also search for a web
category and select the required option.
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c. UnderAction, select Allow orDeny.

d. Click Save.

10. To filter access based on the security ratings of the website:

a. Select Web Reputation under Service.

b. Move the slider to select a specific web reputation value to deny access to websites with a
reputation value lower than or equal to the configured value or to permit access to websites with
a reputation value higher than or equal to the configured value. The following options are
available:
n Trustworthy WRI > 81—These are well known sites with strong security practices and may

not expose the user to security risks. There is a very low probability that the user will be
exposed to malicious links or payloads.

n Low Risk WRI 61-80—These are benign sites and may not expose the user to security risks.
There is a low probability that the user will be exposed to malicious links or payloads.

n Moderate WRI 41-60—These are generally benign sites, but may pose a security risk. There
is some probability that the user will be exposed to malicious links or payloads.

n Suspicious WRI 21-40—These are suspicious sites. There is a higher than average probability
that the user will be exposed to malicious links or payloads.

n High Risk WRI < 20—These are high risk sites. There is a high probability that the user will be
exposed to malicious links or payloads.

c. UnderAction, select Allow orDeny as required.

11. To set a bandwidth limit based on web category or web reputation score, select theApplication
Throttling check box and specify the downstream and upstream rates in Kbps. For example, you
can set a higher bandwidth for trusted sites and a low bandwidth rate for high risk sites.

12. If required, select the following check boxes:
n Log —Select this check box if you want a log entry to be created when this rule is triggered. Aruba

Central supports firewall based logging. Firewall logs on the Instant APs are generated as security
logs.

n Blacklist —Select this check box to blacklist the client when this rule is triggered. The blacklisting
lasts for the duration specified asAuth Failure Blacklist Time on theBlacklisting pane of the
Security window. For more information, see Blacklisting Instant AP Clients on page 384.

n Disable Scanning—Select Disable scanning check box to disable ARM scanning when this rule
is triggered. The selection of theDisable scanning applies only if ARM scanning is enabled, For
more information, see Configuring Radio Parameters on page 338.

n DSCP Tag—Select this check box to add a DSCP tag to the rule. DSCP is an L3 mechanism for
classifying and managing network traffic and providing QoS on the network. To assign a higher
priority, specify a higher value.

n 802.1p priority—Select this check box to enable 802.1p priority. 802.1p priority is an L2
protocol for traffic prioritization to manage QoS on the network. There are eight levels of priority,
0-7. To assign a higher priority, specify a higher value.

13. Click Save to save the rules.
14. Click Save Settings in theRoles pane to save the changes to the role for which you defined ACL

rules.
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In mixed versions of the groups, the application rule update is supported only at the VC level and not at the
group level. If you have a group with multiple Instant APs running 6.2.1.0-4.0 and if you upgrade one or more VC
to 6.2.1.0-4.1, you can configure application rules at the VC level, but not at the group level. To use application
rules at the group level, create a new group and move Instant APs running 6.2.1.0-4.1 to the newly created
group. If application rules are configured in this group, ensure that the Instant APs with versions lower than
6.2.1.0-4.1 are not moved to that group.

Configuring Custom Redirection URLs for Instant AP
Clients
You can create a list of URLs to redirect users to when they access blocked websites. You can define an
access rule to use these redirect URLs and assign the rule to a user role in the WLAN network.

Creating a List of Error Page URLs
To create a list of error page URLs, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. Under Manage, click Devices > Access Points.
3. Click theConfig icon to display the AP configuration dashboard.
4. Click Show Advanced.
5. Click the Security tab.
6. Under Custom Blocked Page URL, click + and enter the URL to block.
7. Repeat the procedure to add more URLs. You can add up to 8 URLs to the list of blocked web pages.
8. Click OK.

Configuring ACL Rules to Redirect Users to a Specific URL
To configure ACL rules to redirect users to a specific URL, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. Under Manage, click Devices > Access Points.
3. Click theConfig icon to display the AP configuration dashboard.
4. Click Show Advanced.
5. Click the Security tab.
6. UnderRoles, select the role for which you want to configure access rules.
7. Click + in the Access Rules section. TheNew Rule window is displayed.
8. Select the rule type asBlocked Page URL.
9. Select the URLs from the existing list of custom redirect URLs. To add a new URL, click +.

10. Click Save.

Configuring Firewall Parameters for Inbound Traffic
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Instant APs support an enhanced inbound firewall for the traffic that flows into the network through the
uplink ports of an Instant AP.

To configure the firewall rules, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theWireless IDS/IPS accordion.
6. Click Firewall Settings.
7. In theAccess Rule section, click the + icon.

The Inbound Firewall page is displayed.
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8. In the Inbound Firewall page, enter the following information:

Parameter Description

Service Select a service from the list of available services. You can allow or
deny access to any or all of the services based on your requirement:

n Any—Access is allowed or denied to all services.
n Custom—Customize the access based on available options such
as TCP, UDP, and other options. If you select the TCP or UDP
options, enter appropriate port numbers. If the Other option is
selected, ensure that an appropriate ID is entered.

Action Select any of following actions:
n Select Allow to allow user access based on the access rule.
n Select Deny to deny user access based on the access rule.
n Select Destination-NAT to allow making changes to the
destination IP address and the port.
n Select Source-NAT to allow making changes to the source IP
address. The destination NAT and source NAT actions apply only to
the network services rules.

Source Select any of the following options:
n From all sources—Traffic from all sources is either allowed,
denied, or the IP address is translated at the source or the
destination as defined in the rule.
n From a particular host—Traffic from a particular host is either
allowed, denied, or the IP address is translated at the source or the
destination as defined in the rule. After selecting this option, specify
the IP address of the host.
n From a network—Traffic from a particular network is either
allowed, denied, or the IP address is translated at the source or the
destination as defined in the rule. After selecting this option, specify
the IP address and netmask of the source network.

Destination Select a destination option for the access rules for network services,
applications, and application categories. You can allow or deny access
to any the following destinations based on your requirements.

n To all destinations—Traffic for all destinations is allowed,
denied, or the IP address is translated at the source or the
destination as defined in the rule.
n To a particular server—Traffic to a specific server is allowed,
denied, or the IP address is translated at the source or the
destination as defined in the rule. After selecting this option, specify
the IP address of the destination server.
n Except to a particular server—Access is allowed or denied to
servers other than the specified server. After selecting this option,
specify the IP address of the destination server.
n To a network—Traffic to the specified network is allowed,
denied, or the IP address is translated at the source or the
destination as defined in the rule. After selecting this option, specify
the IP address and netmask for the destination network.
n Except to a network—Access is allowed or denied to networks
other than the specified network. After selecting this option, specify
the IP address and netmask of the destination network.
n To a Domain name—Traffic to the specified domain is allowed,
denied, or the IP address is translated at the source or the
destination as defined in the rule. After selecting this option, specify
the domain name in the Domain Name text box.

Table 116: Inbound Firewall Rule Configuration Parameters
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Parameter Description

n To AP IP—Traffic to the specified Instant AP is allowed. After
selecting this option, specify the domain name in the IP text box.
n To AP Network—Traffic to the specified Instant AP network is
allowed. After selecting this option, specify the domain name in the
IP text box.
n To master IP—Traffic to the specified master Instant AP or
virtual controller is allowed. After selecting this option, specify the
domain name in the IP text box.

Log Select the Log check box if you want a log entry to be created when this
rule is triggered. Instant supports firewall-based logging function.
Firewall logs on the Instant APs are generated as security logs.

Blacklist Select the Blacklist check box to blacklist the client when this rule is
triggered. The blacklisting lasts for the duration specified in the Auth
failure blacklist time on the Blacklisting tab of the Security window.

Classify
Media

Select the Classify Media check box to classify and tag media on
HTTPS traffic as voice and video packets.

Disable
scanning

Select Disable scanning check box to disable ARM scanning when this
rule is triggered. The selection of Disable scanning applies only if ARM
scanning is enabled.

DSCP TAG Select the DSCP TAG check box to specify a DSCP value to prioritize
traffic when this rule is triggered. Specify a value within the range of 0–
63. To assign a higher priority, specify a higher value.

802.1p
priority

Select the 802.1p priority check box to specify an 802.1p priority.
Specify a value between 0 and 7. To assign a higher priority, specify a
higher value.

9. Click Ok.
10. Click Save Settings.

For all subnets, a deny rule is created by default as the last rule. If at least one rule is configured, the deny all
rule is applied to the upstream traffic by default. The inbound firewall is not applied to traffic coming through
the GRE tunnel.

Configuring Restricted Access to Corporate Network
You can configure restricted corporate access to block unauthorized users from accessing the corporate
network. When restricted corporate access is enabled, corporate access is blocked from the uplink port of
master Instant AP, including clients connected to a slave Instant AP.

To configure restricted corporate access, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.
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3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theWireless IDS/IPS accordion.
6. Click Firewall Settings.
7. To restrict corporate access, turn on theRestrict Corporate Access toggle switch.
8. Click Save Settings.

Enabling ALG Protocols on Instant APs
To configure protocols for ALG, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theWireless IDS/IPS accordion.

6. Under Firewall Settings, set the toggle button against the corresponding protocol to enable SIP,
VOCERA,ALCATEL NOE,Auto Topology Rules, Restrict Corporate Access, and CISCO Skinny
protocols.

7. Click Save Settings.

When the protocols for the ALG are disabled, the changes do not take effect until the existing user sessions
have expired. Reboot the Instant AP and the client, or wait a few minutes for changes to take effect.

Blacklisting Instant AP Clients
The client blacklisting denies connection to the blacklisted clients. When a client is blacklisted, it is not
allowed to associate with an Instant AP in the network. If a client is connected to the network when it is
blacklisted, a deauthentication message is sent to force client disconnection.

Blacklisting Clients Manually
Manual blacklisting adds the MAC address of a client to the blacklist. These clients are added into a
permanent blacklist. These clients are not allowed to connect to the network unless they are removed from
the blacklist.

To add a client to the blacklist manually, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.
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2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theBlacklisting accordion.
6. UnderManual Blacklisting, click + and enter the MAC address of the client to be blacklisted.
7. Click OK.
8. Click Save Settings.

To delete a client from the manual blacklist, select the MAC Address of the client under theManual
Blacklisting, and then click the delete icon.

For the blacklisting to take effect, you must enable the blacklisting option when you create or edit the WLAN
SSID profile. Go to WLANs > Security > Advanced Settings and enable the Blacklisting option. For more
information, see Configuring Wireless Network Profiles on Instant APs.

Blacklisting Clients Dynamically
The clients can be blacklisted dynamically when they exceed the authentication failure threshold or when a
blacklisting rule is triggered as part of the authentication process.

When a client takes time to authenticate and exceeds the configured failure threshold, it is automatically
blacklisted by an Instant AP.

In session firewall based blacklisting, an ACL rule automates blacklisting. When the ACL rule is triggered, it
sends out blacklist information and the client is blacklisted.

To configure the blacklisting duration, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theBlacklisting accordion.
6. UnderDynamic Blacklisting, enter the following information:

a. ForAuth Failure Blacklist Time, enter the duration after which the clients that exceed the
authentication failure threshold must be blacklisted.

b. For Policy Enforcement Failure Rule Blacklisted Time, enter the duration after which the
clients can be blacklisted due to an ACL rule trigger.

7. Click Save Settings.
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You can configure a maximum number of authentication failures by the clients, after which a client must be
blacklisted. For more information on configuring maximum authentication failure attempts, see Configuring
Wireless Network Profiles on Instant APs.
To enable session-firewall-based blacklisting, select the Blacklist check box in the Access Rule page during the
WLAN SSID profile creation. For more information, see Configuring Network Service ACLs.

Configuring Instant APs for VPN Services
This section describes the following VPN configuration procedures:

n Instant AP VPN Overview
n Configuring Instant APs for VPN Tunnel Creation
n Configuring Routing Profiles for Instant AP VPN

Instant AP VPN Overview
As Instant APs use a virtual controller architecture, the Instant AP network does not require a physical
controller to provide the configured WLAN services. However, a physical controller is required for
terminating VPN tunnels from the Instant AP networks at branch locations or data centers, where the Aruba
controller acts as a VPN Concentrator.

When the VPN is configured, the Instant AP acting as the virtual controller creates a VPN tunnel to Aruba
Mobility Controller in your corporate office. The controller acts as a VPN endpoint and does not supply the
Instant AP with any configuration.

The VPN features are recommended for:

n Enterprises with many branches that do not have a dedicated VPN connection to the corporate office.
n Branch offices that require multiple APs.
n Individuals working from home, connecting to the VPN.

Supported VPN Protocols
Instant APs support the following VPN protocols for remote access:

VPN Protocol Description

Aruba IPsec IPsec is a protocol suite that secures IP communications by authenticating and encrypting
each IP packet of a communication session.
You can configure an IPsec tunnel to ensure that to ensure that the data flow between the
networks is encrypted. However, you can configure a split-tunnel to encrypt only the corporate
traffic.
When IPsec is configured, ensure that you add the Instant AP MAC addresses to the whitelist
database stored on the controller or an external server. IPsec supports Local, L2, and L3
modes of IAP-VPN operations.

NOTE: The Instant APs support IPsec only with Aruba Controllers.

Table 117: VPN Protocols
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VPN Protocol Description

Layer-2 (L2)
GRE

GRE is a tunnel protocol for encapsulating multicast, broadcast, and L2 packets between a
GRE-capable device and an endpoint. Instant APs support the configuration of L2 GRE
(Ethernet over GRE) tunnel with an Aruba Controller to encapsulate the packets sent and
received by the Instant AP.
You can use the GRE configuration for L2 deployments when there is no encryption
requirement between the Instant AP and controller for client traffic.
Instant APs support two types of GRE configuration:

n Manual GRE—The manual GRE configuration sends unencrypted client traffic with an
additional GRE header and does not support failover. When manual GRE is configured on
the Instant AP, ensure that the GRE tunnel settings are enabled on the controller.
n Aruba GRE—With Aruba GRE, no configuration on the controller is required except for
adding the Instant AP MAC addresses to the whitelist database stored on the controller or
an external server. Aruba GRE reduces manual configuration when Per-AP Tunnel
configuration is required and supports failover between two GRE endpoints.

NOTE: Instant APs support manual and Aruba GRE configuration only for L2 mode of
operations. Aruba GRE configuration is supported only with Aruba Controllers.

L2TP The L2TP version 3 feature allows Instant AP to act as L2TP Access Concentrator (LAC) and
tunnel all wireless clients L2 traffic from AP to LNS. In a centralized L2 model, the VLAN on the
corporate side are extended to remote branch sites. Wireless clients associated with Instant
AP gets the IP address from the DHCP server running on LNS. For this, AP has to transparently
allow DHCP transactions through the L2TPv3 tunnel.

Table 117: VPN Protocols

Configuring Instant APs for VPN Tunnel Creation
Instant AP supports the configuration of tunneling protocols such as GRE, IPsec, and L2TPv3. This section
describes the procedure for configuring VPN host settings on an Instant AP to enable communication with a
controller in a remote location:

n Configuring IPsec VPN Tunnel
n Configuring Automatic GRE VPN Tunnel
n Configuring a GRE VPN Tunnel
n Configuring an L2TPv3 VPN Tunnel

Configuring IPsec VPN Tunnel
An IPsec tunnel is configured to ensure that the data flow between the networks is encrypted. When
configured, the IPsec tunnel to the controller secures corporate data. You can configure an IPsec tunnel
from virtual controller using Aruba Central.

To configure an IPsec tunnel from virtual controller, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.
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4. Click Show Advanced, and click theVPN tab.

The VPN details page is displayed.

5. Click theController accordion.
6. In the Protocol drop-down list, select Aruba IPsec.
7. In the Primary host field, enter the IP address or FQDN for the main VPN/IPsec endpoint.
8. In theBackup host field, enter the IP address or FQDN for the backup VPN/IPsec endpoint. This

entry is optional. When you enter the primary host IP address and backup host IP address, other
fields are displayed.

9. Specify the following parameters.

a. To allow the VPN tunnel to switch back to the primary host when it becomes available again,
select the Preemption check-box. This step is optional. If Preemption is enabled, specify a
value in seconds forHold time. When preemption is enabled and the primary host comes up,
the VPN tunnel switches to the primary host after the specified hold-time. The default value for
Hold time is 600 seconds.

b. To allow the Instant AP to create a backup VPN tunnel to the controller along with the primary
tunnel, and maintain both the primary and backup tunnels separately, select the Fast Failover
check-box. When fast failover is enabled and if the primary tunnel fails, the Instant AP can switch
the data stream to the backup tunnel. This reduces the total failover time to less than one
minute.

c. Specify a value in seconds for Secs Between Test Packets. Based on the configured
frequency, the Instant AP can verify if an active VPN connection is available. The default value is 5
seconds, which means that the Instant AP sends one packet to the controller every 5 seconds.

d. Enter a value forMax Allowed Test Packet Loss, to define a number for lost packets, after
which the Instant AP can determine that the VPN connection is unavailable. The default value is
2.

e. To disconnect all wired and wireless users when the system switches during VPN tunnel transition
from primary to backup and backup to primary, select theReconnect User On Failover check-
box.

f. To configure an interval for which wired and wireless users are disconnected during a VPN tunnel
switch, specify a value in seconds forReconnect Time On Failover within a range of 30-900
seconds. By default, the reconnection duration is set to 60 seconds. TheReconnect Time on
Failover field is displayed only when Reconnect User On Failover is enabled.

10. When the IPsec tunnel configuration is completed, the packets that are sent from and received by an
Instant AP are encrypted.

11. Click Save Settings.

You will be unable to upload the self-signed certificate from Aruba Central. You must upload the self-signed
certificate to Aruba Activate followed by the AP reboot procedure. When the AP contacts Aruba Activate, the
Aruba Activate informs the AP about the self-signed AP certificate that is required to be downloaded. The AP
then installs a new certificate before connecting to Aruba Central. For more information, see Aruba Activate User
Guide.

Configuring Automatic GRE VPN Tunnel
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In Aruba Central, you can configure an Instant AP to automatically set up a GRE tunnel from the Instant AP
to the controller.

To configure an Instant AP to automatically set up a GRE tunnel, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click theVPN tab.

The VPN details page is displayed.

5. Click theController accordion.
6. In the Protocol drop-down list, select Aruba GRE.
7. In the Primary host field, enter the IP address or FQDN for the main VPN/IPsec endpoint.
8. In theBackup host field, enter the IP address or FQDN for the backup VPN/IPsec endpoint. This

entry is optional. When you enter the primary host IP address and backup host IP address, other
fields are displayed.

9. Specify the following parameters:

a. To allow the VPN tunnel to switch back to the primary host when it becomes available again,
select the Preemption check-box. This step is optional. If Preemption is enabled, specify a
value in seconds forHold time. When preemption is enabled and the primary host comes up,
the VPN tunnel switches to the primary host after the specified hold time. The default value for
Hold time is 600 seconds.

b. To allow the Instant AP to create a backup VPN tunnel to the controller along with the primary
tunnel, and maintain both the primary and backup tunnels separately, select the Fast Failover
check-box. If the primary tunnel fails, the Instant AP can switch the data stream to the backup
tunnel. This reduces the total failover time to less than one minute.

c. To disconnect all wired and wireless users when the system switches during VPN tunnel
transition from primary to backup and backup to primary, select theReconnect User On
Failover.

d. To configure an interval for which wired and wireless users are disconnected during a VPN tunnel
switch, specify a value in seconds forReconnect Time On Failover within the range of 30-90
seconds. By default, the reconnection duration is set to 60 seconds.

e. Specify a value in seconds for Seconds Between Test Packets. Based on the configured
frequency, the Instant AP can verify if an active VPN connection is available. The default value is
5 seconds, which means that the Instant AP sends one packet to the controller every 5 seconds.

f. Enter a value forMax Allowed Test Packet Loss, to define a number for lost packets, after
which the Instant AP can determine that the VPN connection is unavailable. The default value is
2.

g. Select the Per-AP-Tunnel check-box. The administrator can enable this option to create a GRE
tunnel from each Instant AP to the VPN/GRE Endpoint rather than the tunnels created just from
the master Instant AP. When enabled, the traffic to the corporate network is sent through a
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Layer-2 GRE tunnel from the Instant AP itself and need not be forwarded through the master
Instant AP.

10. Click Save Settings.

Configuring a GRE VPN Tunnel
You can also manually configure a GRE tunnel by configuring the GRE tunnel parameters on the Instant AP
and controller. This procedure describes the steps involved in the manual configuration of a GRE tunnel
from virtual controller by using Aruba Central.

During the manual GRE setup, you can either use the virtual controller IP or the Instant AP IP to create the
GRE tunnel at the controller side depending upon the following Instant AP settings:

n If a virtual controller IP is configured and if Per-AP tunnel is disabled, the virtual controller IP is used to
create the GRE tunnel.

n If a virtual controller IP is not configured or if Per-AP tunnel is enabled, the Instant AP IP is used to create
the GRE tunnel.

To configure the GRE tunnel manually, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click theVPN tab.

The VPN details page is displayed.

5. Click theController accordion.
6. In the Protocol drop-down list, select Manual GRE.
7. Specify the following parameters:

a. Host—Enter the IPv4 or IPv6 address or FQDN for the main VPN/GRE tunnel.

b. Backup Host—(Optional) Enter the IPv4 or IPv6 address or FQDN for the backup VPN/GRE
tunnel. You can edit this field only after you enter the IP address or FQDN in theHost field.

c. Reconnect User On Failover—When you enter the host IP address and backup host IP
address, this field appears. Select this check box to disconnect all wired and wireless users when
the system switches during VPN tunnel transition from primary to backup and backup to
primary.

d. Reconnect Time On Failover—If you select theReconnect User On Failover check box, this
field appears. To configure an interval for which wired and wireless users must be disconnected
during a VPN tunnel switch, specify a value within a range of 30-90 seconds. By default, the
reconnection duration is set to 60 seconds.

e. GRE Type—Enter a value for the parameter.
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f. GRE MTU—Specify a size for theGRE MTU within the range of 1024–1500. After GRE
encapsulation, if packet length exceeds the configured MTU, IP fragmentation occurs. The
default MTU size is 1300.

g. Per-AP-Tunnel—The administrator can enable this option to create a GRE tunnel from each
Instant AP to the VPN/GRE endpoint rather than the tunnels created just from the master
Instant AP. When enabled, the traffic to the corporate network is sent through a Layer-2 GRE
tunnel from the Instant AP itself and need not be forwarded through the master Instant AP.

By default, the Per-AP tunnel option is disabled.

h. To disconnect all wired and wireless users when the system switches during VPN tunnel
transition from primary to backup and backup to primary, select theReconnect User On
Failover.

8. When the GRE tunnel configuration is completed on both the Instant AP and Controller, the packets
sent from and received by an Instant AP are encapsulated, but not encrypted.

Configuring an L2TPv3 VPN Tunnel
The Layer 2 Tunneling Protocol version 3 (L2TPv3) feature allows Instant AP to act as L2TP Access
Concentrator (LAC) and tunnel all wireless clients L2 traffic from AP to LNS. In a centralized L2 model, the
VLAN on the corporate side are extended to remote branch sites. Wireless clients associated with Instant AP
gets the IP address from the DHCP server running on LNS. For this, AP has to transparently allow DHCP
transactions through the L2TPv3 tunnel.

To configure an L2TPv3 tunnel by using Aruba Central, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click theVPN tab.

The VPN details page is displayed.

5. Click theController accordion.
6. In the Protocol drop-down list, select L2TPv3.
7. To configure a tunnel profile, complete the following steps:

a. Turn on the Enable Tunnel Profile toggle switch.

b. Enter the profile name.

c. Enter the primary server IP address.

d. Enter the remote end backup tunnel IP address. This is an optional field and is required only
when backup server is configured.

e. Enter the peer UDP and local UDP port numbers. The default value is 1701.
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f. Enter the interval at which the hello packets are sent through the tunnel. The default value is 60
seconds.

g. Select the message digest as MD5 or SHA used for message authentication.

h. Enter a shared key for the message digest. This key should match with the tunnel end point
shared key.

i. If required, set the failover mode. The following two failover modes are supported:
n Preemptive—In this mode, if the primary comes up when the backup is active, the backup

tunnel is deleted and the primary tunnel resumes as an active tunnel. If you configure the
tunnel to be preemptive, and when the primary tunnel goes down, it starts the persistence
timer which tries to bring up the primary tunnel.

n Non-Preemptive—In this mode, when the backup tunnel is established after the primary
tunnel goes down, it does not make the primary tunnel active again.

n Set an interval between every failover retry. The default value is 60 seconds.

j. Configure a number of retries before the tunnel fails over.

k. Ensure that Checksum is disabled.

l. Specify a value for the tunnel MTU value if required. The default value is 1460.

m. Click Save Settings.

Configuring Routing Profiles for Instant AP VPN
Aruba Central can terminate a single VPN connection on Aruba Mobility Controller. The routing profile
defines the corporate subnets which need to be tunneled through IPsec.

You can configure routing profiles to specify a policy based on routing into the VPN tunnel.

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click theVPN tab.

The VPN details page is displayed.

5. Click theRouting accordion.
6. Click + in theRouting pane.

TheNew Route page with the route parameters is displayed.

7. Update the following parameters:
n Destination—Specify the destination network that is reachable through the VPN tunnel. This

defines the IP or subnet that must reach through the IPsec tunnel. Traffic to the IP or subnet
defined here will be forwarded through the IPsec tunnel.

n Netmask—Specify the subnet mask to the destination defined forDestination.
n Gateway—Specify the gateway to which traffic must be routed. In this field, enter one of the

following based on the requirement:
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l The controller IP address on which the VPN connection will be terminated. If you have a primary and
backup host, configure two routes with the same destination and netmask, but ensure that the
gateway is the primary controller IP for one route and the backup controller IP for the second route.

l The "tunnel" string if you are using the Instant AP in Local mode during local DHCP configuration.
n Metric—Specify the best optimal path for routing traffic. A value of 1 indicates the best path, 15

indicates the worst path, and 16 indicates that the destination is unreachable on the route.

8. Click OK.
9. Click Save Settings.

Configuring DHCP Pools and Client IP Assignment
Modes on Instant APs
This section provides the following information:

n Configuring DHCP Scopes on Instant APs
n Configuring DHCP Server for Assigning IP Addresses to Instant AP Clients

Configuring DHCP Scopes on Instant APs
The VC supports the following types of DHCP address assignments:

n Configuring Distributed DHCP Scopes on page 393
n Configuring a Centralized DHCP Scope on page 395
n Configuring Local DHCP Scopes on page 398

Configuring Distributed DHCP Scopes
Aruba Central allows you to configure the DHCP address assignment for the branches connected to the
corporate network through VPN. You can configure the range of DHCP IP addresses used in the branches
and the number of client addresses allowed per branch. You can also specify the IP addresses that must be
excluded from those assigned to clients, so that they are assigned statically.

Aruba Central supports the following distributed DHCP scopes:

n Distributed, L2—In this mode, the VC acts as the DHCP server, but the default gateway is in the data
center. Based on the number of clients specified for each branch, the range of IP addresses is divided.
Based on the IP address range and client count configuration, the DHCP server in the VC controls a scope
that is a subset of the complete IP Address range for the subnet distributed across all the branches. This
DHCP Assignment mode is used with the L2 forwarding mode.

n Distributed, L3—In this mode, the VC acts as the DHCP server and the default gateway. Based on the
number of clients specified for each branch, the range of IP addresses is divided. Based on the IP address
range and client count configuration, the DHCP server in the VC is configured with a unique subnet and a
corresponding scope.

To configure distributed DHCP scopes such as Distributed, L2 or Distributed, L3, complete the following
steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.
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2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click theDHCP accordion.
6. To configure distributed DHCP scope, click + underDistributed DHCP Scopes.

TheNew Distributed DHCP Scopes pane is displayed.

7. Based on the type of distributed DHCP scope, configure the following parameters:

Data pane
item Description

Name Enter a name for the DHCP scope.

Type Select any of the following options:
n Distributed, L2—On selecting Distributed, L2, the VC acts as the DHCP Server
but the default gateway is in the data center. Traffic is bridged into VPN tunnel.
n Distributed, L3—On selecting Distributed, L3, the VC acts as both DHCP
Server and default gateway. Traffic is routed into the VPN tunnel.

VLAN Specify a VLAN ID. To use this subnet, ensure that the VLAN ID specified here is
assigned to an SSID profile.

Netmask If Distributed, L2 is selected for type of DHCP scope, specify the subnet mask. The
subnet mask and the network determine the size of subnet.

Default Router If Distributed, L2 is selected for type of DHCP scope, specify the IP address of the
default router.

DNS Server If required, specify the IP address of a DNS server.

Domain Name If required, specify the domain name.

Lease Time Specify a lease time for the client in minutes.

IP
Address Range

Specify a range of IP addresses to use. To add another range, click the + icon. You can
specify up to four different ranges of IP addresses.

n For Distributed, L2 mode, ensure that all IP ranges are in the same subnet as the
default router. On specifying the IP address ranges, a subnet validation is
performed to ensure that the specified ranges of IP address are in the same
subnet as the default router and subnet mask. The configured IP range is divided
into blocks based on the configured client count.
n For Distributed, L3 mode, you can configure any dis-contiguous IP ranges. The
configured IP range is divided into multiple IP subnets that are sufficient to
accommodate the configured client count.

NOTE: You can allocate multiple branch IDs (BID) per subnet. The Instant AP
generates a subnet name from the DHCP IP configuration, which the controller can
use as a subnet identifier. If static subnets are configured in each branch, all of them

Table 118: Distributed DHCP Scope Configuration Parameters



Configuring DHCP Pools and Client IP Assignment Modes on Instant APs | 395

Data pane
item Description

are assigned the with BID 0, which is mapped directly to the configured static subnet.

DHCP
Reservation

Displays the total number of DHCP reservations. Click the number to view the list of
DHCP reservations.

NOTE: You can configure DHCP reservation only on virtual controllers.

From the filter bar, select a virtual controller and click the + icon to configure
DHCP reservation. Specify the following details:

n MAC—Specify the MAC address of the device for which the IP address has to be
reserved.
n IP—Specify the IP address that has to be reserved for the MAC address. The
IP address should be in the IP address range.

NOTE: Aruba Central allows you to configure a maximum of 32 DHCP reservations.

To delete a DHCP reservation, click the delete icon.

Option Specify the type and a value for the DHCP option. You can configure the organization-
specific DHCP options supported by the DHCP server. For example, 176, 242, 161, and
so on. To add multiple DHCP options, click the + icon. You can add up to eight DHCP
options.

Table 118: Distributed DHCP Scope Configuration Parameters

8. Click Next. TheBranch Size tab is displayed. Specify the number of clients to use per branch. The
client count configured for a branch determines the use of IP addresses from the IP address range
defined for a DHCP scope. For example, if 20 IP addresses are available in an IP address range
configured for a DHCP scope and a client count of 9 is configured, only a few IP addresses (in this
example, 9) from this range will be used and allocated to a branch. The Instant AP does not allow the
administrators to assign the remaining IP addresses to another branch, although a lower value is
configured for the client count.

9. Click Next. The Static IP tab is displayed. Specify the number of first and last IP addresses to reserve
in the subnet.

10. Click Finish.

Configuring a Centralized DHCP Scope
The centralized DHCP scope supports L2 and L3 clients.

When a centralized DHCP scope is configured:

n The virtual controller does not assign an IP address to the client and the DHCP traffic is directly
forwarded to the DHCP Server.

n For L2 clients, the virtual controller bridges the DHCP traffic to the controller over the VPN/GRE tunnel.
The IP address is obtained from the DHCP server behind the controller serving the VLAN/GRE of the
client. This DHCP assignment mode also allows you to add the DHCP option 82 to the DHCP traffic
forwarded to the controller.

n For L3 clients, the virtual controller acts as a DHCP relay agent that forwards the DHCP traffic to the
DHCP server located behind the controller in the corporate network and reachable through the IPsec
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tunnel. The centralized L3 VLAN IP is used as the source IP. The IP address is obtained from the DHCP
server.

To configure a centralized DHCP scope, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click theDHCP accordion.
6. To configure centralized DHCP scopes, click + under Centralized DHCP Scopes.
7. TheNew Centralized DHCP Scope data pane is displayed.
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8. Based on type of centralized DHCP scope, configure the following parameters:

Data
pane
item

Description

Name Enter a name for the DHCP scope.

Type Select one of the following options:
n Centralized, Layer-2
n Centralized, Layer-3

VLAN Specify a VLAN ID or multiple VLAN IDs by entering a list of comma separated digits or
ranges, for example 1,2,5, or 1- 4, or all. You can enter the VLAN ID in the range of 1-4093. To
use this subnet, ensure that the VLAN ID(s) specified here is assigned to an SSID profile.

Split
Tunnel

Enable the split tunnel function if you want allow a VPN user to access a public network and a
local LAN or
WAN network at the same time through the same physical network connection. For example,
a user can use a remote access VPN software client connecting to a corporate network using
a home wireless network. When the split tunnel function is enabled, the user can connect to
file servers, database servers, mail servers, and other servers on the corporate network
through the VPN connection.
When the user connects to resources on the Internet (websites, FTP sites, and so on), the
connection request goes directly to the gateway provided by the home network. The split DNS
functionality intercepts DNS requests from clients for non-corporate domains (as configured
in Enterprise Domains list) and forwards to the Instant AP's own DNS server.
When split tunnel is disabled, all the traffic including the corporate and the Internet traffic is
tunneled irrespective of the routing profile specifications. If the GRE tunnel is down and when
the corporate network is not reachable, the client traffic is dropped.

NOTE: When split tunnel is enabled, you can specify only a single VLAN ID in the VLAN field.
When split tunnel is disabled, you can enter multiple VLAN IDs separated by commas in the
VLAN field.

DHCP
Relay

Select the DHCP Relay check-box to allow the Instant APs to intercept the broadcast packets
and relay DHCP requests.

Helper
Address

Enter the IP address of the DHCP server.

VLAN
IP

Field is applicable only if you select Centralized, Layer-3. Specify the VLAN IP address of the
DHCP relay server.

VLAN
Mask

Field is applicable only if you select Centralized, Layer-3. Specify the VLAN subnet mask of
the DHCP relay server.

Option
82

Select one of the following options:
n None—If you have configured the DHCP Option 82 XML file, the ALU option scope is
disabled in the drop-down list. To enable ALU, set the drop-down list to None and delete
the DHCP Option 82 XML file. To enable the XML option, select None from the drop-down
list and select the XML file from the DHCP Option 82 XML drop-down list.
n ALU—ALU option is disabled if an XML file is selected from the DHCP Option 82 XML
drop-down list in the System > General pane. Select ALU to enable DHCP Option 82 to
allow clients to send DHCP packets with the Option 82 string. The Option 82 string is
available only in the Alcatel (ALU) format. The ALU format for the Option 82 string consists

Table 119: DHCP mode configuration parameters
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Data
pane
item

Description

of the following:
n Remote Circuit ID; X AP-MAC; SSID; SSID-Type
n Remote Agent; X IDUE-MAC
n XML—XML option is enabled only if an XML file is selected from the DHCP Option 82
XML drop-down list in the System > General pane. Alternatively, to enable the XML
option, select None from the drop-down list and select the XML file from the DHCP
Option 82 XML drop-down list.

For information related to XML files, see Configuring System Parameters for an AP

Table 119: DHCP mode configuration parameters

9. Click Save Settings.

The following table describes the behavior of the DHCP Relay Agent and Option 82 in the Instant AP.

DHCP Relay Option 82 Behavior

Enabled Enabled DHCP packet relayed with the ALU-specific Option 82 string

Enabled Disabled DHCP packet relayed without the ALU-specific Option 82 string

Disabled Enabled DHCP packet not relayed, but broadcast with the ALU-specific Option 82 string

Disabled Disabled DHCP packet not relayed, but broadcast without the ALU-specific Option 82
string

Table 120: DHCP Relay and Option 82

Configuring Local DHCP Scopes
You can configure the following types of local DHCP scopes on an Instant AP:

n Local—In this mode, the VC acts as both the DHCP Server and default gateway. The configured subnet
and the corresponding DHCP scope are independent of subnets configured in other Instant AP clusters.
The VC assigns an IP address from a local subnet and forwards traffic to both corporate and non-
corporate destinations. The network address is translated appropriately and the packet is forwarded
through the IPsec tunnel or through the uplink. This DHCP assignment mode is used for the NAT
forwarding mode.

n Local, L2—In this mode, the VC acts as a DHCP server and the gateway is located outside the Instant AP.
n Local, L3—In this mode, the VC acts as a DHCP server and default gateway, and assigns an IP address

from the local subnet. The Instant AP routes the packets sent by clients on its uplink. This DHCP
assignment mode is used with the L3 forwarding mode.

To configure a new local DHCP scope, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.
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3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click theDHCP accordion.
6. To configure local DHCP scopes, click + under Local DHCP Scopes.
7. TheNew DHCP Scopes data pane is displayed.
8. Based on type of local DHCP scope, configure the following parameters:

Data pane
item Description

Name Enter a name for the DHCP scope.

Type Select any of the following options:
n Local—On selecting Local, the DHCP server for local branch network is used for
keeping the scope of the subnet local to the Instant AP. In the NAT mode, the traffic
is forwarded through the uplink.
n Local, L2—On selecting Local, L2, the VC acts as a DHCP server and a default
gateway in the local network is used.
n Local, L3—On selecting Local, L3, the VC acts as a DHCP server and gateway.

VLAN Enter the VLAN ID. To use this subnet, ensure that the VLAN ID specified here is
assigned to an SSID profile.

Network Specify the network to use.

Netmask Specify the subnet mask. The subnet mask and the network determine the size of
subnet.

Excluded
Address

Specify a range of IP addresses to exclude. You can add up to two exclusion ranges.
Based on the size of the subnet and the value configured for Excluded address, the IP
addresses either before or after the defined range are excluded.

DHCP
Reservation

Displays the total number of DHCP reservations. Click the number to view the list of
DHCP reservations.

NOTE: You can configure DHCP reservation only on virtual controllers.

From the filter bar, select a virtual controller and click the + icon to configure
DHCP reservation. Specify the following details:

n MAC—Specify the MAC address of the device for which the IP address has to be
reserved.
n IP—Specify the IP address that has to be reserved for the MAC address. The
IP address should be in the IP address range.

NOTE: Aruba Central allows you to configure a maximum of 32 DHCP reservations.

To delete a DHCP reservation, click the delete icon.

Default
Router

Enter the IP address of the default router.

Table 121: Local DHCP Configuration Parameters
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Data pane
item Description

DNS Server Enter the IP address of a DNS server.

Domain Name Enter the domain name.

Lease Time Enter a lease time for the client in minutes.

Option Specify the type and a value for the DHCP option. You can configure the organization-
specific DHCP options supported by the DHCP server. To add multiple DHCP options,
click the + icon.

Table 121: Local DHCP Configuration Parameters

9. Click Save Settings.

Configuring DHCP Server for Assigning IP Addresses to
Instant AP Clients
The DHCP server is a built-in server, used for networks in which clients are assigned IP address by the VC.
You can customize the DHCP pool subnet and address range to provide simultaneous access to more
number of clients. The largest address pool supported is 2048. The default size of the IP address pool is
512.

When the DHCP server is configured and if the Client IP assignment parameter for an SSID profile is set to
Virtual Controller Assigned, the virtual controller assigns the IP addresses to the WLAN or wired clients. By
default, the Instant AP automatically determines a suitable DHCP pool for Virtual Controller Assigned
networks.
The Instant AP typically selects the 172.31.98.0/23 subnet. If the IP address of the Instant AP is within the
172.31.98.0/23 subnet, the Instant AP selects the 10.254.98.0/23 subnet. However, this mechanism does not
avoid all possible conflicts with the wired network. If your wired network uses either 172.31.98.0/23 or
10.254.98.0/23, and you experience problems with the Virtual Controller Assigned networks after upgrading
to Aruba Central, manually configure the DHCP pool by following the steps described in this section.

To configure a domain name, DNS server, and DHCP server for client IP assignment, complete the following
steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click theDHCP accordion.
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6. Click DHCP For WLANs and enter the following information:

a. Enter the domain name of the client in Domain Name.

b. Enter the IP addresses of the DNS servers in DNS Server. To add another DNS server, click the +
icon.

c. Enter the duration of the DHCP lease in Lease Time. Select Minutes,Hours, orDays for the
lease time from the list next to Lease Time. The default lease time is 0.

d. Enter the network name in theNetwork box.

e. Enter the mask name in theMask box.

f. Click Save Settings.

To provide simultaneous access to more than 512 clients, use the Network and Mask fields to specify a larger
range. While the network (prefix) is the common part of the address range, the mask (suffix) specifies how long
the variable part of the address range is.

Configuring Services
This section describes how to configure AirGroup, location services, Lawful Intercept, OpenDNS, SIP phones,
and Firewall services.

n Configuring AirGroup Services on page 401
n Configuring an Instant AP for RTLS Support on page 405
n Configuring an Instant AP for ALE Support on page 405
n Managing BLE Beacons on page 406
n Configuring OpenDNS Credentials on Instant APs on page 407
n Configuring CALEA Server Support on Instant APs on page 407
n Configuring Instant APs for Palo Alto Networks Firewall Integration on page 409
n Configuring XML API Interface on page 409
n Configuring SIP Phones with Source-NAT on page 410
n Application Visibility and Deep Packet Inspection on page 411

Configuring AirGroup Services
AirGroup is a zero configuration networking protocol that enables service discovery, address assignment,
and name resolution for desktop computers, mobile devices, and network services. It is designed for flat,
single-subnet IP networks such as wireless networking at home.

Bonjour can be installed on computers running Microsoft Windows and is supported by the new network-
capable printers. Bonjour uses multicast DNS (mDNS) to locate devices and the services offered by these
devices. The AirGroup solution supports both wired and wireless devices. Wired devices that support
Bonjour services are part of AirGroup when connected to a VLAN that is terminated on the Virtual
Controller.

In addition to the mDNS protocol, Instant APs also support UPnP, and DLNA enabled devices. DLNA is a
network standard derived from UPnP, which enables devices to discover the services available in a network.
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DLNA also provides the ability to share data between the Windows or Android-based multimedia devices. All
the features and policies applicable to mDNS are extended to DLNA to ensure full interoperability between
compliant devices.

Limitations
AirGroup has the following limitations:

n When 802.11r supported AirGroup servers roam and do not send any mDNS packets, the location
accuracy is not updated until a new mDNS packet is advertised by the server. In such a scenario, reinitiate
the mDNS packet from the server.

n AirGroup does not support temporal filter.
n AirGroup learns an Amazon device only if the device sends an advertisement and not if it is already

connected.
n SSDP devices are not learnt with Wildcard query.
n AirGroup does not support wired devices.
n AirGroup supports Google Chrome browser but does not support Googlecast-based applications.

AirGroup Features
AirGroup provides the following features:

n Send unicast responses to mDNS queries and reduces mDNS traffic footprint.
n Ensure cross-VLAN visibility and availability of AirGroup devices and services.
n Allow or block AirGroup services for all users.
n Allow or block AirGroup services based on user roles.
n Allow or block AirGroup services based on VLANs.

For more information on AirGroup solution, see Aruba Instant User Guide.

AirGroup Services
Bonjour supports zero-configuration services. The services are pre-configured and are available as part of
the factory default configuration. The administrator can also enable or disable any or all services.

The following services are available for Instant AP clients:

n AirPlay — Apple AirPlay allows wireless streaming of music, video, and slide shows from your iOS device
to Apple TV and other devices that support the AirPlay feature.

n AirPrint — Apple AirPrint allows you to print from an iPad, iPhone, or iPod Touch directly to any AirPrint
compatible printer.

n iTunes— The iTunes service is used by iTunes Wi-Fi sync and iTunes home-sharing applications across all
Apple devices.

n RemoteMgmt— Use this service for remote login, remote management, and FTP utilities on Apple
devices.

n Sharing— Applications such as disk sharing and file sharing, use the service ID that are part of this service
on one or more Apple devices.

n Chat— The iChat® (Instant Messenger) application on Apple devices uses this service.
n ChromeCast—The ChromeCast service allows you to use a ChromeCast device to play audio or video

content on a high-definition television by streaming content through Wi-Fi from the Internet or local
network.
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n DLNA Media—Applications such as Windows Media Player use this service to browse and play content on
a remote device.

n DLNA Print—This service is used by printers that support DLNA.

Enabling AirGroup Services
To enable AirGroup services:

Disabling or enabling an AirGroup service results in 20 min delay in clearing the message queue.
An AP reboot is mandatory when an AirGroup service is upgraded.

1. In theNetwork Operations app, set the filter to a group that contains at least one AP. The
dashboard context for the group is displayed.

2. Under Manage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed.
4. Click Show Advanced, and click Services tab. The Services page is displayed.
5. Click theAirGroup accordion.
6. Select theAirGroup check-box.

The mDNS (Bonjour) and SSDP (DLNA/UPNP) check-boxes are selected by default.
Select at least mDNS (Bonjour) or SSDP (DLNA/UPNP) to proceed further.
Optionally, select the Guest Bonjour Multicast check-box to allow guest users to use the Bonjour
services that are enabled in a guest VLAN. When Guest Bonjour Multicast is enabled, the Bonjour
devices are visible only in the guest VLAN and AirGroup does not discover or enforce policies in guest
VLAN.

7. Under theAirGroup Settings sub-accordion, select the check-box against one or more AirGroup
services listed in Table 122.

Mode Description

AirGroup Across
Mobility Domains

AirGroup service availability in inter cluster domains.

AirPrint Wireless printing between AirPrint capable devices and AirPrint compatible
printers.

Enable AirPlay Wireless streaming of music, video, or slide shows from AirPlay capable devices
and AirPlay compatible devices.

iTunes iTunes service for home-sharing applications.

Remote Management Remote login, remote management, or FTP utilities on compatible devices.

Sharing Applications like disk sharing or file sharing on compatible devices.

Chat Instant messenger application between compatible devices.

Googlecast Wireless streaming of audio or video content from the Internet or local network
on a HDTV through a Chromecast device.

Table 122: AirGroup Services
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Mode Description

DIAL Wireless streaming between DIAL compatible devices likes devices like Roku,
Chromecast, or FireTV.

AmazonTV Wireless playing of content from the Internet or local network on a HDTV
through a FireTV device.

DLNA Print Wireless printing between DLNA capable devices and DLNA compatible printers.

DLNA Media Wireless browsing or playing audio or video content by applications like
Windows Media Player on remote devices.

Allow All All AirGroup services.

n Optionally, when enabling an AirGroup service, define disallowed roles. The disallowed roles are
not allowed to use the specific AirGroup service. To disallow roles:

1. Click Edit against Disallowed Roles.
2. Move the roles from theAvailable pool to the Selected pool.
3. Click Ok.

n Optionally, when enabling an AirGroup service, define disallowed VLANs. The disallowed VLANs are
not allowed to use the specific AirGroup service. To disallow VLANs:

1. Click Edit against Disallowed VLANs.
2. Type the VLANs in Enter comma-separated list of VLAN IDs. Separate multiple VLANs

with a comma.
3. Click Ok.

n Optionally, configure and enable a new AirGroup service. If defined, disallowed roles or VLANs are
not allowed to use the new AirGroup service. To configure and enable a new AirGroup service:

1. Click Add New Service.
2. Type the service name in Service Name. Use alphanumeric characters.
3. Type a service ID in Service ID. Use + to add additional service IDs.

Sample service ID: urn:schemas-upnp-org:service:RenderingControl:1 or _sleep-
proxy._udp.

4. Click Ok.
5. Select the check-box against the new AirGroup service.

8. Optionally, under ClearPass Settings sub-accordion, configure the parameters listed in Table 123.

Mode Description

ClearPass Policy
Manager Server 1

Specify the ClearPass Policy Manager server to use. Select one from the drop-
down or define a new ClearPass Policy Manager server.

Enforce ClearPass
Registration

Specify is ClearPass registration should be enforced.

Table 123: ClearPass Settings

9. Click Save Settings.
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Configuring an Instant AP for RTLS Support
Aruba Central supports the real time tracking of devices. With the help of the RTLS, the devices can be
monitored in real time or through history.

To configure RTLS, complete the following steps:

1. In theNetwork Operations app, use the filter to select a group or a device.
2. UnderManage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed.
4. Click Show Advanced, and click Services. The Services page is displayed.
5. Click Real Time Locating System > Aruba.
6. Select Aruba RTLS to send the RFID tag information to the Aruba RTLS server.
7. Click 3rd Party and select Aeroscout to send reports on the stations to a third-party server.
8. In the IP/FQDN and Port field, specify the IP address and port number of the RTLS server, to which

location reports must be sent.
9. In the Passphrase field, enter the passphrase required for connecting to the RTLS server.

10. Retype the passphrase in theRetype Passprahrse field.
11. Specify the update interval within the range of 6–60 seconds in theUpdate every field. The default

interval is 30 seconds.
12. If 3rd Party is selected, specify the IP address and port number of the 3rd party server.
13. Select Include Unassociated Stations to send reports on the stations that are not associated to

any Instant AP.
14. Click Save Settings.

Configuring an Instant AP for ALE Support
ALE is designed to gather client information from the network, process it and share it through a standard
API. The client information gathered by ALE can be used for analyzing a client’s Internet behavior for
business such as shopping preferences.

ALE includes a location engine that calculates the associated and unassociated device location every 30
seconds by default. For every device on the network, ALE provides the following information through the
Northbound API:

n Client user name
n IP address
n MAC address
n Device type
n Application firewall data, showing the destinations and applications used by associated devices.
n Current location
n Historical location

ALE requires the AP placement data to be able to calculate location for the devices in a network.

ALE with Aruba Central
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Aruba Central supports Analytics and Location Engine (ALE). The ALE server acts as a primary interface to all
third-party applications and the Instant AP sends client information and all status information to the ALE
server.

To integrate Instant AP with ALE, the ALE server address must be configured on an Instant AP. If the ALE
sever is configured with a host name, the Virtual Controller performs a mutual certificated-based
authentication with ALE server, before sending any information.

Enabling ALE support on an Instant AP
To configure an Instant AP for ALE support:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP. The
dashboard context for the group is displayed.

2. Under Manage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed.
4. Click Show Advanced, and click Services tab. The Services page is displayed.
5. Click theReal Time Locating System accordion.
6. Click Aruba, and then select Analytics & Location.
7. Specify the ALE server name or IP address.
8. Specify the reporting interval within the range of 6–60 seconds. The Instant AP sends messages to

the ALE server at the specified interval. The default interval is 30 seconds.
9. Click Save Settings.

Managing BLE Beacons
Instant APs support Aruba BLE devices, such as BT-100 and BT-105, which are used for location tracking and
proximity detection. The BLE devices can be connected to an Instant AP and are managed by a cloud-based
Beacon Management Console. The BLE Beacon Management feature allows you to configure parameters
for managing the BLE beacons and establishing secure communication with the Beacon Management
Console.

Support for BLE Asset Tracking
Instant AP assets can be tracked using BLE tags, Instant AP beacons scan the network. When a tag is
detected, the Instant AP sends a beacon with information about the tag including the MAC address and RSSI
of the tag to the Virtual Controller.

To manage beacons and configure BLE operation mode, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP. The
dashboard context for the group is displayed.

2. Under Manage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed.
4. Click Show Advanced, and click Services tab. The Services page is displayed.
5. Click theReal Time Locating System accordion.
6. Click Aruba.
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7. Select Manage BLE Beacons to manage the BLE devices using BMC.

a. Enter the authorization token in Authorization token. The authorization token is a text string
of 1–255 characters used by the BLE devices in the HTTPS header when communicating with the
BMC. This token is unique for each deployment.

b. Enter the server URL in Endpoint URL. The BLE data is sent to the server URL for monitoring.

8. Select any of the following options fromBLE Operation Mode drop-down list:

Mode Description

beaconing The built-in BLE chip in the Instant AP functions as an iBeacon combined with the beacon
management functionality.

disabled The built-in BLE chip of the Instant AP is turned off. The BLE operation mode is set to
Disabled by default.

dynamic-
console

The built-in BLE chip of the Instant AP functions in the beaconing mode and dynamically
enables access to Instant AP console over BLE when the link to LMS is lost.

persistent-
console

The built-in BLE chip of the Instant AP provides access to the Instant AP console over BLE
and also operates in the Beaconing mode.

Table 124: BLE Operation Modes

9. To configure BLE web socket management server, enter the URL of BLE web socket management
server in BLE Asset Tag Mgmt Server(wss).

10. Select BLE Asset Tag Mgmt Server(https) to configure BLE HTTPS management server.

a. Enter the URL of BLE HTTPS management server in Server URL.

b. Enter the authorization token in Authorization token.

c. Enter the location ID in Location ID.

11. Click Save Settings.

Configuring OpenDNS Credentials on Instant APs
Instant APs use the OpenDNS credentials to provide enterprise-level content filtering.

To configure OpenDNS credentials:

1. In theNetwork Operations app, use the filter to select a group or a device.
2. UnderManage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed.
4. Click Show Advanced, and click Services. The Services page is displayed.
5. Click theOpenDNS accordion.
6. Enter theUsername and Password.
7. Click Save Settings.

Configuring CALEA Server Support on Instant APs
LI allows the Law Enforcement Agencies to perform an authorized electronic surveillance. Depending on the
country of operation, the ISPs are required to support LI in their respective networks.



Aruba Central | User Guide 408

In the United States, Service Providers are required to ensure LI compliance based on CALEA specifications.

Aruba Central supports CALEA integration with an Instant AP in a hierarchical and flat topology, mesh
Instant AP network, the wired and wireless networks.

Enable this feature only if lawful interception is authorized by a law enforcement agency.

For more information on the communication and traffic flow from an Instant AP to CALEA server, see Aruba
Instant User Guide.

To enable an Instant AP to communicate with the CALEA server, complete the following steps:

n Creating a CALEA Profile
n Creating ACLs for CALEA Server Support

Creating a CALEA Profile
To create a CALEA profile, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP. The
dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed.
4. Click Show Advanced, and click Services tab. The Services page is displayed.
5. Click theCALEA accordion.
6. Specify the following parameters:

n IP address— Specify the IP address of the CALEA server.
n Encapsulation type— Specify the encapsulation type. The current release of Aruba Central

supports GRE only.
n GRE type— Specify the GRE type.
n MTU— Specify a size for the MTU within the range of 68—1500. After GRE encapsulation, if

packet length exceeds the configured MTU, IP fragmentation occurs. The default MTU size is
1500.

7. Click Save Settings.

Creating ACLs for CALEA Server Support
To create an access rule for CALEA, complete the following steps:

1. In theNetwork Operations app, use the filter to select a group or a device.
2. If you select a group, perform the following steps:

a. UnderManage, click Devices > Access Points.

b. Click theConfig icon. The tabs to configure the group is displayed.

3. If you select a device, underManage, click Devices.
4. Click Show Advanced, and click Security tab. The Security page is displayed.
5. Click theRoles accordion.
6. UnderAccess Rules for Selected Roles, click + icon. TheNew Rule window is displayed.
7. Set theRule Type to CALEA.
8. Click Save.
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9. Create a role assignment rule if required.
10. Click Save Settings.

Configuring Instant APs for Palo Alto Networks Firewall
Integration
Instant APs maintains the network (such as mapping IP address) and user information for its clients in the
network. To integrate the Instant AP network with a third-party network, you can enable an Instant AP to
provide this information to the third-party servers.

To integrate an Instant AP with a third-party network, you must add a global profile. This profile can be
configured on an Instant AP with information such as IP address, port, user name, password, firewall
enabled or disabled status.

Configuring an Instant AP for Network Integration
To configure an Instant AP for network integration:

1. In theNetwork Operations app, use the filter to select a group or a device.
2. UnderManage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed.
4. Click Show Advanced, and click Services. The Services page is displayed.
5. Click theNetwork Integration accordion.
6. Select Enable to enable PAN firewall.
7. Specify theUsername and Password. Ensure that you provide user credentials of the PAN firewall

administrator.
8. Re-enter the password in Retype.
9. Enter the PAN firewall IP Address.

10. Enter the port number within the range of 1—65535. The default port is 443.
11. Enter the client domain in Client Domain.
12. Click Save Settings.

Configuring XML API Interface
The XML API interface allows Instant APs to communicate with an external server. The communication
between Instant AP and an external server through XML API Interface includes the following steps:

n An API command is issued in the XML format from the server to the virtual controller.
n The virtual controller processes the XML request and identifies where the client is and sends the

command to the correct slave Instant AP.
n Once the operation is completed, the virtual controller sends the XML response to the XML server.
n The administrators can use the response and take appropriate action to suit their requirements. The

response from the virtual controller is returned using the predefined formats.

To configure XML API for servers, complete the following steps:

1. In theNetwork Operations app, set the filter to select a group or a device.
2. UnderManage, click Devices > Access Points.
3. Click theConfig icon. The tabs to configure access points is displayed
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4. Click Show Advanced, and click Services. The Services page is displayed.
5. Go to Network Integration > XML API Server Configuration.
6. Click + to add a new XML API server.
7. Enter a name for the XML API server in theName text box.
8. Enter the IP address of the XML API server in the IP Address text box.
9. Enter the subnet mask of the XML API server in theMask text box.

10. Enter a passcode in the Passphrase text box, to enable authorized access to the XML API Server.
11. Re-enter the passcode in theRetype Passphrase box.
12. To add multiple entries, repeat the procedure.
13. Click Add.
14. Click Save Settings.
15. To edit or delete the server entries, use the Edit and Delete buttons, respectively.

For information on adding an XML API request, see Aruba Instant User Guide.

Configuring SIP Phones with Source-NAT
Aruba Central allows to use SIP phones with source-NAT function using centralized Gateway service. SIP ALG
is supported in bridge mode along with the use of NAT on APs.

The SIP phones with source-NAT supported only on AP devices running Aruba Instant 8.6.0.3.

To configure SIP phones with source-NAT function, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Services tab.

The Services details page is displayed.

5. Click the SIP accordion.
6. Click the + icon in the SIP pane.

The SIP-ALG SVC Port window is displayed.

7. In the Port field, enter the port number within the range of 1—65535.
8. Select TCP orUDP from the Protocol drop-down list.
9. In the Timeout field, enter the timeout value in seconds. The value should be between 15 to 30

seconds.
10. Click OK.

The SIP-ALG SVC Port table in the SIP section lists the configured SIP settings.

11. Click Save Settings.

The following figure displays the SIP configuration page:
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Figure 55 SIP Configuration

Application Visibility and Deep Packet Inspection
AppRF is a custom built Layer 7 firewall capability supported for Instant APs managed by Aruba Central. It
consists of an on-board deep packet inspection and a cloud-based Web Policy Enforcement service that
allows creating firewall policies based on types of application.

Instant APs with DPI capability analyze data packets to identify applications in use and allow you to create
access rules to determine client access to applications, application categories, web categories and website
URLs based on security ratings. You can also define traffic shaping policies such as bandwidth control and
QoS per application for client roles. For example, you can block bandwidth monopolizing applications on a
guest role within an enterprise.

The Deep Packet Inspection feature is supported on Instant AP running 6.4.3.x-4.1.x.x or later releases. The
AppRF feature is not supported on IAP-104/105 and IAP-134/135 devices.
You can configure InstantInstant APs to send URL information for the blocked HTTP and HTTPS sessions to ALE.
The URL information can be extracted for the associated clients for DPI, analytics, and data mining through the
Northbound APIs. To enable URL information logging and extraction, enable the URL Visibility parameter in the
InstantInstant AP UI or CLI. For more information, see Aruba Instant User Guide.

For more information on DPI and application analytics, see the following topics:

n Application Visibility on page 684
n Enabling Application Visibility Service on APs
n Configuring ACLs for Deep Packet Inspection on page 376
n Configuring ACLs on APs for Website Content Classification on page 378
n Configuring Custom Redirection URLs for Instant AP Clients on page 380

Enabling Application Visibility Service on APs
To view application usage metrics for WLAN clients, enable the Application Visibility service on APs.

To enable the Application Visibility feature, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.
The dashboard context for the group is displayed.

2. Under Manage, click Devices > Access Points.

3. Click theConfig icon to display the AP configuration dashboard.

4. If you select the device, click Device underManage.
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5. Click Show Advanced.

6. Click Services. The Services page is displayed.

7. Click AppRF.
8. Select any of the following options forDeep Packet Inspection:

n All—Performs deep packet inspection on client traffic to application, application categories, website
categories, and websites with a specific reputation score.

n App—Performs deep packet inspection on client traffic to applications and application categories.

n WebCC—Performs deep packet inspection on client traffic to specific website categories and websites
with specific reputation ratings.

n None—Disables deep packet inspection.

9. Click Save Settings.

Configuring Uplink Interfaces on Instant APs
This section provides the following information:

n Configuring Uplink Interfaces
n Configuring Uplink Preferences and Switching

Configuring Uplink Interfaces
Aruba Central supports 3G and 4G USB modems, and the Wi-Fi uplink to provide access to the corporate
network.

By default, the AP-318, AP-374, AP-375, and AP-377 access points have Eth1 as the uplink port and Eth0 as the
downlink port. Aruba recommends you not to upgrade the mentioned access points to 8.5.0.0 and 8.5.0.1
firmware versions as the upgrade process changes the uplink from Eth1 to Eth0 port thereby making the
devices non-reachable.

The following types of uplinks are supported on Aruba Central:

n 3G/4G Uplink
n Ethernet Uplink on page 414
n Wi-Fi Uplink on page 415

3G/4G Uplink
Aruba Central supports the use of 3G/4G USB modems to provide the Internet back haul to Aruba Central.
The 3G/4G USB modems can be used to extend client connectivity to places where an Ethernet uplink
cannot be configured. This enables the Instant APs to automatically choose the available network in a
specific region.

Types of Modems
Aruba Central supports the following three types of 3G modems:

n True Auto Detect—Modems of this type can be used only in one country and for a specific ISP. The
parameters are configured automatically and hence no configuration is necessary.

n Auto-detect + ISP/country—Modems of this type require the user to specify the Country and ISP. The
same modem is used for different ISPs with different parameters configured for each of them.



Configuring Uplink Interfaces on Instant APs | 413

n No Auto Detect—Modems of this type are used only if they share the same Device-ID, Country, and ISP
details. You need to configure different parameters for each of them. These modems work with Aruba
Central when the appropriate parameters are configured.

Modem Type Supported 4G Modem

True Auto Detect n Pantech UML290
n Ether-lte

Table 125: 4G Supported Modem

When UML290 runs in auto detect mode, the modem can switch from 4G network to 3G network or vice-versa
based on the signal strength. To configure the UML290 for the 3G network only, manually set the USB type to
pantech-3g. To configure the UML290 for the 4G network only, manually set the 4G USB type to pantech-lte.

Configuring Cellular Uplink Profiles
To configure 3G or 4G uplinks using Aruba Central, complete the following steps:

Before you begin, obtain the modem configuration parameters from the local IT administrator or the modem
manufacturer.

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theUplink accordion.
6. Under 3G/4G, perform any of the following steps:

n To configure a 3G or 4G uplink automatically, select theCountry and ISP. The parameters are
automatically populated.

n To configure a 3G or 4G uplink manually, perform the following steps:
a. Select the country from theCountry drop-down list.
b. Select the service protocol from the ISP drop-down list.
c. Enter the type of the 3G/4G modem driver type:

n For 3G—Enter the type of 3G modem in theUSB Type text box.
n For 4G—Enter the type of 4G modem in the 4G USB Type text box.

a. Enter the device ID of modem in theUSB DEV text box.
b. Enter the TTY port of the modem in theUSB TTY text box.
c. Enter the parameter to initialize the modem in theUSB INIT text box.
d. Enter the parameter to dial the cell tower in theUSB Dial text box.
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e. Enter the parameter used to switch a modem from the storage mode to modem mode in
theUSB Mode Switch text box.

f. Select the USB authentication type from theUSB Auth Type drop-down list.
g. Enter the username used to dial the ISP in theUSB User text box.
h. Enter the password used to dial the ISP in theUSB Password text box.

7. Click Save Settings.
8. Reboot the Instant AP for changes to affect.

Ethernet Uplink
The Ethernet 0 port on an Instant AP is enabled as an uplink port by default. The Ethernet uplink supports
the following:

n PPPoE
n DHCP
n Static IP

You can use PPPoE for your uplink connectivity in a single AP deployment.

Uplink redundancy with the PPPoE link is not supported.

When the Ethernet link is up, it is used as a PPPoE or DHCP uplink. After the PPPoE settings are configured,
PPPoE has the highest priority for the uplink connections. The Instant AP can establish a PPPoE session with
a PPPoE server at the ISP and get authenticated using PAP or the CHAP. Depending upon the request from
the PPPoE server, either the PAP or the CHAP credentials are used for authentication. After configuring
PPPoE, reboot the Instant AP for the configuration to take effect. The PPPoE connection is dialed after the
AP comes up. The PPPoE configuration is checked during Instant AP boot and if the configuration is correct,
Ethernet is used for the uplink connection.

When PPPoE is used, do not configure Dynamic RADIUS Proxy and IP address of the VC. An SSID created with
default VLAN is not supported with PPPoE uplink.

You can also configure an alternate Ethernet uplink to enable uplink failover when an Ethernet port fails.

Configuring PPPoE Uplink Profile
To configure PPPoE settings, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theUplink accordion.
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6. Under PPPoE, configure the following parameters:

a. Enter the PPPoE service name provided by your service provider in the Service Name.

b. In theCHAP Secret and Retype CHAP Secret fields, enter the secret key used for CHAP
authentication. You can use a maximum of 34 characters for the CHAP secret key.

c. To set a local interface for the PPPoE uplink connections, select a value from Local Interface.
The selected DHCP scope is used as a local interface on the PPPoE interface and the Local, L3
DHCP gateway IP address as its local IP address. When configured, the local interface acts as an
unnumbered PPPoE interface and allocated the entire Local, L3 DHCP subnet to the clients.

d. Enter the user name for the PPPoE connection in theUser field.

e. In the Password and Retype Password fields, enter a password for the PPPoE connection and
confirm it.

The options in Local Interface are displayed only if a Local, L3 DHCP scope is configured on the
Instant AP.

7. Click Save Settings.
8. Reboot the Instant AP.

Wi-Fi Uplink
The Wi-Fi uplink is supported for all Instant AP models, except 802.11ac APs. Only the master Instant AP
uses the Wi-Fi uplink. The Wi-Fi allows uplink to open, PSK-CCMP, and PSK-TKIP SSIDs.

n For single radio Instant APs, the radio serves wireless clients and Wi-Fi uplink.
n For dual radio Instant APs, both radios can be used to serve clients but only one of them can be used for

Wi-Fi uplink.

When Wi-Fi uplink is in use, the client IP is assigned by the internal DHCP server.

Configuring a Wi-Fi Uplink Profile
The following configuration conditions apply to the Wi-Fi uplink:

n To bind or unbind the Wi-Fi uplink on the 5 GHz band, reboot the Instant AP.
n If Wi-Fi uplink is used on the 5 GHz band, mesh is disabled. The two links are mutually exclusive.

To provision an Instant AP with Wi-Fi Uplink, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.
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5. Click theUplink accordion.
6. UnderWi-Fi, enter the name of the wireless network that is used for Wi-Fi uplink in theName(SSID)

box.
7. FromBand, select the band in which the VC currently operates. The following options are available:

n 2.4 GHz (default)
n 5 GHz

8. FromKey Management drop-down list, select the type of key for uplink encryption and
authentication.
n When WPA Personal orWPA-2 Personal key management type is selected, the passphrase

options are available for configuration.
a. Select a passphrase format from the Passphrase Format drop-down list.

The following passphrase options are available:

8 - 63 alphanumeric characters
64 hexadecimal characters

Ensure that the hexadecimal password string is exactly 64 digits in length.

b. Enter a PSK passphrase in Passphrase.
n When WPA Enterprise orWPA-2 Enterprise key management type is selected, the 802.1x

authentication options are available for configuration.
a. From the WiFi1X drop-down list, select 802.1x authentication protocol to be used:

n Specify the certificate type to be used by selecting Cert TPM or Cert User.
n If PEAP authentication type is selected, enter the user credentials in theUsername and

Password text box.

b. Toggle theValidate Server button to enable or disable server certificate verification by the
AP.

9. Click Save Settings.

If the uplink wireless router uses mixed encryption, WPA-2 Personal or WPA-2 Enterprise is recommended for
Wi-Fi uplink.

Configuring Uplink Preferences and Switching
This section describes the following topics:

n Enforcing Uplinks
n Setting an Uplink Priority
n Enabling Uplink Pre-emption

Enforcing Uplinks
The following conditions apply to the uplink enforcement:

n When an uplink is enforced, the Instant AP uses the specified uplink regardless of uplink pre-emption
configuration and the current uplink status.



Configuring Uplink Interfaces on Instant APs | 417

n When an uplink is enforced and multiple Ethernet ports are configured and uplink is enabled on the
wired profiles, the Instant AP tries to find an alternate Ethernet link based on the priority configured.

n When no uplink is enforced and pre-emption is not enabled, and if the current uplink fails, the Instant AP
tries to find an available uplink based on the priority configured.

n When no uplink is enforced and pre-emption is enabled, and if the current uplink fails, the Instant AP
tries to find an available uplink based on the priority configured. If current uplink is active, the Instant AP
periodically tries to use a higher priority uplink and switches to the higher priority uplink even if the
current uplink is active.

To enforce a specific uplink on an Instant AP, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theUplink accordion.
6. UnderManagement > Enforce Uplink, select the type of uplink from the drop-down list. If

Ethernet uplink is selected, the Port field is displayed.
7. Specify the Ethernet interface port number.
8. Click Save Settings.

The selected uplink is enforced on the Instant AP.

Setting an Uplink Priority
To set an uplink priority, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theUplink accordion.
6. UnderManagement > Uplink Priority List, select the uplink to increase or decrease the priority.

By default, the Eth0 uplink is set as a high priority uplink.
7. Click Save Settings.

The selected uplink is prioritized over other uplinks.

Enabling Uplink Pre-emption
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The following configuration conditions apply to uplink pre-emption:

n Pre-emption can be enabled only when no uplink is enforced.
n When pre-emption is disabled and the current uplink fails, the Instant AP tries to find an available uplink

based on the uplink priority configuration.
n When pre-emption is enabled and if the current uplink is active, the Instant AP periodically tries to use a

higher priority uplink, and switches to a higher priority uplink even if the current uplink is active.

To enable uplink pre-emption, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theUplink accordion.
6. UnderManagement, ensure that the Enforce Uplink is set to None.
7. Select the Pre-emption check-box.
8. Specify value for Pre-emption Interval.
9. Click Save Settings.

Switching Uplinks based on the Internet Availability
You can configure Aruba Central to switch uplinks based on the Internet availability.

When the uplink switchover based on Internet availability is enabled, the Instant AP continuously sends
ICMP packets to some well-known Internet servers. If the request is timed out due to a bad uplink
connection or uplink interface failure, and the Internet is not reachable from the current uplink, the Instant
AP switches to a different connection.

To configure uplink switching, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Interfaces tab.

The Interfaces details page is displayed.

5. Click theUplink accordion.
6. UnderManagement, specify a value for Failover Internet IP.
7. Select the Internet Failover check-box.
8. Specify values for Failover Internet Packet Send Frequency, Failover Internet Packet Lost
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Count, and Internet Check Count.
9. Click Save Settings.

By default, the master AP sends the ICMP packets to 8.8.8.8 IP address only if the out-of-service operation
based on Internet availability (internet-down state) is configured on the SSID. You can use Failover Internet IP
as an alternative to the default option to configure an IP address to which the AP must send AP packets, and
verify if the Internet is reachable when the uplink is down.
When Internet Failover is enabled, the Instant AP ignores the VPN status, although uplink switching based on
VPN status is enabled.

Configuring Preferred Uplink on AP-318 and 370 Series APs
The AP-318 and 370 Series APs have an ethernet port for Eth0 and a fibreport for Eth1. Either of these
ports can be configured as the uplink port as required. By default, Eth1 port is configured as the uplink for
these AP platforms. All functionality of the Eth0 port is supported by Eth1 port with exception to the
following:

n Eth0 bridging feature is not supported when the Eth1 port is configured as preferred uplink.
n If LACP is enabled, the Eth1 port cannot be configured as the preferred uplink.

By default, the AP-318, AP-374, AP-375, and AP-377 Instant APs have Eth1 as the uplink port and Eth0 as the
downlink port. Aruba recommends you not to upgrade the mentioned access points to 8.5.0.0 and 8.5.0.1
firmware versions as the upgrade process changes the uplink from Eth1 to Eth0 port thereby making the
devices non-reachable.

Configuring Enterprise Domains
In a typical Instant AP deployment without tunneling, all DNS requests from a client are forwarded to the
client’s DNS server by default. However, if an Instant AP is configured for tunneling, the IAP-VPN enables
split DNS by default, and the DNS behavior for both the clients on the Instant AP network is determined by
the enterprise domain settings.

The enterprise domain setting on the Instant AP specifies the domains for which DNS resolution must be
forwarded to the default DNS server of the client. For example, if the enterprise domain is configured for
arubanetworks.com, the DNS resolution for host names in the arubanetworks.com domain is
forwarded to the default DNS server of the client. The DNS resolution for host names in all other domains is
forwarded to the local DNS server of the Instant AP.

In a full-tunnel mode, all DNS traffic is forwarded over IPSec tunnel to DNS server of the client regardless of the
enterprise domain configuration. If an asterisk is configured in the enterprise domain list instead of a domain
name, then all DNS requests are forwarded to the default DNS server of the client.
Split DNS functionality is supported for IAP-VPN scenarios only.

To configure an enterprise domain, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.
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2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the Enterprise Domains accordion.
6. Click + in the Enterprise Domains pane, and enter a name in theNew Domain Name window.
7. Click OK.
8. Click Save Settings.

To delete an enterprise domain, select the domain in the Enterprise Domains pane, and then click the
delete icon.

Configuring SNMP Parameters
This section describes the following topics:

n SNMP Configuration Parameters on page 420
n Configuring Community String for SNMP on page 421
n Configuring SNMP Trap Receivers on page 422

SNMP Configuration Parameters
Aruba Central supports SNMPv1, SNMPv2c, and SNMPv3 for reporting purposes only. An Instant AP cannot
use SNMP to set values in an Aruba system.

You can configure the following parameters for an Instant AP:

Data Pane Item Description

Community
Strings for
SNMPV1 and
SNMPV2

An SNMP Community string is a text string that acts as a password, and is used to
authenticate messages sent between the virtual controller and the SNMP agent.

If you are using SNMPv3 to obtain values from the Instant AP, you can configure the following parameters:

Name A string representing the name of the user.

Authentication
Protocol

An indication of whether messages sent on behalf of this user can be authenticated, and
if so, the type of authentication protocol used. This can take one of the two values:

n MD5—HMAC-MD5-96 Digest Authentication Protocol
n SHA—HMAC-SHA-96 Digest Authentication Protocol

Authentication
protocol password

If messages sent on behalf of this user can be authenticated, the (private) authentication
key for use with the authentication protocol. This is a string password for MD5 or SHA
depending on the choice above.

Table 126: SNMP Parameters
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Data Pane Item Description

Privacy protocol An indication of whether messages sent on behalf of this user can be protected from
disclosure, and if so, the type of privacy protocol which is used. This takes the value DES
(CBC-DES Symmetric Encryption).

Privacy protocol
password

If messages sent on behalf of this user can be encrypted/decrypted with DES, the
(private) privacy key for use with the privacy protocol.

Configuring Community String for SNMP
This section describes the procedure for configuring SNMPv1, SNMPv2, and SNMPv3 community strings in
Aruba Central.

Creating Community strings for SNMPv1 and SNMPv2 using Aruba
Central
To create community strings for SNMPv1 and SNMPv2, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the SNMP accordion.
6. Under SNMP, click + to add a new community string.
7. In theNew SNMPwindow, enter a name for the community string.
8. Click OK.
9. To delete a community string, select the string in the SNMP pane, and then click the delete icon.

Creating community strings for SNMPv3 using Aruba Central
To create community strings for SNMPv3, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the SNMP accordion.
6. UnderUser for SNMPV3, click + to add a new community string for SNMPv3.
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7. In theNew SNMPv3 User window, enter the following information:

a. In theAuth protocol drop-down list, select the type of authentication protocol.

b. In the Password text-box, enter the authentication password and retype the password in the
Retype Password text-box.

c. In the Privacy protocol drop-down list, select the type of privacy protocol.

d. In the Password text-box, enter the privacy protocol password and retype the password in the
Retype Password text box.

e. Click OK.

8. To edit the details for a particular user, select the user, and then click the edit icon.
9. To delete a particular user, select the user, and then click the delete icon.

Configuring SNMP Trap Receivers
Aruba Central supports the configuration of external trap receivers. Only the Instant AP acting as the VC
generates traps. The OID of the traps is 1.3.6.1.4.1.14823.2.3.3.1.200.2.X.

To configure SNMP traps, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the SNMP accordion.
6. Under SNMP Traps Receivers, click + to add a new community string for SNMP Traps Receivers.
7. In theNew SNMP Trap Receiver window, enter the following information:

a. In the IP Address text-box, enter the IP address of the new SNMP Trap Receiver.

b. In theVersion drop-down list, select the SNMP version, such as v1, v2c, v3. The version
specifies the format of traps generated by the access point.

c. In theCommunity/Username text-box, specify the community string for SNMPv1 and
SNMPv2c traps and a username for SNMPv3 traps.

d. In the Port text-box, enter the port to which the traps are sent. The default value is 162.

e. In the Inform drop-down list, select Yes orNo. When enabled, traps are sent as SNMP INFORM
messages. It is applicable to SNMPv3 only. The default value is Yes.

f. Click OK.

Configuring Syslog and TFTP Servers for Logging
Events
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This section describes the following topics:

n Configuring Syslog Server on Instant APs on page 423
n Configuring TFTP Dump Server Instant APs on page 424

Configuring Syslog Server on Instant APs
To specify a syslog server for sending syslog messages to the external servers, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the Logging accordion.
6. In the Servers section, enter the IP address of the syslog server in the Syslog Server text-box.

You can enter up to three IP addresses in the Syslog Server text box. Separate each value with a
comma.

Aruba Central allows you to configure up to three syslog servers for logging events.

7. Click Syslog Facility Levels, and enter the required logging level from the drop-down in each of the
fields.

Syslog facility is an information field associated with a syslog message. It is an application or
operating system component that generates a log message. The Instant AP supports the following
syslog facilities:
n Syslog Level—Detailed log about syslog levels.
n AP-Debug—Detailed log about the AP device.
n Network—Log about change of network, for example, when a new Instant AP is added to a

network.
n Security—Log about network security, for example, when a client connects using wrong

password.
n System—Log about configuration and system status.
n User—Important logs about client.
n User-Debug—Detailed log about client.
n Wireless—Log about radio.

Table 127 describes the logging levels in order of severity, from the most severe to the least.
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Logging level Description

Emergency Panic conditions that occur when the system becomes unusable.

Alert Any condition requiring immediate attention and correction.

Critical Any critical condition such as a hard drive error.

Error Error conditions.

Warning Warning messages.

Notice Significant events of a non-critical nature. The default value for all syslog facilities.

Information Messages of general interest to system users.

Debug Messages containing information useful for debugging.

Table 127: Logging Levels

8. Click Save Settings.

Configuring TFTP Dump Server Instant APs
To configure a TFTP server for storing core dump files, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the Logging accordion.
6. In the Servers section, enter the IP address of the TFTP server in the TFTP Dump Server text-box.
7. Click Save Settings.

Configuring Mobility for Clients
This section provides the following information on Layer-3 Mobility for Instant AP clients:

n Layer-3 Mobility on page 424
n Configuring L3 Mobility Domain on page 425

Layer-3 Mobility
Instant APs form a single Aruba Central network when they are in the same Layer-2 (L2) domain. As the
number of clients increase, multiple subnets are required to avoid broadcast overhead. In such a scenario, a
client must be allowed to roam away from the Aruba Central network to which it first connected (home
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network) to another network supporting the same WLAN access parameters (foreign network) and continue
its existing sessions.

Layer-3 (L3) mobility allows a client to roam without losing its IP address and sessions. If WLAN access
parameters are the same across these networks, clients connected to Instant APs in a given Aruba Central
network can roam to Instant APs in a foreign Aruba Central network and continue their existing sessions
using their IP addresses. You can configure a list of Virtual Controller IP addresses across which L3 mobility
is supported.

Home Agent Load Balancing
Home Agent Load Balancing is required in large networks where multiple tunnels might terminate on a
single border or lobby AP and overload it. When load balancing is enabled, the VC assigns the home AP for
roamed clients by using a round robin policy. With this policy, the load for the APs acting as Home Agents
for roamed clients is uniformly distributed across the Instant AP cluster.

Configuring L3 Mobility Domain
To configure a mobility domain, you have to specify the list of all Aruba Central networks that form the
mobility domain. To allow clients to roam seamlessly among all the APs, specify the VC IP for each foreign
subnet. You may include the local Aruba Central or VC IP address, so that the same configuration can be
used across all Aruba Central networks in the mobility domain.

Aruba recommends that you configure all client subnets in the mobility domain. When client subnets are
configured:

n If a client is from a local subnet, it is identified as a local client. When a local client starts using the IP
address, the L3 roaming is terminated.

n If the client is from a foreign subnet, it is identified as a foreign client. When a foreign client starts using
the IP address, the L3 roaming is set up.

To configure a Layer-3 Mobility domain, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the Layer-3 Mobility accordion.
6. Turn on theHome Agent Load Balancing toggle switch. By default, home agent load balancing is

disabled.
7. Under IP Address, click +, and enter an IP address name in theNew IP Address window, and then

click OK.

Repeat Step 7 to add the IP addresses of all VCs that form the L3 mobility domain.
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8. Under Subnets, click +, and specify the following:

a. Enter the client subnet in the IP Address box.

b. Enter the mask in the Subnet Mask box.

c. Enter the VLAN ID in the home network in theVLAN ID box.

d. Enter the home VC IP address for this subnet in theVirtual Controller IP box.

9. Click OK.

Mapping Instant AP Certificates
When an Instant AP joins a group that does not have a certificate, the Instant AP's existing certificate is
retained. When an Instant AP joins a group that already has a certificate, the Instant AP's certificate is
overwritten by the group certificate.

To map an Instant AP certificate name to a specific certificate type or category, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the Security tab.

The Security details page is displayed.

5. Click theCertificate Usage accordion.
6. To map a certificate, for each usage type underUsage Type, select the suitable certificate from the

Certificate drop-down list:
n Certificate Authority—To verify the identity of a client.
n Authentication Server—To verify the identity of the server to a client.
n Captive Portal—To verify the identity of internal captive portal server.
n RadSec—To verify the identity of the TLS server.
n RadSec Certificate Authority—To verify the authentication between the Instant AP and the TLS

server.
n Clearpass—To verify the identity of the ClearPass server.

7. Click Save Settings.

To enable certificates for the Cloud Guest Service, contact the Aruba Central support team.

Configuring HTTP Proxy on an Instant AP
If your network requires a proxy server for Internet access, ensure that you configure the HTTP proxy on
the Instant AP to download the image from the cloud server. After setting up the HTTP proxy settings, the
Instant AP connects to the Activate server, Aruba Central, or OpenDNS server through a secure HTTP
connection. You can also exempt certain applications from using the HTTP proxy (configured on an Instant
AP) by providing their host name or IP address under exceptions. Aruba Central allows the user to
configuring HTTP proxy on an Instant AP.
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To configure HTTP proxy on Instant AP through Aruba Central, complete the following steps:

1. In theNetwork Operations app, set the filter to a group that contains at least one AP.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure the access points are displayed.

4. Click Show Advanced, and click the System tab.

The System details page is displayed.

5. Click the Proxy accordion and specify the following:

a. Enter the HTTP proxy server IP address in the Server text-box.

b. Enter the port number in the Port text-box.

6. Click Save Settings.

Aruba Central displays the Username, Password, and Retype Password fields under System > Proxy for
Instant AP running Aruba Instant 8.3.0.0. The Instant APs with the Aruba Instant 8.3.0.0 firmware require user
credentials for proxy server authentication.

Configuring APs Using Templates
Templates in Aruba Central refer to a set of configuration commands that can be used by the administrators
for provisioning devices in a group. Configuration templates enable administrators to apply a set of
configuration parameters simultaneously to multiple devices in a group and thus automate AP
deployments.

To minimize configuration errors and troubleshoot device-specific configuration issues, Aruba recommends
that the device administrators familiarize themselves with the CLI configuration commands available on Aruba
APs.

For template-based provisioning, APs must be assigned to a group with template-based configuration
method enabled.

To create a template for the APs in a template group, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the template group underGroups.
2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click theConfig icon.

The tabs to configure access points in a template group are displayed.

4. In the Templates table, click + to add a new template.

TheAdd Template window is displayed.

5. UnderBasic Info, enter the following information:
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a. Template Name—Enter the template name.

b. Model—Set the model parameter to ALL.

c. Version—Set the model parameter to ALL.

6. Under Template, add the CLI script content.
7. Check the following guidelines before adding content to the template:

n Ensure that the command text indentation matches the indentation in the running configuration.
n The template allows multiple per-ap-settings blocks. The template must include theper-ap-

settings %_sys_lan_mac% variable. Theper-ap-settings block uses the variables for each AP.
The general VC configuration uses variables for master AP to generate the final configuration from
the provided template. Hence, Aruba recommends that you upload all variables for all devices in a
cluster and change values as required for individual AP variables.

n You can obtain the list of variables for per-ap-settings by using the show amp-audit command.

The following example shows the list of variables for per-ap-settings.

(Instant AP)# show amp-audit | begin per-ap

per-ap-settings 70:3a:0e:cc:ee:60

hostname EE:60-335-24

rf-zone bj-qa

ip-address 10.65.127.24 255.255.255.0 10.65.127.1 10.65.6.15 ""

swarm-mode standalone

wifi0-mode access

wifi1-mode access

g-channel 6+ 21

a-channel 140 26

uplink-vlan 0

g-external-antenna 0

a-external-antenna 0

ap1x-peap-user peap22 282eaf1077b8d898b91ec41b5da19895

The commands in the template are case-sensitive.

IF ELSE ENDIF conditions are supported in the template. If the template text includes the if
condition, % sign is required at the beginning and the end of the text. For example, %if guest%.

The following example shows the template text with the IF ELSE ENDIF condition.

wlan ssid-profile %ssid_name%

%if disable_ssid=true%

disable-ssid

%endif%

%if ssid_security=wpa2%

opmode wpa2-aes

%else%

opmode opensystem

%endif%

Templates also support nesting of the IF ELSE END IF condition blocks.

The following example shows how to nest such blocks:

%if condition1=true%

routing-profile
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route 10.10.0.0 255.255.255.0 10.10.0.255

%if condition2=true%

routing-profile

route 10.20.0.0 255.255.255.0 10.20.0.255

%else%

routing-profile

route 10.30.0.0 255.255.255.0 10.30.0.255

%endif%

%else%

routing-profile

route 10.40.0.0 255.255.255.0 10.40.0.255

%if condition3=true%

routing-profile

route 10.50.0.0 255.255.255.0 10.50.0.255

%else%

routing-profile

route 10.60.0.0 255.255.255.0 10.60.0.255

%endif%

%endif%

For profile configuration CLI text, for example, vlan, interface, access-list, ssid and so on, the first
command must start with no white space. The subsequent local commands in given profile must
start with at least one initial space (' ') or indented as shown in the following examples:

Example 1

vlan 1

name "vlan1"

no untagged 1-24

ip address dhcp-bootp

exit

Example 2

%if vlan_id1%

vlan %vlan_id1%

%if vlan_id1=1%

ip address dhcp-bootp

%endif%

no untagged %_sys_vlan_1_untag_command%

exit

%endif%

To comment out a line in the template text, use the pound sign (#). Any template text preceded by
# is ignored when processing the template.

To allow or restrict APs from joining the Instant AP cluster, Aruba Central uses the _sys_allowed_
ap_ system-defined variable. Use this variable only when allowed APs configuration is enabled. For
example, _sys_allowed_ap: "a_mac, b_mac, c_mac". Use this variable only once in the template.

8. Click OK.
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The variables configured for the Instant AP devices functioning as the VCs are replaced with the values
configured at the template level.
If any device in the cluster has any missing variables, the configuration push to those AP devices in the cluster
fails. The audit trail for such instances shows the missing variables.
You can configure the RF zone for an AP by adding the rf-zone %rfzone% variable in the template. Similarly,
you can add the wifi0-mode %wifi0-mode% variable to configure a Wi-Fi0 interface of an AP to function in the
access, monitor, or spectrum monitor mode.

Sample Template
The following example shows the typical contents allowed in a template file for APs:

virtual-controller-country %countrycode%

virtual-controller-key d2d8c79e010af35667dae85f950cf144b476ab4beba9ce5696

organization %org%

name %VCname%

virtual-controller-ip %vcip%

terminal-access

clock time zone none 00 00

rf-band all

allow-new-aps

allowed-ap 38:17:c3:cd:34:ca

hash-mgmt-password

hash-mgmt-user admin password cleartext public

syslog-level debug

syslog-level warn ap-debug

arm

wide-bands none

a-channels 44,44+,40,36

g-channels 13,1+

min-tx-power 15

max-tx-power 127

band-steering-mode prefer-5ghz

air-time-fairness-mode fair-access

channel-quality-aware-arm-disable

client-match

client-match nb-matching 55

client-match calc-interval 5

client-match slb-mode 2

wlan access-rule default_wired_port_profile

index 0

rule any any match any any any permit

wlan access-rule wired-SetMeUp

index 1

rule masterip 0.0.0.0 match tcp 80 80 permit

rule masterip 0.0.0.0 match tcp 4343 4343 permit

rule any any match udp 67 68 permit

rule any any match udp 53 53 permit

wlan access-rule %ssid_name%

index 2

rule any any match any any any permit

wlan ssid-profile %ssid_name%
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%if disable_ssid=true%

disable-ssid

%endif%

%if ssid_security=wpa2%

opmode wpa2-aes

%else%

opmode opensystem

%endif%

type employee

essid %ssid_name%

wpa-passphrase %pw%

max-authentication-failures 0

auth-server InternalServer

rf-band all

captive-portal disable

dtim-period 1

broadcast-filter arp

blacklist

dmo-channel-utilization-threshold 90

local-probe-req-thresh 0

max-clients-threshold 64

okc

%if condition1=true%

routing-profile

route 10.10.0.0 255.255.255.0 10.10.0.255

%if condition2=true%

routing-profile

route 10.20.0.0 255.255.255.0 10.20.0.255

%else%

routing-profile

route 10.30.0.0 255.255.255.0 10.30.0.255

%endif%

%else%

routing-profile

route 10.40.0.0 255.255.255.0 10.40.0.255

%if condition3=true%

routing-profile

route 10.50.0.0 255.255.255.0 10.50.0.255

%else%

routing-profile

route 10.60.0.0 255.255.255.0 10.60.0.255

%endif%

%endif%

wired-port-profile wired-SetMeUp

switchport-mode access

allowed-vlan all

native-vlan guest

no shutdown

access-rule-name wired-SetMeUp

speed auto

duplex auto

no poe

type guest

captive-portal disable

no dot1x

wired-port-profile default_wired_port_profile

switchport-mode trunk

allowed-vlan all

native-vlan 1

shutdown



Aruba Central | User Guide 432

access-rule-name default_wired_port_profile

speed auto

duplex full

no poe

type employee

captive-portal disable

no dot1x

enet0-port-profile default_wired_port_profile

enet1-port-profile wired-SetMeUp

uplink

preemption

enforce none

failover-internet-pkt-lost-cnt 10

failover-internet-pkt-send-freq 30

failover-vpn-timeout 180

cluster-security

allow-low-assurance-devices

per-ap-settings %_sys_lan_mac%

hostname %hostname%

rf-zone %rfname%

swarm-mode %mode%

wifi0-mode %wifi0mode%

wifi1-mode %wifi1mode%

g-channel %gch% %gtx%

a-channel %ach% %gtx%

Password Management in Configuration Templates for AP
In Aruba Central, the AP management user passwords are stored and displayed as hash instead of plain text.
Password for an AP can be set using the following commands:

mgmt-user <user-name> <password>

mgmt-user <user-name> <password> guest-mgmt

mgmt-user <user-name> <password> read-only

The mgmt-user commands are used for APs running below Aruba Instant 4.3 firmware version.

The hash-mgmt-user commands is enabled by default on the APs provisioned in the template and UI
groups. If a pre-configured AP joins Aruba Central and is moved to a new group, Aruba Central uses the
hash-mgmt-user configuration settings and discardsmgmt-user configuration settings, if any, on the AP.
In other words, Aruba Central hashes management user passwords irrespective of the management user
configuration settings running on an AP.

The mgmt-user commands can only be used for APs running firmware versions equal to or above Aruba Instant
4.3.

Password for AP can be set using the following hash-mgmt-user commands:
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hash-mgmt-user <user-name> password hash <hash-password>

hash-mgmt-user <user-name> password cleartext <cleartext-password>

hash-mgmt-user <user-name> password hash <hash-password> usertype read-only

hash-mgmt-user <user-name> password cleartext <cleartext-password> usertype read-

only

hash-mgmt-user <user-name> password hash <hash-password> usertype guest-mgmt

hash-mgmt-user <user-name> password cleartext <cleartext-password> usertype guest-

mgmt

hash-mgmt-user <user-name> password hash <hash-password> usertype local

hash-mgmt-user <user-name> password cleartext <cleartext-password> usertype local

Aruba Central supports the use of hash commands with clear text, however, Aruba recommends you to use
hash passwords instead of clear text passwords to avoid password disclosures. 
Aruba Central allows you to re-use the hash from one AP on another AP.
All AP templates must include a password command to set a password for the device. The template cannot be
saved without adding a password command. If the configuration that is pushed from Aruba Central to the
device does not contain a password command, the configuration push is aborted for the device and a log is
added to the audit trail. For example, if you add the password command in a condition block and the condition
evaluates to false, the configuration that is pushed will not contain the password command. For more
information, see Managing Password in Configuration Templates



Chapter 7
Aruba Switches

Aruba Switches
Aruba switches enable secure, role-based network access for wired users and devices, independent of their
location or application. With Aruba switches, enterprises can deploy a consistent and secure access to
network resources based on the type of users, client devices, and connection methods.

Aruba Central offers a cloud-based management platform for managing Aruba switch infrastructure. It
simplifies switch management with flexible configuration options, monitoring dashboards, and
troubleshooting tools.

n Getting Started with Aruba Switch Deployments on page 437
n Getting Started with Aruba CX Deployments on page 453
n Provisioning Factory Default Switches on page 439
n Provisioning Pre-Configured Switches on page 443
n Using Configuration Templates for Aruba Switch Management on page 469
n Configuring or Viewing Switch Properties in UI Groups on page 480
n Aruba Switch Stack on page 519
n Monitoring Switches and Switch Stacks on page 560

Supported Aruba Switch Platforms

Aruba Central uses the SSL certificate by GeoTrust Certificate Authority for device termination and web
services. As the SSL certificate is about to expire, Aruba is replacing it with a new certificate from another
trusted Certificate Authority. During the certificate upgrade window, all devices managed by Aruba Central will
be disconnected. After the upgrade, the devices reconnect to Aruba Central and resume their services with
Aruba Central. However, for Aruba switches to reconnect to Aruba Central after the certificate upgrade, you
must ensure that the switches are upgraded to the recommended software version listed in Table 128.
Aruba Central does not support switch software versions below 16.08 release for firmware upgrade. In addition,
only the latest three switch software versions of all major release versions will be available for firmware
upgrade from Aruba Central. For example, if the latest switch software version released is 16.10.0009, the
following versions will be available for firmware upgrade: 16.10.0007, 16.10.0008 and 16.10.0009.

The following tables list the switch platforms, corresponding software versions supported in Aruba Central,
and switch stacking details.
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Switch
Platform

Supported
Software
Versions

Recommended
Software
Versions

Switch Stack-
ing Support

Supported
Stack Type
(Frontplane
(VSF) /
Backplane
(BPS))

Supported
Configuration
Group Type for
Stacking (UI /
Template)

Aruba
2530
Switch
Series

YA/YB.16.05.0008
or later

YA/YB.16.10.0009 N/A N/A N/A

Aruba
2540
Switch
Series

YC.16.03.0004 or
later

YC.16.10.0009 N/A N/A N/A

Aruba
2920
Switch
Series

WB.16.03.0004 or
later

WB.16.10.0009 Yes
Switch
Software
Dependency:
WB.16.04.0008
or later

BPS UI and Template

Aruba
2930F
Switch
Series

WC.16.03.0004 or
later

WC.16.10.0009 Yes
Switch
Software
Dependency:
WC.16.07.0002
or later

VSF UI and Template

Aruba
2930M
Switch
Series

WC.16.04.0008 or
later

WC.16.10.0009 Yes
Switch
Software
Dependency:
WC.16.06.0006
or later

BPS UI and Template

Aruba
3810
Switch
Series

KB.16.03.0004 or
later

KB.16.10.0009 Yes
Switch
Software
Dependency:
KB.16.07.0002
or later

BPS UI and Template

Aruba
5400R
Switch
Series

KB.16.04.0008 or
later

KB.16.10.0009 Yes
Switch
Software
Dependency:
KB.16.06.0008
or later

VSF Template only

Table 128: Supported Aruba Switch Series, Software Versions, and Switch Stacking

Provisioning and configuring of Aruba 5400R switch series and switch stacks is supported only through
configuration templates. Aruba Central does not support moving Aruba 5400R switches from the template
group to a UI group. If an Aruba 5400R switch is pre-assigned to a UI group, then the device is moved to an
unprovisioned group after it joins Aruba Central.
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Mobility Access Switch Series Supported Software Versions

n S1500-12P
n S1500-24P
n S2500-24P
n S3500-24T

ArubaOS 7.3.2.6
ArubaOS 7.4.0.3
ArubaOS 7.4.0.4
ArubaOS 7.4.0.5
ArubaOS 7.4.0.6

Table 129: Supported Aruba Mobility Access Switch Series and Software
Versions

Data sheets and technical specifications for the supported switch platforms are available at:
https://www.arubanetworks.com/products/networking/switches/

Supported Aruba CX Platforms
To manage your Aruba CX switches using Aruba Central, ensure that the switch software is upgraded to
10.05.0001 or a later version. Aruba CX switches with version 10.04.2000 or earlier might not connect to Aruba
Central after ten days of operation. You must upgrade the Aruba CX switch to a recommended software version to
connect to Aruba Central.

The following table lists the Aruba CX platforms, corresponding software versions supported in Aruba
Central, and switch stacking details.

Switch
Platform

Supported
Software
Versions

Recommended
Software
Versions

Switch
Stacking
Support

Supported
Stack
Type

Maximum
Number
of Stack
Members

Supported
Configuration
Group Type
(UI /
Template)

Aruba CX
6200
Switch
Series

10.04.1000 10.05.0010 Yes
Switch
Software
Dependency:
10.04.1000

VSF 8 Template only

Aruba CX
6300
Switch
Series

10.04.0020 10.05.0010 Yes
Switch
Software
Dependency:
10.04.0020

VSF 10 Template only

Aruba CX
6405
Switch
Series

10.04.1000 10.05.0010 -N/A- -N/A- -N/A- Template only

Aruba CX
6410
Switch
Series

10.05.0001 10.05.0010 -N/A- -N/A- -N/A- Template only

Table 130: Supported Aruba CX Switch Series, Software Versions, and Switch Stacking

https://www.arubanetworks.com/products/networking/switches/
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Switch
Platform

Supported
Software
Versions

Recommended
Software
Versions

Switch
Stacking
Support

Supported
Stack
Type

Maximum
Number
of Stack
Members

Supported
Configuration
Group Type
(UI /
Template)

Aruba CX
8320
Switch
Series

10.05.0001 10.05.0010 -N/A- -N/A- -N/A- Template only

Aruba CX
8325
Switch
Series

10.05.0001 10.05.0010 -N/A- -N/A- -N/A- Template only

Provisioning and configuring of Aruba CX switch series and switch stacks is supported only through configuration
templates.

Data sheets and technical specifications for the supported switch platforms are available at:
https://www.arubanetworks.com/products/networking/switches/.

Getting Started with Aruba Switch Deployments
Before you get started with your onboarding and provisioning operations, browse through the list of Aruba
switches supported in Aruba Central.

Provisioning Workflow
The following sections list the steps required for provisioning switches in Aruba Central.

Provisioning a Factory Default Switch
Like most Aruba devices, Aruba Switches support ZTP. Switches with factory default configuration have very
basic configuration for all ports in VLAN-1. When a new switch (factory default) is powered on, it
automatically obtains IP address, connects to Aruba Activate and downloads the provisioning parameters.
When the switch identifies Aruba Central as its management entity, it connects to Aruba Central.

To manage switches from Aruba Central, you must onboard the switches to the device inventory and assign
a valid subscription.

For step-by-step instructions, see Provisioning Factory Default Switches on page 439.

Provisioning a Pre-configured or Locally-Managed Switch
Pre-configured switches have customized configuration; for example, an additional VLAN or static IP
address configured on the default.

Unlike factory default switches, locally managed switches and the switches with custom configuration
require one touch provisioning. These switches do not automatically identify Aruba Central as their
management platform, therefore you must manually enable the Aruba Central management service on
these switches to allow them to connect to Aruba Central.

For step-by-step instructions, see Provisioning Pre-Configured Switches.

https://www.arubanetworks.com/products/networking/switches/


Aruba Central | User Guide 438

Group Assignment
Aruba Central supports provisioning switches in one of the following types of groups:

n UI group—Allows you to customize and manage device parameters using the UI workflows, that is, the
menu options and tabs available underNetwork Operations.

n Template Group—Allows you to configure devices using CLI-based configuration templates.

The following figure illustrates the group assignment workflow in Aruba Central:

Figure 56 Group Assignment-Switches

Configuration and Management
Aruba Central supports managing switch configuration using UI workflows or configuration templates.
Based on your configuration requirements, ensure that you assign switches to either UI group or template
group.

For more information on managing switches in Aruba Central, see the following topics:
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n Using Configuration Templates for Aruba Switch Management on page 469
n Configuring or Viewing Switch Properties in UI Groups on page 480

Switch Monitoring
To view the operation status of switches and health of wired access network:

n In theNetwork Operations app, use the filter to select a group that has switches.
n Under Manage, click Devices > Switches.

For more information, see Monitoring Your Network on page 536.

Troubleshooting and Diagnostics
TheConfiguration Audit page underNetwork Operations > Device(s) > Switches in the Aruba Central
UI displays errors in configuration sync, templates, and a list of configuration overrides. For more
information, see Viewing Configuration Status on page 144.

To troubleshoot switches remotely, use the tools available underNetwork Operations > Analyze
> Tools. For more information, see Using Troubleshooting Tools.

Provisioning Factory Default Switches
Switches that run default configuration either after shipped from a factory or a factory reset are referred to
as factory default switches. This topic describes the steps for provisioning factory default switches in Aruba
Central.

n Step 1: Onboard the Switch to Aruba Central
n Step 2: Assign the Switch to a Group
n Step 3: Connect the Switch to Aruba Central
n Step 4: Provision the Switch to a Group
n Step 5: Verify the Configuration Status

Step 1: Onboard the Switch to Aruba Central
To onboard switches to the device inventory in Aruba Central, complete the following steps:

n Log in to Aruba Central
n Add switches to Aruba Central
n Assign Subscriptions

Step 2: Assign the Switch to a Group
Before assigning a group, determine if the switch must be provisioned in a UI or template group. By default,
Aruba Central assigns the factory default switches to default group. You can create a new group and assign
switch to the new group.

For more information on creating a group, see Creating a Group on page 120.

To assign a device to a group from theAccount Home page:

1. In theAccount Home page, underGlobal Settings, click Device Inventory. The Device Inventory
page is displayed

2. Select the device that you want to assign to a group.



Aruba Central | User Guide 440

3. Click Assign Group. TheAssign a Group to the Selected Devices window is displayed.
4. Select the group to which you want to assign.
5. Click Assign Device(s).

To assign a device to a group from theNetwork Operations app:

6. In theNetwork Operations app, set the filter to Global.
The dashboard context for the group is displayed.

7. UnderMaintain, click Organization > Groups. The Groups page is displayed.
8. From the devices table on the right, select the device that you want to assign to a new group.
9. Drag and drop the device to the group to which you want to assign the device.

Step 3: Connect the Switch to Aruba Central
Switches with factory default configuration have very basic configuration for all ports in VLAN-1 that is
required for obtaining an IP address and automatic provisioning (ZTP). For ZTP, switches must have a valid
IP address, DNS, and NTP configuration.

When a factory default switch is powered on and connected to the Internet, it establishes connection with
Aruba Activate and downloads the provisioning parameters. If the switch is already added and assigned a
subscription, it connects to Aruba Central.

Step 4: Provision the Switch to a Group
When the switch connects to Central, if it is already added to the device inventory and is assigned a
subscription in Aruba Central, Aruba Central assigns it to a pre-assigned group. If there is no pre-assigned
group, Aruba Central moves the device to thedefault group. Based on your configuration requirements,
you create a UI group or template group and assign the switch.

The following figure illustrates the provisioning step required for each group type.
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Figure 57 Switch Provisioning Steps Per Group Type

If the switch is assigned to a new UI group, Aruba Central uses the current configuration of switch as base
configuration and applies it to the other switches that join this group later. You can also modify the
configuration of switches in a group using the UI menu options under theNetwork Operations app >
Manage > Devices > Switches. For more information, see Configuring or Viewing Switch Properties in UI
Groups on page 480.

Provisioning Switches in Template Groups
If you have assigned the switch to a template group, create a new configuration template. To create a
configuration template:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

4. Click the Templates tab. The Templates page is displayed.
5. Click + to add a new template. TheAdd Template window is displayed.
6. In theBasic Info tab, enter a name for the template in the Template Name field.
7. In theDevice Type drop-down, select Aruba Switch.
8. Select the switch model and software version. You can specify any of the following combinations:

n ALL for both Model and Version—To apply the template to all switch models and all supported
switch software versions.
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n ALL forModel and a software version forVersion—To apply the template to all switch models
running the selected software version.

n ALL forVersion and a switch model forModel—To apply the template to a switch model and all
software versions supported by the selected switch model.

n A switch model and a software version—To apply the template to a specific switch model and the
software version. The template created for a switch model and a software version takes
precedence over the template that is created for all platforms and versions.

9. Select the manufacturing part number of the switch in the Part Number drop-down.

The Part Number drop-down is displayed only if you select a switch model in the Model drop-down.
If you select a specific switch model and part number, you can apply the template to a standalone switch
and not to a stack.
If you select All in the Model drop-down, or if you select a switch model and All in the Part Number
drop-down, you can apply a template to both a standalone switch and stack.

10. Click Next. The Template tab is displayed.
11. Build a new template or import configuration information from a switch that is already provisioned in

the template group.
n To build a new template, add the switch command information in the Template text box. Ensure

that the template text adheres to the guidelines listed in Using Configuration Templates for Aruba
Switch Management on page 469.

n To import configuration text from a switch that is already provisioned in the template group:
a. Click Import Configuration As Template.
b. From the search box, select the switch from which you want to import the configuration.

The imported configuration is displayed in the Template text box.

Importing configuration from an existing device in the template group allows you to quickly
create a basic template. However, before applying the template to other switches in the
group, ensure that the template text is variabilized as per your deployment requirements.
For more information, see Managing Variable Files on page 1.
All switch templates must include a password command to set a password for the device.
The switch template cannot be saved without adding a password command. If the
configuration that is pushed from Aruba Central to the device does not contain a password
command, the configuration push is aborted for the device and a log is added to the audit
trail. For example, if you add the password command in a condition block and the condition
evaluates to false, the configuration that is pushed will not contain the password command.
For more information, see Managing Password in Configuration Templates on page 451 .
For more information about using password commands, see the Configuring Username and
Password Security chapter in the HPE ArubaOS-Switch Access Security Guide.

c. To view the variables present in the imported configuration template, click Show Variables
List. The Variables in Template column is displayed.

For more information on variables, see Managing Variable Files on page 130.

d. To download the variables as a CSV or plain text file, click the download icon and select one
of the following options:
n Download .CSV
n Download plain text (.txt)
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12. Click Save. After you apply the configuration template, switches reboot and reconnect to Aruba
Central with the new configuration

Step 5: Verify the Configuration Status
To verify the configuration status:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. Click theConfig icon.

The tabs to configure switches using templates is displayed.

n To verify the configuration status for the template group, click Configuration Audit. The
Configuration Audit dashboard displays the number of devices with template and configuration
synchronization errors.

n To view configuration errors for a specific device, select a switch from the filter bar. The
Configuration Audit dashboard displays the number of template and configuration
synchronization errors for the device.

3. To view template errors, click View Template Errors.
4. To view configuration synchronization errors, click Failed / Pending config changes.
5. To compare running configuration and pending changes, click View under Config Comparsion Tool.

Provisioning Pre-Configured Switches
Unlike factory default switches, locally managed switches and the switches with custom configuration
require one touch provisioning. These switches do not automatically identify Aruba Central as their
management platform, therefore you must manually enable the Aruba Central management service on
these switches to allow them to connect to Aruba Central.

To onboard a locally-managed or a pre-configured switch to Aruba Central, follow one of the following
options:

n Manually enable Aruba Central management service on the switch and connect it to Aruba Central. Aruba
recommends that you use this option if you want to preserve the current configuration running on the
switch. For more information on this procedure, see the workflows described in this topic.

n Reset the switch configuration to factory default and use ZTP to provision the switch. For information on
provisioning factory default switches, see Provisioning Factory Default Switches on page 439.

Aruba Central supports provisioning switches using one of the following methods:

n Pre-provisioning—In this workflow, a switch is added to the device inventory and assigned a group in
Aruba Central before it connects to Aruba Central.

See Workflow 1—Pre-Provisioning a Switch on page 444.

n Onboarding connected switches—In this workflow, Aruba Central onboards the switch that attempts to
connect and then assigns a group.

See Workflow 2—Provisioning a Switch On-Demand on page 448.

The following figure illustrates provisioning procedure for a pre-configured switch.
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Figure 58 Provisioning Workflow for Pre-Configured Switches

Workflow 1—Pre-Provisioning a Switch
The pre-provisioning workflow includes the following steps:

n Step 1: Onboard the Switch to Aruba Central
n Step 2: Assign the Switch to a Group
n Step 3: Enable Aruba Central Management Service on the Switch
n Step 4: Provision the Switch to a Group
n Step 5: Verify the configuration Status

Step 1: Onboard the Switch to Aruba Central
To onboard switches to the device inventory in Aruba Central, complete the following steps:

n Log in to Aruba Central
n Add switches to Aruba Central
n Assign Subscriptions
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Step 2: Assign the Switch to a Group
Before assigning a group, determine if the switch must be provisioned in a UI or template group. If you
want to preserve the existing configuration on the switch, Aruba recommends that you create a new group
for the switch.

For more information on creating a group, see Creating a Group on page 120.

To assign a device to a group from theAccount Home page:

1. In theAccount Home page, underGlobal Settings, click Device Inventory.

The Device Inventory page is displayed

2. Click Assign Group. TheAssign a Group to the Selected Devices window is displayed.
3. Select the group to which you want to assign.
4. Click Assign Device(s).

To assign a device to a group from theNetwork Operations app:

5. In theNetwork Operations app, set the filter to Global.
The dashboard context for the group is displayed.

6. UnderMaintain, click Organization > Groups.

The Groups page is displayed.

7. From the devices table on the right, select the device that you want to assign to a new group.
8. Drag and drop the device to the group to which you want to assign the device.

Step 3: Enable Aruba Central Management Service on the Switch
A locally-managed or pre-configured switch cannot connect to Aruba Central, unless it is configured to
identify Aruba Central as its management entity. To manage such a device from Aruba Central, you must
manually enable the provisioning and management service on the switch.

1. Verify if the Activate provisioning service is enabled by executing the following command at the
switch CLI:

switch)# show activate provision

configuration and Status - Activate Provision Service

Activate Provision Service : Enabled

Activate Server Address : device.arubanetworks.com

If the Activate provision service is not enabled, execute the following command at

the switch CLI:

(switch)# activate provision enable
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To enable switches to automatically connect to Aruba Central, enforce ZTP on the

switch:

(switch)# activate provision force

The switch establishes connection with Activate and is directed to Aruba Central. If

the switch is already added to the device inventory and is assigned a subscription,

Aruba Central assigns it to a pre-assigned group.

Step 4: Provision the Switch to a Group
When the switch connects to Aruba Central, Aruba Central automatically assigns it to the pre-assigned
group. The following figure illustrates the provisioning steps for each group type.

Figure 59 Switch Provisioning Steps Per Group Type

If the switch is assigned to a new UI group, you can modify the configuration of switches in a group using
the UI menu options under theNetwork Operations app > Manage > Devices > Switches. For more
information, see Configuring or Viewing Switch Properties in UI Groups on page 480.

If you have assigned the switch to a template group, you can import the existing configuration to a new
configuration template and apply this template to other devices in the group. To create a configuration
template using the existing configuration on the switch:
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1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

4. Click the Templates tab. The Templates page is displayed.
5. Click + to add a new template. TheAdd Template window is displayed.
6. In theBasic Info tab, enter a name for the template in the Template Name field.
7. In theDevice Type drop-down, select Aruba Switch.
8. Select the switch model and software version. You can specify any of the following combinations:

n ALL for both Model and Version—To apply the template to all switch models and all supported
switch software versions.

n ALL forModel and a software version forVersion—To apply the template to all switch models
running the selected software version.

n ALL forVersion and a switch model forModel—To apply the template to a switch model and all
software versions supported by the selected switch model.

n A switch model and a software version—To apply the template to a specific switch model and the
software version. The template created for a switch model and a software version takes
precedence over the template that is created for all platforms and versions.

9. Select the manufacturing part number of the switch in the Part Number drop-down.

The Part Number drop-down is displayed only if you select a switch model in the Model drop-down.
If you select a specific switch model and part number, you can apply the template to a standalone
switch and not to a stack.
If you select All in the Model drop-down, or if you select a switch model and All in the Part Number
drop-down, you can apply a template to both a standalone switch and stack

10. Click Next. The Template tab is displayed.
11. Build a new template or import configuration information from a switch that is already provisioned in

the template group.
n To build a new template, add the switch command information in the Template text box. Ensure

that the template text adheres to the guidelines listed in Using Configuration Templates for Aruba
Switch Management on page 469.

n To import configuration text from a switch that is already provisioned in the template group:
a. Click Import Configuration As Template.
b. From the search box, select the switch from which you want to import the configuration.

The imported configuration is displayed in the Template text box.
c. If required, modify the configuration parameters. Ensure that the template text adheres to

the guidelines listed in Using Configuration Templates for Aruba Switch Management on
page 469.
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Importing configuration from the switch allows you to quickly create a basic configuration
template that you can apply for all devices in a template group. Before applying the template
to other switches in the group, ensure that the template text is variabilized based on the
deployment requirements. For more information on configuration templates and variable
definitions, see Using Configuration Templates for Switch Management on page 1 and
Managing Variable Files on page 1.
All switch templates must include a password command to set a password for the device.
The template cannot be saved without adding a password command. If the configuration that
is pushed from Aruba Central to the device does not contain a password command, the
configuration push is aborted for the device and a log is added to the audit trail. For example,
if you add the password command in a condition block and the condition evaluates to false,
the configuration that is pushed will not contain the password command. For more
information, see Managing Password in Configuration Templates on page 451.
For more information about using password commands, see the Configuring Username and
Password Security chapter in the HPE ArubaOS-Switch Access Security Guide.

d. To view the variables present in the imported configuration template, click Show Variables
List. The Variables in Template column is displayed.

For more information on variables, see Managing Variable Files on page 130.

e. To download the variables as a CSV or plain text file, click the download icon and select one
of the following options:
n Download .CSV
n Download plain text (.txt)

12. Click Save. After you apply the configuration template, switches reboot and reconnect to Aruba
Central with the new configuration.

Step 5: Verify the configuration Status
To verify the configuration status:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

n To verify the configuration status for the template group, click Configuration Audit. The
Configuration Audit dashboard displays the number of devices with template and configuration
synchronization errors.

n To view configuration errors for a specific device, select a switch from the filter bar. The
Configuration Audit dashboard displays the number of template and configuration
synchronization errors for the device.

4. To view template errors, click View Template Errors.
5. To view configuration synchronization errors, click Failed / Pending config changes.
6. To compare running configuration and pending changes, click View under Config Comparsion Tool.

Workflow 2—Provisioning a Switch On-Demand
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To dynamically provision switches on-demand, complete the following steps:

n Step 1: Enable Aruba Central Management Service on the Switch
n Step 2: Add the Switch to Aruba Central
n Step 3: Assign a Subscription
n Step 4: Provision the Switch to a Group
n Step 5: Verify the configuration Status

Step 1: Enable Aruba Central Management Service on the Switch
A locally-managed or pre-configured switch cannot connect to Aruba Central, unless it is configured to
identify Aruba Central as its management entity. To manage such a device from Aruba Central, you must
manually enable the provisioning and management service on the switch.

1. Verify if the Activate provisioning service is enabled by executing the following command at the
switch CLI:

switch)# show activate provision

configuration and Status - Activate Provision Service

Activate Provision Service : Enabled

Activate Server Address : device.arubanetworks.com

2. If the Activate provision service is not enabled, execute the following command at the switch CLI:

(switch)# activate provision enable

3. To enable switches to automatically connect to Aruba Central, enforce ZTP on the switch:

(switch)# activate provision force

The switch establishes connection with Activate. Activate directs the switch to Aruba Central.

Step 2: Add the Switch to Aruba Central
Add the switch to the Aruba Central device inventory. For more information, see Onboarding Devices on
page 91.

Step 3: Assign a Subscription
To allow Aruba Central to manage the switch, ensure that a valid subscription is assigned to the switch. For
more information, see Managing Subscriptions on page 98.

Step 4: Provision the Switch to a Group
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If the switch has a valid subscription assigned, Aruba Central marks the switch as unprovisioned. To
preserve the switch configuration, move it to a new group.

To move the device to a template group:

1. Create a template group.
2. On theGroups page, select the switch.
3. Drag and drop the switch to the new template group that you just created. Aruba Central adds the

switch to the new template group.
4. To import switch configuration to a new configuration template:

a. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon.

The tabs to configure switches using templates is displayed.

d. Click the Templates tab. The Templates page is displayed.
e. Click + to add a new template. TheAdd Template window is displayed.
f. In theBasic Info tab, enter a name for the template in the Template Name field.
g. In theDevice Type drop-down, select Aruba Switch.
h. Select the switch model and the software version to which you want to apply the new

template. You can specify any of the following combinations:
n ALL for both Model and Version—To apply the template to all switch models and all

supported switch software versions.
n ALL forModel and a software version forVersion—To apply the template to all switch

models running the selected software version.
n ALL forVersion and a switch model forModel—To apply the template to a switch model

and all software versions supported by the selected switch model.
n A switch model and a software version—To apply the template to a specific switch model

and the software version. The template created for a switch model and a software version
takes precedence over the template that is created for all platforms and versions.

i. Select the manufacturing part number of the switch in the Part Number drop-down.

The Part Number drop-down is displayed only if you select a switch model in the Model drop-
down.
If you select a specific switch model and part number, you can apply the template to a
standalone switch and not to a stack
If you select All in the Model drop-down, or if you select a switch model and All in the Part
Number drop-down, you can apply a template to both a standalone switch and stack

j. Click Next. The Template tab is displayed.
k. Build a new template or import configuration information from a switch that is already

provisioned in the template group. See step 11.
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Importing configuration from the switch allows you to quickly create a basic configuration
template that you can apply for all devices in a template group. Before applying the template to
other switches in the group, ensure that the template text is variabilized based on the
deployment requirements. For more information on configuration templates and variable
definitions, see Using Configuration Templates for Switch Management on page 1 and
Managing Variable Files on page 1.
All switch templates must include a password command to set a password for the device. The
template cannot be saved without adding a password command. If the configuration that is
pushed from Aruba Central to the device does not contain a password command, the
configuration push is aborted for the device and a log is added to the audit trail. For example, if
you add the password command in a condition block and the condition evaluates to false, the
configuration that is pushed will not contain the password command. For more information, see
Managing Password in Configuration Templates on page 451.
For more information about using password commands, see the Configuring Username and
Password Security chapter in the HPE ArubaOS-Switch Access Security Guide.

l. To view the variables present in the imported configuration template, click Show Variables
List. The Variables in Template column is displayed.

For more information on variables, see Managing Variable Files on page 130.

m. To download the variables as a CSV or plain text file, click the download icon and select one of
the following options:
n Download .CSV
n Download plain text (.txt)

n. Click Save. After you apply the configuration template, switches reboot and reconnect to
Aruba Central with the new configuration.

Step 5: Verify the configuration Status
To verify the configuration status:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

n To verify the configuration status for the template group, click Configuration Audit. The
Configuration Audit dashboard displays the number of devices with template and configuration
synchronization errors.

n To view configuration errors for a specific device, select a switch from the filter bar. The
Configuration Audit dashboard displays the number of template and configuration
synchronization errors for the device.

4. To view template errors, click View Template Errors.
5. To view configuration synchronization errors, click Failed / Pending config changes.
6. To compare running configuration and pending changes, click View under Config Comparsion Tool.

Managing Password in Configuration Templates
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All IAP and switch templates must include a password command to set a password for the device. The
template cannot be saved without adding a password command. If the configuration that is pushed from
Aruba Central to the switch does not contain a password command, the configuration push is aborted for
the device and a log is added to the audit trail. For example, if you add the password command in a
condition block and the condition evaluates to false, the configuration that is pushed will not contain the
password command.

When configuring a password, you must add the include-credentials command in the template. This
command stores the password in the running-config file associated with the switch. Aruba Central
automatically executes this command while reading the switch configuration.
For Aruba CX switches, you must configure the password only in plaintext.

Password for Switches
The following format of the passwords can be set on Aruba Switch series:

password manager plaintext <string>

password manager sha1 <string>

password manager sha256 <string>

password manager user-name <string> plaintext <string>

password manager user-name <string> sha1 <string>

password manager user-name <string> sha256 <string>

The following format of the passwords can be set on Aruba CX switches:

user admin group administrators password plaintext <string>

Password for APs
The following format of the passwords can be set on the APs:

mgmt-user <STRING:username:User_name> { <STRING:password:Password> }

hash-mgmt-user <STRING:username:User_name> password cleartext <STRING:cleartext_

password:Password>
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hash-mgmt-user <STRING:username:User_name> password hash <STRING:hash_

password:Password>

Setting Password using Variables
User cannot enter the entire password line in a variable. The following examples show the valid and invalid
format for entering password using a variable.

Valid format where the variable contains only the password (for example, %pass_var% = Aruba@123) for the
device:

hostname "Aruba-2930M-24G"

password manager plaintext "%pass_var%"

include-credentials

no cwmp enable

Invalid format where the variable contains the password command (for example, %pass_var% = password

manager plaintext Aruba@123) for the device:

hostname "Aruba-2930M-24G"

%pass_var%

include-credentials

no cwmp enable

Getting Started with Aruba CX Deployments
Before you get started with your onboarding and provisioning operations, browse through the list of
Supported Aruba CX Platforms on page 436 in Aruba Central.

Provisioning Workflow
The following sections list the steps required for provisioning Aruba CX switches in Aruba Central.

Provisioning a Factory Default Switch
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Like most Aruba devices, Aruba CX switches support ZTP. Switches with factory default configuration have
very basic configuration for all ports in VLAN-1. When a new Aruba CX switch (factory default) is powered
on, it automatically obtains IP address, connects to Aruba Activate and downloads the provisioning
parameters. When the switch identifies Aruba Central as its management entity, it connects to Aruba
Central.

To manage Aruba CX switches from Aruba Central, you must onboard the switches to the device inventory
and assign a valid subscription.

For step-by-step instructions, see Provisioning Factory Default Aruba CX Switches on page 459.

Provisioning a Pre-configured or Locally-Managed Switch
Pre-configured switches have customized configuration; for example, an additional VLAN or static IP
address configured on the default.

Aruba Central management service is enabled by default on Aruba CX switches. When the switch is powered
on, it identifies Aruba Central as its management entity and connects to Aruba Central.

To manage Aruba CX switches from Aruba Central, you must onboard the switches to the device inventory
and assign a valid subscription.

For step-by-step instructions, see Provisioning Pre-Configured Aruba CX Switches on page 462.

Group Assignment
Aruba Central supports provisioning Aruba CX switches in template groups. Template groups allow you to
configure devices using CLI-based configuration templates.

The following figure illustrates the group assignment workflow in Aruba Central:
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Figure 60 Group Assignment-Switches

Configuration and Management
Aruba Central supports managing Aruba CX switches configuration using configuration templates only.
Ensure that you assign the Aruba CX switches to a template group.

When initially onboarding an Aruba CX switch to Aruba Central, you must manually create the template for the
switch in a group, along with the password in plaintext format. You can use the output of the show running-

config command to create the template. You can also add variables to use the same template for onboarding
multiple Aruba CX switches.

For more information on managing Aruba CX switches in Aruba Central, see Using Configuration Templates
for Aruba CX Switch Management on page 475.

Switch Monitoring
To view the operation status of switches and health of wired access network:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or Sites.
For all devices, set the filter to Global. Ensure that the filter selected contains at least one active switch.
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The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

For more information, see Monitoring Your Network on page 536.

To view Aruba CX switches in the monitoring pages, you must create a template configuration for the switch with
the password in plaintext. See Using Configuration Templates for Aruba CX Switch Management on page 475.

Viewing VSX Details
Aruba Central displays information about VSX configuration of Aruba CX switches. For more information,
see Switch > VSX on page 587.

Last synced data is displayed in the Switch > VSX page only when VSX synchronization is enabled for the Aruba CX
switch. However, enabling VSX synchronization using template configuration in Aruba Central is not
recommended. By enabling VSX synchronization, the peer switch may get into an unknown configuration state.

Viewing Topology Map
In Aruba Central, the Topology tab in the site dashboard provides a graphical representation of the site
including the network layout, details of the devices deployed and health of the WAN uplinks and tunnels.
Aruba Central supports Aruba CX switches to be displayed in the Topology tab. For more information, see
Monitoring Sites in the Topology Tab on page 711.

To view Aruba CX switches in the topology map, you must create a template configuration for the switch with the
password in plaintext. See Using Configuration Templates for Aruba Switch Management on page 469.

Troubleshooting and Diagnostics
If you are unable to view all details of the Aruba CX switch, then maybe the template configuration was not
applied correctly, the password was missing in the template configuration, or the password was not in
plaintext. See the audit trail to check the status of the switch. The audit trail should show the device
onboarded message for the switch serial number followed by the configuration push and login successful
messages. For more information on troubleshooting Aruba CX switch onboarding issues, see
Troubleshooting Aruba CX Switch Onboarding Issues on page 592.

Configuration Audit
TheConfiguration Audit page underNetwork Operations > Device(s) > Switches in the Aruba Central
UI displays errors in configuration sync, templates, and a list of configuration overrides. For more
information, see Viewing Configuration Status on page 144.

Troubleshooting Tools
To troubleshoot Aruba CX switches remotely, use the tools available underNetwork Operations >
Analyze > Tools. For more information, see Using Troubleshooting Tools on page 169.

Actions Drop-down
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You can also reboot, connect to the remote console of the switch, or generate a tech support dump for
troubleshooting the device, by using the tools available under theActions drop-down. TheActions drop-
down is available in the switch monitoring pages.

TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port

443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Limitations of Aruba CX Switch in Aruba Central
There are a few limitations while managing and monitoring Aruba CX switches using Aruba Central. The
following sections provide details on the limitations while onboarding, configuring, monitoring, and
troubleshooting Aruba CX switches using Aruba Central.

Onboarding
The following limitations should be taken into consideration when onboarding Aruba CX switches in Aruba
Central:

n ZTP does not work on inline data ports for Aruba CX 8320 and 8325 switch series. The following is an
example configuration for onboarding Aruba CX 8320 and 8325 switch series to Aruba Central:

interface 1/1/1

no shutdown

no routing

interface vlan 1

ip address <IP-ADDRESS/MASK>

ip route 0.0.0.0/0 <IP-GATEWAY>

ip dns server-address <DNS-SERVER>

https-server vrf default

ztp force-provision

n After the erase startup-config command is executed on the Aruba CX switches, the switches do not
onboard to Aruba Central. It is recommended to execute the erase all zeroize command, instead of
the erase startup-config command.

n When an Aruba CX switch is first onboarded to Aruba Central, Aruba Central must perform the following
actions, before it can perform events such as rebooting the switch and upgrading the firmware:

l Login to the switch using the password provided in the template configuration

l Apply the template to the switch
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Applying Template
The following limitations should be taken into consideration when applying the template to Aruba CX
switches in Aruba Central:

n You must configure the admin password in the template configuration only in plaintext. The format of
the password configuration command must be user admin group administrators password

plaintext <string>.

n If the template for Aruba CX switches contains % in the configuration, Aruba Central will not save the
configuration.

Although the % character is allowed in Aruba CX switches, for example in banners, the same is not
allowed in Aruba Central. In Aruba Central, the % character is reserved for variables.

n The maximum number of lines supported in the configuration template is 84000. Beyond this limit,
Aruba Central will not apply the template to the Aruba CX switch.

n The Import Configuration as Template option is not displayed for Aruba CX switches on theAdd
Template window. When initially onboarding an Aruba CX switch to Aruba Central, you must manually
create the template for the switch by using the output of the show running-config command.

Configuring Aruba CX VSF Stack
The following are the VSF stacking limitations of Aruba CX switches in Aruba Central:

Aruba Central supports only a few functions related to Aruba CX switch stack, such as onboarding a stack to
Aruba Central and replacing member switches having the same model and part number, through template
configuration. All other stacking related functions, such as creating a stack, deleting, or adding a new
member to the stack, must be performed offline, that is, outside Aruba Central. These stacking related
functions must be performed before or after onboarding the stack to Aruba Central depending on the
function.

For example, you must create a stack offline before onboarding the stack to Aruba Central. For more
information, see Aruba CX VSF Stack on page 527.

Aruba CX VSF Stack Related Functions Not Supported on Aruba Central
The following stack related functions are not supported on Aruba Central:

n Creating a new stack
n Adding a new member to an existing stack
n Deleting a member from the stack
n Replacing a member with different part number
n Modifying standby member ID
n Adding, deleting, and modifying VSF links

Using Aruba CX VSX
The following limitations apply when configuring VSX or viewing VSX data for Aruba CX switches in Aruba
Central:

n Enabling VSX synchronization using template configuration in Aruba Central is not recommended. By
enabling VSX synchronization, the peer switch might get into an unknown configuration state.

n Last synced data is not displayed on theVSX page, in Aruba Central, if VSX synchronization is not
enabled.
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Managing Firmware Upgrade
To upgrade an Aruba CX switch in Aruba Central, a WAN connection with a minimum speed of 2 Mbps is
required. The upgrade activity will time out after a period of 60 minutes.

Troubleshooting
The following are the limitations while troubleshooting Aruba CX switches in Aruba Central:

n For Aruba CX 8320 and 8325 switch series, to use the remote console feature, you must enable SSH
server on the VRF that the switch uses to connect to Aruba Central. You must add one of the following
commands in the template:

l If the switch is connecting to Aruba Central using the inline default VRF, add ssh server vrf default to the
template.

l If the switch is connecting to Aruba Central using the OOBM management VRF, add ssh server vrf mgmt to
the template.
n TheChassis Locate option, in theAnalyze > Tools > Device Check tab, is not displayed for Aruba CX

8320 and 8325 switch series.

Monitoring
In the monitoring pages in Aruba Central, the IP address for the connected wired clients on Aruba CX
switches might not be displayed. For more information, see Switch > Clients > Clients on page 574.

Provisioning Factory Default Aruba CX Switches
Switches that run default configuration either after shipped from a factory or a factory reset are referred to
as factory default switches. This topic describes the steps for provisioning factory default switches in Aruba
Central.

n Step 1: Onboard the Aruba CX Switch to Aruba Central
n Step 2: Assign the Aruba CX Switch to a Group
n Step 3: Connect the Aruba CX Switch to Aruba Central
n Step 4: Provision the Aruba CX Switch to a Group
n Step 5: Verify the Configuration Status

Step 1: Onboard the Aruba CX Switch to Aruba Central
To onboard switches to the device inventory in Aruba Central, complete the following steps:

n Log in to Aruba Central
n Add switches to Aruba Central
n Assign Subscriptions

Step 2: Assign the Aruba CX Switch to a Group
Before assigning a group, determine if the switch must be provisioned in a UI or template group. By default,
Aruba Central assigns the factory default switches to default group. You can create a new group and assign
switch to the new group.

For more information on creating a group, see Creating a Group on page 120.

To assign a device to a group from theAccount Home page:
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1. In theAccount Home page, underGlobal Settings, click Device Inventory. The Device Inventory
page is displayed

2. Select the device that you want to assign to a group.
3. Click Assign Group. TheAssign a Group to the Selected Devices window is displayed.
4. Select the group to which you want to assign.
5. Click Assign Device(s).

To assign a device to a group from theNetwork Operations app:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the group is displayed.

2. UnderMaintain, click Organization > Groups. The Groups page is displayed.
3. From the devices table on the right, select the device that you want to assign to a new group.
4. Drag and drop the device to the group to which you want to assign the device.

Step 3: Connect the Aruba CX Switch to Aruba Central
Switches with factory default configuration have very basic configuration for all ports in VLAN-1 that is
required for obtaining an IP address and automatic provisioning (ZTP). For ZTP, switches must have a valid
IP address, DNS, and NTP configuration.

When a factory default switch is powered on and connected to the Internet, it establishes connection with
Aruba Activate and downloads the provisioning parameters. If the switch is already added and assigned a
subscription, it connects to Aruba Central.

Step 4: Provision the Aruba CX Switch to a Group
When the switch connects to Central, if it is already added to the device inventory and is assigned a
subscription in Aruba Central, Aruba Central assigns it to a pre-assigned group. If there is no pre-assigned
group, Aruba Central moves the device to thedefault group. Based on your configuration requirements,
you create a template group and assign the switch.

Provisioning Switches in Template Groups
After assigning the switch to a template group, create a new configuration template. To create a
configuration template:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

1. Click the Templates tab. The Templates page is displayed.
2. Click + to add a new template. TheAdd Template window is displayed.
3. In theBasic Info tab, enter a name for the template in the Template Name field.
4. In theDevice Type drop-down, select Aruba CX.
5. Select the switch model and software version. You can specify any of the following combinations:

n ALL for both Model and Version—To apply the template to all switch models and all supported
switch software versions.
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n ALL forModel and a software version forVersion—To apply the template to all switch models
running the selected software version.

n ALL forVersion and a switch model forModel—To apply the template to a switch model and all
software versions supported by the selected switch model.

n A switch model and a software version—To apply the template to a specific switch model and the
software version. The template created for a switch model and a software version takes
precedence over the template that is created for all platforms and versions.

6. Select the manufacturing part number of the switch in the Part Number drop-down.

The Part Number drop-down is displayed only if you select a switch model in the Model drop-down.
If you select a specific switch model and part number, you can apply the template to a standalone
switch and not to a stack.
If you select All in the Model drop-down, or if you select a switch model and All in the Part Number
drop-down, you can apply a template to both a standalone switch and stack.

7. Click Next. The Template tab is displayed.
8. Build a new template by adding the output of the show running-config from the switch CLI in the

Template text box. Ensure that the template text adheres to the guidelines listed in Important
Points to Note on page 476.

You must manually create the template for the CX switch in a group, along with the password in
plaintext format. You can use the output of the show running-config command to create the template.
You can also add variables to use the same template for onboarding multiple CX switches. For more
information on variables, see Managing Variable Files on page 1.
All switch templates must include a password command to set a password for the device. The template
cannot be saved without adding a password command. If the configuration that is pushed from Aruba
Central to the device does not contain a password command, the configuration push is aborted for the
device and a log is added to the audit trail. For example, if you add the password command in a
condition block and the condition evaluates to false, the configuration that is pushed will not contain the
password command. For more information, see Managing Password in Configuration Templates on
page 451.
For Aruba CX switches, you must configure the password only in plaintext. Also, the format of password
must be user admin group administrators password plaintext <string>.

9. Click Save. After you apply the configuration template, switches reboot and reconnect to Aruba
Central with the new configuration.

Step 5: Verify the Configuration Status
To verify the configuration status:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

n To verify the configuration status for the template group, click Configuration Audit. The
Configuration Audit dashboard displays the number of devices with template and configuration
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synchronization errors.
n To view configuration errors for a specific device, select a switch from the filter bar. The

Configuration Audit dashboard displays the number of template and configuration
synchronization errors for the device.

4. To view template errors, click View Template Errors.
5. To view configuration synchronization errors, click Failed / Pending config changes.
6. To compare running configuration and pending changes, click View under Config Comparsion Tool.

Provisioning Pre-Configured Aruba CX Switches
Unlike factory default switches, locally managed switches and the switches with custom configuration
require one touch provisioning. On Aruba CX switches, Aruba Central is enabled, by default, as their
management platform, and therefore the switches connect to Aruba Central automatically.

To onboard a locally-managed or a pre-configured Aruba CX switch to Aruba Central, follow one of the
following options:

n Connect the Aruba CX switch directly to Aruba Central. Aruba recommends that you use this option if
you want to preserve the current configuration running on the switch. For more information on this
procedure, see the workflows described in this topic.

n Reset the switch configuration to factory default and use ZTP to provision the switch. For information on
provisioning factory default switches, see Provisioning Factory Default Aruba CX Switches on page 459.

Aruba Central supports provisioning Aruba CX switches using one of the following methods:

n Pre-provisioning—In this workflow, a switch is added to the device inventory and assigned a group in
Aruba Central before it connects to Aruba Central.

See Workflow 1—Pre-Provisioning an Aruba CX Switch.

n Onboarding connected switches—In this workflow, Aruba Central onboards the switch that attempts to
connect and then assigns a group.

See Workflow 2—Provisioning an Aruba CX Switch On-Demand.

The following figure illustrates provisioning procedure for a pre-configured switch.



Provisioning Pre-Configured Aruba CX Switches | 463

Figure 61 Provisioning Workflow for Pre-Configured Switches

Workflow 1—Pre-Provisioning an Aruba CX Switch
The pre-provisioning workflow includes the following steps:

n Step 1: Onboard the Aruba CX Switch to Aruba Central
n Step 2: Assign the Aruba CX Switch to a Group
n Step 3: Provision the Aruba CX Switch to a Group
n Step 4: Verify the Configuration Status

Step 1: Onboard the Aruba CX Switch to Aruba Central
To onboard Aruba CX switches to the device inventory in Aruba Central, complete the following steps:

n Log in to Aruba Central
n Add switches to Aruba Central
n Assign Subscriptions

Step 2: Assign the Aruba CX Switch to a Group
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Aruba CX switches can be provisioned in a template group only. If you want to preserve the existing
configuration on the switch, Aruba recommends that you create a new group for the switch.

For more information on creating a group, see Creating a Group on page 120.

To assign a device to a group from theAccount Home page:

1. In theAccount Home page, underGlobal Settings, click Device Inventory.

The Device Inventory page is displayed

2. Select the device that you want to assign to a group.
3. Click Assign Group. TheAssign a Group to the Selected Devices window is displayed.
4. Select the group to which you want to assign.
5. Click Assign Device(s).

To assign a device to a group from theNetwork Operations app:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the group is displayed.

2. UnderMaintain, click Organization > Groups.

The Groups page is displayed.

3. From the devices table on the right, select the device that you want to assign to a new group.
4. Drag and drop the device to the group to which you want to assign the device.

Step 3: Provision the Aruba CX Switch to a Group
When the Aruba CX switch connects to Aruba Central, Aruba Central automatically assigns it to the pre-
assigned template group.

You can import the existing switch configuration to a new configuration template and apply this template to
other devices in the group. To create a configuration template using the existing configuration on the
switch:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

4. Click the Templates tab. The Templates page is displayed.
5. Click + to add a new template. TheAdd Template window is displayed.
6. In theBasic Info tab, enter a name for the template in the Template Name field.
7. In theDevice Type drop-down, select Aruba CX.
8. Select the switch model and software version. You can specify any of the following combinations:

n ALL for both Model and Version—To apply the template to all switch models and all supported
switch software versions.

n ALL forModel and a software version forVersion—To apply the template to all switch models
running the selected software version.

n ALL forVersion and a switch model forModel—To apply the template to a switch model and all
software versions supported by the selected switch model.
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n A switch model and a software version—To apply the template to a specific switch model and the
software version. The template created for a switch model and a software version takes
precedence over the template that is created for all platforms and versions.

9. Select the manufacturing part number of the switch in the Part Number drop-down.

The Part Number drop-down is displayed only if you select a switch model in the Model drop-down.
If you select a specific switch model and part number, you can apply the template to a standalone
switch and not to a stack.
If you select All in the Model drop-down, or if you select a switch model and All in the Part Number
drop-down, you can apply a template to both a standalone switch and stack.

10. Click Next. The Template tab is displayed.
11. Build a new template by adding the output of the show running-config from the switch CLI in the

Template text box. Ensure that the template text adheres to the guidelines listed in Important
Points to Note on page 476.

You must manually create the template for the CX switch in a group, along with the password in
plaintext format. You can use the output of the show running-config command to create the template.
You can also add variables to use the same template for onboarding multiple CX switches. For more
information on variables, see Managing Variable Files on page 1.
All switch templates must include a password command to set a password for the device. The template
cannot be saved without adding a password command. If the configuration that is pushed from Aruba
Central to the device does not contain a password command, the configuration push is aborted for the
device and a log is added to the audit trail. For example, if you add the password command in a
condition block and the condition evaluates to false, the configuration that is pushed will not contain the
password command. For more information, see Managing Password in Configuration Templates on
page 451.
For Aruba CX switches, you must configure the password only in plaintext. Also, the format of password
must be user admin group administrators password plaintext <string>.
For Aruba CX switches, the password configured in the template must match the password configured
on the switch. Aruba Central cannot override the password that is configured on the switch.

12. Click Save. After you apply the configuration template, switches reboot and reconnect to Aruba
Central with the new configuration.

Step 4: Verify the Configuration Status
To verify the configuration status:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

n To verify the configuration status for the template group, click Configuration Audit. The
Configuration Audit dashboard displays the number of devices with template and configuration
synchronization errors.
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n To view configuration errors for a specific device, select a switch from the filter bar. The
Configuration Audit dashboard displays the number of template and configuration
synchronization errors for the device.

4. To view template errors, click View Template Errors.
5. To view configuration synchronization errors, click Failed / Pending config changes.
6. To compare running configuration and pending changes, click View under Config Comparsion Tool.

Workflow 2—Provisioning an Aruba CX Switch On-Demand
To dynamically provision switches on-demand, complete the following steps:

n Step 1: Add the Aruba CX Switch to Aruba Central
n Step 2 Assign a Subscription to the Aruba CX Switch
n Step 3: Provision the Aruba CX Switch to a Group
n Step 4: Verify the Configuration Status

Step 1: Add the Aruba CX Switch to Aruba Central
Add the switch to the Aruba Central device inventory. For more information, see Onboarding Devices on
page 91

Step 2 Assign a Subscription to the Aruba CX Switch
To allow Aruba Central to manage the switch, ensure that a valid subscription is assigned to the switch. For
more information, see Managing Subscriptions on page 98.

Step 3: Provision the Aruba CX Switch to a Group
If the switch has a valid subscription assigned, Aruba Central marks the switch as unprovisioned. To
preserve the switch configuration, move it to a new template group.

1. UnderMaintain, click Organization > Groups.
2. Select the device.
3. Click Import configuration to New Group. The Import configuration window is displayed.
4. Enter a name for the group.
5. Configure a password for the group.
6. Click Import configuration. Aruba Central imports the switch configuration to the new group.

1. Create a template group.
2. In theNetwork Operations app, set the filter to Global.

The dashboard context for the group is displayed.

3. UnderMaintain, click Organization > Groups.

The Groups page is displayed.

4. Select the Aruba CX switch.
5. Drag and drop the switch to the new template group that you just created. Aruba Central adds the

switch to the new template group.
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6. To build a new configuration template:

a. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.

c. Click theConfig icon.

The tabs to configure switches using templates is displayed.

d. Click the Templates tab. The Templates page is displayed.

e. Click + to add a new template. TheAdd Template window is displayed.

f. In theBasic Info tab, enter a name for the template in the Template Name field.

g. In theDevice Type drop-down, select Aruba CX.

h. Select the switch model and the software version to which you want to apply the new template.
You can specify any of the following combinations:
n ALL for both Model and Version—To apply the template to all switch models and all

supported switch software versions.
n ALL forModel and a software version forVersion—To apply the template to all switch

models running the selected software version.
n ALL forVersion and a switch model forModel—To apply the template to a switch model

and all software versions supported by the selected switch model.
n A switch model and a software version—To apply the template to a specific switch model and

the software version. The template created for a switch model and a software version takes
precedence over the template that is created for all platforms and versions.

n A switch model and a software version—To apply the template to a specific switch model and
the software version. The template created for a switch model and a software version takes
precedence over the template that is created for all platforms and versions.

i. Select the manufacturing part number of the switch in the Part Number drop-down.

The Part Number drop-down is displayed only if you select a switch model in the Model drop-down.
a specific switch model and part number, you can apply the template to a standalone switch and
not to a stack.
All in the Model drop-down, or if you select a switch model and All in the Part Number drop-
down, you can apply a template to both a standalone switch and stack.

j. Click Next. The Template tab is displayed.

k. Build a new template by adding the output of the show running-config from the switch CLI in
the Template text box. Ensure that the template text adheres to the guidelines listed in the
Important Points to Note on page 476.
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You must manually create the template for the CX switch in a group, along with the password in
plaintext format. You can use the output of the show running-config command to create the
template. You can also add variables to use the same template for onboarding multiple CX
switches. For more information on variables, see Managing Variable Files on page 1.
All switch templates must include a password command to set a password for the device. The
template cannot be saved without adding a password command. If the configuration that is pushed
from Aruba Central to the device does not contain a password command, the configuration push is
aborted for the device and a log is added to the audit trail. For example, if you add the password
command in a condition block and the condition evaluates to false, the configuration that is pushed
will not contain the password command. For more information, see Managing Password in
Configuration Templates on page 451.
For Aruba CX switches, you must configure the password only in plaintext. Also, the format of
password must be user admin group administrators password plaintext <string>.
For Aruba CX switches, the password configured in the template must match the password
configured on the switch. Aruba Central cannot override the password that is configured on the
switch.

l. Click Save. After you apply the configuration template, switches reboot and reconnect to Aruba
Central with the new configuration.

Step 4: Verify the Configuration Status
To verify the configuration status:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

n To verify the configuration status for the template group, click Configuration Audit. The
Configuration Audit dashboard displays the number of devices with template and configuration
synchronization errors.

n To view configuration errors for a specific device, select a switch from the filter bar. The
Configuration Audit dashboard displays the number of template and configuration
synchronization errors for the device.

4. To view template errors, click View Template Errors.
5. To view configuration synchronization errors, click Failed / Pending config changes.
6. To compare running configuration and pending changes, click View under Config Comparsion Tool.

Configuring Aruba Switches
Aruba Central supports provisioning switches in UI and template groups. Aruba Central supports basic
configuration options in the UI.

The users can also assign switches to template groups and use configuration templates and variables to
manage switches from Aruba Central.

See the following topics for more information on managing switches and switch stacks in Aruba Central:
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n Using Configuration Templates for Aruba Switch Management on page 469
n Configuring or Viewing Switch Properties in UI Groups on page 480
n Aruba Switch Stack on page 519
n Aruba CX VSF Stack on page 527

CA Certificate Installation using API and Templates
This feature is supported for switches with a minimum firmware version of 16.09.

Aruba Central supports the installation of CA certificates through templates and APIs. Typically, an
administrator uses an NB API to push the CA certificate to the Aruba Central certificate store. The
certificates must be pushed to the certificate store of the same tenant. After that, use the ArubaOS-Switch
CLI commands in an Aruba Central template to push the certificate as part of the configuration audit.

If the certificate push or install process is not successful, the Aruba Central audit logs display the specific
failure. Only those certificates that are installed through Aruba Central are monitored by Aruba Central.
Other switch certificates are not supported for monitoring.

Use the following command to push the CA certificate: cert-prof name “<name of cert>”

For example, if the certificate name is ca_cert_1, the following is the format of the command: cert-prof
name “ca_cert_1”.

Points to Note

n Unlike IAPs and Gateways, where a certificate cannot be deleted if it is referenced in a template or a
variable, in switches, users can delete a certificate even if it is referenced in a template or a variable.

n Deleting an existing certificate and creating a new certificate with the same name but with different
certificate data does not guarantee that the new certificate is installed for switches. Re-apply the
template or variable to ensure that the change is propagated.

Using Configuration Templates for Aruba Switch
Management
Templates in Aruba Central refer to a set of configuration commands that can be used by the administrators
for provisioning devices in a group. Configuration templates enable administrators to apply a set of
configuration parameters simultaneously to multiple switches in a group and thus automate switch
deployments.

To minimize configuration errors and troubleshoot device-specific configuration issues, Aruba recommends
that the device administrators familiarize themselves with the CLI configuration commands available on Aruba
Switch.

Creating a Group for Template-Based Configuration
For template-based provisioning, switches must be assigned to a group with template-based configuration
method enabled.

For more information, see Managing Groups on page 120 and Assigning Devices to Groups on page 121.

Creating a Configuration Template
To create a configuration template for switches:
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1. In theNetwork Operations app, set the filter to a template group.
The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.
4. Click the Templates tab. The Templates page is displayed.
5. Click + to add a new template. TheAdd Template window is displayed.
6. In theBasic Info tab, enter a name for the template in the Template Name field.
7. In theDevice Type drop-down, select Aruba Switch.
8. Select the switch model and software version. You can specify any of the following combinations:

n ALL for both Model and Version—To apply the template to all switch models and all supported
switch software versions.

n ALL forModel and a software version forVersion—To apply the template to all switch models
running the selected software version.

n ALL forVersion and a switch model forModel—To apply the template to a switch model and all
software versions supported by the selected switch model.
A switch model and a software version—To apply the template to a specific switch model and the
software version. The template created for a switch model and a software version takes
precedence over the template that is created for all platforms and versions.

9. Select the manufacturing part number of the switch in the Part Number drop-down.

The Part Number drop-down is displayed only if you select a switch model in the Model drop-down.
If you select a specific switch model and part number, you can apply the template to a standalone switch
and not to a stack.
If you select All in the Model drop-down, or if you select a switch model and All in the Part Number
drop-down, you can apply a template to both a standalone switch and stack.

10. Click Next. The Template tab is displayed.
11. Build a new template or import configuration information from a switch that is already provisioned in

the template group.
n To build a new template, add the switch command information in the Template text box. Ensure

that the template text adheres to the guidelines listed in the Important Points to Note on page
471.
To import configuration text from a switch that is already provisioned in the template group:

a. Click Import Configuration As Template.
b. From the search box, select the switch from which you want to import the configuration.

The imported configuration is displayed in the Template text box.
c. If required, modify the configuration parameters. Ensure that the template text adheres to

the guidelines listed in the Important Points to Note on page 471.
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Importing configuration from an existing device in the template group allows you to quickly
create a basic template. However, before applying the template to other switches in the
group, ensure that the template text is variabilized as per your deployment requirements.
For more information on variable definitions, see Managing Variable Files on page 130.
All switch templates must include a password command to set a password for the device.
The template cannot be saved without adding a password command. If the configuration
that is pushed from Aruba Central to the device does not contain a password command, the
configuration push is aborted for the device and a log is added to the audit trail. For
example, if you add the password command in a condition block and the condition evaluates
to false, the configuration that is pushed will not contain the password command. For more
information, see Managing Password in Configuration Templates on page 451.
For more information about using password commands, see the Configuring Username and
Password Security chapter in the HPE ArubaOS-Switch Access Security Guide.

d. To view the variables present in the imported configuration template, click Show Variables
List. The Variables in Template column is displayed.
For more information on variables, see Managing Variable Files on page 130.

e. To download the variables as a CSV or plain text file, click the download icon and select one
of the following options:
n Download .CSV
n Download plain text (.txt)

12. Click Save. After you apply the configuration template, switches reboot and reconnect to Aruba
Central with the new configuration.

Important Points to Note
Note the following points when adding configuration text to a template:

n The CLI syntax in the switch template must be accurate. Aruba recommends that you validate the
configuration syntax on the switch before adding it to the template text.

n Ensure that the command text indentation matches the indentation in the running configuration.
n The commands in the template are case-sensitive.

When configuring a password, you must add the include-credentials command in the template. This
command stores the password in the running-config file associated with the switch. Aruba Central
automatically executes this command while reading the switch configuration.

The following example illustrates the case discrepancies that the users must avoid in the template text:

trunk E1-E4 trk1 trunk

interface Trk1

dhcp-snooping trust
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exit

trunk E1-E4 trk1 trunk

switch-interconnect trk1

trunk E5-E6 trk2 trunk

vlan 5

name "VLAN5"

untagged Trk2

tagged Trk1

isolate-list Trk1

ip igmp forcedfastleave Trk1

ip igmp blocked Trk1

ip igmp forward Trk1

forbid Trk1

loop-protect Trk2
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trunk E1-E4 trk1 trunk

trunk E4-E5 trk2 trunk

spanning-tree Trk1 priority 4

spanning-tree Trk2 admin-edge-port

trunk A2-A4 trk1 trunk

igmp fastlearn Trk1

trunk E4-E5 trk2 trunk

ip source-binding 2 4.5.6.7 b05ada-96a4a0 Trk2

[no] ip source-binding trap OutOfResources

snmp-server mib hpSwitchAuthMIB ..

snmp-server mib hpicfMACsec unsecured-access ..
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[no] lldp config <P-PORT-LIST> dot1TlvEnable ..

[no] lldp config <P-PORT-LIST> medTlvEnable ..

no lldp config <P-PORT-LIST> medPortLocation..

[no] lldp config <P-PORT-LIST> dot3TlvEnable ..

[no] lldp config <P-PORT-LIST> basicTlvEnable ..

[no] lldp config <P-PORT-LIST> ipAddrEnable <lldp-ip>

trunk-load-balance L4-based

trunk-load-balance L3-based

Best Practices
Aruba recommends you to follow the below steps to use configuration templates in managing switches:
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1. Configure the switch.
2. Add the switch to Aruba Central.
3. Create the template, You can use Import template option to import an existing template created

for switches.
4. Modify the template based on the user requirement. For example, addition or removal of variables.
5. Save the edited template.

Using Configuration Templates for Aruba CX Switch
Management
Templates in Aruba Central refer to a set of configuration commands that can be used by the administrators
for provisioning devices in a group. Configuration templates enable administrators to apply a set of
configuration parameters simultaneously to multiple switches in a group and thus automate switch
deployments

To minimize configuration errors and troubleshoot device-specific configuration issues, Aruba recommends
that the device administrators familiarize themselves with the CLI configuration commands available on Aruba
CX switches.

Creating a Group for Template-Based Configuration
For template-based provisioning, switches must be assigned to a group with template-based configuration
method enabled.

For more information, see Managing Groups on page 120 and Assigning Devices to Groups on page 121.

Aruba CX switches can only be configured using configuration templates.

You cannot move a Aruba CX switch from a template group to a UI group in Aruba Central. If attempted, a
warning is displayed that the Aruba CX switch cannot be moved to a UI group, because UI group is not
supported on Aruba CX switches.

When you onboard a factory default Aruba CX switch, the switch is listed under Unassigned Devices in the
Organization > Groups page, because UI group is not supported on Aruba CX switches.

When you pre-provision a Aruba CX switch, the switch is listed under Unassigned Devices in the Organization
> Groups page, because UI group is not available for Aruba CX switches.

For Aruba CX switches, the Import Configuration to New Group feature is not supported.

Creating a Configuration Template
To create a configuration template for switches:

1. In theNetwork Operations app, set the filter to a template group.

The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
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3. Click theConfig icon.

The tabs to configure switches using templates is displayed.

4. Click the Templates tab. The Templates page is displayed.
5. Click + to add a new template. TheAdd Template window is displayed.
6. In theBasic Info tab, enter a name for the template in the Template Name field.
7. In theDevice Type drop-down, select Aruba CX.
8. Select the switch model and software version. You can specify any of the following combinations:

n ALL for both Model and Version—To apply the template to all switch models and all supported
switch software versions.

n ALL forModel and a software version forVersion—To apply the template to all switch models
running the selected software version.

n ALL forVersion and a switch model forModel—To apply the template to a switch model and all
software versions supported by the selected switch model.

n A switch model and a software version—To apply the template to a specific switch model and the
software version. The template created for a switch model and a software version takes
precedence over the template that is created for all platforms and versions.

9. Select the manufacturing part number of the switch in the Part Number drop-down.

The Part Number drop-down is displayed only if you select a switch model in the Model drop-down.
If you select a specific switch model and part number, you can apply the template to a standalone switch
and not to a stack.
If you select All in the Model drop-down, or if you select a switch model and All in the Part Number
drop-down, you can apply a template to both a standalone switch and stack.

10. Click Next. The Template tab is displayed.
11. Build a new template by adding the output of the show running-config from the switch CLI in the

Template text box. Ensure that the template text adheres to the guidelines listed in the Important
Points to Note on page 476.

You must manually create the template for the Aruba CX switch in a group, along with the password in
plaintext format. You can use the output of the show running-config command to create the
template. You can also add variables to use the same template for onboarding multiple Aruba CX
switches. For more information on variables, see Managing Variable Files on page 130.
All switch templates must include a password command to set a password for the device. The template
cannot be saved without adding a password command. If the configuration that is pushed from Aruba
Central to the device does not contain a password command, the configuration push is aborted for the
device and a log is added to the audit trail. For example, if you add the password command in a
condition block and the condition evaluates to false, the configuration that is pushed will not contain the
password command. For more information, see Managing Password in Configuration Templates on
page 451.
For Aruba CX switches, you must configure the password only in plaintext. Also, the format of password
must be user admin group administrators password plaintext <string>.

12. Click Save. After you apply the configuration template, switches reboot and reconnect to Aruba
Central with the new configuration

Important Points to Note
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Note the following points when adding configuration text to a template:

n The CLI syntax in the switch template must be accurate. Aruba recommends that you validate the
configuration syntax on the switch before adding it to the template text.

n Ensure that the command text indentation matches the indentation in the running configuration.
n The commands in the template are case-sensitive.

The following example illustrates the case discrepancies that the users must avoid in the template text:

trunk E1-E4 trk1 trunk

interface Trk1

dhcp-snooping trust

exit

trunk E1-E4 trk1 trunk

switch-interconnect trk1

trunk E5-E6 trk2 trunk

vlan 5

name "VLAN5"

untagged Trk2

tagged Trk1

isolate-list Trk1

ip igmp forcedfastleave Trk1
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ip igmp blocked Trk1

ip igmp forward Trk1

forbid Trk1

loop-protect Trk2

trunk E1-E4 trk1 trunk

trunk E4-E5 trk2 trunk

spanning-tree Trk1 priority 4

spanning-tree Trk2 admin-edge-port

trunk A2-A4 trk1 trunk

igmp fastlearn Trk1

trunk E4-E5 trk2 trunk

ip source-binding 2 4.5.6.7 b05ada-96a4a0 Trk2
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[no] ip source-binding trap OutOfResources

snmp-server mib hpSwitchAuthMIB ..

snmp-server mib hpicfMACsec unsecured-access ..

[no] lldp config <P-PORT-LIST> dot1TlvEnable ..

[no] lldp config <P-PORT-LIST> medTlvEnable ..

no lldp config <P-PORT-LIST> medPortLocation..

[no] lldp config <P-PORT-LIST> dot3TlvEnable ..

[no] lldp config <P-PORT-LIST> basicTlvEnable ..

[no] lldp config <P-PORT-LIST> ipAddrEnable <lldp-ip>
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trunk-load-balance L4-based

trunk-load-balance L3-based

Configuring or Viewing Switch Properties in UI
Groups
This section describes the configuration and viewing procedures for the switches in the UI groups.

Aruba Central does not support pre-configured switches in a UI group. If you want to move a switch from a
template group to a UI group, you must clear the switch configuration, delete the device from Aruba Central,
and then provision the switch as a new device in a UI group.

To configure or view properties of the switches provisioned in UI groups, perform the following procedure:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click the config icon to edit the switch properties. Tabs to access different configuration pages are
displayed.

The following table describes the different configuration pages and their functions.

Tab Function

Switches Configure or view general switch properties, such as, hostname, type of IP
addressing, and so on.
See Configuring or Viewing the Switch Properties.

Stacks Create stacks, add members, or view stacking details such as stack type, stack id,
topology, and so on.
See Configuring Switch Stacks using UI Groups.

Ports Assign or view port properties, such as, PoE, access policies, and trunk groups.
See Configuring Switch Ports on Aruba Switches

Table 131: Tabs for Configuring Switches Provisioned in a UI Group
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Tab Function

PoE Configure or view PoE settings for each port.
See Configuring PoE Settings on Aruba Switch Ports.

Trunk Groups Configure or view trunk groups and their associated properties, such as, members of
the trunk group, type of trunk group, and so on.
See Configuring Trunk Groups on Aruba Switches in UI Groups.

VLANs Configure or view VLANs and the associated ports and access policies.
See Configuring VLANs on Aruba Switches

Spanning Tree Configure or view spanning tree protocol and its associated properties.
See Enabling Spanning Tree Protocol on Aruba Switches in UI Groups

Loop
Protection

Configure or view loop protection and its associated properties.
See Configuring Loop Protection on Aruba Switch Ports.

Access Policy Add or view access policies.
See Configuring Access Policies on Aruba Switches.

DHCP Snooping Configure or view DHCP snooping, authorized DHCP servers IP addresses, and their
associated properties.
See Configuring DHCP Snooping on Aruba Switches.

Port Rate Limit View or specify bandwidth to be used for inbound or outbound traffic for each port.
See Configuring Port Rate Limit on Aruba Switches in UI Groups.

Radius Configure or view RADIUS (Remote Authentication Dial-In User Service) server settings
on switches.

See Configuring RADIUS Server Settings on Aruba Switches.

Tunnel Node
Server

Configure or view tunneled node on switches.
See Configuring Tunnel Node Server on Aruba Switches.

Authentication Configure or view 802.1X authentication and MAC authentication for switches.
See Configuring Authentication for Aruba Switches.

Access/DNS Configure or view the administrator and operator logins.
See Configuring System Parameters for Aruba Switches.

Time Configure time synchronization in switches.
See Configuring Time Synchronization on Aruba Switches.

SNMP Add or view SNMP community and its trap destination.
See Configuring SNMP on Aruba Switches.

CDP Configure CDP and its associated properties.
See Configuring CDP on Aruba Switches.

Routing Configure or view a specific routing path to a gateway.
See Configuring Routing on Aruba Switches.

DHCP Pools Add or view a DHCP pool and its associated properties.
See Configuring DHCP Pools on Aruba Switches.
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Tab Function

IGMP Configure IGMP and its associated properties.
See Configuring IGMP on Aruba Switches.

QoS Create QoS traffic policies. define QoS classes and change the priorities of traffic on
switches.
See Configuring QoS Settings on Aruba Switches.

Device Profie Configure or view device profile settings on switches.
See Configuring Device Profile.

Configuration
Audit

View configuration sync errors and overrides.
See Viewing Configuration Status.

Configuring or Viewing the Switch Properties
When you add a switch to a group, the switch inherits the configuration of the group.

It is not recommended to add a switch with an existing configuration to a group that already has a defined
configuration. Aruba Central permits device-level overrides, however the overrides are resolved or preserved
based on the requirements.

You can create a new group and add a pre-configured switch to that group so that the group inherits the
configuration of the switch. If the switch inherits the group configuration, the configuration parameters are
already defined. If required, you can edit these parameters. All factory default switches are provisioned in a
new group and these parameters can also be defined at the group level.

To edit the configuration parameters for the switch in an UI group, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click the Switches tab.
The Switches page is displayed with the following information.
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Name Description Value

MAC Address MAC address of the switch. Property inherited from the switch.

Hostname Name of the host. A string.

IP Assignment Method of IP assignment as static or
DHCP.

Static or DHCP.

IP Address IP address for static IP assignment. IPv4 address.

Netmask Netmask for static IP assignment. Netmask address.

Default
Gateway

Default gateway for static IP assignment. IPv4 address.

Location Location of the switch. For example: Portland, Oregon.

Contact Email address or phone number. For example:
admin@xyzcompany.com.

Table 132: Switches Parameters

3. To edit the switch configuration parameters, select the row you want to edit and click the edit icon.
The Edit Switches window is displayed.

4. Edit the required parameters.

In the Switches page, you can edit only Hostname, Location, and Contact information. Use the VLANs
page to configure IP Assignment, IP address, Netmask and Default Gateway parameters. For more
information, see Configuring VLANs on Aruba Switches on page 487.

5. Click OK.
6. Click Save Settings.

Configuring Switch Ports on Aruba Switches
To view the port details of a switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
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d. UnderManage, click Device.
The tabs to configure the switch is displayed.

2. Click Interface > Ports. The Ports page is displayed with the list of ports configured on the switch.

For the Aruba Mobility Access Switches, the Ports page displays the following information:

Name Description Value

Port Number Indicates the number assigned to
the switch port.

Dependent on the type of switch.

Admin Status Indicates the operational status of
the port.

Up or Down.

Port Mode Indicates the mode of operation.
The port can be configured to
function in Trunk or Access mode.

Trunk Mode or Access Mode.

By default, a port is in Access mode and carries
traffic only for the VLAN to which it is assigned. In
Trunk mode, a port can carry traffic for multiple
VLANs.

VLAN Shows the VLAN to which the port
is assigned. Based on the port
mode, you can assign different
types of VLAN.

n For Access mode, an Access VLAN can be
specified.
n For Trunk mode, the Native VLAN and
Allowed VLAN can be configured.

Auto
Negotiation

Indicates the status of the Auto
Negotiation.

n If auto negotiation is enabled, the Speed
and Duplex fields are automatically set to
Auto.

n If auto negotiation is disabled, the speed
can be set to 10 Mbps, 100 Mbps, or 1 Gbps
and the duplex mode can be set to half or full.

Speed/Duplex Displays the speed and duplex
configuration settings for the client
traffic.

Trusted Indicates if the port is trusted.

Table 133: Ports Page—Mobility Access Switches

For Aruba switches, the Ports page displays the following information:

Name Description Value

Port Number Indicates the number assigned to the switch port. Dependent on the
switch type.

Name Name of the port for easy identification. For example:
UPLINK-SRVR-
ROOM.

Table 134: Ports Page—Aruba Switches
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Name Description Value

You can add or edit port names. However, do not delete port
names as it may cause config push to fail. The config push
failure may also arise if you move a switch from a group
configured with port names to a new group. This issue is only
applicable to switch firmware versions earlier than 16.08.0002.

Admin Status Allows you to set the operational status of the port. Up or Down

Speed-Duplex
(Mbps)

Allows you to set the maximum bandwidth of the port traffic. Select from drop-
down menu.

Default is Auto.

Tunneled Indicates whether the port is tunneled or not. Enable or
Disable
To configure a
Tunnel Node
Server, see
Configuring
Tunnel Node
Server on Aruba
Switches

DHCP Snooping Status of port to filter DHCP messages received at the port. Trust or Untrust
See Configuring
DHCP Snooping
on Aruba
Switches.

Access Policy
(In)

Allows you to apply an existing access policy for the inbound
traffic on the port.

Select from drop-
down menu.
See Configuring
Access Policies on
Aruba Switches.

Access Policy
(Out)

Allows you to apply an existing access policy for the outbound
traffic on the port.

Select from drop-
down menu.
See Configuring
Access Policies on
Aruba Switches.

Trunk Group Displays the name of the trunk group to which the port is
assigned.

To configure a
Trunk Group, see
Configuring Trunk
Groups on Aruba
Switches in UI
Groups.

3. Select the port row, click Edit. The Edit Ports window is displayed.
4. Configure the required parameters.
5. Click Save.

Configuring PoE Settings on Aruba Switch Ports
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Power over Ethernet (PoE) is a technology that allows the switches to deliver power to the powered devices
(PD). If you have switches provisioned in UI groups, you can enable or disable PoE operation on switch
ports. The PoE page displays the configuration details of all PoE enabled ports.

To configure the PoE settings of a switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Interface > PoE. The PoE page is displayed.
3. Select the port(s) you want to edit and click Edit.

The Edit Power Over Ethernet Settings window is displayed.
4. Configure the following parameters:

Name Description Value

Port The number assigned to the switch port. The port number is auto-generated
and cannot be changed in the settings.

Auto-
generated
port
number

PoE The status of the PoE operation on the port. When PoE is enabled, the switch
sends power to the powered device (PD).

Enabled
or
Disabled

Priority The PoE priority level of the port. If there is not enough power available to
provision all active PoE ports, then PoE ports at priority level as critical are
powered first, then high and low priority at the last.

Low, High
or Critical

LLDP MED
TLV (PoE)

The status of the LLDP MED TLV configuration. Switches use LLDP to
repeatedly query the PD to discover the power requirement and send the
exact power required.

Enabled
or
Disabled

LLDP Dot3
TLV (PoE+)

The status of the LLDP Dot3 TLV configuration. Enabled
or
Disabled

Table 135: PoE Parameters
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Name Description Value

Allocation
By

The PoE power allocation method used for the port. If usage is selected, then
the allocation is made based on the automatic allocation by the PD. If class is
selected, then the allocation is made based on class of the PD.

Usage or
Class

Pre Std
Detect

The status of support for pre-standard devices. When this option is enabled,
switch supports some pre-802.3af devices.

Enabled
or
Disabled

Configured
type

The user-defined identifier for the port to identify its intended use. A string

The status of LLDP in PoE page is displayed as Enabled only if one or both LLDP settings (LLDP MED TLV
(PoE) and LLDP Dot3 TLV (PoE+)) are enabled for the port.

5. Click OK.
6. Click Save Settings.

Configuring VLANs on Aruba Switches
The Aruba switches support the following types of VLANs:

n Port-based VLANs—In the case of trusted interfaces, all untagged traffic is assigned a VLAN based on the
incoming port.

n Tag-based VLANs—In the case of trusted interfaces, all tagged traffic is assigned a VLAN based on the
incoming tag.

The Aruba Mobility Access Switch also supports the following types of VLANs:

n Voice VLANs—You can use voice VLANs to separate voice traffic from data traffic when the voice and
data traffic are carried over the same Ethernet link.

n MAC-based VLANs—In the case of untrusted interfaces, you can associate a client to a VLAN based on
the source MAC of the packet. Based on the MAC, you can assign a role to the user after authentication.

Adding VLAN Details
By default, all ports in the Switches are assigned to VLAN 1. However, if the ports are assigned to different
VLANs, the VLANs page displays their details.

To add a VLAN, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.



Aruba Central | User Guide 488

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Interface > VLANs. The VLANs page is displayed.
3. In theVLANs Settings accordion, click + to add a VLAN and configure the following parameters.

Name Description Value

Name The name of the VLAN. A string

IP
Assignment

The method of IP assignment.
The static option is displayed only at the device level.
The options to assign Primary VLAN and Management VLAN are
displayed only when you select Static or DHCP.

Static, DHCP, or
Disabled
Default: DHCP

IP Address The IP address for static IP assignment.
This field is enabled only when you select Static from the IP
Assignment drop-down.

IPv4 address

Netmask The netmask for static IP assignment.
This field is enabled only when you select Static from the IP
Assignment drop-down.

IPv4 address

DHCP Server Indicates whether the switch is configured as the DHCP server on
the VLAN.

n This field is enabled only when you select Static from the IP
Assignment drop-down.
n You can enable DHCP Server option only when there are no
DHCP Helper IP addresses configured.

Toggle switch to
the on or off
position

DHCP Helper
IP

IP address of the DHCP helper server for that VLAN.
n You can configure a maximum of 16 DHCP helper IP
addresses for each VLAN.
n You can configure DHCP Helper IP addresses only when
DHCP Server option is disabled.

IPv4 address

Voice Indicates whether support for voice VLANs are enabled for the
VLAN interface.

Toggle switch to
the on or off
position

Primary
VLAN

Indicates whether the VLAN is assigned as the primary VLAN for the
switches. To assign primary VLAN, at least one tagged or untagged
port should be configured. This is a mandatory field.

Toggle switch to
the on or off
position

Management
VLAN

Indicates whether the VLAN is assigned as the management VLAN
for the switches.

Toggle switch to
the on or off
position

Table 136: Configuring and Viewing VLAN Parameters
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Name Description Value

Default
Gateway

Default gateway for static IP assignment. This field is enabled only
when you select Static from the IP Assignment drop-down.

IPv4 address

Jumbo Indicates whether jumbo packet handling is enabled for the VLAN
interface.

Toggle switch to
the on or off
position

Access Policy
(In)

The security policy that you want to apply for the inbound traffic. See Configuring
Access Policies
on Aruba
Switches.Access Policy

(Out)
The security policy that you want to apply for the outbound traffic.

VLAN Access
Policy (In)

The security policy that you want to apply for the bridged and
routed inbound packets on the VLAN.

VLAN Access
Policy (Out)

The security policy that you want to apply for the bridged and
routed outbound packets on the VLAN.

4. To configure the VLAN ports, complete the following steps:

a. In the Ports table, select the port number(s).

b. Select any of the following port modes:
n Tagged Ports
n Untagged Ports
n None

5. To assign the VLAN to a trunk group, select the trunk group in the Trunk Groups table.
6. Click OK.
7. Click Save Settings.

When you upgrade to Aruba Central version 2.5.2, the static IP address configured at group level for VLANs is
migrated to device level and preserved as overrides. The static IP assignment is available only at the device
level.

Editing the VLAN Details
To edit the details of a VLAN, point to the row for the VLAN, and click the edit icon in theActions column,
and configure the parameters.

Deleting VLAN Details
To delete the VLAN details, complete the following steps:

1. Ensure that the VLANs are not tagged to any ports.
2. Point to the row for the VLAN, and click the edit icon in theActions column.

VLAN 1 is the primary VLAN and cannot be deleted.
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Configuring DHCP Relay Settings
You can configure a switch as a DHCP relay agent for transmitting DHCP messages between the
DHCP server and client. You can also configure the option-82 feature for the switch to include DHCP relay
information in the forwarded DHCP request messages.

To configure a switch as a DHCP relay agent, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Interface > VLANs. The VLANs page is displayed.
3. Expand theDHCP Relay Settings accordion.
4. To enable DHCP relay, move theDHCP Relay toggle switch to the on position.

DHCP Relay option is enabled by default.

5. To enable option-82 feature, move theDHCP Relay Option 82 toggle switch to the on position.
6. Click Save Settings.

Configuring Trunk Groups on Aruba Switches in UI Groups
If you have switches provisioned in an UI group, Aruba Central enables you to configure port trunking on
these switches using the UI workflows. The network administrator can configure a trunk group on switches
to create one logical link or a trunk by aggregating multiple links. The trunk link functions as a high-speed
link to provide increased bandwidth.

A trunk group is a set of up to eight ports configured as members of the same port trunk.

Aruba Switch Platform Valid Trunk Groups

Aruba 2540 Switch Series Trk1-Trk26

Aruba 2920 Switch Series
Aruba 2930F Switch Series
Aruba 2930M Switch Series

Trk1-Trk60

Table 137: Trunk Group configuration Support Per Switch Platform



Configuring or Viewing Switch Properties in UI Groups | 491

Aruba Switch Platform Valid Trunk Groups

Aruba 2530 Switch Series Trk1-Trk24

Aruba 3810 Switch Series Trk1-Trk144

The following are some guidelines:

n All ports in the same trunk group must be of the same trunk type (LACP or trunk.)
n The names of the trunk groups include the prefix Trk followed by the numbers in a sequential order. For

example, Trk1, Trk2 and so on.
n When STP is enabled on the switch, the STP configuration is applied for all ports at the trunk group level.

Individual ports cannot be configured for STP or VLAN operation.

Adding Trunk Groups on Switches
To configure a trunk group on switches:

Ensure that the switches are onboarded and provisioned to a UI group in Aruba Central.

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. Click theConfig icon to view the switch configuration dashboard.
c. UnderManage, click Devices > Switches.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Interface > Trunk Groups. The Trunk Groups page is displayed.
3. In the Trunk Groups table, click + to add a trunk group and configure the following parameters:

Name Description Value

Name Indicates the number assigned to the switch port. String.

Type A name of the port for easy identification. Trunk or LACP.

Untagged
VLANs

If the switch ports are untagged, select a VLAN from the Untagged
VLAN list.

Select from drop-
down menu.

Table 138: Ports Page—Aruba Switches
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Name Description Value

Tagged
VLANs

If the switch ports are tagged, select the VLANs from the Tagged
VLAN list.

Select from drop-
down menu.

Ports Select the ports for trunking. You can use up to eight ports for link
aggregation. The ports in a trunk group need not be consecutive.

Select from drop-
down menu.

DHCP
Snooping

Select the status of port to filter DHCP messages received at the port. Trust or Untrust.
Default is Untrust.

4. Click OK.
5. Click Save Settings.

Editing Trunk Groups on Switches
To edit details of a trunk group, point to the row for the trunk group, and click the edit icon and configure
the parameters.

Deleting Trunk Groups on Switches
To delete a trunk group, point to the row for the trunk group, and click the delete icon.

Enabling Spanning Tree Protocol on Aruba Switches in
UI Groups

This is a beta feature and not recommended for a production environment.

The Spanning Tree Protocol (STP) eliminates Layer 2 loops in networks, by selectively blocking some ports
and allowing other ports to forward traffic, based on global (bridge) and local (port) parameters you can
configure.

STP is always disabled by default on Aruba switches. To configure STP for switches provisioned in the UI
groups:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
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d. UnderManage, click Device.
The tabs to configure the switch is displayed.

2. Click Interface > Spanning Tree. The Spanning Tree page is displayed.
3. Enable MSTP if you want to avoid bridge loops between network nodes and to maintain a single

active path between the network nodes. MSTP will be enabled for all VLANs assigned to switch ports.
If you have a trunk group configured for the switches in the group, MSTP is enabled at the trunk
level.

4. Set the priority of the UI group.
5. To configure MSTP parameters for ports, select the port row(s) in Port Settings, click Edit.
6. To configure MSTP parameters for trunks, select the trunk group row(s) in Trunk Group Settings,

click Edit.
7. Configure the following MSTP parameters for ports or trunks of individual switches:

Name Description Value

Priority A number used to identify the root bridge in an STP instance. The
switch with the lowest value has the highest priority and is the root
bridge. A higher numerical value means a lower priority; thus, the
highest priority is 0.

When the switches in a network select their root bridge, two
parameters are considered, the STP priority and the MAC address of
the switch. All Aruba switches have a default STP priority of 8. So the
switch with the lowest MAC automatically gets selected as a root
bridge. This is not a recommended process as it randomizes the
selection of the root bridge.

0 – 8
Default: 8

BPDU
Protection

A security feature used to protect the active STP topology by
preventing spoofed BPDU packets from entering the STP domain. In a
typical implementation, BPDU protection is applied to the edge ports
and access ports connected to end-user devices that do not run STP. If
STP BPDU packets are received on a protected port, the port is
disabled and the network manager is alerted via SNMP traps.

Enable or
Disable
Default: Disable

BPDU
Filter

Enables control of STP participation for each port. The feature can be
used to exclude specific ports from becoming part of STP operations.
A port with the BPDU filter enabled ignores incoming BPDU packets
and stays locked in the STP forwarding state. All other ports maintain
their role.

Recommended ports for BPDU filter: Ports or trunks connected to
client devices.

Enable or
Disable
Default: Disable

Admin-
Edge

When set, the port directly goes into forwarding state.
This configuration is not recommended for ports which connect to
infrastructure devices. A BPDU guard also assists when a port
inadvertently goes into a forwarding state.

Enable or
Disable
Default: Disable

Root
Guard

Sets the port to ignore superior BPDUs to prevent the switch from
becoming the Root Port.

Enable or
Disable
Default: Disable

Table 139: Viewing or Configuring Port and Trunk Settings
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Name Description Value

Trunk
Group

Sets the trunk group to which the port is assigned. Enable or
Disable
Default: Disable

Configuring Loop Protection on Aruba Switch Ports

Enabling Loop Protection consumes CPU resources.

Loop protection provides protection against loops by transmitting loop protocol packets out of ports. For
switches provisioned in UI groups, administrators can enable or disable loop protection on the switch ports
or trunks by using the menu options available under the Network Operations app.

Loop protection is always disabled by default on Aruba switches. To configure loop protection for switches
provisioned in the UI groups:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Interface > Loop Protection. The Loop Protection page is displayed.
3. Depending on whether you want to configure a port or trunk, complete one of the following steps:

n In the Port Settings tab, select the port(s), and click Edit.
n In the Trunk Group Settings tab, select the trunk(s), and click Edit.

Name Description Value

Port The number assigned to the switch port. 0 – 65535

Loop Protection Enables or disables loop protection. Enable or Disable
Default: Disable

Trunk Group Name of the trunk group to which the port belongs. Dependent on the switch type.

Table 140: Viewing or Configuring Port Settings
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Name Description Value

Trunk Group Name of the trunk group to which the port belongs. Dependent on the switch type.

Loop Protection Enables or disables loop protection. Enable or Disable
Default: Disable

Table 141: Viewing or Configuring Trunk Group Settings

4. Select Enable in the Loop Protection drop-down.
5. Click OK.
6. Click Save Settings.

Configuring Port Rate Limit on Aruba Switches in UI
Groups
Rate limiting allows allocating a specific bandwidth for the incoming and outgoing traffic from each port.
When traffic exceeds the configured limit, it is dropped. This effectively sets a usage level on a given port
and is a tool for enforcing maximum service level commitments granted to network users. This feature
operates on a per-port level and is not configurable on port trunks. Rate-limiting is designed to be applied at
the network edge to limit traffic from non-critical users or to enforce service agreements such as those
offered by Internet Service Providers (ISPs) to provide only the bandwidth for which a customer has paid.

Port rate limit is always disabled by default on Aruba switches. To configure port rate limit for switches
provisioned in the UI groups:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Security > Port Rate Limit. The Port Rate Limit page is displayed.
3. Under Port Rate Limit, select the port or ports you want to modify and click Edit.
4. Set the value of Limit to Traffic by Category if you prefer to set individual limitations.

Else, set the value of Limit to All Traffic to set a collective limitation.
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Percentage limits are based on link speed. For example, if a 100 Mbps port negotiates a link at 100
Mbps and the inbound rate-limit is configured at 50%, then the traffic flow through that port is limited to
no more than 50 Mbps. Similarly, if the same port negotiates a 10 Mbps link, then it allows no more than
5 Mbps of inbound traffic. Configuring a rate limit of 0 (zero) on a port blocks all traffic on that port.
However, if this is the desired behavior on the port, disable the port instead of configuring a rate limit of
0.

a. If you select All Traffic, rate limit is placed on all packets received from unknown sources. Move
the slider to Enable and then enter the values for IN and OUT in percentage values.

b. If you select Traffic by Category, refer to the following table to set the correct parameters.

Name Description Value

Broadcast Sets a rate limit on broadcast traffic. Expressed as percentage of
the total bandwidth.

Multicast Indicates the operational status of the port.

Unknown
Unicast

Indicates the mode of operation. The port can be
configured to function in Trunk or Access mode.

ICMP Sets a rate limit on ICMP traffic.

Table 142: Traffic by Category Parameters

Configuring RADIUS Server Settings on Aruba Switches
Aruba Central allows you to configure RADIUS (Remote Authentication Dial-In User Service) server settings
on switches.

To configure a RADIUS server, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Security > RADIUS. The RADIUS page is displayed.
3. Click + to add a RADIUS server. The Add RADIUS Server window is displayed.
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4. Configure the following parameters.

Name Description Value

Server IP The IP address of the RADIUS server.

Port The destination port for authentication requests to the specified
RADIUS server.

Default: 1812

Shared Key The encryption key for use during authentication sessions with the
specified RADIUS server.

Confirm
Shared Key

Retype the shared key.

Dynamic
Authorization

Indicates whether the dynamic authorization is enabled.
When enabled, the RADIUS server can dynamically terminate or
change the authorization parameters used in an active client
session on the switch.

Toggle switch to
the on or off
position

Table 143: RADIUS Parameters

5. Click Save.

Editing a RADIUS Server Settings
To edit a RADIUS server, point to the row for the server, and click the edit icon.

Deleting a RADIUS Server Settings
To delete a RADIUS server, point to the row for the server, and click the delete icon.

Configuring Tunnel Node Server on Aruba Switches
Aruba Central allows you to configure tunneled node on switches. The tunneled node connects to one or
more client devices at the edge of the network and then establishes a secure Generic Routing Encapsulation
(GRE) tunnel to the controlling concentrator server. You can configure Port-Based Tunnel using UI group.

To configure a tunneled node on the switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
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d. UnderManage, click Device.
The tabs to configure the switch is displayed.

2. Click Security > Tunnel Node Server. The Tunnel Node Server page is displayed.
3. Configure the following parameters.

Name Description Value

Mode The mode of tunneling from the
drop-down:

n No Tunnel—Switch does
not tunnel traffic.
n Port Based Tunnel—
Allows the switch to tunnel
traffic to an Aruba
controller on a per-port
basis.

No Tunnel or Port Based
Tunnel

Primary
Gateway IP

The IP address of the primary
gateway.

A valid IPv4 address

Backup
Gateway IP

The IP address of the backup
gateway. This field is optional.

A valid IPv4 address

4. Click Save Settings.

Configuring Authentication for Aruba Switches
Aruba Central supports enabling 802.1X and MAC authentication for switches. You can enable and
configure 802.1X authentication of clients at the switch and port level, and enable authentication of 802.1X
access through a RADIUS server using either EAP or CHAP protocol. You can also enable and configure ports
to authenticate clients based on MAC addresses.

802.1X Authentication
802.1X is a method for authenticating the identity of a user before providing network access. Aruba Central
supports internal RADIUS server and external RADIUS server for 802.1X authentication.

Configuring 802.1X Authentication
To configure 802.1X authentication for the switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
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c. Click a switch underDevice Name.
The dashboard context for the switch is displayed.

d. UnderManage, click Device.
The tabs to configure the switch is displayed.

2. Click Security > Authentication. The Authentication page is displayed.
3. Expand the 802.1X Authentication accordion.
4. To enable 802.1x Authentication at group level in the group context, slide the toggle switch to on

position.
5. In theAuthentication Method from the drop-down, select either Local , EAP or CHAP.

If you select EAP or CHAP, you must configure the RADIUS server.

The Port Settings table displays the number of ports and the parameters configured for the ports.

6. Select one or more ports for which you want to enable 802.1X authentication, and click the edit icon.
The Edit Ports Selected window is displayed.

7. Select Enable from the 802.1X drop-down.
8. Configure the following parameters.

Name Description Value

Client Limit The maximum number of clients to allow on the port. Default:
0

UnAuthorized
VLAN ID

The VLAN to use for an unauthorized client. Default:0

Authorized
VLAN ID

The VLAN to use for an authorized client. Default:
0

Reauth
Period

The time (in seconds) that the switch enforces on a client to re-
authenticate. The client remains authenticated while the re-authentication
occurs. When set to 0, re-authentication is disabled.

Default:
300
seconds

Cached
Reauth
Period

The time (in seconds) when cached re-authentication is allowed on the
port.

Default:
0

Log off
Period

The time (in seconds) that the switch enforces for an implicit logoff. Default:
300
seconds

Quiet Period The time (in seconds) during which the port does not try to acquire a
supplicant. The period begins after the last attempt authorized by the max-
requests parameter fails.

Default:
60
seconds

Tx Period The time (in seconds) the port waits to retransmit the next EAPOL PDU
during an authentication session.

Default:
30
seconds

Table 144: Configuring 802.1X Authentication
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Name Description Value

Server
Timeout

The time (in seconds) that the switch waits for a server response to an
authentication request

Default:
300
seconds

Supplicant
Timeout

The time (in seconds) that the switch waits for a supplicant response to an
EAP request. If the supplicant does not respond within the configured time
frame, the session times out.

Default:
300
seconds

9. Click Save Settings.

MAC Authentication
MAC authentication is used for authenticating devices based on their physical MAC addresses. For MAC
authentication, the MAC address of a machine must match an approved list of manually defined addresses
on the switch.

MAC authentication can be used alone or it can be combined with 802.1X authentication.

To configure MAC authentication for the switch ports, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Security > Authentication.
3. In theAuthentication tab, expand the MAC Authentication accordion. The Port Settings table

displays the parameters configured for the port.
4. Select one or more ports for which you want to enable MAC authentication and click the edit icon.

The Edit Ports Selected window is displayed.
5. Select Enable from theMAC Auth drop-down.
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6. Configure the following parameters.

Name Description Value

Client Limit The maximum number of clients to allow on the port. Default:
0

UnAuthorized
VLAN ID

The VLAN to use for an unauthorized client. Default:
0

Authorized
VLAN ID

The VLAN to use for an authorized client. Default:
0

Reauth
Period

The time (in seconds) that the switch enforces on a client to re-authenticate.
The client remains authenticated while the re-authentication occurs. When
set to 0, re-authentication is disabled.

Default:
300
seconds

Cached
Reauth
Period

The time (in seconds) when cached re-authentication is allowed on the port. Default:
0

Log off
Period

The time (in seconds) that the switch enforces for an implicit logoff. Default:
300
seconds

Quiet Period The time (in seconds) during which the port does not try to acquire a
supplicant. The period begins after the last attempt authorized by the max-
requests parameter fails.

Default:
60
seconds

Table 145: Configuring MAC Authentication

7. Click Save Settings.

Configuring CDP on Aruba Switches
Cisco Discovery Protocol (CDP) is used to share information about connected network devices. It is used to
share information such as device type, model, interfaces, IP addresses, operating system versions, and
VLANs. You can configure CDP modes for the switch.

To enable CDP for the switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
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d. UnderManage, click Device.
The tabs to configure the switch is displayed.

2. Click System > CDP. The CDP page is displayed.
3. To enable CDP for the switch, move theCDP toggle switch to the on position.
4. Select any of the following modes from theMode drop-down:

n rx-only—Switch only receives CDP information from other connected devices and stores this
information in the database. However, it does not send its own information to other devices.

n pass-through—CDP information passes through the switch to other connected devices.
n pre-standard-voice—Enables CDP-compatible voice VLAN discovery with pre-standard VoIP

phones.

5. Click Save Settings.

Configuring Access Policies on Aruba Switches

Aruba Central does not support access policy configuration on Aruba Mobility Access Switches.

To restrict certain types of traffic on physical ports of Aruba switches, you can configure ACLs from the
Aruba Central UI.

To create an access policy, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. Under Manage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. Under Manage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Security > Access Policy. The Access Policy page is displayed.
3. Click + to add a new access policy. TheNew Access Policy page is displayed.
4. Enter a name for the policy.
5. Click Add.
6. To add a rule to the access policy, click + underRules for test, and configure the following

parameters:
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Name Description Value

Source Select a source of the traffic for which you want to an
access rule.

n Any, Network, or Host
n For Network, specify IP
address and mask
n For Host, specify IP
address

Destination Select a destination. n Any, Network, or Host
n For Network, specify IP
address and mask
n For Host, specify IP
address

Protocol Select the type of protocol. Some protocols also require
source and destination ports.

Select from drop-down.

Action The action that the switch must perform on the traffic
received at a port.

Permit or Deny

Table 146: Configuring Rules for Access Policies

7. Click OK.
8. Click Save Settings.

The access policies must be applied to a switch port and the VLAN assigned to a port. For more information
on access policy assignment to ports and VLANs, see the following topics:

n Configuring Switch Ports on Aruba Switches
n Configuring VLANs on Aruba Switches

Configuring SNMP on Aruba Switches
You can configure SNMP community settings and trap settings through the UI.

SNMP settings can be configured only when switch is installed with the minimum supported firmware version of
16.09 or later.

To enable SNMP on a switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.



Aruba Central | User Guide 504

a. UnderManage, click Device.
The tabs to configure the switch is displayed.

2. Click System > SNMP. The SNMP page is displayed.
3. Move the SNMP toggle switch to the on position.

Configuring community settings
You can add or delete SNMP communities to restrict access to the switch.

Adding a read community
To add an SNMP community, complete the following steps:

1. In the SNMP page, expand theCommunity Settings accordion.
TheRead Community table displays the list of communities that have read-only access.

2. To add a read community, click +. TheAdd Community window is displayed.
3. Enter the name of the community in theCommunitytext box and click OK.

Deleting a read community
To delete a read community, click the delete icon for the community you want to delete.

Configuring trap settings
You can configure authentication, trap destination, and trap categories using trap settings.

Adding a trap destination
To add a trap destination, complete the following steps:

1. In the SNMP page, expand the Trap Settings accordion.
n The Trap Destination table displays the following information:

l Destination IP—The destination IP address for sending the trap.

l Community—The community name used for sending the trap.

2. To add a read destination, click +. TheAdd Trap Destination window is displayed.
3. Configure the parameters listed in step 1.
4. Click OK

Deleting a trap destination
To delete a trap destination, point to the row for the trap destination, and click the delete icon in the
Actions column.

Enabling trap categories
To enable trap categories, complete the following steps:

1. In the Trap Settings accordion, select the authentication type used to connect to the SNMP server
from theAuthentication drop-down.

2. In the Trap Category table, select the checkbox for the trap category you want to enable.
3. Click Save Settings.

The availability of trap categories differs based on the device model.
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Configuring DHCP Pools on Aruba Switches
To configure a new DHCP pool on a switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Security > DHCP Pools. The DHCP Pools page is displayed.

Aruba 2530 Switch Series do not support DHCP server on the device platform. Hence, Aruba Central
pushes the group-level configuration for DHCP to all applicable devices in the group except the Aruba
2530 Switch Series.
If any of the devices is running a lower version, a warning message is displayed, and the DHCP
configuration changes are pushed only to the devices that support the DHCP. If the devices are
upgraded to a supported version or moved out of the group, the warning message will not be
displayed.

3. To activate the DHCP service, move the Enable DHCP service toggle switch to the on position.
The DHCP service can be enabled only if there is a valid DHCP pool.

4. To add a new DHCP pool, click +and configure the following parameters:

Name Description Value

Name Name of the pool. A string.

Network A valid network IP address to assigned to the DHCP pool. IPv4 address

Netmask Netmask of the DHCP pool. Subnet mask

Lease
Time

The lease time for the DHCP pool in days-hours-minutes
format.

You can set a maximum value of
365 days 23 hours and 59
minutes in the DD-HH-MM
format.

Table 147: Configuring a DHCP Pool
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Name Description Value

Default
Router

IP address of the default router in the subnet. You can add up to 8 IP
addresses.

DNS
Server

Address of the DNS server. To add multiple DNS
servers, click +.

You can add up to 8 DNS
servers.

Netbios
Server

Address of the Netbios server. The Netbios server
address configuration is not required for Mobility Access
Switches. To add multiple Netbios servers, click +.

You can add up to 8 Netbios
servers.
For Mobility Access Switches, an
option called WINS Server is
available.

IP
Address
Range

IP address range within the network and network mask
combination. To add multiple IP address range, click +.

You can add up to 64 IP address
range.

Exclude
Address
Range

IP address range to exclude. This field is available only
for the Mobility Access Switches. To add multiple
excluded address range, click +.

You can add up to 64 IP address
range.

Option The code type, and ASCII or HEX value of the DHCP
option to configure. To add multiple options, click +.

You can add up to 8 options.
A value within the range of 2-254
with type as hexadecimal and
ASCII is valid.

5. Click Add.
6. Click Save Settings.
7. To edit the details of a DHCP pool, point to the row for the DHCP pool, and click the edit icon in the

Edit column, and configure the parameters.
8. To delete a DHCP pool, point to the row for the DHCP pool, and click the delete icon in theDelete

column. When theDo you want to delete <DHCP Pool Name>? pop-up window prompts you,
click Yes.

Configuring DHCP Snooping on Aruba Switches
DHCP snooping provides network security by filtering untrusted DHCP messages. Filtering is performed by
distinguishing trusted ports connected to a DHCP server or switch and untrusted ports connected to end-
users.

When you enable DHCP snooping, DHCP packets received at untrusted ports will be dropped, because all
ports are configured as untrusted by default. You must configure the ports to be trusted in the Switches >
Interface > Ports page.

You must also configure authorized DHCP servers for the network to have a functional DHCP server that
serves clients on this switch.

By default, DHCP snooping is disabled for the switch.

Enabling DHCP Snooping on a Switch
To enable DHCP snooping on a switch, complete the following steps:
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1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Security > DHCP Snooping. The DHCP Snooping page is displayed.
3. To enable DHCP snooping for the switch, move theDHCP Snooping toggle switch to the on position.
4. To enable option-82 for the switch, move theDHCP Snooping Option-82 toggle switch to the on

position.
When you enable both DHCP snooping and option-82, the switch drops the option-82 information
from the DHCP packets.

5. Click Save Settings.

Adding Authorized DHCP Servers for a Switch
To add the list of IP addresses of authorized DHCP servers for a switch, complete the following steps:

1. In the DHCP Snooping page, click + in theAuthorized DHCP Servers IP table. The Add Authorized
DHCP Server IP window is displayed.

2. Enter the IP address in theAuthorized DHCP Servers IP field.
3. Click OK.
4. Click Save Settings.

Deleting Authorized DHCP Servers for a Switch
To delete the authorized DHCP servers IP addresses, in theAuthorized DHCP Servers IP table, point to IP
address, and click the delete icon for the DHCP server IP you want to delete.

Enabling DHCP Snooping for a VLAN
To enable DHCP snooping for a VLAN, complete the following steps:

1. In theDHCP Snooping Settings table, select the VLAN row(s) for which you want to configure DHCP
snooping, and click Edit.

2. Select Enable orDisable from theDHCP Snooping drop-down.
3. Click OK.
4. Click Save Settings.

Configuring IGMP on Aruba Switches
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In a network where IP multicast traffic is transmitted for various multimedia applications, Internet Group
Management Protocol (IGMP) helps reduce bandwidth usage on a per-port basis on a switch. Enabling IGMP
for a VLAN allows the ports to detect IGMP queries and report packets, and manage IP multicast traffic
through the switch.

By default, IGMP is disabled for all VLANs.

To enable IGMP for a VLAN, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click IGMP. The IGMP page is displayed with the list of existing VLANs.
3. Select the VLAN row(s) for which you want to configure IGMP, and click Edit.
4. Select Enable orDisable from the IGMP drop-down.
5. Click OK.
6. To configure the switch to filter unknown multicast messages, move the Filter Unknown Multicast

toggle switch to the on position.
7. Click Save Settings.

Configuring QoS Settings on Aruba Switches
QoS is used to classify and prioritize traffic throughout a network. QoS enables you to establish an end-to
end traffic-priority policy to improve the control and throughput of important data. You can manage
available bandwidth so that the most important traffic goes first.

Aruba Central allows you to configure QoS settings on a group of switches through the UI. The setting that
can be configured using the UI are:

n Creating QoS traffic policies on switches in your network to enable traffic-handling rules across the
network.

n Defining QoS classes for a QoS Policy.
n Changing the priorities of traffic from various segments of your network as your business needs change.

Creating a QoS Traffic Policy
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1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

The tabs to configure the switch is displayed.

2. Click QoS. The QoS page is displayed.
3. In theQoS Traffic Policy accordion, click + to add a new QoS traffic policy.
4. Configure the following parameters.

Name Description Value

Policy Name The name of the QoS policy. A string

Target The target where the policy is applied. Port or VLAN

ID Select one or more ports or VLAN ID to mapped to a traffic policy. Numeric value

Table 148: Configuring QoS policy

5. Click Save.

Editing a QoS Policy
To edit a QoS policy, point to the row for the Qos policy, and click the edit icon.

Deleting a QoS Policy
To delete a QoS policy, point to the row for the Qos policy, and click the delete icon.

Adding a QoS Class for the Policy
To define a QoS class for the a policy, complete the following steps:

1. Select a QoS policy from the New QoS Policy table. The QoS Class table is displayed below the New
QoS Policy table with the configured QoS classes.

2. Click + to add a QoS classifier for the selected policy. The Add QoS classifier window is displayed.
3. Configure the following parameters.

Name Description Value

Class
Name

The class name of the QoS policy. A string

Packet Matching Criteria

Source The type of source for which you want to apply a
policy.

Any, Network, or Host.
If you select Network, enter the IP
address and wildcard mask .

Table 149: Configuring QoS class
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Name Description Value

If you select Host, enter the IP
address.

Destination The type of destination for which you want to apply a
policy.

Any, Network, or Host.
If you select Network, enter the
IP address and wildcard mask .
If you select Host, enter the IP
address.

Protocol Select the type of data transfer protocol from the
drop-down.
If you select UDP or TCP, the Source and Destination
type and ports fields are displayed.

Protocol types

Source Port
(s)

The port numbers of source. You can specify a
comma separated list of ports or range of ports.

Numeric value

Destination
Port(s)

The port numbers of destination. You can specify a
comma separated list of ports or range of ports.

Numeric value

Actions

DSCP Select a Differentiated Service Code Point (DSCP)
from the drop-down.

DSCP value range from 0 to 63.
Default value is No Change.

Priority Select a priority value for the selected DSCP. The priority range from 0 to 7.
0 – Normal Priority
1 – Low Priority
7 – High Priority
Default value is No Change.

Editing a QOS Class
To edit a QoS Class, point to the row for the Qos policy class, and click the edit icon.

Deleting a QOS Class
To delete a QoS Class, point to the row for the Qos policy class, and click the delete icon.

Configuring DSCP Map
DSCP map table displays mappings between Incoming DSCP and priority.

To change priority value associated with a DSCP code point, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

2. Click QoS. The QoS page is displayed.
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3. Expand theDSCP Map accordion.
4. Select the Incoming DSCP row for which you want to change the priority and click the edit icon. The

Edit DSCP window is displayed.
5. Select the priority value from the drop-down.
6. Click OK.

Configuring Time Synchronization on Aruba Switches
Time synchronization in a switch ensures maintaining a uniform time among all interoperating devices.
Aruba Central offers the following time synchronization protocols for switches:

n Network Time Protocol (NTP)
n Simple Network Time Protocol (SNTP)

To configure time synchronization in a switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click System > Time. The Time page is displayed.



Aruba Central | User Guide 512

3. Configure the following parameters.

Name Description Value

Time
Sync
Method

The synchronization method or protocol to use for synchronizing the
time on the switch.

SNTP and NTP
Default: NTP

Mode The operating mode for connecting to a time server. The following
modes are supported:

n Broadcast—The switch acquires time updates from the data
that any time server broadcasts to the network. The switch uses
the time data from the first server detected and ignores others.
If the poll interval expires thrice without the switch acquiring a
time update from the first server detected, the switch accepts a
time update from the next server broadcast.
Note: To use the Broadcast mode, the switch and the time
server must be in the same subnet. Also, the time server must
be configured to broadcast time updates to the network
broadcast address.
n Unicast—The switch acquires time updates from a specific
server for time synchronization. This mode requires at least one
server address to be configured in the Server Address field.
n DHCP—The switch attempts to acquire a time server IP
address from the DHCP server. If the switch receives a server
address, it polls the server for time updates according to the poll
interval. If the switch does not receive a time server IP address, it
cannot perform time synchronization updates. This mode is
applicable only for SNTP.
n Disabled—Time synchronization is disabled. You cannot
disable synchronization if NTP is selected.

SNTP
Supported modes:
Broadcast, Unicast,
DHCP, and Disabled
Default mode: DHCP
NTP
Supported modes:
Broadcast, Unicast
Default mode:
Broadcast

Default: DHCP

Server
Address

IP address of the time server that the switch accesses for obtaining
time synchronization updates. This field is applicable only when you
select the Unicast mode for synchronization.
You can configure a maximum of three time server IP addresses.
When you add more than one IP address, the priority that the switch
considers in selecting the IP address is the order in which you add
the IP address. Therefore, the first IP address that you add will be
priority 1, second IP address will be priority 2, and so on. There is no
priority assigned when NTP mode is selected.
You can delete the IP addresses by clicking the delete icon
corresponding to the address. For STP, when more than one IP
addresses are added, you must first delete the IP address you
added last. In the case of NTP, you can delete the IP addresses in
any order.

IPv4 address

Timezone The time zone corresponding to the location of the switch. Time zone selected
from the drop-down.

Daylight
Time
Rule

The rule that the switch uses to adjust the time for Daylight Saving
Time (DST).
For information about the predefined and user-defined times, see
Predefined DST Rules on page 513.

Alaska, Canada and
Continental US,
Middle Europe and
Portugal, Southern
Hemisphere,
Western Europe,
and User-defined.

Table 150: Configuring Time Synchronization Parameters



Configuring or Viewing Switch Properties in UI Groups | 513

Name Description Value

When you select the User-defined option, you must configure the
beginning and ending months and dates for DST changes in the
Begin Month and Day and End Month and Day fields. All DST
rules begin and end at 2 a.m. on the configured dates.

Begin
Month
and Day

The beginning month and date for the user-defined DST changes.
This field appears only when you select User-defined in the
Daylight Time Rule field.

Month and date
selected from the
drop-down.

End
Month
and Day

The ending month and date for the user-defined DST changes. This
field appears only when you select User-defined in the Daylight
Time Rule field.

Month and date
selected from the
drop-down.

4. Click Save Settings.

Predefined DST Rules
Following are the details of the beginning and ending days for the predefined DST rules:

Predefined DST Rule Name Description

Alaska n Begin DST at 2 a.m. on March 8.
n End DST at 2 a.m. on November 1.

Canada and Continental US

Middle Europe and Portugal n Begin DST at 2 a.m. on March 25.
n End DST at 2 a.m. on September 24.

Southern Hemisphere n Begin DST at 2 a.m. on October 25.
n End DST at 2 a.m. on March 1.

Western Europe n Begin DST at 2 a.m. on March 25.
n End DST at 2 a.m. on October 25.

Configuring Routing on Aruba Switches

This is a beta feature and not recommended for a production environment.
Central does not support routing on Aruba Mobility Access Switches.

Static routes provide a means for restricting and troubleshooting routed traffic flows and in small networks
can provide the simplest and most reliable configuration for routing. Static routes are manually configured
in the routing table.

You can enable routing on Aruba switches in Aruba Central.
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1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click IP Settings > Routing. The Routing page is displayed.
3. You can toggle routing to enabled on the slider menu.

Before enabling routing, you must already have configured a path to the gateway.
4. In theRoutes table, click + to add a VLAN and configure the following parameters:

Name Description Value

Network A valid network IP address for the destination
network or host.

IPv4 address.

Netmask Netmask of the IP address. Netmask address.

Gateway Default gateway IP address. IPv4 address.

Metric A parameter used by the routers to determine the
best optimal path for routing traffic.

This is a fixed metric for static IP
routes, and is set to “1”.

Distance The administrative distance helps routers
determine the best route when there are multiple
routes to the destination. A lower value is
recommended.

The default administrative distance for
static IP routes is 1, but can be
configured to any value in the range of
1 - 255.

Table 151: Routing Path Parameters

If the routing metric and administrative distance are set to a lower value for static routes, switches
use the static IP routes as the best route for routing traffic.

5. Click Save.

Configuring Device Profile
Device profile configuration allows you to dynamically detect an Aruba AP, which is directly connected to the
switch, and apply predefined configurations to ports on which the Aruba AP is detected.

Configuration changes made on the Device Profile page will always take precedence over changes made on
other configuration pages.

To configure device profile, complete the following procedure:
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1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Device Profile. The Device Profile page is displayed.
3. Slide the Status toggle switch to on to enable the device profile support for a device type. By default,

the device profile is disabled.
4. Configure the following parameters.

Name Description Value

Profile
Name

The name of the profile configured.You cannot modify this field.
If no other device profile is mapped to the device type, the default
device profile default-ap-profile is associated with the device type.

associated with the device type.

Inherited from
switch.

Device
Type

Type of the device supported. The only device type
supported is Aruba
AP.

Tagged
VLAN

The tagged member of the VLAN.

UnTagged
VLAN

The untagged member of the VLAN. Select from drop-
down list.
The default value is
1.

PoE
Priority

The PoE priority for the device port. Low, High or
Critical.

Jumbo Indicates whether jumbo packet handling is enabled for the VLAN
interface.

Toggle switch to the
on or off position

5. Click Save Settings.

You can validate device profile using show device-profile status and show vlan <id> options.
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Automatic Rollback Configuration
Aruba Central supports an auto-rollback mechanism for switches running software version 16.10.0009 or
later. The rollback mechanism is triggered when the switch loses connectivity to Aruba Central after
configuration push. A period of about 10 minutes is taken by switch to complete the rollback with last
known stable configuration and connect back to Aruba Central. After recovery, theAuto Commit State in
theConfiguration Audit page is set to Off to stop subsequent configuration push from Aruba Central.
Before changing theAuto Commit State to ON, user needs to review the configuration change that
resulted in network disconnect.

If there is a switch rollback, an event will be logged in theAudit Trail page as shown in the following figure:

Configuring System Parameters for Aruba Switches
The System menu under Switches-MAS and Switches allows you to configure administrator credentials
and enable mode for the switch users.

Configuring Administrator Credentials for Mobility Access Switch
To configure administrator credentials for a Mobility Access Switch, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click System > Access/DNS. TheAccess/DNS page is displayed.
3. Enter the password for admin in theAdmin Password text box and confirm the administrator

password.
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4. Enter the password for enable mode in the Enable Mode Password text box and confirm the
password.

5. Click Save Settings.

Configuring Administrator and Operator Credentials for Other
Aruba Switches
To configure administrator credentials for other Aruba switches, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click System > Access/DNS. TheAccess/DNS page is displayed.
3. Enter the username for the administrator user in theAdmin Username text box.
4. Enter the password for admin in theAdmin Password text box and confirm the administrator

password.
5. To configure the operator user credentials, complete the following steps:

n Select the Set Operator Username check box.
n Enter a username and password for the operator user.
n Confirm the password.

6. Click Save Settings.

Configuring a Name Server
To set a static IP switches, you must configure a name server. To configure a name server, complete the
following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
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c. Click a switch underDevice Name.
The dashboard context for the switch is displayed.

d. UnderManage, click Device.
The tabs to configure the switch is displayed.

2. Click System > Access/DNS. TheAccess/DNS page is displayed.
3. Select DHCP or Static from theName Server drop-down.
4. If you selected Static in the drop-down, enter the IP address of the name server obtained from the

DNS server in the text box.
5. Click Save Settings.
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Aruba Switch Stack
A switch stack is a set of switches that are interconnected through stacking ports. The switches in a stack
elect a primary switch called Commander and a backup switch as Standby. The remaining switches become
Members of the stack. The following table lists the switches that support stacking:

Switch
Platform

Maximum
Number
of Stack
Members

Minimum
Supported
Version for
Template
Group

Minimum
Supported
Version for
UI Group

Supported
Stack Type
(Frontplane
(VSF) /
Backplane
(BPS))

Supported
Configuration Group
Type for Stacking
(UI / Template)

Aruba 2920
Switch Series

4 WB.16.04.0008 WB.16.08.0001 BPS UI and Template

Aruba 2930M
Switch Series

10 WC.16.06.0006 WC.16.08.0001 BPS UI and Template

Aruba 2930F
Switch Series

8 WC.16.07.0002 WC.16.08.0001 VSF UI and Template

Aruba 5400R
Switch Series

2 KB.16.06.0008 N/A VSF Template only

Aruba 3810
Switch Series

10 KB.16.07.0002 KB.16.08.0001 BPS UI and Template

Table 152: Switch Stacking Support

Provisioning and configuring of Aruba 5400R switch series and switch stacks is supported only through
configuration templates. Aruba Central does not support moving Aruba 5400R switches from the template
group to a UI group. If an Aruba 5400R switch is pre-assigned to a UI group, then the device is moved to an
unprovisioned group after it joins Aruba Central.

For more information on topology and configuration of switch stacks, see theHPE ArubaOS-Switch
Management and configuration Guide for the respective switch series.

Provisioning Switch Stacks in Aruba Central
The switch elected as the commander establishes a WebSocket connection to Aruba Central. The following
criteria apply to provisioning and management of switch stacks in Aruba Central:

n Switch stacks can be added only to a template group and cannot be moved to a UI group.
n If the standalone switches in a group join to form a switch stack, the switch is moved to the

Unprovisioned state.
n If a switch stack in the template group joins Aruba Central as a stand-alone Switch, it is blocked unless it is

deleted from the stack. After it is removed from the stack, the stand-alone switch is moved to the pre-
provisioned group.

n If a switch stack is moved from a pre-provisioned group to an existing group in the UI, it will be moved to
Unprovisioned state.
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n After forming a switch stack, you can remove a member and erase its stacking configuration. However,
the member can join Aruba Central as a standalone switch only after it is deleted from the switch stack.

n When a stack is removed, the stack members cannot join Aruba Central until the stack entry is deleted.
For more information on deleting the stack, see Configuring Switch Stacks using UI Groups. When a stack
entry is not deleted and the member tries to rejoin Aruba Central, an event is triggered in the Audit Trail
page stating that the stack association is detected.

Assigning Labels and Sites
Aruba Central supports organizing your devices into sites for ease of monitoring. Sites refer to physical
locations in which the devices are installed. Administrators can assign switch stacks to a single site for ease
of managing installations and monitoring the overall site health. For more information on assigning devices
to sites, see Managing Sites on page 140.

Similarly, switch stacks can also be tagged using labels. Labels allow you to identify or tag devices installed in
a specific site for ease of monitoring. For more information on assigning labels, see Managing Labels on
page 143.

If any one member of the switch stack is assigned to a site, Aruba Central automatically assigns all other
members in a switch stack to the same site. Similarly, if a label is assigned to an individual member in a stack,
the same label is applied to all other members of the stack.

Because all members of a switch stack must be assigned to the same site and label, Aruba Central
automatically corrects the site and label assignment for switch stacks that were earlier assigned to different
labels or sites. If you have such switch stacks in your account, you will notice that all stack members are
migrated to the same site or label to which the commander was assigned. Aruba recommends that you review
the sites and labels assigned by Aruba Central to verify that the switch stacks in your account are assigned to
sites and labels that you intended to use, and if required, assign all members of stack to a common site or label
of your choice.

Configuring Switch Stacks
For information on configuring switch stacks using template groups, see Configuring Switch Stacks using
Template Groups.

For information on configuring switch stacks using UI groups, see Configuring Switch Stacks using UI
Groups.

Monitoring Switch Stacks
See Monitoring Switches in List View on page 561.

Viewing Switch Stacks in Site Topology
See Monitoring Sites in the Topology Tab on page 711.

Configuring Switch Stacks using Template Groups
The switch stacks are provisioned under template groups in Aruba Central. The template groups allow you
to configure and modify the settings of a switch stack using configuration templates.
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When uploading a configuring template, ensure that the variables are uploaded for all the members of the
stack. The template is applied with the variables of the member that is elected as the commander.

To create a configuration template for switch stack, complete the following steps:

1. In theNetwork Operations app, set the filter to a template group.
The dashboard context for the group is displayed.

2. UnderManage, click Devices > Switches.
3. Click theConfig icon.

The tabs to configure switches using templates is displayed.
4. Click + to create a template for the Aruba switch stack.
5. Specify a name for the template.
6. Select Aruba Switch from theDevice drop-down list.
7. Select the Aruba Switch model in theModel drop-down list.
8. Select the Aruba Switch software version in theVersion drop-down list.
9. Enter the template text in the Template box.

All switch templates must include a password command to set a password for the device. The switch
template cannot be saved without adding a password command. If the configuration that is pushed
from Aruba Central to the device does not contain a password command, the configuration push is
aborted for the device and a log is added to the audit trail. For example, if you add the password
command in a condition block and the condition evaluates to false, the configuration that is pushed will
not contain the password command.

10. Click Save.

Aruba Central does not support the use of part number (J-number) in place of Switch model number in
configuration templates for the Aruba switch stack.

The following pre-defined variables are refreshed and re-imported from a switch stack when a new stack
member is added or removed, or when a failover occurs.

n _sys_template_header
n _sys_module_command
n _sys_stack_command
n _sys_oobm_command
n _sys_vlan_1_untag_command
n _sys_vlan_1_tag_command

For information about deploying VSF stacks of ArubaOS Switches using Zero Touch Provisioning (ZTP) in
Aruba Central, see the VSF Stacking Guide.

For information about switch stacks using UI groups, see Configuring Switch Stacks using UI Groups.

Configuring Switch Stacks using UI Groups
Aruba Central supports both Backplane stacking (BPS) and Virtual Switching Framework (VSF) switch
stacking. You can create switch stacks and add stack members through the UI. The stack configuration is
possible only when the switches are online.

https://support.hpe.com/hpsc/doc/public/display?docId=a00091437en_us
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Stacks created using UI groups can only be managed in a UI group. If a device is moved to a template group,
then the device cannot be managed in a UI group without rebuilding the stack.
Fiber modules / SFP ports are manageable in a UI group when the stack is created. These modules are available
for configuration at the device level context.

Onboarding commander and members to Aruba Central
for VSF stacking
The following is a high-level process flow for configuring VSF switch stacks:

1. Add the switches to the device inventory and assign a valid subscription. All the switch members must
be set to factory default and powered off.

2. Power on the switch you intend to add as a commander. The switch comes up online in Central as a
standalone switch.

3. Create a stack with the standalone switch. After stack creation, the switch will reboot and comes up as
a stack commander. For more information, see the section Creating a switch stack on page 523.

4. Add other members to the stack when the status of the commander switch is active. For more
information, see Adding a stack member on page 525.

5. After adding members, connect the Ethernet cables between the switches to form the desired
topology.

6. Power on the switches one at a time. The second switch that is powered on will be elected as standby.
The subsequent switches that get powered on will be designated as the members of the stack.

For more information on deploying a VSF stack, see Recommended deployment workflow on page 522
section.

For more information on topology and configuration of switch stacks, see the ArubaOS-Switch Installation
and Getting Started Guide and ArubaOS-Switch Advanced Traffic Management Guide for the respective
switch series.

If the stack members are connected and powered on before adding to a stack, then the members might not join
the stack and status of the stack members are displayed as Inactive in the UI. In this scenario, stack cannot be
managed through the UI.

Recommended deployment workflow
The following procedure provides the recommended workflow for deploying three-member VSF stack
(Commander, Standby, and a Member switch).

1. Connect a staging port on the first switch in the VSF stack to a DHCP enabled network or a device that
has access to the internet. After rebooting and initialization, the switch assumes its role as
commander and the LED on the VSF stack ports of the switch will turn amber.

2. Connect a VSF port of the next switch to the VSF port of the commander switch. During initialization,
the switch will act as standby and the LED on the VSF port will turn amber.

3. Connect a VSF port of the next switch to the VSF port of the standby switch. During initialization, the
new switch acts as a member and the LED on the VSF port of the switch will turn amber.

4. Connect the VSF port of the commander switch to the VSF port of the member to complete the loop.
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If the stack members are connected and powered on before adding to a stack, then the members might not join
the stack in Aruba Central. In such scenarios, the status of the stack members is displayed as Inactive in the UI.
Also, the stack cannot be managed using UI groups in Aruba Central.

Onboarding commander and members to Aruba Central
for BPS stacking
The following is a high-level process flow for configuring BPS switch stacks:

1. Add the switches to the device inventory and assign a valid subscription. All the switch members
must be set to factory default and powered off.

2. Insert the stacking module to the switch you intend to add as a commander.
3. Power on the commander switch. The switch comes up online in Central as one-member BPS switch

stack. A one-member BPS switch stack is a single BPS switch with stacking enabled.
4. Move the one-member switch stack from theUnassigned Devices group to a UI group. The

stacking information is displayed in the Stacks configuration page with switch member added as the
commander.

5. Add other members to the stack when the status of the commander switch is active in the Members
table. For more information, see Adding a stack member on page 525.

6. After adding members, connect the stacking modules and stacking cables between the switches to
form the desired topology.

7. Power on the switches one at a time. The second switch that is powered on will be elected as standby.
The subsequent switches that get powered on will be designated as the members of the stack.

If the stack members are connected and powered on before adding to a stack, then the members might not join
the stack in Aruba Central. In such scenarios, the status of the stack members is displayed as Inactive in the UI.
Also, the stack cannot be managed using UI groups in Aruba Central.

For more information on topology and configuration of switch stacks, see the ArubaOS-Switch Installation
and Getting Started Guide and ArubaOS-Switch Advanced Traffic Management Guide for the respective
switch series.

Creating a switch stack
To create a switch stack, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.



Aruba Central | User Guide 524

c. Click a switch underDevice Name.
The dashboard context for the switch is displayed.

d. UnderManage, click Device.
The tabs to configure the switch is displayed.

2. Click Stacks. The Stacks page is displayed.
The Stacks table displays the following information:

Name Description Value

Name The name of the switch stack. A string

Type The type of switch stacking. BPS or VFS

Stack ID The ID of the switch stack. The stack ID is auto-generated and cannot
be changed in the settings.

Auto-generated
String

Members The number of members on the switch stack. Integer

MAC
Address

The MAC address of the switch stack. Alphanumeric MAC
address

Topology The type of switch stack topology. Chain, Ring, or
unknown

Status The status of the stack formation. Pending, In-
progress, Active, or
Failed

VSF Port
Speed

The port speed in the case of VSF stacking. This column is hidden by
default. You must select the column from the columns list.

1G or 10G

Table 153: Stacks table

3. In the Stacks table, click + to add a stack.
TheCreate New Stackwindow is displayed.

4. Select a commander switch from the Select Commander Switch drop-down list. The model number
and serial number of switches are displayed in the drop-down list.

n The commander switch must be installed with the minimum supported firmware version of 16.06 or
later.

If the selected switch supports VSF Stacking, configure the following parameters:
n Link 1 Name and Port(s)—The name of the link 1 and its corresponding ports.
n Link 2 Name and Port(s)— The name of the link 2 and its corresponding ports.
n Domain ID—The domain ID of the switch stack.
n Port Speed—The VSF port speed from the drop-down.

If the selected switch supports BPS stacking, insert the stacking module in switch and continue to
step 5.

5. Click Save & Reboot Stack. When the stack reboots, the status of the stack formation is displayed in
the Stacks table. Do not make any changes to the stack until the status changes from In Progress to
Active or Failed. If stack creation fails due to some issues, delete the stack entry and retry.
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Editing a Stack
To edit a stack, select the stack row you want to edit and click the edit icon.

You can edit a stack only when its status is Active.

Removing a stack
To remove a stack, select the stack row that you want to remove and click the delete icon.

You can remove a stack only when its status is Failed.

Adding a stack member
Stacking allows you to add switches to the stack only when the commander is active.

To add a switch to stack as a new member, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a switch group in the filter:

a. Set the filter to a group containing at least one switch.
The dashboard context for the group is displayed.

b. UnderManage, click Devices > Switches.
c. Click theConfig icon to view the switch configuration dashboard.

n To select a switch in the filter:
a. Set the filter to Global or a group containing at least one switch.
b. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.
c. Click a switch underDevice Name.

The dashboard context for the switch is displayed.
d. UnderManage, click Device.

The tabs to configure the switch is displayed.

2. Click Stacks. The Stacks page is displayed.
3. In the Stacks table, select the stack row for which you want to add a member. The Members table

displays the list of members for that particular stack. TheMembers table displays the following
information:

Name Description Value

Name The name of the switch stack member. A string

MAC
Address

The MAC address of the stack member. Alphanumeric MAC address

Model The hardware model of the switch. A String

Table 154: Members table
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Name Description Value

Priority The priority level of the stack member. 1 to 255

Role The role of a stack member. Commander, member, or
standby

Status The status of the switch stack member. Active, Inactive, or Not
Joined

Link1 |
Port

The name of the link and its corresponding port of the
stack member.

A String

Link2 |
Port

4. In theMembers table, click + to add a stack member.
TheAdd Stack Member For <stack name> window is displayed. The following information is auto-
generated:
n Member ID—Identification number of the member.
n Priority—Priority of the member.

5. Select the member using one of the following options:
n Same as Commander—Use this option when your commander and member have the same

model number.
n Select Model —Use this option when your commander and member have different model

numbers. Select the switch model from the model drop-down list.

6. If the selected switch supports VSF Stacking, configure the following parameters:
n Link1 Name and Port(s)—Specify the name of the link 1 and its corresponding port.
n Link2 Name and Port(s)—Specify the name of the link 2 and its corresponding port.

7. To add another stack member, click Save & Add Another.

A message is displayed above the Members table when the maximum number of switches in a stack
has been added.

8. Click Save. After the stack members appear in Members table, connect the stacking modules and
stacking cables to all switches and power on the switches.

Editing a stack member
To edit a stack member, select the member row you want to edit and click the edit icon.

Removing a stack member
To delete a stack member, select the member row that you want to delete and click the delete icon.

After removing a member, disconnect the switch from the stack. To disconnect the switch from the stack, do
one of the followings:

n Turn off the power from the switch.
n Restart the switch using switch reset button.
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You can remove only the stack member that has the lowest priority. For example, if there are three stack
members with priority 254, 253 and 252 respectively and if you want to remove a stack member with priority
253, then first you need to remove the member with priority 252.
Priority cannot be assigned manually. Commander switch is always assigned with priority 255. The priority of
other subsequent members is decremented by 1.

Aruba CX VSF Stack
A switch stack is a set of switches that are interconnected through stacking ports. The switches in a stack
elect a primary switch called Commander and a backup switch as Standby. The remaining switches become
Members of the stack. The following table lists the Aruba CX switches that support stacking:

Switch
Platform

Maximum
Number
of Stack
Members

Minimum
Supported
Version

Recommended
Version

Supported
Stack Type

Supported
Configuration Group
Type for Stacking (UI
/ Template)

Aruba CX
6200 Switch
Series

8 10.04.1000 10.05.0010 VSF Template only

Aruba CX
6300 Switch
Series

10 10.04.0020 10.05.0010 VSF Template only

Table 155: Aruba CX Switch Stacking Support

For more information on topology and configuration of switch stacks, see the ArubaOS-CX Virtual Switching
Framework (VSF) Guide for the respective switch series.

This section contains the following topics:

n Aruba CX Switch Stacking Functions Supported in Aruba Central on page 527
n Aruba CX Switch Stacking Functions Not Supported in Aruba Central on page 528
n General Recommendations on page 528
n Configuring Aruba CX Switch Stacks on page 528
n Monitoring Aruba CX Switch Stacks on page 529
n Viewing Aruba CX Switch Stacks in Site Topology on page 529

Aruba CX Switch Stacking Functions Supported in Aruba
Central
Aruba Central supports only a few functions related to Aruba CX switch stack, such as onboarding a stack to
Aruba Central and replacing member switches having the same model and part number. All other stacking
related activities, such as creating a stack, deleting or adding a new member to the stack, must be performed
offline, that is, outside Aruba Central.

Following stack related functions are supported on Aruba Central:

The Aruba CX switch stack must be setup using the CLI or the Aruba CX mobile application before onboarding
on to Aruba Central.
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n Onboarding a VSF stack to Aruba Central
n Replacing a VSF member with same model and part number
n Rebooting a member—Commander, standby, and other members
n Splitting or merging a stack
n VSF switchover

Aruba CX Switch Stacking Functions Not Supported in
Aruba Central
Following stack related functions are not supported on Aruba Central and must be performed outside Aruba
Central, after taking the stack offline from Aruba Central:

n Setting up an Aruba CX switch stack
n Adding a new member to an existing stack
n Adding a new VSF link
n Deleting a member from the VSF stack
n Reassigning standby or other members to the stack

For information on these configurations, see the ArubaOS-CX Virtual Switching Framework (VSF) Guide
for the respective switch series and the ArubaOS-CX VSF Best Practices document.

General Recommendations
Following are the general recommendations to note when configuring an Aruba CX switch stack:

n To maximize available VSF link bandwidth, use Aruba 50G DAC cables for VSF links.
n All VSF link ports in a stack must operate at the same speed (10G, 25G, or 50G).
n For maximum stack resiliency, the primary and secondary members should be the same switch models

with redundant power supplies connected to different circuits. This is required to minimize the
probability that a single-source power failure will disable both the stack commander and standby.

n A secondary member must always be defined to assume the VSF standby role.
n The out-of-band management (OOBM) ports on the primary and secondary members must be

connected to each other, either directly or through a dedicated management network. This is required to
utilize the VSF split detection, which must always be enabled.

Configuring Aruba CX Switch Stacks
You can perform the following functions in Aruba Central for Aruba CX switches:

n Onboard the stack to Aruba Central.

For information, see Onboarding Aruba CX VSF Stack to Aruba Central on page 529.

n Replace a stack member with the same model and part number.

For information, see Replacing an Aruba CX VSF Stack Member (Same Model and Part Number) on
page 529.

n Remove a stack member.

For information, see Removing an Aruba CX VSF Stack Member on page 530.

https://arubapedia.arubanetworks.com/arubapedia/images/5/53/AOS-CX_VSF_Best_Practices.pdf


Onboarding Aruba CX VSF Stack to Aruba Central | 529

Monitoring Aruba CX Switch Stacks
See Monitoring Switches and Switch Stacks on page 560.

Viewing Aruba CX Switch Stacks in Site Topology
See Monitoring Sites in the Topology Tab on page 711.

This section contains the following topics:

n Onboarding Aruba CX VSF Stack to Aruba Central on page 529
n Replacing an Aruba CX VSF Stack Member (Same Model and Part Number) on page 529
n Removing an Aruba CX VSF Stack Member on page 530

Onboarding Aruba CX VSF Stack to Aruba Central
To onboard an Aruba CX VSF stack to Aruba Central, complete the following procedure:

1. Setup the switch stack using the Aruba CX mobile application or the CLI.

This step must be performed outside Aruba Central.

For information , see ArubaOS-CX VSF Best Practices. Although this document is created for Aruba
CX 6300 switches, it is also applicable to Aruba 6200 switches.

2. Add and subscribe the commander and standby members in the Aruba CX stack to Aruba Central.
The other members are optional to be added to Aruba Central.

For information on adding and subscribing devices, see Onboarding Devices on page 91 and
Managing Subscriptions on page 98.

3. Create a template group for the Aruba CX VSF stack in Aruba Central.
4. Assign the stack members to the template group from any of the following pages:

n Device Inventory page in Account Home under Global Settings.
n Groups page underMaintain > Organization in theNetwork Operations app.

5. Create a configuration template in the template group for the Aruba CX VSF stack.

Copy the details of the show running config command of the Aruba CX VSF stack from the commander and
paste it in the template.
Ensure to update the password in plaintext.

See Using Configuration Templates for Aruba Switch Management on page 469.

Replacing an Aruba CX VSF Stack Member (Same
Model and Part Number)
Aruba Central allows you to replace a member of the Aruba CX VSF stack only if the switch model and part
number are same. You can replace either the commander, standby, or any other member of the stack.

Replacing the Commander
To replace the commander in the VSF stack, complete the following procedure:

https://arubapedia.arubanetworks.com/arubapedia/images/5/53/AOS-CX_VSF_Best_Practices.pdf
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1. Shut down the commander member in the stack.
2. Wait for the standby member to become the commander.
3. Replace the switch.
4. Toggle aruba-central disable and enable from the switch CLI.

If this does not work, go to bash and restart hpe-restd service by running the systemctl restart

hpe-restd command.

switch# configure

switch(config)# aruba-central

switch(config-aruba-central)# disable

switch(config-aruba-central)# enable

OR

switch# start-shell

switch:~$ sudo systemctl restart hpe-restd

5. Switchover to the new commander in the switch CLI.

Replacing the Standby or Other Members
To replace the standby or any other member of the VSF stack, complete the following procedure:

1. Shut down the member in the stack.
2. Configure the new switch and the VSF links to the new switch.
3. Renumber the VSF member using the vsf renumber-to command.

For example, if the member ID of the old switch was 2, renumber the new VSF member to 2.

4. Move the VSF link DAC cable from the old switch to the new switch.
5. Verify the status of the Aruba Central after the new switch reboots.
6. Toggle aruba-central disable and enable from the switch CLI.

switch# configure

switch(config)# aruba-central

switch(config-aruba-central)# disable

switch(config-aruba-central)# enable

OR

switch# start-shell

switch:~$ sudo systemctl restart hpe-restd

Removing an Aruba CX VSF Stack Member
You can remove a member from the Aruba CX VSF stack in Aruba Central. It involves completing procedures
both in Aruba Central and the switch CLI.

To remove a member in the VSF stack, complete the following procedure:
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1. Unsubscribe all members of the VSF stack from Aruba Central.
2. Wait for the stack to display offline in the switches List view.
3. Delete the stack from Aruba Central.

See Deleting an Offline Switch on page 563.

4. Remove the member from the VSF stack in the switch CLI by running the following commands:

For example, in a three-member stack, run the following commands to remove one member.

switch# configure

switch(config)# no vsf member 3

The specified switch will be unconfigured and rebooted

Do you want to continue (y/n)? y

5. Disconnect the physical VSF links for the member.
6. Update the template in Aruba Central with the configuration from the remaining stack.
7. Add and subscribe the remaining members in the Aruba CX stack to Aruba Central.
8. Assign the stack members to the template group.
9. The new stack and the standalone switch will connect back to Aruba Central.

Run the following commands if you want the switches to reconnect immediately:

switch# configure

switch(config)# aruba-central

switch(config-aruba-central)# disable

switch(config-aruba-central)# enable

OR

switch# start-shell

switch:~$ sudo systemctl restart hpe-restd



Chapter 8
Aruba SD-Branch Solution

Aruba SD-Branch Solution
The Aruba SD Branch solution offers the best-in-class wireless and wired infrastructure and management
orchestration features with the SD-WAN capabilities. The SD Branch solution extends the SD-WAN concept
to all elements in the branch to deliver a full stack solution that addresses the business challenges of
distributed enterprises. Coupled with Aruba Central, the solution provides a cloud-hosted environment for
simplified operations and improved agility.

Why SD-WAN?
A traditional branch setup supports client connectivity requirements across different geographical locations
for various types of business operations. The sites in remote geographical locations serve as branch offices,
while the headquarters or main office serves as a data center that hosts network resources to store, manage,
and distribute data. The main office also hosts a centralized Virtual Private Network (VPN) management
system to aggregate traffic from the remote branch sites. A Wide Area Network (WAN) —with Multiprotocol
Label Switching (MPLS), T1, T3, Broadband, or Cellular links—is used for connecting multiple local area
networks to a central corporate network or data centers separated by distance.

Due to an increase in the number of client devices at the remote sites and the new bandwidth requirements,
branch office networks are expected rapidly scale to provide uninterrupted user experience. A traditional
branch infrastructure with multiple appliances, different operating systems, and management tools only
adds to the cost, involves a maintenance overhead, and demands skilled IT personnel.

The Aruba SD-WAN solution simplifies your branch deployments with a single management interface for
administering, managing, and monitoring your branch networks. It also provides a unified policy
enforcement framework with operational ease.

Key Features and Benefits
The SD-WAN solution comes with the following key capabilities:

n Zero Touch Provisioning of devices—Ability to self-provision without operator's intervention.
n Centralized overlay management and control—A single cloud-based network management interface for

managing and monitoring SD Branch devices. Aruba Central, the cloud based network management
system, supports unified management of SD branch devices with ZTP and hierarchical configuration.

n IPsec based Automatic VPN Tunnels—Support for high-performance and automatic IPsec VPN for secure
overlay networking.

n Unified security policy for wired, wireless, and WAN—Support for a common security policy framework
based on user roles for WAN, WLAN, and LAN users.

n Dynamic path selection—Support for dynamically steering traffic or a service request to the best available
path. For example, you can configure a policy to dynamically route the real-time voice and video traffic on
the link with the lowest latency and jitter, and the bulk file traffic on the link with the maximum
bandwidth.

n Deep Packet Inspection and Web Content Classification—Support for monitoring and analyzing
application usage by clients.
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n Visibility, analytics, and troubleshooting—Dashboards for monitoring branch health, device
performance, and client connectivity metrics. Alerts, reports, and audit trails for monitoring and
troubleshooting network performance issues.

n Policy-based Routing—In addition to the traditional destination-based routing, the SD Branch devices
support routing client traffic based on user role or type of application, For example, traffic generated
from the guest devices can be routed directly to the internet, while traffic from the employees can be
routed to the MPLS network.

For more information about how SD-WAN works, see Understanding SD-WAN.

Understanding SD-WAN
The SD-WAN solution includes a new set of devices called Aruba Gateways that inter-operate Aruba Switches
and Instant APs to provide a full-fledged WAN architecture.

Based on the size of your branch setup, you can choose device combination that best suits your
requirement:

n Medium to large branches—For branches that require more than 24 ports, you can use a combination of
Branch Gateways and one or more Aruba switches at the branch site, with Aruba Gateways as
VPN Concentrator at the data center.

n Small to medium branches—For branches that require less than 24 ports (including all
WAN and LAN ports), you can deploy Branch Gateways at the branch sites, with Aruba  Gateways as
VPN Concentrator at the data center.

n Micro branches—For micro branches, you can deploy an Instant AP cluster at the branch site, with
Aruba Gateway as the VPN Concentrator at the data center.

See Supported SD-Branch Components for information on Aruba Gateways that can be deployed as VPNCs.

Figure 62 shows a typical deployment topology of an SD Branch with Branch Gateways and a micro branch
with Instant APs:

Figure 62 SD Branch Topology

Figure 63 illustrates the communication flow between Aruba Central, branch sites, and data center.
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Figure 63 Aruba Central and Cloud Communication

Figure 64 shows all elements in an SD Branch and the SD-WAN data flow.

Figure 64 Aruba SD-WAN Data Flow

What are the Solution Requirements?
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The Aruba Gateways are the most important components of the Aruba SD-Branch Solution. The SD-WAN
Gateway portfolio includes and Aruba Branch Gateways and VPN Concentrators.

At the Branch Site
The following are the components in a branch:

n Branch Gateways—Function at the branch to optimize and control WAN, LAN, and cloud security
services.

n Switches—Function with Branch Gateways to detect and isolate rogue APs, and blacklist rogue devices.
n Instant APs—Function as VPN clients at branch sites. The client data traffic from these APs are

aggregated by the VPN Concentrator located at the data center

At the Data Center
At the data center, you can deploy Aruba Gateways as VPN Concentrator. For data center redundancy, you
can deploy two VPN concentrators in the active-standby or active-active mode.

The following are the components operational at the Data Center:

n VPNC—A VPN Concentrator functions as a VPN management system that aggregates data traffic from
the branches and terminates IPsec VPN tunnels.

n Virtual Gateway—The headend gateway at the enterprise data center can be hosted as a virtual
appliance. The virtualised instance enterprise data center gateway in public or private cloud is referred to
as Virtual Gateway. Aruba Virtual Gateways function as VPN Concentrators.

For a list of supported Gateways, Switches, and APs, see Supported SD-Branch Components.

In the Cloud
A valid Aruba Central subscription is required to avail cloud-based administration, management,
configuration and monitoring of SD branch components such as Branch Gateways, VPN Concentrators,
Instant APs, and Aruba Switches.



Chapter 9
Monitoring Your Network

Monitoring Your Network
This chapter describes the various options available for viewing the device, client, and network details:

n Network Overview on page 536
n Network Health Dashboard on page 651
n All Clients on page 661
n Application Visibility on page 684
n About Floorplans on page 701
n Monitoring Sites in the Topology Tab on page 711
n Alerts & Events on page 719
n Reports on page 765

Network Overview
In theNetwork Operations app, perform the following steps to access the overall network summary page:

1. Set the filter to Global.
The Global dashboard is displayed.

2. UnderManage > Overview, the network summary page displays the following tabs:
n Network Health—Displays vital information of the network sorted by site. For more information,

see Network Health Dashboard.
n WAN Health—Displays information on WAN Healths.
n Summary—Displays details such as the bandwidth usage in the network, client counts, and

cluster-specific details. For more information, see Global—Summary.
n WiFi Connectivity—Displays connection details of all the clients connected to an AP. For more

information, see Wi-Fi Connectivity.
n AI Insights—Displays information on AP performance issues such as excessive channel changes,

excessive reboots, airtime utilization, and memory utilization at AP. For more information, see The
AI Insights Dashboard.

Monitoring Access Points
The access point dashboard enables you to manage, configure, monitor and troubleshoot access points
provisioned and managed through Aruba Central.

The access point Health Bar provides a snapshot of the overall health of the access points configured in
Aruba Central. For more information, see Health Bar for the AP Dashboard.

Monitoring Access Points in Summary View
The AP Summary page provides all the metrics about the health, status, and clients information associated
with the AP provisioned and managed in Aruba Central.
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Viewing the AP Summary Page
To navigate to the AP Summary page, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click the Summary icon.

The AP Summary page is displayed.

The AP Summary page displays the following information:

n Usage—Displays the incoming and outgoing data traffic detected on the APs.
n Clients—Displays the number of clients connected to an AP over a specific time period.
n Bandwidth Usage Per Network—Displays the incoming and outgoing traffic for all APs per SSID over

a specific duration.
n Client Count Per Network—Displays the number of clients connected to an AP per SSID over a specific

time period.

You can change the time range for the AP Summary page by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Monitoring Access Points in List View
The AP List page provides information associated with the APs and radios provisioned and managed in
Aruba Central. The AP List page displays the following sections:

n Access Points Table
n Deleting an Offline AP
n Rebooting an AP
n Radios Table

Viewing the AP List Page
To navigate to the AP List page, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

The AP List page displays the following information:
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n Access Points—Displays the total number of APs. When you click theAccess Points tab, it provides
information about all APs in theAccess Points table.

n Online—Displays the total number of online APs. When you click theOnline tab, it provides
information about the online APs in theAccess Points table.

n Offline—Displays the total number of offline APs. When you click theOffline tab, it provides
information about the offline APs in theAccess Points table.

n Radios—Displays the total number of radios. When you click theRadios tab, it provides information
about all radios in theRadios table.

l 2.4 GHz—Displays the total number of 2.4 GHz radios. When you click the 2.4 GHz tab, it provides
information about 2.4 GHz radios in theRadios table.

l 5 GHz—Displays the total number of active 5 GHz and 5 GHz (Secondary) radios. When you click the 5 GHz
tab, it provides information about 5 GHz and 5 GHz (Secondary) radios in theRadios table.

The tri-radio feature is available only for AP-555. In the 5 GHz tab, the Radio 5 GHz (Secondary) data is
available only if the tri-radio mode is enabled. For more information, see About Tri-Radio Mode.

Access Points Table
TheAccess Points table displays the following information:

n Device Name—Name of the AP.
n Status—Displays the operational status of the AP. The status is as follows:

l Online—Indicates that the AP is online.

l Offline—Indicates that the AP is offline.

l Online—Indicates that the AP is operating under thermal management. For more information, see
Thermal Shutdown Support in Instant AP.
n IP Address—IP address of the AP.
n Model—The model number of the AP.
n Serial—The serial number of the device.
n Firmware Version—The firmware version running on the AP.
n Clients—Clients connected to the AP.
n Alerts—Opens alerts related to APs.
n MAC Address—MAC address of the AP.
n Virtual Controller—The name of the virtual controller.
n Config Status—The configuration changes associated with the AP. TheConfig Status column is not

supported in the exported CSV file.
n Group—Group to which the AP belongs.
n Labels—Labels associated with the AP. If multiple labels are associated with the AP, hover over the label

link to view all the labels.
n Site—The site to which the device belongs.
n Uptime—Time since when the device is operational. TheUptime column is not applicable for offline

devices and remains blank for all the devices in theOffline page.
n Last Seen—The last active time and date of the device. The Last Seen column is not applicable for

online devices and remains blank for all the devices in theOnline page.
n Public IP—IP address logged by servers when the device is connected through internet connection.



Monitoring Access Points in List View | 539

n LLDP Neighbor—Displays the name of the LLDP neighbor. Click the LLDP Neighbor name to view the
switch details page, if the switch is managed by Aruba Central.

n LLDP Port—Displays the port number of LLDP neighbor.
n AI Insights—The number of AI insights generated for the AP in the last three hours. TheAI Insights

column is not supported in the exported CSV file.
n Note—Displays the information captured in theNote parameter, in the AP Details section. The search

filter allows you to search for exact and partial text search with prefix. The text search with suffix is not
supported.

n Zone—Zone to which the AP belongs.

A search filter is provided only for the Device Name, IP Address, Model, Serial, MAC Address, Virtual

Controller, Group, Labels, Site, LLDP Neighbor, Note, and Zonecolumns. The and icons allow you to
sort the Device Name, IP Address, Serial, MAC Address, Virtual Controller, and Zone columns in an
ascending and descending order.
By default, the AP List table displays the Device Name, Status, IP Address, Model, Serial, and Firmware
Version. You can customize the view of AP List table with additional columns such as the Clients, Alerts,
MAC Address, Virtual Controller, Config Status, Group, Labels, Site, Uptime, Last Seen, Public IP,
LLDP Neighbor, LLDP Port, Insights, Note, and Zone. These additional columns can be selected by clicking

the icon provided at the right corner of the table that displays the AP list. Click the Reset to default button

provided in the drop-down list to reset the AP List with default columns only. To autofit the columns, click the
icon and select Autofit columns.

To download the .csv file of the AP list table, click the icon. If the table contains unicode value, you must
use a UTF-8 enabled software to view the contents. To view the file in Microsoft Excel 2007 spreadsheet
software, perform the following steps to view table with unicode values:

1. Open the Microsoft Excel 2007 software.
2. Click on the Data menu bar option.
3. Click on the From Text icon.
4. Browse to the location of the file that you want to import.
5. Select the file name and click Import.
6. The Text Import wizard is displayed.
7. Select the file type. For .csv format, select theDelimited option.
8. Select the 65001: Unicode (UTF-8)option from the drop-down list that is displayed next to the File

origin.
9. Click Next. The Text ImportWizard-Step 1 of 3 page is displayed.

10. Place a check mark next to the delimiter such as the comma or full stop that was used in the file you
wish to import into Microsoft Excel 2007.

11. TheData Previewwindow displays the data based on the selected delimiter.
12. Click Next. The Text ImportWizard-Step 3 of 3 page is displayed. Select the appropriate data

format for each column that you want to import.

Importing one or more columns is optional.

13. Click Finish to import the data into Microsoft Excel 2007.
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Deleting an Offline AP
To delete an offline AP, see Deleting an Offline AP.

Rebooting an AP
To reboot an AP, see Rebooting an AP.

Radios Table
When you click theRadios, 2.4 GHz, and 5 GHz tab in theRadios list page, the respective tables with the
following columns are displayed:

n Access Point—Name of the AP.

The online radios are displayed with a green dot and offline radios are displayed with a red dot.

n Radio MAC Address—The MAC address of the radios connected to the AP.
n Band—The type of radio band. For example, 2.4 GHz, 5 GHz, and 5 GHz (Secondary).

The tri-radio feature is available only for AP-555. In the Band column, the Radio 5 GHz (Secondary) data is
available only if the tri-radio mode is enabled. For more information, see About Tri-Radio Mode.

n Bandwidth—The bandwidth of data transferred through the radios.
n Channel—Channels assigned for the radios.
n Utilization (%)—The percentage of time (normalized to 255) that the channels of the radios are sensed

to be busy. The AP uses either the physical or the virtual carrier sense mechanism to sense a busy
channel. This percentage not only depends on the data bits transferred but also with the transmission
overhead that makes use of the channel.

n Power (dBm)—The transmit power of the radios measured in decibels.
n Noise Floor (dBm)—The noise at the radio receivers of the radios. Certain type of interferences, though

not all, may affect or increase:

l Noise at the radio receivers of the radios

l Thermal noise

l Noise floor

Noise Floor value may vary depending on the noise introduced by components used in the computer or
client device.

A search filter is provided only for the Access Point column.

Rebooting an AP
To reboot an AP, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.
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3. A list of access points is displayed in the List view.
4. In theAccess Points table, hover over the online AP that you want to reboot.

5. Click the reboot icon.

To reboot multiple online APs, select the online APs that you want to reboot and click the reboot
icon.

6. Click Reboot in the confirmation dialog box.

Deleting an Offline AP
To delete an offline AP, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. In theAccess Points table, hover over the offline AP that you want to delete.

4. Click the delete icon.

To delete multiple offline APs, select the offline APs that you want to delete and click the delete icon.

5. Click Delete in the confirmation dialog box.

Thermal Shutdown Support in Instant AP
Aruba AP-555 and AP-535 Instant AP devices are equipped with an internal thermal sensor. The sensor
initiates a shutdown when the operating temperature crosses the temperature threshold recommended for
an Instant AP. When an Instant AP operates under thermal management, all the radios are in Disabled
mode in the AP Health Bar.

n In swarm mode, the thermal shutdown support is as follows:

l In swarm mode, when the slave Instant AP operates beyond the recommended temperature threshold, the
Virtual AP profile is disabled. Once the slave Instant AP attains the optimum temperature again, it reboots
with theRecovery from Thermal Management Mode message, and then reconnects with the virtual
controller. This process of reboot and reconnection is executed for five times. If the connection between the
slave Instant AP and the virtual controller does not restore after five times, the slave Instant AP remains in
the shutdown state until it is manually turned on.

l In swarm mode, when the master Instant AP operates beyond the recommended temperature threshold, it
reboots with theReboot due to Thermal Management message. Once the master Instant AP attains the
optimum temperature again, it turns into a slave Instant AP, reboots with theRecovery from Thermal
Management Mode message, and then reconnects with the virtual controller. This process of reboot and
reconnection is executed for five times. If the connection between the slave Instant AP and the virtual
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controller does not restore after five times, the slave Instant AP remains in the shutdown state until it is
manually turned on.

l In swarm mode, when the master Instant AP operates beyond the recommended temperature threshold
and the number of Instant APs is one in the swarm scale, the Virtual AP profile is disabled. Once the master
Instant AP attains the optimum temperature again, it reboots with theRecovery from Thermal
Management Mode message. This process of reboot is executed for five times. If the master Instant AP
does not reboot after five times, the master Instant AP remains in the shutdown state until it is manually
turned on.
n In standalone mode, when the Instant AP operates beyond the recommended temperature threshold,

the Virtual AP profile is disabled. Once the Instant AP attains the optimum temperature again, it reboots
with theRecovery from Thermal Management Mode message. This process of reboot is executed
for five times. If the Instant AP does not reboot after five times, it remains in the shutdown state until it
is manually turned on.

Thermal Shutdown Events
To view the thermal shutdown events, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

2. UnderAnalyze, click Alerts & Events.

TheAlerts & Events page is displayed in the List view.

3. Click the Events tab.

A list of events is displayed in the Events table.

When the thermal shutdown feature is either enabled or disabled in an Instant AP, the Events table displays
the following details:

n The Event Type column includes theAP Thermal Shutdown type which can be used to filter thermal
shutdown events.

n TheDescription column includes the status of the thermal shutdown feature in the Instant AP. For
example, Thermal management enabled or Thermal management disabled.

In Aruba Central, the thermal shutdown feature is supported on Instant APs running Aruba Instant 8.6.0.0 or
later versions.

About Tri-Radio Mode
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Aruba Central offers tri-radio mode support in Aruba AP-555, a flagship 802.11ax access point. In tri-radio
mode or split 5 GHz mode, the 8x8 5 GHz radio is split into two independent 4x4 5 GHz radios. In the split 5
GHz Mode, Radio 5 GHz Secondary operates on channels from 36 to 64 and Radio 5 GHz operates on
channels from 100 to 165.

To enable tri-radio, go to Access Points > Radio in the AP configuration dashboard, and select the Split
Radio check-box.

The split 5 GHz radio can operate in the following modes:

n Access
n Monitor
n Spectrum

Viewing Tri-Radio Events
To view the tri-radio events, complete the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points.

A list of access points is displayed in the List view.

c. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

2. UnderAnalyze, click Alerts & Events.

TheAlerts & Events page is displayed in the List view.

3. Click the Events tab.

A list of events is displayed in the Events table.

When the tri-radio mode is either enabled or disabled in an AP, the Events table displays the following
details:

n The Event Type column includes theAP Tri-Radio type which can be used to filter tri-radio events.
n TheDescription column includes the status of the tri-radio mode in AP.

In Aruba Central, the tri-radio mode feature is available only on AP-555 running Aruba Instant 8.6.0.0 or later
versionS.
By default, the AP-555 operates in dual radio mode.

Access Point > Overview > Summary
In the AP dashboard, the Summary tab displays the device details, network information, radio details
including the topology of clients connected to each radio, and the health status of the AP in the network.
The Summary tab displays the following sections:
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n Device
n Network
n Radios
n Data Path
n Health Status
n Actions
n Go Live

Viewing the Overview > Summary Tab
To navigate to the Summary tab in the AP dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The Summary tab is displayed.

To exit the AP dashboard, click the back arrow on the filter.

You can change the time range for the Summary tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Device
TheDevice section displays the following details:

n AP Model—The AP hardware model.
n Country Code—Country code in which the AP operates.
n MAC—MAC address of the AP.
n Serial Number—Serial number of the AP.
n Uptime—Time since when the AP is operational.
n Last Reboot Reason—The reason for the latest rebooting of AP.
n Firmware Version—The firmware version running on the AP. If the device is running an older firmware

version, this field prompts the user to upgrade to the latest firmware version along with the link to the
Maintenance > Firmware page.

n Configuration Status—Displays the configuration status and the timestamp of the last device
configuration changes.

n Band Selection—Displays the operating band of the AP. The supported bands areDual Band,Dual 5
GHz, or Tri-Radio.

n Power Draw—The power utilized by the device in watts (W) or kilowatts (kW). For more information on
the list of APs that support power draw, see Supported Instant APs.

n Power Negotiation—The power in watts (W) negotiated on the ethernet port of the device in a wired
network.
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n Recommended Power—The recommended power in watts (W) negotiated on the ethernet port of the
device in a wired network.

n Group—The group to which the AP belongs. Click the group name to go to theOverview > Summary
page for that group.

When an AP belongs to an unprovisioned group, the hyperlink to the unprovisioned group is disabled.

n Labels—The labels associated with the AP. You can also add a new label to the AP by clicking the edit
icon. To view all the labels associated with a device, hover your mouse over the Labels column.

n LEDs on Access Point—To enable the blinking of LEDs on the AP to identify the location. The default
blinking time is set to 5 minutes and it automatically stops. To stop the blink, click Stop Blinking.

n Site—The site to which the AP belongs. Click the site name to go to theOverview > Site Health page
for that site.

n Note—When you click the edit icon, a text-box is displayed. It allows you to add information that
can be used as reference. For example, AP location, and upgrade information.

Network
TheNetwork section displays information of the network and interfaces to which the AP is connected.
Along with the network profile name, the following fields are displayed in theNetwork section:

n ETH0—Displays the status of the ETH0 network.
n Speed (Mbps)/Duplex—The speed of the network measured in Mbps. This field also indicates whether

the network has a full-duplex or half-duplex communication.
n VLAN—The number of VLAN connections associated with the network.

l LLDP Details—Click the LLDP Details link to view the ETH0 LLDP details. The pop-up window displays the
Neighbor Name,Neighbor MAC,Neighbor Port, and Neighbor VLAN details.

In Aruba Central, all the LLDP details are supported on Instant APs running Aruba Instant 8.6.0.3 or later
versions.

n ETH1—Displays the status of the ETH1 network.
n Speed (Mbps)/Duplex—The speed of the network measured in Mbps. This field also indicates whether

the network has a full-duplex or half-duplex communication.
n VLAN—The number of VLAN connections associated with the network.

l LLDP Details—Click the LLDP Details link to view the ETH1 LLDP details. The pop-up window displays the
Neighbor Name,Neighbor MAC,Neighbor Port, and Neighbor VLAN details.
n Current Uplink—The current uplink connection on the AP.
n Uplink connected to—The switch name to which the AP is connected. Click this link to view the switch

details page, if the switch is managed by Aruba Central. For more information, see Switch > Overview >
Summary.

l Port—The port number of the switch to which the AP is connected.
n IP Address—IP address of the AP.
n Public IP Address—IP address logged by servers when the AP device is connected through internet

connection.
n DNS Name Servers—The server that has a directory of domain names and their associated IP

addresses.
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n Default Gateway—A 32 bit value that is used to uniquely identify the device on a public network.
n NTP Server—Displays information about the NTP Server.

Radios
TheRadios section displays the following information related to Radio 2.4 GHz, Radio 5 GHz, and Radio 5
GHz Secondary:

n Mode—The type of mode for the radios. For example, Client Access, Monitor, and Spectrum.
n Status—Displays the operational status of the radios connected to the AP. The status is as follows:

l Up—Indicates that the radio is online.

l Down—Indicates that the radio is offline.

l Down - Thermal shutdown—Indicates that the radio is offline as the AP is operating under thermal
management. For more information, see Thermal Shutdown Support in Instant AP.
n Radio MAC Address—The MAC address of the radios connected to the AP.
n Channel—The channels assigned to the radios.
n Power—The transmit power of the radios.
n Type—The type of wireless LAN used for the radios.
n Clients—The number of clients connected to the AP.
n Wireless Networks—The number of SSIDs configured in the network.
n Antenna—The type of antennae. For example, internal and external.
n Spatial Stream—Displays the number of spatial streams. By default, the spatial stream value forRadio

5 GHz is 8x8. When tri-radio mode is enabled, the spatial stream values forRadio 5 GHz and Radio 5
GHz (Secondary) is 4x4.

When the Instant AP radios are set to spectrum scan mode, the Channel and Power values are empty.
The tri-radio feature is available only for AP-555. In the Radios section, the Radio 5 GHz (Secondary) data is
available only if the tri-radio mode is enabled. For more information, see About Tri-Radio Mode.

Data Path
TheData Path section displays the topology of clients connected to each of the radios of the AP, which in
turn is connected to switches or gateways through VLAN. When you hover over the upstream device in the
data path topology, a pop-up displays theName, Serial Number, and Port details of the upstream
devices.
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Figure 65 Data Path

The tri-radio feature is available only for AP-555. In the Data Path section, the 5 GHz (Secondary) data is
available only if the tri-radio mode is enabled. For more information, see About Tri-Radio Mode.

Health Status
TheHealth Status trend graph indicates the health status of the device in the network for the time
specified in the time range filter. When you over the graph, you can view information such as date and time,
Health Status,Noise Floor, CPU,Memory, Channel Utilization (Radio 1), Channel Utilization
(Radio 2), and Channel Utilization (Radio 3).

The tri-radio feature is available only for AP-555. In the Health Status section, the Channel Utilization (Radio
3) data is available only if the tri-radio mode is enabled. For more information, see About Tri-Radio Mode.

Actions
TheActions drop-down list contains the following options:

n Reboot AP—Reboots the access point. For more information, see Rebooting an Instant AP.
n Reboot Swarm—Reboots the AP cluster. For more information, see Rebooting an Instant AP Cluster .
n Tech Support—Enables the administrator to generate a tech support dump required for

troubleshooting the access point. For more information, see Tech Support for an Instant AP .
n Console—Opens the remote console for a CLI session through SSH for an access point. For more

information, see Opening a Remote Console.

Go Live
Aruba Central supports live monitoring of Instant APs that support Aruba Instant 8.4.0.0 firmware version
and above. Aruba Central allows you to monitor live data of an AP updated at every 5 seconds. For more
information, see Enabling Live Instant AP Monitoring.

Access Point > Overview > AI Insights
In the AP dashboard, theAI Insights tab displays information on AP performance issues such as excessive
channel changes, excessive reboots, airtime utilization, and memory utilization.
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Viewing Access Points > AI Insights
To navigate to theAI Insights tab in the AP dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In the access point dashboard context, click theAI Insights tab.

The Insights page is displayed.

To exit the AP dashboard, click the back arrow on the filter.

You can change the time range for theAI Insights tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

AI Insights are displayed for the time range selected. Select the time range from the Time Range Filter ( ) to
filter reports.

AI Insights Categories
AI Insights are categorized in high, medium, and low priorities depending on the number of occurrences.

n Red—High priority
n Orange—Medium priority
n Yellow—Low priority

AI Insights listed in the dashboard are sorted from high priority to low priority. TheAI Insights dashboard
displays a report of network events that could possibly affect the quality of the overall network
performance. Each insight report provides specific details on the occurrences of these events for ease in
debugging. For more information, see The AI Insights Dashboard.

The AP AI Insights page displays the following insights:

n Information (telemetry) was not received from APs/Radios
n Access Points had unusually high CPU utilization
n Access Points with unusually high memory usage were found
n Access Points had a high number of reboots
n Clients experienced high latency while roaming
n Clients roamed excessively
n DNS request/responses were significantly delayed
n DNS server(s) rejected a high number of queries
n DNS queries failed to reach or return from the servers
n Clients had an unusual number of MAC authentication failures
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n Clients had excessive 802.1x authentication failures
n Clients had excessive Wi-Fi security key-exchange failures
n Access Points impacted by high 2.4 GHz usage
n Access Points were impacted by high 5 GHz usage
n Dual-band (2.4/5 GHz) capable clients primarily used 2.4 GHz
n Clients had a significant number of Low SNR uplink minutes
n Access Points had an excessive number of channel changes
n Access Point radios changed their transmit power frequently

Access Point > Overview > Floor Plan
In the AP dashboard, the Floor Plan tab provides information regarding the current location of the Instant
AP.

Viewing the Overview > Floor Plan Tab
To navigate to the Floor Plan tab in the AP dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In the access point dashboard context, click the Floor Plan tab.

The Floor Plan tab is displayed.

To exit the AP dashboard, click the back arrow on the filter.

You can change the time range for the Floor Plan tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

The Floor Plan tab displays a sitemap and the floor plan showing the current location of the Instant AP .
The sitemap is derived from the Visual RF application, if Visual RF service is enabled for the Aruba Central
account. You can also edit the location of the Instant AP device by clicking the edit icon provided next to the
address in the Floor Plan tab.

Actions
TheActions drop-down list contains the following options:

n Reboot AP—Reboots the access point. For more information, see Rebooting an Instant AP.
n Reboot Swarm—Reboots the AP cluster. For more information, see Rebooting an Instant AP Cluster .
n Tech Support—Enables the administrator to generate a tech support dump required for

troubleshooting the access point. For more information, see Tech Support for an Instant AP .
n Console—Opens the remote console for a CLI session through SSH for an access point. For more

information, see Opening a Remote Console.
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Go Live
Aruba Central supports live monitoring of Instant APs that support Aruba Instant 8.4.0.0 firmware version
and above. Aruba Central allows you to monitor live data of an AP updated at every 5 seconds. For more
information, see Enabling Live Instant AP Monitoring.

Access Point > Overview > Performance
In the AP dashboard, the Performance tab displays the size of data transmitted through the AP.

Viewing the Overview > Performance Tab
To navigate to the Performance tab in the AP dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In the access point dashboard context, click the Performance tab.

The Performance tab is displayed.

To exit the AP dashboard, click the back arrow on the filter.

You can change the time range for the Performance tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

The Performance tab provides the following details:

n Throughput
The Throughput graph indicates the size of data sent to and received by the device in bits per second
for the wired or wireless networks. For example, Eth 0 or Eth 1 wired network profiles and specific SSIDs
of wireless networks. You can also view data for all the wireless SSIDs by selectingAll SSIDS from the
drop-down list. You can view the overall data usage measured in bytes in theOverall Usage field.

n Clients
TheClients graph indicates the number of clients connected to the device for a selected time range in
the time range filter. You can select a specific SSID or all SSIDs, Eth 0, or Eth 1 from the drop-down list
provided in theClients section.

When you hover over the Throughput and Quality graphs, it displays specific data for the selected timestamp.

Actions
TheActions drop-down list contains the following options:
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n Reboot AP—Reboots the access point. For more information, see Rebooting an Instant AP.
n Reboot Swarm—Reboots the AP cluster. For more information, see Rebooting an Instant AP Cluster .
n Tech Support—Enables the administrator to generate a tech support dump required for

troubleshooting the access point. For more information, see Tech Support for an Instant AP .
n Console—Opens the remote console for a CLI session through SSH for an access point. For more

information, see Opening a Remote Console.

Go Live
Aruba Central supports live monitoring of Instant APs that support Aruba Instant 8.4.0.0 firmware version
and above. Aruba Central allows you to monitor live data of an AP updated at every 5 seconds. For more
information, see Enabling Live Instant AP Monitoring.

Access Point > Overview > RF
In the AP dashboard, theRF tab provides details corresponding to 2.4 GHz, 5 GHz, and 5 GHz Secondary
radios of the AP.

Viewing the Overview > RF Tab
To navigate to theRF tab in the AP dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In the access point dashboard context, click theRF tab.

TheRF tab is displayed.

To exit the AP dashboard, click the back arrow on the filter.

You can change the time range for theRF tab by clicking the time range filter and selecting one of the
available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

TheRF tab provides the following details:

Channel Utilization
TheChannel Utilization graph indicates the percentage of channel utilization for the selected time range
from the time range filter.

Noise Floor
TheNoise Floor graph indicates the noise floor detected in the network to which the device belongs.

Frames - 802.11
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The Frames - 802.11 line graph indicates the trend of frames transmitted through the network. The frames
can be one of the following types: Drops, Errors, and Retries. The graph indicates the status of data
frames that were dropped, encountered errors, retried to be transferred, in a wireless network.

Channel Quality
TheChannel Quality graph indicates the quality of channel in percentage.

When you hover over the Channel Utilization, Noise Floor, Frames - 802.11, and Channel Quality graphs, it
displays specific data for the selected timestamp.
The tri-radio feature is available only for AP-555. In the RF tab, the Radio 5 GHz (Secondary) tab is available
only if the tri-radio mode is enabled. For more information, see About Tri-Radio Mode.

Actions
TheActions drop-down list contains the following options:

n Reboot AP—Reboots the access point. For more information, see Rebooting an Instant AP.
n Reboot Swarm—Reboots the AP cluster. For more information, see Rebooting an Instant AP Cluster .
n Tech Support—Enables the administrator to generate a tech support dump required for

troubleshooting the access point. For more information, see Tech Support for an Instant AP .
n Console—Opens the remote console for a CLI session through SSH for an access point. For more

information, see Opening a Remote Console.

Go Live
Aruba Central supports live monitoring of Instant APs that support Aruba Instant 8.4.0.0 firmware version
and above. Aruba Central allows you to monitor live data of an AP updated at every 5 seconds. For more
information, see Enabling Live Instant AP Monitoring.

Access Point > Overview > Spectrum
In the AP dashboard, the Spectrum tab provides details for all Wifi and non-Wifi devices associated to each
radio.

When the radios of Instant AP are set to spectrum scan mode, the Instant AP functions as a dedicated full-
spectrum RF monitor, scanning all channels to detect interference from neighboring Instant APs or
interfering devices such as microwaves and cordless phones. To enable the spectrum scan feature on a
specific radio of an AP, see Access Points Configuration Parameters.

The spectrum scan feature is available only on Instant AP devices running Aruba Instant 8.5.0.1 firmware
version and later.

When the spectrum scan feature is enabled, the Instant AP does not provide services to clients. The
Spectrum tab displays the following sections:

n Channel Utilization and Quality
n Interfering Devices
n Actions
n Go Live
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Viewing the Overview > Spectrum Tab
To navigate to the Spectrum tab in the AP dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In the access point dashboard context, click the Spectrum tab.

The Spectrum tab is displayed.

To exit the AP dashboard, click the back arrow on the filter.

You can change the time range for the Spectrum tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Channel Utilization and Quality
Click theChart icon to view theChannel Utilization and Quality details corresponding to 2.4 GHz and 5
GHz radios of the AP. Click the 2.4 GHz and 5 GHz tabs on theChannel Utilization and Quality label to
view theChannel Utilization and Quality graphs for the radios.

n Channel Utilization—TheChannel Utilization graph indicates the percentage of channel utilization
for theAvailable, Interference, and Wi-Fi Utilization categories associated to 2.4 GHz and 5 GHz
radios. You can view the following channel metrics when you hover over theChannel Utilization bar
graph:

Metrics Description

Channel The channel number of the radio.

Available The percentage of the channel currently available for use.

Interference The percentage of the channel currently being used by interfering devices.

Microwave The percentage of the channel currently being used by microwaves. Common
residential microwave ovens with a single magnetron are classified as a
Microwave. These types of microwave ovens may be used in cafeterias, break
rooms, dormitories, and similar environments. Some industrial, healthcare, or
manufacturing environments may also have other equipment that functions
like a microwave and may also be classified as a Microwave device.

Bluetooth The percentage of the channel currently being used by bluetooth devices. Any
device that uses the Bluetooth protocol to communicate in the 2.4 GHz band
is classified as a Bluetooth device. Bluetooth uses a frequency hopping
protocol.

Table 156: Channel Utilization Metrics
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Metrics Description

Cordless
Phone

The percentage of the channel currently being used by cordless phones.

Wi-Fi
Utilization

The percentage of the channel currently being used by Wi-Fi devices.

n Quality—TheQuality graph display the channel quality corresponding to each of the WiFi and non-WiFi
devices connected to the radios. When you hover over theQuality bar graph, the following channel
metrics are displayed:

Metrics Description

Channel The channel number of the radio.

Quality Current relative quality of the channel.

Known APs Number of valid Instant APs identified on the radio channel.

Unknown
APs

Number of invalid or rogue Instant APs identified on the radio channel.

Max AP
Signal

Signal strength of the Instant AP that has the maximum signal strength on a
channel in dBm.

Max
Interference

Signal strength of the non-Wi-Fi device that has the highest signal strength
in dBm.

Max AP
SSID

The network SSID with maximum APs.

Max AP
BSSID

The network SSID with maximum APs.

SNIR The measure of SNIR detected in the network in dB.

Noise Floor The noise at the radio receivers of the radios.

Table 157: Channel Quality Metrics

Interfering Devices
Click the List icon to view Interfering Devices details detected by the spectrum scanner. The page displays
a table with following details of interfering devices:

Metrics Description

Type Device type. This parameter can be any of the following:
n Audio FF (fixed frequency)
n Bluetooth
n Cordless base FH (frequency hopper)
n Cordless phone FF (fixed frequency)
n Cordless network FH (frequency hopper)

Table 158: Interfering Devices Table
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Metrics Description

n Generic FF (fixed frequency)
n Generic FH (frequency hopper)
n Generic interferer
n Microwave
n Microwave inverter
n Video
n Xbox

ID ID number assigned to the device by the spectrum monitor. Spectrum monitors
assign a unique spectrum ID per device type.

Central
Frequency

Center frequency of the signal sent from the device.

Bandwidth Channel bandwidth used by the device in KHz.

Affected
Channels

Radio channels affected by the wireless device.

Signal
Strength

Strength of the signal sent from the device measured in dBm.

Duty Cycle The device duty cycle. This value represents the percent of time the device
broadcasts a signal.

First Seen Time at which the device was first detected.

Last Seen Time at which the device status was updated.

The data displayed in the Spectrum tab is refreshed every 15 seconds. Aruba Central displays the last
recorded data for 30 minutes, if the device turns offline.

Actions
TheActions drop-down list contains the following options:

n Reboot AP—Reboots the access point. For more information, see Rebooting an Instant AP.
n Reboot Swarm—Reboots the AP cluster. For more information, see Rebooting an Instant AP Cluster .
n Tech Support—Enables the administrator to generate a tech support dump required for

troubleshooting the access point. For more information, see Tech Support for an Instant AP .
n Console—Opens the remote console for a CLI session through SSH for an access point. For more

information, see Opening a Remote Console.

Go Live
Aruba Central supports live monitoring of Instant APs that support Aruba Instant 8.4.0.0 firmware version
and above. Aruba Central allows you to monitor live data of an AP updated at every 5 seconds. For more
information, see Enabling Live Instant AP Monitoring.

Access Point > Security > VPN
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TheVPN tab provides information on VPN connections associated with the virtual controller along with
information on the tunnels and the data usage through each of the tunnels.

Viewing the Security > VPN Tab
To navigate to theVPN tab, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. UnderManage, click Security > VPN.

TheVPN tab is displayed.

You can change the time range for theVPN tab by clicking the time range filter and selecting one of
the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

TheVPN tab provides the following information:

n VPNC Tunnels Summary—The section displays information on tunnels with the following details:

l Total—Total tunnels established.

l Up—Number of tunnels currently active.

l Down—Number of tunnels currently inactive.

l Peers—Number of peer tunnels currently active.

The Tunnel table displays information on tunnels with the following columns:

l Tunnel—The type of the tunnels used in the VPN. For example, primary, secondary, or backup.

l Status—The status of the tunnel.

l Source—The source address of the tunnel.

l Destination—The destination address of the tunnel.
n Throughput Usage Per VPN—The Throughput Usage Per VPN graph indicates the successful data

usage per VPN in Mbps for the primary or backup tunnel selected from the drop-down list. The
Throughput Usage Per VPN displays a linear graph of sent and received data in the virtual private
network.

Rebooting an Instant AP
You can reboot an Instant AP using the Aruba Central UI.

To reboot an Instant AP, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.
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2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In theActions drop-down list, click Reboot AP.

AReboot dialog box is displayed.

5. Click Reboot to reboot the AP.

The AP dashboard takes less than a minute to update the interface status, after the AP is rebooted and
reconnected to Aruba Central.

Rebooting an Instant AP Cluster
You can reboot an Instant AP cluster using the Aruba Central UI.

To reboot an Instant AP cluster, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In theActions drop-down list, click Reboot Swarm.

AReboot dialog box is displayed.

5. Click Yes to reboot the AP cluster.

The AP dashboard takes less than a minute to update the interface status, after the VC is rebooted and
reconnected to Aruba Central.

Tech Support for an Instant AP
In Aruba Central UI, the administrators can generate a tech support dump required for troubleshooting the
Instant AP.

To generate a tech support dump for an Instant AP, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.
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3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In theActions drop-down list, click Tech Support.
TheCommands page is displayed. In theCommands page, theDevice Type and Available
Devices fields are automatically selected. The AP Tech Support Dump command is automatically
selected in the Selected Commands pane.

5. Click Run. The output is displayed in theDevice Output section.

For more information, see Troubleshooting Access Points.

Opening a Remote Console
In the Aruba Central UI, you can open the remote console for a CLI session through SSH for an Instant AP.
You can reset the system configuration of an Instant AP by erasing the existing configuration on the Instant
AP.

Resetting an AP through the Console
To reset an Instant AP through theConsole, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. In theActions drop-down list, click Console.

A CLI session dialog box is displayed.

5. Execute the write erase all command in the command prompt.
6. Reboot the Instant AP.

In this procedure, the complete configuration including the Per AP Settings on the Instant AP is
reset. After the reboot, the Instant AP is moved to default group and will not be present in the group
to which it was previously attached.

For information on resetting an Instant AP to factory default configuration by using the reset button on the
device, see Aruba Instant User Guide.

Enabling Live Instant AP Monitoring
Aruba Central supports live monitoring of Instant APs that support Aruba Instant 8.4.0.0 firmware version
and above. Aruba Central allows you to monitor live data of an AP updated at every 5 seconds.

Enabling and Disabling Go Live
To enable and disable the live monitoring of an AP, complete the following steps:
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1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. Click theGo Live button to start live monitoring of the AP.
5. Click the Stop Live button to exit live monitoring of the AP.

The Go Live feature is not applicable for offline Instant APs. The Go Live button remains grayed-out for all the
APs that are not associated with Instant AP devices running Aruba Instant 8.4.0.0 firmware version and above.
Aruba Central allows you to monitor live data for 15 minutes. After this time period, Aruba Central redirects to
the AP dashboard in a non-live mode to display the monitoring details for the time selected in the Time Range
Filter. For more information on AP dashboard in a non-live mode, see Access Point > Overview > Summary.

AP Details in Go Live Mode
When you click theGo Live button, the page displays live graphs based on noise floor, frames, and channel
quality of the neighboring RF devices for 15 minutes, until you select Stop Live button.

The page displaysNoise Floor, Frames, and Channel Quality live graphs forRadio 2.4 GHz, Radio 5
GHz, and Radio 5 GHz Secondary radios.

In Go Live mode, AP dashboard updates and displays data at every 5 seconds.
The tri-radio feature is available only for AP-555. In the Go Live page, the Radio 5 GHz (Secondary) tab is
available only if the tri-radio mode is enabled. For more information, see About Tri-Radio Mode.
The time range selected in the Time Range Filter is not applicable when the Go Live button is enabled.
You can monitor live data for multiple APs simultaneously on different tabs.

Access Point > Clients > Clients
In the AP dashboard, theClients tab displays details of all the clients connected to a specific AP.

Viewing the Access Point > Clients > Clients Tab
To navigate to theClients tab in the AP dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.
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3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. UnderManage, click Clients.

TheClients page is displayed in the List view.

To exit the Clients dashboard, click the back arrow on the filter.

You can change the time range for theClients tab by clicking the time range filter and selecting one
of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

For more information, see All Clients.

Access Point > Alerts & Events > Alerts & Events
In the AP dashboard, theAlerts & Events tab displays details of the alerts and events generated for the AP.

Viewing the Access Point > Alerts & Events > Alerts &
Events Tab
To navigate to theAlerts & Events tab in the AP dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active access point.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Access Points.

A list of access points is displayed in the List view.

3. Click an access point listed underDevice Name.

The dashboard context for the access point is displayed.

4. UnderAnalyze, click Alerts & Events.

TheAlerts & Events page is displayed in the List view.

To exit the Alerts & Events dashboard, click the back arrow on the filter.

For more information, see Alerts & Events.
You can also configure and enable certain categories of Instant AP alerts. For more information, see Access
Point Alerts.

Monitoring Switches and Switch Stacks
The switch dashboard enables you to manage, configure, monitor and troubleshoot Aruba Switch, Aruba CX
switches, and switch stacks provisioned and managed through Aruba Central.
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To view Aruba CX switches in the monitoring and topology pages, you must create a template configuration for
the switch with the password in plaintext. See Using Configuration Templates for Aruba Switch Management on
page 469.

If you are unable to view all details of the Aruba CX switch, then maybe the template configuration was not
applied correctly, the password was missing in the template configuration, or the password was not in plaintext.
See the audit trail to check the status of the switch. The audit trail should show the device onboarded message
for the switch serial number followed by the configuration push and login successful messages. For more
information on troubleshooting Aruba CX switch onboarding issues, see Troubleshooting Aruba CX Switch
Onboarding Issues on page 592.

Monitoring Switches in List View
The switch monitoring details are displayed on the switch dashboard and the switch details page. The switch
dashboard and the switch details page are accessed from theNetwork Operations app.

The switch dashboard displays details about the health and status of switches and switch stacks. The switch
details are provisioned and managed through Aruba Central. The switch dashboard displays the details in a
summary and list view.

The Switches List page provides information associated with the switches provisioned and managed in
Aruba Central. The Switches List page displays the following sections:

Viewing the Switches List Page
To navigate to the Switches List page, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

The Switches List page displays the following information:

n Switches—Displays the total number of switches, both online and offline. When you click the
Switches tab, it provides information about all switches in the Switches table.

n Online—Displays the number of online switches. When you click theOnline tab, it provides
information about all switches that are currently online and connected to Aruba Central in the
Switches table.

n Offline—Displays the number of offline switches. When you click theOffline tab, it provides
information about all switches that are currently offline or not connected to Aruba Central in the
Switches table.



Aruba Central | User Guide 562

The online switches are displayed with a green dot and offline switches are displayed with a red dot
Even when the Aruba CX switches are displayed as online, there might be instances when the details of the
switches are not displayed completely. This may be because of the following reasons:
- Template configuration is not applied correctly on the switch
- Password is not configured in the template configuration
- Password is not in plaintext format
See the audit trail to check the status of the Aruba CX switches. The audit trail should show the device
onboarded message for the switch serial number followed by the configuration push and login successful
messages. For more information on troubleshooting Aruba CX switch onboarding issues, see Troubleshooting
Aruba CX Switch Onboarding Issues on page 592.

Switches Table
The Switches table displays the following information:

n Device Name—Name of the switch or switch stack. For a switch stack, a stack icon is displayed next to
the device name.

n Clients—Number of clients connected.
n Alerts—Number of alerts from the switch or switch stack.
n Model—Model number of the switch. For a switch stack, the term Stack is displayed.
n Config Status—configuration status of the switch or switch stack.
n Last Seen—Date and time when the switch or switch stack was last connected.
n Usage—Data usage on the switches.
n IP Address—IP address of the switch or switch stack.
n MAC—MAC address of the switch or switch stack.
n Firmware Version—Firmware version of the switch or switch stack.
n Group—Name of the group to which the switch or switch stack is assigned.
n Labels—Name of the label associated with the switch or switch stack.
n Site—Site in which the switch or switch stack is provisioned.
n Uptime—Duration for which the switch is operational.
n Serial/Stack ID—Serial number of the switch or switch stack.
n Uplink Ports—Uplink ports configured on the switch or switch stack.
n Port Utilization—Utilization percentage of the port.

A search filter is provided only for the Device Name and Model columns.

To download the switch details as a .csv file, click theDownload CSV icon. If the table contains unicode
value, you must use a UTF-8 enabled software to view the contents. To view the file, open the file in a
Microsoft Excel spreadsheet software.

Assigning Uplink Ports
To assign uplink port(s):

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
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The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. In the Switches table, hover over the switch for which you want to assign uplink port(s).
4. Click Uplinks.
5. In theAssign Uplink Ports/Trunks dialog box, select the ports in theAssigned Uplink

Ports/Trunks drop-down. On selecting the ports, the uplink rates for the selected ports are
displayed in the uplink trend chart. For more information, see Uplink on page 567.

6. Click Assign.

Deleting an Offline Switch
To delete an offline switch, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selection contains at least one
switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click Offline to display a table with the list of offline switches.
4. In the Switches table, hover over the offline switch that you want to delete.

5. Click the delete icon.

To delete multiple offline switches, select the offline switches that you want to delete, and click the
delete icon at the bottom of the page.

6. Click Yes in the confirmation dialog box.

Downloading Switch Details
You can download the switch details as a .csv file.

To download the switch details, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.

The dashboard context for the selected filter is displayed.

2. UnderManage click Devices > Switches.

A list of switches is displayed in the List view.

3. In the Switches table, click the download icon to download the switches details as a .csv file.

A .csv file is downloaded.

Monitoring Switches in Summary View
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The Switches Summary page provides a graphical view of all metrics about the usage and clients information
associated with the switch provisioned and managed in Aruba Central.

Viewing the Switches Summary Page
To navigate to the Switches Summary page, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click the Summary icon.

The Switches Summary page is displayed with the following information:

n Usage—Displays aggregate client data traffic detected on the switches.
n Clients—Displays the number of clients connected to a switch.

You can change the time range by clicking the time range filter and selecting one of the available
options: 3 hours, 1 day, 1 week, 1 month, or 3 months.

Switch > Overview > Summary
In the switch dashboard, the Summary tab displays the switch device details, network details, ports,
hardware, uplink graph, usage graph, and details about the stack members.

The Summary tab displays the following sections:

n Switch

n Network

n Ports

n Hardware

n Uplink

n Usage

n Stack Members

n Actions

Viewing the Overview > Summary Tab
To navigate to the Summary tab in the Switch dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or Sites.
For all devices, set the filter to Global. Ensure that the filter selected contains at least one active switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the specific switch is displayed.

4. UnderManage, click Overview > Summary .

The Summary tab is displayed.
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5. To exit the Switch dashboard, click the back arrow on the filter.

You can change the time range for the Summary tab by clicking the time range filter and selecting one of
the available options: 3 hours, 1 day, 1 week, 1 month, or 3 months.

Switch
The Switch section displays the following details:

n Model—Hardware model of the switch.

n J-Number—Part number of the switch. This field is displayed only for standalone switches that are not
part of switch stacks.

n Location—Current location of the switch.

n Contact—E-mail address of the contact person.

n Commander—Serial number of the commander switch in a switch stack. This field is displayed only for
switch stacks.

n Serial—Serial number of the switch. This field is displayed only for standalone switches that are not part
of switch stacks.

n MAC Address—MAC address of the switch. This field is displayed only for standalone switches that are
not part of switch stacks.

n Uptime—Time duration for which the switches are operational.

n Last Reboot—Timestamp of when the switch was last rebooted.

n Configuration—Configuration status of the switch.

n Last Sync:—Timestamp when the configuration was last synched between the peer switches in the
stack.

n Last Stats Received—Timestamp of when the last statistics were received.

n Firmware Version—Firmware version of the switch. If an updated version is available, the version
number is displayed and you can click the link to navigate to the firmware management page and
upgrade the firmware.

n Last Updated—Timestamp of when the switch firmware was last changed.

n Firmware Status—Displays whether a new firmware version is available.

n Group—Name of the group to which the switch belongs. Click the group name to view the dashboard
context for the group.

n Site—Name of the site to which the switch belongs. Click the site name to view the dashboard context
for the site.

n Label(s)—Name of the label to which the switch belongs.

Figure 66 Switch Overview

Network
TheNetwork section displays the following details:
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n IP Address—IP address of the switch. For Aruba CX switches, a value is displayed only if the IP address is
configured for the management interface of the switch. If IP address is obtained from the DHCP server,
this field will appear blank for Aruba CX switches.

n Default VLAN—Default VLAN ID of the switch.

n Management VLAN—Management VLAN ID of the switch. This field is displayed only for Aruba Switch
series.

n Stack/Standalone— Indicates whether the switch is part of a stack or if it is a standalone switch.

n Stack Members—Total number of members in the stack. This field is displayed only for switch stacks.

n Stack Topology—Topology of the stack.

n Stack ID—Stack ID used to identify the stack. This field is displayed only for switch stacks.

Figure 67 Network Details

Ports
The Ports section displays the following details:

n Status—Number of ports in Up and Down state, and number of alerts.

n Power Over Ethernet (PoE)—Number of PoE ports enabled and disabled, and number of alerts.

Figure 68 Port Summary

Hardware
TheHardware section displays the following details:

n Power Supply—Total number of power supplies and number of power supplies in Up state.

n Fans—Total number of fans and the number of fans in the Up and Down states.

n CPU—CPU utilization status.

n Memory—Memory utilization status.

n Temperature—Temperature status. Hover your mouse over the status to view the temperature data.
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Figure 69 Hardware Details

Uplink
TheUplink section displays the uplink rate (bps) trend chart for the duration specified in the time range
filter. Hover the mouse over the trend chart to view the uplink rate at a particular time.

Figure 70 Uplink Trend Chart

Usage
TheUsage section displays the trend chart for client data traffic detected on the switch. Hover your mouse
over the trend chart to view data transmitted and received at a particular time.

Figure 71 Usage Graph

Stack Members
The Stack Members table displays the following details:

n Name—Name of the switch stack member.

n Member ID—Identification number of the member.

n Model—The hardware model of the switch.

n MAC Address— The MAC address of the stack member.
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n Serial— The serial number of the switch.

n Role —The role of a stack member.

n Status—The status of the switch stack member.

n Priority—Priority of the member. This column is not displayed for Aruba CX switches.

Figure 72 Stack Members Table

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port

443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Switch > Overview > Hardware
In the switch dashboard, theHardware tab displays information related to power supplies, fans, utilization,
and temperature. TheHardware tab displays the following sections:

n Hardware on page 569
n Power Supplies on page 570
n Fans on page 570
n CPU on page 570
n Memory on page 570
n Temperature on page 570
n Thermals on page 571
n Actions on page 571
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Viewing the Overview > Hardware Tab
To navigate to theHardware tab in the Switch dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the specific switch is displayed.

4. UnderManage, click Overview > Hardware .

TheHardware tab is displayed.

5. To exit the Switch dashboard, click the back arrow on the filter.

You can change the time range for theRouting tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, or 3 months.

Hardware
TheHardware table displays the overall hardware summary:

n ID—Identity of the hardware.
n Name—Name of the device.
n Power Supplies

l Total—Total number of power supplies.

l Up—Number of power supplies in Up state.

l Down—Number of power supplies in Down state.
n Fans

l Total—Total number of fans.

l Up—Number of fans in Up state.

l Down—Number of fans in Down state.
n Utilization

l CPU—Current CPU utilization percentage.

l Memory—Current memory utilization percentage.
n Temperature

l Current—Current temperature. This column is available only for Aruba Switch series.

l Min—Minimum temperature. This column is available only for Aruba Switch series.

l Max—Maximum temperature. This column is available only for Aruba Switch series.

l Sensors—Number of sensors present in the switch. The number inside the brackets show the number of
sensors whose status is high. This column is available only for Aruba CX switches
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Figure 73 Hardware table details for Aruba Switch

Figure 74 Hardware table details for Aruba CX switch

Power Supplies
The Power Supplies table displays the following details:

n Name—Name of the power supply.
n Status—Current status of the power supply.

Fans
The Fans table displays the following details:

n Name —Name of the fan.
n Status—Current status of the fan.

CPU
TheCPU section displays the current CPU utilization percentage and trend chart. Hover over the trend chart
to view the CPU utilization at a particular time.

Memory
TheMemory section displays the current memory utilization percentage and trend chart. Hover over the
trend chart to view the memory utilization at a particular time.

Temperature

This section is available only for <MadCap:variable name="Variables.Company_name_short" /> Switch series.

The Temperature section displays the current, minimum, and maximum temperature and trend chart.
Hover over the trend chart to view the temperature at a particular time.

Figure 75 Temperature
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Thermals

This section is available only for <MadCap:variable name="Variables.Company_name_short" /> CX switches.

The Thermals table displays the following details of each of the sensors that are present in the Aruba CX
switches:

n Name—Name of the component where the sensor is present.
n Status—Current status of the fan.
n Current—Current temperature of the component.
n Min—Minimum temperature of the component.
n Max—Maximum temperature of the component.

Expand each of the rows to display the fan status, location of the fan, current, minimum, and maximum
temperatures, and a temperature trend chart. Hover over the trend chart to view the temperature at a
particular time.

Figure 76 Thermals

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
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n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port
443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Switch > Overview > Routing

The Routing tab is displayed only for Aruba Switch series that run the firmware version 16.09 or later.

In the switch dashboard, theRouting tab displays the following sections:

n Overview of Routing Information on page 572
n Routing on page 572
n Actions on page 573

Viewing the Overview > Routing Tab
To navigate to theRouting tab in the Switch dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the specific switch is displayed.

4. UnderManage, click Overview > Routing .

TheRouting tab is displayed.

5. To exit the Switch dashboard, click the back arrow on the filter.

You can change the time range for theRouting tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, or 3 months.

Overview of Routing Information

n This section displays the following routing information:

l Total—Displays the total number of routes on the switch.

l Static—Displays the total number of static routes on the switch.

l Connected—Displays the total number of connected routes on the switch.

l Dynamic—Displays the total number of dynamic routes on the switch.

Routing
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TheRouting table displays the following details:

n Destination—Displays the network address of the destination route.
n Gateway—Displays the IP address of the gateway.
n VLAN—Displays the VLAN ID of the route destination.
n Type—Displays the following types of routes:

l Static—The routes that are manually added to the routing table in the switch.

l Connected—The routes that are directly connected to the interface.
n Sub Type—Displays the subtype of the route as Internal or External.
n Metric—Displays the measure used to calculate the best path to reach the destination. A value of 1

indicates the best path, 15 indicates the worst path, and 16 indicates that the destination is unreachable
on the route.

n Distance—Displays the administrative distance of the route. The administrative distance helps routers
determine the best route when there are multiple routes to the destination

The routing information is displayed from the Aruba 3810 Series and Aruba 5400R switches in the network. The
details displayed on the Routing tab are refreshed every five minutes.

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port

443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Switch > Overview > AI Insights
In the switch dashboard, theAI Insights tab displays information on switch performance issues such as
PoE issues, port errors, port flaps, airtime utilization, and memory utilization.

Viewing Switches > AI Insights
To navigate to theAI Insights tab in the switch dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroup, Label, or Site.
For all devices, set the filter to Global. Ensure that the filter selected contains at least one active
switch.

The dashboard context for the selected filter is displayed.
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2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the switch is displayed.

4. In the switch dashboard context, click theAI Insights tab.

The Insights page is displayed.

To exit the switch dashboard, click the back arrow on the filter.

You can change the time range for theAI Insights tab by clicking the time range filter and
selecting one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

AI Insights are displayed for the time range selected. Select the time range from the Time Range Filter
( ) to filter reports.

AI Insights Categories
AI Insights are categorized in high, medium, and low priorities depending on the number of occurrences.

n Red—High priority
n Orange—Medium priority
n Yellow—Low priority

AI Insights listed in the dashboard are sorted from high priority to low priority. TheAI Insights dashboard
displays a report of network events that could possibly affect the quality of the overall network
performance. Each insight report provides specific details on the occurrences of these events for ease in
debugging. For more information, see The AI Insights Dashboard.

The switch AI Insights page displays the following insights:

n Switches had unusually high CPU utilization
n Switches had unusually high memory usage
n Switch ports had a high number with Power-over-Ethernet problems
n Switches had an unusual number of port error
n Switches had excessive port flaps

Switch > Clients > Clients
In the switch dashboard, theClients tab displays details about the wired clients that are connected to the
switch. This tab also displays a visual representation of the switch faceplate with port details.

TheClients tab displays the following details:

n Overview of Connected Devices on page 575
n Faceplate on page 575
n Client Devices on page 575
n Actions on page 576

Viewing the Clients > Clients Tab
To navigate to theClients tab in the Switch dashboard, complete the following steps:
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1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the specific switch is displayed.

4. UnderManage, click Clients > Clients.

TheClients tab is displayed.

5. To exit the Switch dashboard, click the back arrow on the filter.

You can change the time range for theClients tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Overview of Connected Devices
This section displays the following details:

n Total—Total number of clients connected to the switch.
n Non-Tunneled—Number of clients, that are not tunneled connected, to the switch.
n User Based Tunneled (UBT)—Number of UBT clients connected to the switch.
n Port Based Tunneled (PBT)—Number of PBT clients connected to the switch.

To view the details about dynamic segmentation, a gateway must be licensed in and connected to the
switch.

Faceplate
If the switch is a standalone switch, the faceplate of the switch is displayed. For a switch stack, faceplate of
all the switches part of the stack is displayed. From the faceplate, click on a port to view port-level
information. On the switch faceplate, hover over a port to view the following details:

n Port Number
n Port Name
n Speed
n Type
n Tunneled

Client Devices
TheClient Devices tab displays the following details:

The VLAN Type, Primary VLAN ID, and Primary VLAN Name columns are not displayed for CX switches.

n Name—Displays the name of the client device.
n Status—Displays the status of the client as Connected, Disconnected, Failed, Connecting, or Blacklisted.
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n Port—Displays the port number of the switch the client device is connected to. If the port is part of a
LAG, the LAG name is displayed.

n MAC Address—Displays the MAC address of the client device.
n IP Address—Displays the IP address of the client device. The IP address is displayed only if the client is

directly connected to the switch or if the IP tracker is enabled on the switch. IP tracker is not available for
Aruba CX switches.

n VLAN ID—Displays the VLAN ID of the client device.
n VLAN Name—Displays the VLAN name of the client device.
n VLAN Type—Displays the following VLAN types of the client device

l Normal—The subnetwork which can group devices on separate physical LANs.

l Primary—The standard VLAN that is partitioned to create a private VLAN.

l Isolated—Secondary VLAN that carries unidirectional traffic upstream from the hosts toward the
promiscuous ports.

l Community— Secondary VLAN that forwards traffic between ports which belong to the same community
and to the promiscuous ports.
n Primary VLAN ID—Displays the primary VLAN ID of the client device.
n Primary VLAN Name—Displays the primary VLAN name of the client device.
n Authentication—Displays the authentication type of the client device.
n Usage—Displays the total data usage by the client device for the selected time period.
n Tunneled—Indicates whether the client is a tunneled client or not. Yes orNo.
n Segmentation—Displays the type of dynamic segmentation configured for the client. Supported values

areUBT, PBT,Underlay,Overlay, orNone.
n Switch Role—Name of the role that the switch assigns to the client.
n Gateway Role—Name of the role that the gateway assigns to the client.
n Gateway Name—Name of the gateway.

The wired client will show up in the Client Devices table only if the client is connected to an , , , , , , or any of
the CX Switch Series.

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port

443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.
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Switch > Clients > Neighbours
In the switch dashboard, theNeighbours tab displays details about the devices neighboring the switch.

TheNeighbours tab displays the following details:

n Neighbour Devices on page 577
n Actions on page 577

Viewing the Clients > Neighbours Tab
To navigate to theClients tab in the Switch dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the specific switch is displayed.

4. UnderManage, click Clients > Neighbours.

TheNeighbours tab is displayed.

5. To exit the Switch dashboard, click the back arrow on the filter.

You can change the time range for theNeighbours tab by clicking the time range filter and
selecting one of the available options: 3 hours, 1 day, 1 week, 1 month, or 3 months.

Neighbour Devices
TheNeighbours tab displays the following details:

n MAC Address—Displays the MAC address of the neighboring device.
n Hostname—Displays the hostname of the neighboring device.
n IP Address—Displays the IP address of the neighboring device.
n Description—Displays the description of the neighboring device.
n Local Port—Displays the local port number of the neighboring device.
n Remote Port—Displays the remote port number of the neighboring device.
n Capabilities—Displays the capabilities of the neighboring device.
n VLAN ID(s)—Displays the VLAN IDs of the neighboring device.

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
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n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port
443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Switch > LAN > Ports
In the switch dashboard, the Ports tab displays details about ports and the LAGs configured in the switch.

The Ports tab displays the following details:

n Port Status on page 578
n Faceplate on page 579
n Ports on page 579
n LAGS on page 579
n Viewing Port-Level Information on page 579
n Actions on page 580

Viewing the LAN > Ports Tab
To navigate to the Ports tab in the Switch dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the specific switch is displayed.

4. UnderManage, click LAN > Ports.

The Ports tab is displayed.

5. To exit the Switch dashboard, click the back arrow on the filter.

You can change the time range for the Ports tab by clicking the time range filter and selecting one
of the available options: 3 hours, 1 day, 1 week, 1 month, or 3 months.

To view a visual representation of the Ports tab, click here.

Port Status
The Port Status section displays the total number of ports for the following:

n Up—Ports in up state
n Down—Ports in down state

https://help.central.arubanetworks.com/2.5.2/documentation/online_help/content/resources/images/gifs/switches-ports.gif
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n Alert—Alerts generated
n Uplink—Number of uplink ports

Faceplate
If the switch is a standalone switch, the faceplate of the switch is displayed. For a switch stack, faceplate of
all the switches part of the stack is displayed. From the faceplate, click on the port to drill down and view
port-level information. On the switch faceplate, hover over a port to view the following details:

n Port
n Name
n Type
n Speed
n LAG
n Reason (Applicable only to Aruba CX switches)

Ports
The Ports table displays the following details:

n Port—Port number. Use the column filter to search for a particular port and use the sort option to sort
the ports in ascending or descending order.

n Name—Name of the switch.
n Status—Status of the switch. Use the column filter to filter by status.
n Type—Type of switch port. Use the column filter to filter by type.
n MTU (Bytes)—MTU size of the switch.
n Speed (Mbps)—Port speed of the switch.
n LAG—If the port is part of a trunk group or LAG, the name of the trunk group or LAG is displayed.
n Admin—Admin status of the switch.
n MAC Address-MAC address of the switch.
n VLAN—VLAN ID of the port.
n VLAN Mode—VLAN mode of the port. Supported values areAccess or Trunk.
n Native VLAN—Native VLAN ID of the port.
n Reason—Indicates the reason when the switch is down. This field is displayed only for Aruba CX

switches.

LAGS
The LAGs table displays the list of LAGs along with the following details:

n Name—Name of the LAG. Use the sort option to sort the LAGs in ascending or descending order.
n Up Ports—Number of uplink ports in the LAG and their port numbers.
n Down Ports—Number of downlink ports in the LAG and their port numbers.
n VSX—Indicates whether VSX is enabled or disabled in the LAG. This column is displayed only for Aruba

CX switches.

Viewing Port-Level Information
Use one of the following options to navigate to the port and view port-level information:
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n In the switch faceplate, click on the port number.
n In the Ports table, click the port number.

The port-level information page consists of the following sections:

n Status—The Status section displays the following details:

l Operational status

l Admin status

l Type of port

l Description

l MAC Address

l Name

l Untagged VLAN

l Tagged VLAN

l Trunk group

l Usage In

l Usage Out

n Port Usage—The Port Usage section provides a graphical representation of data received and
transmitted by the port. Each line in the graph is a sum of the received and sent traffic for a given uplink
port. Hover over the graph to view data for a particular time of the day.

Frame Counters—The Frame Counters section provides a graphical representation of the interface
frame counters. From the drop-down, select one of the following options:

l Unicast
l Broadcast
l Multicast
l Discards
l Error

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port

443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Switch > LAN > PoE
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In the switch dashboard, the PoE tab displays details, such as, PoE status summary, PoE ports, and PoE
consumption.

The PoE tab displays the following details:

n PoE Status on page 581
n Faceplate on page 581
n Ports PoE on page 582
n PoE Consumption on page 582
n Viewing PoE Port-Level Information on page 582
n Actions on page 584

Viewing the LAN > PoE Tab
To navigate to the PoE tab in the Switch dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the specific switch is displayed.

4. UnderManage, click LAN > PoE.

The PoE tab is displayed.

5. To exit the Switch dashboard, click the back arrow on the filter.

You can change the time range for the PoE tab by clicking the time range filter and selecting one of
the available options: 3 hours, 1 day, 1 week, 1 month, or 3 months.

The PoE tab displays monitoring data only if the Aruba Switch or the Aruba CX Switch supports PoE.

PoE Status
The PoE Status section displays the following details:

n Available—Power available for consumption for the switch or stack.
n Used—Power used by various devices.
n Remaining—Power remaining to be utilized in the stack or device.
n PoE Denied Ports—Number of ports for which power is denied.
n Alerts—Number of alerts generated.

Faceplate
If the switch is a standalone switch, the faceplate of the switch is displayed. For a switch stack, faceplate of
all the switches part of the stack is displayed. From the faceplate, click on the port to drill down and view
port-level information. On the switch faceplate, hover over a PoE port to view the following details:
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n Port
n Name
n Type
n Class
n Priority

From theContext drop-down, select the context:

n POE-STATUS—Displays the sate of each port. The state can be: Uplink, Drawing, Enabled, Disabled, or
Alert.

n POE-CLASS—Power class of the PoE port. The class can be: Class0, Class1, Class2, Class3, Class4, or
Disabled.

n POE PRIORITY—PoE priority configured on the port. The priority can be: Critical, High, or Low.

For a visual representation of how to set the context on the faceplate, click here.

Ports PoE
The Ports PoE table displays the following details:

n Port—Port number.
n Name—Name of the port.
n PoE—PoE state: Enabled or Disabled.
n Priority—PoE priority: Critical, High, or Low.
n Status—Current power status of the PoE port: Searching, Delivering, Disabled, or Fault.
n Pre-STD Detect—Displays whether PoE for pre-802.3af-standard powered devices is enabled on the

switch: On or Off.
n Alloc Actual—Power actually being used on the port.
n Alloc Configured—The maximum amount of power allocated for the port.
n PLC Class—Power class of the PoE port.
n PLC Type—Physical layer classification type.

PoE Consumption
The PoE Consumption section displays a trend chart for the PoE power drawn from the switch in watts.
Hover over the trend chart to view the PoE power drawn at a particular time. For a stack, select the switch
from the drop-down to view the PoE consumption for the specific device (commander, standby, or
member.)

For a visual representation of how to view PoE consumption for a switch stack, click here.

Viewing PoE Port-Level Information
Use one of the following options to navigate to the PoE port and view port-level information:

n In the switch faceplate, click on the port number.
n In the Ports PoE table, click the port number.

http://help.central.arubanetworks.com/2.5.2/documentation/online_help/content/resources/images/gifs/switch-context.gif
http://help.central.arubanetworks.com/2.5.2/documentation/online_help/content/resources/images/gifs/switch-poe-consumption.gif
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For a visual representation of how to navigate to the PoE port level, click here.

The port-level information pane displays the following details:

n Summary
n Slot Info & PoE Configuration
n LLDP Information

Summary
The Summary tab displays the following sections:

n Summary—Displays the following details:

l PSE Reserved Power—Power reserved for the port in the Power Sourcing Equipment (PSE).

l PSE Voltage—Total voltage, in volts (V), currently being delivered to the powered device connected to the
port

l PD Power Draw—Power drawn by the powered device.

l PD Amperage Draw—Amperage drawn by the powered device.

l Over Current Count—Number of times a powered device connected to the port attempted to draw more
power than was allocated to the port.

l MPS Absent Count—Number of times the powered device has no longer requested power from the port
MPS is Maintenance Power Signature.

l Power Denied Count—Number of power requests from the port that were denied because sufficient
power was unavailable.

l Short Count—Number of times the switch provided insufficient current to the powered device connected
to the port.
n PoE Consumption—Displays the trend chart for PoE consumption and power available for the duration

specified in the time range filter

Slot Info & PoE Configuration
The Slot Info & PoE Configuration tab displays the following sections:

n PoE Slot Information—Displays the following details:

l Slot—Slot where the port is located.

l —Displays PoE power is available for the slot: On, Off, or Faulty.

l Operation Status
l Maximum Power—Maximum PoE wattage available to provision active PoE ports in the slot.

l Power In Use—PoE power currently being used by the slot.

l Usage Threshold—Configured percentage of available PoE power provisioning the switch must exceed to
generate a usage notice.
n PoE Configuration—Displays the following details:

l PoE Power—Displays whether PoE power is enabled on the port.

l Pre STD Detect—Displays whether PoE for pre-802.3af-standard powered devices is enabled on the
switch: On or Off. This field is not displayed for Aruba CX switches.

l PoE Port Status—Current power status of the PoE port: Searching, Delivering, Disabled, or Fault.

l Power Priority—Power priority configured on ports enabled for PoE: Low, High, or Critical.

http://help.central.arubanetworks.com/2.5.2/documentation/online_help/content/resources/images/gifs/switch-poe-level.gif
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l Allocate by Configuration—Maximum amount of power allocated for the port.

l Allocate by Actual—Power actually being used on the port.

l PLC Class Type—Physical layer classification type.

l DLC Class Type—Data link layer classification type.

l Configured Type—If configured, shows the user-specified identifier for the port. If not configured, this field
is empty.

l PoE Value configuration—PoE power value configured for the port. This field is not displayed for Aruba CX
switches.

LLDP Information
The LLDP Information tab displays the following details:

n UPSE Allocated Power—Power allocated for the port in the PSE.
n PD Requested Power—Power requested by the powered device.
n PD TLV Sent Type—TLV that is actually sent from the powered device.
n PSE TLV Configured—TLV that is configured for the switch port to send to the powered device.
n PSE TLV Sent Type—TLV that is actually sent from the PSE.
n MED LLDP Detect—Status of the PoE LLDP detection. This field is not displayed for Aruba CX switches.

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port

443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Switch > LAN > VLAN
In the switch dashboard, theVLAN tab displays VLAN information configured on the switch and details
about tagged and untagged ports.

TheVLAN tab displays the following details:

n VLANs on page 585
n Faceplate on page 586
n Actions on page 586

Viewing the LAN > VLAN Tab
To navigate to theVLAN tab in the Switch dashboard, complete the following steps:
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1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. Ensure that the filter selected contains at least one
active switch.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click a switch listed underDevice Name.

The dashboard context for the specific switch is displayed.

4. UnderManage, click LAN > VLAN.

TheVLAN tab is displayed.

5. To exit the Switch dashboard, click the back arrow on the filter.

You can change the time range for theVLAN tab by clicking the time range filter and selecting one
of the available options: 3 hours, 1 day, 1 week, 1 month, or 3 months.

VLANs
TheVLANs table displays the following details:

The Type, Primary VLAN, Promiscuos, ISL, and Jumbo columns are displayed only for Aruba Switch series.

n Name—Displays the name of the VLAN. Click the sort icon to sort the VLAN names in the column.
n ID—Displays the VLAN ID associated with the VLAN.
n Status—Displays the status of the VLAN as Up or Down.
n Type—Displays the following types of VLANs:

l Regular VLAN—A regular VLAN is a single broadcast domain.

l Private-Primary—The regular VLAN which partitions one broadcast domain into multiple smaller broadcast
sub-domains.

l Private-isolated—Secondary VLAN that carries unidirectional traffic upstream from the hosts toward the
promiscuous ports.

l Private-Community—Secondary VLAN that forwards traffic between ports which belong to the same
community and to the promiscuous ports.
n Primary VLAN—Displays the primary VLAN details.
n Promiscuous—Displays the promiscuous port value. A promiscuous port is a switch port that is

connected to an uplink router, firewall, or other common gateway device, and can communicate with all
ports within a private VLAN, including the ports in the isolated and community VLANs. By default, every
primary VLAN port acts as a promiscuous port.

n ISL—Displays the Inter-switch Link (ISL) port value (range). ISL port is also called PVLAN member port.
ISL port is required in multi-switch PVLAN configurations to span the switches. The ISL port will
automatically become a member of all VLANs within the PVLAN and it carries traffic from the primary
VLAN and all secondary VLANs

n Tagged Ports—Displays the ports that have marked the VLAN as tagged.
n Untagged Ports—Displays the ports that have marked the VLAN as untagged.
n IP address—Displays the IP address of the VLAN.
n Voice—Displays whether the Voice is enabled or disabled for the VLAN.
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n IGMP—Displays whether the IGMP is enabled or disabled for the VLAN.
n Jumbo—Displays whether the Jumbo packets are enabled or disabled for the VLAN.

Faceplate
From theVLANs table, select a VLAN to view the tagged and untagged ports, promiscuous port, ISL port,
and the VLAN types in the faceplate.

Figure 77 VLANs tab details for Aruba Switch

Figure 78 VLAN tab details for Aruba CX switch

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
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n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port
443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Switch > VSX
Aruba Virtual Switching Extension (VSX) is virtualization technology for aggregation and core Aruba CX
switches. The VSX solution lets the switches present as one virtualized switch in critical areas.

VSX is supported in the Aruba CX 6400 Switch Series, Aruba CX8320 Switch Series, and Aruba CX 8325
Switch Series.

Aruba Central provides support for VSX by displaying information about the configurations of the switches
and the status of the inter-switch link (ISL) between the switches.

Viewing the VSX Page
To navigate to the VSX page in the Switch dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroup, Label, or Site.
Ensure that the filter selection contains at least one Aruba CX switch. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click an Aruba CX switch underDevice Name.

The dashboard context for the switch is displayed.

4. UnderManage, click VSX.

TheVSX page displays the following details:

n VSX Summary on page 587
n Info on page 588
n Actions on page 589

5. To exit the switch dashboard, click the back arrow on the filter

VSX Summary
Displays state information of the switch, connections to the peer switch, and the role of the switch in the
VSX configuration.

Field Description

ISL State State of the ISL connection with the peer Aruba CX switch. Following are the supported values:

Table 159: VSX Summary Details
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Field Description

n WAITING_FOR_PEER—Waiting for connectivity to the peer.
n PEER_ESTABLISHED—Steady state. VSX LAGs are up when the device is in this state.
n SPLIT_SYSTEM_PRIMARY—Lost ISL connectivity to the peer and the device is operating
as primary.
n SPLIT_SYSTEM_SECONDARY—Lost ISL connectivity to the peer and the device is
operating as secondary.
n SYNC_PRIMARY—ISL connectivity to the peer restored and the device is syncing states to
the peer.
n SYNC_SECONDARY—ISL connectivity to the peer restored and he device is learning
states from the peer. VSX LAGs are down when the device is in this state.
n SYNC_SECONDARY_LINKUP_DELAY—Device has learned its states from the peer and
monitoring for hardware is to be programmed. VSX LAGs are down when the device is in
this state.

ISL Mgmt
State

Management state of the ISL. Following are the supported values:
n OPERATIONAL—ISL management is operational.
n INTER_SWITCH_LINK_MGMT_INIT—ISL management is in initialization state.
n CONFLICTING_OR_MISSING_DEVICE_ROLES—Either the role is missing on one of the
VSX peers or the same role is configured on both VSX peers.
n SW_IMAGE_VERSION_MISMATCH_ERROR—Software version on the primary device
does not match with the software version on the secondary device.
n INTER_SWITCH_LINK_DOWN—ISL is down.
n INTERNAL_ERROR—ISL management has internal errors.

Config Sync
Status

Status of the configuration synchronization between the VSX switches. Following are the
supported values:

n IN-SYNC—Configuration synchronization is operational and the VSX switches are in sync.
n DISABLED—Configuration synchronization is disabled.
n SW_IMAGE_VERSION_MISMATCH_ERROR—Software image version on the primary
device does not match with the software image version on the secondary device.
n CONFLICTING_OR_MISSING_DEVICE_ROLES—Either the role is missing on one of the
VSX peers or the same role is configured on both VSX peers.
n PEER_DB_CONNECTION_ERROR—Error in connecting to peer database. It involves
errors due to ISL or ISL management.
n CONFIGURATION_SYNC_CONFLICT—Configuration synchronization is operational but
has conflicts synchronizing the configuration. Conflicts can occur if the configuration on the
primary device is marked for sync, but the same configuration on the secondary device is
not marked for sync.
n CONFIGURATION_SYNC_MISSING_REFERENCE—Configuration synchronization is
operational but has missing references in synchronizing the configuration.

NAE Status of the NAE connection between the VSX switches.

HTTPS Server Status of the HTTPS server connection between the VSX switches.

Last Synched Timestamp of when the configuration was synched between the peer switch.

NOTE: Last synced data is displayed in the VSX page only when VSX synchronization is enabled
for the Aruba CX switch. However, enabling VSX synchronization using template configuration
in Aruba Central is not recommended. By enabling VSX synchronization, the peer switch may
get into an unknown configuration state.

Role Role of the Aruba CX switch in the VSX configuration. Supported values are Primary and
Secondary

Info
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Displays system and configuration information of the switch and its peer. The following details are
displayed:

n System
l Local MAC—MAC address of the selected switch.

l Peer MAC—MAC address of the peer switch.

l Peer Hostname—Hostname of the peer switch.

l Peer IP—IPv4 address of the peer switch.
n Configuration

l Config Sync—Indicates whether the configuration synchronization between the peers are enabled or
disabled.

l ISL Port—Inter-switch Link (ISL) port number of the selected Aruba CX switch. If the ISL is a LAG, then this
field displays the LAG name.

l Peer ISL Port—ISL port number of the peer switch. If the ISL is a LAG, then this field displays the LAG name.

l MC LAGs—List of MC LAG names present in the switches.

Actions
TheActions down-down lists the following options available for remote administration of the switch:

n Reboot—Reboots the switch. See Rebooting Switches.
n Tech Support—Allows the administrators to generate a tech support dump for troubleshooting the

device. See Troubleshooting Aruba Switches.
n Console—Opens the remote console for a CLI session through SSH. Ensure that you allow SSH over port

443. The default user ID is admin, but you can edit and customize the user ID. This custom user ID must
be mapped to the device. See Opening Remote Console for Switch.

If the Copy and Paste function from the keyboard shortcut keys (CTRL+C and CTRL+V) do not work in your web
browser, use the Copy and Paste functions available under the menu options in the web browser.
You can only troubleshoot Aruba switches using the Console option in Aruba Central. You cannot configure the
switches.

Rebooting Switches
You can reboot a switch using the Aruba Central UI.

To reboot a switch, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one switch. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click Online to display a table with the list of online switches.
4. In the Switches table, click the switch to reboot.

The Switches Details page corresponding to the switch is displayed.
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5. In theActions drop-down, click Reboot.
AReboot Switch dialog box is displayed.

6. Click Continue to reboot the switch.

All clients connected to this switch are disconnected and the switch reboots.

The Switches Details page takes less than a minute to update the interface status after the switch is
rebooted and reconnected to Aruba Central.

Opening Remote Console for Switch
In the Aruba Central UI, you can open the remote console for a CLI session through SSH for a switch. Ensure
that you allow SSH over port 443.

For Aruba CX 8320 and 8325 switch series, you must enable SSH server on either the default VRF or the
management VRF depending on the type of VRF that the switch uses to connect to Aruba Central. You must
add one of the following commands in the template:

n If the switch is connecting to Aruba Central using inline default VRF, add ssh server vrf default to the
template.

n If the switch is connecting to Aruba Central using OOBM management VRF, add ssh server vrf mgmt to
the template.

You can only troubleshoot switches using the Console option in . You cannot configure the switches.

To open the remote console for a switch, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one switch. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. Click Online to display a table with the list of online switches.
4. In the Switches table, click the switch for which you want to open the remote console.

The Switch Details page corresponding to the switch is displayed.

5. In theActions drop-down, click Open Remote Console.

A CLI session dialog box is displayed. The default user ID is admin, but you can edit and customize
the user ID. This custom user ID must be mapped to the device.

Troubleshooting Aruba Switches
You can troubleshoot a switch using the Aruba Central UI.

To troubleshoot a switch, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one switch. For all devices, set the filter to
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Global.
The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed in the List view.

3. In the Switches table, click the switch to troubleshoot.

The Switch Details page corresponding to the switch is displayed.

4. In theActions drop-down, click Tech Support.
TheCommands page is displayed.

5. Select any command category in theCategories pane and theCommands pane displays the
associated commands.

CX switches support only the show tech and show running-config commands.

6. Click Add > to add the selected commands to the Selected Commands pane.
7. If you have selected a command marked with either '*' or '+', enter the filtration parameters as

displayed in theAdditional Filters dialog box. For more information on filtering commands, see
Filtering Commands.

8. (Optional) Select command(s) and click < Remove to remove selected command(s) or click <
Remove All to clear the Selected Commands pane.

9. (Optional) To set a frequency for automatically executing the troubleshooting commands:

a. Click theRepeat check box.

b. Specify an interval for executing the troubleshooting commands. You can also specify how
frequently the commands must be executed during a given interval.

c. Click Reset to modify the values in all the fields, and Cancel All for canceling all the repeats.
Click the stop icon to stop a particular repeat.

10. Click Run. The output is displayed in theDevice Output section.

For information about viewing and downloading the output, see Viewing the Device Output.

Enabling Unsupported Transceivers on Aruba Switches
Aruba Switches running software versions 16.02.0013 or later, support the use of third-party transceivers.
Allowing unsupported transceivers enables the Aruba Switch to unblock the port and allow third-party
transceivers to connect to the switch.

To enable this feature, complete the following procedure in Aruba Central:

1. Open the console of the switch using the console option in Aruba Central. For more information, see
Opening Remote Console for Switch.

2. Login to the switch in the console.
3. Run the following command to enable Aruba Central support mode:

aruba-central support-mode enable

4. 1. Run the following command to allow third -party transceivers to be connected to the Aruba
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Switch:

allow-unsupported-transceiver

5. Run the following command to save the running configuration of the switch to the startup
configuration.

write memory

6. Run the following command to disable Aruba Central support mode:

aruba-central support-mode disable

7. Reboot the switch. For more information, see Rebooting Switches.
8. Verify the transceiver details by running the following command:

show tech transceivers

Troubleshooting Aruba CX Switch Onboarding Issues
Though an Aruba CX switch is displayed as online, there might be instances where the complete switch
details are not displayed. To troubleshoot such issues, you can see the audit trail page to check the status of
the switch.

To see the audit trail for a switch, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one switch. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Switches.

A list of switches is displayed.

3. In the Switches table, click the switch you wish to troubleshoot.

The dashboard context for the switch is displayed.

4. UnderAnalyze, click Audit Trail.
TheAudit Trail page is displayed.

If a switch is onboarded successfully, the audit trail log displays the following messages:

a. Device : <Device Serial Number> Onboarded

b. Applying template <Template Configuration Name> to device

c. Login Successful reading running configuration

d. Config push successful
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If applying template configuration to the Aruba CX switch fails, the Template/Variable
Configuration Error error message is displayed:

f any of the messages listed in step 4b, 4c, 4d, or Template/Variable Configuration Error is not
displayed in the audit trail logs, one of the following might be the reason:- User has not created a
template group with template configuration for the CX switch.- User has created a template group
with template configuration but has not moved the CX switch to the template group.

The following image displays the audit trail log of a switch that is successfully onboarded.

Figure 79 Example audit trail log for successfully onboarded Aruba CX switch

Monitoring Gateway
You can monitor gateways in Aruba Central from all the available dashboards includingGlobal,Groups,
Sites, Labels, and Gateways.

For a snapshot of all the gateways configured at the global, group or site level, in either list or summary view,
see the following topics:

n Monitoring Gateway in the List View
n Monitoring Gateways in the Summary View

Monitoring Gateways in List View
The List view for gateways is available from theGlobal,Group, Site, and Label dashboards. In all
applicable dashboards, the List view is underManage > Devices > Gateways.

To view the list of gateways, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.

Ensure that the selected option has at least one gateway configured.

The dashboard context for the selected filter is displayed.

2. UnderManage click Devices > Gateways.

A list of gateways is displayed in the List view.
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List View
The list view displays the following tabs:

n Gateways—Displays the total number of gateways configured.
n Online—Displays a list of gateways that are online and connected to Aruba Central.
n Offline—Displays a list of Gateways that are currently down.

List View > Gateways
TheGateways table displays the following details forGateways,Online and Offline tabs:

n Device Name—Displays the gateway name.
n Model—Displays the model of the gateway.
n Firmware Version—Displays the firmware version of the gateway.
n Uptime—Displays the time period for which the gateway has been functioning.
n IP Address—Displays the IP address of the gateway.
n Site—Displays the site information.
n MAC—Displays the MAC address of the gateway.
n Group—Displays the gateway group name.
n Labels—Displays the labels assigned to the gateway.
n Serial—Displays the gateway serial number.

Apart from the above fields, you can see the following fields if IDPS is enabled:

n Inspection Engine—The Aruba IDPS engine version number.
n Ruleset—The ruleset version currently running on the device.
n Last Successful Ruleset Update—The timestamp of the last successful ruleset update.
n Ruleset Update Status—The ruleset update status could be one of the following:

l Failed
l Success
l Initialized

Click the download icon to download the gateways details as a .csv file. Fore more information, see
Downloading Gateway Details.

Click the ellipsis icon to perform the following additional operations:

n Select the columns that you want to display in the table.
n Adjust the column width of the table to fit the page evenly.
n Reset the table view to the default columns.

Monitoring Gateways in Summary View
The Summary view for gateways is available from theGlobal,Groups, Sites, and Labels dashboards. In all
applicable dashboards, the Summary view is underManage > Devices > Gateways. Displays a graphical
representation of the gateway operations.

To view the summary of gateways, complete the following steps:
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1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.

Ensure that the selected option has at least one gateway configured.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices>Gateways.

A list of gateways is displayed in the List view.

3. Click the Summary icon.

A graphical representation of the gateway operations is displayed.

You can change the time range by clicking the time range filter and selecting one of the available options:
3 hours, 1 day, 1 week, 1 month, and 3 months.

If you have just set up a gateway, you may not see relevant data immediately.

Summary View
The Summary view displays a graphical representation for the following:

n Usage—Displays the overall usage metrics for the gateways provisioned in your Aruba Central account.
Displays the incoming and outgoing traffic for the gateways with time plotted on the x-axis. You can
hover over the chart to see the incoming and outgoing traffic for a particular time frame.

n WAN Compression—Displays the data packet compression statistics for the WAN network. You can
view the compressed, uncompressed, and saved bandwidth. By default, traffic between the Branch
Gateway and VPN Concentrator is subject to compression. You can hover over the chart to see the
compressed and uncompressed statistics for a particular time frame.

n WAN Tag Provider Distribution—Displays the number of online and offline uplinks per
WAN provider.

n WAN Transport Health—Displays the Mean Opinion Score (MOS) score trends for each uplink for the
selected time range. The uplink health trend is plotted using health indicators such as Good, Fair, and
Poor. You can hover over the chart to see the uplink scores for a particular time frame. Click an uplink
name to show or hide MOS score trends for that uplink.

n WAN Type Provider Distribution—Displays the number of online and offline uplinks per WAN circuit
type.

n Model Distribution—Displays the total percentage of gateways distributed per hardware platform. You
can hover over a donut slice to display the percentage for a specific hardware model. Click a hardware
platform number to show or hide the distribution percentage for that platform.

n Firmware Distribution—Displays the total percentage of gateways distributed by software versions.
Click a firmware number to show or hide the distribution percentage for that firmware.

Gateway > Overview > Summary
The Summary tab underManage > Overview in the gateway dashboard displays the following three
sections:

n Device Info
n WAN Summary
n Health Status
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Viewing the Overview > Summary Tab
To navigate to the Summary tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click Overview > Summary .

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for the Summary tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Device Info
TheDevice Info section displays the following details.

Figure 80 Device Info

n Name—The name of the gateway.
n Serial Number—The serial number of the gateway.
n Model—The hardware model of the gateway.
n MAC Address—The MAC address of the gateway.
n System IP address—The IP address of the gateway.
n Public IP address—The public IP address of the gateway.
n Firmware Version—The firmware version running on the gateway. If a new version of the firmware is

available, this information is also displayed. Clicking on the new firmware version redirects you to the
Maintain > Firmware > Gateways page in the gateway dashboard, where you can select the gateway to
upgrade it.

n POE (DRAW/MAX)—The amount of power that the devices connected to the Branch Gateway consume
and the maximum PoE power capacity. For example, if the value displayed is 6/120, the devices draw 6
watts and the maximum PoE power allocated is 120 watts.

n Redundancy Peer—Displays the redundant gateway if it is configured. Click the link to view the
redundant gateway details.
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n Group Name—The name of the group, if the gateway is configured as part of a group. Click the group
name to go to the Overview > Summary page for that group.

n Site—The name of the site, if the gateway is configured as part of a site. Hover over the i icon to display
the complete address of the site. Click the site name to go to the Overview > Site Health page for that
site.

n Labels—The name of the label, if the gateway is configured as part of a single or multiple labels.
n 4G/LTE Modem Status—Displays the modem connectivity status. The status shows only 'Connected'

when the modem type is not internal.
n 4G/LTE Modem Type—Displays the LTE connection type.
n Config Sync Status—The status of the configuration sync. Hover over the i icon to display the last

successful configuration sync time.
n NTP Server—The name of the NTP server configured and its synchronization status.
n Last Reboot Reason—The reason for the last reboot.
n Internal Modem Status (Only for Gateway model: 9004-LTE)—Displays the name of the service

provider and the signal strength. Hover over the information icon to view details about the active SIM,
the IMEI number and the phone number. You can view the signal strength classification based on RSSI
value, in the following table:

WAN Summary
TheWAN Summary section displays information of WAN Availability, VPN Availability, Usage, Throughput
and Compression.

Figure 81 WAN Summary

n WAN Availability—Provides a graphical representation of the WAN uplink availability for the Branch
Gateway. The graph displays each WAN uplink availability for the selected time range. Availability is
determined by the default gateway and monitored IP reachability. You can hover over the chart to see
the WAN availability statistics for a particular time frame.

l Red—Down

l Yellow—(>50) Partial availability

l Green—No Issues

l Gray—Unknown

l Dotted lines—Invalid
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n VPN Availability—Provides a graphical representation of the VPNC reachability for the Branch
Gateway. Availability is determined by the probe settings configured using theHealth Check option.

l Red—Down

l Yellow—>50 percent availability

l Green—No Issues

l Gray—Unknown

l Dotted lines—Invalid
n Usage—Displays the aggregate sent and received traffic usage by the WAN interface for the Branch

Gateway. Displays the incoming and outgoing traffic for the gateways with time plotted on the x-axis.
You can hover over the chart to see the incoming and outgoing traffic for a particular time frame. Select
one of the following options from the drop-down list:

l All

l Internet

l VPN

Click the following icons to see the chart in logarithmic scale or linear scale.

n Logarithmic Scale—Click this icon to view chart in logarithmic scale.

n Linear Scale—Click this icon to view chart in linear scale.

Click Received or Sent at the bottom of the chart to view or hide the usage chart for received or sent data.

n Throughput—Provides a graphical representation of the aggregated WAN interfaces throughput. The
graph displays the transmit and receive performance in bps for a WAN interface. Displays the incoming
and outgoing traffic for the gateways with time plotted on the x-axis. You can hover over the chart to see
the received and sent throughput for a particular time frame.

Click the following icons to see the chart in logarithmic scale or linear scale.

n Logarithmic Scale—Click this icon to view chart in logarithmic scale.

n Linear Scale—Click this icon to view chart in linear scale.

Click Received or Sent at the bottom of the chart to view or hide the usage chart for received or sent data.

n Compression—Displays the aggregate WAN compression details across all uplinks. The average
bandwidth savings is displayed as a percentage. The compressed and uncompressed bandwidth is
displayed as vertical grouped bar graphs. You can hover over the chart to see the bandwidth savings
statistics for a particular time frame.

l Gray—Optimized

l Red—Non Optimized

Health Status
TheHealth Status section displays the health of the gateway in terms of CPU, Memory and device
connectivity to Central.

The health status is plotted using health indicators such as Good, Fair, Poor and Offline. You can hover over
the chart to see the health status for a particular time frame.
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Figure 82 Health Status

The default view of gateways table shows only a few columns. To view the hidden columns, click the settings
icon at the right side of the table. To reset the columns, click Reset Columns.

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

1. UnderManage, click Devices > Gateways.
2. Click a gateway underDevice Name.
3. UnderManage, click Overview. By default, the Summary tab is displayed.

n WAN—Displays the total number of WAN interfaces that are currently operational or down. On clicking a
port, the dashboard displays WAN interface details.

n LAN—Displays the total number of LAN interfaces that are currently operational or down. On clicking a
port, the dashboard displays LAN and VLAN interface details.

n Tunnels—Displays the total number of VPN tunnels that are currently active or down. On clicking a port
tunnel, the dashboard displays VPN tunnel details.

n IDPS—Displays details pertaining to the IDPS traffic inspection engine health and the number of packets
dropped. The IDPS tab is displayed for 9004 gateways with a valid IDPS subscription.

n Routing—Displays details pertaining to the routing protocols such as BGP, OSPF, RIPv2 and Overlay.
n Path Steering—Displays the total number of path steering policies that are compliant with the

performance criteria (SLAs) defined for each type of traffic.
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n Sessions—Displays detailed information about the running sessions.
n AI Insights—Displays a report of network events that could possibly affect the quality of the overall

network performance.
n Alerts—Displays the total number of open alerts that are yet to be acknowledged.

Gateways > Overview > IDPS
The IDPS tab underManage > Overview in the gateway dashboard displays the following sections:

n Traffic Inspection Engine Status
n Traffic Inspection Engine CPU Usage
n Traffic Inspection Engine Memory Usage
n Dropped Packets

After you on-board the gateways and configure IDPS, you can view the IDPS traffic engine health and the
number of packets dropped.

Viewing the Overview > IDPS Tab
To navigate to the IDPS tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or Sites
that has IDPS supported gateways. For all devices, set the filter to Global. The dashboard context for
the selected filter is displayed.
The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.
A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.
The dashboard context for the specific gateway is displayed.

4. UnderManage, click Overview > IDPS .

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for the IDPS tab by clicking the time range filter and selecting one of the
available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

To set the charts to show data for specific duration, use the options in the time range filter. By default, the data

is displayed for a duration of 3 hours. To view the graphs for different durations, click the time filter icon and
select a time range of your choice. You can view data for 3 hours, 1 day, 1 week, 1 month, or 3 months.
The IDPS tab is displayed for 9004 gateways with a valid IDPS subscription.

Traffic Inspection Engine Status
The Traffic Inspection Engine Status chart displays the status of the traffic inspection engine for the
selected period in a timeline chart. Hover over the graph to view the status of the traffic inspection engine at
a particular time. The legends represent different status of the traffic inspection engine.

The Traffic Inspection Engine Status chart is available for a period of 3 hours, 1 day, 1 week, or 1 month.
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Figure 83 Traffic Inspection Engine Status

Traffic Inspection Engine CPU Usage
The Traffic Inspection Engine CPU Usage chart displays the CPU usage percentage of the traffic
inspection engine for the selected period in a line chart. Hover over the graph to view the CPU usage
percentage at a particular time.

Figure 84 Traffic Inspection Engine CPU Usage

Traffic Inspection Engine Memory Usage
The Traffic Inspection Engine Memory Usage chart displays the percentage of memory usage by the
traffic inspection engine for the selected period in a line chart. Hover over the graph to view the memory
usage percentage at a particular time.

Figure 85 Traffic Inspection Engine Memory Usage

Dropped Packets
TheDropped Packets chart displays the number of packets dropped for the selected period in a vertical
bar chart. Hover over the graph to view the packets dropped at a particular time.

Figure 86 Dropped Packets
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Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

Gateway > Overview > Routing
TheRouting tab underManage > Overview in the gateway dashboard displays the following sections:

n Gateway > Overview > Routing > Route Table
n Gateway > Overview > Routing > BGP
n Gateway > Overview > Routing > OSPF
n Gateway > Overview > Routing > Overlay
n Gateway > Overview > Routing > RIP

Viewing the Overview > Routing Tab
To navigate to theRouting tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click Overview > Routing .

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for theRouting tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Gateway > Overview > Routing > Route Table
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TheRoute Table tab underManage > Overview > Routing in the gateway dashboard displays the
following sections:

n Routes Summary
n Routes

Viewing the Overview > Routing > Routes Table Tab
To navigate to theRoutes Table tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click Overview > Routing > Routes Table.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for theRoutes Table tab by clicking the time range filter and
selecting one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Routes Summary
n Capacity—Number of routes currently configured. Also displays the maximum number of allowed

routes.
n Default—Number of default routes.
n Static—Number of static routes.
n Dynamic—Number of dynamic routes.
n Overlay—Number of overlay connections.

Figure 87 Routes Summary

Routes
n Last Refreshed—Indicates the time, in hr:mm:ss format, when the routes were last refreshed.
n Prefix—Controller prefix for the route.
n Length—Prefix length.
n Address—Destination IP address of the route.
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n Route—The route IP address and subnet.
n Nexthop—The IP address of the next hop.
n Protocol—Routing protocol. Possible values are Unknown, Connected, Static, IKE, Overlay, BGP, OSPF,

BOC, RAPNG, RIP, VPN, Application and Default
n Type—The type of connection.
n Metric—Distance for static routes. For a given route destination, there can be multiple next hops. A

route metric enables the gateway to prefer one route over another or load-balance when the metric is
the same.

n Flags—Route flags that indicate the flags for the selected routes.

Figure 88 Routes details

Click the settings icon to reset or set the default columns that are displayed.

Click the filter icon on each column header row to type in an applicable value, and then display the
corresponding row. For Protocol column you can select a value from the drop-down list.
Click the icon on on each column header row to arrange the data in ascending or descending order.
Click the refresh icon on the Routes table to refresh the table data.

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

Gateway > Overview > Routing > BGP
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TheBGP tab underManage > Overview > Routing in the gateway dashboard displays the following
sections:

n BGP Summary

n BGP Details

n BGP Details > Neighbors

n BGP Details > Routes

Viewing the Overview > Routing > BGP Tab
To navigate to theBGP tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or Sites.
Ensure that the filter selection contains at least one gateway. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click Overview > Routing > BGP.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for theBGP tab by clicking the time range filter and selecting one of the
available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

BGP Summary
TheBGP Summary section displays the following information:

l Router ID—Displays the Router ID.

l AS Number—Displays the private Autonomous System (AS) number.

l Neighbors—Displays the number of neighboring connections.

l Routes Learned—Displays the number of routes that have been learned.

Figure 89 BGP—Summary

BGP Details
TheBGP Details section displays the information categorized by Neighbors and Routes.

BGP Details > Neighbors
l Total Neighbors—Displays the total number of neighbors.

l Last Refreshed—Indicates when the last refresh was completed.



Aruba Central | User Guide 606

l Neighbor—Displays the available neighbors.

l ASN—Displays the private Autonomous System (AS) number.

l State—Displays the current state.

l Type—Neighbor type.

l Last State Change—Displays the last state change.

l Down Count—Displays the number of neighbors that are down.

l Up Count—Displays the number of neighbors that are up.

l Hold Time—Displays the time spent on hold.

l Keep Alive Interval—Displays the time set for the Keep Alive Interval.

l Router ID—Displays the Router ID.

l Neighbor Version—Displays the firmware version of the connected neighbors.

l IP Precedence Value—Displays the IP precedence.

l Datagrams (Max = 1400Bytes)—Displays existing datagrams.

l Route Refresh—Displays the latest route refresh.

l Graceful Restart Capability—Displays whether graceful restart is supported.

l BGP Addtl-Paths Computation—Displays the additional paths computation.

l Recv Paths—Displays the receive path information.

l Send Paths—Displays the send path information. Clicking the number of routes opens theRoutes
Advertised table which displays the routes advertised to that neighbor.

l Sent—Displays the number of routes sent.

l Received—Displays the number of routes received. Clicking the number of routes opens theRoutes
Learned table. This table displays a small red circle if the number of routes received has exceeded the
route limit and the corresponding action being taken on the routes (Drop orWarning) as configured
in the BGP configuration page.

l Recv Path Limit—Displays the Route Limit per neighbor configured in the BGP configuration page.

l Recv Path Action—Displays the action specified in the BGP configuration page when the number of
routes exceeds the route limit.

l Source Address—Displays the source information.

l Nexthop—Displays information about the next hop.

l Link Address—Displays the link address.

l CFfg Hold Time— Displays the minimum acceptable hold time.

l CFfg Keep Alive Time— Displays the configuration keep alive time.

l IS Route Reflector—Displays the net hop path.

l IS Router Server—Displays the IS Router Server details.

l BGP Advertise-Best_External—Displays the backup external route.

l Up Time—Displays the time that the connection has been up.
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Figure 90 BGP—Neighbors Details

Clear Neighbor Sessions
l TheClear button allows you to clear BGP neighbor sessions.

l Clear a neighbor session: To clear a specific neighbor session, use theClear button available for
that particular neighbor row.

l Clear all neighbor sessions: To clear all neighbor sessions, use theClear button available on the
table header.

Figure 91 BGP—Clear Neighbors

BGP Details > Routes
l Total Routes—Displays the total number of routes.

l Last Refreshed—Indicates when the last refresh was completed.

l Network—Connected network.

l Neighbor—Displays the available neighbors.

l Nexthop—Displays information about the next hop.

l Metric—Distance for static routes. For a given route destination, there can be multiple next hops. A
route metric enables the gateway to prefer one route over another or load-balance when the metric is
the same.

l Local Pref—Displays the outbound external path.
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l AS Path—Displays the private Autonomous System path.

l State—Displays the connection state of the connection.

l Route Source—Displays the specific route the packet should take.

l Origin—Displays the origin attribute value.

l Advertised to Upd-Grp—Displays the Advertised Update-Group status.

l Router ID—Displays the router ID.

Figure 92 BGP—Routes Details

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Gateway > Overview > Routing > OSPF
TheOSPF tab underManage > Overview > Routing in the gateway dashboard displays the following
sections:

n OSPF Summary
n OSPF Details

Viewing the Overview > Routing > OSPF Tab
To navigate to theOSPF tab in the gateway dashboard, complete the following steps:
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1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click Overview > Routing > OSPF.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for theOSPF tab by clicking the time range filter and selecting one
of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

OSPF Summary
n Status—Status is either Enabled or Disabled.
n Router ID—The routers identification details.
n Areas—Area type as specified in the OSPF parameters.
n Interfaces—Displays the current interface.
n Neighbors—Displays the number of neighbors available.
n Active LSA—Displays the Active Link-State Advertisements.
n Retransmit LSA—Displays the Retransmitted Link-State Advertisements.

Figure 93 OSPF—Summary

OSPF Details
Displays the information categorized by Neighbors, Interfaces,Areas, and Link State Databases.

n Neighbors
l Total Neighbors—The total number of neighbors.

l Last Refreshed—Indicates when the last refresh was completed.

l Neighbor—Details of the neighbors.

l Address—IP address of the neighbor.

l Interface—Displays the current interface for the neighbor.

l Priority—Displays the priority of each neighbor.
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l State—Displays the state of the connection.

l Area—Displays the area of the neighbor.

l Options—Available neighbor options.

l Dead Timer—Displays the required time to wait before the neighbor connection is dead.

l Retransmit Timer—Displays the time between OSPF and LSA retransmissions.

Figure 94 OSPF—Neighbor details

n Interfaces
l Total Interfaces—The total number of interfaces.

l Last Refreshed—Indicates when the last refresh was completed.

l Name—Name of the interface.

l Area—Displays the logical collection of devices that share the same area.

l Address—IP address of the interface.

l Mask—IP mask of the interface.

l State—Displays the state of the connection.

l Type—Displays the type of connection.

l Cost—Displays the cost associated with the OSPF traffic on the tunnel interface.

l Neighbor Count —Displays the number of neighbors.

l ID—Displays the interface ID.

l Address—Displays the IP address of the interface.

l Priority—Displays the priority of the interface to determine the default router.

l Hello Timer—Displays the time interval between the hello packets to be sent on the interface.

l Dead Timer—Displays the time interval after which a router is declared dead if hello packets are not
received.

l Retransmit Timer —Displays the retransmit interval time for link state advertisements.

l Authentication—Displays the status of this option that is used for enabling OSPF authentication mode for
MD5.

Click on an interface listed in the table to view the following details:

l Type—Displays the type of connection.

l Area—Displays the logical collection of devices that share the same area.

l Address—IP address of the interface.

l Mask—IP mask of the interface.

l Cost—Displays the cost associated with the OSPF traffic on the tunnel interface.

l State—Displays the state of the connection.

l Priority—Displays the priority of the interface to determine the default router.
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l Neighbor Count—Displays the number of neighbors.

l Dead Timer—Displays the time interval after which a router is declared dead if hello packets are not
received.

l Hello Timer—Displays the time interval between the hello packets to be sent on the interface.

l Retransmit Timer—Displays the retransmit interval time for link state advertisements.

l Authentication—Displays the status of this option that is used for enabling OSPF authentication mode for
MD5.

Figure 95 OSPF— Interfaces details

n Areas

Click the Settings icon to reset or set the default columns that are displayed.

l Total Areas—The total number of areas.

l Last Refreshed—Indicates when the last refresh was completed.

l Area—Displays the logical collection of devices that share the same area.

l Type—Displays the type of connection.

l Interface count—Displays the interface count.

l SPF Count—Displays the Shortest Path First count.

l Enable Summary—Displays if summary collection is enabled.

Figure 96 OSPF— Areas details

n Link State Databases

Click the Settings icon to reset or set the default columns that are displayed.

l Total Link State Database—The total number of Link State Databases.

l Last Refreshed—Indicates when the last refresh was completed.

l Link ID—Displays the router ID of the originating router.
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l Advertising Router—Displays the routes that is advertising the link-state.

l Area—Displays the logical collection of devices that share the same area.

l LSA Type—Displays the aggregation type.

l Age—Displays the age of the OSPF LSA.

l State—Displays the state of the connection.

l Seq No.—Displays the 32-bit OSPF Sequence number.

l Checksum—Displays the 16-bit checksum for the OSPF packet.

Figure 97 OSPF—Link State Databases details

n LSA types—There are various LSA types available and they are listed here:

l Router—The Router page displays the following details:
o Flags
o Link ID
o Link Data
o Link Type
o Metric

l Network—The Network page displays the following details:
o Mask
o Attached router

l Network Summary—The Network Summary page displays the following details:
o Address
o Mask
o Metric

l ASBR Summary—The ASBR Summary page displays the following details:
o ASBR
o Metric

l External—The External page displays the following details:
o Mask
o Metric
o Type
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o Route Tag
o Forwarding Address

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

Gateway > Overview > Routing > Overlay
TheOverlay tab underManage > Overview > Routing in the gateway dashboard displays the following
sections:

n Overlay Summary

n Overlay Details

Viewing the Overview > Routing > Overlay Tab
To navigate to theOverlay tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or Sites.
Ensure that the filter selection contains at least one gateway. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click Overview > Routing > Overlay.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for theOverlay tab by clicking the time range filter and selecting one of
the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Click the Settings icon to reset or set the default columns that are displayed.

Click the filter icon on each column header row to filter the displayed information

Overlay Summary
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l Status—Status is either Enabled or Disabled.

l Site—Displays the site location.

l Control Connections—Displays the number of active control connections.

l Interfaces—Displays the number of active interfaces.

l Routes Advertised—Displays the number of routes that are advertised.

l Routes Learned—Displays the number of routes that are learned.

Figure 98 Overlay—Summary

Overlay Details
n Displays the information categorized by Control Connections, Interfaces, Routes Advertised, and

Routes Learned.

n Control Connections

Click the Settings icon to reset or set the default columns that are displayed.

Click the filter icon on each column header row to filter the displayed information

l Total Control Connections—Displays the total number of control connections.

l Last Refreshed—Indicates when the last refresh was completed.

l Control Plane Peers—Displays the Control Plane Peers.

l State—Displays the state of the connection.

l Last State Change—Indicates the Last State Change.

l Down Count—Displays the Down Count.

l Routes Advertised—Displays the advertised routes.

l Routes Learned—Displays the number of routes that are learned.

Figure 99 Overlay Details —Control Connections
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n Interfaces

Click the Settings icon to reset or set the default columns that are displayed.

Click the filter icon on each column header row to filter the displayed information

l Total Interfaces—Displays the total number of interfaces.

l Last Refreshed—Indicates when the last refresh was completed.

l Interfaces—Displays the number of active interfaces.

l State—Displays the state of the interface.

l Tunnel Destination—Displays the destination address.

l Uptime—Amount of time the tunnel has been active since it was last reset.

l Routes Learned—Displays the number of routes that are learned.

Figure 100 Overlay Details —Interfaces

n Routes Advertised

Click the Settings icon to reset or set the default columns that are displayed.

Click the filter icon on each column header row to filter the displayed information.

l Route—Displays the route name.

l Nexthop—Displays information about the next hop.

l Interface—Displays the number of active interfaces.

l Flags—Lists the number of active flags.

l Origin—Origin of the route.

l Cost—Cost associated with the route.

Figure 101 Overlay Details—Routes Advertised

n Routes Learned
l Total Routes Learned—Displays the total number of routes that are learned.

l Last Refreshed—Indicates when the last refresh was completed.

l Route—The route IP address aand subnet.

l Age (Last Updated)—Last updated date.

l Origin—Orging of the connection, for example, Connected or Overlay.

l Flags—Lists the number of active flags.

l Nexthop—Displays information about the next hop.

l Interface—Displays the number of active interfaces.
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Figure 102 Overlay Details—Routes Learned

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

Gateway > Overview > Routing > RIP
TheRIP tab underManage > Overview > Routing in the gateway dashboard displays the following
sections:

n RIP Summary
n RIP Details

Viewing the Overview > Routing > RIP Tab
To navigate to theRIP tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

1. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.
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2. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

3. UnderManage, click Overview > Routing > RIP.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for theRIP tab by clicking the time range filter and selecting one of
the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

RIP Summary
TheRIP Summary section displays the following information:

n Enabled—Implies that RIPv2 is enabled on the gateway device.
n Version—Displays the RIP version, RIPv1 or RIPv2. Currently, Arubasupports only RIPv2.
n Interfaces—Displays the number of interfaces that participates in the routing process.
n Neighbors—Displays the number of neighboring connections.
n Routes—Displays the number of routes advertised.
n ECMP—Displays the number of ECMPs available.
n Infinity—The hop count (16) assigned to unreachable devices (typically, any route that requires more

than 15 hops).
n Timers—RIP uses timers to regulate its performance:

l Update timer displays the interval between periodic routing updates. By default this is set to 30 seconds.

l Invalid timer displays the time in seconds after which the route is marked invalid but is still available in the
table. By default this is set to 180 seconds.

l Flush timer displays the time duration after which the route is flushed out or removed from the table. By
default this is set to 120 seconds.

Figure 103 RIP—Summary

RIP Details
Displays the information categorized by Interfaces,Neighbors, and Routes.

n Interfaces
l Name—Displays the name of the interface.

l Address—Displays the IP Address of the interface.

l Cost—Displays the cost associated.

l State—Displays the state of the connection (Up pr Down).

l Neighbors—Displays the number of neighbors.

l Authentication—Displays the status of this option that is used for enabling RIP authentication mode for
MD5.

l Next Update—Time in seconds for the next update
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Click on an interface listed in the table to view the following details:

l RIP Interface—Displays the name of the interface.

l Address—Displays the IP Address of the interface.

l Mask—Displays the subnet mask.

l State—Displays the state of the connection (Up or Down).

l Port—Displays the port number of the interface.

l Version—Displays the RIP protocol version.

l Mode—Displays the interface configuration mode.

l Metric—Displays the number of hop counts.

l Passive—Indicates whether the interface is operating in passive mode.

l Split Horizon—Indicates whether Split Horizon is implemented.

l Poison Reverse—Indicates whether Poison Reverse is implemented.

l Authentication—Displays the status of this option that is used for enabling RIP authentication mode for
MD5.

l Update Timer—Displays the interval between periodic routing updates, by default this is set to 30 seconds.

l Invalid Timer—Displays the time in seconds after which the route is marked invalid but is still available in
the table.

l Flush Timer—Displays the time duration after which the route is flushed out or removed from the table.

Figure 104 RIP—Interfaces Details

n Neighbors
l Address—Displays the IP address of the neighbor.

l Interface—Displays the name of the interface.

l Metric—Displays the number of hop counts.

l Routes— Displays the number of routes learned. Click the number for details of the routes learned.
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l Last Seen— Displays the last seen time duration in nD nH nM nS format.

Figure 105 RIP—Neighbors Details

n Routes
l Route—Displays the route.

l Next Hop—Displays information about the next hop.

l Metric— Displays the number of hop counts.

l Tag—Displays the tag number associated with the route attribute that is set.

l Expires—Displays the time in nD nH nM nS format after which the route expires.

Figure 106 RIP—Routes Details

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console
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n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

Gateway > Overview > Sessions
The Sessions tab underManage > Overview in the gateway dashboard displays the following sections:

n Session Summary
n Sessions

Viewing the Overview > Sessions Tab
To navigate to the Sessions tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click Overview > Sessions.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for the Sessions tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Session Summary
n Displays a summary of all the running sessions.
n Sessions—Displays filtered session information.

The following details are displayed in the Session Summary section:

l Current entries—Displays the number of current and active entries.

l Max entries—Displays the total entries made with the time period.

l High watermark—Displays the highest number of active entries.

l Allocation failures—Displays the number of failed allocations.

l Denied entries—Displays the number of entries that were denied.

Sessions
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The Sessions section displays information filtered by the IP Address entered in the text box.

Click the Settings icon to reset or set the default columns that are displayed.
Click the Filter icon and enter the keyword or ip address to filter the information.

The Session table displays information about:

n Application—Displays the list of applications.
n Protocol—Displays the communication protocol used.
n Source port —Displays the source port number.
n Dest port —Displays the destination port number used by the application.
n Action—Displays the application specific action.
n Flags—Displays the applied flags. Hover over the information icon to see the Legend for the flag

description.
n Packets—Displays the number of packets.
n Bytes—Displays the amount of data (in bytes and mega bytes) consumed by the application.
n State—Displays the connection state of the application. The state can either be Active, Inactive, or

Denied.
n Start Time—Displays the start time.
n Receive Time—Displays the receive time.
n WEBCC Category—Displays the WEBCC category.
n WEBCC Reputation—Displays the WEBCC reputation.
n WEBCC Score—Displays the WEBCC score.
n Application Category—Displays the application category.

To view additional information of individual sessions, click the drop down icon to expand and display
session specific information.

The following information is displayed:

l Details
l User role—Displays the user role name.

l User policy rule (ACE)—Displays the user policy rule.

l Start time—Displays the session start time.

l Receive time—Displays the session receive time.

l WebCC category—Displays the WebCC categorization.

l WebCC reputation—Displays the site reputation.

l Application category—Displays the application category.
n Nexthop

l Uplink interface—Displays the uplink interface details.

l Uplink VLAN—Displays the uplink VLAN details.

l Tunnel—Displays the tunnel details.
n Matching PBR

l Policy Name (RACL)—Displays the policy name.

l Policy Rule (RACE)—Displays the policy rule.
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n Dynamic Path Selection (DPS)
l Policy name—Displays the policy name.

l Path preference—Displays the path interface details.

l Compliance—Displays the compliance details.

l Matching Policy Rule—Displays the matching policy rule.

Matching PBR and Dynamic Path Selection (DPS) tables require SD-WAN version 2.0.0.1 or higher.

Figure 107 Session summary and session information

Figure 108 Session Details

Gateway > Overview > AI Insights
In the gateway dashboard, theAI Insights tab displays information on gateway performance issues such as
tunnel up, tunnel down, airtime utilization, and memory utilization.

Viewing Gateways > AI Insights
To navigate to theAI Insights tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroup, Label, or Site.
For all devices, set the filter to Global. Ensure that the filter selected contains at least one active
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gateway.

The dashboard context for the selected filter is displayed.

2. UnderManage, click Devices > Gateways.

A list of gateways is displayed in the List view.

3. Click a gateway listed underDevice Name.

The dashboard context for the gateway is displayed.

4. In the gateway dashboard context, click theAI Insights tab.

The Insights page is displayed.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for theAI Insights tab by clicking the time range filter and
selecting one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

AI Insights are displayed for the time range selected. Select the time range from the Time Range Filter ( ) to
filter reports.

AI Insights Categories
AI Insights are categorized in high, medium, and low priorities depending on the number of occurrences.

n Red—High priority

n Orange—Medium priority

n Yellow—Low priority

AI Insights listed in the dashboard are sorted from high priority to low priority. TheAI Insights dashboard
displays a report of network events that could possibly affect the quality of the overall network
performance. Each insight report provides specific details on the occurrences of these events for ease in
debugging.

Gateway > WAN > Summary
The Summary tab underManage > WAN page in the gateway dashboard displays the following sections:

n Port Status
n WAN Interfaces
n Go Live

You can view and monitor your WAN interfaces, the tunnels configured, and the path steering data for all
the DPS policies configured.

Viewing the WAN > Summary Tab
To navigate to theWAN > Summary tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.
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The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click WAN > Summary.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for the Summary tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Port Status
n Displays the WAN port status. Click a WAN port for more details.

Figure 109 Port Status

For a 9004-LTE Branch Gateway, the Port Status displays the LTE uplink details and when you hover
over Internal LTE, you can view details about the active SIM, the name of the service provider, and the
signal strength.

Figure 110 Port Status of a 9004-LTE Gateway

You can click on the active SIM to view the port details of cellular.
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Figure 111 Port Details

WAN Interfaces
n Lists the WAN interfaces and provides the total number of WAN interfaces. Displays the summary of

WAN uplinks. The following details are displayed for the port:

Click the Settings icon to reset or set the default columns that are displayed.

l Total WAN Interfaces—Total number of WAN interfaces available.

l Name—Name of the WAN interface.

l Port— Port number along with the associated VLAN ID.

l WAN Status—WAN reachability status.

l VPN Status—VPNC reachability status.

l Usage—WAN interface usage (Sent and Received).

l Throughput—WAN interface transmit and receive performance in Kbps.



Aruba Central | User Guide 626

l Loss—Loss percentage.

l Latency—The latency in milliseconds.

In theWAN Interfaces table, click a port number to display the Packets and Errors details.

Figure 112 WAN Interfaces Packets and Errors

n The following graphs are displayed under the Packets tab:

l Unicast—The number of unicast packets per second.

l Multicast—The number of multicast packets per second.

l Broadcast—The number of broadcast packets per second.
n The following graphs are displayed under the Errors tab:

l CRC Errors—The number of cyclic redundancy errors logged.

l Error Frames—The number of error frames logged.

l Collisions—The number of collisions encountered.
n Additional Parameters—In theWAN Interfaces table, hover on the WAN interface name to view the

additional parameter for the WAN interface.

Figure 113 Additional Parameters

The following additional parameters are displayed for the WAN interface:

l Uptime—Uptime of the uplink (DD-HH-MM).

l Default Gateway—Default gateway.

l Speed/Duplex—Port speed.

l Type—Service provider uplink type (Physical / Virtual).
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l Private IP—Private IP address.

l WAN Backup—Backup of WAN interface (Enabled or Disabled).
n WAN Availability—Provides an overall graphical representation of the selected interface's WAN

availability based on reachability. The graph shows the selected WAN port's ability to reach its default
gateway and health check IP.

n VPN Availability—Provides an overall graphical representation of the selected interface's VPN
availability based on reachability.

n Usage—Displays the inbound and outbound traffic usage.
n WAN Compression—Displays the WAN compression details. The average bandwidth savings is

displayed as a percentage.
n Usage—Provides a snapshot of the WAN usage and is available forAll Traffic, Internet, and VPN

specific information. The graphs also display information that is sent and received and total usage.
n Throughput—Provides a graphical representation of the selected WAN interface's throughput. The

graph displays the WAN interface's transmit and receive performance in bps.
n Performance—The Performance section displays the MOS score of interface and the following graphs

based on the probe that is selected. For a health check probe, only Latency and Packet Loss graphs are
displayed.

l Latency—The latency in milliseconds.

l Packet Loss—Displays the packet loss in percentage.

l Jitter—Displays the jitter in milliseconds.

l MOS Score—Displays the MOS score.
n WAN Compression—Provides bandwidth savings of WAN compression uplink, along with optimized

and non optimized packets and the average bandwidth saved in percentage.

Figure 114 WAN Interfaces Availability

Live Monitoring for Device State is enabled for Status Header Tile, Port Status and WAN Interfaces.
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Figure 115 WAN_Live Monitoring

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live option allows you to view the WAN interface data in real-time. The details about individual
WAN interfaces are updated every five minutes in the normal WAN page view, whereas the details displayed
in Live mode are updated every five seconds. This feature allows you to compare the statistics of two WAN
interfaces. By default, the first two are displayed. You can select the uplinks for which you want to view the
data. This feature is especially useful to troubleshoot issues.

TheDownstream graph displays data on download speed and theUpstream graph provides data on
upload speed. The X-axis in the graph indicates the time and the Y-axis indicates the throughput in Bytes per
second (bps).

The Live session is active for 15 minutes and automatically returns to normal view at the end of 15 minutes.
A timer displays the number of minutes since the live session started.

To view the live statistics of the WAN interfaces, click theGO LIVE button. To go back to normal view, click
the STOP LIVE button.
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Figure 116 GO LIVE page

Gateway > WAN > Tunnels
The Tunnels tab underManage > WAN page in the gateway dashboard displays the following sections:

n Tunnels Summary
n Tunnels
n Tunnel Info

The Tunnels tab displays the status and health details for Branch Gateway tunnels and IAP-VPN tunnel.

Viewing the WAN > Tunnels Tab
To navigate to the Tunnels tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click WAN > Tunnels.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for the Tunnels tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Tunnels Summary
The following details are displayed in the Tunnels Summary table:
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n Total—Total number of VPN tunnels.
n Up—Number of VPN tunnels in UP state.
n Down—Number of VPN tunnels in DOWN state.
n Peers—Total number of VPN peers.
n Orchestrated—Total number of VPN tunnels running in orchestrated mode.

Figure 117 Tunnels Summary

Tunnels
The following details are displayed in the Tunnels table:

n Name—Tunnel name.
n Status—Status of the tunnel (Up or Down).
n Mode—Displays the type of tunnel. The tunnel configurations displayed are:

l Orch—Identifies tunnels that have been orchestrated.

l Orch-Srv—Identifies the orchestrated tunnels that are in survivability state.

l Orch-IKE—Orchestrated tunnels which use the Internet Key Exchange (IKE) protocol to set up a security
association (SA) in the IPsec protocol suite with 3rd party devices such as Zscaler.

l IKE—Identifies tunnels created manually using the IKE protocol.
n Source—Source IP address of the tunnel.
n Destination—Destination IP address of the tunnel.
n Loss—Percentage of packet loss.
n Latency—The latency in microseconds.
n Last Change Reason—Reason for the last status change of the tunnel.
n Availability—Availability graph of the tunnel. Displays the percentage of time the tunnel was in UP

state.

The default view of gateways table shows only a few columns. To view the hidden columns, click the settings
icon at the right side of the table. To reset the columns, click Reset to default.
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Figure 118 Tunnels Details

Tunnel Info
n Expand a tunnel name to view the following details:

l Uptime—Amount of time the tunnel has been active since it was last reset.

l Link—Tunnel link.

l WAN IP—WAN IP address.

l Uplink Port—Uplink port details.

l Last Change Reason—Reason for the last status change of the tunnel.

l Peer IP—Peer IP address.

l VLAN—VLAN ID.

l Source MAC—Source MAC address.

l Next Rekey—Next Rekey time.

l Auth—Authentication methods such as SHA1, DES, and 3DES.

l In SPI—Inbound Security Parameter Index (SPI).

l Out SPI—Outbound Security Parameter Index (SPI).

l Encryption—Encryption.
n Availability—Availability information of the tunnel.

l Tunnel Status—Provides an overall graphical representation of the selected tunnel's availability based on
VPNC reachability.

l Usage—Displays the tunnel's traffic usage.

l Throughput—Displays the inbound and outbound traffic rates for the selected tunnel. The graph displays
the tunnel's performance in Kbps. The graph also displays information that is sent and received.

l Performance—The Performance section displays the details based on the interface that is selected.

Live monitoring is enabled for sections that display the status, such as:

n The Tunnels Summary
n Status of the Tunnels Details

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):
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n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

n Utilization—Displays the utilization in percentage terms. The average, minimum, and maximum packet
utilization is displayed.

n SLA Policy Compliance—Displays the following details:

Gateway > WAN > Path Steering
In the Path Steering tab, you can view traffic path steering details for the Dynamic Path Steering policies
configured on the Branch Gateway. This tab also displays the number of policies that are compliant along
with the total number of policies configured on the Branch Gateway.

From the list of Dynamic Path Steering polices, select the policy for which you want to view the path steering
details.

The Pathsteering tab underManage > WAN page in the gateway dashboard displays the following
sections:

n Path Steering Summary
n Path Steering Details

Viewing the WAN > Path Steering Tab
To navigate to the Path Steering tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click WAN > Path Steering.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for the Path Steering tab by clicking the time range filter and
selecting one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.
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Path Steering Summary
Displays the following information.

n State—Displays whether the path steering feature is enabled.
n Policy Compliance—Displays the compliance status of all the configured policies.

Figure 119 Path Steering Summary

Path Steering Details
Displays the following information.

n Status—Provides a graphical representation of the configured uplink statuses. The following details are
displayed:

l Overall status

l The status of each of the uplinks configured for the Dynamic Path Steering policy on that gateway

Hover over the status bar to view the compliance status details of all the configured uplinks. You can view
the compliance status of the uplinks and the probe IPs. If the probe IPs are non-compliant, it displays the
reason for non-compliance such as latency, jitter, or packet loss. The following list contains the various colors
and the corresponding compliance status:

l Green—An uplink is Compliant when all of the associated probe IPs meet the set SLAs and threshold
settings.

l Orange—An uplink is Partially Compliant when you have multiple probe IPs and not all of them are
compliant.

l Red—An uplink isNon-Compliant when all of the probe IPs are non-compliant.

l Yellow—This is theHold Periodwhen an uplink changes it's status from Non-compliant to Compliant
(usually the first 3 minutes of the transition phase).

l Grey—Uplink status isUnknown when the Dynamic Path Steering feature does not send any compliance
information to the cloud.
n Sessions—Provides a graphical representation of the total number of sessions. The following details are

displayed:
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l Overview

l The sessions count on each of the uplinks configured for the Dynamic Path Steering policy on that gateway

Figure 120 Path Steering Details—Compliance Summary

n Event Logs—When an uplink becomes non-compliant, an event is recorded. When the same uplink
becomes compliant adhering to the set SLAs, another event is recorded. The Event Logs table provides
information about all such events. It displays the timestamp and a detailed event statement that
contains the policy name, the uplink name, the probe IP, and the reason for non-compliance, if it is a non-
compliance event.

Figure 121 Event Logs

Live monitoring is enabled for sections that display status, such as:

n Thepath Steering Summary
n Real time state of the Event Logs
n Path Steering Summary—Path steering summary of the primary, secondary, and standby uplinks. The

following details are displayed for each uplink:
n Path Steering Details—Displays the following path steering details:
n Traffic Path—Displays traffic path steering status for each link associated with the WAN policy. The

following details are also displayed:
n Status—Provides a graphical representation of the status of uplinks. The following details are displayed:
n MPLS (Primary)
n Comcast (Secondary)
n LTE (Standby)
n Traffic Steer—Displays the following graphs:
n Traffic Classification—Displays charts showing client traffic trends to application, application

categories, website categories, and websites of a specific security reputation score. The Traffic
Classification section also shows application with the highest security threat score. To view the traffic
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classification based on application, application category, and website category, you must enableDeep
Packet Inspection on the Branch Gateways.

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

Gateway > LAN > Summary
The Summary tab underManage > LAN page in the gateway dashboard displays the following sections:

Port Status

LAN Interfaces Summary

VLAN Interfaces Summary

Viewing the LAN > Summary Tab
To navigate to theWAN > Summary tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click LAN > Summary.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for the Summary tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Port Status
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n Provides a graphical representation of the Branch Gateway's LAN link availability. Also provides a quick
view of the LAN port status. Click a LAN port to view the Port Details pop-up screen.

Figure 122 LAN port status

LAN Interfaces Summary
n The table displays the summary of LAN interfaces and total number of LAN interfaces. The following

details are displayed for the port:

l Port—Port number. Click on the Port to open the Port Details pop-up screen.

l Admin State—Administrative state of the LAN interface. Values are Enabled orDisabled.

l Operational State—Operational state of the LAN interface. Values areUp orDown.

l Port Speed—Port speed.

l VLANs—Range of VLANs.

l MTU—MTU value.

Figure 123 LAN Interfaces Summary

Port Details pop-up Screen
Click on a Port in the Port Status or LAN Interfaces Summary screen to display the Port Details pop-up
screen.

n The following graphs are displayed under the Port Details > Packets tab:

l Unicast—The number of unicast packets per second.

l Multicast—The number of multicast packets per second.

l Broadcast—The number of broadcast packets per second.

Hover over any point of time on the x-axis to get data about packets for that instant of time.
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Figure 124 Port Details—Packets

n The following graphs are displayed under the Port Details > Errors tab:

l CRC Errors—The number of cyclic redundancy errors logged.

l Error Frames—The number of error frames logged.

l Collisions—The number of collisions encountered.

Hover over any point of time on the x-axis to get data about packets for that instant of time.
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Figure 125 Port Details—Errors

VLAN Interfaces Summary
n The table displays the summary of VLAN interfaces and total number of VLAN interfaces. The following

details are displayed:

l VLAN ID—VLAN ID number.

l IP Address—IP address.

l Admin State—Administrative state of the VLAN interface.

l Oper. State—Operational state of the VLAN interface.

l Addressing Mode—Type of addressing mode.

l Description—Description of the VLAN.

l Status—Status of the VLAN interface.

Figure 126 VLAN Interfaces Summary

Live monitoring is available for the following:
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n Port Status
n Operational state of the LAN interface in LAN Interfaces Summary table.

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

Gateway > LAN > DHCP
TheDHCP tab underManage > LAN page in the gateway dashboard displays the following sections:

n Gateway > LAN > DHCP
n Active Leases

Viewing the LAN > DHCP Tab
To navigate to theWAN > DHCP tab in the gateway dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click LAN > DHCP.

To exit the gateway dashboard, click the back arrow on the filter.

You can change the time range for theDHCP tab by clicking the time range filter and selecting one
of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

DHCP Pools



Aruba Central | User Guide 640

n The table displays the summary of DHCP pools and total number of DHCP pools. The following details
are displayed:

l VLAN ID—VLAN ID number.

l Pool Name—Name of the DHCP pools.

l Subnet—IP address of the client subnet.

l Pool size—Size of the pool.

l Lease time—Lease time of the pool.

l Free—Number of addresses available.

Figure 127 DHCP Pools

Active Leases
n The table displays the summary of active leases total number of active leases. The following details are

displayed:

l Pool Name—Name of the DHCP pools.

l Private IP—IP address of the client subnet. The IP address with asterisk symbol (*) indicates it is a reserved
IP address.

l MAC Address—MAC address of the client. Clicking on the address takes you to the Client page.

l Client Name—Client name.

l Client Type—Client type.

l Start Date—Start date and time of the lease.

l End Date—End date and time of the lease.

l Remaining—Remaining time for the lease to expire.

Figure 128 Active Leases
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Live monitoring is available for the following:

n Port Status
n Operational state of the LAN interface in LAN Interfaces Summary table.

Actions
TheActions drop-down list contains the following options (the Clear IPSec SA, and Clear ISAKMP SA options
are available for tunnels only):

n Reboot Gateway—Reboots the gateway. See Rebooting a Gateway
n Open Remote Console—Opens the remote console for a CLI session through SSH. The default user ID

is admin, but you can edit and customize the user ID. This custom user ID must be mapped to the device.
See Opening a Remote Console

n Clear IPSec SA—Clears the IPSec Security Associations (SA). See Clearing IPSec SA
n Clear ISAKMP SA—Clears the ISAKMP SA. See Clearing ISAKMP SA

Go Live
TheGo Live link redirects to theManage > WAN > Summary tab in the gateway dashboard. See theGo
Live section in the Gateway > WAN > Summary page.

Gateway > Applications > Visibility
TheVisibility tab underManage > Applications in the gateway dashboard displays the following tabs:

n Gateway > Applications > Visibility
n Gateway > Applications > Visibility

TheVisibility dashboard displays charts showing client traffic trends with respect to application, application
categories, website categories, and websites of a specific security reputation score. To view the traffic
classification based on application, application category, and website category, you must enable
Application Visibility service on Branch Gateways.

To view the application usage metrics for gateways, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one Branch Gateway. For all devices, set the
filter to Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in the List view.

3. Click a gateway underDevice Name.

The dashboard context for the specific gateway is displayed.

4. UnderManage, click Applications > Visibility .

The Visibility dashboard is displayed with two second-level tabs,Applications and Websites.

You can change the time range for theVisibility tab by clicking the time range filter and selecting
one of the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.
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Click the List and the Summary icons on the Application and Websites sections to toggle between the
dashboard views.

Applications Tab in List View
TheVisibility > Applications tab in List view displays the following:

n Application—Displays the top N applications based on total bandwidth usage. Apart from the top N, the
rest of the applications are grouped under theUnclassified category. Click the + sign next to the service
name to expand an application in List view. A graph is displayed with date and time on the x-axis and
usage on the y-axis. The graph displays the amount of data sent and received by the application over a
period of time. To get the data sent and data received information for a specific day, hover over a point
on the x-axis.

n Category—Displays the top N web categories based on total bandwidth usage. Apart from the top N,
the rest of the web categories are grouped under theUnclassified category.

n Usage—Displays the bandwidth usage of each application.
n Sent—Displays the amount of data sent by the application.
n Received—Displays the amount of data received by the application.

Figure 129 Visibility > Applications in List View

Applications Tab in Summary View
n TheVisibility > Applications tab in Summary view displays the following:
n Applications—Displays the graph top 5 applications based on total bandwidth usage. The graph

displays date on the x-axis and usage on the y-axis. To get the total data usage information for a specific
day, hover over a bar on the x-axis.

n Categories—Displays the top 5 web categories based on total bandwidth usage. The graph displays date
on the x-axis and usage on the y-axis. To get the total data usage information for a specific day, hover
over a bar on the x-axis
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Figure 130 Visibility > Applications in Summary View

Websites Tab in List View
TheVisibility > Websites tab in List view displays the following:

n Reputation and Usage—Displays the reputation and usage percentage.
n Category and Usage—Displays the WebCC category and the usage percentage.

Figure 131 Visibility > Websites in List View

Websites Tab in Summary View
TheVisibility > Websites tab in Summary view displays the following:

n Reputations—Displays the top 5 reputations based on total bandwidth usage. The graph displays date
on the x-axis and usage on the y-axis. To get the total data usage information for a specific day, hover
over a bar on the x-axis.

n Web Categories—Displays the top 5 WebCC categories based on total bandwidth usage. The graph
displays date on the x-axis and usage on the y-axis. To get the total data usage information for a specific
day, hover over a bar on the x-axis.
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Figure 132 Visibility > Websites in Summary View

Downloading Gateway Details
You can download the gateway details as a .csv file.

To download the gateway details, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.

The dashboard context for the selected filter is displayed.

2. UnderManage click Devices > Gateways.

A list of gateways is displayed in the List view under the second-levelGateways tab.

3. In theGateways table, click the download icon to download the gateways details as a .csv file.
A .csv file is downloaded.

Related links:

Deleting a Gateway

Rebooting a Gateway

Deleting a Gateway
You can only delete a gateway when the device is offline. To delete an offline gateway, complete the
following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in List view under the second-levelGateways tab.

3. Click Offline to display a table with the list of offline gateways.
4. From theGateways table, select the gateway(s) that you want to delete. To select a gateway, click on

any column except Device Name.

Clicking on a device name in the Device Name column opens the gateway dashboard.
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5. Click theDelete button at the bottom of the page to delete all the selected gateways. To delete a
particular gateway, click theDelete button available at the end of the row for that gateway.

6. Confirm deletion.

The offline gateway is deleted. However, the device still can be found in Aruba Central database, as the
device entry remains in theDevice Inventory page.

Rebooting a Gateway
You can reboot a gateway using the Aruba Central UI.

TheReboot Gateway option is available under theActions drop-down for many gateway pages. The
following procedure explains how to reboot a gateway in theManage > Overview > Summary page for a
gateway.

The Reboot Gateway option is only available for online gateways.

To reboot a gateway, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in the List view under the second-levelGateways tab.

3. Click the second-levelOnline tab to display a table with the list of online gateways.
4. In the Gateways table, click the gateway to reboot.
5. You can delete the gateway in multiple ways. Perform one of the following steps:

n In theActions drop-down list, click Reboot Gateway.
n Click theReboot button available at the end of the row for that gateway.
n Click theReboot button at the bottom of the page.

AReboot dialog box is displayed.
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6. Click Yes to reboot the gateway.

All clients connected to this gateway are disconnected and gateway reboots.

TheGateway Details page takes less than a minute to update the interface status after the gateway is
rebooted and reconnected to Aruba Central

Opening a Remote Console
In the Aruba Central UI, you can open the remote console for a CLI session through SSH for a gateway.
Ensure that you allow SSH over port 443.

To open the remote console for a gateway, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in the List view under the second-levelGateways tab.

3. Click the second-levelOnline tab to display a table with the list of online gateways.
4. In the Gateways table, click the gateway for which you want to open the remote console.

TheOverview > Summary page corresponding to the gateway is displayed.

5. In theActions drop-down list, click Open Remote Console.

A CLI session dialog box is displayed. The default user ID isAdmin, but you can edit and customize
the user ID. This custom user ID must be mapped to the device.

Clearing IPSec SA
In the Aruba Central UI, you can clear the IPSec Security Association (SA) for a gateway. TheClear IPSec SA
option is available under theActions drop-down for many gateway pages. The following procedure explains
how to clear IPSec SA in theManage > Overview > Summary page for a gateway.

The Clear IPSec SA option is only available for online gateways.

To clear IPSec SA for a gateway, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in the List view under the second-levelGateways tab.

3. Click the second-levelOnline tab to display a table with the list of online gateways.
4. In theGateways table, click the gateway for which you want to clear the IPSec SA option.

TheOverview > Summary page corresponding to the gateway is displayed.

5. In theActions drop-down list, click Clear IPSec SA.
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Clearing ISAKMP SA
In the Aruba Central UI, you can clear the ISAKMP Security Association (SA) for a gateway. TheClear
ISAKMP SA option is available under theActions drop-down for many gateway pages. The following
procedure explains how to clear ISAKMP SA in theManage > Overview > Summary page for a gateway.

The Clear IPSec SA option is only available for online gateways.

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the filter selection contains at least one gateway. For all devices, set the filter to
Global.

The dashboard context for the selected filter is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in the List view under the second-levelGateways tab.

3. Click the second-levelOnline tab to display a table with the list of online gateways.
4. In the Gateways table, click the gateway for which you want to clear the ISAKMP SA option.

TheOverview > Summary page corresponding to the gateway is displayed.

5. In theActions drop-down list, click Clear ISAKMP SA.

The clear command is sent successfully. A success message is displayed.

Enabling Gateway Logs
Logs aims to help users diagnose and debug issues detected in an Aruba Central-managed network. The
Logs tab on the Tools page of a gateway dashboard provides the user with an option to enableOn-
Demand data collection. TheOn-Demand data collection enables you to download TAR logs and crash
logs related to gateways.

To enable logs collection for a gateway on the Aruba Central-managed network, complete the following
procedure::

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. Ensure that the selected option contains at least one gateway. For all devices, set the filter to
Global.
The dashboard context for the selected filter is displayed.
n To select a device in the filter:

a. Set the filter to Global.
b. UnderManage, click Devices > Gateways.

A list of gateways is displayed in the List view.

c. Click a gateway listed underDevice Name for which you want to perform diagnostic test.

The dashboard context for the gateway is displayed.

2. UnderManage > Devices, click theGateways tab.

A list of gateways is displayed in the List view.

3. Click a gateway listed underDevice Name.

The dashboard context for the gateway is displayed.

4. UnderAnalyze > Tools, click the Logs tab.
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5. In the Logs tab, turn on the Enable On-Demand data collection toggle to download TAR logs and
crash logs.

6. To upload TAR log or crash log, click + in the Log Files table. The Upload Log File panel opens.
7. Configure the following parameters as per your requirements:

Parameter Description

File type Select one of the log file types listed here:
n TAR log
n Crash log

Tar log The following options are displayed when the File Type is configured as TAR log. You
can select one of the options listed here:

n Upload existing file—Allows you to upload an existing TAR log file.
n Generate & upload new file now—Allows you to generate and upload a new
TAR log file now.
n Generate & upload new file at a scheduled time—Allows you to generate and
upload a new TAR log file at a later date and time.

Crash Log The following options are displayed when the File Type is configured as Crash log. You
can select one of the options listed here:

n Upload existing file—Allows you to upload an existing Crash log file.
n Prepare & upload new file now—Allows you to prepare and upload a new Crash
log file now.
n Prepare now & upload new file at a scheduled time—Allows you to prepare a
Crash log file now and upload it at a later date and time.

Scheduled
Time

If you chose to upload a TAR or Crash log file at a later date and time, configure the
parameters listed here:

n Select Zone—Allows you to configure the time zone.
n Select Date—Allows you to select a date within the range of a week.
n Hours—Allows you to configure hour ranging from 0 to 23.
n Minutes—Allows you to configure minutes ranging from 0 to 59.

Table 160: Upload Log File Configuration Parameters

8. Click Save.
9. The Log Files table displays the information in the table below:

Parameter Description

File type Displays the name of the generated log file.

Type Displays the type of the generated log file:
n TAR file
n Crash file

Status Displays the status of the generated log file.
Scheduled—Displays this status when an existing log file is scheduled for upload.
In progress—Displays this status when a new log file is generated and it is scheduled for
upload now or for a later date.

Collection
Time

Displays the time when the log file was created.

Table 161: Log Files Parameters
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Parameter Description

Size Displays the size of the log file.

User Displays the User ID of the user who generated the log file.

10. To download a log, select the respective log listed in the Log Files table and click the download icon.
11. To delete a log, select the respective log listed in the Log Files table and click the delete icon.

About RAPIDS
With Aruba Central, you can quickly identify and act on interfering devices that can be later considered for
investigation, restrictive action, or both. Once the interfering devices are discovered, Aruba Central sends
alerts to the network administrators about the possible threat and provides essential information needed
to locate and manage the threat.

This section includes the following topics:

n Viewing the RAPIDS Page
n Monitoring WIDS Events
n Configuring IDS Parameters
n Generating Alerts for Security Events
n Generating Reports for Security Events

Viewing the RAPIDS Page
To view the RAPIDS page, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroup, Label, or Site.
For all devices, set the filter to Global.

2. UnderManage, click Security. TheRAPIDS > IDS > WIDS Events table is displayed.

Users with the admin role can see all the interfering devices.

Monitoring WIDS Events
TheManage > Security > RAPIDS > IDS tab provides a summary of the total number of wireless attacks
detected for a given duration.

TheWIDS Events table displays the following information category:

n Infrastructure attacks—Displays the number of infrastructure attacks detected in the network.
n Client attacks—Displays the number of client attacks detected in the network.
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Field Description

Event Type The type of the intrusion or attack detected. Click the drop-down arrow at the column heading to
filter the event types based on your requirement.

Category Category of the intrusion or attack, infrastructure or client attack. Click the drop-down arrow at
the column heading to filter the category that you want to display.

Level The level of the intrusion or attack detected. Click the drop-down arrow at the column heading to
filter the attack level.

Time Time of the intrusion or attack.

Station
MAC

MAC address of the station under attack or BSSID of the AP under attack.

Detecting
AP

The MAC address of the device that detected the intrusion or attack.

Radio Band Radio band on which the intrusion was detected. There are two radio band signals available, 2.4
GHZ and 5 GHZ. Click the drop-down arrow at the column heading to filter the radio band where
the intrusion was detected.

Description Details of the attack or the intrusion.

Table 162: WIDS Events

Note the following important points:

n Clicking icon enables you to customize theWIDS Events table columns or set it to the default view.
n To view the details of each event that is generated, click the arrow against each row in the table.

n Intrusions are displayed for the time selected in Time Range Filter. TheWIDS Events displays data for
a maximum time period of 1 only.

Configuring IDS Parameters
The type and severity of Intrusion Detections raised by an AP is configurable and affects the data that is
seen in theWIDS Events table. For more information, see Configuring IDS Parameters on APs on page 340.

Generating Alerts for Security Events
Aruba Central supports configuring alerts for IDS events. To generate alerts, complete the following steps:

1. In theNetwork Operations app, use the filter to select Global.
2. UnderAnalyze, click Alerts & Events. TheAlerts & Events page is displayed.
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3. In theAlerts & Events page, click theConfig icon.

TheAlert Severities & Notifications is displayed.

4. Select Access Point tab to display the AP dashboard. Aruba Central supports three alert types for
identifying interfering devices:
n Rogue AP Detected
n Infrastructure Attacks Detected
n Client Attack Detected

5. Select an alert and click + to enable the alert with default settings. To configure alert parameters, click
on the alert tile (anywhere within the rectangular box) and do the following:

a. Severity—Set the severity. The available options are Critical, Major, Minor, and Warning.

For a few alerts, you can configure threshold value for one or more alert severities. To set the
threshold value, select the alert and in the exceeds text box, enter the value. The alert is triggered
when one of the threshold values exceed the duration.

b. Device Filter Options—(Optional) You can restrict the scope of an alert by setting one or more
of the following parameters:
n Group—Select a group to limit the alert to a specific group.
n Label—Select a label to limit the alert to a specific label.
n Sites—Select a site to limit the alert to a specific site.

c. Notification Options
n Email—Select the Email check box and enter an email address to receive notifications when

an alert is generated. You can enter multiple email addresses, separate each value with a
comma.

n Webhook—Select theWebhook check box and select the Webhook from the drop-down list.
For more information, see Webhooks on page 738.

d. Click Save.

For more information on how to configure Alerts, see Configuring Alerts on page 724.

Generating Reports for Security Events
Aruba Central supports generating reports for IDS events. To generate reports, complete the following
steps:

1. In theNetwork Operations app, use the filter to select Global.
2. UnderAnalyze, click Reports.
3. In the Reports page, click Create. Aruba Central supports Security Compliance to display the

report of all wireless intrusions. For more information on how to create Reports, see Creating a
Report on page 771.

For creating RAPIDS report, you need not select the Groups or Labels option. Also, you need not select the
Device Groups name or Labels name from the Device Groups or Labels drop-down lists, respectively.

Network Health Dashboard
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The Network Health dashboard displays information of the network sorted by site. This dashboard displays
information on network devices and WAN connectivity of individual sites.

To launch theNetwork Health dashboard, complete the following procedure:

1. In theNetwork Operations app, set the filter to Global.
2. UnderManage, click Overview > Network Health to launch theNetwork Health dashboard.

TheNetwork Health dashboard has two views, you can toggle between them by clicking on the view icons.

n Summary— This view displays the vital network information of individual sites on cards mapped by
geographical location. Sites are marked with location pins- red pin for a site with potential issues and
green pin for a site with no issues. To view the information card of a site, click on the location pin of a site.
Hover over a site to view the Network health card.

The following table lists the information displayed in a Network health card:

Item Description

Insights Displays the number of AI Insight reports available for the site. The reports are organized by
degree- High, Medium, and Low depending on the number of events in the network.

Devices Displays the number of connected and Offline APs for the site. Clicking on one of the numbers
redirects you to the Devices dashboard page of the site.

Clients Displays the number of connected and failed clients for the site. Clicking on one of the numbers
redirects you to the Clients dashboard page of the site.

RF
Coverage

Provides a link to view or configure the floorplan for the site. Clicking on the Floorplan redirects
you to the floor plans page of the site

Uplinks Displays the uplink connectivity status of devices in the site. This information is displayed when
there is at least one uplink in the site.

Tunnels Displays the connectivity status of tunnels in the site. This information is displayed when there
is at least one tunnel in the site.

High Mem
usage

Displays the number of devices with high memory utilization in the site. This information is
displayed when there is at least one device with high memory utilization in the site.

High CPU
usage

Displays the number of devices with high CPU usage in the site. This information is displayed
when there is at least one device with high CPU usage in the site.

High CH
utilization

Displays the number of APs with a higher channel utilization in the 5 GHz and 2.4 GHz radio
bands. This information is displayed when there is at least one AP with a higher channel
utilization in the 5 GHz or 2.4 GHz radio bands in the site.

High
noise
utilization

Displays the number of APs with high RF noise in the 5 GHz and 2.4 GHz bands. This
information is displayed when there is at least one AP with a higher noise utilization in the 5
GHz or 2.4 GHz radio bands in the site.

Table 163: Network Health Card

n List—This view displays the global network report in a list sorted according to individual sites. Clicking on
the site name will take you to the Site Health dashboard page. The data columns listed in the page can
be managed by clicking on the hamburger icon ( ) on the right of the column header. The report can be
filtered by clicking on the filter labels below the column name. Selecting a filter label filters the results
based on the field values of the column is ascending or descending order, sites with zero issues will not be
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displayed. The order of the results displayed can be toggled by clicking the or icon beside the
filter.

TheNetwork Health dashboard displays the information listed in the table below.

Header Description

Site Name The name of the site. Clicking on the site name will take you to the Site Health dashboard page
(Site > Overview > Site Health tab). To search for a site by name, click on the Site Name label
and enter the name of the site.

AI Insights Displays the number of AI Insight reports available for the site. The reports are organized by
degree- High, Medium, and Low depending on the number of events in the network.

Number of Devices

Status The number of devices that are in Up or Down state in a site. Click the List icon and hover your
mouse over a field in the column to view the following details:

n WLAN Devices Down
n Wired Devices Down
n Branch Devices Down

High
Memory
Usage

The number of devices with high memory utilization in the site. Click the List icon and hover your
mouse over a field in the column to view the following details:

n WLAN High Memory
n Wired High Memory
n Branch High Memory

High CPU
Usage

The number of devices with high CPU usage in the site. Click the List icon and hover your mouse
over a field in the column to view the following details:

n WLAN CPU High
n Wired CPU High
n Branch CPU High

High CH
Utilization

The number of APs with a higher channel utilization in the 5 GHz and 2.4 GHz radio bands.

Clients Displays the number of connected and failed clients for the site.

High
Noise

The number of APs with high RF noise in the 5 GHz and 2.4 GHz bands.

WAN

Uplink
Status

Displays the uplink connectivity status of devices in the site. The data is classified into two
columns: devices with no issues and devices with no uplink connectivity.

Tunnel
Status

Displays the connectivity status of tunnels in the site. The data is classified into two columns:
tunnels with no issues and tunnels with no connectivity.

Table 164: Network Health Dashboard

Global—Summary
In theGlobal dashboard, the Summary tab displays theUsage, Clients, Bandwidth Usage Per
Network, Client Count Per Network, Top APs By Usage, Top Clients By Usage, Top IAP Clusters By
Usage, Top IAP Clusters By Clients, and WLAN network details.
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You can change the time range for the Summary tab by clicking the time range filter and selecting one of
the available options: 3 hours, 1 day, 1 week, 1 month, and 3 months.

Viewing the Global Summary Page
To navigate to the Global Summary page, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage, click Overview > Summary.

The Global Summary page is displayed.

The Global Summary page displays the following information:

Data Pane
Item

Description

Usage Displays the incoming and outgoing data traffic detected on the APs.

Clients Displays the number of clients connected to an AP over a specific time period.

Bandwidth
Usage Per
Network

Displays the incoming and outgoing traffic for all APs per SSID over a specific duration.

Client Count
Per Network

Displays the number of clients connected to an AP per SSID over a specific time period.

Top APs By
Usage

Displays the list of top APs that utilize the maximum bandwidth in the network. Bandwidth usage
includes the sum total of data transmitted and received on the radio interfaces and wired clients
connected to the AP.

Top Clients
By Usage

Displays the list of top clients connected to the currently available SSIDs that utilize the
maximum bandwidth in the network.

Top
IAP Clusters
By Usage

Displays the list of top AP clusters that utilize the maximum bandwidth in the network.

Top
IAP Clusters
By Clients

Displays the list of top AP clusters connected to the client that utilize the maximum bandwidth in
the network.

WLAN Displays the list of SSIDs configured. The WLANs table displays the SSID details such the Name,
Clients, Type, and Security.

Table 165: Global Summary Page Parameters

Site Health Dashboard
The Site Health dashboard displays details of wired and wireless devices deployed on the site. This page
includes information on client connectivity statistics, change logs, health of devices, and RF health of the
site.

To launch the Site Health dashboard, complete the following procedure:
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1. In theNetwork Operations app, set the filter to a site.
2. UnderManage, click Overview > Site Health to launch the Site Health dashboard.

Alternatively, the Site Health dashboard can be accessed by selecting a site from theNetwork Health
dashboard page. The Site Health dashboard displays the information listed in the table below:

Content

Name Name of the site.

Location Location of the site.

APs Number of APs deployed on the site.

Switches Number of switches deployed on the site.

Gateways Number of gateways deployed on the site.

Summary
Statistics

A graphical representation of the number of clients (wired and wireless) and their bandwidth
usage for the selected time range.

Change Log A visual representation of change logs for configuration, firmware, and reboot changes in the
selected time range. Select a column in the graph and click on the Config Log, Firmware Log
and Reboot Log button to view detailed information logs on the corresponding events in the site.

System Health Indicators

Down
Devices

This graph shows the count of devices with DOWN status. The graph displays the following
information:

n Total number of devices
n Number of unique devices that were DOWN
n Minimum and maximum device downtime.

To view more details, select a time range in the graph and click on See Devices. A pop-up
window displays the details of devices with DOWN status and their Up and Down time in
percentage. You can also add other metrics such as CPU, Memory, 5 GHz and 2.4 GHz Channel
Utilization, and 5 GHz and 2.4 GHz Noise Floor by clicking on the Add Metric button. A particular
device can be filtered from the list by clicking on the filter icon ( )and entering the name of the
device.

High
CPU & High
Memory

This graph shows the total count or percentage of devices with high CPU utilization and high
memory utilization.

n High CPU Utilization—This graph displays the total number of devices, number of unique
devices with high CPU utilization, and minimum and maximum number of devices with high
CPU utilization. You can also view the total count or percentage of maximum and minimum
number of devices with high CPU utilization for a specific time when you hover your mouse
over the graph.
n High Memory Utilization—This graph displays the total number of devices, number of
unique devices, the minimum and maximum number of devices with high memory utilization.
You can also view the total count or percentage of maximum and minimum number of
devices with high memory utilization for specific time when you hover your mouse over the
graph.
n Threshold Setting Widget—You can also choose to view the graph details based one of

the following criteria by clicking the ( ) icon and selecting any of the following options:
n >70% CPU utilization

n >80% CPU utilization

Table 166: Site Health Dashboard



Aruba Central | User Guide 656

Content

n >90% CPU utilization

n >70% memory utilization

n >80% memory utilization

n >90% memory utilization
To view more details, select a time range in the graph and click on See Devices. A pop-up
window displays the details of devices with high CPU utilization and memory utilization with their
individual minimum and maximum values. You can add other metrics such as 5 GHz and 2.4 GHz
Channel Utilization , 5 GHz and 2.4 GHz Noise Floor, and Device Down time for the devices by
clicking on the Add Metric button. A particular device can be filtered from the list by clicking on
the filter icon ( ) and entering the name of the device.

RF Health Indicators

5 GHz
Utilization
and Noise

This graph displays the total count or percentage of devices with high channel utilization and high
noise floor levels for 5 GHz band.

n Device Details—The graph displays total number of devices, number of unique devices
with high 5 GHz channel utilization and high noise floor levels, and the minimum and
maximum number of devices with high channel utilization. You can also view the total count of
maximum and minimum number of devices with high 5 GHz channel utilization and noise for
a specific time when you hover your mouse over the graph.
n Threshold setting—You can also choose to view the graph details based one of the

following criteria by clicking the ( ) icon and selecting any of the following options:
n >60% 5 GHz Utilization

n >70% 5 GHz Utilization

n >80% 5 GHz Utilization

n >-75 dBm 5 GHz Noise

n >-80 dBm 5 GHz Noise

n >-85 dBm 5 GHz Noise
To view more details, select a time range in the graph and click on See Devices. A pop-up
window displays the details of devices with high CPU utilization and memory utilization with their
individual minimum and maximum CPU utilization values. You can add other metrics such as
CPU, Memory, 2.4 GHz Channel Utilization, 2.4 GHz Noise Floor, and Device Down time for the
devices by clicking on the Add Metric button. A particular device can be filtered from the list by
clicking on the filter icon ( ) and entering the name of the device.

2.4 GHz
Utilization
and Noise

This graph displays the total count or percentage of devices with a higher channel utilization and
high noise floor levels for 2.4 GHz channel.

n Device Details—The graph displays the total number of devices, number of unique
devices with high 2.4 GHz channel utilization and noise floor levels, minimum and maximum
number of devices with high channel utilization and noise levels. You can also view the total
count of maximum and minimum number of devices with high 2.4 GHz Utilization and Noise
for a specific time when you hover your mouse over the graph.
n Threshold Setting widget —You can also choose to view the graph details based one of

the following criteria by clicking the ( ) icon and selecting any of the following options:
>60% 2.4 GHz Utilization

>70% 2.4 GHz Utilization

>80% 2.4 GHz Utilization

>-75 dBm 2.4 GHz Noise

Table 166: Site Health Dashboard
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Content

>-80 dBm 2.4 GHz Noise

>-85 dBm 2.4 GHz Noise
To view more details, select a time range in the graph and click on See Devices. A pop-up
window displays the details of devices with 2.4 GHz channel utilization and 2.4 GHz noise floor
with their individual minimum and maximum values. You can add other metrics such as CPU,
Memory, 5 GHz Channel Utilization, 5 GHz Noise Floor, and Device Down time for the devices by
clicking on the Add Metric button. A particular device can be filtered from the list by clicking on
the filter icon ( ) and entering the name of the device.

NOTE: The threshold setting widget ( ) is visible only when you bring the mouse pointer closer to its position
slightly above the right-hand side of each graph.

Table 166: Site Health Dashboard

Wi-Fi Connectivity
TheWi-Fi Connectivity page displays an overall view of the connection details for all clients that are
connected to or tried to connect to each connection phase. The connection phases includeAssociation,
Authentication,DHCP, and DNS.

To view the connectivity details page complete the following procedure:

1. In theNetwork Operations app, select one of the following options:
n To select a group, site, or all devices in the filter, set the filter to one of the options underGroup or

Site. For all devices, set the filter to Global.
2. UnderManage > Overview, click Wi-Fi Connectivity.

The dashboard context for the selected filter is displayed.

By default, the graphs on theWi-Fi Connectivity page is plotted for a time range of 3 hours. To view the
graphs for a different time range, click the Time Range Filter icon. You can choose to view graphs for a
time period of 3 hours, 1 day, 1 week, 1 month and 3 months.

This section includes the following topics:

n Connectivity Summary Bar
n Connection Experience
n AI Insights
n Connection Problems
n Connection Events

Connectivity Summary Bar
The connectivity summary bar displays the details of all clients in percentage. It displays the percentage
success rate of each stage for the users to know the network performance.

Figure 133 Connectivity Summary Bar
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The following table describes the information displayed in each section:

Field Description

All Displays the aggregated success percentage of Association, Authentication, and DHCP for all
clients connected to the network.

Association Displays the percentage of successful attempts made by a client to connect to the network.

Authentication Displays the percentage of successful attempts of client authentication.

DHCP Displays the percentage of successful attempts of DHCP requests and responses when
onboarding a client.

DNS Displays the percentage of successful attempts in the detected DNS resolutions, when a
client is connected to the network.

Table 167: Connectivity Summary Bar

Connection Experience
TheConnection Experience tile displays the overall success percentage, total number of attempts,
number of successful attempts, total delays, and the total failures for each of the stages based on the
selected time range filter. To view the connection experience for each individual stage, select the stage type
from theConnectivity Summary bar, theConnection Experience gets charted for the selected stage.

Figure 134 Connection Experience tile

AI Insights
TheAI Insights tile provides a list of AI Insights generated for a selected time range. To view the details, click
on a selected AI Insight. The page gets redirected to the AI Insights under theAI Insights page. Click each
of the listed AI Insight for a detailed analysis based on the impact on the network. For more information on
AI Insights, see The AI Insights Dashboard.
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AI-Insights is not implemented for Association and DNS. AI Insights is not implemented at a Group level also.
The page displays No AI Insights observed.

For a visual representation of viewing an AI Insight, click here.

Connection Problems
TheConnection Problems tile displays the details of Failures and Delays graphically for each of the
categories from the drop-down list. Each graph displays the top five MAC addresses or SSID based on the
selected category. Each category in theConnection Problems drop-down lists changes based on the
selected stage in theConnectivity Summary bar. Selecting the required category from the drop-down
displays the failures and delays in a pie chart with percentage, and a bar graph with the number of failures
and delays. Hover the cursor over each graph to view the number of failures or delays for each stage.

Figure 135 Connection Problems Tile

The following table describes the information displayed in each connection category based on the selected
stage:

Data Pane
Content

Description

All Displays the details of the failures and delays that occurred during a client connection. The
chart displays the failure details of Association, Authentication, and DHCP for each client. The
Connection Problems drop-down list includes the following categories:

n By Stage
n By Clients
n By Access Points
n By Band

Table 168: Connection Problems Rolls-ups

https://help.central.arubanetworks.com/2.5.0/documentation/online_help/content/clients/wifi-connectivity.htm
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Data Pane
Content

Description

n By SSID

Association Charts the details of the failures and delays that occurred during a client association. The
Connection Problems drop-down list includes the following categories:

n By Clients
n By Access Points
n By Band
n By SSID
n By Reason

Authentication Charts the details of the failures and delays that occurred during a client authentication. The
Connection Problems drop-down list includes the following categories:

n By Type
n By Clients
n By Access Points
n By Band
n By SSID
n By Server

DHCP Charts the details of the failures and delays that occurred during the attempts of DHCP
requests and responses by a client. The Connection Problems drop-down list includes the
following categories:

n By Clients
n By Access Points
n By Reason

DNS Charts the details of the failures and delays that occurred during the attempts in detected
DNS resolutions when a client is connected to the network. The Connection Problems drop-
down list includes the following categories:

n By Access Points
n By Reason
n By Server

Connection Events
Connection Events table details out the list of delays and failures for each client based on the client MAC

addresses. Click the icon to view the connection events table. Click theConnection Events drop
down to filter the eventsBy Clients orBy Access Points. TheConnection Events table displays the
following information:

Data Pane Content Description

MAC Address Displays the MAC address of the client.

Name Displays the name of the access point.

Delays Displays the delays that occurred during the event.

Failures Displays the failure details that occurred during the event.

Table 169: Connection Events
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All Clients
TheClients page provides a list view of all the clients connected to the network. You can filter clients based
on the network the clients are connected to. The page displays key client information and also allows you to
view a specific client detail page.

For monitoring clients connected to an Aruba Switch, the client entry is displayed in theAll Clients page
only if the client is connected to one of the following supported Aruba Switches:

n Aruba 2530 Switch Series (applies to wired authenticated clients only)
n Aruba 2540 Switch Series
n Aruba 2920 Switch Series
n Aruba 2930F Switch Series
n Aruba 2930M Switch Series
n Aruba 3810 Switch Series
n Aruba 5400R Switch Series
n Aruba CX Switch Series

To view the list of clients connected:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. The dashboard context for the selected filter is
displayed.

2. UnderManage, click Clients. The clients overview page is displayed in List view.
3. By default, theClients table displays a unified list of clients. The list of clients is populated for a time

range of 3 hours. To view the list of clients for a different time range, click the Time Range Filter
and select the required time period. Total data usage for the selected time period is displayed above
the client summary bar.

4. To filter clients based on the device to which the clients are connected, select the device type from
theClients drop-down list:
n All—Displays a list of all the clients connected to the network.
n AP—Displays a list of clients connected to the Instant AP.
n Switch—Displays a list of clients connected to the switch.
n Gateway—Displays a list of clients connected to the gateway.

5. To filter clients based on the network to which the clients are connected, click the network type from
theClient Summary bar:
n All—Displays a list of all the clients connected to the network.
n Wireless—Displays a list of clients connected to the wireless network.
n Wired—Displays a list of clients connected to the wired network.

6. To filter the clients based on the state of connectivity, click the connectivity type from theClient
Summary bar:
n Connected—Displays a list of clients that are successfully connected to the network.
n Failed—Displays a list of all failed client connections.
n Offline—Displays a list of all offline clients.
n Blocked—Displays a list of all blocked clients.
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TheClients table lists the details of each client. By default, the table displays the following columns: Client
Name, Status, IP Address, VLAN, Connected To, Link,AP Role,Gateway Role, and Health. Click the
ellipsis icon to perform additional operations:

n Download CSV—Downloads the client details in the .csv file format.
n Select All—Selects all columns.
n Reset Columns—Resets the table view to the default columns.

If a filter icon appears next to the column header, click it and enter the filter criteria or select a filter criteria.
For example, in theClient Name column, enter the name of the client and in the Status column, select
from one of the predefined filter criteria: Connected,Offline, Failed, orBlocked.

Column
Names Applicability Description

Client Name n All
n AP
n Switch
n Gateway

Username, hostname, or MAC address of the client. Click the client name to
view the Summary page.

Status n All
n AP
n Switch
n Gateway

Client connection status. Use the filter option to view the following:
n Connected clients
n Offline clients
n Failed clients
n Blocked clients

Hover the cursor over the status column to view a pop-up summary based
on the connection status. The status summary is populated based on the
status type. Each status type and the summary is described below:
Connected:

n Client name—Name of the client.
n Authentication—Type of authentication. Displays the authentication
label only for authenticated clients.
n IP address—Client IP address
n Connected Since—Date and time at which the client was connected.
n Failure Stage—Status of the client that failed to connect.
n Health Score—Device health.
n Connected Device Port—The device port that the wired client is
connected to.

Failed:
n Client name—Name of the client.
n Last Seen Time—Date and time the client was last connected.
n Failure Stage—Status of the client that failed to connect.
n Failure Reason—Reason for the client failure.
n Connected Device Port—The device port that the wired client is
connected to.

Offline:
n Client name—Name of the client.
n Authentication—Type of authentication. Displays the authentication
label only for authenticated clients.
n IP address—Client IP address
n Connected Since—Date and time at which the client was connected.
n Last Seen Time—Date and time the client was last connected.
n Failure Stage—Status of the client that failed to connect.
n Connected Device Port—The device port that the wired client is
connected to.

Blocked:

Table 170: All Client Details
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Column
Names Applicability Description

n Client name—Name of the client.
n Last Seen Time—Date and time the client was last connected.

IP Address n All
n AP
n Switch
n Gateway

IP address of the client.

VLAN n All
n AP
n Switch
n Gateway

VLAN of the device to which the client is connected.

Connected To n All AP name, Switch name, or Gateway name. This is the first layer 2 hop for
the client. If the device does not have a name, the MAC address is
displayed.

AP Role n All
n AP

Role assigned by the Instant AP.

Gateway Role n All
n Gateway

Role assigned by the Aruba Gateway.

Health n All
n AP

Client health. The value can be one of the following:
n Poor—0-30
n Fair—31-70
n Good—71-100

Link n All
n AP
n Switch
n Gateway

Displays the SSID for wireless clients and the port number for wired clients.
The column title displays SSID and Port interchangeably based on the
device filters. For APs, the column title displays SSID. For switch and
gateway, the column title displays Port.

Insights n All
n AP

The total number of AI insights generated for the client.

Switch Role n All
n Switch

Role assigned by the Aruba switch.

Failure Stage n All
n AP

Failure status of the client that failed to connect. The failure reasons could
be:

n Association error
n MAC authentication error
n 802.1X authentication error
n Key exchange error
n DHCP error
n Captive Portal error

Group Name n All
n AP
n Switch
n Gateway

Displays the name of the group that the device is connected to. The
Connected To column displays the device name that the client is connected
to.

Table 170: All Client Details
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Column
Names Applicability Description

Site Name n All
n AP
n Switch
n Gateway

Displays the name of the site that the device is connected to. The
Connected To column displays the device name that the client is connected
to.

MAC Address n All
n AP
n Switch
n Gateway

MAC address of the client.

Hostname n All
n AP
n Gateway

Host name of the client.

User Name n All
n AP
n Switch
n Gateway

Username of the client.

Key
Management

n All
n AP

Security mode used by the client.

Authentication n All
n AP
n Switch
n Gateway

Authentication type.

IPV6 Address n All
n AP

IPv6 address of the client.

Capabilities n All
n AP

Client capabilities.

Usage n All
n AP
n Switch
n Gateway

Total data usage for the selected time period.

Last Seen
Time

n All
n AP
n Switch
n Gateway

Date and time when the client was last seen.

Connected
Since

n All
n AP
n Switch
n Gateway

Date and time since when the client was connected.

AP Name n All
n AP

Name of the Instant AP.

AP Mac
Address

n All
n AP

MAC address of the Instant AP.

Table 170: All Client Details
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Column
Names Applicability Description

Channel/Band n All
n AP

Last connected channel and band.

Switch Name n All
n Switch

Name of the switch.

Port n All
n Switch
n Gateway

Port number of the switch.

Gateway
Name

n All
n Gateway

Name of the Aruba Gateway.

Tunneled n All
n AP
n Switch
n Gateway

Tunnel mode applicable for the Aruba Gateway managed WLAN, UBT, or
PBT client.

Segmentation n All
n AP
n Switch
n Gateway

Type of segmentation. The type of segmentation can be:
n None
n UBT
n PBT
n Underlay
n Overlay

NOTE: To view the details about dynamic segmentation, a gateway must be
licensed in Aruba Central and connected to the switch.

Client
Category

n All
n AP
n Gateway

Displays the category of the profiled device. For example, Access Points,
Computer, Smart Device, VoIP phone, and so on.
For more information, see Classifying Clients.

Client Family n All
n AP
n Gateway

Displays the type of operating system or vendor. For example, if the client
category is Computer, the client family can be Windows, Linux, or Apple
Mac.
For more information, see Classifying Clients.

Client OS n All
n AP
n Gateway

Displays the operating system that the device runs on. For example, if the
client category is Computer and the client family is Windows, the client OS
can be Windows or Windows 8/10.
For more information, see Classifying Clients.

Table 170: All Client Details

Client Overview
TheClients page displays the details of clients connected to the devices in Aruba Central and their
connectivity status.

To view the clients overview page:
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1. In theNetwork Operations app, use the filter bar to select a group, label, site, or a device.
2. UnderManage, click Clients. The All Clients overview page is displayed.

3. Click the icon to view the client overview page.

The overview page displays the total number of clients, bandwidth usage, and the application usage by the
clients connected to the wired and wireless networks. The following table describes the information
displayed in each section:

Data Pane
Content

Description

Time Range
Filter

By default, the graphs on the Clients page are plotted for a time range of 3 hours. To view the
graphs for a different time range, click the Time Range Filter link. You can choose to view
graphs for a time period of 3 hours, 1 day, 1 week, 1 month and 3 months.
However, the Distribution data (Client OS) under the Distribution tab does not honor the time
range you selected in the time range filter.

Total Displays the total number of clients.

Wireless Displays the total number of clients connected to wireless network.

Wired Displays the total number of clients connected to the wired network.

Usage Displays the Bandwidth Usage of the incoming and outgoing throughput traffic for all the
clients during a specific time range. The graph will not show any data for the clients that are
connected to the network for less than two hours.

Distribution Displays the type of client device connected to the wireless network.

Top N Displays a list of clients connected to the currently available SSIDs that utilize the maximum
bandwidth in the network.
The Top Clients by Usage table displays data only for the clients that are connected to the
network for a total duration of two or more hours.

Table 171: Client Overview Page

Clients > Wireless Client > Overview
TheClients page displays the number of clients connected to the wireless and wired networks. By default,
theClients page displays a unified list of clients for the selected group, label, site or device. The wireless
client overview page displays the client summary details, AI Insights, Location, and client sessions details for
the selected client.

The wired client shows up in the All Clients page only if the client is connected to an Aruba 2540 Series, Aruba
2920 Series, Aruba 2930F Series, Aruba 2930M Series, Aruba 3810 Series, or Aruba 5400R Series switch.

The section includes the following topics:

n Viewing Clients Connected to Wireless Networks
n Overview
n Applications
n Live Events
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n Events
n Tools

Viewing Clients Connected to Wireless Networks
To view the details of a client connected to the wireless network, perform the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.The dashboard context for the selected filter is
displayed.

2. UnderManage, click Clients. TheAll Clients page is displayed.
3. By default, theClients table displays a unified list of clients.
4. Click the client name to view the client details page. If there are many clients connected to the

network, click Wireless to filter the clients connected to the wireless network.
5. Enter the client name in theClient Name column and then click the client name. TheClient

Summary page is displayed.

For a visual representation of the procedure, click here.

Overview
The wireless client overview tab displays the wireless client summary, AI insights, location, and sessions
details for each client.

Wireless Client Health Bar
The client heath bar displays the client connection, device health, and transmission rate along with name of
the device the client is connected to. For more information, see The Health Bar.

TheHealth bar displays the following information:

Field Description

Connection
status

Connection status of the client. Connection status is updated immediately on state change.

Device
Health

Signal strength of the client device. The signal strength value is displayed in percentage:
n 0-25—Poor
n 26-50—Fair
n 50-100—Good

Signal
Quality

SNR for the client as measured by the AP. The SNR value is displayed in decibels:
n 0-20—Poor
n 21-35—Fair
n >35—Good

TX | Rx
Rate

Data transmission and reception rate.

Connected
To

Name of the AP that broadcasts the SSID to which the client is connected. Click the name of the
AP to view the device details page.

Table 172: Wireless Client Health Bar

http://help.central.arubanetworks.com/2.4.8/documentation/online_help/content/resources/images/gifs/wireless-client.gif
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Summary
The wireless Client Details page displays the information about the type of data path that the client uses,
the network and connectivity details, and basic client details such as IP address of the client, type of
encryption etc. The client details page refreshes automatically to display real time data and graphs. To
refresh the page manually, click the refresh icon on the client details page.

The following table describes the information displayed in each section:

Section Description

Data Path Displays the data path of the client in the network. Click the AP icon to view the AP details page.
The data path can be one of the following:

n Client > SSID > AP
n Client > SSID > AP > Switch
n Client > SSID > AP > Switch > Gateway
n Client > SSID > AP > Gateway

Client Displays the following information:
n Username—User name of the client.
n Hostname—Hostname of the client.
n Client Type—Type of the client, wireless or wired.
n IP Address—IP address of the client.
n MAC Address—MAC address of the client.
n Client Category—Category of the profiled device. For example, Access Points, Computer,
Smart Device, VoIP phone, and so on. For details, see Classifying Clients.
n Client Family—Displays the type of operating system or vendor. For example, if the client
category is Computer, the client family can be Windows, Linux, or Apple Mac. For details, see
Classifying Clients.
n Client OS—Displays the operating system that the device runs on. For example, if the
client category is Computer and the client family is Windows, the client OS can be Windows or
Windows 8/10. For details, see Classifying Clients.
n Connected Since—Date and time since when the client is connected.
n Manufacturer—Manufacturer of the client device.
n Encryption—Type of client encryption.
n AI Insights—The total number of AI insights seen on the client device.

Network Displays the following information:
n VLAN—Displays the VLAN ID on which the client is connected to the AP.
n VLAN Derivation—Displays the VLAN derivation method used for assigning an IP address
to the client. Aruba devices can assign a static or dynamically derived IP address from a
DHCP pool to the clients.
n AP Role—Displays the role assigned to the client by the AP.
n AP Derivation—Displays the role derivation method used for assigning a role to a client.
For example, clients that authenticate successfully can be assigned a default role as per the
AAA profile.
n Gateway Role—Displays the role assigned to the client by the Gateway.
n Switch Role—Displays the role assigned to the client by the Switch.
n Segmentation—Displays the type of dynamic segmentation configured for the client.
Supported values are UBT, PBT, Underlay, or Overlay.
n Auth Server—Server that last authenticated the client device. The field displays the IP
address of the server that performed either 802.1X or MAC authentication for the client
device. If the client connects to the network through 802.1X and MAC authentication, Aruba
Central displays only the IP address of the server that performed 802.1X authentication.
n DHCP Server—DHCP server that last assigned IP address to the client.
n Tunneled—Displays whether the client is tunneled or not.
n Tunnel ID—Displays the tunnel ID the client is connected to.

Table 173: Wireless Client Details
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Section Description

Connection Displays the following information:
n Channel—Radio channel assigned to the client.
n Band—Radio band on which the client is connected.
n Client Capabilities—Capabilities of the client device.
n Client Max Speed—Wireless link data transfer speed.

Throughput Displays the incoming and outgoing throughput traffic for the client during a specific time range.
By default, the graph on the Throughput pane is plotted for a time range of 3 hours. To view the
graph for a different time range, click the Time Range Filter link. You can choose to view the
graph for a time period of 3 hours, 1 day, 1 week, 1 month, or 3 months.

Health Displays the health score and status of a wireless client. By default, the graph on the Health
pane is plotted for a time range of 3 hours. To view the graph for a different time range, click the
Time Range Filter link. You can choose to view the graph for a time period of 3 hours, 1 day, 1
week, 1 month, or 3 months. The graph is plotted against the client health and client score, where
the client health is measured as Poor, Fair, or Good and the health score ranges between 0 to
100.

Signal
Quality

Displays the signal quality and the SNR for the wireless client as measured by the AP. The SNR
value is displayed in decibels:

n 0-20—Poor
n 21-35—Fair
n >35—Good

Retry
Frames

Displays the percentage of Tx and Rx retries by a wireless client.

Tx/Rx Rate Displays the data transmission and reception rate for the wireless client .

Roaming
Experience

Displays the details of a roaming event and the latency of the client. When a wireless client
roams between two APs, the destination AP creates an event. By default, the Roaming Events &
Latency table displays data for the last 3 hours. To view the table for a different time range, click
the Time Range Filter link. You can choose to view the data for a time period of 3 hours, 1 day, 1
week, 1 month, or 3 months. The Roaming Events & Latency displays two views, grid view and
trend view. The grid view displays the following information:

n Date/Time—Displays the time of occurrence of the client roaming/ association events.
n SSID—The SSID to which the client is connected.
n Latency(ms)—Roaming Latency in milliseconds between source and destination AP.
n To BSSID—The BSSID of the destination AP.
n Source AP—AP to which the client was connected.
n Destination AP—AP to which the client is connected.
n Roaming Type—The type of roam.
n Band—Radio band on which the client is connected.
n RSSI(dBm)—Received Signal Strength Indicator (RSSI) on the client, estimated measure of
power level that the client is receiving from the AP.

The trend view displays a chart that shows the percentage of high latency roaming events, total
roaming events, and the number of high latency roaming events at a particular instance based
on the value selected in the Time Range Filter. Clicking the chart icon brings you back to the
grid view.

Table 173: Wireless Client Details

AI Insights
TheAI Insight tab displays information about client performance and connectivity issues such as, excessive
2.4 GHz dwell and low SNR links. AI Insights are displayed for a selected time period based on the time
selected in Time Range Filter. The user can select 3 hours, 1 week, 1 day, or 1 month to view the insight
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data. AI Insights are categorized in high, medium, and low priorities depending on the number of
occurrences.

n Red—High priority
n Orange—Medium priority
n Yellow—Low priority

Each insight report provides specific details on the occurrences of these events for ease in debugging. For
more information, see The AI Insights Dashboard.

The clientsAI Insights page displays the following insights:

n Clients roamed excessively
n Clients experienced high latency while roaming
n Clients had a significant number of Low SNR uplink minutes
n Dual-band (2.4/5 GHz) capable clients primarily used 2.4 GHz
n Clients had DHCP server connection problems
n DNS request/responses were significantly delayed
n DNS server(s) rejected a high number of queries
n Clients had an unusual number of MAC authentication failures
n Clients had excessive Wi-Fi security key-exchange failures
n Clients had excessive 802.1x authentication failures

Location
The Location tab displays the current physical location of the client device on the floor map.

Sessions
The client sessions page consists of the firewall session details for the client connected to an AP or a Branch
Gateway. The Sessions page displays information filtered by the IP address of the client. The Sessions
Summary pane displays the device the client is connected to, total number of sessions, and the time stamp
of when the page was last refreshed.

The Sessions table lists the details of each session. By default, the table displays the following columns:
Application, Source IP,Destination IP, Source Port,Destination Port,Action, Flags, Packets, and
State. Click the ellipsis icon to perform additional operations:

n Autofit columns—Adjusts the column width of the table to fit the page evenly.
n Reset to default—Resets the table view to the default columns.

If a filter icon appears next to the column header, click it and enter the filter criteria or select a filter criteria.
The following table describes the information displayed in each session:

Section Description

Application Displays the list of applications.

Source IP Displays the source IP address.

Table 174: Sessions Tab
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Section Description

Destination IP Displays the destination IP address.

Protocol Displays the communication protocol used.

Source Port Displays the source port number.

Dest Port Displays the destination port number.

Action Displays the application specific action.

Flags Displays the active flags

Packets Displays the number of packets.

State Displays the connection state of the application. The state can either be Denied, Active, or
Inactive.

Start Time Displays the start time.

Receive Time Displays the receive time.

WebCC Category Displays the WebCC category.

WebCC
Reputation

Displays the WebCC reputation.

WebCC Score Displays the WebCC score.

Application
Category

Displays the application category.

Table 174: Sessions Tab

Client Sessions is supported only if the Instant AP is running ArubaInstant 8.6.0.0 firmware version or later
versions.

For details on the AP client sessions refer, Access Point > Clients > Clients. For details on the Branch Gateway
client sessions refer, Gateway > Overview > Sessions.

Applications
TheApplications page provides you the client details for passive motoring of the client connected to a
wireless network. TheApplication page consists of theVisibility tab and theUCC tab.

Visibility
TheVisibility dashboard provides a summary of client traffic and their data usage to and from applications,
and websites. You can also analyze the client traffic flow using the graphs displayed in theVisibility
dashboard. The tab consists of a list view and a graph view. TheVisibility dashboard displays metrics and
graphs related to client traffic flow in the following sections:
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n Applications
n Websites

For more information about enablingApplication Visibility, list of supported Instant APs, and the data
displayed on theApplications and Websites sections, see Application Visibility.

UCC
TheUCC tab displays the detailed call records for the client if any. To view this data, ensure that the Unified
Communication application service is enabled on the APs. The following table describes the information
displayed in each session:

Section Description

Calls Displays the total number of calls. The call quality is displayed as:
n Good
n Fair
n Poor
n Unknown

Client Health Displays the health of the client.

Session Type Displays the type of the call or session. For example, audio, or video, or desktop sharing.

Quality Displays the quality of the call.

Table 175: UCC Tab

For more information on the UCC services and enabling the application, see Unified Communications.

Live Events
Aruba Central allows you to troubleshoot issues related to a client or a site in real time for detailed analysis.
You can live troubleshoot clients connected to a wireless network. For more information on live
troubleshooting a client, see Client Live Troubleshooting.

Events
The Events page displays the details of events generated by the AP and client association. By default, the
table displays the following columns: Occurred On, Event Type, and Description. Click the ellipsis icon to
perform additional operations:

n Autofit columns—Adjusts the column width of the table to fit the page evenly.
n Reset to default—Resets the table view to the default columns.

If a filter icon appears next to the column header, click it and enter the filter criteria or select a filter criteria.
The following table describes the information displayed in each event:
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Section Description

Occurred On Displays the time at which the event occurred.

Event Type Displays the type of the event.

Description Displays the detailed description of the event.

Device MAC Displays the MAC address of the device.

BSSID Displays the BSSID.

Table 176: Events Tab

To download events into a CSV format, click the download button. Aruba Central generates the CSV report
of all the events for the selected client.

You can also filter the events based on the type of events, click theClick here for Advance Filtering.
Select the type of events from the list and click Filter. The events under the selected categories get listed in
the Events table. For more information on Events, see Alerts & Events

Tools
The Tools page is automatically filtered based on the client you select. This enables network administrators
to perform checks on the client and debug client connectivity issues. For more information on Tools, see
Using Troubleshooting Tools.

Client Live Monitoring
Click Go Live to start live monitoring of the client. Live monitoring is supported only if the Instant AP is
running 8.4.0.0 firmware version. Live monitoring stops after 15 minutes. At any point, you can click Stop
Live to go back to the historical view.

Five seconds after you start live monitoring, the following data starts getting populated:

n Usage graph—The Instant AP sends bandwidth usage data every five seconds and the usage graph is live
for 15 minutes.

n For the following fields, data is refreshed every five seconds and the average for the last 60 seconds is
displayed:

n Device Health
n SNR
n TX Rate
n RX Rate

For a visual representation of the procedure, click here.

Disconnecting a Wireless Client from an AP
To disconnect a wireless client from an online AP:

http://help.central.arubanetworks.com/2.4.8/documentation/online_help/content/resources/images/gifs/live-monitoring.gif
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1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to GlobalThe dashboard context for the selected filter is displayed.

2. UnderManage, click Clients. The clients overview page is displayed in List view.
3. By default, theClients table displays a unified list of clients.
4. Click the name of the wireless client to open the corresponding Client Details page. If there are

many clients connected to the network, click Wireless to filter the clients connected to the wireless
network, enter the client name in theClient Name column, and click the client name.

5. From theActions drop-down list, click Disconnect from AP. The clients gets disconnected from the
AP.

The Actions drop-down is disabled if the AP is offline.

Blocking a Wireless Client
Blocking a client automatically denies association for wireless clients that breach a rule or policy. Client
blocking excludes a client from an AP in the network. Excluding a client from the network can be performed
for various reasons, few of them being security and intrusion detection.

Client blocking can be performed when the client is in either Connected, Failed, orOffline state. Wireless
clients can be excluded from the network only when the client blocking option is enabled for the SSID under
the AP configuration. Client blocking can be performed manually or dynamically. Manual blocking adds the
MAC address of a client to the blocked list. These clients are added into a permanent blocked list. The clients
can be blocked dynamically when they exceed the authentication failure threshold or when a blocking rule is
triggered as part of the authentication process. For details, see Blacklisting Instant AP Clients.

To block a wireless client, ensure that the Instant AP is running one of the following firmware versions:

n Aruba Instant 8.5.0.7 firmware version or later versions
n Aruba Instant 8.6.0.3 firmware version or later versions

To block a wireless client, perform the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. The dashboard context for the selected filter is
displayed.

2. UnderManage, click Clients. The clients overview page is displayed in List view.
3. By default, theClients table displays a unified list of clients.
4. Click the name of the wireless client to open the corresponding Client Details page. If there are

many clients connected to the network, click Wireless to filter the clients connected to the wireless
network, enter the client name in theClient Name column, and click the client name.

5. From theActions drop-down list, click Block Client. The clients gets blocked from the network.

Unblocking a Wireless Client
1. To unblock a wireless client, perform the following steps:
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2. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. The dashboard context for the selected filter is
displayed.

3. UnderManage, click Clients. The clients overview page is displayed in List view. By default, the
Clients table displays a unified list of clients.

4. To filter the Blocked clients, click Blocked in theAll Clients page. The list of blocked clients is
displayed.

5. Click the name of the wireless client to open the corresponding Client Details page. Enter the client
name in theClient Name column, and click the client name.

6. From theActions drop-down list, click Remove Block. The clients is unblocked from the network.

Client Live Troubleshooting
Aruba Central allows you to troubleshoot issues related to a wireless client connected to an access point or a
wired client connected to a switch.

To troubleshoot a wired client connected to a switch, the switch firmware version must be 16.09.0001 or a
later version and the model should be one of the following:

n Aruba 2930F Switch Series
n Aruba 2930M Switch Series
n Aruba 3810 Switch Series
n Aruba 5400R Switch Series (V3 mode)

You can troubleshoot a wired client connected to both a standalone switch or stack.

Live troubleshooting is supported only if the wireless client is connected to the access point running Aruba
Instant 8.4.0.0 or a later version. You can also enable targeted packet capture during live troubleshooting
and download the PCAP file if the access point is running Aruba Instant 8.6.0.5 or a later version.

Live troubleshooting can be performed on a wired client only when the access point is running Aruba
Instant 8.5.0.0 or a later version.

Troubleshooting a Client
Aruba Central allows you to troubleshoot issues related to a client or a site in real time for detailed analysis.

To troubleshoot a client at a site level, perform the following steps:

1. In theNetwork Operations app, set the filter to a Site that contains at least one device. The
dashboard context for the selected site is displayed.

2. UnderAnalyze, click Live Events.The Live Events page is displayed.
3. Enter the MAC address of the client and click Start Troubleshooting.

To troubleshoot a wireless or wired client, perform the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. The dashboard context for the selected filter is
displayed.

2. UnderManage, click Clients. The clients overview page is displayed in List view.
3. By default, theClients table displays a unified list of clients.
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4. Click the name of the wireless or wired client to open the corresponding Client Details page. If there
are many clients connected to the network, click Wireless orWired to filter the clients connected to
the wireless or wired client respectively.

5. Enter the client name in theClient Name column, and click the client name.
6. UnderAnalyze, click Live Events. The Live Events page is displayed.

The client live troubleshooting starts automatically for the selected client.

The status of the troubleshooting is displayed every minute. The troubleshooting session runs for a
duration of 15 minutes. You can stop live troubleshooting at any point by clicking Stop Troubleshooting
to go back to the historical view.

After the live troubleshooting session ends, the details of the events are displayed in the live events table.

Live Events Details
The following details are captured and displayed in the Live Events table:

n Occurred On—Displays the timestamp of the event. Use the filter option to filter the events by date
and time.

n Device Name—Displays the name of the device the client is connected to. Set the filter to select a
specific device under Site.

n Device Type—Displays the type of device the client is connected to.
n Category—Displays the category of the event. Use the filter option to filter the events by category.
n Description—Displays a description of the event. Use the filter option to filter the events based on

description.

Packet Capture
Aruba Central allows you to interact and launch a targeted packet capture on a client connected to a specific
access point or a switch. After you start packet capture from the UI, Aruba Central notifies the access point
and the switch. The default packet capture duration is 15 minutes. After you start packet capture, use the
toggle button to stop packet capture, or go back to theClient Overview page.

For packet capture, for a wired client connected to an Aruba 5400R Switch Series (V3 mode), ensure that “no-
allow v2 modules” is set for the switch.
Packet capture for stack switches works only if the client is connected to the commander of the stack.

Starting Packet Capture
You can start packet capture from the wireless or wired clients page. Packet capture can be done at a site
level (wireless client only) or for a selected client.

To start packet capture at a site level, perform the following steps:

1. In theNetwork Operations app, set the filter to a Site that contains at least one device. The
dashboard context for the selected site is displayed.

2. UnderAnalyze, click Live Events.The Live Events page is displayed.
3. Enter the MAC address of the client.

At a site level, Aruba Central does not support packet capture for a wired client connected to a switch.
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4. Enable the Packet Capture toggle button to start live packet capture for the selected client.
5. Click Start Troubleshooting.

To start packet capture for a wireless or wired client, perform the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage, click Clients. The clients overview page is displayed in List view.
3. By default, theClients table displays a unified list of clients.
4. Click the name of the wireless or wired client to open the corresponding Client Details page. If there

are many clients connected to the network, click Wireless orWired to filter the clients connected to
the wireless or wired client respectively.

5. Enter the client name in theClient Name column, and click the client name.
6. UnderAnalyze, click Live Events. The Live Events page is displayed. The client live

troubleshooting starts automatically for the selected client.
7. Click Stop Troubleshooting to stop live troubleshooting.
8. Enable the Packet Capture toggle button to start live packet capture for the selected client.
9. Click Start Troubleshooting to live troubleshoot the selected client. Live packet capture starts for

the selected client.

The live troubleshooting session runs for a duration of 15 minutes. After the live troubleshooting
session ends, aDownload PCAP text appears above the live events table. Click Download PCAP to
download the generated pcap file on your local system.

Clients > Wired Client > Overview
The overview page displays the client summary details and client sessions details for the selected wired
client. The section includes the following topics:

n Viewing Clients Connected to Wired Networks
n Overview
n Applications
n Live Events
n Events
n Tools

Viewing Clients Connected to Wired Networks
To view the details of a client connected to the wired network:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global. The dashboard context for the selected filter is
displayed.

2. UnderManage, click Clients. TheAll Clients page is displayed.
3. By default, theClients table displays a unified list of clients for the selected group, label, site or

device.
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4. Click the name of the wired client to open the corresponding Client Details page. If there are many
clients connected to the network, click Wired to filter the clients connected to the wired network.

5. Enter the client name in theClient Name column, and click the client name. The client Summary
page is displayed.

6. Additionally, click Sessions page to view client sessions details.

For a visual representation of the procedure, click here.

Overview
The wired client overview page displays the client summary bar and the wired client details.

Wired Client Health Bar
The wired client health bar displays the connection status, the connected port, and the name of the gateway
the client is connected to. For more information, see The Health Bar.

TheHealth bar displays the following information:

Field Description

Connection
status

Connection status of the client. Connection status is updated immediately on state change.

Connected
Port

Name of the port through which the is connected.

Connected
To

Name of the Gateway to which the client is connected. Click the name of the Gateway to view
the device details page.

Table 177: Wired Client Health Bar

Summary
The wired Client Details page displays the information about the type of data path that the client uses, the
network details, and basic client details such as IP address of the client, type of encryption etc. The client
details page refreshes automatically to display real time data and graphs. To refresh the page manually, click
the refresh icon on the client details page.

The following table describes the information displayed in each section:

Section Description

Data Path Displays the data path of the client in the network. Click the device icon to view the corresponding
device details page. The data path can be one of the following:

n Client > Wired Profile > AP
n Client > Wired Profile > AP > Switch
n Client > Wired Profile > AP > Switch > Gateway
n Client > Wired Profile > AP > Gateway
n Client > Switch
n Client > Switch > Gateway

Table 178: Wired Client Details

http://help.central.arubanetworks.com/2.4.8/documentation/online_help/content/resources/images/gifs/wired-client.gif
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Section Description

n Client > Gateway

Client Info Displays the following information:
n Username—User name of the client.
n Hostname—Hostname of the client.
n Client Type—Type of the client device.
n IP Address—IP address of the client.
n MAC Address—MAC address of the client.
n Client Category—Category of the profiled device. For example, Access Points, Computer,
Smart Device, VoIP phone, and so on. For details, see Classifying Clients.
n Client Family—Displays the type of operating system or vendor. For example, if the client
category is Computer, the client family can be Windows, Linux, or Apple Mac. For details, see
Classifying Clients.
n Client OS—Displays the operating system that the device runs on. For example, if the
client category is Computer and the client family is Windows, the client OS can be Windows or
Windows 8/10. For details, see Classifying Clients.
n Connected Since—Date and time since when the client was last connected.
n Manufacturer—Manufacturer of the client device.
n Encryption—Type of client encryption.

Network
Info

Displays the following information:
n VLAN—Displays the VLAN ID on which the client is connected to the AP.
n VLAN Derivation—Displays the VLAN derivation method used for assigning an IP address
to the client. Aruba devices can assign a static or dynamically derived IP address from a
DHCP pool to the clients.
n AP Role—Displays the role assigned to the client by the AP.
n AP Derivation—Displays the role derivation method used for assigning a role to a client.
For example, clients that authenticate successfully can be assigned a default role as per the
AAA profile.
n Gateway Role—Displays the role assigned to the client by the Gateway.
n Switch Role—Displays the role assigned to the client by the Switch.
n Segmentation—Displays the type of dynamic segmentation configured for the client.
Supported values are UBT, PBT, Underlay, or Overlay.

NOTE: To view the details about dynamic segmentation, a gateway must be licensed in Aruba
Central and connected to the switch.

n Auth Server—Server that last authenticated the client device. The field displays the IP
address of the server that performed either 802.1X or MAC authentication for the client
device. If the client connects to the network through 802.1X and MAC authentication, Aruba
Central displays only the IP address of the server that performed 802.1X authentication.
n DHCP Server—DHCP server that last assigned IP address to the client.
n Tunneled—Displays whether the client is tunneled or not.
n Tunnel ID—Displays the tunnel ID the client is connected to.
n Port—Displays the port type used by the client.

Throughput Displays the incoming and outgoing throughput traffic for the client during a specific time range.
By default, the graph on the Throughput pane is plotted for a time range of 3 hours. To view the
graph for a different time range, click the Time Range Filter link. You can choose to view the
graph for a time period of 3 hours, 1 day, 1 week, 1 month, or 3 months.

Table 178: Wired Client Details

AI Insights
TheAI Insight tab displays information about client performance and connectivity issues such as, excessive
2.4 GHz dwell and low SNR links. AI Insights are displayed for a selected time period based on the time
selected in Time Range Filter. The user can select 3 hours, 1 week, 1 day, or 1 month to view the insight
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data. Each AI Insight type displays the AI Insight label, AI Insight graph, and AI Insight chart. Further, the
Insights include categories of information present in form of tabs like, reason, band, channel, SNR and so
on. These tabs are clickable and display the detailed information found in that section of the Insight. For
more information on AI Insights, see The AI Insights Dashboard.

Sessions
The client sessions page consists of the firewall session details for the client connected to a Branch Gateway.
The Sessions page displays information filtered by the IP address of the client. The Sessions Summary
pane displays the device the client is connected to, total number of sessions, and the time stamp of when
the page was last refreshed. The sessions details page refreshes automatically, to refresh the page manually,
click the refresh icon after the timestamp.

The Sessions table lists the details of each session. By default, the table displays the following columns:
Application, Source IP,Destination IP, Source Port,Destination Port,Action, Flags, Packets, and
State. Click the ellipsis icon to perform additional operations:

n Autofit columns—Adjusts the column width of the table to fit the page evenly.
n Reset to default—Resets the table view to the default columns.

If a filter icon appears next to the column header, click it and enter the filter criteria or select a filter criteria.
The following table describes the information displayed in each session:

Section Description

Application Displays the list of applications.

Source IP Displays the source IP address.

Destination IP Displays the destination IP address.

Protocol Displays the communication protocol used.

Source Port Displays the source port number.

Dest Port Displays the destination port number.

Action Displays the application specific action.

Flags Displays the active flags

Packets Displays the number of packets.

State Displays the connection state of the application. The state can either be Denied, Active, or
Inactive.

Start Time Displays the start time.

Receive Time Displays the receive time.

WebCC Category Displays the WebCC category.

WebCC
Reputation

Displays the WebCC reputation.

Table 179: Sessions Tab
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Section Description

WebCC Score Displays the WebCC score.

Application
Category

Displays the application category.

Table 179: Sessions Tab

Client Sessions is supported only if the Instant AP is running Aruba Instant 8.6.0.0 firmware version or later
versions.

For details on the Branch Gateway client sessions refer, Gateway > Overview > Sessions.

Applications
TheApplications page provides you the client details for passive motoring of the client connected to a
wired network. TheVisibility dashboard provides a summary of client traffic and their data usage to and
from applications, and websites. You can also analyze the client traffic flow using the graphs displayed in the
Visibility dashboard. The tab consists of a list view and a graph view. TheVisibility dashboard displays
metrics and graphs related to client traffic flow in the following sections:

n Applications
n Websites

For more information about enablingApplication Visibility, list of supported Instant APs, and the data
displayed on theApplications and Websites sections, see Application Visibility on page 684.

Live Events
Aruba Central allows you to troubleshoot issues related to a client or a site in real time for detailed analysis.
You can live troubleshoot clients connected to a wired network. For more information on live
troubleshooting a client, see Client Live Troubleshooting.

Events
The Events page displays the details of events generated by the AP and client association. By default, the
table displays the following columns: Occurred On, Event Type, and Description. Click the ellipsis icon to
perform additional operations:

n Autofit columns—Adjusts the column width of the table to fit the page evenly.
n Reset to default—Resets the table view to the default columns.

If a filter icon appears next to the column header, click it and enter the filter criteria or select a filter criteria.
The following table describes the information displayed in each event:
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Section Description

Occurred On Displays the time at which the event occurred.

Event Type Displays the type of the event.

Description Displays the detailed description of the event.

Device MAC Displays the MAC address of the device.

BSSID Displays the BSSID.

Table 180: Events Tab

To download events into a CSV format, click the download button. Aruba Central generates the CSV report
of all the events for the selected client.

You can also filter the events based on the type of events, click theClick here for Advance Filtering.
Select the type of events from the list and click Filter. The events under the selected categories get listed in
the Events table. For more information on Events, see Alerts & Events

Tools
The Tools page is automatically filtered based on the client you select. This enables network administrators
to perform checks on the client and debug client connectivity issues. For more information on Tools, see
Using Troubleshooting Tools.

Classifying Clients
If the Aruba Central account is registered in the US-2 or EU-1 regional cluster, Aruba Central classifies the
client connected to an AP. This section includes the following topics:

n Clients Page
n Insights

Clients Page
TheClients page provides a list view of all the clients connected to the network. The page displays key client
details and also allows you to view a specific client detail page. For more information about clients, see All
Clients.

The following details are displayed in theClients > List view and theClient Details page:

n Client Category—Displays the category of the profiled client. For example, Computer, Smart Device,
VoIP phone, and so on.

n Client Family—Displays the type of operating system or vendor. For example, if the client category is
Computer, the client family can be Windows, Linux, or Apple Mac.

n Client OS—Displays the operating system that the client runs on. For example, if the client category is
Computer and the client family isWindows, the client OS can be Windows or Windows 8/10.

The following figure shows theClient section in theClient Details page:
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Insights
TheClient card in insights display the number of clients impacted. From theClient card, you can drill-down
to the Top 50 Clients Impacted table. In this table, theOS column displays the client family and the
operating system of the client. If Aruba Central is unable to classify the client,Unclassified is displayed.

The access point must be running Instant AP 6.4.4.8 or a later version.

The following connectivity and roaming insights display the client family and client OS:

n Clients had an unusual number of MAC authentication failures
n Clients had excessive Wi-Fi security key-exchange failures
n Clients had excessive 802.1x authentication failures
n Clients had DHCP server connection problems
n Clients had a significant number of Low SNR uplink minutes
n Dual-band (2.4/5 GHz) capable clients primarily used 2.4 GHz

The following figure shows the Top 50 Clients Impacted table for theHigh DHCP Failures insight:
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Related Topics:

n Clients > Wireless Client > Overview
n Clients > Wired Client > Overview
n The AI Insights Dashboard

Application Visibility
TheManage > Applications tab provides detailed information on data usage by the clients connected to
APs and Branch Gateways in the network. TheVisibility dashboard provides a summary of client traffic and
their data usage to and from applications and websites. Click the List and the Summary icons on the
Application and Websites sections to toggle between the dashboard views.

Application Visibility is supported on Instant APs running software versions 6.4.3.1-4.2.0.0 or later.
Aruba Central supports Application visibility monitoring, DPI configuration, and web filtering for IAP-103, RAP-
108/109, IAP-114/115, RAP-155, IAP-224/225, IAP-274/275, IAP-228, IAP-277, IAP-205, IAP-214, IAP-324/325, and
IAP-304/305, IAP-207, IAP-334,IAP-314/315, IAP-344/345, IAP-504/505, IAP-514/515, IAP-535/534 and IAP-555.
Instant AP-104/105, Instant AP-134/135, RAP3WNP, and Instant AP-175 devices only support web policy
enforcement.

Viewing Visibility Dashboard
To view theVisibility dashboard, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups or Sites. For all
devices, set the filter to Global. The dashboard context for the selected filter is displayed.

2. UnderManage, click Applications. The visibility dashboard is displayed.

TheVisibility dashboard displays metrics and graphs related to client traffic flow in the following sections:

n Applications
n Websites
n Blocked Traffic

The following image displays theVisibility dashboard at the global level:
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To view client traffic details, ensure that the DPI access rules are enabled on the Instant AP device.
The Blocked Traffic tab is only displayed in Global level in the Network Operations > Manage >
Applications page.

Applications
TheApplications tab includes a table view and a graph view related to the client traffic flow to and from
various applications. These graphs are displayed for a specific time frame (3 Hours, 1 Day, 1 Week, 1 Month,
3 Months). By default, the graphs display real-time client traffic data or usage trend in last three hours.

Table View in Application Section
Click the List icon in theApplications tab to display a table with the following columns:

n Application—Name of the application.
n Category—The category to which the application belongs. The application can belong to any of the

categories, such asUnclassified, Standard, Social Networking, Streaming,Web, Cloud File
Storage, Instant Messaging Network Service and so on.

n Usage—Data consumed by an application.
n Sent—The size of data sent from the application.
n Received—The size of data received by the application.

Graph View in Applications Section
Click the Summary icon in the Applications tab to display bar graphs indicating the traffic flow in the
following tabs:
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n Applications—The stacked bar graph in this tab displays details of the client traffic flowing to or from
the top five classified applications listed in theApplications table. The legend beside the bar graphs
displays the list of applications to which the traffic flow is detected. By hovering the mouse on the bar
graph, you can view the size of data flowing to and from the application same as displayed in legend.

n Categories—The stacked bar graph in this tab displays details of the client traffic flowing to or from the
top five classified application categories listed in the Applications table. By hovering the mouse on the
bar graph, you can view the size of data flowing to and from the application categories same as displayed
in legend.

Supported Applications
The following applications are supported:

1. AppleTalk
2. BitTorrent
3. Connection Oriented Transfer Protocol
4. dailymotion.com
5. eBay
6. FTP
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7. FTP Data
8. Google Mail
9. Google Search

10. google.com
11. Google Earth
12. Google Groups
13. Google Maps
14. HTTP
15. HTTPS
16. ICMP
17. ICMP for IP6
18. Identification Protocol
19. Internet Protocol
20. IPV6
21. IPsec Encapsulating Security Payload
22. IPv6 Control Protocol
23. ISAKMP
24. XMPP Protocol (Jabber)
25. Kazaa (FastTrack protocol)
26. LDAP Secure
27. Mobile IPv6
28. Microsoft Multimedia Streaming
29. MSN Messenger
30. MSN Video
31. myspace.com
32. NBMA Address Resolution Protocol
33. Netbios Name Service
34. Network File System
35. Post Office Protocol
36. Point-to-Point Tunneling Protocol
37. QQ
38. Real Time Protocol
39. SAP
40. Session Initiation Protocol
41. Skype
42. Server Message Block
43. SMTP
44. SMTPS
45. SOAP
46. Secure Shell
47. SSL
48. TCP
49. telnet
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50. Telnet VIP
51. UDP
52. VMWare
53. wikipedia.com
54. YouTube
55. Facebook
56. Google Ads
57. MPEG Stream
58. Jabber File Transfer
59. Microsoft Office Groove
60. Gmail Basic
61. 4shared.com
62. Ares
63. Google Chat
64. Gmail Mobile
65. Ask.com
66. mapquest.com
67. Expedia.com
68. southwest.com
69. Yahoo Maps
70. travelocity.com
71. Realtor.com
72. wordpress.com
73. flickr.com
74. linkedin.com
75. apple.com
76. rapidshare.com
77. Megaupload
78. Rambler.ru
79. Mail.ru Webmail
80. Windows Live Groups
81. Steampowered.com
82. Badoo.com
83. Books iRead
84. DeviantArt.com
85. Foursquare.com
86. Goodreads.com
87. goibibo.com
88. LiveJournal.com
89. Meetup.com
90. MyAnimeList.net
91. ResearchGATE.net
92. Taringa.net
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93. Tumblr
94. Twitter
95. Vkontakte
96. yammer.com
97. yelp.com
98. Yandex.ru
99. facebook mail

100. iTunes
101. Spotify
102. TeamViewer
103. Bing.com
104. baidu.com
105. Adobe Update Manager
106. Adobe Flash Plugin Update
107. YouTube HD
108. Archive.org
109. Nintendo Wi-Fi Connection
110. Symantec AntiVirus Updates
111. Viber
112. Playstation Network
113. ARIS
114. Transport Layer Security
115. VISA
116. netflix.com
117. Silverlight (Microsoft Smooth Streaming)
118. Google Analytics
119. Google GStatic
120. Ytimg.com
121. HTTP Tunnel
122. FTP Secure
123. Microsoft SharePoint
124. Microsoft SharePoint Administration Application
125. Adobe Meeting Remote Control
126. Box
127. Concur
128. Dropbox
129. Google Cache
130. Google Translate
131. Libero.it
132. MediaFire.com
133. Pandora
134. pandora.tv
135. Salesforce
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136. YouKu
137. Microsoft Office Live Meeting
138. GoToMeeting Online Meeting
139. WebEx
140. Slingbox
141. Bloomberg.com
142. Microsoft Office Communicator
143. Gmail drive
144. Microsoft SharePoint Blog Management
145. Microsoft SharePoint Calendar Management
146. Microsoft SharePoint Document Management
147. Adobe Connect
148. Echo
149. Google Generic
150. accuweather.com
151. Adobe Acrobat DC (Document Cloud)
152. Alexa.com
153. AlloCine.fr
154. Amazon Generic Services
155. AmericanExpress.com
156. att.com (AT&T)
157. Blogger.com
158. Blogspot.com
159. businessweek.com
160. Cam4.com
161. CapitalOne.com
162. cartoonnetwork.com
163. Cdiscount.com
164. cnet.com
165. CNN
166. comcast.com
167. DailyMail.co.uk
168. Daum.net
169. DirecTv
170. FoxNews.com
171. Groupon
172. HowStuffWorks.com
173. IKEA.com
174. Intuit.com
175. Intuit.com
176. LeBonCoin.fr
177. LeTV.com
178. Livedoor.com
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179. match.com
180. Monster.com
181. Mozilla
182. NationalGeographic.com
183. naver.com
184. NBA.com
185. NFL.com
186. Nike.com
187. nytimes.com
188. PlayStation.com
189. Redtube.com
190. reuters.com
191. Reverso.net
192. Ryanair.com
193. SlideShare
194. Spiegel.de
195. SurveyMonkey.com
196. Tube8.com
197. USAToday.com
198. vimeo.com
199. WahingtonPost.com
200. Weather.com
201. Xbox.com
202. XNXX.com
203. Xvideos.com
204. Youdao.com
205. Youm7.com
206. youporn.com
207. Sina.com.cn
208. WhatsApp Messenger
209. Sina Weibo
210. Taobao
211. Google App Engine
212. Google Toolbar
213. Apple App Store
214. Internet Relay Chat
215. GMX webmail
216. Apple FaceTime
217. Apple Push Notification(APNs)
218. iOS over-the-air update
219. Google Play Store
220. Line
221. Google Plus
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222. iCloud (Apple)
223. Kaskus.co.id
224. Detik.com
225. Kompass.com
226. KapanLagi.com
227. Okezone.com
228. Tribunnews.com
229. Scribd.com
230. Google Sky
231. HBO GO
232. Hulu
233. Instagram
234. SoundCloud
235. Vevo.com
236. Amazon Web Services/Cloudfront CDN
237. Windows Live File Storage
238. 11st.co.kr
239. Gmarket.co.kr
240. Tistory.com
241. Auction.co.kr
242. Nexon.com
243. Amazon Prime Video
244. QQ.com
245. 163.com
246. Sohu.com
247. Soso.com
248. Ifeng.com
249. Tmall.com
250. Hao123
251. Chinaz.com
252. alipay.com
253. Sogou.com
254. Douban.com
255. Tianya.cn
256. cnzz.com
257. 360.cn
258. 58.com
259. alibaba.com
260. iQiyi.com
261. Zol.com.cn
262. Xinhuanet.com
263. Chinese Software Developer Network
264. People.com.cn
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265. 4399.com
266. Facebook Apps
267. Akamai Technologies CDN
268. zynga.com
269. Level 3 Communications CDN
270. Microsoft Azure
271. 802.11
272. Mobile IP
273. yahoo.com
274. WeChat
275. MEGA
276. FC2.com
277. Rakuten.co.jp
278. Goo.ne.jp
279. Kakaku.com
280. Ameba.jp
281. Hatena.ne.jp
282. Dmm.co.jp
283. Pixiv.net
284. Tabelog.com
285. AppleDaily.com.tw
286. Baike.com
287. chinatimes.com
288. CK101.com
289. Ctrip.com
290. Ettoday.net
291. Eyny.com
292. Mobile01.com
293. Momoshop.com.tw
294. NOWnews.com
295. PChome.com.tw
296. Pixnet.net
297. Ruten.com.tw
298. Udn.com
299. Wall Street Journal
300. Xiami.com
301. pornhub.com
302. Google Talk (incl. Hangouts and Allo and Duo)
303. Microsoft Office 365
304. Zoho Corporation
305. Microsoft SharePoint Online (Office 365)
306. Microsoft Skype for Business
307. iperf
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308. Speedtest
309. ESPN
310. Pinterest
311. Webex WebOffice
312. Citrix Online
313. BuzzFeed
314. Microsoft Outlook (Office 365)
315. reddit.com
316. Internet Movie Database
317. Apple SIRI
318. Wikia.com
319. Imgur.com
320. ThePirateBay.se
321. xHamster.com
322. Google Documents
323. Evernote.com
324. JingDong
325. Apple Maps
326. WebSocket
327. Baidu Games
328. Bet365.com
329. DCinside.com
330. Microsoft Skype for Business
331. Apple AirPlay
332. Apple AirPrint
333. 1337x.org
334. paypal.com
335. Rutracker Bittorrent tracker
336. Orange.com
337. BBC.co.uk
338. AVG.com
339. Softonic.com
340. Y8.com
341. ElPais.com
342. Marca.com
343. NeoBux.com
344. Kooora.com
345. MercadoLibre.com
346. Olx.com
347. espncricinfo.com
348. Goal.com
349. Telegraf.rs
350. Apple HTTP Live Streaming
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351. Avito.ru
352. Free
353. Allegro.pl
354. Blog.hu
355. craigslist.com
356. Gazeta.pl
357. Globo.com
358. Grid.mk
359. Hespress.com
360. Hurriyet.com.tr
361. Indiatimes
362. Interia.pl
363. Kijiji.ca
364. Ouedkniss.com
365. Sahibinden.com
366. Seznam.cz
367. Varzesh3.com
368. AliExpress.com
369. Bankmellat.ir
370. Bild.de
371. Coccoc.com
372. Elmundo.es
373. Pantip.com
374. Repubblica.it
375. Rt.com
376. Sabq.org
377. UOL.com.br
378. Wp.pl
379. Emol.com
380. Flipkart.com
381. Milliyet.com.tr
382. Onet.pl
383. Souq.com
384. VnExpress.net
385. Zing.vn
386. Google Accounts
387. Haber7
388. Lapatilla
389. Gazetaexpress
390. Amazon Ad System
391. AOL
392. Snapchat
393. Aparat



Aruba Central | User Guide 696

394. Digikala
395. Naver
396. AddThis
397. uTorrent
398. Telegram
399. Huffington Post
400. Symantec
401. Oracle
402. Albawabhnews
403. Discuss
404. Independent
405. TRUSTe
406. Adobe
407. Zendesk
408. magicJack
409. Google Safe Browsing
410. Samsung
411. TWITCH
412. OkCupid
413. Facebook Messenger
414. Afreeca TV
415. battlenet
416. Inquirer
417. Ukr
418. 4CHAN
419. Web
420. Eksisozluk
421. Amazon Cloud Drive
422. Hibapress
423. Chouftv
424. Google Cloud Storage
425. Google Cloud Messaging
426. Biobiochile
427. Google Calendar
428. Theladbible
429. Apple Location
430. GitHub
431. Bitbucket
432. Bongacams
433. Gmw
434. Sabah
435. Pastebin
436. SourceForge
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437. Google Tag Manager
438. Google Play Music
439. Xbox Video (Microsoft Movies and Tv)
440. Gmanetwork
441. Diply
442. Apple Music
443. GoogleBot
444. Microsoft SpyNet (aka Microsoft Active Protection Service)
445. Dropbox Upload
446. Dropbox Download
447. Microsoft Translator
448. Microsoft Sway (Office 365)
449. Microsoft Planner (Office 365)
450. Microsoft Office OneNote (Office 365)
451. Google Code
452. Microsoft Excel Online (Office 365)
453. Salesforce Chatter
454. Google Web Light
455. Google Trusted Store (Google Commerce)
456. Microsoft OneDrive
457. Microsoft
458. SOS ALG FTP
459. SOS ALG RTSP
460. SOS ALG SVP
461. SOS ALG SCCP
462. SOS ALG Vocera
463. SOS ALG SIP
464. SOS ALG NOE
465. SOS ALG SIPS
466. SOS ALG H323
467. SOS ALG Facetime
468. SOS ALG Skype4B Voice
469. SOS ALG Skype4B Video
470. SOS ALG Skype4B Desktop-Sharing
471. SOS ALG Skype4B File-Transfer
472. SOS ALG SIP-Audio
473. SOS ALG SIP-Video
474. SOS ALG Jabber
475. SOS ALG Jabber Video
476. SOS ALG Jabber Desktop-Sharing
477. SOS ALG Jabber-Video
478. SOS ALG Skype4B App-Sharing
479. SOS ALG RTP
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480. SOS ALG RTP
481. SOS ALG WIFI CALLING
482. SOS ALG WIFI CALLING
483. SOS ALG Facetime-Audio
484. Google Spaces
485. Google Photos (formerly Google Picasa)
486. Slack
487. Zoom
488. Pokemon Go
489. Google Local Guides
490. Miscellaneous
491. square application
492. pearsonvue web
493. learningalanytics web
494. squirrelsystems web
495. Youtube Education web
496. IMO
497. Amazon Music
498. Google Sprayscape
499. Microsoft Word Online (Office 365)
500. Microsoft Powerpoint Online (Office 365)
501. Tidal
502. Google Inbox
503. Google Classroom
504. Amazon Chime
505. Google Chrome Remote Desktop
506. Microsoft Power BI (Office 365)
507. Google Secure User Plane Location
508. Google Cloud Platform
509. Workplace by Facebook
510. Microsoft teams
511. Microsoft PowerShell Remoting Protocol
512. Office365 SAAS
513. Google SAAS
514. Salesforce SAAS
515. Dropbox SAAS
516. Zendesk SAAS
517. Amazon SAAS
518. Box SAAS
519. GoToMeeting SAAS
520. Webex SAAS
521. Adobe SAAS
522. Slack SAAS
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523. Intuit SAAS
524. Concur SAAS
525. Oracle SAAS
526. Unclassified

Websites
TheWebsites tab includes a table view and a bar graph view related to the client traffic flow and their data
usage by various websites. These graphs are displayed for a specific time frame (3 Hours, 1 Day, 1 Week, 1
Month, 3 Months). By default, the graphs display real-time client traffic data or usage trend in last three
hours.

Table View in Websites Section
TheWebsites tab displays the following details:

n Reputation—The reputation of the application categories, for example, Trustworthy, Incomplete,
Moderate Risk, Low Risk,High Risk and so on. The reputations are set based on the risk levels
exhibited by the application categories.

n Usage—The percentage of data usage by application categories based on their reputation.
n Category—The category of the client traffic that sends and receives data, for example,Unclassified,

Social Networking, Streaming,Web, Cloud File Storage, Instant Messaging and so on.
n Usage—The size and percentage of data usage by the corresponding categories.

Graph View in Websites Section
Click the Summary icon in theWebsites section to display bar graphs for the following tabs:

n Reputation—The stacked bar graph displays details of client traffic flow for the top five reputations
listed in theWebsites table.
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n Web Categories—The stacked bar graph displays details of client traffic flow for the top five web
categories listed in theWebsites table. You can view the size of data flowing to and from each of the
web categories by hovering the mouse on the bar graph. The legend beside the bar graphs displays the
list of websites based on its reputation, to which the traffic flow is detected.

The Applications (Apps) and Web Categories charts are also displayed in the Applications pages for the Group,
Site, APs, and Gateways levels.
Application Visibility data is updated every 0th minute of every hour. The data population on the Applications >
Visibility dashboard may be delayed by an hour when compared to the Application Visibility data displayed in
the Applications pages for the Group, Site, APs, and Gateways levels.

Blocked Traffic
Based on the group selection from theBlocked Traffic drop-down list, theBlocked Traffic section of the
Application > Visibility > Blocked Traffic dashboard allows you to view the following information:

n Blocked devices of the selected group as CSV file.
n The number of user sessions that are blocked.
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The blocked traffic details are shown only for the APs on which Application Visibility or DPI ACLs are enabled.

Downloading Blocked Session Details
To download blocked session details in the CSV format, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups or Sites. For all
devices, set the filter to Global. The dashboard context for the selected filter is displayed.

2. UnderManage, click Applications. TheVisibility dashboard is displayed.
3. Click Blocked Traffic tab.
4. To download the blocked sessions report, select the device group from the Select Group drop-

down.
5. Click Download CSV. Aruba Central generates the CSV report with data from the last 7 days.

The CSV file shows up to 50000 blocked sessions for a single Instant AP cluster.

About Floorplans
Floorplans allow you to plan sites, create and manage floor plans, and provision access points. You can use
Floorplans to do basic planning procedures, such as, creating a floor plan and provisioning access points.
The Floorplans dashboard can be accessed only from a site context.

Floorplans provide a real-time picture of the radio environment of your wireless network and the ability to
plan the wireless coverage of new sites. For a better understanding of your wireless network, you must
know the location of your devices and users, and the RF environment of your network. Floorplans provide
this information at your fingertips through integrated mapping and location data.

Floorplans use sophisticated RF fingerprinting to accurately display coverage patterns and calculate the
location of every wireless device in range. Floorplans does not require dedicated RF sensors or a costly
additional location appliance, because it gathers all the necessary information from your existing devices.

Floorplans is supported only on access points running 6.5.2.0 or a later version.
Do not use the internet browser for back or front navigation. Instead, use the breadcrumbs.

Floorplans offer the following features:

n Create and import floor plans.
n Pictorial navigation that allows you to view the floor plans associated with access points, associated

clients, rogues, buildings, and floors.
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n Accurate calculation of the location of all associated client devices (laptops and Phones) using RF data
from your devices.

n Accurate calculation of the location of all rogue devices (as classified by RAPIDS) using RF data from your
devices.

n A tree view that allows you to navigate to a specific campus.
n A map view that shows the location of devices and heatmaps that depict the strength of RF coverage in

each location.

Related Topics

n Floorplans Dashboard
n Planning and Provisioning Devices
n Customizing the Floorplans View
n Floorplans APIs

Floorplans Dashboard
The Floorplans dashboard can be accessed from a site context or an access point context. You can either
navigate to a specific site to view the floor plan or view a specific site floor plan from theNetwork Health
tab in theGlobal context.

To view the Floorplans dashboard from theNetwork Health tab in theGlobal context, complete the
following steps:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for theGlobal filter is displayed.

2. UnderManage > Overview, click Network Health. The Summary page is displayed.
3. Hover over a site to view the following details:

4. Click Floorplan underRF Coverage. The Floorplans dashboard for the selected site is displayed.

To view the Floorplans dashboard from a site context, complete the following steps:

1. In theNetwork Operations app, set the filter to a Site.

The dashboard context for the selected site is displayed.
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2. UnderManage > Overview, click Floorplans. The Floorplans dashboard is displayed.

The Floorplans dashboard allows you to customize the view by selecting various properties and also
allows you to select multiple floors in the same site.

To view the Floorplans dashboard from an access point context, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for theGlobal filter is displayed.

2. UnderManage > Devices, click Access Points.

A list of access points is displayed in the List view.

3. Click theAccess Point name to view theAccess Point Details page. If there are many access
points connected to the network, click Online to filter the online access points.

4. Additionally, enter the access point name in theDevice Name column and then click the access
point name. TheAccess Point Details page is displayed.

5. UnderManage > Overview, click Floor Plan. The floor plan details for the access point is displayed.

Planning and Provisioning Devices
Floorplans provide the capability to plan buildings, floors, and location for device provisioning before the
actual deployment. Using Floorplans, you can create a floor plan and add devices to the floor plan.

The planning and provisioning workflow includes the following procedures:

n Creating a Floor Plan
n Importing a Floor Plan
n Modifying Floor Plan Properties
n Adding Devices to the Floor Plan

Creating a Floor Plan
Floorplans allow you to add, modify, and import a floor plan background image file. When importing RF
plans ensure that the devices from the device catalog are included.

To create a new floor plan, complete the following steps:

1. In theNetwork Operations app, set the filter to a Site.

The dashboard context for the selected site is displayed.

2. UnderManage > Overview, click Floorplans. The Floorplans dashboard is displayed.
3. Click Add Floors. The Floor Plan tab is displayed.

4. Click Edit in the slide out pane on the right.
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5. Click New Floorplan. TheNew Floorplan pop-up window is displayed:

6. Click Choose File and locate a floor plan image file from your local file system. You can import the
floor plan image file in the jpg, jpeg, gif, bmp, pdf, or png format.

7. Assign a floor name and a floor number in the Floor name and Floor number text boxes,
respectively.

8. Click Save.
9. You can define new floor by clicking theDefine New Floor option on the top right corner.

10. TheDefine New Floor includes the following option:

a. Scale—Shows the dimensions of the floor.

b. Region—Allows you to define floor plan boundary and planning region.

c. CAD Layer—Allows you to import walls from the CAD file.

d. Access Points—Allows you to add the access point's to the floor plan.

11. Click Next button after you set the Scale, Region, and CAD layer for the floor.
12. To add a planned access point, underAccess Points > Planned APs, select the device type from the

Type drop-down menu.
13. In theCount field, enter the number of devices to add to the new floor.
14. Click and drag theDeployment Type slider bar to adjust data rates for a high density or low density

environment.
15. Optionally, click theAdvance link to configure the advance deployment options:

a. Service Level—Select Speed or Signal to plan coverage by adjusting the data rate requirements
(speed) or AP signal strength settings. Click Calculate AP Count to recalculate the suggested
number of APs based on these settings.

b. Client Density—In theMax Clients field, set the anticipated number of clients that will be
stationed in the floor. In theClients Per AP field, enter the maximum number of clients
supported by each radio. Click Calculate AP Count to recalculate the suggested number of APs
based on these settings.

16. Click Add APs to Floorplan to add the planned APs to the floor.
17. Click Finish.
18. To remove the planned device from the floor plan, right-click on that device and click Remove.
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Importing a Floor Plan
To import a floor plan exported from AirWave or Aruba Central, complete the following steps:

1. In theNetwork Operations app, set the filter to a Site.

The dashboard context for the selected site is displayed.

2. UnderManage > Overview, click Floorplans. The Floorplans dashboard is displayed.
3. Click the Import menu option:

4. Click Choose File and select the floor plan zip file to import.
5. Click Upload. When an import is complete, the UI displays a notification to alert the user.

Modifying Floor Plan Properties
To edit the properties of an existing floor plan, complete the following steps:

1. In theNetwork Operations app, set the filter to a Site.

The dashboard context for the selected site is displayed.

2. UnderManage > Overview, click Floorplans. The Floorplans dashboard is displayed.
3. Click the floor number or floor name link. The <Floor Name> slide out pane is displayed.
4. Click Edit to modify the properties. For more information, see Customizing the Floorplans View.
5. Click Save.

Adding Devices to the Floor Plan
You can add the planned devices (for example, APs) or the already deployed devices to floor plan.

To add the already deployed devices to the floor plan, complete the following steps:

1. In theNetwork Operations app, set the filter to a Site.

The dashboard context for the selected site is displayed.

2. UnderManage > Overview, click Floorplans. The Floorplans dashboard is displayed.
3. Click the floor number or name link. The <Floor Name> slide out pane is displayed.
4. Click Edit.
5. Click theAdd Deployed Devices. A list of devices is displayed.
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6. Expand the group containing the APs which need to be provisioned on this floor plan. Note that by
default, devices that have already been added to Floorplans are hidden. To show them, clear the
Hide APs that are already added check box at the bottom of the list.

7. Click and drag an AP (or a Group or Folder of APs) to its proper location on the floor.
8. To remove a device from the floor plan, right-click that device and then click Remove.

To add planned devices when creating a new floor plan, complete the following steps:

1. In theNetwork Operations app, set the filter to a Site.

The dashboard context for the selected site is displayed.

2. UnderManage > Overview, click Floorplans. The Floorplans dashboard is displayed.
3. Click the floor number or name link. The <Floor Name> slide out pane is displayed.
4. Click Edit.
5. Click Add Planned Devices and select a device type (model) from the list of available devices.
6. Click and drag the device to the desired location on the floor.
7. To Auto-match the planned devices, click Auto-Match Planned Devices from theAction tab.
8. To remove a planned device from the floor plan, right-click on that device and then click Remove.

Customizing the Floorplans View
To customize your floor plan view, click theView tab on the right sliding panel. TheView tab displays the list
of campuses and the devices.

n Click APs to view the details of the access point and the RF environment.
n Click Clients to view the client details.
n Click Rogues to view the rogue details.

The Floorplans navigation menu on the right pane consists of the Properties, View, and Edit tabs. The
following table describes the menu options available for a floor:
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Tabs Options

The Properties tab has the following
menu options:

n APs—Displays the total number of
APs, the planned APs, and the
number of APs that are offline.
n Clients—Displays the total
number of clients.
n Floor name—Displays the floor
name.
n Floor number—Displays the floor
number.
n Width—Displays the current
width of the floor plan. To change
these settings, click the Measure
icon and measure a portion of the
floor.
n Height—Displays the current
height of the floor plan. To change
these settings, click the Measure
icon and measure a portion of the
floor.
n Gridsize—Displays the grid.
Decreasing the grid size enables the
location to place clients in a small
grid which increases accuracy.
n Advanced—Allows you to set the
values to indicate if the environment
is related to an office space,
cubicles, offices, or concrete.

Table 181: Floorplan Menu Options
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Tabs Options

The View tab has the following menu
options:

n Devices—Displays APs, clients,
and rogue devices detected on the
floor.
n AP Overlays—Shows the
heatmap for the current and
adjacent floors.
n Floorplan Features—Displays
the following details:
lGrid Lines—Allows you to
change the grid size and color.
lLabels—Shows or hides the
labels tagged to the devices on
the floor.
lOrigin—To ensure that multi-
floor heatmaps display properly,
ensure that your floor plans are
vertically aligned. Floorplans use
the origination point for this
alignment. By default, the origin
appears in the upper left corner of
the floor plan. You can drag and
drop the origin point to the correct
position.
lRegions—Displays the regions
defined within a floor plan. For
example, you can define two
small regions of high density
clients within a larger floor plan
with lower client density.
lWalls—Displays walls drawn on
the floor.
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Tabs Options

The Edit tab has the following menu
options:

n Drawing—Allows you to draw a
region or wall for the floor.
n Devices—Allows you to add and
delete the already deployed or
planned devices.
n Actions—Displays the following
options:
lSelect All—Selects all floors.
lExport Floor Plans—Exports the
floor plan of a specific floor.
lUndo—Cancels the previous
action.
lNew Floorplan—Allows you to
create a new floor plan.
lAuto-match Planned
Devices—Automatically matches
the devices that are planned for
deployment and reloads the page.
lGo to floor above—Allows you
to navigate to the floor above.
lGo to floor below—Allows you
to navigate to the floor below.
lRefresh—Refreshes the page.
lReplace Background—Allows
you to replace the current
background.

User Interface Elements of the Floorplans Dashboard
The Floorplans dashboard provides various options to customize your view. The customizable parameters
include:
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UI Element Description

Click the drop-down to select a specific floor from the site.

Click APs to view the details of the access point and the RF environment.

Click Clients to view the client details.

Click Rogues to view the rogue details.

Click Heatmaps to view the strength of RF coverage in each location. You can view
heatmaps in monochrome also. Click the monochrome checkbox in the Floorplans
dashboard to select either the monochrome display or the colored display of heatmaps.

Click Walls and Regions to view the segregation of regions and walls in the selected
floor.

Click the Refresh icon to refresh the floor plan details.

Click the + or - icon to zoom in or zoom out of a floor plan. You can also scroll to
increase or decrease the floor plan view. Additionally, click the box icon to view the floor
plan in full screen mode.

Table 182: User Interface Elements

Floorplans APIs
Aruba Central supports the following APIs for retrieving client location and floor plan information:

n GET /visualrf_api/v1/campus—Retrieves a list of all campus sites.
n GET /visualrf_api/v1/campus/{campus_id}—Retrieves information about a specific campus and its

buildings.
n GET /visualrf_api/v1/building/{building_id}—Retrieves information about specific building and its

floors.
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n GET /visualrf_api/v1/floor/{floor_id}—Retrieves details about a specific floor.
n GET /visualrf_api/v1/floor/{floor_id}/image—Retrieves background image from a specific floor plan.
n GET /visualrf_api/v1/floor/{floor_id}/access_point_location—Retrieves information about the

location of the APs on a specific floor plan.
n GET /visualrf_api/v1/access_point_location/{macaddr}—Retrieves location details of a specific AP.
n GET /visualrf_api/v1/client_location/{macaddr}—Retrieves location details of a specific client.
n GET /visualrf_api/v1/floor/{floor_id}/client_location—Retrieves information about the location of

clients on a specific floor.

For more information on APIs, see Aruba Central APIs and refer to API documentation at https://app1-
apigw.central.arubanetworks.com/swagger/central.

Monitoring Sites in the Topology Tab
In Aruba Central, the Topology tab in the site dashboard provides a graphical representation of the site
including the network layout, details of the devices deployed, and the health of the WAN uplinks and
tunnels.

The minimum required ArubaOS version for topology is ArubaOS version 8.1.0.0-1.0.1.1.

This section includes the following topics:

n Before You Begin
n Grouping VPNCs
n Viewing the Topology Tab

l Parts of the Topology Tab User Interface

l Pop-Up Details

l Details Pane

Before You Begin
The pre-requisites for Branch Gateways are:

n The topology map filters devices based on sites. To view the topology map, ensure that you have
assigned the devices to sites.

n To view the topology map, ensure that LLDP is enabled. On switches, LLDP is enabled by default. On
Branch Gateways, if the port type is LAN, LLDP is enabled by default.

The pre-requisite for Aruba CX switches is:

n To view Aruba CX switches in the topology map, you must create a template configuration for the switch
with the password in plaintext.

Grouping VPNCs
If the tunnels in the overlay are orchestrated, the VPNCs are grouped according to their hub groups. You
can also see the group preference order marked as primary, secondary, or tertiary.

If the tunnels are configured manually, the VPNCs are grouped according to their sites. If the VPNCs are not
associated with any site, they are grouped based on their hub groups. For manual tunnels, the Data Center
group preference is not displayed.

https://app1-apigw.central.arubanetworks.com/swagger/central
https://app1-apigw.central.arubanetworks.com/swagger/central
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If you have a combination of gateways in a single site, with one gateway configured as a manual tunnel and
the other gateway configured as an orchestrated tunnel, both the tunnels are treated as manual and the
VPNCs are grouped based on their sites. If there are no associated sites, they are grouped according to their
hub groups.

Various combinations of configuration for VPNCs in a single site is not recommended.

Viewing the Topology Tab
To view the topology tab, complete the following steps:

1. In theNetwork Operations app, set the filter to one of the options under Site for which you want
to view the topology map.

The dashboard context for the site is displayed.

2. UnderManage, click Overview > Topology.

The Topology tab for the selected site is displayed.

3. In the topology map, hover over a device or a link to view the pop-up details. For more information,
see Pop-Up Details.

4. In the device or the link pop-up, click the Show Details link to view the correspondingDetails pane.
For more information, see Details Pane .

Parts of the Topology Tab User Interface
In the topology tab, the icons provides the following functionality:

Figure 136 Parts of the Topology Tab

Callout
Number Description

1 Set the toggle icon to show or hide the labels.

2 Click the icon to filter the type of devices to be shown on the map. The following options are
available:

n Access Points—Allows you to show or hide the access points from the topology map.

Table 183: Icon Details
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Callout
Number Description

n Security Cloud—Allows you to show or hide the Zscaler and Palo Alto Prisma Access™
Cloud Service from the topology map.
n Switch—Allows you to show or hide the switches from the topology map.
n VPNC—Allows you to show or hide the VPNCs and virtual gateways from the topology map.
n Show Devices Without Link—Allows you to show or hide the devices without link from
the topology map.

3 Click the icon to view the topology map in a left to right orientation. The default orientation of the
topology map is left to right orientation.

4 Click the icon to view the topology map in a top to down orientation.

5 The search bar allows you to locate a device in the topology map. The search bar field supports
exact and partial text search.

6 Click the icon to reset the topology map to the default view.

7 Click the icons to change the zoom level of the topology map. Alternatively, you can drag the
slider to set the zoom level of the topology map.

8 Click the icon to view the topology map in full-screen view. In the full-screen view, the pop-up
details feature is disabled in the topology map.

When the number of downstream devices connected to a device is less than or equal to 10, the devices are
visible in the topology map. When the number of downstream devices connected to a device is more than 10,
click the device icon to view the devices in the topology map. A bubble icon on the device represents the
number of connected downstream devices.

Pop-Up Details
When you hover over a device or link, a pop-up displays the following details:

Figure 137 Pop-Up Details

Type Description

Access Point Displays the following details:

Table 184: Pop-Up Details
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Type Description

n Name—Hostname of the access point.
n Type—Type of the device.
n Model—Hardware model of the access point.
n Health Reason—The health status of the access point. This parameter is only
available when the access point is offline.
n Show Details—Click the link to view the Details pane.

Branch Gateway Displays the following details:
n Name—Hostname of the Branch Gateway.
n Type—Type of device deployment.
n Model—Hardware model of the device.
n Children—Number of devices connected to the Branch Gateway categorized based
on the health and status of the devices. The Children field displays the following
details:
lHealth—Count of devices connected to the Branch Gateway based on the health of
the device. The red, yellow, and green dots indicate the health of the devices.
lStatus—Count of devices connected to the Branch Gateway based on the current
status of the devices. The green (up) and red (down) arrows indicate the status of the
devices.

n Show Details—Click the link to view the Details pane.

VPNC Displays the following details:
n Name—Hostname of the VPNC.
n Type—Type of device deployment.
n Model—Hardware model of the device.
n Show Details—Click the link to view the Details pane.

Switch Displays the following details:
n Name—Hostname of the switch.
n Type—Type of the device.
n Model—Hardware model of the switch.
n Children—Number of devices connected to the switch categorized based on the
health and status of the devices. The Children field displays the following details:
lHealth—Count of devices connected to the switch based on the health of the device.
The red, yellow, and green dots indicate the health of the devices.
lStatus—Count of devices connected to the switch based on the current status of the
devices. The green (up) and red (down) arrows indicate the status of the devices.

n Show Details—Click the link to view the Details pane.

Switch Stack Displays the following details:
n Name—Hostname of the switch stack.
n Type—Type of the device.
n Model—Hardware model of the switch.
n Children—Number of devices connected to the switch categorized based on the
health and status of the devices. The Children field displays the following details:
lHealth—Count of devices connected to the switch based on the health of the device.
The red, yellow, and green dots indicate the health of the devices.
lStatus—Count of devices connected to the switch based on the current status of the
devices. The green (up) and red (down) arrows indicate the status of the devices.

n Show Details—Click the link to view the Details pane.

Aruba CX VSX
Switch

Displays the following details:
n Name—Name of the Aruba CX switch that is configured with VSX. The name is
displayed in the VSX_<Device Name> format. For example, VSX_8320-switch-
primary.
n Type—Type of the device.
n Model—Hardware model of the Aruba CX switch.
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Type Description

n VSX Role—Role of the Aruba CX switch in the VSX configuration. Supported values
are Primary and Secondary.
n Children—Number of devices connected to the switch categorized based on the
health and status of the devices. The Children field displays the following details:
lHealth—Count of devices connected to the switch based on the health of the device.
The red, yellow, and green dots indicate the health of the devices.
lStatus—Count of devices connected to the switch based on the current status of the
devices. The green (up) and red (down) arrows indicate the status of the devices.

n Show Details—Click the link to view the Details pane.

Tunnel Displays the alias map name of the tunnel configured on the Branch Gateway.
In the topology map, the tunnels are shown as dotted lines. The red and green color of the
tunnel link indicates the health of the tunnel link.
Click the tunnel link to view the Details pane.

NOTE: In case of High Availability, the redundant gateway tunnel details are also displayed
in the Details tab under Virtual Tunnels when you select the tunnel.

Uplink Displays the following information about uplinks configured on the Branch Gateway:
n <Name of the Branch Gateway>—Displays the name of the Branch Gateway.
n Uplink—Type of the uplink.
n VLAN—VLAN ID of the uplink.
n Health Reason—Displays the health status and reason of the down uplink. This
parameter is only available when the uplink is down.

The red and green color of the uplink indicates the health of the uplink.
Click the uplink to view the Details pane.

NOTE: In case of High Availability, the redundant gateway tunnel details are also displayed
in the Details tab under Virtual Tunnels when you select the uplink.

Edge Displays the following information about the edge link:
n <Interface of the device>—Interface number of the device.
n <Name of the device>—Displays the name of the device.
n Health Reason—Displays the health status and reason of the down edge link. This
parameter is only available when the edge link is down.

The red and green color of the edge link indicates the health of the edge.
Click the edge link to view the Details pane.

ISL edge in Aruba
CX VSX toplogy
map

Displays the following information about the link:
n ISL—Number of inter-switch link (ISL) present between the Aruba CX switches
configured with VSX.
n Other Links—Number of other links present between the Aruba CX switches
configured with VSX.

Active tunnels are green in color and inactive tunnels are red in color. If there are multiple tunnels connecting to
a VPNCs, and even if one of those tunnels is down, the tunnel mapping is displayed in red dotted lines.

Details Pane
In the topology map, theDetails task pane provides a summary of the devices, uplinks, and tunnel details.
The red and green indicators show the current status and health of the WAN uplinks and tunnels.

In the topology map, select a device and then click the Show Details link in the pop-up window to view the
Details pane. To view theDetails pane for a tunnel, uplink, or edge, click the link.
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Figure 138 Details Pane

TheDetails task pane displays the following information:

Type Description

Access
Point

Displays the following details:
n Name—Hostname of the access point. Click the access point name to view the Access Point
Details page.
n IP—IP address of the access point.
n MAC—MAC address of the access point.
n Type—Type of the device.
n Serial—Serial number of the access point.
n Model—Hardware model of the access point.
n Status—Operational status of the access point.
n Health—Operational health of the access point.

Branch
Gateway

Displays the following details:
n Name—Hostname of the Branch Gateway. Click the Branch Gateway name to view the
Gateway Details page.
n IP—IP address of the Branch Gateway.
n MAC—MAC address of the device.
n Type—Type of device deployment.
n Serial—Serial number of the Branch Gateway.
n Model—Hardware model of the device.
n Status—Operational status of the device.
n Health—Operational health of the device.

VPNC Displays the following details:
n Name—Hostname of the VPNC. Click the VPNC name to view the Gateway Details page.
n IP—IP address of the VPNC.
n MAC—MAC address of the device.
n Type—Type of device deployment.
n Serial—Serial number of the VPNC.
n Model—Hardware model of the device.
n Status—Operational status of the device.
n Health—Operational health of the device.

Switch Displays the following details:
n Name—Hostname of the switch. Click the switch name to view the Switch Details page.
n IP—IP address of the switch.
n MAC—MAC address of the switch.
n Type—Type of the device.

Table 185: Contents of the Details Pane
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Type Description

n Serial—Serial number of the switch.
n Model—Hardware model of the switch.
n Status—Operational status of the switch.
n Health—Operational health of the switch.

Switch
Stack

Displays the following details:
n Name—Hostname of the switch. Click the switch name to view the Switch Details page.
n IP—IP address of the switch.
n MAC—MAC address of the switch.
n Type—Type of the device.
n Serial—Serial number of the switch.
n Stack Role—Role of the switch in the stack.
n Model—Hardware model of the switch.
n Status—Operational status of the switch stack.
n Health—Operational health of the switch stack.
n Stack Members—Provides the Name, Role, and State details of the stack member. Click
the stack member name to view the Switch Details page.

Aruba CX
VSX

Displays the following details:
n Name—Hostname of the Aruba CX switch with VSX configured. Click the switch name to
view the Switch Details page.
n IP—IP address of the switch.
n MAC—MAC address of the switch.
n Type—Type of the device.
n Serial—Serial number of the switch.
n Model—Hardware model of the switch.
n Status—Operational status of the switch.
n Health—Operational health of the switch.

VSX section displays the following details:
n ISL State—State of the ISL connection with the peer Aruba CX switch. Following are the
supported values:
lWAITING_FOR_PEER—Waiting for connectivity to the peer.
lPEER_ESTABLISHED—Steady state. VSX LAGs are up when the device is in this state.
lSPLIT_SYSTEM_PRIMARY—Lost ISL connectivity to the peer and the device is operating as
primary.
lSPLIT_SYSTEM_SECONDARY—Lost ISL connectivity to the peer and the device is operating
as secondary.
lSYNC_PRIMARY—ISL connectivity to the peer restored and the device is syncing states to the
peer.
lSYNC_SECONDARY—ISL connectivity to the peer restored and he device is learning states
from the peer. VSX LAGs are down when the device is in this state.
lSYNC_SECONDARY_LINKUP_DELAY—Device has learned its states from the peer and
monitoring for hardware is to be programmed. VSX LAGs are down when the device is in this
state.

n ISL Port—ISL port number of the selected Aruba CX switch. If the ISL is a LAG, then this field
displays the LAG name.
n ISL Mgmt State—Management state of the ISL. Following are the supported values:
lOPERATIONAL—ISL management is operational.
lINTER_SWITCH_LINK_MGMT_INIT—ISL management is in initialization state.
lCONFLICTING_OR_MISSING_DEVICE_ROLES—Either the role is missing on one of the
VSX peers or the same role is configured on both VSX peers.
lSW_IMAGE_VERSION_MISMATCH_ERROR—Software version on the primary device
does not match with the software version on the secondary device.
lINTER_SWITCH_LINK_DOWN—ISL is down.
lINTERNAL_ERROR—ISL management has internal errors.

n Config Sync Enabled—Configuration synchronization between the VSX switches are
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Type Description

enabled or disabled.
n Config Sync Status—Status of the configuration synchronization between the VSX switches.
Following are the supported values:
lIN-SYNC—Configuration synchronization is operational and the VSX switches are in sync.
lDISABLED—Configuration synchronization is disabled.
lSW_IMAGE_VERSION_MISMATCH_ERROR—Software image version on the primary
device does not match with the software image version on the secondary device.
lCONFLICTING_OR_MISSING_DEVICE_ROLES—Either the role is missing on one of the
VSX peers or the same role is configured on both VSX peers.
lPEER_DB_CONNECTION_ERROR—Error in connecting to peer database. It involves errors
due to ISL or ISL management.
lCONFIGURATION_SYNC_CONFLICT—Configuration synchronization is operational, but
has conflicts synchronizing the configuration. Conflicts can occur if the configuration on the
primary device is marked for sync, but the same configuration on the secondary device is not
marked for sync.
lCONFIGURATION_SYNC_MISSING_REFERENCE—Configuration synchronization is
operational, but has missing references in synchronizing the configuration.

n Role—Role of the Aruba CX switch in the VSX configuration. Supported values are Primary
and Secondary.
n Peer IP—IPv4 address of the peer switch.
n Peer Serial—Serial number of the peer switch.
n Peer MAC—MAC address of the peer switch.
n Peer Name—Hostname of the peer switch.
n Last Seen—Date on which the peer switch was last synced.

Tunnel Displays the following information about tunnels configured on the Branch Gateway:
n Map Name—Name of the tunnel interface.
n Peer MAC—MAC address of the peer device with which the tunnel was established.
n Local MAC—MAC address of the Branch Gateway.
n Source IP—Source IP address from where the traffic originates.
n Destination IP—IP address to which the traffic is sent.
n Established Time—Timestamp showing when the tunnel was established.
n VLAN—VLAN ID of the tunnel.
n Source Serial—Source Serial of the tunnel.
n A green bullet icon indicates that the tunnel is up and a red bullet icon indicates that the
tunnel is down.

Uplink Displays the following information about uplinks configured on the Branch Gateway:
n Uplink Type—Type of the uplink.
n VLAN—VLAN ID of the uplink.
n Link Status—Uplink status.
n Description—Description of the uplink.
n WAN Status—WAN status.
n IP Address—IP address of the WAN interface.
n Public IP Address—Public IP address.
n Device MAC—MAC address of the device.
n Serial—Serial number of the device.
n Port Number—Port number of the device.
n Tunnels—Displays a list of tunnels mapped to the uplink. Click the drop-down on each
tunnel to view the tunnel details.
n A green bullet icon indicates that the tunnel is up and a red bullet icon indicates that the
tunnel is down.

Edge Displays the following information about the link:
n Interface numbers—Interface numbers of the device.
n Interface—Interface number of the individual device.
n Serial—Serial number of the individual device.
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Type Description

n Device Name—The name of the individual device.
n Port Number—The port number of the individual device.

NOTE: In case of Branch Office Controller (BOC) to Switch link, if a peer Branch Gateway link is
configured for redundancy, link details are displayed for the peer Branch Gateway to switch link as
well.

ISL edge in
Aruba CX
VSX
toplogy
map

Displays the following information about the ISL edge:
n Inter-Switch Link Status—Status of the ISL connection with the peer.
n <LAG-name> - ISL section displays details about all the interfaces that are part of the LAG.
The section also displays the details of the devices connected to these interfaces. It displays
the following details:
lSerial—Serial number of the individual device.
lDevice Name—Name of the individual device.
lPort Number—Port number of the individual device.

n Other—This section displays details about the other links present between the VSX
configured Aruba CX switches. It displays the following details:
lSerial—Serial number of the individual device.
lDevice Name—Name of the individual device.
lPort Number—Port number of the individual device.

For an animation of the site topology map, click
https://help.central.arubanetworks.com/latest/documentation/online_
help/content/resources/images/gifs/topology.gif.

Alerts & Events
TheAlerts & Events pane displays all types of alerts and events generated for events pertaining to device
provisioning, configuration, and user management.

This section includes the following topics:

n Configuring Alerts
n Adding Default Recipients
n Suppressing Alerts
n Viewing Alerts in List view
n Viewing Events in List view
n Viewing Alerts & Events in Summary view
n Viewing Enabled Alerts

Alerts & Events Dashboard
TheAlerts and Events dashboard displays a list of alerts and events generated for events pertaining to
device provisioning, configuration, and user management. You can view the alerts and events in List view
and Summary view. Configuration view is used to configure alerts and it is available only at theGlobal
context. The components of the List view is different forAlerts and Events tab whereas the Summary
view displays similar components.

This section includes the following topics:
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n Viewing Alerts in List view
n Viewing Events in List view
n Viewing Alerts & Events in Summary view

Viewing Alerts in List view
To view the of list alerts and events and acknowledge alerts, complete the following procedure:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.
c. A list of devices is displayed in the List view.
d. Click a device listed underDevice Name.

The dashboard context for the device is displayed.

2. UnderAnalyze, click Alerts & Events.
By default, theAlerts & Events page displays the alert and events in the List view.

TheAlerts & Events page offers a list view, summary view, and a configuration view.

Configuration view is only available at the Global context.

By default, theAlerts tab is selected and theOpen Alerts table is displayed. The table displays all
the generated alerts. TheAlerts bar categorizes the alerts as Critical,Major,Minor, and Warning.

The Gateway Emergency Mode and VPN Peer Failover alerts can be configured and enabled for all
gateways. However, these alerts will not be generated for gateways on versions other than ArubaOS
8.0.x.

3. Optionally, click Acknowledge All to acknowledge all the alerts at once.

Important Points:
n Once an alert is acknowledged, the alert is moved to theAcknowledged tab.
n AllAcknowledged Alerts can be viewed when the Show Acknowledged Alerts button is ON.
n If the user does not acknowledge an alert, the alert is suppressed for 5 minutes. The alert

notification is then sent to the user every 5 minutes in case the issue still persists.
n If the user acknowledges an alert, the alert is suppressed until the issue is resolved. After resolving

the issue, if it re-occurs the alert is sent again.

4. Optionally, enable the Show Acknowledged Alerts button to display the list of acknowledged
alerts.

Advanced Alert Filtering
Aruba Central allows you to filter the alerts based on the alert categories. To filter alerts based on alert
categories, complete the following steps:
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1. In theAlerts page, click Click here for advanced filtering to filter the alerts based on alert
categories.

2. Select the alert category and click Filter. You can select multiple categories from the advanced
filtering option.

3. TheOpen Alerts table displays the list of alerts generated in each alert category. The filter summary
bar displays the total number of alerts in the selected categories.

4. Optionally, to clear advanced filtering option, from the alerts summary bar, click Clear All. The
advanced filtering gets cleared.

The following table describes the information displayed in each column of theAlerts table:

Data Pane
Content

Description

Occurred
On

Displays the timestamp of the alert. Use the sort option to
sort the events by date and time. Use the filter option to select
a specific time range to display the alerts.

Category Displays the category of the alert. Use the filter option to filter
the alert by category.

Label Displays the label name of the alert.

Site Displays the site name of the alert.

Group Displays the group name of the alert.

Severity Displays the severity level of the alert. The severity can be
Critical, Major, Minor, or Warning.

Description Displays a description of the alert. Use the search option in
filter bar to filter the alert based on description.

Table 186: Alerts pane

To customize theAlerts & Events table, click the ellipses icon to select the required columns, or click
Reset to default to set the table to the default columns.

Viewing Events in List view
To view a summary of events, complete the following procedure:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.

A list of devices is displayed in the List view.
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c. Click a device listed underDevice Name.

The dashboard context for the device is displayed.

2. UnderAnalyze, click Alerts & Events.

By default, theAlerts & Events page displays the alert and events in the List view.

TheAlerts & Events dashboard offers a list view, summary view, and a configuration view.

Configuration view is only available at the Global context.

3. In theAlerts & Events summary bar, click Events. By default, the List view is selected and a
consolidated list of events is displayed in the events table.

Advanced Event Filtering
Aruba Central allows you to filter the events based on the event types. To filter events based on event types,
complete the following steps:

1. In the Events page, click Click here for advanced filtering to filter the events based on event
types.

2. Select the event type and click Filter. You can select multiple event types from the advanced filtering
option.

3. The events table displays the list of events generated in each event type. The filter summary bar
displays the total number of events in the selected category and the type(s) of events.

4. Optionally, to clear advanced filtering option, from the events summary bar, click Clear All. The
advanced filtering gets cleared.

The following table describes the information displayed in each column of the Events table:

Data Pane
Content

Description

Occurred On Displays the timestamp of the event. Use the sort option to
sort the events by date and time. Use the filter option to select
a specific time range to display the events.

Device Type Displays the type of the device, Access Point, Gateway, Switch.
Use the filter option to filter events by device types.

Device
Hostname

Displays the host name of the device where the event is
generated.

Device MAC Displays the MAC address of the device.

Client MAC Displays the MAC address of the device to which the client is
connected.

BSSID Displays the BSSID of the device.

Event Type Displays the type of the event.

Table 187: Events pane
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Data Pane
Content

Description

Label Displays the label name of the event.

Site Displays the site name of the event.

Group Displays the group name of the event.

Description Displays the description of the event. Use the column filter to
filter an event based on the description.

To customize theAlerts & Events table, click the ellipses icon to select the required columns, or click
Reset to default to set the table to the default columns.

Aruba Central allows you to download the global list of events to your local browser. Click to download
the events list in a CSV format.

Viewing Alerts & Events in Summary view
To view a summary of alerts and events, complete the following procedure:

1. In theNetwork Operations app, select one of the following options:
n To select a group, label, site, or all devices in the filter, set the filter to one of the options under

Groups, Labels, or Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.

A list of devices is displayed in the List view.

c. Click a device listed underDevice Name.

The dashboard context for the device is displayed.

2. UnderAnalyze, click Alerts & Events.
By default, theAlerts & Events page displays the alert and events in the List view.

TheAlerts & Events page offers a list view and summary view, and a configuration view.

Configuration view is only available at the Global context.

3. To view the graphs displaying alerts and events, click the Summary icon. By default,ALL tab is
selected. Select each tab Access Points, Switches, orGateways to view the graphs pertaining to
each device type.

The Alerts & Events graphs are displayed for the time range selected. Select the time range from the

Time Range Filter ( ) to filter alerts and events.

The graphs in the Summary view displays the alerts and events in the following categories:
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n Alerts By Type—Displays the alert categories under which the maximum alerts are generated.
Hover your mouse over the bar graphs to see the total count of alerts generated under each
category.

n Alerts By Severity—Displays the alert severity categorized under Critical,Major,Minor, and
Warning. Hover your mouse to see the total count of alerts generated under each severity level.

n Events By Type—Displays the event categories under which the maximum events are generated.
Hover your mouse over the bar graphs to see the total count of events generated under each
category.

Configuring Alerts
Aruba Central allows network administrators and users with admin permissions to configure alerts. To
configure alerts, complete the following procedure:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Alerts & Events.

TheAlerts & Events page is displayed in the List view.

3. In theAlerts & Events page, click theConfig icon.

TheAlert Severities & Notifications is displayed.

4. Use the tabs to navigate between the alert categories. Select an alert and click + to enable the alert
with default settings. To configure alert parameters, click on the alert tile and do the following:

a. Severity—Set the severity. The available options are Critical, Major, Minor, and Warning. By
default, the following alerts are enabled and the severity isMajor:
n Virtual Controller Disconnected
n Rogue AP Detected
n New User Account Added
n Switch Detected
n Switch Disconnected

For a few alerts, you can configure threshold value for one or more alert severities. Enter a
value in the exceeds text box to set a threshold value for the alerts. The alert is triggered when
one of the threshold values exceed the duration.

b. Duration—Enter the duration in minutes.
c. Device Filter Options—(Optional) You can restrict the scope of an alert by setting one or

more of the following parameters:
n Group—Select a group to limit the alert to a specific group.
n Label—Select a label to limit the alert to a specific label.
n Device—Select a device to limit the alert to a specific device.
n Site—Select a site to limit the alert to a specific site.

d. Other Filter Options—(Optional) In addition to the device filter options few alerts also has
further filtering options in order to restrict the alert scope by setting one or more of the
following parameters:
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n SSID—For few Connectivity alerts, you can select a SSID to limit the alert to a specific
SSID.

n Interface—For few switch port alerts, you can mention an interface value to limit the alert
criteria to a specific port.

n Band—For fewAccess Point alerts, you can select the band, 2.4 GHz or 5 GHz to limit the
alert to a specific band.

n Subnet— For few gateway alerts, you can limit the alert for a specific DHCP pool identified
by its subnet.

n Provider Tag—For few gateway alerts, you can limit the alert to a particular uplink
identified by its link tag (Provider Tag).

e. Notification Options
n Email—Select the Email check box and enter an email address to receive notifications

when an alert is generated. You can enter multiple email addresses, separate each value
with a comma. TheDefault Recipient check box is selected by default. If you want to
disable specific email addresses from the default list to avoid sending alert notification, click

the number displayed in parenthesis and click against each email address. To add or
delete default recipient, see Adding Default Recipients. Uncheck theDefault Recipient
check box in order to disable alert notifications to all the default email addresses.

The number displayed in the parenthesis denotes the total number of email addresses that
have been already configured as default recipients to receive notifications when an alert is
generated.

n Streaming—Select the Streaming check box to receive the streaming notifications when
an alert is generated.

n Webhook—Select the Webhook check box and select the webhook as required. You can
also Create Webhook for alert notification. For more information, see Webhooks.

f. Click Save.
g. Add Rule—(Optional) For a few alerts, theAdd Rule option appears. For such alerts, you can

add additional rule(s). The rule summaries appear at the top of the page.

You can use the Search box, to search for alerts using keywords.

Aruba Central allows you to configure the following alerts:

n User Alerts
n Access Point Alerts
n Switch Alerts
n Gateway Alerts
n WAN Health Alerts
n Connectivity Alerts
n Audit Alerts
n Site Alerts

User Alerts
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Aruba Central allows network administrators and users with admin permissions to configure alerts. For
more information, see Configuring Alerts.

Following are the user management alerts that you can configure:

n New User Account Added—Generates an alert when a new user account is added. This alert is enabled
by default and the alert severity isMajor.

n User Account Deleted—Generates an alert when a user account is deleted.
n User Account Edited—Generates an alert when a user account is edited.

Switch Alerts
Aruba Central allows network administrators and users with admin permissions to configure alerts. For
more information, see Configuring Alerts.

Following are the switch alerts that you can configure:

n New Switch Connected—Generates an alert when a new switch is connected.
n Switch Disconnected—Generates an alert when a switch is disconnected. This alert is enabled by

default and the alert severity isMajor. In theDuration field, enter the duration during which the
condition persists. The alert must be generated if the condition persists even after this duration. The
default value is 10 minutes.

n Switch Mismatch Config—Generates an alert when there is a mismatch in switch configuration.
n Switch Hardware Failure—Generates an alert when the switch hardware fails. The following are the

typical hardware failures for Aruba and MAS switches:

Aruba switches
l Fan failure.

l Power supply failure.

l Redundant power supply failure.

l High temperature.

l Management module failures—Management module failed self-test or lost communication with
management module.

l Slot failure—Lost communications detected, slot self-test failure or unsupported module, or chassis hot
swap failure.

l Fabric power failure.

l Internal power supply: Fan failure.

l Internal power supply failure.

l Internal power supply main PoE power failure.

l Internal power supply: Main inlet exceeds/within total fault count.

l Bad driver—Too many undersized/giant packets.

l Bad transceiver—Excessive jabbering.

l Bad cable—Excessive CRC/alignment errors.

l Too long cable—Excessive late collisions.

l Over bandwidth—High collision or drop rate.

l Broadcast storm—Excessive broadcasts.

l Duplex mismatch HDx—Duplex mismatch. Reconfigure to Full Duplex.
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l Duplex mismatch FDx—Duplex mismatch. Reconfigure port to Auto.

l Link flap—Rapid detection of link faults and recoveries.

MAS switches
l Fan failure.

l High temperature.
n Switch CPU Utilization—Generates an alert when the switch CPU utilization exceeds the threshold

value. In theDuration field, enter the duration after which the alert must be generated. You can add
additional rule(s) for this alert.

n Switch Memory Utilization—Generates an alert when the switch memory utilization exceeds the
threshold value. In theDuration field, enter the duration after which the alert must be generated. You
can add additional rule(s) for this alert.

n Switch Port Tx Rate—In the Transform Function drop-down, select either absolute or percentage.
Select absolute to generate an alert if the data transmission rate of the port (in terms of Mbps) exceeds
the threshold value. Select percentage to generate an alert if the data transmission rate of the port (in
terms of utilization as a percentage of total bandwidth available) exceeds the threshold value. In the
Interface field, enter the interface name. You can add additional rule(s) for this alert.

n Switch Port Rx Rate—In the Transform Function drop-down, select either absolute or percentage.
Select absolute to generate an alert if the data reception rate of the port (in terms of Mbps) exceeds the
threshold value. Select percentage to generate an alert if the data reception rate of the port (in terms of
utilization as a percentage of total bandwidth available) exceeds the threshold value. In the Interface
field, enter the interface name. You can add additional rule(s) for this alert.

n Switch Port Input Errors—Generates an alert when the percentage of input errors on the port exceeds
the threshold value. In the Interface field, enter the interface name. You can add additional rule(s) for
this alert.

n Switch Port Output Errors—Generates an alert when the percentage of output errors on the port
exceeds the threshold value. In the Interface field, enter the interface name. You can add additional rule
(s) for this alert.

n Switch Port Duplex Mode—Generates an alert when the port is operating in half-duplex mode. In the
Interface field, enter the interface name.

n Switch PoE Utilization—Generates an alert when the PoE utilization for a port exceeds the critical and
major threshold value. This alert is enabled by default and the alert severity is Critical. You can add
additional rule(s) for this alert.

n Switch STP Root Change—Generates an alert when there is a change in the Spanning Tree Protocol
(STP) root. This alert is enabled by default and the alert severity isMajor.

n Stack Member Added/Removed—Generates an alert when a stack member is added or removed. This
alert is enabled by default and the alert severity isMajor.

n Switch Stack Commander Change—Generates an alert when there is a change in Stack commander.
This alert is enabled by default and the alert severity isMajor.

Gateway Alerts
Aruba Central allows network administrators and users with admin permissions to configure alerts.

Following are the SD-WAN and Gateway appliance-related alerts that you can configure:

n SLA DPS Compliance Violations—Generates an alert when the WAN policy does not meet the
compliance criteria.

n New Gateway Connected—Generates an alert when a new Branch Gateway is connected.
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n Gateway Disconnected—Generates an alert when a Branch Gateway is disconnected. When a gateway
disconnects because of license expiry, the alert description shows 'Reason: Device unlicensed'.

n Gateway CPU Utilization—Generates an alert when the Branch Gateway CPU utilization exceeds the
threshold value. You can add additional rule(s) for this alert.

n Gateway Memory Utilization—Generates an alert when the Branch Gateway memory utilization
exceeds the threshold value. You can add additional rule(s) for this alert.

n OSPF Session Error—Generates an alert when an OSPF session fails.
n BGP Session Error—Generates an alert when a BGP session fails.
n Gateway Base License Capacity Limit Exceeded—Generates an alert when a Gateway with

Foundation-Base Capacity subscription exceed the client capacity threshold.
n Routing Table Limit—Generates an alert when the routing table size exceeds the 90% of the capacity.

This alert is auto-acknowledged when the Routing table size goes below 85% of the capacity.
n BGP Neighbor Route Limit—Generates an alert when the number of routes received from a BGP

neighbor exceeds the configured limit. This alert is auto-acknowledged when the number of routes from
the BGP neighbor goes below the configured limit.

n Overlay Route Orchestrator Connection—Generates an alert when the control connection between
the Branch Gateway and the Overlay Route Orchestration (ORO) is down. This alert is auto-acknowledged
when the control connection is re-established.

n Gateway Cellular Data Usage—Generates an alert when the cellular data usage exceeds the threshold
value. You must set theData Usage alert limit and Billing start date in theUplink configuration
page for this alert to generate.

Note: This alert configuration is only applicable for 9004-LTE gateways that have an integrated LTE
modem.

n WAN Health-Check Failure—Generates an alert when WAN health check fails.
n WAN VPN-Peer Unreachable—Generates an alert when the WAN VPN peer is unreachable.
n WAN Uplink Status Change—Generates an alert when the WAN uplink status changes.
n WAN Uplink Autonegotiation State Change—Generates an alert when the WAN uplink automatic

negotiation status changes.
n WAN Uplink Input Errors—Generates an alert when the percentage of WAN uplink input errors exceed

the threshold value. In the Interface field, enter the interface name. You can add additional rule(s) for
this alert.

n WAN Uplink Output Errors—Generates an alert when the percentage WAN uplink output errors
exceed the threshold value. In the Interface field, enter the interface name. You can add additional rule
(s) for this alert.

n WAN Uplink PHY Errors—Generates an alert when the percentage WAN uplink PHY errors exceed the
threshold value. In the Interface field, enter the interface name. You can add additional rule(s) for this
alert.

n DHCP Pool Consumption Alert—Generates an alert when the percentage DHCP pool consumption
exceeds the threshold value. In the Subnet field, enter the subnet address to filter the alert based on
subnet.

n IPSec Establishment Failure—Generates an alert when the IPsec tunnel fails to establish.
n IPSec SA Down—Generates an alert when the IPsec SA is down.
n All IPSec SAs Down—Generates an alert when all the IPsec SAs are down.
n CFG-SET Advertisement Failure—Generates an alert when the CFG-SET advertisement fails.
n Uplink Flapping—Generates an alert when the uplink state changes frequently. In the Interface field,

enter the interface name. You can add additional rule(s) for this alert.
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n Tunnel Flapping—Generates an alert when the tunnel state changes frequently. In the Interface field,
enter the interface name. You can add additional rule(s) for this alert.

n Uplink Speed Flapping—Generates an alert when the uplink speed changes. In the Interface field,
enter the interface name. You can add additional rule(s) for this alert.

n EST Enrollment Failure—Generates an alert when the Virtual Gateway fails to enroll with the
EST server.

n VGW VM Down—Generates an alert when an Aruba Virtual Gateway deployed as a Virtual Machine is
down.

n Gateway Firmware Upgrade Failed—Generates an alert when there is a firmware upgrade failure.
n Gateway IDS/IPS Engine Error State—Generates an alert when the Gateway’s IDS/IPS Engine state is

either crashed or stopped. A severity of Critical indicates that the engine has crashed and Major
indicates that the engine has stopped.

n Gateway IDS IPS Engine CPU Utilization—Generates an alert when the CPU utilization by IDS/IPS
engine exceeds the threshold value and duration. You can add additional rule(s) for this alert.

n Gateway IDS IPS Engine Memory Utilization—Generates an alert when the memory utilization
exceeds the threshold value and duration. You can add additional rule(s) for this alert.

n Gateway IDS IPS Engine Packer Dropped Detected—Generates an alert every time when the
number of packets dropped exceeds the configured threshold value.

Currently, Aruba IDPS is supported only on 9004, 9012, and 9004-LTE Branch Gateways that have Security
license entitled to them.
Alerts that fall under WAN/ Tunnels/ DPS/ Routing/ Firewall are not applicable to Aruba Unified Network
Architecture deployments.

You can configure the following alerts for gateways running ArubaOS 8.0.x:

n Gateway Emergency Mode—Generates an alert when a gateway enters the emergency mode,
where all the uplinks are down and the backup uplink is activated.

n VPN Peer Failover—Generates an alert when all the tunnels from the gateway to the primary VPN
controller go down including via backup uplink and establishes a tunnel with the secondary VPN
controller.

You can configure and enable these alerts for gateways running other ArubaOS versions also. However,
these alerts will not be generated for gateways on versions other than ArubaOS 8.0.x.

Access Point Alerts
Aruba Central allows network administrators and users with admin permissions to configure alerts. For
more information, see Configuring Alerts.

Following are the IAP alerts that you can configure:

n New Virtual Controller Detected—Generates an alert when a new virtual controller is detected.
n Virtual Controller Disconnected—Generates an alert when a virtual controller is disconnected. This

alert is enabled by default and the alert severity is automatically set to Major. To customize the alert
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trigger, enter a duration in minutes, in theDuration field. By default, the trigger to generate the alert is
set to 10 minutes.

n New AP Detected—Generates an alert when a new Instant AP is detected.
n AP Disconnected—Generates an alert when an Instant AP is disconnected. This alert is enabled by

default and the alert severity is automatically set to Major. To customize the alert trigger, enter a
duration in minutes, in theDuration field. By default, the trigger to generate the alert is set to 15
minutes.

n Rogue AP Detected—Generates an alert when a rogue Instant AP is detected. This alert is enabled by
default and the alert severity isMajor.

n Infrastructure Attack Detected—Generates an alert when an infrastructure attack is detected.
n Client Attack Detected—Generates an alert when a client attack is detected.
n Uplink Changed—Generates an alert when an uplink has changed.
n Modem Unplugged—Generates an alert when the modem is unplugged.
n Modem Plugged—Generates an alert when the modem is plugged.
n AP CPU Utilization—Generates an alert when the Instant AP CPU utilization exceeds the threshold

value. In theDuration field, enter the duration after which the alert must be generated. You can add
additional rule(s) for this alert.

n AP Memory Utilization—Generates an alert when the Instant AP memory utilization exceeds the
threshold value. In theDuration field, enter the duration after which the alert must be generated. You
can add additional rule(s) for this alert.

n Insufficient Power Supplied—Generates an alert when the IAP is supplied with lesser power than the
required power.

n Radio Channel Utilization—Generates an alert when the Instant AP radio channel utilization exceeds
the threshold value. In theDuration field, enter the duration after which the alert must be generated.
From theBand drop-down, select the spectrum band: 2.4 GHz or 5 GHz. You can add additional rule(s)
for this alert.

n Radio Noise Floor—Generates an alert when the Noise Floor (dBm) exceeds the threshold value. In the
Duration field, enter the duration after which the alert must be generated. From theBand drop-down,
select the spectrum band: 2.4 GHz or 5 GHz. You can add additional rule(s) for this alert.

n Connected Clients per VC—Generates an alert when the number of connected clients to the VC
exceeds the threshold value. In theDuration field, enter the duration after which the alert must be
generated. You can add additional rule(s) for this alert.

n Connected Clients per AP— Generates an alert when the number of connected clients to the AP
exceeds the threshold value. You can enter the threshold value after which the alerts must be generated.
The recommended value is 15 minutes and above. You can add additional rule(s) for this alert.

n Radio Frames Retry Percent—Generates an alert when the Instant AP radio frames retry percent
exceeds the threshold value. In theDuration field, enter the duration after which the alert must be
generated. From theBand drop-down, select the spectrum band: 2.4 GHz or 5 GHz. You can add
additional rule(s) for this alert.

n IAP Firmware Upgrade Failed—Generates an alert when there is any Instant AP upgrade failure such
as, no firmware image is available or there is no response from the device.

Connectivity Alerts
Aruba Central allows network administrators and users with admin permissions to configure alerts. For
more information, see Configuring Alerts.

Following are the connectivity alerts that you can configure:
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n DNS Delay Detected—Generates an alert when clients experience significant delays in response from
the DNS server. Set the severity values to generate an alert if the percentage of delay from the DNS
server exceeds the threshold value. TheDuration field displays the duration after which the alert is
generated. The default value is 30 minutes. You can add additional rule(s) for this alert.

n DNS Failure Detected—Generates an alert when wireless APs experience a high number of connection
failures with the DNS server. Set the severity values to generate an alert if the DNS failure percentage
exceeds the threshold value. TheDuration field displays the duration after which the alert is generated.
The default value is 30 minutes. You can add additional rule(s) for this alert.

n DHCP Delay Detected—Generates an alert when there is excessive DHCP delay from client to AP in the
network. Set the severity values to generate an alert if the percentage of the DHCP delay exceeds the
threshold value. TheDuration field displays the duration after which the alert is generated. The default
value is 30 minutes. You can add additional rule(s) for this alert.

n DHCP Failure Detected—Generates an alert when there is high number of DHCP failure observed from
client to AP in the network. Set the severity values to generate an alert if the DHCP failure percentage
exceeds the threshold value. TheDuration field displays the duration after which the alert is generated.
The default value is 30 minutes. You can add additional rule(s) for this alert.

n Authentication Delay Detected—Generates an alert when there is excessive delay in the client
authentication process with the AP in the network. Authentication failures include the following:

l Wi-Fi security key-exchange failures

l 802.1x authentication failures

l MAC authentication failures

l Captive failures

Set the severity values to generate an alert if the percentage of the authentication delay exceeds the
threshold value. TheDuration field displays the duration after which the alert is generated. The default
value is 30 minutes. You can add additional rule(s) for this alert.

n Authentication Failure Detected—Generates an alert when there are high number of client
authentication failures in the network. Authentication failures include the following:

l Wi-Fi security key-exchange failures

l 802.1x authentication failures

l MAC authentication failures

l Captive failures

Set the severity values to generate an alert if the authentication failure percentage exceeds the threshold
value. TheDuration field displays the duration after which the alert is generated. The default value is 30
minutes. You can add additional rule(s) for this alert.

n Association Delay Detected—Generates an alert when client association delay is detected in the
network. Set the severity values to generate an alert if the percentage of the association delay exceeds
the threshold value. TheDuration field displays the duration after which the alert is generated. The
default value is 30 minutes. You can add additional rule(s) for this alert.

n Association Failure Detected—Generates an alert when client association failure is detected in the
network. Set the severity values to generate an alert if the association failure percentage exceeds the
threshold value. TheDuration field displays the duration after which the alert is generated. The default
value is 30 minutes. You can add additional rule(s) for this alert.

WAN Health Alerts
Aruba Central allows network administrators and users with admin permissions to configure alerts. For
more information, see Configuring Alerts.
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Following are the WAN health related alerts that you can configure:

n Application Unreachable—Generates an alert when the application is not reachable.
n High Latency Detected—Generates an alert when high latency is detected.
n Low Download Rate Detected—Generates an alert when the download rate over the WAN network is

detected to be low.
n Low Upload Bandwidth Detected—Generates an alert when the upload bandwidth over the WAN

network is detected to be low.
n Low Download Bandwidth Detected—Generates an alert when the download bandwidth over the

WAN network is detected to be low.
n High Download Packet Loss Detected—Generates an alert when there is a high download packet loss

over the WAN network.
n High Download Jitter Detected—Generates an alert when there is a high download jitter detected.
n High Connection Time Detected—Generates an alert when the connection time to the WAN network

is high.
n Health Check Failed—Generates an alert when the health check fails.
n High Upload Packet Loss Detected—Generates an alert when there is a high upload packet loss

detected.
n High Upload Jitter Detected—Generates an alert when there is a high upload jitter detected.

Audit Alerts
Aruba Central allows administrators to enable alerts for configuration changes at group level. TheConfig
Change Detected alert is underAudit tab. Configuration change alerts are intended for administrators
handling large distributed network. For more information on how to configure alerts, see Configuring Alerts.
Audit alerts are triggered under the following scenarios:

n Create New Template
n Update Existing Template
n Variable Upload

l Device Level: Sends an alert with additional parameters such as serial number and MAC address of the
device.

l Group Level: Sends an alert with respective group name.

l Configuration restore
n Configuration change at Device Level
n Configuration change at Group Level

The alert content includes the following information:

n Group Name
n Device Type
n User ID
n Config Change
n Device Serial number and MAC Address

The following table describes the behavior of the alert and alert content depending on the user action,



Alerts & Events | 733

User Action Group Name Device Type User ID Config
Change

Device
Serial/
MAC

Created a template Template group
name

IAP/ Switch.
Gateway

User ID No Content NO

Updated existing
template

Template group
name

IAP/ Switch/
Gateway

User ID Changed
content is
displayed

NO

Uploaded variable
at device level

Group name to
which the device
belongs

IAP/ Switch/
Gateway

User ID No Content YES

Uploaded variable
at group level

Template group
name

IAP/ Switch/
Gateway

User ID No Content NO

Made configuration
at the device level

Group name to which
the device belongs

IAP/ Switch/
Gateway

User ID Changed
content is
displayed

YES

Made configuration
change at the
group level

UI group name IAP/ Switch/
Gateway

User ID Changed
content is
displayed

NO

Table 188: Config Alert Behavior

Site Alerts
Aruba Central allows you to configure and enable this alert for aggregated device disconnections. For more
information on how to configure alerts, see Configuring Alerts.

TheAggregated Device Disconnections alert is under Site tab. It is intended to reduce the number of
alerts that are generated for customers that prefer to have a single notification or a handful of notifications
for mass outages where several devices may go down simultaneously in a given site.

For example, if site alerts are configured with Severity as Major,Duration being 10 minutes, and Site as
site1, a single alert saying “Aggregated Device Disconnects” is raised on the user interface for every set of
device belonging to “site1” that goes down within 10 minutes of the first DOWN event limited to 100
devices per alert. Any device that is not a part of “site1” is treated as not being aggregated.

The alert content includes the following information for each device:

n Hostname
n Device Serial Number
n MAC Address
n IP Address

Unlike other alerts types, site alerts will not be auto closed.

Adding Default Recipients
To set default recipients for alert notification, complete the following procedure:
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1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Alerts & Events.

TheAlerts & Events page is displayed in the List view.

3. In theAlerts & Events page, click theConfig icon.

TheAlert Severities & Notifications is displayed.

4. In theAlert Severities & Notifications page, click Default Recipients.

TheDefault Recipients dialog box is displayed.

5. Click the + icon to add the email address that you want add as a default recipient to receive
notifications when an alert is generated.

You can add multiple email addresses as required.

6. Click Save.

 You can also delete the existing email addresses that is already added as default recipients.

Suppressing Alerts
Suppressing alerts for a particular site prevents all devices within the site from generating alert notifications.
You can enable alert suppression only at the Site level.

To suppress alerts, complete the following procedure:

1. In theNetwork Operations app, use the filter to select a Site.

The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Alerts & Events.

TheAlerts & Events page is displayed in the List view.

3. In theAlerts & Events page, click theConfig icon.

TheAlert Notifications screen is displayed.

4. Enable the Suppress Alerts toggle button.

The Suppress Alerts dialog box is displayed for confirmation.

5. Click Suppress Alerts.
6. Click Save.

Viewing Enabled Alerts
To view alerts that you have enabled, complete the following procedure:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Alerts & Events.

TheAlerts & Events page is displayed in the List view.

3. In theAlerts & Events page, click theConfig icon.

TheAlert Severities & Notifications is displayed.
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4. In theAlert Severities & Notifications page, click Enabled.

Use the tabs to navigate between the alert categories. The alerts enabled for each category are
displayed in the respective tabs.

Supported Access Point Events
Aruba Central provides an Events dashboard for viewing the events triggered from access points, clients,
switches, and gateways.

The following table lists the access point events that are supported in Aruba Central:

Event Description

AP IP Conflict IP Conflict detected for IP [Device IP] to MAC [Device MAC].

AP Upgrade Failure Upgrade failure.

AP Insufficient Power Supply Received low POE power.

AP Modem Plugged Modem plugged.

AP Modem Unplugged Modem unplugged.

AP User Reboot User reboot triggered.

AP Tri-Radio Enabled Access point is online with tri-radio mode enabled.

AP Tri-Radio Disabled Access point is online with tri-radio mode disabled.

AP Thermal Shutdown Event Thermal management enabled.

AP Thermal Shutdown Recovery Event Thermal management disabled.

Radio Radar Detected 802.11 Radar detected on channel [Channel].

Radio Radar Cleared 802.11 Radar cleared on channel [Channel].

Radio Tx Hang 802.11 Radio Tx hanged on channel [Channel].

Radio Tx Clear 802.11 Radio Tx cleared on channel [Channel].

Radio 40MHz Intolerance 40MHz Intolerance observed on channel [Channel].

Radio Cancel 40MHz Intolerance 40MHz Intolerance cleared on channel [Channel].

Radio 40MHz Align 40MHz aligned on channel [Channel].

Radio ARM Interference ARM Interference detected on channel [Channel].

Radio ARM Invalid Channel ARM invalid channel [Channel].

Radio ARM Error Threshold Exceeded Radio errors threshold exceeded on channel [Channel].

Radio ARM Noise Threshold Exceeded Radio noise threshold exceeded.

Table 189: Access Point Events
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Event Description

Radio ARM Empty Channel ARM empty channel.

Radio ARM Rogue Containment
Triggered

Rogue containment triggered.

Radio ARM Decreased Power Radio output power decreased to [EIRP] dBm.

Radio ARM Increased Power Radio output power increased to [EIRP] dBm.

Radio RADAR Turn Off Radio Radar detected radio up.

Radio ARM Turn On Radio Radar detected radio down.

Radio ARM Channel Quality Threshold
Exceeded

Radio channel quality threshold exceeded

Radio ARM Dynamic BW Channel width set to channel [Channel].

Radio ARM Interference CCA Channel width set to channel [Channel].

Radio Freeze Radio stopped service.

Radio Un-Freeze Radio resumed service.

Mesh Link Up Mesh link established to Portal [Portal Device MAC].

Mesh Link Down Mesh link to Portal [Portal Device MAC] is down.

VPN IPSec Tunnel Up VPN IPSec Tunnel to Gateway peer [Peer Device Hostname] ([Peer
Device IP]) is up.

VPN IPSec Tunnel Down VPN IPSec Tunnel to Gateway peer [Peer Device Hostname] ([Peer
Device IP]) is down.

VPN GRE Tunnel Up VPN L3 GRE Tunnel to Gateway peer [Peer Device Hostname] ([Peer
Device IP]) is up.

VPN GRE Tunnel Down VPN L3 GRE Tunnel to Gateway peer [Peer Device Hostname] ([Peer
Device IP]) is down.

WLAN SSID Scheduled Active SSID [SSID] scheduled activation.

WLAN SSID Scheduled De-active SSID [SSID] scheduled deactivation.

Supported Client Events
Aruba Central provides an Events dashboard for viewing the events triggered from access points, clients,
switches, and gateways.

The following table lists the client events that are supported in Aruba Central:
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Event Description

Client 802.11
Association
Reject

802.11 Association rejected for client [Client MAC] to BSSID [BSSID] on channel [Channel] of AP
hostname [Device Hostname].

Client 802.11
Disassociation
to Client

802.11 Disassociation sent to client [Client MAC] from BSSID [BSSID] on channel [Channel] of
AP hostname [Device Hostname].

Client 802.11
Disassociation
from Client

802.11 Disassociation received from client [Client MAC] associated to BSSID [BSSID] on
channel [Channel] of AP hostname [Device Hostname].

Client 802.11
Authentication
Failure

802.11 Authentication failed for client [Client MAC] on BSSID [BSSID] on channel [Channel] of
AP hostname [Device Hostname].

Client 802.11
De-
authentication
to Client

De-authentication sent to client [Client MAC] from BSSID [BSSID] on channel [Channel] of AP
hostname [Device Hostname].

Client 802.11
De-
authentication
from Client

De-authentication sent from client [Client MAC] associated to BSSID [BSSID] on channel
[Channel] of AP hostname [Device Hostname].

Client
Roaming
Success

Client [Client MAC] associated to BSSID [From BSSID (roamed from)] on channel [From Channel
(roamed from)] of AP hostname [From Device Hostname (roamed from)] roamed successfully to
BSSID [BSSID] on channel [Channel] of AP hostname [Device Hostname].

Client MAC
Authentication
Reject

MAC Authentication failed for client [Client MAC] to Radius Server [Radius Server IP] through
BSSID [BSSID] on channel [Channel] of AP hostname [Device Hostname].

Client 802.1x
Radius Reject

802.1x Radius Reject received for client [Client MAC] on BSSID [BSSID] on channel [Channel] of
AP hostname [Device Hostname].

Client 802.1x
Radius
Timeout

802.1x Radius Timeout occurred for client [Client MAC] on BSSID [BSSID] on channel [Channel]
of AP hostname [Device Hostname].

Client Captive
Portal
Authentication
Failure

Captive Portal failure occurred for client [Client MAC] associated to BSSID [BSSID] of AP
hostname [Device Hostname].

Client EAP
Failure

EAP failure occurred for client [Client MAC] associated to BSSID [BSSID] on channel [Channel]
of AP hostname [Device Hostname].

Client EAP
Timeout from
Client

EAP response from client [Client MAC] associated to BSSID [BSSID] on channel [Channel] of AP
hostname [Device Hostname] timed out.

Client VoIP
Call Start

VoIP call initiated from station [Source Client Name] ([Source Client IP]) to station [Destination
Client Name] ([Destination Client IP]) on AP hostname [Device Hostname].

Table 190: Client Events



Aruba Central | User Guide 738

Event Description

Client VoIP
Call Stop

VoIP call terminated from station [Source Client Name] ([Source Client IP]) to station
[Destination Client Name] ([Destination Client IP]) on AP hostname [Device Hostname].

Client DHCP
Acknowledged

DHCP acknowledgment received from DHCP server [DHCP Server IP] for client [Client MAC]
([Client IP]) associated to BSSID [BSSID] on channel [Channel] of AP hostname [Device
Hostname].

Client DHCP
Not
Acknowledged

DHCP NACK to DHCP server [DHCP Server IP] from client [Client MAC] ([Client IP]) associated to
BSSID [BSSID] on channel [Channel] of AP hostname [Device Hostname].

Client DHCP
Declined

DHCP declined from DHCP server [DHCP Server IP] for client [Client MAC] ([Client IP])
associated to BSSID [BSSID] on channel [Channel] of AP hostname [Device Hostname].

Client DNS
Failure

DNS failure to [Domain Name] detected for client [BSSID] on BSSID [BSSID] of AP hostname
[Device Hostname].

Client DHCP
Timeout

DHCP request to DHCP server [DHCP Server IP] from client [Client MAC] timed out.

Client
Blacklisted

Blacklisted client [Client MAC] on AP hostname [Device Hostname] for SSID [SSID name].

Client Fast
Roaming
Failure

Fast Roaming failed for client [Client MAC] with roaming type [Roaming Type] on AP hostname
[Device Hostname].

Client
Roaming
Success

Client [Client MAC] roamed successfully to SSID [SSID name] on channel [Channel] of AP
hostname [Device Hostname].

Client Match
Steer Attempt

Client match attempted a [Steer Type] using [Steer Mode] for client [Client MAC] from radio
BSSID [From BSSID] to radio BSSID [To BSSID] with result: [Steer Result].

Client Match
Steer Reject

Client match attempted a [Steer Type] using [Steer Mode] for client [Client MAC] from radio
BSSID [From BSSID] to radio BSSID [To BSSID] which was rejected by the client with reason
code [802.11v Move Result].

Client Match
Steer Wrong
Destination

Client match attempted a [Steer Type] using [Steer Mode] for client [Client MAC] from radio
BSSID [From BSSID] to radio BSSID [To BSSID] which resulted in the client moving to a different
radio BSSID [Destination Radio BSSID].

Webhooks
Webhooks allow you to implement event reactions by providing real-time information or notifications to
other applications. Aruba Central allows you to create Webhooks and select Webhooks as the notification
delivery option for all alerts.

Using Aruba Central, you can integrate Webhooks with other third-party applications such as ServiceNow,
Zapier, IFTTT, and so on.

You can access the Webhooks service either through the Aruba Central UI or API Gateway. Aruba Central
supports creating up to 10 Webhooks. To enable redundancy, Aruba Central allows you to add up to three
URLs per Webhook.

From Aruba Central, you can add, list, or delete Webhooks; get or refresh Webhooks token; get or update
Webhooks settings for a specific item; and test Webhooks notification.

This section includes the following topics:
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n Creating and Updating Webhooks Through the UI
n Refreshing Webhooks Token Through the UI
n Creating and Updating Webhooks Through the API Gateway
n List of Webhooks APIs
n Sample Webhooks Payload Format for Alerts

In theAlerts & Events page, click theConfiguration icon to configure and enable an alert. In the
Notification Options, select Webhooks as the notification delivery option.

The following figure illustrates how Aruba Central integrates with third-party applications using Webhooks.

Figure 139 Webhooks Integration

Creating and Updating Webhooks Through the UI
To access the Webhooks service from the UI:

1. In theAccount Home page, underGlobal Settings, click Webhooks.TheWebhooks page is
displayed.

2. In theWebhook tab, click + sign. TheAdd Webhook pop-up window is displayed.
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a. Name—Enter a name for the Webhook

b. Retry Policy— Select one of the following options:

n None—No retries.
n Important—Up to 5 retries over 6 minutes.
n Critical—Up to 5 retries over 27 hours.

a. URLs—Enter the URL. Click + to enter another URL. You can add up to three URLs.

1. Click Save. The Webhooks is created and listed in theWebhook table.

TheWebhook table displays the following information and also allows you to edit or delete Webhooks:

n Name—Name of the Webhooks.
n Number of URL Entries—Number of URLs in Webhooks. Click the number to view the list of URLs.
n Updated At—Date and time at which Webhooks was updated.
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n Webhook ID—Webhooks ID.
n Token—Webhooks token. Webhooks token enables header authentication and the third-party receiving

service must validate the token to ensure authenticity.
n Edit—Select the Webhook from the list and click the Edit icon to edit the Webhook. You can refresh the

token and add URLs. Click Save to save the changes.
n Delete—Select the Webhook from the list and click the Delete icon and click Yes to delete the

Webhook.
n Test Webhooks—Select the Webhook from the list and click the Test Webhooks icon to test the

Webhook by posting sample webhook payload to the configured URL. The Test Webhooks table
provides theURL and Status of the selected Webhook.

n View Dispatch Logs—Select the Webhook from the list and click theView Dispatch Log icon to view
theDispatch Logs for the selected Webhook. TheDispatch Logs table provides theURL, Status, and
Dispatched Time. Click the arrow against each row to view the Log Details and Attempts in the drop-
down for the respective URL.

Refreshing Webhooks Token Through the UI
To refresh Webhooks token through the UI:

1. In theAccount Home page, underGlobal Settings, click Webhooks.TheWebhooks page is
displayed.

2. In theWebhook table, select the Webhook from the list and click Edit icon to edit.
3. In the pop-up window, click theRefresh icon next to the token. The token is refreshed.

Creating and Updating Webhooks Through the
API Gateway
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The following HTTP methods are defined for Aruba Central API Webhooks resource:

n GET
n POST
n PUT
n DELETE

You can perform CRUD operation on the Webhooks URL configuration. The key configuration elements that
are required to use API Webhooks service are Webhooks URL and a shared secret.

A shared secret token is generated for the Webhooks URL when you register for Webhooks. A hash key is
generated using SHA256 algorithm by using the payload and the shared secret token. The API required to
refresh the shared secret token is provided for a specific Webhooks configuration. You can choose the
frequency at which you want to refresh the secret token.

To access and use the API Webhooks service:

1. In theAccount Home page, underGlobal Settings, click API Gateway.TheAPI Gateway page is
displayed.

2. In theAPIs tab, click the Swagger link under theDocumentation header. The Swagger website
opens.

3. In the Swagger website, from theURL drop-down list, select Webhook. All available Webhooks APIs
are listed underAPI Reference.

For more information on Webhooks APIs, refer to https://app1-
apigw.central.arubanetworks.com/swagger/central.

List of Webhooks APIs
Aruba Central supports the following Webhooks APIs:

n GET /central/v1/webhooks—Gets a list of Webhooks.

The following is a sample response:

{

"count": 1,

"settings": [

{

"wid": "e26450be-4dac-435b-ac01-15d8f9667eb8",

"name": "AAA",

"updated_ts": 1523956927,

"urls": [

"https://example.org/webhook1",

"https://example.org/webhook1"

],

"secure_token": "KEu5ZPTi44UO4MnMiOqz"

}

]

}

n POST /central/v1/webhooks—Creates Webhooks.

The following is a sample response:

https://app1-apigw.central.arubanetworks.com/swagger/central
https://app1-apigw.central.arubanetworks.com/swagger/central
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{

"name": "AAA",

"wid": "e829a0f6-1e36-42fe-bafd-631443cbd581"

}

n DELETE /central/v1/webhooks/{wid}—Deletes Webhooks.

The following is a sample response:

{

"wid": "e26450be-4dac-435b-ac01-15d8f9667eb8"

}

n GET /central/v1/webhooks/{wid}—Gets Webhooks settings for a specific item.

The following is a sample response:

{

"wid": "e26450be-4dac-435b-ac01-15d8f9667eb8",

"name": "AAA",

"updated_ts": 1523956927,

"urls": [

"https://example.org/webhook1",

"https://example.org/webhook1"

],

"secure_token": "KEu5ZPTi44UO4MnMiOqz"

}

n PUT /central/v1/webhooks/{wid}—Updates Webhooks settings for a specific item.

The following is a sample response:

{

"name": "AAA",

"wid": "e829a0f6-1e36-42fe-bafd-631443cbd581"

}

n GET /central/v1/webhooks/{wid}/token—Gets the Webhooks token for the Webhooks ID.

The following is a sample response:

{

"name": "AAA",

"secure_token": "[{\"token\": \"zSMrzuYrblgBfByy2JrM\", \"ts\": 1523957233}]"

}

n PUT /central/v1/webhooks/{wid}/token—Refreshes the Webhooks token for the Webhooks ID.

The following is a sample response:
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{

"name": "AAA",

"secure_token": "[{\"token\": \"zSMrzuYrblgBfByy2JrM\", \"ts\": 1523957233}]"

}

n GET /central/v1/webhooks/{wid}/ping—Tests the Webhooks notification and returns whether
success or failure.

The following is a sample response:

"Ping Response [{'url': 'https://example.org', 'status': 404}]"

Sample Webhooks Payload Format for Alerts
URL POST <webhook-url>

Custom Headers
Content-Type: application/json

X-Central-Service: Alerts

X-Central-Event: Radio-Channel-Utilization

X-Central-Delivery-ID: 72d3162e-cc78-11e3-81ab-4c9367dc0958

X-Central-Delivery-Timestamp: 2016-07-12T13:14:19-07:00

X-Central-Customer-ID: <########>

Refer to the following topics to view sample JSON content:

n Access Point Alerts—Sample JSON
n Switch Alerts—Sample JSON
n Gateway Alerts—Sample JSON
n Miscellaneous Alerts—Sample JSON

Access Point Alerts—Sample JSON
This section includes sample JSON content for the following alerts:

AP Disconnected
{

"alert_type": "AP disconnected",

"description": "AP with Name 84:d4:7e:c5:c8:8c and MAC address 84:d4:7e:c5:c8:8c

disconnected, Group:unprovisioned",

"timestamp": 1564326129,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-4",

"state": "Open",

"nid": 4,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"conn_status": "disconnected",

"params": [

"84:d4:7e:c5:c8:8c",

"84:d4:7e:c5:c8:8c"

],

"time": "2019-07-28 15:02:09 UTC"
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},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm2zVQO1ZtiGF20e",

"severity": "Critical"

}

AP Connected Clients
{

"alert_type": "AP_CONNECTED_CLIENTS",

"description": "Number of Clients connected to AP with name 84:d4:7e:c5:c8:8c has been

above 1 for about 5 minutes

since 2019-07-29 12:26:00 UTC.",

"timestamp": 1564326128,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-1255",

"state": "Open",

"nid": 1255,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"name": "84:d4:7e:c5:c8:8c",

"duration": "5",

"threshold": "1",

"time": "2019-07-28 15:02:08 UTC"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm1zVGH9ZtiGF20d",

"severity": "Major"

}

AP CPU Over Utilization
{

"alert_type": "AP_CPU_OVER_UTILIZATION",

"description": "CPU utilization for AP 84:d4:7e:c5:c8:8c with serial CT0779239 has been

above 10% for about 5 minutes

since 2019-07-28 14:21:00 UTC.",

"timestamp": 1564323960,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-1250",

"state": "Open",

"nid": 1250,

"details": {

"_rule_number": "0",

"group": "1",

"name": "84:d4:7e:c5:c8:8c",

"duration": "5",

"time": "2019-07-28 14:21:00 UTC",

"threshold": "10",

"ds_key": "201804170291.CT0779239.cpu_utilization.5m",

"serial": "CT0779239",

"unit": "%"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw4-VVrVQO1ZtiGFkZ3",

"severity": "Critical"

}

AP Memory Over Utilization
{
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"alert_type": "AP_MEMORY_OVER_UTILIZATION",

"description": "Memory utilization for AP iap-303-iphone456-offline with serial

CNGHKGX004 has been above 40% for about 5 minutes

since 2019-07-24 07:11:00 UTC.",

"timestamp": 1563952560,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-1251",

"state": "Open",

"nid": 1251,

"details": {

"_rule_number": "1",

"group": "3",

"name": "iap-303-iphone456-offline",

"labels": "3,118",

"duration": "5",

"time": "2019-07-24 07:11:00 UTC",

"threshold": "40",

"ds_key": "201804170291.CNGHKGX004.memory_utilization.5m",

"serial": "CNGHKGX004",

"unit": "%"

},

"operation": "create",

"device_id": "CNGHKGX004",

"id": "AWwi1jihVQO1ZtiGThDA",

"severity": "Major"

}

AP Radio Noise Floor
{

"alert_type": "AP_RADIO_NOISE_FLOOR",

"description": "Noise floor on AP iap-303-iphone456-offline operating on Channel 10 and

serving 0 clients has been above -110 dBm

for about 10 minutes since 2019-07-24 07:06:00 UTC.",

"timestamp": 1563952560,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-1253",

"state": "Open",

"nid": 1253,

"details": {

"_rule_number": "0",

"group": "3",

"name": "iap-303-iphone456-offline",

"_radio_num": "1",

"client_count": "0",

"labels": "3,118",

"_band": "0",

"duration": "10",

"time": "2019-07-24 07:06:00 UTC",

"threshold": "110",

"ds_key": "201804170291.CNGHKGX004.radio.noisefloor",

"serial": "CNGHKGX004",

"channel": "10"

},

"operation": "create",

"device_id": "CNGHKGX004",

"id": "AWwi1jjgVQO1ZtiGThDB",

"severity": "Critical"

}

AP Radio Over Utilization
{

"alert_type": "AP_RADIO_OVER_UTILIZATION",

"description": "Radio utilization on AP 84:d4:7e:c5:c8:8c operating on Channel 36E and
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serving 0 clients has been above 1%

for about 5 minutes since 2019-07-28 14:31:00 UTC.",

"timestamp": 1564324560,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-1252",

"state": "Open",

"nid": 1252,

"details": {

"_rule_number": "0",

"group": "1",

"name": "84:d4:7e:c5:c8:8c",

"_radio_num": "0",

"client_count": "0",

"_band": "1",

"duration": "5",

"unit": "%",

"time": "2019-07-28 14:31:00 UTC",

"threshold": "1",

"ds_key": "201804170291.CT0779239.radio.busy64",

"serial": "CT0779239",

"channel": "36E"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5An08VQO1ZtiGFpgm",

"severity": "Critical"

}

Client Attack detected
{

"alert_type": "Client attack detected",

"description": "An AP (NAME iap-303-iphone456-o and MAC 90:4c:81:cf:27:74 on RADIO 1)

detected an unencrypted frame

between a valid client (88:63:df:bb:2a:9d) and access point (BSSID 90:4c:81:72:77:55)

with source 88:63:df:bb:2a:9d

and receiver ff:ff:ff:ff:ff:ff SNR value is 55",

"timestamp": 1564392710,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-13",

"state": "Open",

"nid": 13,

"details": {

"group": "3",

"labels": "3,142,141",

"params": "None",

"_rule_number": "0",

"time": "2019-07-29 09:31:50 UTC"

},

"operation": "create",

"device_id": "CNGHKGX004",

"id": "AWw9EmBxVQO1ZtiGO1Q8",

"severity": "Critical"

}

Connected Clients
{

"alert_type": "CONNECTED_CLIENTS",

"description": "Number of Clients connected to swarm with name SetMeUp-CA:35:56 has been

above 1 for about 5 minutes

since 2019-07-29 12:26:00 UTC.",

"timestamp": 1564403460,

"webhook": "68612ee3-3ee9-4da4-b07b-13977a350344",

"setting_id": "b8be21720dc04a8e9f0028374b6a9bbd-1254",

"state": "Open",
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"nid": 1254,

"details": {

"_rule_number": "0",

"group": "1",

"name": "SetMeUp-CA:35:56",

"duration": "5",

"aggr_context": "swarm",

"time": "2019-07-29 12:26:00 UTC",

"threshold": "1",

"ds_key": "b8be21720dc04a8e9f0028374b6a9bbd.cluster.156.device.clients.5m",

"serial": "156"

},

"operation": "create",

"device_id": "156",

"id": "AWw9tmhNVQO1ZtiGQR5U",

"severity": "Critical"

}

Infrastructure Attack Detected
{

"alert_type": "Infrastructure attack detected",

"description": "An AP (NAME iap-303-iphone456-o and MAC 90:4c:81:cf:27:74 on RADIO 1)

detected that the Access Point with

MAC f0:5c:19:23:56:10 and BSSID f0:5c:19:23:56:10 has sent a beacon for SSID tan This

beacon advertizes channel 149

but was received on channel 161 with SNR 50 ",

"timestamp": 1564400165,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-12",

"state": "Open",

"nid": 12,

"details": {

"group": "3",

"labels": "3,142,141",

"params": "None",

"_rule_number": "0",

"time": "2019-07-29 11:36:05 UTC"

},

"operation": "create",

"device_id": "CNGHKGX004",

"id": "AWw9hCLAVQO1ZtiGP1ig",

"severity": "Critical"

}

Insufficient Power Alert
{

"alert_type": "INSUFFICIENT_POWER_ALERT",

"description": "Insufficient inline power supplied to AP-205 with name

04:bd:88:c3:b6:f0",

"timestamp": 1564403450,

"webhook": "68612ee3-3ee9-4da4-b07b-13977a350344",

"setting_id": "b8be21720dc04a8e9f0028374b6a9bbd-21",

"state": "Open",

"nid": 21,

"details": {

"group": "0",

"name": "04:bd:88:c3:b6:f0",

"labels": [],

"label_site_desc": "",

"time": "2019-07-29 12:30:50 UTC",

"serial": "CM0381143",

"group_name": "default",

"ap_model": "AP-205"

},

"operation": "create",
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"device_id": "CM0381143",

"id": "AWw9tkNGVQO1ZtiGQRz-",

"severity": "Major"

}

Modem Plugged
{

"alert_type": "Modem Plugged",

"description": "Modem plugged to ap with name 84:d4:7e:c5:c8:8c'and MAC address

84:d4:7e:c5:c8:8c",

"timestamp": 1564326128,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-18",

"state": "Open",

"nid": 18,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"params": [

"84:d4:7e:c5:c8:8c",

"84:d4:7e:c5:c8:8c"

],

"time": "2019-07-28 15:02:08 UTC"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm1zJKL90tiGF20d",

"severity": "Critical"

}

Modem Unplugged
{

"alert_type": "Modem Unplugged",

"description": "Modem unplugged from ap with name 84:d4:7e:c5:c8:8c'and MAC address

84:d4:7e:c5:c8:8c",

"timestamp": 1564326128,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-19",

"state": "Open",

"nid": 19,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"params": [

"84:d4:7e:c5:c8:8c",

"84:d4:7e:c5:c8:8c"

],

"time": "2019-07-28 15:02:08 UTC"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm1zVQO1ZtiGF20d",

"severity": "Critical"

}

New AP Detected
{

"alert_type": "New AP detected",

"description": "New AP with Name 84:d4:7e:c5:c8:8c and MAC address 84:d4:7e:c5:c8:8c

detected, Group:unprovisioned",

"timestamp": 1564326128,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",
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"setting_id": "201804170291-3",

"state": "Open",

"nid": 3,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"params": [

"84:d4:7e:c5:c8:8c",

"84:d4:7e:c5:c8:8c"

],

"time": "2019-07-28 15:02:08 UTC"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm1zVQO1ZtiJH56e",

"severity": "Major"

}

New Virtual Controller Detected
{

"alert_type": "New Virtual Controller detected",

"description": "New Virtual Controller with Name SetMeUp-CA:51:D6, Version 8.4.0.0_69847

and IP address 10.29.43.70

detected, Group:unprovisioned",

"timestamp": 1564326128,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-1",

"state": "Open",

"nid": 1,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"params": [

"SetMeUp-CA:51:D6",

"8.4.0.0_69847",

"10.29.43.70"

],

"time": "2019-07-28 15:02:08 UTC"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm1zVQO1ZtiJH56j",

"severity": "Critical"

}

Rogue AP Detected
{

"alert_type": "Rogue AP detected",

"description": "An AP (NAME 84:d4:7e:c5:c8:8c and MAC address 84:d4:7e:c5:c8:8con RADIO

1) detected an access point

(BSSID 0c:00:01:34:69:62 and SSID ssid1 on CHANNEL 52) as rogue",

"timestamp": 1564326128,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-10",

"state": "Open",

"nid": 10,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"params": [

"84:d4:7e:c5:c8:8c",
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"84:d4:7e:c5:c8:8c",

"1",

"0c:00:01:34:69:62",

"ssid1",

"52"

],

"time": "2019-07-28 15:02:08 UTC"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm1zVQO1ZtiJK89l",

"severity": "Critical"

}

Uplink Changed
{

"alert_type": "Uplink Changed",

"description": "Uplink changed from 0 to 1 for ap'with name {params[2]} and MAC address

{params[3]}",

"timestamp": 1564326128,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-17",

"state": "Open",

"nid": 17,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"params": [

"0",

"1",

"84:d4:7e:c5:c8:8c",

"84:d4:7e:c5:c8:8c"

],

"time": "2019-07-28 15:02:08 UTC"

},

"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm1zVQO1ZtiGF20d",

"severity": "Critical"

}

Virtual Controller Disconnected
{

"alert_type": "Virtual controller disconnected",

"description": "Virtual Controller with Name SetMeUp-CA:51:D6, Version 8.4.0.0_69847 and

IP address 10.29.43.70

disconnected, Group:unprovisioned",

"timestamp": 1564326128,

"webhook": "780c65a0-10b6-4eb1-b725-21b0d52aa432",

"setting_id": "201804170291-2",

"state": "Open",

"nid": 2,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"conn_status": "disconnected",

"params": [

"SetMeUp-CA:51:D6",

"8.4.0.0_69847",

"10.29.43.70"

],

"time": "2019-07-28 15:02:08 UTC"

},
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"operation": "create",

"device_id": "CT0779239",

"id": "AWw5Gm1zVQO1ZtiGF20d",

"severity": "Critical"

}

Switch Alerts—Sample JSON
This section includes sample JSON content for the following alerts:

Switch Disconnected
{

"alert_type": "Switch Disconnected",

"description": "Switch with serial CN8AHKW095, MAC address 54:80:28:b8:f6:20 IP address

10.22.41.3 and

Hostname Aruba-2930F-24G-PoEP-4SFPP disconnected, Group:unprovisioned",

"timestamp": 1569475139,

"webhook": "f8b021a2-8127-4c28-a755-8ee6e01ada66",

"setting_id": "e344d961bccd411dbd279bf92f61b989-203",

"state": "Open",

"nid": 203,

"details": {

"_rule_number": "0",

"group": "1",

"labels": "",

"conn_status": "disconnected",

"params": [

"CN8AHKW095",

"54:80:28:b8:f6:20",

"10.22.41.3",

"Aruba-2930F-24G-PoEP-4SFPP"

],

"time": "2019-09-26 05:18:59 UTC"

},

"operation": "create",

"device_id": "CN8AHKW095",

"id": "AW1sAhfAYu0OgJ2anzUD",

"severity": "Major"

}

New Switch Connected
{

"alert_type": "New Switch Connected",

"description": "New Switch with serial CN8AHKW095, MAC address 54:80:28:b8:f6:20 IP

address 10.22.41.3 and

Hostname Aruba-2930F-24G-PoEP-4SFPP connected, Group:unprovisioned",

"timestamp": 1569476559,

"webhook": "f8b021a2-8127-4c28-a755-8ee6e01ada66",

"setting_id": "e344d961bccd411dbd279bf92f61b989-201",

"state": "Open",

"nid": 201,

"details": {

"group": "1",

"labels": "",

"params": [

"CN8AHKW095",

"54:80:28:b8:f6:20",

"10.22.41.3",

"Aruba-2930F-24G-PoEP-4SFPP"

],

"_rule_number": "0",

"time": "2019-09-26 05:42:39 UTC"
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},

"operation": "create",

"device_id": "CN8AHKW095",

"id": "AW1sF8IGYu0OgJ2an0Aq",

"severity": "Major"

}

Switch Memory Over Utilization
{

"alert_type": "SWITCH_MEMORY_OVER_UTILIZATION",

"description": "Memory utilization for Switch Aruba-2930F-24G-PoEP-4SFPP with serial

CN8AHKW095 has been above 10% for about 5 minutes

since 2019-09-26 05:48:00 UTC",

"timestamp": 1569477180,

"webhook": "f8b021a2-8127-4c28-a755-8ee6e01ada66",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1301",

"state": "Open",

"nid": 1301,

"details": {

"_rule_number": "0",

"group": "1",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"duration": "5",

"time": "2019-09-26 05:48:00 UTC",

"threshold": "10",

"ds_key": "e344d961bccd411dbd279bf92f61b989.CN8AHKW095.memory_utilization.5m",

"serial": "CN8AHKW095",

"unit": "%"

},

"operation": "create",

"device_id": "CN8AHKW095",

"id": "AW1sITrfYu0OgJ2an0UP",

"severity": "Critical"

}

Switch CPU Over Utilization
{

"alert_type": "SWITCH_CPU_OVER_UTILIZATION",

"description": "CPU utilization for Switch Aruba-2930F-48G-PoEP-4SFPP with serial

CN88HKX1CR has been above 5% for about 5 minutes

since 2019-09-26 06:07:00 UTC.",

"timestamp": 1569478320,

"webhook": "f8b021a2-8127-4c28-a755-8ee6e01ada66",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1300",

"state": "Open",

"nid": 1300,

"details": {

"_rule_number": "0",

"group": "41",

"name": "Aruba-2930F-48G-PoEP-4SFPP",

"duration": "5",

"time": "2019-09-26 06:07:00 UTC",

"threshold": "5",

"ds_key": "e344d961bccd411dbd279bf92f61b989.CN88HKX1CR.cpu_utilization.5m",

"serial": "CN88HKX1CR",

"unit": "%"

},

"operation": "create",

"device_id": "CN88HKX1CR",

"id": "AW1sMqB4Yu0OgJ2an055",

"severity": "Critical"

}

Switch Interface Rx Rate
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{

"alert_type": "SWITCH_INTERFACE_RX_RATE",

"description": "Receive rate for Interface 15 on Switch Aruba-2930F-24G-PoEP-4SFPP has

been above 1 % for about 5 minutes

since 2019-09-26 13:18:00 UTC.",

"timestamp": 1569504180,

"webhook": "4d588353-3355-487d-81af-c97f62b0abb0",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1303",

"state": "Open",

"nid": 1303,

"details": {

"_rule_number": "0",

"group": "1",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"max_value_for_percentage": "1000.0",

"threshold": "1",

"intf_name": "15",

"time": "2019-09-26 13:18:00 UTC",

"duration": "5",

"ds_key": "e344d961bccd411dbd279bf92f61b989.CN8AHKW095.intf.rx_utilization.5m",

"serial": "CN8AHKW095",

"unit": "%"

},

"operation": "create",

"device_id": "CN8AHKW095",

"id": "AW1tvTgBYu0OgJ2 aoCgl",

"severity": "Critical"

}

Switch Interface Tx Rate
{

"alert_type": "SWITCH_INTERFACE_TX_RATE",

"description": "Transfer rate for Interface 19 on Switch Aruba-2930F-24G-PoEP-4SFPP has

been above 1 % for about 5 minutes

since 2019-09-26 13:18:00 UTC.",

"timestamp": 1569504180,

"webhook": "4d588353-3355-487d-81af-c97f62b0abb0",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1302",

"state": "Open",

"nid": 1302,

"details": {

"_rule_number": "0",

"group": "1",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"max_value_for_percentage": "1000.0",

"threshold": "1",

"intf_name": "19",

"time": "2019-09-26 13:18:00 UTC",

"duration": "5",

"ds_key": "e344d961bccd411dbd279bf92f61b989.CN8AHKW095.intf.tx_utilization.5m",

"serial": "CN8AHKW095",

"unit": "%"

},

"operation": "create",

"device_id": "CN8AHKW095",

"id": "AW1tvTgBYu0OgJ2aoCgk",

"severity": "Critical"

}

Switch POE Utilization
{

"alert_type": "SWITCH_POE_UTILIZATION",

"description": "PoE utilization for Switch Aruba-2930F-24G-PoEP-4SFPP with serial

CN69HKW05T MAC address e0:07:1b:c4:8d:80
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and IP address 10.22.182.78 has been above 1%",

"timestamp": 1569505920,

"webhook": "4d588353-3355-487d-81af-c97f62b0abb0",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1307",

"state": "Open",

"nid": 1307,

"details": {

"group": "0",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"ip": "10.22.182.78",

"labels": [],

"mac": "e0:07:1b:c4:8d:80",

"time": "2019-09-26 13:52:00 UTC",

"threshold": "1",

"serial": "CN69HKW05T"

},

"operation": "create",

"device_id": "CN69HKW05T",

"id": "AW1t18ccYu0OgJ2aoDYw",

"severity": "Critical"

}

Switch Interface Input Errors
{

"alert_type": "SWITCH_INTERFACE_INPUT_ERRORS",

"description": "Input errors for Interface 19 on Switch Aruba-2930F-24G-PoEP-4SFPP has

been above 90% for about

30 minutes since 2019-09-26 06:07:00 UTC .",

"timestamp": 1569505920,

"webhook": "4d588353-3355-487d-81af-c97f62b0abb0",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1307",

"state": "Open",

"nid": 1307,

"details": {

"group": "0",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"ip": "10.22.182.78",

"labels": [],

"mac": "e0:07:1b:c4:8d:80",

"time": "2019-09-26 13:52:00 UTC",

"threshold": "1",

"serial": "CN69HKW05T"

},

"operation": "create",

"device_id": "CN69HKW05T",

"id": "AW1t18ccYu0OgJ2aoDYw",

"severity": "Critical"

}

Switch Interface Output Errors
{

"alert_type": "SWITCH_INTERFACE_OUTPUT_ERRORS",

"description": "Output errors for Interface 19 on Switch Aruba-2930F-24G-PoEP-4SFPP has

been above 90% for about

30 minutes since 2019-09-26 06:07:00 UTC.",

"timestamp": 1569505920,

"webhook": "4d588353-3355-487d-81af-c97f62b0abb0",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1307",

"state": "Open",

"nid": 1307,

"details": {

"group": "0",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"ip": "10.22.182.78",
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"labels": [],

"mac": "e0:07:1b:c4:8d:80",

"time": "2019-09-26 13:52:00 UTC",

"threshold": "1",

"serial": "CN69HKW05T"

},

"operation": "create",

"device_id": "CN69HKW05T",

"id": "AW1t18ccYu0OgJ2aoDYw",

"severity": "Critical"

}

Switch Mismatch Config
{

"alert_type": "Switch Mismatch Config",

"description": "Config mismatch occurred in switch with serial CN69HKW05T MAC address

e0:07:1b:c4:8d:80 and

IP address 10.22.182.78 and Hostname Aruba-2930F-48G-PoEP-4SFPP ",

"timestamp": 1569505920,

"webhook": "4d588353-3355-487d-81af-c97f62b0abb0",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1307",

"state": "Open",

"nid": 1307,

"details": {

"group": "0",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"ip": "10.22.182.78",

"labels": [],

"mac": "e0:07:1b:c4:8d:80",

"time": "2019-09-26 13:52:00 UTC",

"threshold": "1",

"serial": "CN69HKW05T"

},

"operation": "create",

"device_id": "CN69HKW05T",

"id": "AW1t18ccYu0OgJ2aoDYw",

"severity": "Critical"

}

Switch Hardward Failure
{

"alert_type": "SWITCH_HARDWARE_FAILURE",

"description": "Switch with serial CN8AHKW095 : Fan 1 failed ",

"timestamp": 1569505920,

"webhook": "4d588353-3355-487d-81af-c97f62b0abb0",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1307",

"state": "Open",

"nid": 1307,

"details": {

"group": "0",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"ip": "10.22.182.78",

"labels": [],

"mac": "e0:07:1b:c4:8d:80",

"time": "2019-09-26 13:52:00 UTC",

"threshold": "1",

"serial": "CN69HKW05T"

},

"operation": "create",

"device_id": "CN69HKW05T",

"id": "AW1t18ccYu0OgJ2aoDYw",

"severity": "Critical"

}

Switch Interface Duplex Mode
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{

"alert_type": "SWITCH_INTERFACE_DUPLEX_MODE",

"description": "Interface 19 on switch Aruba-2930F-24G-PoEP-4SFPP with serial CN8AHKW095

is operating at Half-Duplex mode",

"timestamp": 1569901561,

"webhook": "c71404f4-00c1-4241-8bf4-c8d3f981caa2",

"setting_id": "e344d961bccd411dbd279bf92f61b989-1306",

"state": "Open",

"nid": 1306,

"details": {

"group": "1",

"name": "Aruba-2930F-24G-PoEP-4SFPP",

"labels": "",

"mode": "Half",

"intf_name": "19",

"time": "2019-10-01 03:46:01 UTC",

"serial": "CN8AHKW095"

},

"operation": "create",

"device_id": "CN8AHKW095",

"id": "AW2FbMiOYu0OgJ2asaWh",

"severity": "Critical"

}

Gateway Alerts—Sample JSON
This section includes sample JSON content for the following alerts:

WAN Uplink Flap
{

"alert_type": "WAN_UPLINK_FLAP",

"description": "Uplink link1_inet link status flapped 1% on device with CNHHKLB031 for

about 15 minutes

since 2019-07-25 12:36:00 UTC.",

"timestamp": 1564059060,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1600",

"state": "Open",

"nid": 1600,

"details": {

"status": "DOWN",

"_rule_number": "0",

"group": "77",

"labels": "8,661",

"current_status": "UP",

"duration": "15",

"intf_name": "link1_inet",

"time": "2019-07-25 12:36:00 UTC",

"threshold": "1",

"ds_key": "abce082bef4a428bb31366f6d6ff223f.CNHHKLB031.uplink.flap.5m",

"serial": "CNHHKLB031",

"uplink_tag": "link1_inet",

"unit": "%"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwpL0fvVQO1ZtiGh-2_",

"severity": "Critical"

}

WAN Tunnel Flap
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{

"alert_type": "WAN_TUNNEL_FLAP",

"description": "Tunnel data-vpnc-00:1a:1e:03:83:30-link1_inet status flapped 1%

on device CNHHKLB031 for about 15 minutes since 2019-07-25 12:26:00 UTC.",

"timestamp": 1564058460,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1601",

"state": "Open",

"nid": 1601,

"details": {

"alias_map_name": "data-vpnc-00:1a:1e:03:83:30-link1_inet",

"_rule_number": "0",

"group": "77",

"dst_ip": "172.168.101.9",

"labels": "8,661",

"src_ip": "192.168.51.254",

"duration": "15",

"time": "2019-07-25 12:26:00 UTC",

"threshold": "1",

"ds_key": "abce082bef4a428bb31366f6d6ff223f.CNHHKLB031.uplink.tunnel.flap.5m",

"serial": "CNHHKLB031",

"uplink_tag": "link1_inet",

"unit": "%"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwpJiAiVQO1ZtiGh5tw",

"severity": "Critical"

}

WAN Auto Negotiation Flap
{

"alert_type": "WAN_AUTO_NEGOTIATION_FLAP",

"description": "Uplink GE0/0/1 speed flapped 1% on device CNHHKLB031 for about

15 minutes since 2019-07-25 12:32:00 UTC.",

"timestamp": 1564058820,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1602",

"state": "Open",

"nid": 1602,

"details": {

"new_speed": "Auto",

"group": "77",

"labels": "8,661",

"duration": "15",

"_rule_number": "0",

"intf_name": "GE0/0/1",

"time": "2019-07-25 12:32:00 UTC",

"threshold": "1",

"ds_key": "abce082bef4a428bb31366f6d6ff223f.CNHHKLB031.uplink.speed.flap.5m",

"serial": "CNHHKLB031",

"speed": "1000",

"unit": "%"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwpK55sVQO1ZtiGh8zr",

"severity": "Minor"

}

WAN IPsec SA Establishment Failed
{

"alert_type": "WAN_IPSEC_SA_ESTABILSHMENT_FAILED",
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"description": "IPSec Tunnel Establishment from 192.168.51.254 to 172.168.101.9 failed

on device CNHHKLB031 at 2019-07-25 12:49:56 UTC",

"timestamp": 1564058996,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1550",

"state": "Open",

"nid": 1550,

"details": {

"alias_map_name": "data-vpnc-00:1a:1e:03:83:30-link1_inet",

"group": "77",

"name": "None",

"labels": [

"8",

"661"

],

"src_ip": "192.168.51.254",

"link_tag": "link1_inet",

"time": "2019-07-25 12:49:56 UTC",

"dst_ip": "172.168.101.9",

"serial": "CNHHKLB031"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwpLlB0VQO1ZtiGh-WS",

"severity": "Minor"

}

WAN IPsec SA Down
{

"alert_type": "WAN_IPSEC_SA_DOWN",

"description": "IPSec tunnel from 192.168.52.254 to 172.168.101.9 is DOWN on device

CNHHKLB031.

Reason: Administrator cleared IPSEC SA at 2019-07-25 12:40:22 UTC",

"timestamp": 1564058422,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1551",

"state": "Open",

"nid": 1551,

"details": {

"alias_map_name": "data-vpnc-00:1a:1e:03:83:30-link2_mpls",

"group": "77",

"name": "None",

"labels": [

"8",

"661"

],

"src_ip": "192.168.52.254",

"reason": "Administrator cleared IPSEC SA",

"time": "2019-07-25 12:40:22 UTC",

"dst_ip": "172.168.101.9",

"serial": "CNHHKLB031",

"uplink_tag": "link2_mpls"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwpJY4aVQO1ZtiGh5c-",

"severity": "Minor"

}

WAN IPsec SA All Down
{

"alert_type": "WAN_IPSEC_SA_ALL_DOWN",

"description": "All IPSec SAs down for device CNHHKLB031 at 2019-07-25 12:40:22 UTC",

"timestamp": 1564058446,
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"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1552",

"state": "Close",

"nid": 1552,

"details": {

"serial": "CNHHKLB031",

"labels": [

"8",

"661"

],

"group": "77",

"name": "None",

"time": "2019-07-25 12:40:22 UTC"

},

"operation": "update",

"device_id": "CNHHKLB031",

"id": "AWwpJY3NVQO1ZtiGh5c9",

"severity": "Critical"

}

CFG Set Advertisement Failure
{

"alert_type": "CFG_SET_ADVERTISEMENT_FAILURE",

"description": "CFG-Set advertisement failure for Gateway with CNHHKLB031 on tunnel data-

vpnc-00:1a:1e:03:83:30-link1_inet

from 192.168.51.254 to 172.168.101.9",

"timestamp": 1564059635,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1554",

"state": "Open",

"nid": 1554,

"details": {

"alias_map_name": "data-vpnc-00:1a:1e:03:83:30-link1_inet",

"group": "77",

"name": "None",

"labels": [

"8",

"661"

],

"src_ip": "192.168.51.254",

"time": "2019-07-25 13:00:35 UTC",

"map_name": "data-vpnc-00:1a:1e:03:83:30-link1_inet",

"dst_ip": "172.168.101.9",

"serial": "CNHHKLB031"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwpOBCVVQO1ZtiGiD0f",

"severity": "Major"

}

Controller CPU Over Utilization
{

"alert_type": "CONTROLLER_CPU_OVER_UTILIZATION",

"description": "CPU utilization for Gateway Aruba9004_40_0C_28 with serial CNHHKLB031 has

been above 1% for about 15 minutes

since 2019-07-25 09:30:00 UTC.",

"timestamp": 1564047900,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1351",

"state": "Open",

"nid": 1351,

"details": {

"_rule_number": "0",
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"group": "77",

"name": "Aruba9004_40_0C_28",

"labels": "8,661",

"duration": "15",

"time": "2019-07-25 09:30:00 UTC",

"threshold": "1",

"ds_key": "abce082bef4a428bb31366f6d6ff223f.CNHHKLB031.cpu_utilization.5m",

"serial": "CNHHKLB031",

"unit": "%"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwohP4LVQO1ZtiGgfbQ",

"severity": "Critical"

}

Controller Memory Over Utilization
{

"alert_type": "CONTROLLER_MEMORY_OVER_UTILIZATION",

"description": "Memory utilization for Gateway Aruba9004_40_0C_28 with serial CNHHKLB031

has been above 1% for about 10 minutes

since 2019-07-25 09:30:00 UTC.",

"timestamp": 1564047600,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1352",

"state": "Open",

"nid": 1352,

"details": {

"_rule_number": "0",

"group": "77",

"name": "Aruba9004_40_0C_28",

"labels": "8,661",

"duration": "10",

"time": "2019-07-25 09:30:00 UTC",

"threshold": "1",

"ds_key": "abce082bef4a428bb31366f6d6ff223f.CNHHKLB031.memory_utilization.5m",

"serial": "CNHHKLB031",

"unit": "%"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwogGqYVQO1ZtiGgc2L",

"severity": "Major"

}

Controller OSPF Session Error
{

"alert_type": "CONTROLLER OSPF SESSION ERROR",

"description": "OSPF session state change for Gateway with hostname GSK_VPNC2 and serial

CW0003307 from Init State to Down State

for neighbor 1.0.0.2 on interface 100 with reason No hello packets received from

neighbour.Inactivity timer fired",

"timestamp": 1564121712,

"webhook": "60785e88-9513-4352-94d6-ec25fedbeddc",

"setting_id": "b27f67fa44234c51a890fccea7c9b83e-1354",

"state": "Open",

"nid": 1354,

"details": {

"dst_state": "Down State",

"neighbour_ip": "1.0.0.2",

"group": "4",

"uniq_identifier": "100-16777218",

"labels": [

"2",
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"11",

"12",

"15",

"13",

"8"

],

"src_state": "Init State",

"reason": "No hello packets received from neighbour.Inactivity timer fired",

"time": "2019-07-26 06:15:12 UTC",

"interface": "100",

"serial": "CW0003307",

"hostname": "GSK_VPNC2"

},

"operation": "create",

"device_id": "CW0003307",

"id": "AWws60Yxon2R5PyMmUU4",

"severity": "Major"

}

Gateway Base License Capacity Exceeded
{

"alert_type": "GATEWAY_BASE_LICENSE_CAPACITY_EXCEEDED",

"description": "Base license capacity limit exceeded for Gateway with name: Dev-BR1-GW-

Kafka, serial: CP0015859",

"timestamp": 1564141290,

"webhook": "1348bcc4-ce00-4180-b314-32849c3638a1",

"setting_id": "2fb4b8a7e77c496395950510a1d270bc-1356",

"state": "Open",

"nid": 1356,

"details": {

"serial": "CP0015859",

"labels": [],

"group": "1",

"name": "Dev-BR1-GW-Kafka",

"time": "2019-07-26 11:41:30 UTC"

},

"operation": "create",

"device_id": "CP0015859",

"id": "AWwuFgZqnGtA5yFV0hCr",

"severity": "Critical"

}

DHCP Pool Consumption Alert
{

"alert_type": "DHCP_POOL_CONSUMPTION_ALERT",

"description": "DHCP Pool Consumption on Gateway CNHHKLB031 is 12% at 2019-07-25 13:02:39

UTC for 192.168.53.0/24",

"timestamp": 1564059759,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1510",

"state": "Open",

"nid": 1510,

"details": {

"subnet": "192.168.53.0/24",

"group": "77",

"name": "None",

"labels": "8,661",

"time": "2019-07-25 13:02:39 UTC",

"threshold": "12",

"serial": "CNHHKLB031",

"unit": "%"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwpOfQAVQO1ZtiGiE2H",



Gateway Alerts—Sample JSON | 763

"severity": "Critical"

}

WAN Auto Negotiation
{

"alert_type": "WAN_UPLINK_AUTONEGOTIATION_STATE_CHANGE",

"description": "WAN ports autonegotiaton speed changed from 1000 Mbps to Auto Mbps for

device with CNHHKLB031 for

uplink GE0/0/1 at 2019-07-25 12:46:36 UTC",

"timestamp": 1564058796,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1506",

"state": "Open",

"nid": 1506,

"details": {

"new_speed": "Auto",

"group": "77",

"name": "None",

"labels": [

"8",

"661"

],

"intf_name": "GE0/0/1",

"time": "2019-07-25 12:46:36 UTC",

"serial": "CNHHKLB031",

"speed": "1000"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwpK0IxVQO1ZtiGh8oh",

"severity": "Minor"

}

WAN Uplink Status Change
{

"alert_type": "WAN_UPLINK_STATUS_CHANGE",

"description": "Uplink port link1_inet status change UP -&gt; DOWN for device with

CNHHKLB031 at 2019-07-25 09:22:31 UTC",

"timestamp": 1564046551,

"webhook": "394c7a3c-ca41-4476-8afc-857e54aa4b3b",

"setting_id": "abce082bef4a428bb31366f6d6ff223f-1505",

"state": "Open",

"nid": 1505,

"details": {

"status": "UP",

"group": "77",

"name": "None",

"labels": [

"8",

"661"

],

"current_status": "DOWN",

"intf_name": "link1_inet",

"time": "2019-07-25 09:22:31 UTC",

"serial": "CNHHKLB031",

"uplink_tag": "link1_inet"

},

"operation": "create",

"device_id": "CNHHKLB031",

"id": "AWwocGtYVQO1ZtiGgT03",

"severity": "Major"

}
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Miscellaneous Alerts—Sample JSON
This section includes sample JSON content for the following alerts:

Device Config Change Detected
{

"alert_type": "DEVICE_CONFIG_CHANGE_DETECTED",

"description": "Config change detected on group nbapi_test for device type Switch by user

example@hpe.com.\n\nSerial: None, \nMacAddress: None,

\nConfig Content: Template Updated

\nmodel: ALL\nversion: ALL\ndevice_type: HPPC\ntemplate changes: \n @@ -18,6 +18,6

@@\n\n\n

ip address dhcp-bootp\n\n exit\n\n vlan 13\n\n- name \"vlan_8888\"\n\n+ name \"vlan_

44\"\n\n no ip address\n\n exit ",

"timestamp": 1564383294,

"webhook": "272eda1a-f79b-4192-ad6f-b35da11515bc",

"setting_id": "715e45fe3ff8453da355cd34aff2afa5-2000",

"state": "Open",

"nid": 2000,

"details": {

"config_change": "Template Updated\nmodel: ALL\nversion: ALL\ndevice_type:

HPPC\ntemplate changes: \n @@ -18,6 +18,

6 @@\n\n\n ip address dhcp-bootp\n\n exit\n\n vlan 13\n\n- name \"vlan_8888\"\n\n+

name \"vlan_44\"\n\n no ip address\n\n exit ",

"macaddr": "None",

"group": "8",

"dev_type": "Switch",

"labels": "None",

"group_name": "nbapi_test",

"_rule_number": "0",

"params": "None",

"user": "example@hpe.com",

"time": "2019-07-29 06:54:54 UTC",

"serial": "None"

},

"operation": "create",

"device_id": "",

"id": "AWw8grSBeZ6A6PlBvMk4",

"severity": "Warning"

}

User Account Deleted
{

"alert_type": "User account deleted",

"description": "User with name v@gmail.com deleted.",

"timestamp": 1569234480,

"webhook": "057b0a95-9f06-4a0f-b4bf-149a28d749b3",

"setting_id": "573b0412517a41c8a73a80f3e74ff0d2-15",

"state": "Open",

"nid": 15,

"details": {

"group": "-1",

"labels": "None",

"params": [

"v@gmail.com"

],

"_rule_number": "0",

"time": "2019-09-23 10:28:00 UTC"

},

"operation": "create",

"device_id": "",

"id": "AW1dqe6rYu0OgJ2alXzT",

"severity": "Major"

}
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New User Account Added
{

"alert_type": "New User account added",

"description": "User account setting updated for user: newuser@gmail.com with

language:en_US and idle timeout: 1800",

"timestamp": 1569234534,

"webhook": "057b0a95-9f06-4a0f-b4bf-149a28d749b3",

"setting_id": "573b0412517a41c8a73a80f3e74ff0d2-14",

"state": "Open",

"nid": 14,

"details": {

"group": "-1",

"labels": "None",

"params": [],

"_rule_number": "0",

"time": "2019-09-23 10:28:54 UTC"

},

"operation": "create",

"device_id": "",

"id": "AW1dqr6nYu0OgJ2alX1l",

"severity": "Major"

}

User Account Edited
{

"alert_type": "User account edited",

"description": "User with Name newuser@gmail.com, role readwrite and access [] updated.",

"timestamp": 1569235100,

"webhook": "057b0a95-9f06-4a0f-b4bf-149a28d749b3",

"setting_id": "573b0412517a41c8a73a80f3e74ff0d2-16",

"state": "Open",

"nid": 16,

"details": {

"group": "-1",

"labels": "None",

"params": [

"newuser@gmail.com",

"readwrite",

"[]"

],

"_rule_number": "0",

"time": "2019-09-23 10:38:20 UTC"

},

"operation": "create",

"device_id": "",

"id": "AW1ds2LcYu0OgJ2alYM2",

"severity": "Major"

}

Reports
The Aruba Central dashboard enables you to create various types of reports. You can create recurrent
reports or configure the reports to run on demand. To create a report, you must have read/write privileges
or Admin rights.

TheReports page has the following sections:

n Create—Creates a report that can run instantly, on scheduled time, or recurrent reports.
n Manage—Edits or deletes the scheduled reports.
n Browse—Lists all the archived reports.
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This section includes the following topics:

n Report Categories
n Creating a Report
n Editing a Report
n Viewing a Report
n Downloading a Report
n Deleting a Report

Report Categories
Aruba Central allows you to create various types of reports based on your network requirements. The
report types supported by Aruba Central are:

n Clients
n Infrastructure
n Security Compliance
n Applications

The following table lists the different types of reports under each report category:

Section Description

Client
Inventory

Displays the client details summarized by all aggregation fields. The report includes the following
details:

n Client count by SSID
n Client count by role
n Client count by connection mode
n client count by connection type
n Client count by OS
n Client count by vendors

Client
Session

Displays the details of client sessions for the SSIDs provisioned on Instant APs. The report includes
the following details:

n Clients
n Sessions
n Traffic
n Session Data by OS / Connection Mode / SSID / Role / MAC Vendor
n Clients by OS / Connection Mode / SSID / Role / MAC Vendor
n Time Spent by OS / Connection Mode / SSID / Role / MAC Vendor
n Data Usage by OS / Connection Mode / SSID / Role / MAC Vendor
n Client Device OS / Connection Mode / SSID / Role / MAC Vendor
n Top 10 clients by usage filtered based on SSID

Client
Usage

Displays the client usage and count details. The report includes the following details:
n Client Usage
n Top 10 clients by usage filtered based on SSID
n Client Count
n Top 10 applications by usage
n Top 10 web categories by usage
n Top 10 app categories
n Web reputation

Table 191: Clients Reports
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Section Description

Guest Displays the guests, and guest session details for all the SSIDs for a specific time period.

NOTE: Guest report does not support location based filtering for any selected device group or site
label to ensure end user privacy protection.

Summary Displays wireless and wired clients, and wireless and wired usage for one year. The report includes
the following details:

n Total data usage
n Trends
lClients per day
lAverage clients per day
lUsage over time

n Top N Widgets—Top 5, Top 10, Top 25, or Top 50
lTop clients by usage
lTop OS by usage

NOTE: Summary report is supported from Aruba Central 2.5.2 onwards and the data is available
only after an upgrade to version 2.5.2 or later. Data prior to the 2.5.2 upgrade is not available in the
report.

Table 191: Clients Reports

Section Description

Capacity
Planning

Displays the throughput and client density information for devices provisioned in Aruba
Central. The report includes the following details:

n Subscription Utilization: Total Subscription, Used subscriptions, and Available
subscriptions
n Top 25 APs by usage
n Top 25 switches by usage
n Top 25 APs by peak client
n Top-25 APs by average client

Configuration
& Audit

Displays the configuration and audit logs for all the device management, configurations,
and user management events triggered in Aruba Central. The report includes the following
details:

n Configuration Audit Status
n Aruba Switches Configuration Audit Status
n Virtual Controllers Configuration Audit Status

Infra Inventory Displays the inventory and subscription information for the devices that are online during a
specific duration. The report includes the following details:

n Subscription Utilization: Total Subscription, Used subscriptions, and Available
subscriptions
n Subscription Keys
n Number of APs
n Number of Switches
n Number of Gateways
n Firmware Version Summary (IAP)
n Firmware Version Summary (Switch)
n Firmware Version Summary (Gateway)
n Devices by Site
n Model and Firmware version (IAP)

Table 192: Infrastructure Reports
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Section Description

n Model and Firmware version (Switch)
n Model and Firmware version (Gateway)
n AP interfaces summary

Network Displays the following parameters:
n Top 20 Sites By Availability
n Bottom 20 Sites By Availability
n Top 20 Sites By WLAN Usage
n Bottom 20 Sites By WLAN Usage
n Number of APs
n AP Model
n Top Ten Clients By Usage filtered based on SSID
n Device Types (Current)
n Top Ten APs By Usage
n Total Usage By SSID
n Wireless Clients by SSID
n Peak and Average Wireless Data Usage
n Number of Switches
n Switch Model
n Top Ten Switches by Usage
n Top Ten Ports by Usage
n Wired Peak and Average Uplink Stats
n Number of Gateways
n Gateway Model

New Infra
Inventory

Displays the inventory and subscription information to the devices that are newly added in
Aruba Central. The report includes the following details:

n Subscription Utilization: Total Subscription, Used subscriptions, and Available
subscriptions
n Subscription Keys
n APs Added by Model
n APs Added by Group
n Switches Added by Model
n Switches Added by Group
n Total APs
n Total Switches

Resource
Utilization

Displays the details of infrastructure devices that exceeded the configured thresholds on a
daily, weekly, and monthly basis. The report includes the following details:

n Resource Utilization Threshold
n CPU/Memory Compliance
n Sites with Non-Compliant Devices
n Non-Compliance by Device Type
n Non-Compliant Access Points
n Non-Compliant Switches

RF Health Displays the following RF usage statistics for the AP radios.
n Problem Radios (5 GHz / 2.4 GHz)
n Most Noise (5 GHz / 2.4 GHz)
n Most Errors (5 GHz / 2.4 GHz)
n Most Utilized by Channel Usage (5 GHz / 2.4 GHz)
n Least Utilized by Channel Usage (5 GHz / 2.4 GHz)
n Most Channel Changes (5 GHz / 2.4 GHz)
n Most Transmission Power Changes (5 GHz / 2.4 GHz)

Table 192: Infrastructure Reports
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Section Description

n Radio with Least Goodput (5 GHz / 2.4 GHz)

NOTE: For APs that support 5 GHz dual band in synchronization with Aruba Instant 8.3.0.0,
the Device column in the RF Health Report shows the radio number of the operating
radio along with the model number of the device.

Switch Capacity
Planning

Displays the following details about the switch ports usage:
n Total Used/Unused Switch Ports
n Switch Port Summary
n Switch POE Usage Summary

NOTE: The data for this report is generated only after you upgrade to Aruba Central
version 2.5.2. You can view or generate the report for 1, 7, 30, and 90 days after upgrading
to Aruba Central version 2.5.2.

WAN Availability Displays WAN overlay and underlay availability information.
The Underlay report contains the following details:

n Branch Gateway
lSite
lSerial Number
lHost name
lMAC

n Uplink
lName
lType
lVLAN

n %Uptime
n Uptime
n Downtime

The Overlay report contains the following details:
n Branch Gateway
lSite
lSerial Number
lHost name
lMAC

n Uplink
lVLAN

n Tunnel
lName
lSIP
lDIP

n %Uptime
n Uptime
n Downtime

WAN Inventory Displays a list of Branch Gateways onboarded. The report is segregated by ArubaOS
software version and contains the following information:

n Software Version
n Site Name
n Serial Number
n Host name
n MAC
n IP Address

Table 192: Infrastructure Reports
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Section Description

n Model
n Status
n Street Address

WAN Compliance Displays the worst performing or best performing links according to the SLA compliance
violations. The report contains the following details:

n Policy Name
n Branch Gateway
lSite
lSerial Number
lHost Name
lMAC

n Uplink
lName
lType

n Value
lCompliance

WAN Transport
Health

Displays the top N links with probed values. The report contains the following details:
n Report Name
n Report Type
n Date Run
n Periodicity
n Title
n Probe Destination IP
n Branch Gateway
lSite
lSerial Number
lHost name
lMAC

n Uplink
lName
lUplink

n Value
lEither Loss (%

WAN Utilization Displays WAN bandwidth utilization information for Underlay, Overlay, and Uplinks. The
report contains the following details:

n Branch Gateway
lSite
lSerial Number
lHost name
lMAC

n Uplink
lName
lType
lVLAN

n Usage
lAverage Bandwidth (Mbps)
lSLA Bandwidth (Mbps)
l%Utilization

WAN Web
Content
Classification

Displays the details of Reputation, Categories, and Destination Countries. The report can
categorize information by:

Table 192: Infrastructure Reports
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Section Description

n Transport Type— Internet or VPN.
n Top N Count—Top N count of events, the number should be be between 1-250.
n Classify On—Classify the report on geo location, web category, or web
reputation.
n Report type— Choose either a complete summary report or blocked urls report.
n Report Period—Choose the time period for the report from:
lLast day
lLast seven days
lLast 30 days
lCustom Range

n Recurrence—Set the recurrence for the report generation.
The reports contain the following Device Details:

n Site—Location of the Gateway or VPNC.
n Serial #—Serial number of the device.
n Hostname—The hostname.
n MAC—Device MAC address.

The report also contains the top 5 Web Reputation, Web Category, Destination, and total
usage details. If required, a user can generate a report for web traffic going over a VPN.

Table 192: Infrastructure Reports

Section Description

PCI Compliance Displays the PCI Compliance result for the generated report. The report displays the
following details:

n Netmask
n Compliance result as Fail or Pass with the number of violations
n PCI report version 3.2 for Instant AP

RAPIDS Displays the details of all rogue or interfering devices in Aruba Central.

Security
Compliance

Displays the security compliance results. The report includes the following details:
n Rogue APs
n Total Rogue APs Detected
n Wireless Intrusions
n Total Wireless Intrusions

Table 193: Security Compliance Reports

Section Description

AppRF Displays application usage report for a specific device group. The report displays the following
widgets:

n Top 10 applications accessed by the clients
n Top 10 web categories accessed by the clients
n Top 10 applications for device types
n Others

Table 194: Applications Reports

Creating a Report
You can generate reports for devices associated with a group, multi-group, label, or site level. You can also
set a periodicity for running the reports.
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Although your page view is set to a specific group, site, or label, you can create reports for a different group,
site, or label. However, if your page view is set to an Instant AP cluster or Switch, you can schedule report
generation only for that Instant AP cluster or Switch.

To create a report:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyse, click Reports. The reports overview page is displayed.
3. Click Create. TheReports page is displayed.
4. Select one of the categories from the page display and click on the type of report you wish to create.
5. Under Context, select one of the following options:

a. Groups

b. Sites

c. Labels

6. To generate reports for the devices attached to a group, select Groups and then select a device
group.

7. To generate reports for devices attached to a label, click Labels and then select a label.
8. To generate reports for devices deployed on a specific site, click Sites and select a site.

For Client Session report, the Show Detailed Report option is available only for a selected site.
Selecting this option restricts the Report Period to Last Day and Custom Range only. Selecting
custom range enables you to select a one day time range from the particular day till the last seven days
only.

9. To set a role based or SSID based filter for a Client Inventory report or a Client Session report,
select all groups, multiple groups, or a single group. The Filter By window is displayed. Set the filter
to Roles or SSIDs, and select the required role or SSID filter.

10. To set the threshold values for aResource Utilization report, select the AP, Switch, and Gateway
thresholds under the Thresholdwindow.

11. Click Next.
12. UnderReport Period, select one of the following options:

a. Last day

b. Last 7 days

c. Last 30 days

d. Custom Range

13. Click Next.
14. Select one of the recurrent options:

a. One time (now)

b. One time (Later)
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c. Every day

d. Every week

e. Every month

15. UnderReport Information, add a report title, and an optional email address to receive the report as
email.

16. Select PDF and/or CSV, to specify the format of the report to receive the email.
17. Click Generate. The report gets generated is displayed under theGenerated Reports tab. The

report gets emailed as an attachment to the email address provided. If not, you can download the
PDF and/or CSV from theGenerated Reports table.

18. If you selected One Time as the option in step 12, the report will display underArchived Reports.
If the report is scheduled for a later time, the details will display under Scheduled Reports.

Editing a Report
To edit a report:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Reports. The reports overview page is displayed.
3. Click Manage.
4. Under Scheduled Reports, select a report and then click the edit icon. TheCreate Report page is

displayed.
5. Click Next. TheContext page is displayed.
6. Under Context, select one of the following options:

a. Groups

b. Sites

c. Labels

7. To generate reports for the devices attached to a group, select Groups and then select a device
group.

8. To generate reports for devices attached to a label, click Labels and then select a label.
9. To generate reports for devices deployed on a specific site, click Sites and select a site.

10. Click Next.
11. UnderReport Period, select one of the following options:

a. Last day

b. Last 7 days

c. Last 30 days

d. Custom Range

12. Click Next.



Aruba Central | User Guide 774

13. Select one of the recurrent options:

a. One time (now)

b. One time (Later)

c. Every day

d. Every week

e. Every month

14. Select theRun Time for generating the report at a specific time.
15. UnderReport Information, add a report title, and an optional email address to receive the report as

email.
16. Select PDF and/or CSV, to specify the format of the report to receive the email.
17. Click Generate. The report gets generated is displayed under theGenerated Reports tab. The

report gets emailed as an attachment to the email address provided. If not, you can download the
PDF and/or CSV from theGenerated Reports table.

18. If you selected One Time as the option in step 12, the report will display underArchived Reports.
If the report is scheduled for a later time, the details will display under Scheduled Reports.

Viewing a Report
To view a report:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Reports. The reports overview page is displayed.
3. Click Browse. TheReport table is displayed. Existing reports are listed underGenerated Reports

page.
4. UnderGenerated Reports, click the report name. The report details are displayed.

Downloading a Report
To download a report:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Reports. The reports overview page is displayed.
3. Click Browse. TheReport table is displayed. Existing reports are listed underGenerated Reports

page.
4. UnderGenerated Reports, hover the cursor over the report name. The PDF, CSV, Email, and Delete

icons are displayed.
5. Click PDF or CSV to download the report. The report gets downloaded to the local system.
6. Optionally, click the email icon to generate an email attachment of the report.

You can also download the report from the report details page. Click PDF, CSV, or email icon to select the
format.
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Deleting a Report
To delete a report, perform the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Reports. The reports overview page is displayed.
3. Click Browse. TheReport table is displayed. Existing reports are listed underGenerated Reports

page.
4. UnderGenerated Reports, hover the cursor over the report name. The PDF, CSV, Email, and Delete

icons are displayed.
5. Click the delete icon. The selected report gets deleted.

Deleting Multiple Reports
To delete multiple reports, perform the following steps:

1. In theNetwork Operations app, set the filter to one of the options underGroups, Labels, or
Sites. For all devices, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderAnalyze, click Reports. The reports overview page is displayed.
3. Click Browse. TheReport table is displayed. Existing reports are listed underGenerated Reports

page.
4. UnderGenerated Reports, select multiple reports by clicking each row. A pop-up displays the

number of selected rows.
5. Click the delete icon within the pop-up. TheDelete Report window appears.
6. Click Yes to delete the selected reports. The selected reports get deleted.

Viewing Audit Trail
TheAudit Trail page shows the total number logs generated for all device management, configuration, and
user management events triggered in Aruba Central.

To view theAudit Trail logs perform the following steps:

1. In theNetwork Operations app, select one of the following options:
n To select a group or all devices in the filter, set the filter to Group. For all devices, set the filter to

Global.
The dashboard context for the selected filter is displayed.

n To select a device in the filter:
a. Set the filter to Global.
b. UnderManage, click Devices, and then click Access Points, Switches, orGateways.

A list of devices is displayed in the List view.

c. Click a device listed underDevice Name.

The dashboard context for the device is displayed.
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2. UnderAnalyze, click Audit Trail.
The Audit Trail table is displayed with the following details:
n Occurred On— Timestamp of the audit log. Use the sort option to sort the audit logs by date and

time. Use the filter option to select a specific time range to display the audit logs.
n IP Address—IP address of the client device.
n Username—Username of the admin user who applied the changes.
n Target—The group or device to which the changes were applied.
n Category—Type of modification and the affected device management category.
n Description—A short description of the changes such as subscription assignment, firmware

upgrade, and configuration updates. Click to view the complete details of the event. For
example, if an event was not successful, clicking the ellipsis displays the reason for the failure.

To customize the Audit Trail table, click the eclipses icon to select the required columns, or click Reset to
default to set the table to the default columns.

For more information about audit logs, see Viewing Audit Trail in the Standard Enterprise Mode on page
185.



Chapter 10
API Gateway

API Gateway
Aruba Central supports a robust set of REST APIs to enable users to build custom applications and integrate
the APIs with their applications. The Aruba Central API framework uses OAuth protocol to authenticate and
authorize third-party applications, and allows them to obtain secure and limited access to an Aruba Central
service.

This section includes the following topics:

n API Gateway and NB APIs on page 777
n Accessing API Gateway on page 778
n Viewing Swagger Interface on page 779
n List of Supported APIs on page 780

API Gateway and NB APIs
TheAPI Gateway feature in Aruba Central supports the REST API for all Aruba Central services. This feature
allows Aruba Central users to write custom applications, embed, or integrate the APIs with their own
applications. The REST APIs support HTTP GET and POST operations by providing a specific URL for each
query. The output for these operations is returned in the JSON format.

For secure access to the APIs, the Aruba Central API Framework plug-in supports OAuth protocol for
authentication and authorization. The access tokens provide a temporary and secure access to the APIs. The
access tokens have a limited lifetime for security reasons and the applications should use the refresh API to
obtain new tokens periodically (every 2 hours).

The following figure illustrates the API gateway workflow for the users:
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Accessing API Gateway
To access the API Gateway:

1. In theAccount Home page, underGlobal Settings, click API Gateway.

TheAPI Gateway page is displayed. You can get new tokens and refresh old tokens. To obtain a new
token application, you must set authentication parameters for a user session.

Important Points to Note

n The admin user profile of MSP has System Apps & Tokens tab which displays all the apps and tokens
generated locally in the admin user profile. This tab also displays all the apps created in the non-admin
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user profiles. Clicking these apps lists out all the associated tokens created for the non-admin user
profile.

n Administrator role is specific to an app and hence the administrator account related RBAC library APIs
and decorators must contain the application name as one of the parameters in the access verification
query.

n The decorators associated with Account Home,Network Operations, or ClearPass Device Insight
must contain account_setting, central, or optik as app names respectively, as one of the parameters.

Domain URLs
The following table shows the region-specific domain URLs for accessing API Gateway:

Region Domain Name

US-1 app1-apigw.central.arubanetworks.com

US-2 apigw-prod2.central.arubanetworks.com

EU-1 eu-apigw.central.arubanetworks.com

Canada-1 apigw-ca.central.arubanetworks.com

China-1 apigw.central.arubanetworks.com.cn

APAC-1 api-ap.central.arubanetworks.com

APAC-EAST1 apigw-apaceast.central.arubanetworks.com

APAC-SOUTH1 apigw-apacsouth.central.arubanetworks.com

Table 195: Domain URLs for API Gateway Access

The procedures described in this article use app1-apigw.central.arubanetworks.com as an example. Ensure that
you use the appropriate domain URL when accessing API Gateway or generating tokens.

Viewing Swagger Interface
To view the APIs managed through Aruba Central, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click API Gateway.

TheAPI Gateway page with the list of published APIs is displayed.

2. To view the Swagger interface, click the link in theDocumentation column next to the specific
published API name. The documentation is displayed in a new window.

https://app1-apigw.central.arubanetworks.com/
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List of Supported APIs
Aruba Central supports the following APIs for the managed devices.

API Description

Monitoring Gets network, client, and event details. It also allows you to manage labels and switches.

Configuration Allows you to configure and retrieve the following:
n Groups
n Templates
n Devices

AppRF Gets Top N AppRF statistics.

Guest Gets visitor and session details of the portal.

MSP Allows you to manage and retrieve the following:
n Customers
n Users
n Resources
n Devices

Aruba has enforced a request limit for the following APIs:
n GET /msp_api/v1/customers
n GET /msp_api/v1/customers/{customer_id}/devices
n GET /msp_api/v1/devices
n PUT /msp_api/v1/customers/{customer_id}/devices

The maximum limit is set to 50 per API call. If you exceed this limit, the API call returns the
HTTP error code 400 and the following error message: LIMIT_REQUEST_EXCEEDED.

User
Management

Allows you to manage users and also allows you to configure various types of users with a
specific level of access control.

Audit Event Logs Gets a list of audit events and the details of an audit event.

New Device
Inventory

Gets device details and device statistics.

New Licensing Allows you to manage and retrieve subscription keys.

Table 196: APIs and Description
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API Description

Presence
Analytics

Allows you to configure the Presence Analytics application. It also retrieves site and loyalty
data.

Device
Management

Allows you to manage devices.

Firmware Allows you to manage firmware.

Troubleshooting Gets a list of troubleshooting commands for a specific type of device.

Notification Gets notification alerts generated for events pertaining to device provisioning,
configuration, and user management.

Unified
Communications

Retrieves data for all sessions for a specific period of time. It also retrieves the total
number of clients who made calls in the given time range and gets the Lync/Skype for
Business URL for the Aruba Central cluster that you are using.

Refresh API
Token

Allows you to refresh the API token.

Reporting Gets the list of configured reports for the given customer ID.

WAN Health Allows you to the following:
n Get list of configured WAN health policies.
n Create a new WAN health policy.
n Delete an existing WAN health policy.
n Get the details of any specific WAN health policy.
n Update an existing WAN health policy.
n Get policy schedule details.
n Create a schedule for a WAN health policy.
n Get statistics for WAN health cookie generated for a site.
n Get WAN health test results.
n Get WAN health test results for a specific site.

Network Health Allows you to get data for all the labels and sites.

Webhook Allows you to add, or delete Webhooks, and get or refresh Webhook tokens. See Webhooks
on page 738 for further details on Webhook.

VisualRF Allows you retrieve information on floor plans, location of APs, clients and rogue devices.

DPS Monitoring Gets DPS compliance and session statistics for all the links of a device belonging to a
specific policy.

Table 196: APIs and Description

For a complete list of APIs and the corresponding documentation, see https://app1-
apigw.central.arubanetworks.com/swagger/central.

Creating Application and Token
To create an application, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click API Gateway.

TheAPI Gateway page is displayed.

https://app1-apigw.central.arubanetworks.com/swagger/central
https://app1-apigw.central.arubanetworks.com/swagger/central
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2. Click theMy Apps & Tokens tab.

The admin user will be able to create new apps for all the non-admin user by clicking + Add Apps & Tokens in
the System Apps & Tokens tab.

3. Click + Add Apps & Tokens.

4. In theNew Token pop-up window, do the following:
a. Enter the application name. In non-admin user profile, theApplication Name field contains

the logged-in user name and is non-editable.
b. In theRedirect URI field, enter the redirect URL.
c. From the Application drop-down list, select the application.
d. Click Generate. A new application is created and added to theMy Apps & Tokens table.

TheMy Apps & Tokens table displays the following details:
n Name—Name of the application. In non-admin user profile, theApplication Name field

contains the logged-in user name and is non-editable. Any new tokens generated in non-
admin user profile is associated with the same application name.

n Client ID—Unique ID for each application.
n Client Secret—Unique secret ID for each application.
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n Redirect URI—Redirect URL.
n Application—Name of the application. For example, Network Operations.
n Tokens—Token created for the application. The option is available to admin user profile

only.
n Created At—Date on which the application was created.

To delete the added application, click delete icon on the row corresponding to an application and click
Yes to delete that application.

Only admin users will be able to generate tokens with multiple application names. In non-admin user profile, the
Application Name field contains the user name and is non-editable. Any new tokens generated in non- admin
user profile is associated with the same application name. However, all the multiple application names and the
associated tokens in non-admin user profiles from the earlier versions is retained in the Token List table.

Using OAuth 2.0 for Authentication
For secure access to the APIs, the Aruba Central API Framework plug-in supports OAuth protocol for
authentication and authorization. OAuth 2.0 is a simple and secure authorization framework. It allows
applications to acquire an access token for Aruba Central through a variety of work flows supported within
the OAuth 2.0 specification.

All OAuth 2.0 requests must use the SSL endpoint available at https://app1-
apigw.central.arubanetworks.com.

Access and Refresh Tokens
The access token is a string that identifies a user, app, or web page and is used by the app to access an API.
The access tokens provide a temporary and secure access to the APIs.

The access tokens have a limited lifetime. If the application uses web server or user-agent OAuth
authentication flows, a refresh token is provided during authorization that can be used to get a new access
token.

If you are writing a long running applications (web app) or native mobile application you should refresh the
token periodically. For more information, see Refreshing a token.

This section includes the following topics:

n Obtaining Access Token
n Accessing APIs
n Viewing and Revoking Tokens
n Adding a New Token

Obtaining Access Token
Users can generate the OAuth token using one of the following methods:

n Obtaining Token Using Offline Token Mechanism
n Obtaining Token Using OAuth Grant Mechanism

Accessing APIs
To access the API, use the following URL:

https://app1-apigw.central.arubanetworks.com/
https://app1-apigw.central.arubanetworks.com/
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https://app1-apigw.central.arubanetworks.com/.

This endpoint is accessible over SSL and the HTTP (non-SSL) connections are redirected to the SSL port.

URL Description

https://app1-
apigw.central.arubanetworks.com/

The API gateway URL. All APIs can be accessed from this URL by providing
a correct access token.

Table 197: Accessing the API

The parameters for the API are as follows:

Parameter Value Description

request_path URL
Path

URL path of an API, for example, to access monitoring APIs, use the path
/monitoring/v1/aps.

Table 198: Parameters for the API

Header Value Description

Authorization Bearer ouzMaXEBbB6XqGtsWomK7MvaTuhrqDQ1 Pass the access token in the header.

Table 199: Header for the API

Example
Request Method: GET

https://app1-apigw.central.arubanetworks.com/monitoring/v1/aps

Request Header:
Authorization: Bearer ouzMaXEBbB6XqGtsWomK7MvaTuhrqDQ1

Response:
{

"aps": [

{

"firmware_version": "6.4.4.4-4.2.3.1_54637",

"group_name": "00TestVRK",

"ip_address": "10.29.18.195",

"labels": [

"Filter_242",

"Ziaomof",

"roster",

"242455",

"Diegso"

],

"macaddr": "6c:f3:7f:c3:5d:92",

"model": "AP-134",

"name": "6c:f3:7f:c3:5d:92",

"radios": [

{

"band": 0,

"index": 1,

"macaddr": "6c:f3:7f:b5:d9:20",

"status": "Down"

},

{

"band": 1,

https://app1-apigw.central.arubanetworks.com/
https://app1-apigw.central.arubanetworks.com/
https://app1-apigw.central.arubanetworks.com/
https://app1-apigw.central.arubanetworks.com/monitoring/v1/aps?access_token=e325c0fb3f1547b5b735de3221690c2f
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"index": 0,

"macaddr": "6c:f3:7f:b5:d9:30",

"status": "Down"

}

],

"serial": "AX0140586",

"status": "Down",

"swarm_id": "e3bf1ba201a6f85f4b5eaedeead5e502d85a9aef58d8e1d8a0",

"swarm_master": true

}

],

"count": 1

}

Viewing and Revoking Tokens
To view or revoke tokens, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click API Gateway. TheAPI Gateway page is
displayed.

2. Click My Apps & Tokens. The Token List table displays the following:

n Token ID—Token ID of the application.
n User Name—Name of the user to whom this token is associated to. An application can be associated to

multiple users.
n Application—Name of the application to which this token is associated to. For example, Network

Operations.
n Generated At—Date on which the token was generated.
n Revoke Token—Click Revoke Token and click Yes to revoke the token associated to a particular user.

For example, if two users are associated to an application and if you want to remove access to a
particular user, revoke the token associated to that user.

n Download Token—Click Download Token to download the token.

In MSP mode, the admin user profile has System Apps & Tokens tab which displays all the apps and tokens
generated in all non-admin user profiles in addition to the apps and tokens created in the admin user profile. To
view all the tokens of admin and non-admin user, go to Account Home > Global Settings > API Gateway >
System Apps & Tokens.

Adding a New Token
To add a new token, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click API Gateway.The API Gateway page is
displayed.

2. Click My Apps & Tokens.

The admin user can create new tokens for all non-admin users by clicking + Add Apps & Tokens in the System
Apps & Tokens tab.

3. Click + Add Apps & Tokens to add a new token.
4. Enter the application name in theApplication Name box and click Generate.
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If you have registered a custom URI when creating a new app under System Apps and Tokens, the Redirect
URI option is disabled for you in the My Apps and Tokens tab > Add Apps and Tokens > New Token . In
such cases, the Redirect URI option in Add Apps and Tokens > New Token under My Apps and Tokens
populates your already registered URI.

Obtaining Token Using Offline Token Mechanism
To obtain tokens using the offline token method, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click API Gateway. TheAPI Gateway page is
displayed.

2. Click My Apps & Tokens.

In the MSP mode, the admin user profile can view the System Apps & Tokens tab which displays all the apps
and tokens generated in all the non-admin user profiles in addition to the apps and tokens created in the admin
user profile.

3. Click + Add Apps & Tokens. TheNew Token pane is displayed.
4. Enter the application name and redirect URI in theApplication Name and Redirect URI fields

respectively.
5. Choose the application from theApplication drop-down list and click Generate to generate a new

token.
6. The Token List table displays the following:

n Token ID—Token ID of the application.
n User Name—Name of the user to whom this token is associated to. An application can be

associated to multiple users.
n Application—Name of the application to which this token is associated to. For example, Network

Operations.
n Generated At—Date on which the token was generated.
n Revoke Token—Click Revoke Token and click Yes to revoke the token associated to a particular

user. For example, if two users are associated to an application and if you want to remove access
to a particular user, revoke the token associated to that user.

n Download Token—Click Download Token to download the token.

Obtaining Token Using OAuth Grant Mechanism
The following section describes the steps for obtaining the access token and refresh token using the
authorization code grant mechanism:

n Step 1: Authenticate a User and Create a User Session
n Step 2: [Optional] Generating Client Credentials
n Step 3: Generate Authorization Code
n Step 4: Exchange Auth Code for a Token
n Step 5: Refreshing a Token
n Step 6: Deleting a Token
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Step 1: Authenticate a User and Create a User Session
The following API authenticates a user and returns a user session value that can be used to create future
requests for a client with the specified username and password. It is assumed that you already have a client
ID for your application. For more information on how to create an application and obtain tokens, see
Creating Application and Token.

Domain URLs allow you to log in to the API gateway server and to establish the user session. This endpoint
is accessible over SSL, and HTTP (non-SSL) connections are redirected to SSL port. The following table lists
the region specific domain URLs for accessing the API gateway.

If user authentication is successful, the request will return HTTP code 200 and the response header will
include the following attributes.

Header Key Values Description

https://app1-
apigw.central.arubanetworks.com/oauth2/token

csrftoken=xxxx;
session=xxxx

The server returns a CSRF
token and identifies the user
session, which must be used
for all subsequent HTTP
requests.

Table 200: Authentication and User session Response Codes

Example
Request Method: POST

URL: https://app1- apigw.central.arubanetworks.com/oauth2/authorize/central/api/login?client_
id=<client_id> HTTP/1.1

Host: app1-apigw.central.arubanetworks.com

Request Header:
Accept: application/json

Content -Type: application/json
POST Request Body(JSON):
{

"username": "xxxxx",

"password": "xxxxx"

}

Error Response:
400: Bad Request

Response Body (JSON):
{

"extra": {},

"message": "<error string>"

}

401: Auth failure

Response Body (JSON):
{

"message": "Auth failure",

"status": false

}

Success Response:
200: OK

Response Body (JSON):
{

https://app1-apigw.central.arubanetworks.com/oauth2/token
https://app1-apigw.central.arubanetworks.com/oauth2/token
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"status": true

}

Response Header:
Set-Cookie: csrftoken=xxxx;session=xxxx;

The csrf token value received in the successful response message must be used as a parameter for all
subsequent POST/PUT requests. The session value must also be used for all subsequent requests to maintain
the user session context.

Step 2: [Optional] Generating Client Credentials
The following API can be used to generate client credentials for a specific tenant using your Managed Service
Provider (MSP) Client ID.

URL Description

https://app1-
apigw.central.arubanetworks.com/oauth2/authorize/central/api/client_
credentials?client_id=<msp_client_id>

The <msp_client_id> variableis the
client ID given from Central to that a
Managed Service Provider that user
registered the application.

Table 201: URL to Generate Client Credentials

Example
Request Method: POST

URI—https://app1-apigw.central.arubanetworks.coms/oauth2/authorize/central/api/client_
credentials?client_id=<msp_client_id>
POST Request Body(JSON):
{

"customer_id": "<tenant_id>"

}

Request Header: (Values from login API request)

Set-Cookie: csrftoken=xxxx;session=xxxx;

Response Body(JSON):
{

"client_id": "<new-client-id>",

"client_secret": <new-client-secret>"

}

Step 3: Generate Authorization Code
After the user is authenticated and you have a valid session for that user, use this API to get authorization
code. The authorization code is valid only for 5 minutes and must be exchanged for a token within that
time.

URL Description

https://app1
apigw.central.arubanetworks.com/oauth2/authorize/central/api

The endpoint is a POST call to get an
authorization code.

Table 202: URL for to Generate an Authorization Code

Query parameters for this API are as follows:
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Parameter Values Description

client_id client_id is a
unique
hexadecimal
string

The client_id is a unique identifier that identifies the caller. Application
developers obtain a client ID and a client secret when they register with the
API gateway admin.

response_
type

code Use code as the response type to get the authorization code that can be
exchanged for token

scope all or read Requested API permissions may be either all (for both read and write
access) or read for read-only access.

Table 203: Query Parameters for the Auth Code API

Example
Request Method: POST

URL: https://app1 - apigw.central.arubanetworks.com/oauth2/authorize/central/api/?client_id=<client_
id>&response_type=code&scope=all HTTP/1.1

Host: app1-apigw.central.arubanetworks.com

Request Header:
Accept: application/json Cookie: “session=xxxx” X-CSRF-Token: xxxx

Content -Type: application/json
POST Request Body(JSON):
{

"customer_id": "xxxxx"

}

Error Response:
400: Bad Request

Response Body (JSON):
{

"extra": {},

"message": "<error string>"

}

401: Auth failure

Response Body (JSON):
{

"message": "Auth failure",

"status": false

}

Success Response:
200: OK

Response Body (JSON):
{

" auth_code ": “xxxx”

}

Pass the csrf-token value you obtained in step one in the request header, otherwise the request will be
rejected. Note the auth_code value in the response, as you will use this code to obtain an OAuth token.

Response Header:
Set-Cookie: csrftoken=xxxx;session=xxxx;

Step 4: Exchange Auth Code for a Token
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Once you have an authorization code, you just use that code to request an access from the server. The
exchanges should be done within 300 seconds of obtaining the auth code from the previous step, or the
API will return an error.

URL Description

https:// app1- apigw.central.arubanetworks.com/oauth2/token The endpoint is a POST call to get an
access token using the authorization code
obtained from the server.

Table 204: URL for to Generate an Auth Token

Query parameters for this API are as follows:

Parameter Values Description

client_id client_id is a
unique
hexadecimal
string

The client_id is a unique identifier that identifies the caller. Application
developers obtain a client ID and a client secret when they register with the
API gateway admin.

client_secret client_secret is
a unique
hexadecimal
string

The client_secret is a unique identifier provided to each developer at the time
of registration. Application developers can obtain a client ID and client secret
when they register with the API gateway admin.

grant_type authorization_
code

Use code to get the authorization code that can be exchanged for the token.

code auth_code
received from
step 1

The authorization code received from the authorization server.

redirect_uri string The redirect URI must be the same as the one given at the time of
registration. This is an optional parameter.

Table 205: Query Parameters for the Auth Code API

The response to this API query is a JSON dictionary with following values:

Parameter Values Description

token_type bearer Identifies the token type. Central supports only the bearer token type (See
https://tools.ietf.org/html/rfc6750)

refresh_
token

string Refresh tokens are credentials used to renew or refresh the access_token when it
expires without repeating the complete authentication flow. A refresh token is a
string representing the authorization granted to the client by the resource owner.

expires_in seconds The lifetime, in seconds, of the access token.

access_
token

string Access tokens are credentials used to access protected resources. An access token is
a string representing an authorization issued to the client.

Table 206: Auth Token Values

Example
Request Method: POST
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URL: https: //apigw-prod2.central.arubanetworks.com/oauth2/token?client_id=<Ccentral-API-app-
clientid>&client_secret=xxxx&grant_type=authorization_code&code=xxxx \

Content -Type: application/json

Response:
{

"refresh_token": "xxxx",

"token_type": "bearer",

"access_token": "xxxx",

"expires_in": 7200

}

Step 5: Refreshing a Token
You can use the refresh token obtained in the previous step to update the access token without repeating
the entire authentication process.

URL Description

https://app1-
apigw.central.arubanetworks.com/oauth2/token

The endpoint is a POST call to refresh the access token using
the refresh token obtained from the server

Table 207: URL to Refresh a Token

Query parameters for this API are as follows:

Parameter Value Description

client_id client_id is a
unique
hexadecimal
string

The client_id is a unique identifier that identifies the caller. Application
developers obtain a client ID and a client secret when they register with the
API gateway admin.

client_secret client_secret is
a unique
hexadecimal
string

The client_secret is a unique identifier provided to each developer at the time
of registration. Application developers obtain a client ID and a client secret
when they register with the API gateway admin.

grant_type refresh_token Specify refresh_token as the grant type to request that an authorization code
be exchanged for a token

refresh_
token

string A string representing the authorization granted to the client by the resource
owner.

Table 208: Query Parameters for Refresh Tokens

The response to this API query is a JSON dictionary with following values:

Parameter Value Description

token_type bearer Identifies the token type. Only the bearer token type is supported. For more
information, see https://tools.ietf.org/html/rfc6750.

https://app1-apigw.central.arubanetworks.com/oauth2/token
https://app1-apigw.central.arubanetworks.com/oauth2/token
https://tools.ietf.org/html/rfc6750
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Parameter Value Description

refresh_
token

string Refresh tokens are credentials used to renew or refresh the access token when it
expires without going through the complete authorization flow. A refresh token is a
string representing the authorization granted to the client by the resource owner.

expires_in seconds The expiration duration of the access tokens in seconds.

access_
token

string Access tokens are credentials used to access the protected resources. An access
token is a string representing an authorization issued to the client.

Example
Method: POST
https: //apigw-prod2.central.arubanetworks.com/oauth2/token?client_id=<Ccentral-API-app-
clientid>&client_secret=xxxx&grant_type=authorization_code&code=xxxx \

Response
{

"refresh_token": "xxxx",

"token_type": "bearer",

"access_token": "xxxx",

"expires_in": 7200

}

Step 6: Deleting a Token
To delete the access token, access the following URL:

URL Description

https://app1-
apigw.central.arubanetworks.com/oauth2/token

This endpoint is accessible over SSL. The HTTP (non-SSL)
connections are redirected to SSL port. Customer ID is a
string.

Table 209: URL to Delete a Token

Example
Method : DELETE

URL:https://app1-apigw.central.arubanetworks.com/oauth2/api/tokens

JSON Body:
{

"access_token": "<access_token_to_be_deleted>",

"customer_id": "<customer_id_to_whom_token_belongs_to>"

}

Headers:

Content-Type: application/json

X-CSRF-Token: <CSRF_token_obatained_from_login_API>

Cookie: "session=<session_obatained_from_login_API>"

Viewing Usage Statistics

https://app1-apigw.central.arubanetworks.com/oauth2/token
https://app1-apigw.central.arubanetworks.com/oauth2/token
https://app1-apigw.central.arubanetworks.com/oauth2/api/tokens
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TheAPI Gateway page includes theUsage tab that displays the API usage. TheUsage tab is available only
for administrators and the usage data is stored only for the previous 30 days. The following details are
displayed:

n Assigned rate limit.
n Total usage.
n Per user usage.
n MSP and tenant usage if you are in MSP mode.

The administrator receives an alert through text message or email when the API usage reaches a threshold.
You can set the threshold to 75% of the rate limit value.

To view the usage statistics for users of API Gateway, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click API Gateway. TheAPI Gateway page is
displayed.

2. Click Usage. The following details are displayed:

n Rate Limit—The total rate limit assigned for API calls for a month.
n Total Usage:
n Date—The date of usage.
n Usage Per Day—Usage per day.
n Usage Percentage—Usage percentage for a specific date.

n Per User Usage:
n User—The name of the user.
n Date—The date on which the application was accessed.
n Usage Per Day—The total usage by the user per day. This is derived based on the total number of API

calls made on a per day basis. This is an aggregate across all customers.

n If you are in MSP mode, theMSP & Tenant Usage table is displayed:
n Tenant ID: ID of the tenant account.
n Date: The date on which the application was accessed.
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n Usage Per Day: The total usage by the tenant account per day. This is derived based on the total
number of API calls made on a per day basis.

The Usage tab is only available for administrators and the usage data is stored only for the previous 30 days.



Chapter 11
Guest Access

Guest Access
The guest management feature allows guest users to connect to the network and at the same time, allows
the administrator to control guest user access to the network.

Aruba Central allows administrators to create a splash page profile for guest users. Guest users can access
the Internet by providing either the credentials configured by the guest operators or their respective social
networking login credentials. For example, you can create a splash page that displays a corporate logo, color
scheme and the terms of service, and enable logging in from a social networking service such as Facebook,
Google, Twitter, and LinkedIn.

Businesses can also pair their network with the Facebook Wi-Fi service, so that the users logging into Wi-Fi
hotspots are presented with a business page, before gaining access to the network.

To enable logging using Facebook, Google, Twitter, and LinkedIn credentials, ensure that you create an
application (app) on the social networking service provider site and enable authentication for that app. The
social networking service provider will then issue a client ID and client secret key that are required for
configuring guest profiles based on social logins.

Guest operators can also create guest user accounts. For example, a network administrator can create a
guest operator account for a receptionist. The receptionist creates user accounts for guests who require
temporary access to the wireless network. Guest operators can create and set an expiration time for user
accounts. For example, the expiration time can be set to 1 day.

Guest Access Dashboard
The Summary page in the Manage > Guest Access application provides a dashboard displaying the
number of guests, guest SSID, client count, type of clients, and guest connection for the selected group.

Table 210 describes the contents of theGuest Access Overview page:

Data Pane Item Description

Time Range Time range for the graphs and charts displayed on the Overview pane. You can choose to
view graphs for a time period of 1 day, 1 week, and 1 month.

Guests Number of guests connected to the SSIDs with Cloud Guest splash page profiles.

Guest SSID Number of guest SSIDs that are configured to use the Cloud Guest splash page profiles.

Avg. Duration The average duration of client connection on the SSIDs with Cloud Guest splash page
profiles.

Max Concurrent
Connections

Maximum number of client devices connected concurrently on the guest SSIDs.

Guest Connection
(graph)

Time stamp for the client connections on the cloud guest for the selected time range.

Table 210: Guest Access Overview Page
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Data Pane Item Description

Guest Count by
Authentication

Number of client devices based on the authentication type configured on the cloud guest
SSIDs.

Guest Count by
SSID

Number of guest connections per SSID.

Client Type Type of the client devices connected on the guest SSIDs.

Creating Apps for Social Login
The following topics describe the procedures for creating applications to enable the social login feature:

n Creating a Facebook App
n Creating a Google App
n Creating a Twitter App
n Creating a LinkedIn App

Creating a Facebook App
Before creating a Facebook app, ensure that you have a valid Facebook account and you are registered as a
Facebook developer with that account.

To create a Facebook app, complete the following steps:

1. Visit the Facebook app setup URL at https://developers.facebook.com/apps.
2. FromMy Apps, select Add a New App.
3. Enter the app name and your email address in theDisplay Name and Contact Email text boxes,

respectively.
4. Click Create App ID.
5. Hover the mouse on Facebook Login and select Setup.
6. Click Web (that is, the WWW platform).
7. Enter the website URL in the Site URL box.

This URL is the same as the server URL mapped in the splash page configuration.

8. Click Save.
9. Read through the Next Steps section for further information on including Login Dialog, Access

Tokens, Permissions, and App Review.
10. Go to PRODUCTS > Facebook Login > Settings from the left navigation menu.
11. Click theClient OAuth Login toggle switch to turn to Yes.
12. Enter the OAuth URI in theValid OAuth redirect URIs box.

The URI is the server URL mapped in the splash configuration with /oauth/reply appended to it. To
get the valid Oauth redirect URL, go to theGuest Access > Splash Pages path and click the eye (
) icon available against the specific splash page name in the Splash Pages table.

Ensure that the URL is an HTTPS URL with a domain name and not the IP address. For example,
https://example1.cloudguest.arubanetworks.com/oauth/reply.
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13. From the left navigation menu, select App Review.
14. Select theMake <App Name> Public toggle switch to make your app available to public.
15. Click Category.
16. In theChoose a Category pop-up window, select a category.
17. Click Confirm.
18. Select other extra permissions you want to provide for the users of your app.

There are 41 permissions available for you to select from.

19. Click Add xx Items, where x represents the number of permissions you selected.
20. Enter the reason for providing specific permissions and click Save.
21. Click Submit for Review.
22. On the left navigation pane, click the Settings icon.

Note the app ID and app secret key. Use the app ID and secret key when configuring Facebook login
in the Aruba Central UI.

23. UnderApp Domains, enter the server URL.

Creating a Google App
Before creating a an app for Google based login, ensure that you have a valid Google account.

To create a Google app, complete the following steps:

1. a. Access the Google Developer site at https://code.google.com/apis/console.

b. To select an existing project, click Select a project and select the desired project.

c. If the project is not created, click Create a project, enter the project name and click Create.

d. Click Enable APIs and Services.

e. Navigate to Social category, and then click Google API. TheGoogle APIwindow opens.

f. To enable the API, click Enable.

g. Click Create Credentials. If the credentials are already created, click Go to credentials.

h. In theCredentials pane, perform the following actions:
n Under theWhere will you be calling the API from section, select Web Browser.
n Under theWhat data you will be accessing section, select User Data.
n Click What Credentials do I need.

2. Under Create an OAuth 2.0 client ID. Enter theOAuth 2.0 Client ID Name.
3. UnderAuthorized JavaScript Origins, enter the base URL with FQDN of the cloud guest instance

that will be hosting the captive portal. For example, https://%hostname%/.
4. UnderAuthorized Redirect URIs, enter the cloud server OAuth reply URL that includes the FQDN

of the cloud server instance with /oauth/reply appended at the end of the URL.

Ensure that the URL is an HTTPS URL with a domain name and not the IP address. For example,
https://example1.cloudguest.examplenetworks.com/oauth/reply.
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5. Click Create Client ID.

Under Set up the OAuth 2.0 consent screen, provide your Email Address and product name,
and then click Continue. The client ID is displayed.

6. Click Done. A page showing the OAuth Client IDs opens.
7. Click theOauth client ID to view the client ID and client secret key.

Use this client ID and client secret key when configuring Google login in the Aruba Central UI.

Creating a Twitter App
Before creating a Twitter app, ensure that you have a valid Twitter accosunt.

To create a Twitter app, complete the following steps:

1. Visit the Twitter app setup URL at https://apps.twitter.com.
2. Click Create New App. TheCreate an application web page is displayed.
3. Enter the application name and description.
4. For OAuth 2.0 Redirect URLs, enter the HTTPS URL of the cloud guest server to which you want to

connect this social authentication source, and append /oauth/reply at the end of the URL.

Ensure that the URL is an HTTPS URL with a domain name and not the IP address. For example,
https://exa.example.com/oauth/reply.

5. Select Yes, I agree to accept the Developer Agreement terms.
6. Click Create a Twitter application.
7. Click Manage Keys and Access Tokens.

TheKeys and Access Tokens tab opens. The consumer key (API key) and consumer secret (API key)
are displayed.

8. Note the ID and the secret key. The consumer key and consumer secret key when configuring Twitter
login in Aruba Central UI.

Creating a LinkedIn App
Before creating a LinkedIn app, ensure that you have a valid LinkedIn account.

To create a LinkedIn app, complete the following steps:

1. Visit the LinkedIn app setup URL at https://developer.linkedin.com.
2. Click My Apps. You will be redirected to https://www.linkedin.com/secure/developer/apps.
3. Click Create Application. TheCreate a New Application web page is displayed.
4. Enter your company name, application name, description, website URL, application logo with the

specification mentioned, application use, and contact information.
5. Click Submit. TheAuthentication page is displayed.
6. Note the client ID and client secret key displayed on theAuthentication page.
7. ForOAuth 2.0 Redirect URLs, enter the HTTPS URL of the cloud guest server to which you want to

connect this social authentication source and append /oauth/reply at the end of the URL.
8. Click Add and then click Update. The API and secret keys are displayed.
9. Note the API and secret key details. Use the API ID and secret key when configuring LinkedIn login in

the Aruba Central UI.
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Configuring a Cloud Guest Splash Page Profile
This topic describes the following procedures:

n Adding a Cloud Guest Splash Page Profile
n Customizing a Splash Page Design
n Configuring a Cloud Guest Splash Page Profile
n Localizing a Cloud Guest Portal
n Associating a Splash Page Profile to an SSID

Adding a Cloud Guest Splash Page Profile
To create a splash page profile:

1. From theNetwork Operations app, filter a group.
2. UnderManage, click Guests to display the Splash Page.

You can create splash page profiles only for the individual groups.

3. To create a new Splash page, click the + icon.

TheNew Splash Page pane is displayed.

4. On theConfiguration tab, configure the parameters described in the following table:

Data Pane
Content Description

Name Enter a unique name to identify the splash profile.

NOTE: If you attempt to enter an existing splash profile's name, Aruba Central displays
a message stating that Splash page with this name already exists.

Type Configure any of the following authentication methods to provide a secure network
access to the guest users and visitors.

n Anonymous
n Authenticated
n Facebook Wi-Fi

Anonymous Configure the Anonymous login method if you want to allow guest users to log in to the
Splash page without providing any credentials.
For anonymous user authentication, you can also enable a pre-shared key to allow
access. To enable a pre-shared key based authentication, set the Guest Key to ON and
specify a password.

Authenticated

Configure authentication and authorization attributes, and login credentials that enable
users to access the Internet as guests. You can configure an authentication method
based on sponsored access and social networking login profiles.
The authenticated options available for configuring the cloud guest splash page are
described in the following rows.

Table 211: Splash Page Configuration
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Data Pane
Content Description

Username/Password

The Username/Password based authentication method allows pre-configured visitors
to obtain access to wireless connection and the Internet. The visitors or guest users can
register themselves by using the splash page when trying to access the network. The
password is delivered to the users through print, SMS or email depending on the
options selected during registration.
To allow the guest users to register by themselves:

1. Enable Self-Registration.
2. Set the Verification Required to ON if the guest user account must be verified.
3. Enable the Bypass Apple Captive Network Assistant (CNA) to bypass the CNA
on the iOS devices. Enabling CNA bypass allows users to bypass the Apple Captive
Network Assistant pop-up on their iOS devices. However, users still need to verify
their credentials with a browser. When the CNA bypass is disabled, the iOS clients
have to enter the credentials in the CNA pop-up on their devices. The Bypass Apple
Captive Network Assistant (CNA) toggle button is displayed only when
Verification Required is enabled. Users can either enable or disable CNA bypass
based on their requirement.
4. Specify a verification criteria to allow the self-registered users to verify through
email or phone.
n If email-based verification is enabled and the Send Verification Link is selected,
a verification link is sent to the email address of the user. The guest users can click
the link to obtain access to the Internet.
n If phone-based verification is enabled, the guest users will receive an SMS. The
administrators can also customize the content of the SMS by clicking on Customize
SMS.
5. Specify the duration within the range of 1-60 minutes, during which the users can
access free Wi-Fi to verify the link. The users can log in to the network for the
specified duration and click the verification link to obtain access to the Internet.

By default, the expiration date for the accounts of self-registered guest users is set to
infinite during registration. The administrator or the guest operator can set the
expiration date after registration.

Social Login

Social Login—Enable this option to allow guest users to use their existing login
credentials from social networking profiles such as Facebook, Twitter, Google, or
LinkedIn and sign into a third-party website. When a social login based profile is
configured, a new login account to access the guest network or third-party websites is
not required.

n Facebook— Allows guest users to use their Facebook credentials to log in to the
splash page. To enable Facebook integration, you must create a Facebook app and
obtain the app ID and secret key. For more information on app creation, see
Creating a Facebook App. Enter the app ID and secret key for client ID and client
Secret respectively to complete the integration.
n Twitter—Allows guest users to use their Twitter credentials to log in to the splash
page. To enable Twitter integration, you must create a Twitter app and obtain the
app ID and secret key. For more information, see Creating a Twitter App. Enter the
app ID and secret key for client ID and client secret respectively to complete the
integration.
n Google—Allows guest users to use their Google credentials to log in to the splash
page. To enable Google integration, you must create a Google app and obtain the
app ID and secret key. For more information, see Creating a Google App.

1. Enter the app ID and secret key for client ID and client secret
respectively.
2. To restrict authentication attempts to only the members of a
Google hosted domain, enter the domain name in the Gmail for
Work Domain text box. Ensure that you have a valid domain account
licensed by Google Domains or Google Apps. For more information

Table 211: Splash Page Configuration
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Data Pane
Content Description

see:
n https://apps.google.com/intx/en_in/
n https://domains.google.com/about/
3. Specify a text for the Sign-In button.

n LinkedIn—Allows guest user to use their LinkedIn credentials to log in to the
splash page. To enable LinkedIn integration, you must create a LinkedIn app and
obtain the app ID and secret key. For more information, see Creating a LinkedIn App.
Enter the app ID and secret key for client ID and client secret respectively to
complete the integration.

Facebook Wi-Fi

If you want to enable network access through the free Wi-Fi service offered by
Facebook. Select the Facebook Wi-Fi option. The Facebook Wi-Fi feature allows you to
pair your network with a Facebook business page, thereby allowing the guest users to
log in from Wi-Fi hotspots using their Facebook credentials.
If the Facebook Wi-Fi business page is set up, when the users try to access the Internet,
the browser redirects the user to the Facebook page. The user can log in with their
Facebook account credentials and can either check in to access free Internet or skip
checking in and then continue.

Facebook Wifi
Configuration

After selecting the Facebook Wi-Fi option, complete the following steps to continue with
the Facebook Wi-Fi configuration.

1. Click the Configure Now link.
2. Sign in to your Facebook account.
3. If you do not have a business page, click Create Page. For more information on
setting Facebook Wi-Fi service, see Setting up Facebook Wi-Fi for Your Business
at https://www.facebook.com/help/126760650808045.

NOTE: Instant AP devices support Facebook Wi-Fi services on their own, without Aruba
Central. However, for enabling social login based authentication, the guest splash
pages must be configured in Aruba Central. For more information on Facebook Wi-Fi
configuration on an Instant AP, see the Aruba Instant User Guide.

Allow Internet In
Failure

To allow users access the Internet when the external captive portal server is not
available, click the Allow Internet In Failure toggle switch. By default, this option is
disabled.

Override Common
Name

To override the default common name, click the Override Common Name toggle
switch and specify a common name. The common name is the web page URL of the
guest access portal. By default, the common name is set to
securelogin.arubanetworks.com. The guest users can override this default name by
adding their own common name.
If your devices are managed by AirWave and you want to use your own certificate for
the captive portal service, ensure that the captive portal certificate is pushed to the
Instant AP from the AirWave management system. When the appropriate certificate is
loaded on the AP, perform the following actions:

1. Run the show captive-portal-domains command at the Instant AP command
prompt.
2. Note the common name or the internal captive portal domain name.
3. Add this domain name in the Override Common Name field on the Splash Page
configuration page.
4. Save the changes.

Guest Key To set password for anonymous users, enable the Guest Key and enter a password.

Table 211: Splash Page Configuration
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Data Pane
Content Description

Sponsored Guest Enable the Sponsored Guest option to provide authorization control to a guest sponsor
for allowing and denying a guest from accessing the network.

Allowed Sponsor
Domains

Enter accepted company domain names. The domain name must match the suffix of
the sponsor's email address. The domain names must be company names and not any
public domain names such as gmail, yahoomail, and so on. To add more domain
names, click the add icon and enter the domain name. This is a mandatory field.

Allowed Sponsor
Emails

Enter the allowed email addresses. If you leave this field empty, all emails that
correspond to the allowed domains list are permitted to sponsor guests. To add more
sponsor emails, click the add icon and enter the sponsor's email address. This is an
optional field.

Authentication
Success Behavior

If Anonymous or Authenticated option is selected as the guest user authentication
method, specify a method for redirecting the users after a successful authentication.
Select one of the following options:

n Redirect to Original URL— When selected, upon successful authentication, the
user is redirected to the URL that was originally requested.
n Redirect URL— Specify a redirect URL if you want to override the original request
of users and redirect them to another URL.

Authentication
Failure Message

If the Authenticated option is selected as the guest user authentication method, enter
the authentication failure message text string returned by the server when the user
authentication fails.

Session Timeout Enter the maximum time in Day(s): Hour(s): Minute(s) format for which a client session
remains active. The default value is 0:8:00. When the session expires, the users must
re-authenticate.
If MAC caching is enabled, the users are allowed or denied access based on the MAC
address of the connective device.

Share This Profile Select this check box if you want to allow the users to share the Splash Page profile. The
Splash Page profiles under All Devices can be shared across all the groups.

Daily Usage Limit Use this option to set a data usage limit for authenticated guest users, anonymous
profiles, and Facebook Wi-Fi logins. By default, no daily usage limit is applied.
To set a daily usage limit, use one of the following options:

n By Time— Specify the time limit in hours and minutes for data usage during a
day. When a user exceeds the configured time limit, the device is disconnected from
the network until the next day begins; that is, until 00.00 hours in the specified time
zone.
n By Data— Specify a limit for data usage in MB. You can set this limit to either Per
User, Per Session, or Per Device. When the data usage exceeds the configured
limit, the user device is disconnected from the network until the next day begins;
that is, until 00.00 hours in the specified time zone.
lPer User— This option applies the data usage limit based on authenticated user
credentials.
lPer Session—This option applies the data usage limit based on user sessions.
lPer Device—This option applies the data usage limit based on the MAC address
of the client device connected to the network.

Important Points to Note
n The values configured for this feature do not serve as hard limits. There might be
a slight delay in enforcing daily usage limits due to the time required for processing
information.
n For anonymous and Facebook Wi-Fi logins, the daily usage limit is applied per

Table 211: Splash Page Configuration
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Data Pane
Content Description

MAC address of the client device connected to the network.

Whitelist URL To allow a URL, click + and add the URL to the whitelist. For example, if the terms and
conditions configured for the guest portal include URLs, you can add these URLs to the
whitelist, so that the users can access the required web pages.

Table 211: Splash Page Configuration

Customizing a Splash Page Design
1. From theNetwork Operations app, filter a group.
2. UnderManage, click Guests to display the Splash Page.

You can create splash page profiles only for the individual groups.

3. To create a new splash page, click the + icon.

TheNew Splash Page pane is displayed.

To customize a splash page design, on theGuest Access > Splash Page > New Splash Page >
Customization pane, configure the parameters described in the following table:

Data Pane
Content

Description

Layout To customize the page layout based on the device type. Specify a layout by
selecting one of the following options:

n Horizontal, better for computers
n Vertical, better for phones

The horizontal layout is selected by default. To change the layout, click the drop-
down list and select the required layout type.

Background color To change the color of the splash page, select a color from the Background Color
palette.

Button color To change the color of the sign in button, select a color from the Button Color
palette.

Header fill color Select the fill color for the splash page header from the Header fill color palette.

Page font color To change the font color of the text on the splash page, select a color from the
Page font color palette.

Page font Color Select the font color of the splash page from the palette.

Logo To upload a logo, click Browse, and browse the image file. Ensure that the image
file size does not exceed 256 KB.

Background Image Click Browse to upload a background image. Ensure that the background image
file size does not exceed 512 KB.

Table 212: Splash page customization
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Data Pane
Content

Description

Page Title Add a suitable title for the splash page.

Welcome Text Enter the welcome text to be displayed on the splash page. Ensure that the
welcome text does not exceed 20,000 characters.

Terms &
Conditions

Enter the terms and conditions to be displayed on the splash page. Ensure that the
terms and conditions text does not exceed 20000 characters.
The text box also allows you to use HTML tags for formatting text. For example, to
highlight text with italics, you can wrap the text with the <i> </i> HTML tag.
Specify an acceptance criteria for terms and condition by selecting any of the
following options from the Display "I Accept" Checkbox:

n No, Accept by default
n Yes, Display Checkbox

If the I ACCEPT check box must be displayed on the Splash page, select the display
format for terms and conditions.
Ensure that Display Option For Terms & Conditions has the Inline Text option
auto-selected and displayed as an uneditable text.

Ad Settings If you want to display advertisements on the splash page, enter the URL in the
Advertisement URL.
For Advertisement Image, click Browse and upload the image.

Localizing a Cloud Guest Portal

1. From theNetwork Operations app, filter a group.
2. UnderManage, click Guests to display the Splash Page.

You can create splash page profiles only for the individual groups.

3. To create a new splash page, click the + icon.

TheNew Splash Page pane is displayed.

To localize or translate the Cloud Guest portal content, on theGuest Access > Splash Page > New
Splash Page > Localization pane, configure the parameters described in the following table:

These are optional settings unless specified as a required parameter explicitly.

Data Pane
Content

Description
Allowed
Length of
Text

Login Section

Login button title Enter the custom label text to be localized for the Login button. 1–255
characters

Network login title Enter the custom title text that you want to localize for the
Network Login page.

1–255
characters

Table 213: Cloud Guest Portal Localization
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Data Pane
Content

Description
Allowed
Length of
Text

Login page title Enter the custom text for title in the Login page. 1–255
characters

Access denied
page title

Enter the custom title text for the Access Denied page. 1–255
characters

Logged in title Enter the custom Logged in title text for the page that allows
access.

1–255
characters

Username label Enter the custom text for Username lable. 1–255
characters

Username
placeholder

Enter the custom text to show in in the Username placeholder. 1–255
characters

Password
placeholder

Enter the custom text to show in in the Password placeholder. 1–255
characters

Email address
placeholder

Enter the custom text to show in in the Email Address
placeholder.

1–255
characters

Register button
title

Enter the custom title text for Register button. 1–255
characters

Network login
button title

Enter the custom title text for Network Login button. 1–255
characters

Terms and
Conditions title

Enter the custom text to show in the Terms and Conditions title. 1–255
characters

'I accept the Terms
and Conditions'
text

Enter the custom text to show for the 'I accept the Terms and
Conditions' text adjacent to the check box.

Up to 20000
characters

Welcome Text Enter a custom Welcome text to the cloud guest portal user. Up to 20000
characters

Login failed
message

Enter a custom text to show for the Login Failed message when
a user's login attempt gets denied or fails.

Up to 20000
characters

Logged in message Enter a custom text to show for the Logged in message in the
access allowed page.

Up to 20000
characters

Register Section

Phone help
message

Enter a custom help message to show for the Phone help field. Up to 20000
characters

Phone number
placeholder

Enter the custom placeholder text for the Phone Number input
UI control.

1–255
characters

'Back' button text Enter the custom text label to show for the Back button control. 1–255
characters

Table 213: Cloud Guest Portal Localization
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Data Pane
Content

Description
Allowed
Length of
Text

'Continue' button
text

Enter the custom text label toshow for the Continue button
control.

1–255
characters

Email radio button Enter a custom text label for the Email option. —

Phone radio
button

Enter a custom label text for the Phone option. —

Register page title Enter a custom title text for the Register page. 1–255
characters

Accept button title Enter a custom title text for the Accept button. 1–255
characters

Register Page
instructions

Enter a custom message to show in the Register page. Up to 20000
characters

Verification Section

Verification code
label

Enter a custom text to show for the Verification code label. 1–255
characters

Verification code
placeholder

Enter a custom text to show for the Verification code
placeholder.

1–255
characters

Verification email
check message

Enter a custom text for the Verification Email Check message.
This is shown in the verification pending page.

Up to 20000
characters

Verification email
notice message

Enter a custom text for the Verification Email Notice message.
This is the message notifying the user when the email will be
sent.

Up to 20000
characters

Verification email
sent message

Enter a custom text for the Verification Email Sent message. Up to 20000
characters

Verification phone
notice message

Enter a custom text for the Verification Phone Notice message.
This is the message notifying the user that an SMS has been sent.

Up to 20000
characters

Verified account
message

Enter a custom text for the Verified Account message. This is
the message that will be shown in the Verified page.

Up to 20000
characters

Verify account
message

Enter a custom text for the Verify Account message. This is the
message that will be shown in the Verify page.

Up to 20000
characters

Verify button title Enter a custom label text for the Verify button. 1–255
characters

Verify title Enter a custom text for Verify title. 1–255
characters

Network login
message

Enter a custom text message to show in the Network Login
page.

Up to 20000
characters

Table 213: Cloud Guest Portal Localization
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4. Click Preview to preview the localized cloud guest portal page or click Finish.

Previewing and Modifying a Splash Page Profile
To preview a splash page profile, complete the following steps:

1. From theNetwork Operations app, filter a group.
2. UnderManage, click Guests to display the Splash Page.

A list of splash page profiles is displayed.

3. Ensure that the pop-up blocker on your browser window is disabled.
4. Hover over the splash profile you want to preview and click the preview icon. The Splash Page is

displayed in a new window.

The Splash Pages page also allows you to perform any of the following actions:

n To view the Splash Page configuration text in an overlay window, click the settings icon next to the
profile. You can copy the configuration text and apply it to AirWave managed APs using configuration
templates.

n To modify a splash page profile, click the edit icon ext to the profile form list of profiles displayed in the
Splash Page Profiles pane.

n To delete a profile, select the profile and click the delete icon next to the profile.

Associating a Splash Page Profile to an SSID
To associate a splash page profile with an SSID, complete the following steps:

1. From theNetwork Operations app, filter a group.
2. UnderManage, click Device > Access Points.

3. Click the configuration icon to open the configuration window.
4. UnderWLANs, click +Add SSID.
5. TheCreate a New Network pane is displayed.
6. Refer to the AP configuration page for Aruba Central Online Help for more detailed information on

how to create the network .

Creating a WiFi4EU Guest Network
Aruba Central allows administrators to create splash page profile specifically for WiFi4EU. The below
workflow describes how to set up a WiFi4EU splash page profile.
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To create a WiFi4EU splash page, complete the following steps:

1. In theNetwork Operations app, set the filter to a group.

The dashboard context for the group is displayed.

2. UnderManage, click Guests.

TheGuest Access > Splash Pages page is displayed.

3. Click the + icon to create a new splash page.
4. On theConfiguration tab, configure the parameters based on your requirement. Ensure that the

name of the splash page isWiFi4EU. Refer Adding a Cloud Guest Splash Page Profile for details on
creating a new splash page.

To associate a splash page profile with an SSID, complete the following steps:

1. UnderManage, click Guests.
2. Click theConfig icon.

TheGuest Access > Guest Network page is displayed.

3. Click Create Guest Network.

TheCreate Guest Network page is displayed.

4. In SSID, enterWiFi4EU.
5. In the Security option, select Open orWPA2-PSK.

If you selected the WPA2-PSK option, enter a password in Passphrase to access the guest network.

6. Select WiFi4EU splash page profile from the Splash page drop-down-list.
7. Click Add to enter the required time settings.
8. Click Save in theCreate Guest Network pane. The guest network profile is created and is available

for the specified time frame.

To associate the WiFi4EU API with the WiFi4EU splash page, complete the following steps:

1. In theAccount Home page, underGlobal Settings, click API Gateway.

TheAPI Gateway page is displayed.

2. To view the Swagger interface, click the link in theDocumentation column.

The documentation is displayed in a new window.

3. In URL, select Guest from the drop-down list.
4. In API Reference, select WiFi4EU.
5. Under Parameters, enter the network ID provided by the WiF4EU organization and enter the

required two letter language code.
6. Click Try.

The WiFi4EU settings get pushed to the WiFi4EU Splash page. Refer Viewing Swagger Interface for
details.

Configuring Visitor Accounts
TheVisitors pane displays information on the session and account details of the visitors who access the
splash page. It helps you monitor the guest sessions.

The MSP does not support creating or modifying guest visitor accounts. To configure visitors for WLAN
networks and view visitor connection details, the administrators must drill down to the customer account
and access it.
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Adding a visitor
To add a new visitor:

1. From the MSP view, drill down to a customer account.
2. In theNetwork Operations app, navigate to Manage > Guests > Visitors.

TheGuest Access > Visitors page is displayed.

3. Click on theAccount tab, and then click Add Visitor.
TheAdd Visitor pane is displayed.

4. Configure the parameters described in the following table:

Data Pane
Content Description

Name Enter a unique name to identify the visitor.

Company Enter the company name of the visitor.

Email Enter the email ID of the visitor.

Phone Enter the phone number of the visitor.

Password n Click Generate. The automatically generated password is displayed in the
PASSWORD text box.
n Select Send Access Code to send the access code by email or SMS.

Valid Till Specify the duration for the visitor account to expire in Day(S): Hour(s): Minute(s)
format.
To allow users to access the network for unlimited period of time, select
Unlimited.

Enable Select this check box to activate the user account.

Table 214: Adding Visitors

5. Click Save.
6. Click Save and Print to print the details of the visitor.

To view the guest or visitor sessions:

1. From the MSP view, drill down to a customer account.
2. In theNetwork Operations app, navigate to Manage > Guests > Visitors.

The Guest Access > Visitors page is displayed.

3. From the Show visitors for network drop-down list, select a network.

The following table displays the session details of the visitor:
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Data Pane Content Description

Visitors Displays the name of the visitor.

Login Type Displays the login type of the client (Anonymous,
Username/Password, Self-Registration, Facebook Wi-Fi).

Browser Displays the type of browser that the client is connected.

MAC Address Displays the MAC address of the connected client device.

Device Type Displays the type of the device.

OS Name Displays the OS on the client device.

Login Time Displays the login time of the client.

Session Time (Secs) Displays the duration for which the client is connected.

Table 215: Visitor Sessions Pane

The following table displays the account details of a visitor:

Data Pane Content Description

Name Displays the name of the visitor.

Email Displays the email ID of the visitor.

Phone Displays the contact number of the visitor.

Company Displays the company name of the visitor.

Status Indicates if the user account is in active or inactive state.

Creation Displays the date and time on which the visitor account is created.

Expiration Displays the date and time on which the visitor account expired.

Actions Allows you to edit a specific visitor account.

Table 216: Visitor Accounts Pane

You can filter the visitors displayed in the Account List by visitor status. Select Active, Inactive, or Show All
from the drop-down list.

Deleting Visitors
To delete one or more visitors:

1. Select the visitor or visitors you want to delete using theMultiselect box option.
2. Click Delete. The selected visitors get deleted.
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Downloading Visitor Account Details
To download the visitor account details:

1. Click Download to download the visitor account details available in theAccounts tab.



Chapter 12
Presence Analytics

Presence Analytics
Presence Analytics enables businesses to collect and analyze user presence data in public venues, enterprise
environments, and retail hubs. Presence Analytics also enables businesses to collect real-time data on user
footprints within the wireless network range of Aruba Instant APs that are managed using Aruba Central.
Using the Presence Analytics statistics, businesses can analyze user behavior and improve customer
engagement, and thus maximize revenue opportunities, optimize workspace, and increase market presence.

Aruba Central supports Presence Analytics only on the APs running Aruba Instant 6.4.4.4-4.2.3.0 or a later
version.
After Aruba Central is upgraded to 2.5.2, the Presence Analytics historical data is not retained and all the
existing clients are considered as new clients.
To properly manage devices with Presence Analytics, ensure that the devices are associated with a particular
site.

Enabling Presence Analytics
From Aruba Central 2.5.2 release onwards, Presence Analytics does not require a separate service
subscription. If you had assigned a service subscription prior to Aruba Central 2.5.2 release, you can remove
the service subscription and use the same subscription for either Cloud Guest or UCC.

Presence Analytics does not require a service token and is disabled by default.

To enable Presence Analytics on your Instant AP, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
TheGlobal dashboard is displayed.

2. UnderManage, click Guests > Presence Analytics.
3. Click theConfig icon.
4. Turn on the Enable all Access Points to collect data for sites analytics toggle switch.

The Presence Analytics license gets enabled on all devices for the particular account.

If Presence Analytics was enabled on any of the Instant APs before 2.5.2 upgrade, then after upgrade,
Presence Analytics is enabled by default on all the Instant APs in the network. However, Presence and
Loyalty statistics are displayed only for the Instant APs on which the Presence Analytics feature is
enabled.

Using Presence Analytics
Presence Analytics displays data either for all sites or per site. A site in Aruba Central represents a physical
location such as a venue or store. If your account does not have any sites configured, ensure that you create
a site. For more information on creating sites and adding devices, see Managing Sites on page 140.

The Presence Analytics page displays the following menu options:
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n List—Displays a list view of site analytics for all the sites in the account, or the selected site.
n Summary—Displays the graphical view of the Passerby metrics, the Loyal Visitors, Visit Frequency, and

the Visit Status.
n Configuration—Allows you to enable data collection from access points.

List
The Site Analytics table lists the data for all sites connected to the network. To view analytics data for a
specific site, in theNetwork Operations app, set the filter to a site. The specific site data is displayed. By
default, the Site Analytics table displays the following columns: Site,Unique Passerby,Unique Visitor,
Draw Rate, Visit, Loyal Visitor,Average Dwell Time, and Connected Visit. Click the ellipsis icon to
perform additional operations:

n Autofit columns—Adjusts the column width of the table to fit the page evenly.
n Reset to default—Resets the table view to the default columns.

To download the site data into a CSV format, click the download icon. Aruba Central generates the CSV
report of all the sites or the selected site in the network.

Dashboard
View Description

Time range
filter

You can view the clients' presence data for a selected time range. Click the time range filter and
select the From date and To date. Click Apply. The table displays the analytics data for the
selected time range.

Site Displays the name of the sites or site in the network.

Unique
Passerby

Displays the aggregate count of unique passerbys for the selected time range.

Unique
Visitor

Displays the aggregate count of unique visitors for the selected time range.

Draw Rate Displays the percentage of passerby that is converted to visitors for the selected time range.

Visit Displays the total number of visits made by clients for the selected time range. This includes the
repeat visits made by a particular client.

Loyal
Visitor

Displays the aggregate count of the visitors categorized as loyal. Visitors who have visited a site
more than once in the last 1 month are referred to as loyal visitors.

Average
Dwell Time

Displays the average time spent by visitors at a site for the selected time range.

Connected
Visits

Displays the total number of visits connected to the Aruba SSID for the selected time range.

Table 217: Site Analytics Data Metrics and Filters

Summary
The Summary view provides a statistical analysis of the Passerby, Loyal Visitors, Visit Frequency, and
Visit Status in a graphical representation. The graph can be populated for the following time range:
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n Hourly—Data for the an hour, with the current time taken as the basis for calculation.
n Daily—Data for the last 24 hours, with 00:00 hour of the current day taken as the basis for calculation.
n Weekly—Data for the last 1 week, with 00:00 hour of the current week taken as the basis for calculation.

Select the specific time period from the time range filter. Hourly and Daily data is populated if the filter is
set from 24 hours to 48 hours. Daily and Weekly data is displayed is the filter is set from 2 days till a
month.

Passerby
An associated or unassociated client who is in the vicinity of a specific site and has an RSSI value greater than
-90 dBm. You can customize the RSSI value for Passerby on the Presence Analytics > Configuration
page. The Passerby graph shows the aggregate count of passerby clients for the selected time range. The
graph also shows the following details:

n The total count of visits versus the passerby details for the selected time range.

Loyal Visitors
Based on the engagement pattern and the time spent by the clients at the site, Aruba Central classifies
clients as visitors. It also maintains a record of the number of repeat visits made by these clients over a
specific duration. Based on these records, it plots the frequency at which the visitors return to the sites, and
classifies these repeat visitors as loyal visitors.

The Loyal Visitors graph provides a statistical analysis of the clients classified as loyal visitors for a given
time range. The graph also shows the following information:

n The total count of visitors versus the loyal visitors for the selected time range.

Visit Frequency
The visit frequency displays the total count of how many times a loyal visitor visited a site repeatedly. The
graph displays the frequency distribution of visits made by visitors to the site. The graph also shows the
following information:

n The number of loyal visitors versus their total visits in the last 3 months.

Visit Status
Visits are monitored when clients are either connected to an Aruba SSID or disconnected from it. These visits
can either be an employee connected visit or a guest connected visit. TheVisit Status displays a pie chart
for the connected versus the not connected visits from the total number of visits for a specified time range.
The total number of visits by all visitors (including loyal) for the selected time range is also displayed.

Configuration
TheConfiguration tab provides a collective data of all the traffic related to passerby and visitors from the
APs connected to each site. TheData Collection table lists the data for all sites connected to the network.
By default the table displays the following columns: Site, Passerby Threshold, Visitors Threshold,
Conversion Time, and Access Points. Click the ellipsis icon to perform additional operations:

n Autofit columns—Adjusts the column width of the table to fit the page evenly.
n Reset to default—Resets the table view to the default columns.



Using Presence Analytics | 815

Dashboard
View Description

Site Displays the name of the sites or site in the network.

Passerby
Threshold

Displays the set RSSI threshold for the passerbys in dBm.

Visitors
Threshold

Displays the set RSSI threshold for the visitors in dBm.

Conversion
Time

Displays the dwell time in minutes set for each site.

Access
Points

Displays the total number of Instant APs with Presence Analytics enabled on them versus the
total number of Instant APs connected to the site. For example, if a certain site has 4 Instant APs
and only 2 Instant APs have Presence Analytics enabled, the Access Points column displays 2/4.

Table 218: Data Collection Table

Setting RSSI Threshold and Dwell Time for a Site
The RSSI and dwell time configuration allows the administrators to perform the following actions:

n Classify the type of client.
n Analyze presence patterns.
n Determine if the usage has increased over a period of time.

To modify the default RSSI thresholds and dwell time configuration parameters for a site, complete the
following steps:

1. In theNetwork Operations app, set the filter to Site.

The dashboard context for the selected site is displayed.

2. UnderManage, click Guests > Presence Analytics.
3. Click theConfig icon.
4. In theData Collection table, click the Edit Threshold icon.

The Thresholds window is displayed.

5. UnderVisitors, specify the value forRSSI threshold. By default, the RSSI threshold value is set to -
65 dBm. You can specify a value within the range of -100 to 0.

6. Under Passersby, specify the values forRSSI threshold. By default, the RSSI threshold value is set
to -90 dBm. You can specify a value within the range of -100 to 0.

7. Under Conversion, specify the values forDwell Time. By default, the dwell time is set to 5 minutes.
8. Click Save.

Editing Multiple Site RSSI Threshold and Dwell Time
Aruba Central allows you to edit all site thresholds and dwell time simultaneously. Modifying thresholds and
dwell time for all sites simultaneously overwrites all default and custom set values. To modify the RSSI
thresholds and dwell time configuration parameters for all the sites in the network, complete the following
steps:



Aruba Central | User Guide 816

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage, click Guests > Presence Analytics.
3. Click theConfig icon.
4. In theData Collection table, click the Edit Default Thresholds.

The Thresholds window is displayed.

5. Select the check box to overwrite the customized sites threshold.
6. UnderVisitors, specify the value forRSSI threshold. By default, the RSSI threshold value is set to -

65 dBm. You can specify a value within the range of -100 to 0.
7. Under Passersby, specify the values forRSSI threshold. By default, the RSSI threshold value is set

to -90 dBm. You can specify a value within the range of -100 to 0.
8. Under Conversion, specify the values forDwell Time. By default, the dwell time is set to 5 minutes.
9. Click Save.

Editing Default RSSI Threshold and Dwell Time
To modify the default RSSI thresholds and dwell time configuration parameters, complete the following
steps:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage, click Guests > Presence Analytics.
3. Click theConfig icon.
4. In theData Collection table, click the Edit Default Thresholds.

The Thresholds window is displayed.

5. UnderVisitors, specify the value forRSSI threshold. By default, the RSSI threshold value is set to -
65 dBm. You can specify a value within the range of -100 to 0.

6. Under Passersby, specify the values forRSSI threshold. By default, the RSSI threshold value is set
to -90 dBm. You can specify a value within the range of -100 to 0.

7. Under Conversion, specify the values forDwell Time. By default, the dwell time is set to 5 minutes.
8. Click Save.

Editing default thresholds and dwell time changes the default values only, custom set thresholds and dwell time
do not change.
The applied configuration changes for the RSSI threshold and dwell time take a maximum of 2 hours to reflect in
Aruba Central.
If Presence Analytics is disabled at a customer level, then all site level and customer level thresholds get
cleared. Enabling Presence Analytics at customer level again resets the all threshold levels.

Enabling or Disabling Access Points for Each Site
To enable to disable APs associated with each site, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
The dashboard context for the selected filter is displayed.

2. UnderManage, click Guests > Presence Analytics.
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3. Click theConfig icon.
4. In theData Collection table, click theAccess Points icon for the selected site.

TheDevices Data Collection window is displayed.

5. Select the APs you want to enable for the selected site. You can enable multiple APs for each site.
6. To disable APs for the selected site, uncheck the AP names from the list of APs. You can disable

multiple APs for each site.
7. Click Save.



Chapter 13
Unified Communications

Unified Communications
The growing use of Wi-Fi and the proliferation of mobile tablet and smartphone clients cause control and
visibility challenges for communication and collaboration applications. To overcome these challenges, Aruba
offers the Unified Communications application to manage your enterprise communication ecosystem.

The Unified Communications application on Aruba devices provides a seamless user experience for voice
calls, video calls, and application sharing when using communication and collaboration tools. The Unified
Communications application actively monitors voice, video, and application sharing sessions, provides traffic
visibility, and allows you to prioritize the required sessions. The Unified Communications application also
leverages the functions of the service engine on the cloud platform and provides rich visual metrics for
analytical purposes.

The Unified Communications application supports the following functions based on the type of device used
in the solution:

n Session visibility—The unified communications application provides call session visibility correlated across
the network to simplify operations for the network administrator. The administrators can monitor
wireless and wired network connectivity health on a per-session basis and analyze the quality of
experience.

n Session prioritization—Based on the type of device provisioned in your network, the Aruba Central server
receives call control information from devices like Instant AP, controllers, and switches. The Unified
Communications application uses this data to detect and classify the traffic type and dynamically
prioritize the voice and video traffic over data traffic. The heuristics method is used for session
prioritization. A built-in heuristics engine detects the Unified Communications traffic and prioritizes the
required traffic. The heuristics data detection and classification method is used to identify clients in the
call and classify and prioritize media packets. Switches do not support heuristics-based prioritization.

Aruba Central interacts with Instant AP using OpenFlow Controller and OpenFlow Agent.
When Aruba Central is not reachable, Instant AP applies default prioritization to the new calls and dashboard
visibility is not available for the new calls. Unified Communications-defined call prioritization is applied to in-
flight calls.

Heuristics Classification
In the heuristics method, Aruba devices like Instant AP perform deep packet inspection on the traffic to
determine voice and video traffic. For the heuristics classification method, no changes or additional
components are required on the unified communications servers.

The heuristics classification method includes the following steps:

n When the voice or video call is established, classify-media in the ACL is triggered and clients are marked as
media-capable clients.

n Any subsequent UDP data flow with source/destination port numbers above 1023 from or to media-
capable users go through the DPI engine.

n If an RTP session is based on DPI, the payload type in the RTP header is used to determine if it is a voice or
video session.
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Skype for Business calls are classified using heuristics-based and SDN-based call classification.
FaceTime, RTP, and Wi-Fi Calling calls are classified using on heuristics-based classification.
SIP calls are classified using signalling-based classification.

Enabling Unified Communications
To enable Unified Communications:

1. In theNetwork Operations app, set the filter to Global.
2. UnderManage, click Applications > UCC.
3. Click theConfig icon.
4. Move theActivate UCC slider to the right.

To access the Unified Communications application, obtain a valid subscription. To obtain a subscription for
theUnified Communications application, contact the Aruba Central Sales team.

If you have a valid subscription, follows these steps to enable theUnified Communications service on
your devices:

1. In theAccounts Home page, click Global Settings > Subscription Assignment.
2. From the list of subscriptions, select UCC.
3. Select the device from theDevices table.
4. Drag and drop the device from theDevices table to the Subscriptions table.
5. Click Yes to confirm the subscription assignment.

Unified Communications is active only if it is enabled in Aruba Central and the appropriate Unified
Communications subscriptions are applied.

Enabling Retain Client QoS
When retain client QoS is enabled, all configured ALGs are disabled, all traffic is treated as RTP traffic, default
prioritization as defined by the client is honored, and call visibility is provided.

To enable retain client QoS:

1. In theNetwork Operations app, set the filter to Global.
2. UnderManage, click Applications > UCC.
3. Click theConfig icon.
4. Move theRetain Client QoS slider to the right.

Editing Protocol
To edit a protocol:

1. In theNetwork Operations app, set the filter to Global.
2. UnderManage, click Applications > UCC.
3. Click theConfig icon.
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4. Hover over the required protocol and click the icon underAction. Unified Communications
supports Facetime, SIP, Skype for Business, Wi-Fi Calling, Retain Client QoS protocols.

5. Edit the parameters listed in Protocol Parameters.

Parameter Description

Voice Configure voice priority tag.

Video Configure video priority tag.

Desktop Sharing Configure desktop sharing priority tag.

DNS Server Configure DNS server.

Table 219: Protocol Parameters

6. Click Save Settings.

Unified Communications Dashboard
TheApplication > UCC page provides a variety of charts and lists that allow you to assess the quality of
calls in the network. The banner in the header pane shows the following details:

n Calls—Displays the total number of calls that have ended.
n Good—Displays the total number of good calls that have ended. A good call has an UCC RTPA score of

more than 70.
n Fair—Displays the total number of fair calls. that have ended. A fair call has an UCC RTPA score in the

range of 30 to 70.
n Poor—Displays the total number of poor calls that have ended. A poor call has an UCC RTPA score of less

than 30.
n Unknown—Displays the total number of calls whose status is unknown. A call is classified as unknown if

the ALG does not support RTPA or the UCC score is not available.

For the ALG like Skype SDN, the end-to-end Mean Opinion Score (MOS) is used. A good call has a MOS of more
than 3.5, a fair call has a MOS in the range of 2.0 to 3.5, a poor call has a MOS of less than 2.0, and an unknown
call does not have a MOS.
Wi-Fi Calling calls are not tracked. Wi-Fi Calling calls are not assigned an UCC RTPA score and are categorized
as unknown.

The Summary view in theApplications > UCC page provides the following charts:

n Calls—Displays the chart of all, good, fair, poor, or unknown calls. Chart can be viewed by Health, SSID,
Protocol, Operating System, Session Type, or Quality, In any chart, hover your mouse over any segment
of the chart to view additional information.

n Access Points—Displays the chart of access points. Chart can be viewed by Poor Quality % or Most Calls.
Use Show More to view more details of the calls.

n Clients—Displays the chart of clients. Chart can be viewed by Poor Quality % or Most Calls. Use Show
More to view more details of the calls.

The Show More option in theAccess Points chart displays the following details of the calls:
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Parameter Description

Access Point Name Displays the name of the AP.

Calls Total Displays the total number of calls.

Calls Good Displays the total number of good calls.

Calls Fair Displays the total number of fair calls.

Calls Poor Displays the total number of poor calls.

Calls Poor Percentage Displays the percentage of poor calls.

Calls Unknown Displays the total number of unknown calls.

Table 220: Access Points with Calls

Hover over any row in the list to view additional information.

The Show More option in theClients chart displays the following details of the calls:

Parameter Description

Client Name Displays the name of the client.

Calls Total Displays the total number of calls from the client.

Calls Good Displays the total number of good calls from the client.

Calls Fair Displays the total number of fair calls from the client.

Calls Poor Displays the total number of poor calls from the client.

Calls Poor Percentage Displays the percentage of poor calls from the client.

Calls Unknown Displays the total number of unknown calls from the client.

Table 221: Clients with Calls

Hover over any row in the list to view additional information.

The List view in theApplications > UCC page provides a variety of lists that allow you to assess the quality
of calls in the network. The banner in the header pane shows the following details:

n Calls—Displays the total number of calls that have ended.
n Good—Displays the total number of good calls that have ended.
n Fair—Displays the total number of fair calls that have ended.
n Poor—Displays the total number of poor calls that have ended.
n Unknown—Displays the total number of calls whose status is unknown in the last 5 minutes.

TheCalls list displays the following details of the calls:
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Parameter Description

From Displays the device originating the call.

To Displays the device receiving the call.

Start Time Displays the date and time when the call originated.

Duration Displays the duration of the call.

State Displays the state of the call. Possible values are:
n Active
n Success
n Terminated

Quality Displays the quality of the call. Possible values are:
n Good
n Fair
n Poor
n Unknown

AP Name Displays the name of the AP.

Client Displays the name of the client.

Table 222: Call Details

The Call Detail Record (CDR) for FaceTime and Skype for Business calls may be incorrect. The CDR for a
Facetime call may be empty or it may display the quality of the call as unknown. Duplicate CDRs may be
created for a Skype for Business call.



Chapter 14
Installation Management

Installation Management
Site installations and device deployments at customer premises require extensive coordination between the
IT administrators and installation personnel. If there are multiple sites to deploy, businesses may require
more time and manual effort to coordinate and manage site installations. The Aruba Installation
Management service simplifies and automates site deployments, and helps IT administrators manage site
installations with ease.

The Installation Management service includes the following components:

n Install Manager on Aruba Central portal—Intended for IT administrators who oversee the installation
management activities in an organization. Using Install Manager, network administrators can create
installer profiles, assign site deployments to installers, and monitor deployment status for each site from
a remote location. Aruba Central users can access the Install Manager application from the app selection
pane in the UI.

n Aruba Installer mobile app—Intended for the installation personnel who deploy devices on a site. The
Aruba Installer mobile app allows the installers to scan devices and add them to the provisioning network.
The Aruba Installer mobile app is available for downloads on Apple® App Store and Google Play Store.

Installation Management and Monitoring
The Install Manager feature in Aruba Central includes the following menu options:

n Site Installations —Displays a list of sites associated with an Aruba Central account.
n Installers—Displays a list of installers added using the Install Manager application.

Installation Management Workflow
The following figure illustrates the installation management workflow for the Install Manager users:
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Installer Workflow
Installers are technicians who are assigned the task of visiting a physical site or location, and install devices.
The Aruba Installer mobile app enables installers to scan devices and report the task status to IT
administrators.

The following figure illustrates the installation workflow for the Aruba Installer mobile app users:
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Managing Site Deployments
Before you begin, ensure that the following tasks are completed:

n Onboarding Devices on page 91
n Managing Subscriptions on page 98

The steps required for completing a site installation procedure are listed in the following table:

Administrator Workflow Installer Workflow

n Creating a Site
n Assigning Groups to a Site
n Adding an Installer and Assigning Sites for

n Downloading the Installer Mobile App
n Registering as an Aruba Installer
n Installing Devices on a Site

Table 223: Installation Management
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Administrator Workflow Installer Workflow

Installation
n Monitoring and Troubleshooting Installation
Issues

Creating a Site
To create a site in Aruba Central, complete the steps described in Creating a Site on page 140.

Assigning Groups to a Site
To assign groups to a site:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Install Manager tab.
4. On the Site Installations page, click on the site you want to edit.
5. Select the group for each device category.
6. Click Save.

To assign groups to multiple sites:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Install Manager tab.
4. On the Site Installations page, select the sites. TheAssign Groups button is displayed.
5. Click Assign Groups.
6. In theAssign Groups to Sites pop-up window, select a group for each device category.
7. Click Save.

You can also add installation notes for sites. The installers can view the notes by clicking the info icon in the
Installer mobile app.

Adding an Installer and Assigning Sites for Installation
Administrators can add installers and assign installation tasks to these installers through the Aruba Installer
mobile app.

To add an installer profile in Aruba Central, complete the following steps:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Click the Install Manager tab.
4. In the Install Manager tab, click Installers. The Installers page is displayed.
5. Click + Add Installer. TheAdd Installer page is displayed.
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6. Enter the name and phone number of the technician to whom you want to assign a site for installing
the devices.

7. Specify the time until which the installer's profile is valid. The technicians will be automatically logged
out of the Aruba Installer app on the specified date.

8. On theAdd Installer page, you can do the following:
n Select a site in the Sites not assigned table and click Add > to add the site.
n Select a site in the Sites Selected table and click < Remove to remove the site.
n Click Add all > to add all the sites.
n Click < Remove all to remove all sites.

9. Click Save. An SMS notification is sent to the installer's mobile device.

The site(s) assigned are displayed in the Sites Assigned table.

To start the installation, the installer must download the Aruba Installer mobile app and sign up as an
installer. The administrators can verify the installer registration status on the Installers dashboard in the
Install Manager application in Aruba Central. The Installers dashboard displays the following status
indicators for installers.

n Invited—The installer is added and an SMS notification is sent to the installer.
n Registered—The installer has registered using the Aruba Installer mobile app.
n Verified—The installer has accepted the installation invite and successfully completed the registration

with the Aruba Installer app.

Downloading the Installer Mobile App
When an installer is added in the Install Manager application in Aruba Central, an SMS notification is sent to
the installer's mobile device. The SMS notification includes the links for downloading the Aruba Installer
mobile app.

If you are an installer and have received the SMS notification with the Aruba Installer mobile app details,
download the Aruba Installer mobile app. The Aruba Installer mobile app is available in App Store for iOS
devices and Google Play Store for Android devices.

Registering as an Aruba Installer
To register as an installer:

1. Open the Aruba Installer app.
2. In the Sign Up tab, enter your first name, last name, country code and mobile number.
3. Click Register. A verification code is sent to your mobile device.

https://itunes.apple.com/us/app/aruba-installer/id1270000777?mt=8
https://itunes.apple.com/us/app/aruba-installer/id1270000777?mt=8
https://play.google.com/store/apps/details?id=com.arubanetworks.installer
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4. Enter the verification code received through the text message in theCode field.
5. Click Validate Code. If the code is valid, the installer is registered.

Installing Devices on a Site
To install a device on a site:

1. Sign in to Aruba Installer mobile app.
2. View the sites assigned for deployment.
3. Select the site that you want to deploy.
4. Note the devices assigned for the site and installation notes if any.
5. Click Scan Device. Scan the serial number of the device. The Aruba Installer app verifies if the device

is onboarded to Aruba Central device inventory and is assigned a valid subscription.
6. Power on the device and connect it to the Internet. The device automatically connects to Aruba

Central and is provisioned in the group to which it is already assigned.
7. Verify the installation status and report errors if any.

Before scanning a device, ensure that the device is not connected to Aruba Central. If the device is already
connected to Aruba Central, Install Manager will not assign it to a group.

Monitoring and Troubleshooting Installation Issues
To monitor the installation progress:

1. In theNetwork Operations app, set the filter to Global.
2. UnderMaintain, click Organization.
3. Select the Install Manager tab. The Site Installations table is displayed.
4. To view the status of a site installation, check the Status column:

n In Progress—Indicates that the device installation is in progress.
n Completed—Indicates that the device installation is completed.

If the installation status displays an error:

n Check if the devices are onboarded to Aruba Central.
n Verify if the devices are assigned a valid subscription.
n Check if the sites are assigned to a group.
n View the audit trails.

5. If the installation is completed, click the site name to navigate to the site details page and click Mark
Completed.

You can mark a site as completed even if Install Manager was not used to install or onboard the
device.

6. Click Save.
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